The information in this addendum has been provided by PROMODEL Corporation to document the ActiveX capabilities of ProModel, MedModel, and ServiceModel. The information in this addendum is subject to change without notice and does not represent a commitment on the part of PROMODEL Corporation. The software described in this addendum is supplied under a license agreement and may be copied only under the terms of the license agreement. No part of this addendum may be reproduced or transmitted in any form, or by any means, electronic or mechanical, including photocopying, for any purpose other than the owner’s personal use, without the express written permission of PROMODEL Corporation.

© 6/15/06 PROMODEL Corporation.
All rights reserved.
Printed in the United States of America

ProModel, MedModel, and ServiceModel are registered trademarks of PROMODEL Corporation.
Unless otherwise noted, all reference to company names, products, and persons contained in this guide are completely fictitious and are used solely to document the use of ProModel, MedModel, and ServiceModel.

Visual Basic and ActiveX are trademarks of Microsoft Corporation.
Table of Contents

Introduction .................................................................................................................. 1

Chapter 1: The ProModel Application Object ......................................................... 8

   EndReplication ................................................................................................. 9
   EndSimulation ............................................................................................... 10
   GetEventsObject .......................................................................................... 11
   GetSimTime .................................................................................................... 12
   GetStatus ......................................................................................................... 13
   GetVersion ....................................................................................................... 14
   LoadDefaults ............................................................................................... 15
   LoadModel ....................................................................................................... 16
   MenuCommand .............................................................................................. 17
   MergeModel ..................................................................................................... 18
   MsgBox ........................................................................................................... 19
   New ............................................................................................................... 20
   OpenModule ................................................................................................. 21
   Quit ............................................................................................................... 22
   RedrawLayout ............................................................................................... 23
   RedrawTables ............................................................................................... 24
   RunScenarios ............................................................................................... 25
   Save ............................................................................................................... 26
   SaveAs ......................................................................................................... 27
   SetMacro ....................................................................................................... 28
   SetMenus ....................................................................................................... 29
   SetMessageMode ............................................................................................ 30
   SetPan ............................................................................................................ 31
   SetView ......................................................................................................... 32
   SetViewRect ................................................................................................. 33
   SetWindowPos ............................................................................................... 34
   ShowTranslationDlg ..................................................................................... 35
   Simulate ......................................................................................................... 36
   Zoom ............................................................................................................ 37
Chapter 2: The ProModel Events Object ..............................................................38

PMEventsHandler .................................................................39
AnimSpeedChange .................................................................41
InputTextPrompt .................................................................42
ListSelectPrompt .................................................................44
RunError .................................................................46
TranslationError .................................................................47
UserZoom .................................................................48

Chapter 3: The ProModel Runtime Object ....................................................49

GetAnimationState .................................................................50
GetAnimationSpeed .................................................................51
GetStatValue .................................................................52
SetAnimationState .................................................................54
SetAnimationSpeed .................................................................55
SetStatValue .................................................................56

Chapter 4: The ProModel Data Object ............................................................57

AddBackgroundBitmap .............................................................58
AppendEntitySpot .................................................................59
AppendGraphicIcon .................................................................60
AppendGraphicIconSize ..........................................................61
AppendRecord .................................................................62
AppendRoutingPoint ...............................................................63
DeleteRecord .................................................................64
GetIntFieldValue .................................................................65
GetRealFieldValue .................................................................66
GetRecordCount .................................................................67
GetSelectedsFromType ..............................................................68
GetStringFieldValue ...............................................................69
InsertRecord .................................................................70
Populate .................................................................71
SelectMainRecordByIndex ........................................................72
SelectMainRecordByName ........................................................73
SetIntFieldValue .................................................................74
SetRealFieldValue .................................................................75
SetStringFieldValue ...............................................................76
Chapter 5: The RDBDataServer Object ................................................................. 77

  CloseFile ........................................................................................................ 78
  FieldName ...................................................................................................... 79
  GetPositionInfo ............................................................................................ 80
  GetValue ........................................................................................................ 81
  OpenFile ......................................................................................................... 82
  PeriodName ................................................................................................... 83
  PositionIsValid .............................................................................................. 84
  RecordName .................................................................................................. 85
  ReplicationNumber ....................................................................................... 86
  ScenarioName ............................................................................................... 87
  SelectData ..................................................................................................... 88
  TableName ..................................................................................................... 89

Appendix: Table Definitions ........................................................................... 91

  ProModelData Table Definitions ................................................................. 91
  Runtime Table .............................................................................................. 114
  Result Codes (Errors) .................................................................................. 118
  Events ........................................................................................................... 119
  Path Colors .................................................................................................. 120
  Menu Ids ...................................................................................................... 121

Index ............................................................................................................... 125
Introduction

ProModel’s ActiveX Components

ProModel’s ActiveX Automation capability allows you to use any ActiveX-enabled language (e.g. Microsoft Visual Basic, VBA, or Visual C++) to:

• Build customized user interfaces for ProModel
• Add, Change or Delete model data from external data sources, such as spreadsheets, databases or ASCII text files
• Control ProModel from another application
• Extract output data and place it in a spreadsheet or database

The intent of this manual is to give you information that is specific to the ActiveX components automatically installed with your PROMODEL product. We have included plenty of examples to help you understand how to use these powerful tools. All of the examples that follow use Visual Basic commands and syntax. The variable names used in this manual are merely examples, you will want to replace them with names that are meaningful to you.

ProModel Objects

All of the Type Libraries have an Application object, a Data object and a Runtime object. Each object gives you access to different parts of ProModel. The following is a brief description of these objects:

• Application – gives you operational control of ProModel. For example, using this object you can load a model or start a simulation.
• Data – allows you to access to model information (like Locations or Processing records).
• Runtime – gives you methods that can update or capture the values of statistics while a simulation is running.

When you declare object variables, we recommend that you use the ProModel object types. Here are examples of how to declare and create an instance of each of the ProModel objects.

ProModel Type Library

Dim ObjVarName as ProModel.CProModel
Set ObjVarName = CreateObject(“ProModel”)

Dim ObjVarName as ProModel.CProModelData
Set ObjVarName = CreateObject(“ProModelData”)

Dim ObjVarName as ProModel.CRuntime
Set ObjVarName = CreateObject(“ProModel.CRuntime”)

ProModelPM Type Library (ProModel product)
Dim ObjVarName as PromodelPM.Application
Set ObjVarName = CreateObject("PromodelPM.Application")

Dim ObjVarName as PromodelPM.Data
Set ObjVarName = CreateObject("PromodelPM.Data")

Dim ObjVarName as PromodelPM.Runtime
Set ObjVarName = CreateObject("PromodelPM.Runtime")

PromodelMM Type Library (MedModel product)

Dim ObjVarName as PromodelMM.Application
Set ObjVarName = CreateObject("PromodelMM.Application")

Dim ObjVarName as PromodelMM.Data
Set ObjVarName = CreateObject("PromodelMM.Data")

Dim ObjVarName as PromodelMM.Runtime
Set ObjVarName = CreateObject("PromodelMM.Runtime")

PromodelSM Type Library (ServiceModel product)

Dim ObjVarName as PromodelSM.Application
Set ObjVarName = CreateObject("PromodelSM.Application")

Dim ObjVarName as PromodelSM.Data
Set ObjVarName = CreateObject("PromodelSM.Data")

Dim ObjVarName as PromodelSM.Runtime
Set ObjVarName = CreateObject("PromodelSM.Runtime")

Other Objects

ProModel also provides a few other objects that will enable you to:

• Access the data found in the classic output statistics files (*.rdb, *.rdt).
• Capture and respond to events that take place in ProModel.

There are three files that allow you to work with the classic output statistics. They are:

• Rdbsrv.exe – gives you access to the data contained in the General Statistics report. This has been included with previous versions of ProModel.
• Rdbsvr.dll – This DLL gives you access to the General Statistics, but does it much faster than rdbsrv.exe.
• Rdtdata.dll – This DLL gives you access to the Time Series data.

The “ProModel Events 2.0 Type Library” (pmcp53.dll) gives you a way to control things that happen (events) in ProModel. With it, you can:

• Trap and respond to errors without user intervention
• Hide informational messages
• Get information about changes the user makes during simulation, such as changing the animation speed or the view.
• Handle ProModel “Prompt” dialogs or replace them with your own dialogs

Methods

Each ProModel ActiveX Object has one or more methods (actions it can perform).

Each method may or may not have Parameters (details that you provide or that ProModel returns).

Syntax

Most methods can be used in two different ways. The first example shown below does not have a variable to receive the result code. The second example uses a slightly different syntax that will enable you to determine whether or not the method executed successfully.

Syntax 1

If you don’t need to know whether the method succeeded or failed, use the method name, followed by a space, then each parameter. Use a comma to separate the parameters.

```vba
Sub FindRecord()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmDataObject.Populate

    pmDataObject.SelectMainRecordByName 1, "MyLocation"

    Set pmObject = Nothing
    Set pmDataObject = Nothing
End Sub
```

Syntax 2:

When you use this syntax, you can determine what happened when the method was executed. You will need to declare a variable to hold the result code returned by ProModel. In the method call, start with that variable, then an equals (=) sign, followed by the method name and a left parenthesis. As with Syntax 1, the parameters are listed in order, separated by commas. Finally, a right parenthesis closes the method call.

```vba
Sub FindRecord()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim vResultCode as Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmDataObject.Populate

    vResultCode = pmDataObject.SelectMainRecordByName (1, "MyLocation")

    If vResultCode <> 0 Then
```

Result Codes

Almost all of the methods in the ProModelData object may optionally be written to return a result code. Result codes help you know if the execution of the method was successful. For a list of result codes, see “Result Codes (Errors)” on page 118.

Definitions

Record Type = Table Number
Record = Row
Record Index = Row Number
Field = Column
Field Index = Column Number

Parameters

ProModel has two kinds of parameters: Input Parameters and Output Parameters. Each parameter has a specific data type. In this document, the data types shown are Visual Basic data types. If you are programming in another ActiveX enabled language, you will need to use the equivalent types in that language.

For input parameters, you may place a value of the correct type directly in the method call, or place the value into a variable of the appropriate type, then use the variable to satisfy the parameter requirements. For output parameters you must supply a variable of the appropriate type to receive the values returned by ProModel.

For output parameters, you must use a variable.

Although some programming languages will automatically convert one data type to another, you may need to use variables to work with some numbers. In the example for the Zoom method, shown on page 37, you will notice that a variable of type Double is declared, then the numeric value is placed in that variable, and the variable is used in the method call. If the Zoom method is executed with a number as the parameter, an error is raised, because Visual Basic automatically converts the number, but not to the correct type. So, by placing the number in a variable explicitly defined as a Double, the problem of incorrect conversion is avoided. Other languages may have similar limitations.

PM Constants

You may have noticed that the first parameter in the “SelectMainRecordByName” method used in the code sample in the Syntax section contains a number. This number references the Locations table. Because it can be difficult to remember the number codes associated with so many tables, fields, status codes, etc. we have developed text values that you may use in place of the numbers. To use the pre-defined constants, simply include the PMConstants.bas in one of your program modules. Whether you use the pre-defined constants, your own constants or the numbers in your code makes no difference to ProModel. You can even use constants and numbers in the same method call. See the PM Constants chapter for a complete list of pre-defined constants, their values and descriptions.
Working with Data

When you create a model, what you are actually doing is recording information about your business processes. When you run a simulation, ProModel takes that information and uses it to display an animated representation of your processes and to generate the statistical information about your processes.

You can think of each model you create as a database. Within each model database there are many tables, such as Locations, Path Networks, and Processing. ProModel's ActiveX uses numbers to reference each table. In the appendix, you will find a list of tables and their corresponding numbers.

Each table contains one or more fields. You may have records in many of these tables, with information in some of the fields. If you are accustomed to spreadsheets, each model would be a workbook, each table a sheet. Fields would correspond to columns and records would be the rows. Fields and records are also referenced by number. A complete list of tables and fields, along with their reference numbers, can be found in Appendix A on page 91.

With a database, you have an element that is not as easy to create in a spreadsheet, the parent-child relationship. Since ProModel is a database environment, there are many tables that have that type of relationship. Let's look at something a little more concrete.

Suppose you have just started a new model and have defined the locations shown below:

![Diagram of locations]

For each of these three locations, there is more than one graphic icon. In addition, the conveyor for Loc2 has a couple of joints (bends) in it. So, your Locations table would have three records. Each of these records would have more than one graphic. Information about the graphics is stored in a different table, which is a child of the Locations table. The child table (Location Graphics) also has a child of its own, the Q/Conveyor Joints table. A diagram of the table relationships would look something like this:

<table>
<thead>
<tr>
<th>Locations</th>
<th>Location Graphics</th>
<th>Q/Conveyor Joints</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Loc1</td>
<td>1. Part Spot</td>
<td>1. Start Point</td>
</tr>
<tr>
<td></td>
<td>2. Text Box</td>
<td>2. First Bend</td>
</tr>
<tr>
<td></td>
<td>3. Counter</td>
<td>3. Second Bend</td>
</tr>
<tr>
<td>2. Loc2</td>
<td>1. Conveyor</td>
<td>4. End Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Text Box</td>
<td></td>
</tr>
<tr>
<td>3. Loc3</td>
<td>1. Part Spot</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Text Box</td>
<td></td>
</tr>
</tbody>
</table>

If we want to change the name of Loc1 to “EntryPoint”, we would need to make that change in the first record of the Locations table (table number 1). So, we would select record one in table one.
If we want to move Loc3 to a different place in the layout, we would first need to select the Loc3 record in the parent table (Locations). Then we can select records in the child table (Location Graphics – table 45) and change the X and Y values of each.

Now, if we want to move the end of the Loc2 conveyor closer to our new Loc3 position, we first need to select Loc2 in the parent table (Locations). Then, we would select Conveyor in the child table (Location Graphics) for Loc2. Finally, we can select the End Point record in the second level child table (Q/Conveyor Joints – table 61) and change its X and Y values.

You may have realized from the description above that you must always select a record before you can work with any of the information in that record. This holds true for all of the data tables in ProModel. Records can be selected either by name (if it has one) or by index number. The index number is the number in the upper right corner of the data window in ProModel and represents the record’s position in the table (its row number). When a new record is added to a table in ProModel, that record is automatically selected. If a record is deleted from a table, the index numbers of following records will be changed to close the gap.

The fields (columns) are also numbered, from left to right. One caveat: the first field is not always the one you might think it is. For example, the Name field in the Locations table is actually number two. Field one is no longer used.

**Working with Graphics**

Though the basic principles for working with data in the graphics tables are the same as working with any other data table in ProModel, there are some things that work a bit differently. This section covers those differences.

We have already indicated that the Location Graphics table is a child of the Locations table. Entities and Resources also have their own graphics tables. The graphics information for the Path Networks table are actually included in the parent table (it has other children).

With most data tables in ProModel, there are two methods available for adding new records – the AppendRecord and InsertRecord methods. When working with any of the Graphics child tables, only the AppendRecord() is used, InsertRecord() will return an error.

Because there are many types of graphics associated with locations, working with the Location Graphics table can be a bit tricky at first. Let’s look at the example we used previously:

Suppose that we want to add a Counter graphic to Loc3.

First, we must select the record for Loc3 in the Locations table. Then, we would use the AppendRecord method with the Location Graphics table. A library graphic is automatically created. However, we don’t want a Library graphic, so we must use the SetIntFieldValue method to change the value in the Type field to 4 (Counter).

With other data tables, the SetIntFieldValue method would simply replace the value in the specified field. Not so in the Location Graphics table. When using this method on the Type field, it actually deletes the library graphic record, then appends a new record (counter graphic) and sets the value of the Type field to 4. This is fine if you have just appended a new record, but what if you want to change the Type of an existing graphic?
Unless the graphic you wish to change is the last record in the table, the index number will change (because the record is deleted and then a new record added to the end of the table). This also means that the index number of other graphics may change, as outlined earlier.

Changing the graphic type also modifies the apparent structure of the Location Graphics table itself. Each graphic type has different fields associated with it. (see “Location Graphics (45): pmdTblLocGraphic” on page 107). A field by the same name may have different numeric values for different graphic types. The one constant is the Type field, it is always field 1.

What if we create a location, then we append a graphic and we want to change it to a Queue? When we change the value in the Type field to 2, the same process as above takes place, but a few more things happen as well. The Graphic Style field will have the default value of 2 (Line style), and two records will be added to the next level child table (Q Joints table, #61). The first record in the Q Joints table will have the X Position and Y Position both set to zero (0), indicating that the queue starts at the top left corner of the layout. The second record will have default X and Y values of 100, indicating that the queue ends 100 pixels to the right and 100 pixels down from there.

After that, you may work with the other fields of the Location Graphics table to further define how the Queue or Conveyor will look and function. You may also change the X and Y position values of the two records in the Queue/Conveyor Joints table, or add more joints by appending records. However, you cannot delete the two default records, since you cannot have a queue or conveyor with only one end. To delete the queue or conveyor, you must delete the record in the Location Graphics table.

You may notice as you work with Library Graphics that there is no easy way to determine what the Graphic ID number is for any given graphic icon. However, the Graphic ID is a required field when the graphic type is 1. The Graphic Editor is an application that is included with ProModel for your convenience. Unfortunately, as you add, change and delete icons in your graphics libraries, you may end up with numbers out of sequential order or missing altogether.

The following chapters will give you detailed information and examples for each of the objects and methods available with your installation of ProModel.
Chapter 1: The ProModel Application Object

The ProModel Application object is found in pm.exe, mm.exe, and sm.exe as “ProModel”, “ProModel Type Library”, “ProModelPM”, or “ProModel PM Type Library”. If one or more of these libraries are not available in your References list, run PM.EXE (found in your ProModel folder) with the “/regserver” command line option.

The ProModel Application object may be used with Runtime versions of ProModel. The ProModel Application object has methods that control all the commonly used functions of ProModel, as well as the method used to initialize the Events object. The available methods are listed below, grouped by area of functionality.

- EndReplication
- EndSimulation
- GetEventsObject
- GetSimTime
- GetStatus
- GetVersion
- LoadDefaults
- LoadModel
- MenuCommand
- MergeModel
- MsgBox
- New
- OpenModule
- Quit
- RedrawLayout
- RedrawTables
- RunScenarios
- Save
- SaveAs
- SetMacro
- SetMenus
- SetMessageModes
- SetPan
- SetView
- SetViewRect
- SetWindowPos
- ShowTranslationDlg
- Simulate
- Zoom
**EndReplication**

**Syntax:**  EndReplication

**Description:** Terminates a Replication before completion. Simulation will then proceed to the next replication. If EndReplication is called during the final replication, the simulation will end.

**Parameters:** None

**Returns:** Nothing

**Example:** This example loads a model, runs simulation for 30 minutes (1800 seconds), then terminates the current replication.

```vba
Sub QuitSimEarly()
    Dim pmObject As ProModel.CProModel
    Dim CurSimTime AS Double

    CurSimTime = 0
    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
    pmObject.Simulate

    Do While CurSimTime < 1800
        pmObject.GetSimTime CurSimTime
        DoEvents
    Loop

    *pmObject.EndReplication*

    Set pmObject = Nothing
End Sub
```
EndSimulation

Syntax:  EndSimulation

Description:  Terminates a simulation run before completion. The EndSimulation method will have no
effect if called when there is no simulation running. If running multiple replications, the entire simulation
will end (remaining replications will not be run).

Parameters:  None

Returns:  Nothing

This example loads a model, runs it for 30 minutes (1800 seconds), then terminates the simulation.

Sub QuitSimEarly()
  Dim pmObject As ProModel.CProModel
  Dim CurSimTime AS Double

  CurSimTime = 0
  Set pmObject = CreateObject("ProModel")
  pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
  pmObject.Simulate

  Do While CurSimTime < 1800
    pmObject.GetSimTime CurSimTime
    DoEvents
  Loop

  pmObject.EndSimulation

  Set pmObject = Nothing
End Sub
GetEventsObject

Syntax: GetEventsObject

Description: Use this method to initialize the ProModel Events object. For further instructions see the Events Handler section.

Parameters: None

Returns: Event Handler object.

Example: This example is incomplete, but the code given shows how to use the GetEventsObject method. This must be executed before using the Events Handler.

    Sub GenericSub()
        Dim pmObject As ProModel.CProModel
        Dim pmEventObject As PMCPLib.PMEvents

        Set pmObject = CreateObject("ProModel")
        Set pmEventObject = pmObject.GetEventsObject
        **More Code…
    End Sub
GetSimTime

Syntax: GetSimTime (Seconds)

Description: Gets the current simulation time in seconds.

Parameters:

Seconds (Double) Output parameter that receives return value.

Returns: (Double) Current simulation clock time in seconds.

Example: This example loads a model, runs it for 30 minutes (1800 seconds), then terminates the simulation.

Sub QuitSimEarly()
    Dim pmObject As ProModel.CProModel
    Dim CurSimTime AS Double

    CurSimTime = 0
    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
    pmObject.Simulate

    Do While CurSimTime < 1800
        pmObject.GetSimTime CurSimTime
        DoEvents
        Loop

    pmObject.EndSimulation
    Set pmObject = Nothing
End Sub
GetStatus

**Syntax:**  GetStatus

**Description:**  Gets the current state of a loaded model. Use this method to trap events triggered by ProModel or the user. Note: This method is easier to use than the Events Handler, but less robust and reliable. For instance, the GetStatus method will work fine for simple applications, but for more complicated situations, such as running a series of models, it would work better to use the event handler approach to avoid problems with timing issues.

**Parameters:**  None

**Returns:**  Long. Status code (0 – 9) of the loaded model.

**Status Codes:**

0. Status unknown
1. No model loaded
2. Loading a model
3. Model loaded
4. Load error
5. Translating model
6. Simulation in progress
7. Simulation or translation terminated prematurely
8. Simulation completed
9. Simulation frozen

**Example:**  This example starts the simulation for the loaded model and continuously checks the status. Then, when the status changes to 8 (normal completion), shows a message to let the user know it’s done.

```vba
Sub WhatsUp()
    Dim pmObject As ProModel.CProModel
    Dim vStatus As Long

    Set pmObject = CreateObject("ProModel")
    pmObject.Simulate
    vStatus = pmObject.GetStatus

    Do
        DoEvents
        vStatus = pmObject.GetStatus
    Loop Until vStatus = 8

    MsgBox "I'm done."
    Set pmObject = Nothing
End Sub
```
GetVersion

Syntax:  GetVersion

Description:  Returns the version of the product you are using. This could be used to make certain that the user's version of ProModel is recent enough to contain certain features.

Parameters:  None.

Returns:  (String)  Version number and build number shown in the 'Help > About' dialog box in ProModel.

Example:  This example opens ProModel then returns the version information to the variable.

Sub VerNum()
    Dim pmObject As ProModel.CProModel
    Dim pmVersion As String

    Set pmObject = CreateObject("ProModel")
    pmVersion = pmObject.GetVersion
    MsgBox "You are using version " & pmVersion
    Set pmObject = Nothing
End Sub
LoadDefaults

Syntax:  LoadDefaults ININame

Description:  Reloads the INI file, which contains the ProModel defaults. The INI name is ignored.

Parameters:

  ININame  The name of the INI file with the desired defaults.
LoadModel

**Syntax:** LoadModel FileName

**Description:** Loads the specified model.

**Parameters:**

- **FileName** (String) Any valid path and model filename. Model files must have a .mod extension.

**Returns:** Nothing

**Example:** This example loads a model, runs it for 30 minutes (1800 seconds), then terminates the simulation.

```vbscript
Sub QuitSimEarly()
    Dim pmObject As ProModel.CProModel
    Dim CurSimTime AS Double

    CurSimTime = 0
    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel ("C:\Program Files\ProModel\Models\Demos\mfg_cost.mod")
    pmObject.Simulate

    Do While CurSimTime < 1800
        pmObject.GetSimTime CurSimTime
        DoEvents
    Loop

    pmObject.EndSimulation

    Set pmObject = Nothing
End Sub
```
MenuCommand

Syntax:  MenuCommand CmdNum, lParam

Description:  Executes a specified menu option (as if the user had selected it).

Parameters:

CmdNum  (Long)  The ID number of the menu command you wish to use. See “Menu Ids” on page 121.

lParam  (Long)  For almost all MenuIDs, Parameter has no meaning, so a zero should be passed. For #4825 (Interactive Subroutine), Parameter will activate a specific subroutine. The number in Parameter refers to the order of the subroutine in the “Interact” list available during simulation, not its index number in the Subroutine table.

Returns:  Nothing

Example:  The following example loads a model, then opens the General Information dialog.

    Sub ChangeView()
        Dim pmObject As ProModel.CProModel
        Set pmObject = CreateObject("ProModel")
        pmObject.LoadModel ("C:\Program Files\ProModel\Models\Demos\mfg_cost.mod")
        pmObject.MenuCommand 2863, 0
        Set pmObject = Nothing
    End Sub
MergeModel

Syntax:  MergeModel FileName, Xpos, Ypos, Tag, Flags

Description: Merges the specified model into the currently loaded model. Model merging is useful when you wish to join sub models or fragmented model components to the original model.

Parameters:

FileName  (String)  The name of the file you wish to merge.
Xpos  (Double)  Horizontal placement of submodel (number of pixels over from left margin).
Ypos  (Double)  Vertical placement of submodel (number of pixels down from the top margin)
Tag  (String)  A label attached to the beginning or end of every identifier in the merged model.
Flags  (Long)  You can use flags to specify merge options such as whether to attach a tag to the beginning or end of identifiers, or whether or not to merge graphics libraries. Flags should be combined using the “Or” operator.

Returns:  (Long) Result of the merge operation (whether it was successful or not).

Flags:  When using more than one flag, use the keyword “Or” to connect, or simply add the values of the flags together, and enter that value for all flags.

2  Don’t prompt
8  Prefix tag (default is suffix)
16  Merge new model’s graphic library into the current model and save with original name
32  Merge new model’s graphic library into the current model and save as the original name plus the model tag
64  Just use the original model’s graphic library

Example:  This example loads a model, then merges in 24hrclck.mod at an offset of 20x20 pixels from the upper-left corner of the layout. All identifiers associated with the 24 hr. clock will have “sub_” added to the beginning.

Sub AddClock()
  Dim pmObject As ProModel.CProModel
  Dim MySubMod As String

  Set pmObject = CreateObject("ProModel")
  pmObject.LoadModel "C:\Program Files\ProModel\Models\Demos\mfg_cost.mod"
  MySubMod = "C:\Program Files\ProModel\Models\Demos\mfg_cost.mod"
  pmObject.MergeModel MySubMod, 175, 125, "sub_", 8 Or 64

  Set pmObject = Nothing
End Sub
**MsgBox**

**Syntax:** `MsgBox Message`

**Description:** Displays a message box containing the indicated text. The message box will display in ProModel. If you wait for a response from within Excel or a custom VB interface, you may not see the message box. This may delay operations while the dialog awaits a response.

**Parameters:**
- **Message** (String) The message you wish to display.

**Returns:** Nothing

**Example:** This example loads a model, then sends a message to the ProModel window that the user must clear before the next line of code will be executed.

```vba
Sub Hal()
    Dim pmObject As ProModel.CProModel

    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmObject.MsgBox "Good Morning, Dave."

    Set pmObject = Nothing
End Sub
```
New

Syntax: New

Description: Invokes the File/New command without launching the General Information Dialog.

Parameters: None

Returns: Nothing

Example: This example opens ProModel and loads a new (empty) model.

Sub NewMod()
    Dim pmObject As ProModel.CProModel

    Set pmObject = CreateObject("ProModel")
    pmObject.New

    Set pmObject = Nothing
End Sub
OpenModule

Syntax:  OpenModule Module

Description:  Opens a specific build module. A module is a table in the ProModel Build menu. Passing a zero (0) value will close any open modules.

Parameters:

Module (Long)  A module ID number from the list below.

Returns:  Nothing

Module ID Numbers:

0  No modules open
1  Locations
2  Arrivals
5  Entities
6  Resources
10  Variables
11  Attributes
12  Arrays
15  Function tables
16  Distribution tables
17  Cycle tables
18  Subroutines
19  Processing
24  Path Networks
25  Macros
26  Streams
27  External Files
34  Shift Assignments
36  Background Graphics (Behind grid)
37  Background Graphics (Front of grid)

Example:  This example loads a model, then opens the Entities module, as if the user had selected Build >> Entities.

Sub OpenEntMod()
    Dim pmObject As ProModel.CProModel
    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel "C:\Program Files\ProModel\Models\Demos\mfg_cost.mod"
    pmObject.OpenModule 5
    Set pmObject = Nothing
End Sub
Quit

Syntax: Quit

Description: Closes ProModel. The “Save Changes?” prompt will appear, if applicable.

Parameters: None

Returns: Nothing

Example: This example opens ProModel, then closes it.

    Sub ClosePM()
        Dim pmObject As ProModel.CProModel

        Set pmObject = CreateObject("ProModel")
        pmObject.Quit

        Set pmObject = Nothing
    End Sub
RedrawLayout

Syntax: RedrawLayout

Description: Refreshes the layout window. Useful when you add graphical objects via the ProModelData interface.

Parameters: None

Returns: Nothing

Example: The following examples loads a model, adds a location record, attaches a library graphic to the location, and redraws the layout.

Sub AddLoc()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim Xpos As Double
    Dim Ypos As Double

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    Xpos = 20
    Ypos = 20

    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmDataObject.Populate
    pmDataObject.AppendRecord pmdTblLocation
    pmDataObject.AppendGraphicIcon pmdTblLocation, 1, 1, Xpos, Ypos
    pmObject.RedrawLayout

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
RedrawTables

**Syntax:** RedrawTables

**Description:** Refreshes any open tables. When using the ProModel Data Object to update model data, if the table being update is open, the screen will not show the changes until RedrawTables is executed or the module is closed and re-opened.

**Parameters:** None

**Returns:** Nothing

**Example:** This example loads a model, adds a new record to the Entities table, then refreshes the table to show the new record.

```vba
Sub AddEnt()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmObject.OpenModule 5
    pmDataObject.Populate
    pmDataObject.AppendRecord pmdTblEntity
    pmDataObject.SetStringFieldValue pmdTblEntity, pmdFldEntName, "MyNewEntity"
    pmObject.RedrawTables

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
RunScenarios

Syntax: RunScenarios

Description: Runs scenarios defined in the model.

Parameters: None

Returns: Nothing

Example: This example loads a model, then runs the defined simulation scenarios.

    Sub MfgScenarios()
        Dim pmObject As ProModel.CProModel

        Set pmObject = CreateObject("ProModel")
        pmObject.LoadModel ("c:\promodel 2001\models\demos\mfg_cost.mod")
        pmObject.RunScenarios

        Set pmObject = Nothing
    End Sub
Save

**Syntax:**  Save

**Description:**  Saves any changes to the loaded model (to the same file).

**Parameters:**  None

**Returns:**  Nothing

**Example:**  This example loads a model, adds a new record to the Entities table, then saves the changes.

```sub AddEnt()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmDataObject.Populate
    pmDataObject.AppendRecord 2
    pmDataObject.SetStringFieldValue 2, 2, "MyNewEntity"
    pmObject.Save

    Set pmDataObject = Nothing
    Set pmObject = Nothing

End Sub```
SaveAs

**Syntax:**  `SaveAs ModelName`

**Description:**  Saves the loaded model to a specified file.

**Parameters:**

- `ModelName`  (String) Any valid model path & filename.

**Returns:**  Nothing

**Example:**  This example loads a model, adds a record to the Entities table, then saves the changes to a new file.

```vba
Sub SaveModAs()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmDataObject.Populate
    pmDataObject.AppendRecord 2
    pmDataObject.SetStringFieldValue 2, 2, "MyNewEntity"
    pmObject.SaveAs "c:\temp\mfg_cost_new.mod"

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
SetMacro

Syntax:  SetMacro Macro Name, Macro Value

Description:  Sets the value of a ProModel macro.

Parameters:

  MacroName  (String)  ID of any defined macro in loaded model.
  MacroValue  (String)  New value for specified macro.

Returns:  Nothing

Example:  This example loads a model, changes a macro value, then runs the simulation with the new value.

Sub Use3Ops()
  Dim pmObject As ProModel.CProModel

  Set pmObject = CreateObject("ProModel")
  pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
  pmObject.SetMacro "Number_of_Operators", 3
  pmObject.Simulate

  Set pmObject = Nothing
End Sub
SetMenus

Syntax:  SetMenus MenuSet, MenuOptions

Description:  Modifies the menu display within ProModel. Currently, only the options used in the example are implemented.

Parameters:

- MenuSet  (Long)  1 = Edit Menu Set, 2 = Simulation Menu
- MenuOptions  (Long)  1 = Minimal

Returns:  Nothing

Example:  The following example loads the mfg_cost.mod, sets the Simulation menu to minimal, then runs the simulation.  This will cause the menu during the simulation to show only “Simulation >> Pause/Resume” and “Help” options.

```vba
Sub RunMinMenu()
    Dim pmObject As ProModel.CProModel

    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmObject.SetMenus 2, 1
    pmObject.Simulate

    Set pmObject = Nothing
End Sub
```
SetMessageMode

Syntax: SetMessageMode Flags

Description: This method only applies to standard message boxes, it will have no effect on error mes- sages, translation dialog or data dialogs accessed from the menu. With this method you can control what types of messages to display or not to display. Types are based on which control buttons are shown in the message box. The type(s) included in the Flags parameter will be the only types shown, all others will execute the default option, without showing the message box. If you wish to execute a non-default option without showing the message box, you can do so through the ProModel Event Handler.

Parameters:

Flags (Long) See list of flags below.

Returns: Nothing

Flags: Flags can be combined using "+" or "OR", except for values 0 and 1.

0 Do not display any messages
1 Show Information messages
2 Show messages with OK button
4 Show messages with OK & Cancel buttons
8 Show messages with Retry & Cancel buttons
16 Show messages with Yes & No buttons
32 Show messages with Yes, No & Cancel buttons
64 Show messages with Abort, Retry and Ignore buttons
-1 Show All messages

Example: This example runs a simulation, then opens the output statistics module without prompting the user.

Sub SkipMessages()
    Dim pmObject As ProModel.CProModel

    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmObject.SetMessageMode 0
    pmObject.Simulate

    Set pmObject = Nothing
End Sub
SetPan

Syntax: SetPan x, y

Description: Moves the layout view so that the x-y coordinates specified are at the top left corner of the layout window (as if the user had moved the scroll bars).

Parameters:

- **x** (Double) Horizontal shift in pixels.
- **y** (Double) Vertical shift in pixels.

Returns: Nothing

Example: This example loads a model, then scrolls right 100 pixels and down 100 pixels.

```vba
Sub AutoScroll()
    Dim pmObject As ProModel.CProModel

    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmObject.SetPan 100, 100

    Set pmObject = Nothing
End Sub
```
SetView

Syntax:  SetView ViewName

Description:  Sets the layout window to display a specific view.

Parameters:
  ViewName  (String)  The name of the view you wish to display.

Returns:  Nothing

Example:  This example loads a model, then switches to the defined view.

Sub ShowFull()
  Dim pmObject As ProModel.CProModel

  Set pmObject = CreateObject("ProModel")
  pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
  pmObject.SetView "Full View"

  Set pmObject = Nothing
End Sub
SetViewRect

Syntax: SetViewRect Left, Top, Right, Bottom

Description: Zooms and pans the layout to allow the rectangle defined by the input coordinates to fill the layout window. Note: The x,y dimensions are always scaled equally.

Parameters:
- **Left** (Double) The left boundary.
- **Top** (Double) The top boundary.
- **Right** (Double) The right boundary.
- **Bottom** (Double) The bottom boundary.

Example: This example loads a model, then sets the layout window to show the section from x-y coordinates (30, 40) to (100, 200).

```vba
Sub NewPosition()
    Dim pmObject As ProModel.CProModel
    pmObject = CreateObject("ProModel")
    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmObject.SetViewRect 30, 40, 100, 200
    Set pmObject = Nothing
End Sub
```
SetWindowPos

**Syntax:**  SetWindowPos Window, xPos, yPos, xSize, ySize, Flags

**Description:** Defines the position, size and style of the application window or the layout window. The application window position is relative to the screen, other layout window is relative to the application window.

**Parameters:**
- **Window** (Long) Identifies the window (1 = layout window, 2 = application window).
- **xPos, yPos** (Long) Determine the position of the window.
- **xSize, ySize** (Long) Determine the size of the window.
- **Flags** (Long) If xSize or ySize is zero, SetWindowPos calls the Windows API function ShowWindow and passes the flags.

**Window Types:**
- 1 Layout window
- 2 Application window

**Flags:**
- -1 Original Style
- 0 Hide
- 1 Normal
- 2 Minimize
- 3 Maximize
- 9 Restore

**Returns:** Nothing

**Example:** This example loads a model, ensures that ProModel is running maximized, then moves the layout window near the top left corner of the ProModel screen.

```vba
Private Sub CommandButton2_Click()
    Dim pmObject As ProModel.CProModel
    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
    pmObject.SetWindowPos 2, 0, 0, 0, 0, 3
    pmObject.SetWindowPos 1, 10, 10, 700, 500, 0
    Set pmObject = Nothing
End Sub
```
ShowTranslationDlg

Syntax:  ShowTranslationDlg Status

Description:  Shows or hides the translation dialog.

Parameters:

   Status    (Boolean) True displays the dialog, False hides the dialog.

Returns:  Nothing

Example:  This example loads a model, sets the option to hide the Translation dialog, then runs the simulation.

Sub HideIt()
   Dim pmObject As ProModel.CProModel

   Set pmObject = CreateObject("ProModel")
   pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
   pmObject.ShowTranslationDlg False
   pmObject.Simulate

   Set pmObject = Nothing
End Sub
Simulate

**Syntax:**  Simulate

**Description:**  Starts the simulation.

**Parameters:**  None

**Returns:**  Nothing

**Example:**  This example loads a model, runs it for 30 minutes (1800 seconds), then terminates the simulation.

```vba
Sub Simlt()
    Dim pmObject As ProModel.CProModel
    Dim CurSimTime AS Double

    Set pmObject = CreateObject("ProModel")
    pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
    pmObject.Simulate
    CurSimTime = 0
    Do While CurSimTime < 1800
        pmObject.GetSimTime CurSimTime
        DoEvents
    Loop
    pmObject.EndSimulation

    Set pmObject = Nothing
End Sub
```
Zoom

**Syntax:**  Zoom PercentZoom

**Description:**  Sets the zoom percentage of the model.  Passing a zero (0) in the PercentZoom parameter shrinks or expands the model to fit the layout window.

**Parameters:**
- PercentZoom  (Double)  1 = 100%, 0.75 = 75%, etc.

**Returns:**  Nothing

**Example:**  This example loads a model, then shows the layout 90 % of the original size.

```vba
Sub ShrinkIt()
  Dim pmObject As ProModel.CProModel
  Dim ZoomPercent As Double
  ZoomPercent = 0.9
  Set pmObject = CreateObject("ProModel")
  pmObject.LoadModel "c:\promodel 2001\models\demos\mfg_cost.mod"
  pmObject.Zoom ZoomPercent

  Set pmObject = Nothing
End Sub
```
Chapter 2: The ProModel Events Object

The PMEvents object is found in the ProModel Events 2.0 Type Library. This object provides methods for trapping and responding to certain events that happen in ProModel. The PMEvents object must be initialized by the GetEventsObject method found in the ProModel object. In Visual Basic, you must declare this object variable using the WithEvents keyword. When this is done, Visual Basic will automatically create a new entry in the Object drop-down list box in the module where the object variable was declared (you do not need to manually declare the Event Handler function). Within the Event Handler function, you will place code to respond to events returned by ProModel to your application. You may modify the default behavior of some events by returning ‘True’ from your Event Handler method.

• PmEventsHandler

• AnimSpeedChange
• InputTextPrompt
• ListSelectPrompt
• RunError
• TranslationError
• UserZoom
**PMEventsHandler**

To use the ProModel Events Handler, add a reference to the ProModel Events 2.0 Type Library (*pmcp53.dll* typically found in your “C:\Program Files\Common Files\PROMODEL Shared\Components” folder). Then, add the following to the Class Module¹ where you will be calling the GetEvents method of the ProModel Object.

```vbnet
Private WithEvents pmEventsObject As PMCPLib.PmEvents
```

That will place a `pmEventsObject` variable in the Object drop-down list, and a procedure called `PmEventsHandler` in the Procedure/Events drop-down list at the top of the Code Window.

When you select the object variable (pmEventsObject) from the Object drop-down list and PmEventsHandler from the Procedure/Events drop-down list, it will create a function called `pmEventsObject_PmEventsHandler` in your Code Window. In this function, you will create “If…Then” or “Select Case” statements to handle event codes returned to your program by ProModel.

A list of Events that the PMEventsHandler handles can be found on page 119.

**Example:**

```vbnet
Private Function pmEventsObject_PmEventsHandler(ByVal PmEventID As Long, ByVal Description As String) As Long
    Select Case PmEventID
        Case 2: ' PmEvtSaveBeforeQuit
            pmEventsObject_PmEventsHandler = True skip save
        Case Else:
            Debug.Print PmEventID & " " & Description show event in immediate 'window
    End Select
End Function
```

To activate the event handler in your program, include the ProModel Object GetEvents method at the beginning of your code.

**Example:**

```vbnet
Private Sub CommandButton1_Click()
    Dim pmObject As ProModel.CProModel
    Set pmObject = CreateObject("ProModel")
    Set pmEventsObject = pmObject.GetEventsObject
    ...
```

---

¹. **class module**: A module that contains the definition of a class, including its property and method definitions.
Once the Events Object has been “Set”, as above, it will work on it’s own. So, any event that you want to “handle” differently than the default ProModel action, you will place the code for it in the pmEventsObject_PmEventsHandler function.
AnimSpeedChange

**Syntax:**  
`ObjectVariable_AnimSpeedChange(ByVal Speed As Long) As Long`

**Description:**  
This event occurs whenever animation speed is changed by the user, by ANIMATE command encountered in model code, or via COM interface (VB program code).

**Parameters:**

- **Speed** (Long) – Integer from 0 through 100 representing the relative setting of the animation speed control. This number corresponds to the values used in ANIMATE statements in models and the values set and returned by SetAnimationSpeed and GetAnimationSpeed methods of the Runtime object.

**Returns:**  
Not used yet.

**Example:**  
The code below will place descriptive text and the new animation speed into a textbox each time the animation speed is changed (e.g. – “Animation speed changed to 39”).

```vbnet
Private Function pmEventsObject_AnimSpeedChange(ByVal Speed As Long) As Long
    Textbox1.Text = Textbox1.Text & "Animation speed changed to " & Speed & VBCRLF
End Function
```
Chapter 2: InputTextPrompt

Syntax:  \texttt{ObjectVariable\_InputTextPrompt(ByVal Message As String, ByVal Default As String, Value As String, ByVal Flags As Long) As Long}

Description: The \texttt{PROMPT} statement in ProModel can be defined either as a simple prompt/response dialog box or as a list of options to choose from. This event fires whenever a simple \texttt{PROMPT} statement is encountered in the model logic. Use the \texttt{ListSelectPrompt} event to handle \texttt{PROMPT} statements defined as choice lists.

Parameters:
- \texttt{Message} (String) – Message to the user, describing the meaning and asking for a value
- \texttt{Default} (String) – Text shown in the edit field of the dialog (before user changes it)
- \texttt{Value} (String) – Variable to hold value given by user
- \texttt{Flags} (Long) – Not Used

Returns:
- 0 = Use the default value
- 1 = Set the variable to the value in \texttt{Value} parameter
- 2 = Show the prompt dialog and let the user enter a value
- 3 = Abort the simulation

Example: In the following example we start with the form shown below:

```
Private Function pmEventsObject\_InputTextPrompt(ByVal Message As String, _
    ByVal Default As String, ByVal Value As String, ByVal Flags As Long) As Long
    Label1.Caption = "Prompt: " & Message
    Textbox1.Text = Default
    If OptionButton(0).Value = True Then  
        pmEventsObject\_InputTextPrompt = 0  'Use default
    ElseIf OptionButton(1).Value = True Then
        Value = Textbox2.Text
        pmEventsObject\_InputTextPrompt = 1  'Use value from textbox2
    ElseIf OptionButton(2).Value = True Then
        pmEventsObject\_InputTextPrompt = 2  'Show standard prompt
    Else
        pmEventsObject\_InputTextPrompt = 3  'Abort simulation
```
End If
End Function
ListSelectPrompt

Syntax:  

\[ \text{ObjectVariable} \_\text{ListSelectPrompt}(\text{ByVal Message As String, ByVal MenuItemCount As Long, psaLabels() As String, psaValues() As Double, Choice As Long, ByVal Flags As Long}) \text{ As Long} \]

Description:  The PROMPT statement in ProModel can be defined either as a simple prompt/response dialog box or as a prompt dialog with a list of options to choose from. This event fires whenever a PROMPT statement defined as a choice list is encountered in the model logic. Use the InputTextPrompt event to handle simple PROMPT statements.

Parameters:

- **Message** (String) – Message to the user, describing the meaning of parameter being prompted for, values provided, etc.
- **MenuItemCount** (Long) – Number of items in menu
- **psaLabels** – array of strings representing menu items
- **psaValues** – array of real numbers (double) representing values that correspond to each menu item
- **Choice** – zero-based index of the menu item to return to application
- **Flags** (Long) – Not Used

Returns:

- 0 = Use the first value
- 1 = Set the variable to the value in Choice parameter
- 2 = Show the prompt dialog and let the user enter a value
- 3 = Abort the simulation

Example: In the following example we start with the form shown below:

```vbnet
Private Function pmEventsObject_ListSelectPrompt(ByVal Message As String, ByVal MenuItemCount As Long, psaLabels() As String, psaValues() As Double, Choice As Long, ByVal Flags As Long) As Long
    Dim i As Integer
    Label1.Caption = "Prompt: " & Message
    Textbox1.Text = ""
    For i = 0 To MenuItemCount - 1
        Textbox1.Text = Textbox1.Text & i & ") " & psaLabels(i) & ") " & psaValues(i) & vbCrLf
    Next
```

[Form image]

```vbnet
Private Function pmEventsObject_ListSelectPrompt(ByVal Message As String, ByVal MenuItemCount As Long, psaLabels() As String, psaValues() As Double, Choice As Long, ByVal Flags As Long) As Long
    Dim i As Integer
    Label1.Caption = "Prompt: " & Message
    Textbox1.Text = ""
    For i = 0 To MenuItemCount - 1
        Textbox1.Text = Textbox1.Text & i & ") " & psaLabels(i) & ") " & psaValues(i) & vbCrLf
    Next
```
Next i

If OptionButton(0).Value = True Then
    pmEventsObject_ListSelectPrompt = 0  'Use first value
ElseIf OptionButton(1).Value = True Then
    Choice = Textbox2.Text
    pmEventsObject_ListSelectPrompt = 1  'Use value from textbox2
ElseIf OptionButton(2).Value = True Then
    pmEventsObject_ListSelectPrompt = 2  'Show standard prompt
Else
    pmEventsObject_ListSelectPrompt = 3  'Abort simulation
End If

End Function
RunError

**Syntax:**  \texttt{ObjectVariable\_RunError(ByVal ErrorID As Long, ByVal Description As String, ByVal Flags As Long) As Long}

**Description:** This event fires whenever an error is encountered during simulation. This allows you to handle specific types of errors in different ways.

**Parameters:**

- **ErrorID** (Long) – error code generated by ProModel
- **Description** (String) – text description of error generated by ProModel
- **Flags** (Long) – Type of error: 1 = Recoverable, 2 = Fatal

**Returns:**

- 0 = Ignore & continue with simulation, if possible
- 1 = Abort simulation
- 2 = Show error message & allow user to determine how to handle error

**Example:**

```vba
Private Function pmEventsObject\_RunError(ByVal ErrorID As Long, ByVal Description As String, ByVal Flags As Long) As Long
    Select Case Flags
        Case 1:
            pmEventsObject\_RunError = 2
        Case 2:
            pmEventsObject\_RunError = 1
    End Select
End Function
```
**TranslationError**

**Description:** This event occurs whenever an error is encountered during model translation (just before simulation begins).

**Syntax:** 
```vba
ObjectVariable_TranslationError(ByVal ErrorID As Long, ByVal Description As String, ByVal Flags As Long) As Long
```

**Parameters:**

- *ErrorID* (Long) – error code generated by ProModel
- *Description* (String) – text description of error generated by ProModel
- *Flags* (Long) – Type of error: 1 = Recoverable, 2 = Fatal

**Returns:**

- 0 = Ignore & continue with translation
- 1 = Abort translation
- 2 = Show translation status dialog & allow user to determine how to handle error

**Example:**

```vba
Private Function PMEventObj_TranslationError(ByVal ErrorID As Long, ByVal Description As String, ByVal Flags As Long) As Long
  Select Case Flags
    Case 1:
      pmEventsObject_RunError = 2
    Case 2:
      pmEventsObject_RunError = 1
  End Select
End Function
```
UserZoom

**Description:** Fired when zoom setting of the layout window is changed, either by explicit zoom or by changing views.

**Syntax:** `ObjectVariable_UserZoom (ByVal ZoomPercent As Double) As Long`

**Parameters:**

- **ZoomPercent** (Double) – Factor by which the layout is magnified, 1 = 100%

**Returns:** Not used

**Example:**

```vbnet
Private Function PMEventObj_UserZoom(ByVal ZoomPct As Double) As Long
    MsgBox("Zoomed to " & ZoomPct * 100 & ")
End Function
```
Chapter 3:
The ProModel Runtime Object

(ProModel.CRuntime)

The ProModel Runtime object is found in the ProModel Type Library. If you do not see this library in your references list, you will need to run PM.exe with the “/regserver” command line option.

Using the ProModel Runtime object you can access the statistics generated while a simulation is running, similar to using the Dynamic Plots from the ProModel interface. The methods for this object not only allow you to get the statistics values, but you can set new values for variables while the simulation is running.

The Runtime object has the following methods:

• GetAnimationState
• GetAnimationSpeed
• GetStatValue
• SetAnimationState
• SetAnimationSpeed
• SetStatValue
GetAnimationState

**Syntax:**  `GetAnimationState State`

**Description:**  Gets the current state of the animation, whether ON or OFF.

**Parameters:**

- `State`  (Long)  Zero (0) if animation is off, one (1) if animation is on.

**Returns:**  Long - Zero (0) if animation is off, one (1) if animation is on.

**Example:**

```vba
Dim AnimState as Long
Dim pmRun as Promodel.CRuntime

pmObj.Simulate
pmRun.GetAnimationState AnimState
MsgBox "Animation is " & IIF(AnimState = 0, "off", "on")

Set pmObj = nothing
Set pmRun = nothing
```
GetAnimationSpeed

**Syntax:** GetAnimationSpeed Speed

**Description:** Gets the current value … When using GetAnimationSpeed and SetAnimationSpeed, the numeric value of a given speed may be slightly different for each method (because of rounding).

**Parameters:**
- Speed (Long) Numeric value representing animation speed (1 to 100).

**Returns:** Long - Numeric value representing animation speed (1 to 100).

**Example:**
```
Dim AnimSpeed as Long
Dim pmRun as Promodel.CRuntime

pmObj.Simulate
pmRun.GetAnimationState AnimSpeed
MsgBox "Animation Speed is " & AnimSpeed

Set pmObj = nothing
Set pmRun = nothing
```
GetStatValue

Syntax: GetStatValue TableID, RecordNum, StatID, SubRec, Value

Description: Gets the current value for the specified statistics element.

Parameters:

- **TableID** (Long)  Table (Section) Number containing the data element you wish to retrieve.
- **RecordNum** (Long)  Record (Row) Number containing the data element you wish to retrieve.
- **StatID** (Long)  Statistic element you wish to retrieve.
- **SubRec** (Long)  For Resource Stats > Unit Number (0 = parent); For Node Entry Stats > Node Index; For Failed Arrivals > RecordNum = Entity Index, SubRec = Location Index
- **Value** (Double)  Variable or object in which to place the statistics value retrieved.

Returns: The numeric value of the statistic element at the moment the method is executed. The value will be placed in the variable or object specified in the Value parameter.

Example: This example loads Receive.mod, runs the simulation, then pauses 3 times at 30 minute intervals and displays the Current Contents of the Pallet_Storage location, then ends the simulation.

Sub ShowSomeStats()
    Dim pmObject As ProModel.CProModel
    Dim pmRuntime As ProModel.CRuntime
    Dim CurSimTime As Double
    Dim MyStatVal As Double

    CurSimTime = 0
    Set pmObject = CreateObject("ProModel")
    Set pmRuntime = CreateObject("Promodel.CRuntime")
    pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\receive.mod")
    pmObject.Simulate

    Do While CurSimTime < 1800
        pmObject.GetSimTime CurSimTime
        DoEvents
    Loop

    pmObject.MenuCommand 4816, 0
    pmRuntime.GetStatValue 1, 21, 5, MyStatVal
    pmObject.MsgBox MyStatVal
    pmObject.MenuCommand 4816, 0

    Do While CurSimTime < 3600
        pmObject.GetSimTime CurSimTime
        DoEvents
    Loop

    pmObject.MenuCommand 4816, 0 'Pauses Simulation
    pmRuntime.GetStatValue 1, 21, 5, MyStatVal
    pmObject.MsgBox MyStatVal
    pmObject.MenuCommand 4816, 0 'Resumes Simulation

    Do While CurSimTime < 5400
        pmObject.GetSimTime CurSimTime
        DoEvents
    Loop
Loop

pmObject.MenuCommand 4816, 0
pmRuntime.GetStatValue 1, 21, 5, MyStatVal
pmObject.MsgBox MyStatVal
pmObject.MenuCommand 4816, 0

pmObject.EndSimulation
Set pmObject = Nothing
End Sub
SetAnimationState

Syntax: GetStatValue State

Description: Gets the current value …

Parameters:
  State (Long) …

Returns: Long - Zero (0) if animation is off, one (1) if animation is on.

Example:
SetAnimationSpeed

Syntax:  GetStatValue Speed

Description:  Gets the current value ... When using GetAnimationSpeed and SetAnimationSpeed, the numeric value of a given speed may be slightly different for each method.

Parameters:

   Speed       (Long) ...

Returns:  Long - Numeric value representing animation speed (1 to 100).

Example:
SetStatValue

Syntax:  SetStatValue TableID, RecordNum, StatID, SubRec, NewVal

Description:  Changes the current value for the specified statistics element.  To set variable values, use TableID 12, StatID 5.

Parameters:

- TableID  (Long) Table (Section) Number containing the data element you wish to set.
- RecordNum  (Long) Record (Row) Number containing the data element you wish to set.
- StatID  (Long) Statistic element you wish to set.
- SubRec  (Long) For Resource Stats > Unit Number (0 = parent); For Node Entry Stats > Node Index;  For Failed Arrivals > RecordNum = Entity Index, SubRec = Location Index
- NewVal  (Double) New value for the specified statistics element.

Returns:  Nothing.

Example:  This example loads Receive.mod, runs the simulation, sets the value variable 1 to zero after 30, 60 and 90 minutes of simulation, then ends the simulation.

```
Sub ResetStats()
  Dim pmObject As ProModel.CProModel
  Dim pmRuntime As ProModel.CRuntime
  Dim CurSimTime As Double

  CurSimTime = 0
  Set pmObject = CreateObject("ProModel")
  Set pmRuntime = CreateObject("Promodel.CRuntime")
  pmObject.LoadModel("C:\ProModel 2001\Models\Demos\receive.mod")
  pmObject.Simulate

  Do While CurSimTime < 1800
    pmObject.GetSimTime CurSimTime
    DoEvents
    Loop
  pmRuntime.SetStatValue 1, 12, 5, 0

  Do While CurSimTime < 3600
    pmObject.GetSimTime CurSimTime
    DoEvents
    Loop
  pmRuntime.SetStatValue 1, 12, 5, 0

  Do While CurSimTime < 5400
    pmObject.GetSimTime CurSimTime
    DoEvents
    Loop
  pmRuntime.SetStatValue 1, 12, 5, 0

  pmObject.EndSimulation
  Set pmObject = Nothing
End Sub
```
Chapter 4:
The ProModel Data Object

(ProModel.CProModelData)

The ProModelData object is found in the ProModel Type Library. If you do not see this library in your references list, you will need to run PM.exe with the “/regserver” command line option.

This object provides access to your model data, such as Locations, Subroutines, etc. The ProModelData object must be initialized by the Populate method. With the methods listed below, you can read your model information, change it, even delete it. This is a powerful tool and must be used with caution. It is a good idea to always make a backup copy of your original model before using the ProModelData object to make changes.

- AddBackgroundBitmap
- AppendEntitySpot
- AppendGraphicIcon
- AppendGraphicIconSize
- AppendRecord
- AppendRoutingPoint
- DeleteRecord
- GetIntFieldValue
- GetRealFieldValue
- GetRecordCount
- GetSelectedsFromType
-GetStringFieldValue
- InsertRecord
- Populate
- SelectMainRecordByIndex
- SelectMainRecordByName
- SetIntFieldValue
- SetRealFieldValue
- SetStringFieldValue
**AddBackgroundBitmap**

**Syntax:**  AddBackgroundBitmap RecordType, Filename, Xpos, Ypos, Percent  

**Description:**  Adds the bitmap in the specified file to the background of the current model. When adding more than one bitmap, they are placed one on top of the other, so be sure to add the one(s) in back first. It is best to use the ProModel object’s Zoom method to set the zoom to 100% before adding any graphics. You may also want to use the RedrawLayout method after adding new graphics (they may not show until you do).

**Parameters:**

- **RecordType**  (Long)  49 - Background Graphics Table, is the only value allowed.
- **Filename**  (String)  Path & filename of Bitmap, Windows Metafile or Enhanced Metafile.
- **Xpos**  (Double)  How far (in pixels) from the left margin of the layout to place the left edge of the bitmap.
- **Ypos**  (Double)  How far (in pixels) from the top margin of the layout to place the top edge of the bitmap
- **Percent**  (Double)  Factor by which bitmap will be compressed or expanded from its original size. (1.0 = 100%)

**Example:**  The following example creates a new model, ensures that the zoom is set to 100%, then adds a background bitmap.

```vba
Sub AddGfx()
    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmDataObject.Populate
    pmObject.Zoom
    pmDataObject.AddBackgroundBitmap 49, "C:\ProModel 2001\Models\Training\pm_prac.bmp", 3, 3, 1
    pmObject.RedrawLayout
    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
AppendEntitySpot

Syntax:  AppendRecord RecordIndex, XPosition, YPosition

Description:  Appends an Entity Spot graphic to an existing Location record.

Parameters:

- **RecordIndex** (Long)  The Record Index (Row Number) of the Location you wish to add an Entity Spot to.
- **XPosition** (Double)  Number of pixels over from the left margin of the layout to place the entity spot.
- **YPosition** (Double)  Number of pixels down from the top margin of the layout to place the entity spot.

Example:  This example loads the mfg_cost model, adds a record to the Locations table, names the new location & gives it an Entity Spot graphic icon.

Sub AddGfx()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim recnum As Long
    Dim fieldnum As Long
    Dim subtable As Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.AppendRecord 1
    pmDataObject.GetRecordCount 1, recnum
    pmDataObject.SetStringFieldValue 1, 2, "My_New_Loc"
    pmDataObject.AppendEntitySpot recnum, 45, 90

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub

Note:  An entity spot can also be added by appending a location graphic record and changing the type field to Entity Spot (type 7).  See "Working with Graphics" on page 6.
AppendGraphicIcon

**Syntax:**  AppendGraphicIcon RecordType, RecordIndex, GraphicNumber, XPos, YPos

**Description:**  Appends a graphic to an existing Location, Entity or Resource record, without changing its size.

**Parameters:**
- **RecordType**  (Long)  The Record Type (Table Number) of the table you wish to work with.
- **RecordIndex**  (Long)  The Record Index (Row Number) of the Location, Entity or Resource you wish to add a graphic icon to.
- **GraphicNumber**  (Long)  Index number of a graphic icon in the Graphics Library specified in the General Information dialog of the loaded model. Keep in mind that the numbers are not necessarily sequential, there may be gaps.
- **XPos**  (Double)  Number of pixels from the left margin to place the graphic icon.
- **YPos**  (Double)  Number of pixels from the top margin to place the graphic icon.

**Example:**  This example loads a model, adds a record to the Locations table, then appends a graphic icon to the new record.

```vba
Sub AddGfx()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim recnum As Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmDataObject.Populate

    pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
    pmDataObject.AppendRecord 1
    pmDataObject.GetRecordCount 1, recnum
    pmDataObject.SetStringFieldValue 1, 2, "My_New_Loc"
    pmDataObject.AppendGraphicIcon 1, recnum, 10, 100, 50

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
AppendGraphicIconSize

**Syntax:**  AppendGraphicIconPercent RecordType, RecordIndex, GraphicNumber, Xpos, Ypos, Xsize, Ysize

**Description:**  Appends a graphic to an existing Location, Entity or Resource record. This method lets you specify the size of the graphic as a percentage of its original size.

**Parameters:**

- **RecordType** (Long)  The Record Type (Table Number) of the table you wish to work with.
- **RecordIndex** (Long)  The Record Index (Row Number) of the Location, Entity or Resource you wish to add a graphic icon to.
- **GraphicNumber** (Long)  Index number of a graphic icon in the Graphics Library specified in the General Information dialog of the loaded model. Keep in mind that the numbers are not necessarily sequential, there may be gaps.
- **Xpos** (Double)  Number of pixels from the left margin to place the graphic icon.
- **Ypos** (Double)  Number of pixels from the top margin to place the graphic icon.
- **Xsize** (Double)  Width in pixels.
- **Ysize** (Double)  Height in pixels.

**Example:**  This example loads a model, adds a record to the Locations table, then appends a graphic icon to the new record and makes it 50 x 50 pixels.

```
Sub AddGfx()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim recnum As Long
    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmDataObject.Populate
    pmObject.LoadModel("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
    pmDataObject.AppendRecord 1
    pmDataObject.GetRecordCount 1, recnum
    pmDataObject.SetStringFieldValue 1, 2, "My_New_Loc"
    pmDataObject.AppendGraphicIconSize 1, recnum, 10, 100, 50, 50

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
AppendRecord

Syntax:  AppendRecord RecordType

Description:  Adds a new record to the end of the specified table.  When using AppendRecord, you may use the Set...FieldValue methods without first calling the SelectRecordBy… method.  However, if you are using a method that requires the Record Index number as a parameter, you will need to get that number with the GetRecordCount method (or any other method that returns that information).

Parameters:

  RecordType  (Long)  The Record Type (Table Number) of the table you wish to add a record to.

Example:  This example loads the mfg_cost model, adds a new record to the Locations table, and then changes the location name to My_New_Loc.

Sub AppRec()
  Dim pmObject As ProModel.CProModel
  Dim pmDataObject As ProModel.CProModelData

  Set pmObject = CreateObject("ProModel")
  Set pmDataObject = CreateObject("ProModelData")

  pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
  pmDataObject.Populate
  pmDataObject.AppendRecord 1
  pmDataObject.SetStringFieldValue 1, 2, "My_New_Loc"

  Set pmDataObject = Nothing
  Set pmObject = Nothing
End Sub
AppendRoutingPoint

Syntax:  AppendRoutingPoint XPosition, Yposition

Description:  Adds a new Routing Point and connects the previous end point to the new point.  You must first select the Processing and Routing records you wish to append the new Routing Point to.

Parameters:

- Xposition  (Double)  Number of pixels from the left margin of the layout to place the Routing Point.
- Yposition  (Double)  Number of pixels from the top margin of the layout to place the Routing Point.

Example:  The following example loads the mfg_cost model, selects the first processing record, then selects the second routing record for that process and adds a new point.

Sub AddAPoint()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    PmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.SelectMainRecordByIndex 19, 1
    pmDataObject.SelectMainRecordByIndex 20, 2
    pmDataObject.AppendRoutingPoint 125, 90

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
DeleteRecord

Syntax: DeleteRecord RecordType

Description: Deletes the currently selected record from the specified table. Be very careful when using this method, because it will delete records without any data integrity checking. This means that even if the record is referenced by a record in another table, it will be deleted and make the other record invalid.

Parameters:

RecordType (Long) The Record Type (Table Number) of the table you wish to delete a record from.

Example: The following example deletes all records from the Locations table in the mfg_cost model. Be careful with this one, or you could disable the mfg_cost demo model if you then save it.

Sub EmptyLocs()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim rec_count As Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
    pmDataObject.Populate

    pmDataObject.GetRecordCount 1, rec_count
    For x = 1 To rec_count
        pmDataObject.SelectMainRecordByIndex 1, 1
        pmDataObject.DeleteRecord 1
    Next x

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
GetIntFieldValue

**Syntax:** GetIntFieldValue *RecordType, FieldNumber, FieldValue*

**Description:** Returns the value of the specified integer field from the selected record.

**Parameters:**

- **RecordType** (Long) The Record Type (Table Number) of the table you wish to work with.
- **FieldNumber** (Long) The field (column) number in the specified table from which you want to return a value.
- **FieldValue** (Long) Data value contained in the specified field for the selected record. This must be a variable.

**Example:** The following example gets the value of the Default Time units from the mfg_cost model, then displays a message with that information.

```vbs
Sub GetTimeUnits()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim TimeUnit As Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.SelectMainRecordByIndex 18, 1
    pmDataObject.GetIntFieldValue 18, 2, TimeUnit

    Select Case TimeUnit
        Case 1:
            pmObject.MsgBox ("Default Time Units:  Seconds")
        Case 2:
            pmObject.MsgBox ("Default Time Units:  Minutes")
        Case 3:
            pmObject.MsgBox ("Default Time Units:  Hours")
        Case 4:
            pmObject.MsgBox ("Default Time Units:  Days")
        Case Else:
            pmObject.MsgBox ("Error")
    End Select

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
GetRealFieldvalue

Syntax: GetRealFieldvalue RecordType, FieldNumber, FieldValue

Description: Returns the value of the specified real number field from the selected record.

Parameters:

- **RecordType** (Long) The Record Type (Table Number) of the table you wish to work with.
- **FieldNumber** (Long) The field (column) number in specified table from which you want to return a value.
- **FieldValue** (Long) Data value contained in the specified field for the selected record. This must be a variable.

Example: The following example selects the second routing record (not necessarily the second routing block) of the first processing record, gets the Probability value and displays it in a message box.

```vbnet
Sub SetRoutingProbability()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim ProbValue As Double

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\Orders.mod"
    pmDataObject.Populate
    pmDataObject.SelectMainRecordByIndex 19, 1
    pmDataObject.SelectMainRecordByIndex 20, 2
    pmDataObject.GetRealFieldValue 20, 13, ProbValue
    pmObject.MsgBox "Probability = " & ProbValue

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
GetRecordCount

Syntax: GetRecordCount RecordType, Count

Description: Returns the current number of records in the specified table. This is very useful in looping through each record in a table of unknown size.

Parameters:

- **RecordType** (Long) The Record Type (Table Number) for which you want the record count.
- **Count** (Long) Returns the number of records in the specified table.

Example: The following example loads the mfg_cost model, gets the record count from the Locations table, then displays a message telling the user how many locations there are.

```vba
Sub HowManyLocs()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim rec_count As Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel ("C:\ProModel 2001\Models\Demos\mfg_cost.mod")
    pmDataObject.Populate

    pmDataObject.GetRecordCount 1, rec_count

    If rec_count = 1 Then
        pmObject.MsgBox "There is 1 location in this model"
    Else
        pmObject.MsgBox "There are " & rec_count & " locations in this model"
    End If

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
Chapter 4: GetSelectedsFromType

GetSelectedsFromType

Syntax: GetSelectedsFromType RecordType, MainIndex, Field, SubIndex

Description: Returns record index values for the currently selected main and sub records.

Parameters:

- **RecordType** (Long) The Record Type (Table Number) of the table you want to work with.
- **MainIndex** (Long) Returns Record Index (row number) of the currently selected record.
- **Field** (Long) Although this parameter is no longer used, it is still required. It returns -1.
- **SubIndex** (Long) Although this parameter is no longer used, it is still required. It returns -1.

Example: The following example loads the mfg_cost model, finds the “Inspect” location and displays a message telling the user what the index number is for that record.

```vba
Sub WhatsMyIndex()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim recnum As Long
    Dim fieldnum As Long
    Dim subrec As Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.SelectMainRecordByName 1, "Inspect"
    pmDataObject.GetSelectedsFromType 1, recnum, fieldnum, subrec
    pmObject.MsgBox "Location <Inspect> is Record Index #" & recnum

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
GetStringFieldValue

Syntax:  GetStringFieldValue RecordType, FieldNumber, FieldValue

Description:  Returns the value of the specified string field from the selected record.

Parameters:

- **RecordType**  (Long)  The Record Type (Table Number) of the table you want to work with.
- **FieldNumber**  (Long)  The field (column) number in specified table from which you want to return a value.
- **FieldValue**  (Long)  Data value contained in the specified field for the selected record. This must be a variable.

Example:  The following example steps through the Macros table, gets the name and value of each macro, then displays a message with that information.

```vba
Sub GetMacros()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim i As Integer
    Dim RecCount As Long
    Dim MacName As String
    Dim MacText As String

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.GetRecordCount 11, RecCount

    For i = 1 To RecCount
        pmDataObject.SelectMainRecordByIndex 11, i
        pmDataObject.GetStringFieldValue 11, 1, MacName
        pmDataObject.GetStringFieldValue 11, 2, MacText
        pmObject.MsgBox (MacName & " : " & MacText)
        Next i

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
InsertRecord

Syntax:  InsertRecord RecordType

Description:  Inserts a new record before the selected record in the table. The newly inserted record will already be selected, so there is no need to use the SelectMainRecordBy… methods before populating the data.

Parameters:

RecordType (Long)  The Record Type (Table Number) of the table you wish to insert the record into.

Example:  The following example loads the mfg_cost model, finds the “Inspect” location and inserts a new record before it, then selects the new record & gives it a name.

Sub AddALoc()
   Dim pmObject As ProModel.CProModel
   Dim pmDataObject As ProModel.CProModelData

   Set pmObject = CreateObject("ProModel")
   Set pmDataObject = CreateObject("ProModelData")

   pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
   pmDataObject.Populate

   pmDataObject.SelectMainRecordByName 1, "Inspect"
   pmDataObject.InsertRecord 1
   pmDataObject.SetStringFieldValue 1, 2, "My_New_Loc"
   pmObject.MsgBox "Done"

   Set pmDataObject = Nothing
   Set pmObject = Nothing
End Sub
Populate

Syntax: Populate

Description: Populates the ProModelData object with the current, loaded model data. Call this method before using the data object. You must call the Populate method to initialize the ProModelData object with the model's current information. Use Populate each time you open or close a model, or if you add or remove records.

Example: This example loads the mfg_cost model and populates the ProModelData object.

```
Sub AddALoc()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate
    pmObject.MsgBox "ProModelData object populated"

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
SelectMainRecordByIndex

**Syntax:** SelectMainRecordByIndex *RecordType*, *RecordIndex*

**Description:** Selects a record by its Record Index (row number). This method is very useful in looping through all the records in a table.

**Parameters:**
- **RecordType** (Long) The Record Type (Table Number) of the table you wish to work with.
- **RecordIndex** (Long) The Record Index (Row Number) of the record you wish to select.

**Example:** The following example steps through the Macros table, selecting each record by Index Number, then gets the name and value of each macro, then displays a message with that information.

```vba
Sub GetMacros()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim i As Integer
    Dim RecCount As Long
    Dim MacName As String
    Dim MacText As String

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.GetRecordCount 11, RecCount

    For i = 1 To RecCount
        pmDataObject.SelectMainRecordByIndex 11, i
        pmDataObject.GetStringFieldValue 11, 1, MacName
        pmDataObject.GetStringFieldValue 11, 2, MacText
        pmObject.MsgBox (MacName & ":  " & MacText)
    Next i

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
SelectMainRecordByName

**Syntax:** SelectMainRecordByName *RecordType, RecordName*

**Description:** Selects a record by its Name or ID value. This method can only be used with record types that have a name or ID field. If the table does not have a Name or ID field, you must use the `SelectMainRecordByIndex` method.

**Parameters:**
- **RecordType** *(Long)* The Record Type (Table Number) of the table you wish to work with.
- **RecordName** *(Long)* The Name or ID field value for the record (row) you wish to select.

**Example:** The following example loads the mfg_cost model, selects the location record by the name “Inspect”, inserts a new record before it, and gives it a name.

```vba
Sub AddALoc()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.SelectMainRecordByName 1, "Inspect"
    pmDataObject.InsertRecord 1
    pmDataObject.SetStringFieldValue 1, 2, "My_New_Loc"
    pmObject.MsgBox "Done"

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
SetIntFieldValue

**Syntax:** SetIntFieldValue RecordType, FieldIndex, FieldValue

**Description:** Changes the value for the specified integer field of the selected record.

**Parameters:**
- **RecordType** (Long) The Record Type (Table Number) of the table you wish to work with.
- **FieldIndex** (Long) The Field Index (Column Number) of the field you wish to make changes to.
- **FieldValue** (Long) The integer (long) value you want to place in the specified field.

**Example:** The following example loads the mfg_cost model, then sets its default time unit to Hours (it was Minutes).

```vba
Sub Time2Hours()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim TimeUnit As Long

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    TimeUnit = 3  ' (Hours)
    pmDataObject.SelectMainRecordByIndex 18, 1
    pmDataObject.SetIntFieldValue 18, 2, TimeUnit

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
SetRealFieldValue

Syntax: SetRealFieldValue RecordType, FieldIndex, FieldValue

Description: Changes the value for the specified real field of the selected record. When setting values for real fields, it is best to place the number into a variable of the correct type, then use the variable in the method call. This will avoid incorrect numeric conversions.

Parameters:

- **RecordType** *(Long)* The Record Type (Table Number) of the table you wish to work with.
- **FieldIndex** *(Long)* The Field Index (Column Number) of the field for which you want to change the value.
- **FieldValue** *(Double)* The real number value you wish to place in the specified field for the selected record.

Example: The following example loads the Orders model, selects the third processing record, then changes the probabilities for the routing records to 70/30. Be cautious with using this method to set probabilities or percentages that must total 100 (make sure the records still have the correct total after changes).

Sub GetRoutingProbability()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData
    Dim ProbVal1 As Double
    Dim ProbVal2 As Double

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")
    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\Orders.mod"
    pmDataObject.Populate

    ProbVal1 = 0.7
    ProbVal2 = 0.3
    pmDataObject.SelectMainRecordByIndex 19, 3
    pmDataObject.SelectMainRecordByIndex 20, 1
    pmDataObject.SetRealFieldValue 20, 13, ProbVal1
    pmDataObject.SelectMainRecordByIndex 20, 2
    pmDataObject.SetRealFieldValue 20, 13, ProbVal2
    pmObject.MsgBox ("Done")

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
**SetStringFieldValue**

**Syntax:** `SetStringFieldValue RecordType, FieldIndex, FieldValue`

**Description:** Changes the value for the specified string field of the selected record.

**Parameters:**
- `RecordType` (Long) The Record Type (Table Number) of the table you wish to work with.
- `FieldIndex` (Long) The Field Index (Column Number) of the field in which you want to place the new value.
- `FieldValue` (String) The value you wish to place in the specified field for the selected record.

**Example:** The following example loads the mfg_cost model, finds the “Inspect” location and inserts a new record before it, then selects the new record & gives it a name.

```vbscript
Sub AddALoc()
    Dim pmObject As ProModel.CProModel
    Dim pmDataObject As ProModel.CProModelData

    Set pmObject = CreateObject("ProModel")
    Set pmDataObject = CreateObject("ProModelData")

    pmObject.LoadModel "C:\ProModel 2001\Models\Demos\mfg_cost.mod"
    pmDataObject.Populate

    pmDataObject.SelectMainRecordByName 1, "Inspect"
    pmDataObject.InsertRecord 1
    pmDataObject.SetStringFieldValue 1, 2, "My_New_Loc"

    Set pmDataObject = Nothing
    Set pmObject = Nothing
End Sub
```
Chapter 5: The RDBDataServer Object

To use the RDBDataServer object, you will first need to register the RDBDataServer. This is done by running the RDBSRV.EXE found in your ProModel folder. If you do not have this file in your ProModel folder, contact ProModel Technical Support. You will not find a library for this object listed in the references in your VB Editor.

As you work with the RDBDataServer, keep in mind that you are working with a database, not a text file or spreadsheet. This means that there is some information that you cannot get directly from the .rdb file. For example, when you have multiple replications, periods, or scenarios, you can’t get the averages, standard deviations or totals using only the RDBDataServer methods. You must get the same data elements from each replication, period or scenario, then perform the calculations in your spreadsheet or other program.

When talking about tables, each section of the standard output statistics report corresponds to a table in the .rdb file. There are some tables that may or may not be available, depending upon whether that type of data is collected for the specific model (like Logs). However, the table numbers are pre-defined, so each number will always reference the same table, whether or not it is in use.

If you want to get the names of the records (i.e. – Location or Resource Names), you will need to get the data for field number 0 (zero). The zero column in each table has the Record ID from the model.

The RDBDataServer uses the following methods:

- CloseFile
- FieldName
- GetPositionInfo
- GetValue
- OpenFile
- PeriodName
- PositionIsValid
- RecordName
- ReplicationNumber
- ScenarioName
- SelectData
- TableName
CloseFile

**Syntax:** CloseFile

**Description:** Closes the previously opened RDB file.

**Parameters:** None

**Returns:** Nothing

**Example:** This example opens the mfg_cost.rdb, selects data, displays it, then closes the file.

```vba
Sub Get_Data()
    Dim RDBObj As Object
    Dim x

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile "C:\ProModel 2001\Output\mfg_cost.rdb"

    RDBObj.SelectData 1, 1, 1, 1, 1
    x = RDBObj.GetPositionInfo
    MsgBox (x)

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
**FieldName**

**Syntax:** FieldName

**Description:** Returns the name of the current field.

**Parameters:** None

**Returns:** The name of the specified field (column), or “invalid” if the SelectData specifications are not valid.

**Example:** This example opens the mfg_cost.rdb, displays some of the data, then closes the file.

```vba
Sub Get_Data()
    Dim RDBObj As Object
    Dim MyField As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")

    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyField = RDBObj.FieldName
        MsgBox ("Field (Column): " & MyField)
    Else
        MsgBox ("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
GetPositionInfo

**Syntax:** GetPositionInfo

**Description:** Returns the scenario, period, replication, table, field, record and data value of the current selection. This can be useful in loops.

**Returns:** Details of current data selection, as follows:

- Scenario: *Scenario Name*
- Replication: *Replication Number*
- Period: *Period Name*
- Table: *Table Name*
- Field: *Field Name*
- Record: *Record Name*
- Value: *Data Value*

**Parameters:** None

**Example:** This example opens the mfg_cost.rdb, selects data, then displays the details of the selection.

```
Sub Get_Data()
    Dim RDBObj As Object
    Dim x

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile "C:\ProModel 2001\Output\mfg_cost.rdb"

    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    x = RDBObj.GetPositionInfo
    MsgBox (x)

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
GetValue

Syntax: GetValue

Description: Returns the data value for the current data selection.

Parameters: None

Returns: The data value of the current position (or zero if the current selection is not valid).

Example: This example opens the mfg_cost.rdb, gets and displays some of the data, then closes the file.

```vba
Sub Get_Data()
    Dim RDBObj As Object
    Dim MyDataVal As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")

    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyDataVal = RDBObj.GetValue
        MsgBox ("Data Value = " & MyDataVal)
    Else
        MsgBox ("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
OpenFile

Syntax:  OpenFile FileName

Description:  Call this function first to open and load the proper .RDB file.

Parameters:
  FileName  (String)  Path and filename of any valid .rdb file.

Returns:  Nothing

Example:  This example opens the mfg_cost.rdb, gets and displays some of the data, then closes the file.

Sub Get_Data()
  Dim RDBObj As Object
  Dim x

  Set RDBObj = CreateObject("RDBDataServer")
  RDBObj.OpenFile "C:\ProModel 2001\Output\mfg_cost.rdb"

  RDBObj.SelectData 1, 1, 1, 1, 1, 1
  x = RDBObj.GetPositionInfo
  MsgBox (x)

  RDBObj.CloseFile
  Set RDBObj = Nothing
End Sub
**PeriodName**

**Syntax:**  PeriodName

**Description:**  Returns the name of the Period in the current data selection.

**Parameters:**  None

**Returns:**  The current period name, or "invalid" if the current selection is not valid.

**Example:**  This example opens the mfg_cost.rdb, gets and displays some of the data, then closes the file.

```vba
Sub Get_Data()
    Dim RDBObj As Object
    Dim MyPeriod As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")

    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyPeriod = RDBObj.PeriodName
        MsgBox ("Selected Period = " & MyPeriod)
    Else
        MsgBox ("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
PositionIsValid

**Syntax:** PositionIsValid

**Description:** Check the data for the most recent data selection & return “True” if it is valid, “False” if it is not. This method is a little tricky, because it really doesn’t do much unless it is used in an “If…Then” or “Select Case” statement (the ‘x = RDBObj.PositionIsValid’ format is not allowed)

**Parameters:** None

**Returns:** TRUE if the last SelectData function points to valid data. FALSE if it does not.

**Example:** This example opens the mfg_cost.rdb, selects data, checks to see if selection is valid, displays the data or an error message, then closes the file.

```vbscript
Sub Get_Data()
    Dim RDBObj As Object
    Dim MyPeriod As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")

    RDBObj.SelectData 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyPeriod = RDBObj.PeriodName
        MsgBox (“Selected Period = ” & MyPeriod)
    Else
        MsgBox (“Data Selection Invalid”)
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
RecordName

**Syntax:** RecordName

**Description:** Returns the name of the Record in the current data selection.

**Parameters:** None

**Returns:** The current record name, or “invalid” if the current selection is not valid.

**Example:** This example opens the mfg_cost.rdb, gets and displays some of the data, then closes the file.

```vba
Sub Get_Data()
    Dim RDBObj As Object
    Dim MyRecord As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")
    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyRecord = RDBObj.RecordName
        MsgBox ("Selected Record = " & MyRecord)
    Else
        MsgBox ("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
ReplicationNumber

Syntax: ReplicationNumber

Description: Returns the number of the Replication in the current data selection.

Parameters: None

Returns: The current replication number, or "invalid" if the current selection is not valid.

Example: This example opens the mfg_cost.rdb, gets and displays some of the data, then closes the file.

Sub Get_Data()
    Dim RDBObj As Object
    Dim RepNum As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")

    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        RepNum = RDBObj.ReplicationNumber
        MsgBox("Selected Replication = " & RepNum)
    Else
        MsgBox("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
**ScenarioName**

**Syntax:**  ScenarioName

**Description:**  Returns the name of the Scenario in the current data selection.

**Parameters:**  None

**Returns:**  The current scenario name, or “invalid” if the current selection is not valid.

**Example:**  This example opens the mfg_cost.rdb, gets and displays some of the data, then closes the file.

```vba
Sub Get_Data()
    Dim RDBObj As Object
    Dim MyScenario As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")
    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyScenario = RDBObj.ScenarioName
        MsgBox ("Selected Scenario = " & MyScenario)
    Else
        MsgBox ("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
SelectData

Syntax: SelectData Scenario, Replication, Period, Table, Field, Record

Description: Retrieves the specified data element from the .rdb file. All of the parameters must be specified, even if there is only one scenario, replication or period.

Parameters:

- **Scenario** (Long) Scenario number containing the data you wish to select.
- **Replication** (Long) Replication number containing the data you wish to select.
- **Period** (Long) Period number containing the data you wish to select.
- **Table** (Long) Table (report section) number containing the data you wish to select.
- **Field** (Long) Field (column) number containing the data you wish to select.
- **Record** (Long) Record (row) number containing the data you wish to select.

Returns: TRUE if there is valid data corresponding to the parameters.

Example: This example opens the mfg_cost.rdb, gets and displays the Scheduled Hours for the first listed location in the Locations section of the statistic report (first scenario, replication & period), then closes the file.

```vba
Sub Get_Data()
    Dim RDBObj As Object
    Dim MyScenario As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")

    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyScenario = RDBObj.ScenarioName
        MsgBox ("Selected Scenario = " & MyScenario)
    Else
        MsgBox ("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
```
TableName

Syntax: TableName

Description: Returns the name of the Table in the current data selection.

Parameters: None

Returns: The current table name, or “invalid” if the current selection is not valid.

Example: This example opens the mfg_cost.rdb, gets and displays some of the data, then closes the file.

Sub Get_Data()
    Dim RDBObj As Object
    Dim MyTable As String

    Set RDBObj = CreateObject("RDBDataServer")
    RDBObj.OpenFile("C:\ProModel 2001\Output\mfg_cost.rdb")

    RDBObj.SelectData 1, 1, 1, 1, 1, 1
    If RDBObj.PositionIsValid = True Then
        MyTable = RDBObj.TableName
        MsgBox ("Selected Table = " & MyTable)
    Else
        MsgBox ("Data Selection Invalid")
    End If

    RDBObj.CloseFile
    Set RDBObj = Nothing
End Sub
Appendix: Table Definitions

ProModelData Table Definitions

To help you determine the RecordType values, the `pmconst.bas` file defines the constants used in the examples. The following is a list of RecordType values, Visual Basic record type constants, and field types for all data tables.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Visual Basic Constant</th>
<th>Value</th>
<th>Location of Table in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations</td>
<td>pmdTblLocation</td>
<td>1</td>
<td>Build &gt; Locations</td>
</tr>
<tr>
<td>Entities</td>
<td>pmdTblEntity</td>
<td>2</td>
<td>Build &gt; Entities</td>
</tr>
<tr>
<td>Path Networks</td>
<td>pmdTblPathNet</td>
<td>3</td>
<td>Build &gt; Path Networks</td>
</tr>
<tr>
<td>Resources</td>
<td>pmdTblResource</td>
<td>4</td>
<td>Build &gt; Resources</td>
</tr>
<tr>
<td>Arrivals</td>
<td>pmdTblArrival</td>
<td>6</td>
<td>Build &gt; Arrivals</td>
</tr>
<tr>
<td>Shift Assignment</td>
<td>pmdTblShift</td>
<td>7</td>
<td>Build &gt; Shifts &gt; Assign</td>
</tr>
<tr>
<td>Attributes</td>
<td>pmdTblAttribute</td>
<td>8</td>
<td>Build &gt; Attributes</td>
</tr>
<tr>
<td>Variables</td>
<td>pmdTblVariable</td>
<td>9</td>
<td>Build &gt; Variables</td>
</tr>
<tr>
<td>Arrays</td>
<td>pmdTblArray</td>
<td>10</td>
<td>Build &gt; Arrays</td>
</tr>
<tr>
<td>Macros</td>
<td>pmdTblMacro</td>
<td>11</td>
<td>Build &gt; Macros</td>
</tr>
<tr>
<td>Subroutines</td>
<td>pmdTblSubroutine</td>
<td>12</td>
<td>Build &gt; Subroutines</td>
</tr>
<tr>
<td>Arrival Cycles</td>
<td>pmdTblArrivalCycle</td>
<td>13</td>
<td>Build &gt; More Elements &gt; Arrival Cycles</td>
</tr>
<tr>
<td>Table Functions</td>
<td>pmdTblTableFunction</td>
<td>14</td>
<td>Build &gt; More Elements &gt; Table Functions</td>
</tr>
<tr>
<td>User Distributions</td>
<td>pmdTblUserDistrib</td>
<td>15</td>
<td>Build &gt; More Elements &gt; User Distributions</td>
</tr>
<tr>
<td>External Files</td>
<td>pmdTblExternalFile</td>
<td>16</td>
<td>Build &gt; More Elements &gt; External Files</td>
</tr>
<tr>
<td>Streams</td>
<td>pmdTblStream</td>
<td>17</td>
<td>Build &gt; More Elements &gt; Streams</td>
</tr>
<tr>
<td>General Information</td>
<td>pmdTblGenInfo</td>
<td>18</td>
<td>Build &gt; General Information</td>
</tr>
<tr>
<td>Processing</td>
<td>pmdTblProcessing</td>
<td>19</td>
<td>Build &gt; Processing</td>
</tr>
<tr>
<td>Routings</td>
<td>pmdTblRouting</td>
<td>20</td>
<td>Build &gt; Processing</td>
</tr>
<tr>
<td>Model Parameters</td>
<td>pmdTblModelParam</td>
<td>21</td>
<td>Simulation &gt; Model Parameters</td>
</tr>
<tr>
<td>Scenarios</td>
<td>pmdTblScenario</td>
<td>22</td>
<td>Simulation &gt; Scenarios</td>
</tr>
<tr>
<td>Simulation Options</td>
<td>pmdTblSimOption</td>
<td>23</td>
<td>Simulation &gt; Options</td>
</tr>
<tr>
<td>Location Clock Downtimes</td>
<td>pmdTblLocClockDT</td>
<td>25</td>
<td>Build &gt; Locations &gt; DTs… &gt; Clock</td>
</tr>
<tr>
<td>Location Entry Downtimes</td>
<td>pmdTblLocEntryDT</td>
<td>26</td>
<td>Build &gt; Locations &gt; DTs… &gt; Entry</td>
</tr>
<tr>
<td>Location Usage Downtimes</td>
<td>pmdTblLocUsageDT</td>
<td>27</td>
<td>Build &gt; Locations &gt; DTs… &gt; Usage</td>
</tr>
<tr>
<td>Location Setup Downtimes</td>
<td>pmdTblLocSetupDT</td>
<td>28</td>
<td>Build &gt; Locations &gt; DTs… &gt; Setup</td>
</tr>
<tr>
<td>Resource Clock Downtimes</td>
<td>pmdTblResClockDT</td>
<td>31</td>
<td>Build &gt; Resources &gt; DTs… &gt; Clock</td>
</tr>
<tr>
<td>Table Name</td>
<td>Code</td>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resource Usage Downtimes</td>
<td>pmdTblResUsageDT</td>
<td>32</td>
<td>Build &gt; Resources &gt; DTs… &gt; Usage</td>
</tr>
<tr>
<td>Resource Work Search</td>
<td>pmdTblResWorkSearch</td>
<td>33</td>
<td>Build &gt; Resources &gt; Search… &gt; Work</td>
</tr>
<tr>
<td>Resource Park Search</td>
<td>pmdTblResParkSearch</td>
<td>34</td>
<td>Build &gt; Resources &gt; Search… &gt; Park</td>
</tr>
<tr>
<td>Resource Node Logic</td>
<td>pmdTblResNodeLogic</td>
<td>35</td>
<td>Build &gt; Resources &gt; Logic…</td>
</tr>
<tr>
<td>Resource Points</td>
<td>pmdTblResPoint</td>
<td>36</td>
<td>Build &gt; Resources &gt; Pts…</td>
</tr>
<tr>
<td>Shift Assignment Locations</td>
<td>pmdTblShiftLocation</td>
<td>38</td>
<td>Build &gt; Shifts &gt; Assign &gt; Locations</td>
</tr>
<tr>
<td>Shift Assignment Resources</td>
<td>pmdTblShiftResource</td>
<td>39</td>
<td>Build &gt; Shifts &gt; Assign &gt; Resources</td>
</tr>
<tr>
<td>Shift Assignment Files</td>
<td>pmdTblShiftFile</td>
<td>40</td>
<td>Build &gt; Shifts &gt; Assign &gt; Shift Files</td>
</tr>
<tr>
<td>Subroutine Parameters</td>
<td>pmdTblSubRtnParam</td>
<td>41</td>
<td>Build &gt; Subroutines &gt; Parameters…</td>
</tr>
<tr>
<td>Arrival Cycles Values</td>
<td>pmdTblArrivalCycData</td>
<td>42</td>
<td>Build &gt; More Elements &gt; Arrival Cycles &gt; Table…</td>
</tr>
<tr>
<td>Table Functions Values</td>
<td>pmdTblFunctionData</td>
<td>43</td>
<td>Build &gt; More Elements &gt; Table Functions &gt; Table…</td>
</tr>
<tr>
<td>User Distributions Values</td>
<td>pmdTblUserDistribData</td>
<td>44</td>
<td>Build &gt; More Elements &gt; User Distributions &gt; Table…</td>
</tr>
<tr>
<td>Location Graphics</td>
<td>pmdTblLocGraphic</td>
<td>45</td>
<td>Not Visible</td>
</tr>
<tr>
<td>Resource Graphics</td>
<td>pmdTblResGraphic</td>
<td>46</td>
<td>Not Visible</td>
</tr>
<tr>
<td>Entity Graphics</td>
<td>pmdTblEntGraphic</td>
<td>47</td>
<td>Not Visible</td>
</tr>
<tr>
<td>Background Graphics</td>
<td>pmdTblBackGraphic</td>
<td>49</td>
<td>Build &gt; Background Graphics</td>
</tr>
<tr>
<td>Model Defaults</td>
<td>pmdTblModelDefaults</td>
<td>50</td>
<td>Simulation &gt; Model Parameters</td>
</tr>
<tr>
<td>Path Networks Segments</td>
<td>pmdTblPathSegment</td>
<td>51</td>
<td>Build &gt; Path Networks &gt; Paths…</td>
</tr>
<tr>
<td>Path Networks Interfaces</td>
<td>pmdTblPathInterface</td>
<td>52</td>
<td>Build &gt; Path Networks &gt; Interfaces…</td>
</tr>
<tr>
<td>Path Networks Mapping</td>
<td>pmdTblPathMapping</td>
<td>53</td>
<td>Build &gt; Path Networks &gt; Mapping…</td>
</tr>
<tr>
<td>Path Networks Nodes</td>
<td>pmdTblPathNode</td>
<td>54</td>
<td>Build &gt; Path Networks &gt; Nodes…</td>
</tr>
<tr>
<td>Views</td>
<td>pmdTblView</td>
<td>55</td>
<td>View &gt; Views &gt; Define</td>
</tr>
<tr>
<td>Scenario Parameters</td>
<td>pmdTblScenParam</td>
<td>56</td>
<td>Simulation &gt; Scenarios &gt; (Add/Edit)</td>
</tr>
<tr>
<td>Path Networks Mapping Destinations</td>
<td>pmdTblPathMapDest</td>
<td>57</td>
<td>Build &gt; Path Networks &gt; Mapping… &gt; Dest.</td>
</tr>
<tr>
<td>Work Search Locations</td>
<td>pmdTblWorkSearchLoc</td>
<td>58</td>
<td>Build &gt; Resources &gt; Search… &gt; Work &gt; Location List</td>
</tr>
<tr>
<td>Park Search Nodes</td>
<td>pmdTblParkNode</td>
<td>59</td>
<td>Build &gt; Resources &gt; Search… &gt; Park &gt; Parking Node List</td>
</tr>
<tr>
<td>Variable Graphics</td>
<td>pmdTblVarGraphic</td>
<td>60</td>
<td>Build &gt; Variables</td>
</tr>
<tr>
<td>Queue / Conveyor Joints</td>
<td>pmdTblQJoint</td>
<td>61</td>
<td>Build &gt; Locations &gt; (Right-click on Queue) &gt; Add Joint</td>
</tr>
<tr>
<td>Routing Points</td>
<td></td>
<td>62</td>
<td>Build &gt; Processing &gt; (Right-click on Routing) &gt; Add Joint</td>
</tr>
</tbody>
</table>
# Table Field Types

**Key:**
- I = Integer
- S = String
- R = Real

## Locations Table (1): pmdTblLocation

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldLocName</td>
<td>Build &gt; Locations &gt; Name</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldLocCapacity</td>
<td>Build &gt; Locations &gt; Capacity</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldLocUnits</td>
<td>Build &gt; Locations &gt; Units</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>pmdFldLocStats</td>
<td>Build &gt; Locations &gt; Stats</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stats Rule</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>None</td>
<td>pmdStatsTypeNone</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Basic or Summary</td>
<td>pmdStatsTypeBasicSum</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Time Series or By Unit</td>
<td>pmdStatsTypeTSUnit</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldLocIncoming</td>
<td>Build &gt; Locations &gt; Rules &gt; Select Incoming Entities</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Incoming Rule</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Oldest by priority</td>
<td>pmdRuleInEntOldest</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Least available capacity</td>
<td>pmdRuleInEntLeastAvail</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Random</td>
<td>pmdRuleInEntRandom</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Last selected location</td>
<td>pmdRuleInEntLastLoc</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Minimum attribute value</td>
<td>pmdRuleInEntMinAttrib</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Maximum attribute value</td>
<td>pmdRuleInEntMaxAttrib</td>
</tr>
<tr>
<td>11</td>
<td>S</td>
<td>pmdFldLocIncAttrib</td>
<td>Build &gt; Locations &gt; Rules &gt; Select Incoming Entities &gt; Attribute</td>
</tr>
<tr>
<td>12</td>
<td>I</td>
<td>pmdFldLocQOutput</td>
<td>Build &gt; Locations &gt; Rules &gt; Queuing For Output</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Queue Rule</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>No queuing</td>
<td>pmdRuleQOutNone</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>First in, First out</td>
<td>pmdRuleQOutFirstIn, First Out</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Last in, First out</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Maximum attribute value</td>
<td>pmdRuleQOutMaxAttrib</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Minimum attribute value</td>
<td>pmdRuleQOutMinAttrib</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>By type</td>
<td>pmdRuleQOutByType</td>
</tr>
<tr>
<td>13</td>
<td>S</td>
<td>pmdFldLocQOutAttrib</td>
<td>Build &gt; Locations &gt; Rules &gt; Queuing For Output &gt; Attribute</td>
</tr>
<tr>
<td>14</td>
<td>I</td>
<td>pmdFldLocSelectUnit</td>
<td>Build &gt; Locations &gt; Rules &gt; Selecting A Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unit Selection Rule</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Longest empty</td>
<td>pmdRuleUSelLongestEmpty</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Random</td>
<td>pmdRuleUSelRandom</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>By turn</td>
<td>pmdRuleUSelByTurn</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Most available capacity</td>
<td>pmdRuleUSelMostAvail</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Fewest entries</td>
<td>pmdRuleUSelLeastEntries</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>First available</td>
<td>pmdRuleUSelFirstAvail</td>
</tr>
<tr>
<td>15</td>
<td>S</td>
<td>pmdFldLocNotes</td>
<td>Build &gt; Locations &gt; Notes</td>
</tr>
<tr>
<td>16</td>
<td>S</td>
<td>pmdFldLocCostRate</td>
<td>Operation cost per time unit in field 20.</td>
</tr>
<tr>
<td>20</td>
<td>I</td>
<td>pmdFldLocCostTimeUnits</td>
<td>Build &gt; Cost &gt; Locations &gt; Operation Rate</td>
</tr>
</tbody>
</table>

## Time Units Rule

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Seconds</td>
<td>pmd TimeUnitSec</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Minutes</td>
<td>pmd TimeUnitMin</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Hours</td>
<td>pmd TimeUnitHr</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Days</td>
<td>pmd TimeUnitDay</td>
</tr>
</tbody>
</table>
ProModelData Table Definitions

Location Clock Downtimes Subtable (25): `pmdTblLocClockDT`

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td><code>pmdFldDTFrequency</code></td>
<td>Frequency</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td><code>pmdFldDTFirstTime</code></td>
<td>First Time</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td><code>pmdFldDTPriority</code></td>
<td>Priority</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td><code>pmdFldDTScheduled</code></td>
<td>Scheduled</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td><code>pmdFldDTLogic</code></td>
<td>Logic</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td><code>pmdFldDTDisable</code></td>
<td>Disable</td>
</tr>
</tbody>
</table>

Location Entry Downtimes Subtable (26): `pmdTblLocEntryDT`

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td><code>pmdFldDTFrequency</code></td>
<td>Frequency</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td><code>pmdFldDTFirstTime</code></td>
<td>First Time</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td><code>pmdFldDTLogic</code></td>
<td>Logic</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td><code>pmdFldDTDisable</code></td>
<td>Disable</td>
</tr>
</tbody>
</table>

Location Usage Downtimes Subtable (27): `pmdTblLocUsageDT`

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td><code>pmdFldDTFrequency</code></td>
<td>Frequency</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td><code>pmdFldDTFirstTime</code></td>
<td>First Time</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td><code>pmdFldDTPriority</code></td>
<td>Priority</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td><code>pmdFldDTLogic</code></td>
<td>Logic</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td><code>pmdFldDTDisable</code></td>
<td>Disable</td>
</tr>
</tbody>
</table>

Location Setup Downtimes Subtable (28): `pmdTblLocSetupDT`

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>S</td>
<td><code>pmdFldDTLogic</code></td>
<td>Logic</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td><code>pmdFldDTDisable</code></td>
<td>Disable</td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td><code>pmdFldDTEntity</code></td>
<td>Entity</td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td><code>pmdFldDTPriorEnt</code></td>
<td>Prior Entity</td>
</tr>
</tbody>
</table>
### Entities Table (2): pmdTblEntity

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldEntName</td>
<td>Build &gt; Entities &gt; Name</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldEntSpeed</td>
<td>Build &gt; Entities &gt; Speed</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldEntStats</td>
<td>Build &gt; Entities &gt; Stats</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Stats Rule</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldEntNotes</td>
<td>Build &gt; Entities &gt; Notes</td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td>pmdFldEntInitCost</td>
<td>Build &gt; Cost &gt; Entities &gt; Initial Cost</td>
</tr>
</tbody>
</table>

### Path Networks (3): pmdTblPathNet

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldPathColor</td>
<td>Build &gt; Path Networks &gt; Graphics &gt; Color</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldPathVisible</td>
<td>Build &gt; Path Networks &gt; Graphics &gt; Visible</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldPathName</td>
<td>Build &gt; Path Networks &gt; Name</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldPathType</td>
<td>Build &gt; Path Networks &gt; Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Type Rule</strong></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>I</td>
<td>pmdFldPathBasis</td>
<td>Build &gt; Path Networks &gt; T/S</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Basis Rule</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Stats Rule**
- 1 = None
- 2 = Basic or Summary
- 3 = Time Series or By Unit

**Type Rule**
- 0 = No Passing
- 1 = Speed
- 2 = Crane

**Basis Rule**
- 0 = Time
- 1 = Speed & Distance
# ProModel Data Table Definitions

## Path Segments Subtable (51): pmdTblPathSegment

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldPathSegFrom</td>
<td>Build &gt; Path Networks &gt; Paths… &gt; From</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldPathSegTo</td>
<td>Build &gt; Path Networks &gt; Paths… &gt; To</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldPathSegBiDi</td>
<td>Build &gt; Path Networks &gt; Paths… &gt; Bi</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldPathSegSpeedFactor</td>
<td>Build &gt; Path Networks &gt; Paths… &gt;</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldPathSegDistance</td>
<td>Build &gt; Path Networks &gt; Paths… &gt; Distance</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldPathSegTime</td>
<td>Build &gt; Path Networks &gt; Paths… &gt; Time</td>
</tr>
</tbody>
</table>

## Interfaces Subtable (52): pmdTblPathInterface

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldPathXfaceNode</td>
<td>Build &gt; Path Networks &gt; Interfaces… &gt; Node</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldPathXfaceLoc</td>
<td>Build &gt; Path Networks &gt; Interfaces… &gt; Location</td>
</tr>
</tbody>
</table>

## Mappings Subtable (53): pmdTblPathMapping

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldPathMapFromNode</td>
<td>Build &gt; Path Networks &gt; Mapping… &gt; From</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldPathMapSegNum</td>
<td>Not Visible (references Path Networks Segment record number)</td>
</tr>
</tbody>
</table>

## Mapping Destinations Subtable (57): pmdTblPathMapDest

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldPathMapDestNode</td>
<td>pmMapDestSNode</td>
</tr>
</tbody>
</table>

## Nodes Subtable (54): pmdTblPathNode

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldPathnodeName</td>
<td>Build &gt; Path Networks &gt; Nodes &gt; Node</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldPathNodeCapacity</td>
<td>Build &gt; Path Networks &gt; Nodes &gt; Limit</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldPathNodeXPos</td>
<td>Not Visible (number of pixels from left)</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldPathNodeYPos</td>
<td>Not Visible (number of pixels from top)</td>
</tr>
</tbody>
</table>

## Resources Table (4): pmdTblResource

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldResName</td>
<td>Build &gt; Resources &gt; Name</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldResUnits</td>
<td>Build &gt; Resources &gt; Units</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldResStats</td>
<td>Build &gt; Resources &gt; Stats…</td>
</tr>
</tbody>
</table>

**Stats Rule**

- 1 = None
- 2 = Basic or Summary
- 3 = Time Series or By Unit

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>S</td>
<td>pmdFldResNetwork</td>
<td>Build &gt; Resources &gt; Specs… &gt; Path Network</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td>pmdFldResSearch</td>
<td>Build &gt; Resources &gt; Specs… &gt; Resource Search</td>
</tr>
<tr>
<td>Resource Search Rule</td>
<td>Rule</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>1 = Closest Resource</td>
<td>pmdResSrchClosest</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 = Longest Idle</td>
<td>pmdResSrchLongestIdle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 = Least Utilized</td>
<td>pmdResSrchLeastUsed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Entity Search Rule</th>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = Longest Waiting</td>
<td>pmdEntSrchOldest</td>
<td></td>
</tr>
<tr>
<td>2 = Closest Entity</td>
<td>pmdEntSrchClosest</td>
<td></td>
</tr>
<tr>
<td>3 = Minimum Attribute Value</td>
<td>pmdEntSrchMinAttrib</td>
<td></td>
</tr>
<tr>
<td>4 = Maximum Attribute Value</td>
<td>pmdEntSrchMaxAttrib</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pmdFldResEntSearch</td>
<td>Build &gt; Resources &gt; Specs… &gt; Entity Search</td>
</tr>
<tr>
<td>pmdFldResEntSrchMinAttrib</td>
<td>Build &gt; Resources &gt; Specs… &gt; Entity Search &gt; Min Attribute</td>
</tr>
<tr>
<td>pmdFldResEntSrchMaxAttrib</td>
<td>Build &gt; Resources &gt; Specs… &gt; Entity Search &gt; Max Attribute</td>
</tr>
<tr>
<td>pmdFldResSpeedEmpty</td>
<td>Build &gt; Resources &gt; Specs… &gt; Motion &gt; Speed (Empty)</td>
</tr>
<tr>
<td>pmdFldResSpeedFull</td>
<td>Build &gt; Resources &gt; Specs… &gt; Motion &gt; Speed (Full)</td>
</tr>
<tr>
<td>pmdFldResAccel</td>
<td>Build &gt; Resources &gt; Specs… &gt; Motion &gt; Accelerate</td>
</tr>
<tr>
<td>pmdFldResDecel</td>
<td>Build &gt; Resources &gt; Specs… &gt; Motion &gt; Decelerate</td>
</tr>
<tr>
<td>pmdFldResPickupTime</td>
<td>Build &gt; Resources &gt; Specs… &gt; Motion &gt; Pick-up Time</td>
</tr>
<tr>
<td>pmdFldResDepositTime</td>
<td>Build &gt; Resources &gt; Specs… &gt; Motion &gt; Deposit Time</td>
</tr>
<tr>
<td>pmdFldResHomeNode</td>
<td>Build &gt; Resources &gt; Specs… &gt; Nodes &gt; Home</td>
</tr>
<tr>
<td>pmdFldResHomeIfIdle</td>
<td>Build &gt; Resources &gt; Specs… &gt; Nodes &gt; Return Home If Idle</td>
</tr>
<tr>
<td>pmdFldResOffShiftNode</td>
<td>Build &gt; Resources &gt; Specs… &gt; Nodes &gt; Off-Shift</td>
</tr>
<tr>
<td>pmdFldResBreakNode</td>
<td>Build &gt; Resources &gt; Specs… &gt; Nodes &gt; Break</td>
</tr>
<tr>
<td>pmdFldResNotes</td>
<td>Build &gt; Resources &gt; Notes</td>
</tr>
<tr>
<td>pmdFldResCost</td>
<td>Build &gt; Cost &gt; Resources &gt; Regular Rate</td>
</tr>
<tr>
<td>pmdFldResCostPerUse</td>
<td>Build &gt; Cost &gt; Resources &gt; Cost Per Use</td>
</tr>
<tr>
<td>pmdFldResCostTimeUnit</td>
<td>Build &gt; Cost &gt; Resources &gt; Per</td>
</tr>
<tr>
<td>pmdFldResCostTimeUnit</td>
<td>Build &gt; Resources &gt; Resource Graphics &gt; Graphic Size</td>
</tr>
</tbody>
</table>
### ProModel Data Table Definitions

#### Clock Downtimes Subtable (31): pmdTblResClockDT

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldDTFrequency</td>
<td>Frequency</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldDTFirstTime</td>
<td>First Time</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldDTPriority</td>
<td>Priority</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldDTScheduled</td>
<td>Scheduled</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldDTLogic</td>
<td>Logic</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldDTDisable</td>
<td>Disable</td>
</tr>
<tr>
<td>9</td>
<td>S</td>
<td>pmdFldDTList</td>
<td>List</td>
</tr>
<tr>
<td>10</td>
<td>S</td>
<td>pmdFldDTNode</td>
<td>Node</td>
</tr>
</tbody>
</table>

#### Usage Downtimes Subtable (32): pmdTblResUsageDT

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldDTFrequency</td>
<td>Frequency</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldDTFirstTime</td>
<td>First Time</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldDTPriority</td>
<td>Priority</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldDTLogic</td>
<td>Logic</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldDTDisable</td>
<td>Disable</td>
</tr>
<tr>
<td>9</td>
<td>S</td>
<td>pmdFldDTList</td>
<td>List</td>
</tr>
<tr>
<td>10</td>
<td>S</td>
<td>pmdFldDTNode</td>
<td>Node</td>
</tr>
</tbody>
</table>

#### Work Search Subtable (33): pmdTblResWorkSearch

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldResWorkSrchNode</td>
<td>Build &gt; Resources &gt; Search… &gt; Work &gt; Node</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldResWorkSrchType</td>
<td>Build &gt; Resources &gt; Search… &gt; Work &gt; Type</td>
</tr>
</tbody>
</table>

**Resource Work Search Type Rule**

1 = Exclusive  
2 = Non-Exclusive  

#### Search Locations Subtable (58): pmdTblWorkSearchLoc

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldWorkSrchLocName</td>
<td>Build &gt; Resources &gt; Search… &gt; Work &gt; Location List</td>
</tr>
</tbody>
</table>

#### Park Search Subtable (34): pmdTblResParkSearch

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldResParkSrchNode</td>
<td>Build &gt; Resources &gt; Search… &gt; Park &gt; Node</td>
</tr>
</tbody>
</table>

#### Park Nodes Subtable (59): pmdTblParkNode

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldResParkNodeName</td>
<td>Build &gt; Resources &gt; Search… &gt; Park &gt; Parking Node List</td>
</tr>
</tbody>
</table>
## Node Logic Subtable (35): pmdTblResNodeLogic

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldResNLogicNode</td>
<td>Build &gt; Resources &gt; Logic… &gt; Node</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldResNLogicEntry</td>
<td>Build &gt; Resources &gt; Logic… &gt; Entry Logic</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldResNLogicExit</td>
<td>Build &gt; Resources &gt; Logic… &gt; Exit Logic</td>
</tr>
</tbody>
</table>

## Resource Points Subtable (36): pmdTblResPoint

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldPointsNode</td>
<td>Build &gt; Resources &gt; Pts… &gt; Node</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldPointsXPos</td>
<td>Build &gt; Resources &gt; Pts… &gt; Points (before comma)</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldPointsYPos</td>
<td>Build &gt; Resources &gt; Pts… &gt; Points (after comma)</td>
</tr>
</tbody>
</table>

## Arrivals Table (6): pmdTblArrival

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldArrivalEntName</td>
<td>Build &gt; Arrivals &gt; Entity…</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldArrivalLocName</td>
<td>Build &gt; Arrivals &gt; Location…</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldArrivalQtyEach</td>
<td>Build &gt; Arrivals &gt; Qty Each… &gt; Quantity</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldArrivalCycle</td>
<td>Build &gt; Arrivals &gt; Qty Each… &gt; Arrival Cycle</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldArrivalFirstTime</td>
<td>Build &gt; Arrivals &gt; First Time</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldArrivalOccur</td>
<td>Build &gt; Arrivals &gt; Occurrences</td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td>pmdFldArrivalFrequency</td>
<td>Build &gt; Arrivals &gt; Frequency</td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td>pmdFldArrivalLogic</td>
<td>Build &gt; Arrivals &gt; Logic…</td>
</tr>
<tr>
<td>9</td>
<td>Bool</td>
<td>pmdFldArrivalDisable</td>
<td>Build &gt; Arrivals &gt; Disable</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldArrivalTimeBasis</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Define Arrival By</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldArrivalMinute</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Edit Arrival Time &gt; Min</td>
</tr>
<tr>
<td>12</td>
<td>I</td>
<td>pmdFldArrivalHour</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Edit Arrival Time &gt; Hr</td>
</tr>
<tr>
<td>13</td>
<td>I</td>
<td>pmdFldArrivalWeekDay</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Edit Arrival Time &gt; Day</td>
</tr>
<tr>
<td>14</td>
<td>I</td>
<td>pmdFldArrivalMonthDay</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Edit Arrival Time &gt; Day</td>
</tr>
<tr>
<td>15</td>
<td>I</td>
<td>pmdFldArrivalWeek</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Edit Arrival Time &gt; Week</td>
</tr>
<tr>
<td>16</td>
<td>I</td>
<td>pmdFldArrivalMonth</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Edit Arrival Time &gt; Month</td>
</tr>
<tr>
<td>17</td>
<td>I</td>
<td>pmdFldArrivalYear</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Edit Arrival Time &gt; Year</td>
</tr>
<tr>
<td>18</td>
<td>S</td>
<td>pmdFldArrivalVariation</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Scheduling Options &gt; Variation</td>
</tr>
<tr>
<td>19</td>
<td>S</td>
<td>pmdFldArrivalOffset</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Scheduling Options &gt; Offset</td>
</tr>
<tr>
<td>20</td>
<td>I</td>
<td>pmdFldArrivalRepeatType</td>
<td>Build &gt; Arrivals &gt; First Time &gt; Scheduling Options &gt; Repeat (Daily/Weekly)</td>
</tr>
</tbody>
</table>

### Arrival Repeat Type Rule

1 = No Selection         pmdRepeatNone
2 = Repeat Daily         pmdRepeatDaily
3 = Repeat Weekly        pmdRepeatWeekly
### Shift Assignment Table (7): pmdTblShift

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldShiftPriority</td>
<td>Build &gt; Shifts &gt; Assign &gt; Priorities… &gt; Priority for ending shift</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldShiftOffShiftPri</td>
<td>Build &gt; Shifts &gt; Assign &gt; Priorities… &gt; Off-shift priority</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldShiftStartBreakPri</td>
<td>Build &gt; Shifts &gt; Assign &gt; Priorities… &gt; Priority for starting break</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldShiftBreakPri</td>
<td>Build &gt; Shifts &gt; Assign &gt; Priorities… &gt; Break priority</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldShiftPreOffShiftLogic</td>
<td>Build &gt; Shifts &gt; Assign &gt; Logic &gt; Pre-Off Shift</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldShiftOffShiftLogic</td>
<td>Build &gt; Shifts &gt; Assign &gt; Logic &gt; Off Shift</td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td>pmdFldShiftPreBreakLogic</td>
<td>Build &gt; Shifts &gt; Assign &gt; Logic &gt; Pre-Break</td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td>pmdFldShiftBreakLogic</td>
<td>Build &gt; Shifts &gt; Assign &gt; Logic &gt; Break</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>Bool pmdFldShiftDisable</td>
<td>Build &gt; Shifts &gt; Assign &gt; Disable</td>
</tr>
</tbody>
</table>

### Location Index Subtable (38): pmdTblShiftLocation

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldShiftLocNum</td>
<td>Build &gt; Shifts &gt; Assign &gt; Locations</td>
</tr>
</tbody>
</table>

### Resource Index Subtable (39): pmdTblShiftResource

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldShiftResNum</td>
<td>Build &gt; Shifts &gt; Assign &gt; Resources</td>
</tr>
<tr>
<td>12</td>
<td>S</td>
<td>pmdFldShiftResUnits</td>
<td>Build &gt; Shifts &gt; Assign &gt; Resources &gt; Units</td>
</tr>
</tbody>
</table>

### Shift File Index Subtable (40): pmdTblShiftFile

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>I</td>
<td>pmdFldShiftFileNum</td>
<td>Build &gt; Shifts &gt; Assign &gt; Shift Files &gt; Selected Files</td>
</tr>
<tr>
<td>14</td>
<td>S</td>
<td>pmdFldShiftStartTime</td>
<td>Build &gt; Shifts &gt; Assign &gt; Shift Files &gt; Start</td>
</tr>
</tbody>
</table>

### Attributes Table (8): pmdTblAttribute

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldAttribID</td>
<td>Build &gt; Attributes &gt; ID</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldAttribType</td>
<td>Build &gt; Attributes &gt; Type…</td>
</tr>
</tbody>
</table>

*Type Rule*

- 2 = Integer  
- 4 = Real

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldAttribClass</td>
<td>Build &gt; Attributes &gt; Classification…</td>
</tr>
</tbody>
</table>

*Classification Rule*

- 1 = Entity  
- 2 = Location

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldAttribNotes</td>
<td>Build &gt; Attributes &gt; Notes…</td>
</tr>
</tbody>
</table>
### Variables Table (9): pmdTblVariable

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldVarID</td>
<td>Build &gt; Variables &gt; ID</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldVarType</td>
<td>Build &gt; Variables &gt; Type…</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldVarInitValue</td>
<td>Build &gt; Variables &gt; Initial Value</td>
</tr>
</tbody>
</table>

**Type Rule**

<table>
<thead>
<tr>
<th>Type Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 = Integer</td>
<td>pmdDataTypeInteger</td>
</tr>
<tr>
<td>4 = Real</td>
<td>pmdDataTypeReal</td>
</tr>
</tbody>
</table>

**Stats Type**

<table>
<thead>
<tr>
<th>Stats Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = None</td>
<td>pmdStatsTypeNone</td>
</tr>
<tr>
<td>2 = Basic or Summary</td>
<td>pmdStatsTypeBasicSum</td>
</tr>
<tr>
<td>3 = Time Series or By Unit</td>
<td>pmdStatsTypeTSUni</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>I</td>
<td>pmdFldVarStatsType</td>
<td>Build &gt; Variables &gt; Stats… &gt; (None/Basic/Time Series)</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldVarStatsBasis</td>
<td>Build &gt; Variables &gt; Stats… &gt; (Time-weighted/Observation-based)</td>
</tr>
</tbody>
</table>

**Statistics Basis Rule**

<table>
<thead>
<tr>
<th>Statistics Basis Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = Time Weighted</td>
<td>pmdStatsBasisTime</td>
</tr>
<tr>
<td>2 = Observation Based</td>
<td>pmdStatsBasisObserv</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>S</td>
<td>pmdFldVarNotes</td>
<td>Build &gt; Variables &gt; Notes…</td>
</tr>
</tbody>
</table>

### Arrays Table (10): pmdTblArray

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldArrayID</td>
<td>Build &gt; Arrays &gt; ID</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldArrayDimens</td>
<td>Build &gt; Arrays &gt; Dimensions</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldArrayType</td>
<td>Build &gt; Arrays &gt; Type…</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldArrayNotes</td>
<td>Build &gt; Arrays &gt; Notes…</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldArrayImportPath</td>
<td>Build &gt; Arrays &gt; Import File… &gt; Import File</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldArraySheetName</td>
<td>Build &gt; Arrays &gt; (Import) File… &gt; Sheet Name</td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td>pmdFldArrayStartCell</td>
<td>Build &gt; Arrays &gt; (Import) File… &gt; (Import) Start Cell</td>
</tr>
<tr>
<td>9</td>
<td>S</td>
<td>pmdFldArrayEndCell</td>
<td>Build &gt; Arrays &gt; (Import) File… &gt; (Import) End Cell</td>
</tr>
<tr>
<td>10</td>
<td>S</td>
<td>pmdFldArrayExportPath</td>
<td>Build &gt; Arrays &gt; Export File… &gt; Export File</td>
</tr>
<tr>
<td>11</td>
<td>S</td>
<td>pmdFldArrayExSheetName</td>
<td>Build &gt; Arrays &gt; (Export) File… &gt; Sheet Name</td>
</tr>
<tr>
<td>12</td>
<td>S</td>
<td>pmdFldArrayExStartCell</td>
<td>Build &gt; Arrays &gt; (Export) File… &gt; (Export) Start Cell</td>
</tr>
<tr>
<td>13</td>
<td>S</td>
<td>pmdFldArrayExEndCell</td>
<td>Build &gt; Arrays &gt; (Export) File… &gt; (Export) End Cell</td>
</tr>
<tr>
<td>14</td>
<td>S</td>
<td>pmdFldArrayImDBConnect</td>
<td>Build &gt; Arrays &gt; (Import) File… &gt; (Import) DB Connection String</td>
</tr>
<tr>
<td>15</td>
<td>S</td>
<td>pmdFldArrayImDBQueryProc</td>
<td>Build &gt; Arrays &gt; (Import) File… &gt; (Import) DB Query or Stored Procedure</td>
</tr>
<tr>
<td>17</td>
<td>I</td>
<td>pmdFldArrayImportType</td>
<td>Build &gt; Arrays &gt; (Import) File… &gt; (Import) Type (0=Excel, 1=Database)</td>
</tr>
<tr>
<td>20</td>
<td>I</td>
<td>pmdFldArrayPersistData</td>
<td>Build &gt; Arrays &gt; Persists (0=Clear, 1=Keep)</td>
</tr>
<tr>
<td>21</td>
<td>I</td>
<td>pmdFldArrayExportLastRep</td>
<td>Build &gt; Arrays &gt; (Export) File… &gt; Export after final replication only (0=no, 1=yes)</td>
</tr>
<tr>
<td>22</td>
<td>I</td>
<td>pmdFldArrayDisImport</td>
<td>Build &gt; Arrays &gt; Disable (Import) (0=no, 1=yes)</td>
</tr>
<tr>
<td>23</td>
<td>I</td>
<td>pmdFldArrayDisExport</td>
<td>Build &gt; Arrays &gt; Disable (Export) (0=no, 1=yes)</td>
</tr>
</tbody>
</table>
# ProModel Data Table Definitions

## Macros Table (11): pmdTblMacro

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldMacroID</td>
<td>Build &gt; Macros &gt; ID</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldMacroText</td>
<td>Build &gt; Macros &gt; Text…</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldMacroGroup</td>
<td>Build &gt; Macros &gt; Options… &gt; Resource Group</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldMacroRTIName</td>
<td>Build &gt; Macros &gt; Options… &gt; RTI &gt; Define &gt; Parameter Name</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldMacroRTIPrompt</td>
<td>Build &gt; Macros &gt; Options… &gt; RTI &gt; Define &gt; Prompt</td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td>pmdFldMacroRTIMinValue</td>
<td>Build &gt; Macros &gt; Options… &gt; RTI &gt; Define &gt; From</td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td>pmdFldMacroRTIMaxValue</td>
<td>Build &gt; Macros &gt; Options… &gt; RTI &gt; Define &gt; To</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>pmdFldMacroRTIType</td>
<td>Build &gt; Macros &gt; Options… &gt; RTI &gt; Define &gt; (type selections)</td>
</tr>
</tbody>
</table>

**Type Rule**
2 = Range  
3 = Unrestricted

## Subroutines Table (12): pmdTblSubroutine

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldSubRtnID</td>
<td>Build &gt; Subroutines &gt; ID</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldSubRtnLogic</td>
<td>Build &gt; Subroutines &gt; Logic…</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldSubRtnType</td>
<td>Build &gt; Subroutines &gt; Type…</td>
</tr>
</tbody>
</table>

**Type Rule**
0 = None  
2 = Integer  
4 = Real  
8 = Interactive

## Parameters Subtable (41): pmdTblSubRtnParam

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldSubRtnParamName</td>
<td>Build &gt; Subroutines &gt; Parameters… &gt; ID</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldSubRtnParamType</td>
<td>Build &gt; Subroutines &gt; Parameters… &gt; Type…</td>
</tr>
</tbody>
</table>

**Parameter Type Rule**
2 = Integer  
4 = Real

## Arrival Cycles Table (13): pmdTblArrivalCycle

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldArrCycID</td>
<td>Build &gt; More Elements &gt; Arrival Cycles &gt; ID</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldArrCycType</td>
<td>Build &gt; More Elements &gt; Arrival Cycles &gt; Qty/%</td>
</tr>
</tbody>
</table>

**Quantity Rule**
0 = Percent  
1 = Quantity

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldArrCycCumulative</td>
<td>Build &gt; More Elements &gt; Arrival Cycles &gt; Cumulative…</td>
</tr>
</tbody>
</table>
### Arrival Cycle Values Subtable (42): pmdTblArrivalCycData

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldArrCycTime</td>
<td>Build &gt; More Elements &gt; Arrival Cycles &gt; Table… &gt; Time</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldArrCycQtyPercent</td>
<td>Build &gt; More Elements &gt; Arrival Cycles &gt; Table… &gt; Qty%</td>
</tr>
</tbody>
</table>

### Table Functions Table (14): pmdTblTableFunction

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldTableFunID</td>
<td>Build &gt; More Elements &gt; Table Functions &gt; ID</td>
</tr>
</tbody>
</table>

### Function Values Subtable (43): pmdTblFunctionData

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldTableFunIndepVal</td>
<td>Build &gt; More Elements &gt; Table Functions &gt; Table… &gt; Independent Value</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldTableFunDepVal</td>
<td>Build &gt; More Elements &gt; Table Functions &gt; Table… &gt; Dependent Value</td>
</tr>
</tbody>
</table>

### User Distributions Table (15): pmdTblUserDistrib

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldUserDistID</td>
<td>Build &gt; More Elements &gt; User Distributions &gt; ID</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldUserDistType</td>
<td>Build &gt; More Elements &gt; User Distributions &gt; Type…</td>
</tr>
</tbody>
</table>

#### Type Rule
1 = Discrete
2 = Continuous

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldUserDistCumulative</td>
<td>Build &gt; More Elements &gt; User Distributions &gt; Cumulative…</td>
</tr>
</tbody>
</table>

### User Distributions Values Subtable (44): pmdTblUserDistribData

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldUserDistPercentage</td>
<td>Build &gt; More Elements &gt; User Distributions &gt; Table… &gt; Percentage</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldUserDistValue</td>
<td>Build &gt; More Elements &gt; User Distributions &gt; Table… &gt; Value</td>
</tr>
</tbody>
</table>

### External Files Table (16): pmdTblExternalFile

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldXfilesID</td>
<td>Build &gt; More Elements &gt; External Files &gt; ID</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldXfilesType</td>
<td>Build &gt; More Elements &gt; External Files &gt; Type…</td>
</tr>
</tbody>
</table>

#### Type Rule
1 = General Read
2 = General Write
3 = Entity Location
4 = Arrival
5 = Shift
6 = DLL
7 = Excel
### Streams Table (17): pmdTblStream

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldStreamNum</td>
<td>Build &gt; More Elements &gt; Streams &gt; Stream #</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldStreamSeedNum</td>
<td>Build &gt; More Elements &gt; Streams &gt; Seed #</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldStreamReset</td>
<td>Build &gt; More Elements &gt; Streams &gt; Reset…</td>
</tr>
</tbody>
</table>

**Reset Rule**
0 = No  
1 = Yes

### General Information Table (18): pmdTblGenInfo

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldGenInfoTitle</td>
<td>Build &gt; General Information &gt; Title</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldGenInfoDefTimeUnits</td>
<td>Build &gt; General Information &gt; Time Units</td>
</tr>
</tbody>
</table>

**Default Time Units Rule**
1 = Seconds  
2 = Minutes  
3 = Hours  
4 = Days

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldGenInfoDefDistUnits</td>
<td>Build &gt; General Information &gt; Distance Units</td>
</tr>
</tbody>
</table>

**Default Distance Units Rule**
1 = Feet  
2 = Meters

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldGenInfoGLibFile</td>
<td>Build &gt; General Information &gt; Graphic Library File…</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldGenInfoInitLogic</td>
<td>Build &gt; General Information &gt; Initialization Logic…</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldGenInfoTermLogic</td>
<td>Build &gt; General Information &gt; Termination Logic…</td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td>pmdFldGenInfoNotes</td>
<td>Build &gt; General Information &gt; Model Notes…</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td>pmdFldGenInfoModFile</td>
<td>Path of the .MOD file.</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>pmdFldGenInfoZoomPct</td>
<td>Layout zoom percentage.</td>
</tr>
</tbody>
</table>

### Process Table (19): pmdTblProcessing

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldProcEntName</td>
<td>Build &gt; Processing &gt; Entity…</td>
</tr>
<tr>
<td>2</td>
<td>Bool</td>
<td>pmdFldProcPreempt</td>
<td>Build &gt; Processing &gt; Entity… &gt; Preemption Process</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldProcLocName</td>
<td>Build &gt; Processing &gt; Location…</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldProcOpLogic</td>
<td>Build &gt; Processing &gt; Operation…</td>
</tr>
</tbody>
</table>
### Routing Subtable (20): pmdTblRouting

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>S</td>
<td>pmdFldRtgEntName</td>
<td>Build &gt; Processing &gt; Output…</td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td>pmdFldRtgLocName</td>
<td>Build &gt; Processing &gt; Destination…</td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td>pmdFldRtgPriority</td>
<td>Build &gt; Processing &gt; Destination… &gt; Priority</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>pmdFldRtgNewBlock</td>
<td>Build &gt; Processing &gt; Rule… &gt; New Block</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldRtgNewEntity</td>
<td>Build &gt; Processing &gt; Rule… &gt; New Entity</td>
</tr>
<tr>
<td>11</td>
<td>S</td>
<td>pmdFldRtgQuantity</td>
<td>Build &gt; Processing &gt; Rule… &gt; Quantity</td>
</tr>
<tr>
<td>12</td>
<td>I</td>
<td>pmdFldRtgRoutingRule</td>
<td>Build &gt; Processing &gt; Rule… &gt; (choice list)</td>
</tr>
</tbody>
</table>

#### Routing Rules
- 1 = First Available  pmdRtgFirstAvail
- 2 = Most Available   pmdRtgMostAvailCap
- 3 = By Turn          pmdRtgByTurn
- 4 = If Join Request   pmdRtgJoinRequest
- 5 = If Load Request   pmdRtgLoadRequest
- 6 = If Send           pmdRtgIfSend
- 7 = Until Full        pmdRtgUntilFull
- 8 = As Alternate      pmdRtgAsAlt
- 9 = Probability       pmdRtgProb
- 10 = User Condition   pmdRtgCond
- 11 = Random           pmdRtgRandom
- 12 = Longest Unoccupied pmdRtgLongestEmpty
- 13 = If Empty         pmdRtgIfEmpty
- 14 = Continue         pmdRtgContinue
- 15 = As Backup        pmdRtgAsBackup
- 16 = Dependent        pmdRtgDependent

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>R</td>
<td>pmdFldRtgProbability</td>
<td>Build &gt; Processing &gt; Rule… &gt; Probability</td>
</tr>
<tr>
<td>14</td>
<td>S</td>
<td>pmdFldRtgCondition</td>
<td>Build &gt; Processing &gt; Rule… &gt; User Condition</td>
</tr>
<tr>
<td>15</td>
<td>S</td>
<td>pmdFldRtgMoveLogic</td>
<td>Build &gt; Processing &gt; Move Logic…</td>
</tr>
</tbody>
</table>

### Model Parameters Table (21): pmdTblModelParam

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldModParamValue</td>
<td>Simulation &gt; Model Parameters &gt; Change</td>
</tr>
</tbody>
</table>

### Scenarios Table (22): pmdTblScenario

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldScenName</td>
<td>Simulation &gt; Scenarios</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldScenDisable</td>
<td>Simulation &gt; Scenarios &gt; Disable (toggles on/off for selected record)</td>
</tr>
</tbody>
</table>
## ProModelData Table Definitions

### Scenario Parameter Subtable (56): pmdTblScenParam

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldScenParamValue</td>
<td>Simulation &gt; Scenarios &gt; (Add/Edit) &gt; Change</td>
</tr>
</tbody>
</table>

### Simulation Options (23): pmdTblSimOption

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldSimOptOutPath</td>
<td>Simulation &gt; Options &gt; Output Path</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldSimOptTimeBasis</td>
<td>Simulation &gt; Options &gt; Define run length by</td>
</tr>
</tbody>
</table>

**Time Basis Rule**

- 0 = Time Only
- 1 = Calendar Date
- 2 = Weekly Time

**Note:** Values 3 & 4 are used only if Time Basis = 0.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldSimOptRunHours</td>
<td>Simulation &gt; Options &gt; Run Hours (Time Only)</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldSimOptWarmPeriod</td>
<td>Simulation &gt; Options &gt; Warmup Hours (Time Only)</td>
</tr>
<tr>
<td>5</td>
<td>I</td>
<td>pmdFldSimOptWarmMonCal</td>
<td>Simulation &gt; Options &gt; Warmup Start &gt; Month (Calendar)</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldSimOptWarmDayCal</td>
<td>Simulation &gt; Options &gt; Warmup Start &gt; Day (Calendar)</td>
</tr>
<tr>
<td>7</td>
<td>I</td>
<td>pmdFldSimOptWarmYrCal</td>
<td>Simulation &gt; Options &gt; Warmup Start &gt; Year (Calendar)</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td>pmdFldSimOptWarmHr</td>
<td>Simulation &gt; Options &gt; Warmup Start &gt; Hour (Weekly, Calendar)</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>pmdFldSimOptWarmMin</td>
<td>Simulation &gt; Options &gt; Warmup Start &gt; Min (Weekly, Calendar)</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldSimOptBegMonCal</td>
<td>Simulation &gt; Options &gt; Sim. Begin &gt; Month (Calendar)</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldSimOptBegDayCal</td>
<td>Simulation &gt; Options &gt; Sim. Begin &gt; Day (Calendar)</td>
</tr>
<tr>
<td>12</td>
<td>I</td>
<td>pmdFldSimOptBegYrCal</td>
<td>Simulation &gt; Options &gt; Sim. Begin &gt; Year (Calendar)</td>
</tr>
<tr>
<td>13</td>
<td>I</td>
<td>pmdFldSimOptBegHr</td>
<td>Simulation &gt; Options &gt; Sim. Begin &gt; Hour (Weekly, Calendar)</td>
</tr>
<tr>
<td>14</td>
<td>I</td>
<td>pmdFldSimOptBegMin</td>
<td>Simulation &gt; Options &gt; Sim. Begin &gt; Min (Weekly, Calendar)</td>
</tr>
<tr>
<td>15</td>
<td>I</td>
<td>pmdFldSimOptEndMonCal</td>
<td>Simulation &gt; Options &gt; Sim. End &gt; Month (Calendar)</td>
</tr>
<tr>
<td>16</td>
<td>I</td>
<td>pmdFldSimOptEndDayCal</td>
<td>Simulation &gt; Options &gt; Sim. End &gt; Day (Calendar)</td>
</tr>
<tr>
<td>17</td>
<td>I</td>
<td>pmdFldSimOptEndYrCal</td>
<td>Simulation &gt; Options &gt; Sim. End &gt; Year (Calendar)</td>
</tr>
<tr>
<td>18</td>
<td>I</td>
<td>pmdFldSimOptEndHr</td>
<td>Simulation &gt; Options &gt; Sim. End &gt; Hour (Weekly, Calendar)</td>
</tr>
<tr>
<td>19</td>
<td>I</td>
<td>pmdFldSimOptEndMin</td>
<td>Simulation &gt; Options &gt; Sim. End &gt; Min (Weekly, Calendar)</td>
</tr>
<tr>
<td>20</td>
<td>I</td>
<td>pmdFldSimOptRptMethod</td>
<td>Simulation &gt; Options &gt; Output Reporting</td>
</tr>
</tbody>
</table>

**Output Report Method Rule**

- 0 = Standard
- 1 = Batch Mean
- 2 = Periodic

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>S</td>
<td>pmdFldSimOptRptIntLength</td>
<td>Simulation &gt; Options &gt; Output Reporting &gt; Interval Length</td>
</tr>
<tr>
<td>22</td>
<td>S</td>
<td>pmdFldSimOptNumReps</td>
<td>Simulation &gt; Options &gt; Output Reporting &gt; Number of Replications</td>
</tr>
<tr>
<td>23</td>
<td>I</td>
<td>pmdFldSimOptClockPrecision</td>
<td>Simulation &gt; Options &gt; Clock Precision &gt; (drop-down list)</td>
</tr>
</tbody>
</table>
### Clock Precision Rule

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No Clock Precision Chosen</td>
</tr>
<tr>
<td>1</td>
<td>pmdSimClockPrecNone</td>
</tr>
<tr>
<td>2</td>
<td>pmdSimClockPrec1</td>
</tr>
<tr>
<td>3</td>
<td>pmdSimClockPrec10</td>
</tr>
<tr>
<td>4</td>
<td>pmdSimClockPrec100</td>
</tr>
<tr>
<td>5</td>
<td>pmdSimClockPrec1000</td>
</tr>
<tr>
<td>6</td>
<td>pmdSimClockPrec10000</td>
</tr>
</tbody>
</table>

#### Clock Precision Units Rule

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmdTimeUnitSec</td>
</tr>
<tr>
<td>2</td>
<td>pmdTimeUnitMin</td>
</tr>
<tr>
<td>3</td>
<td>pmdTimeUnitHr</td>
</tr>
<tr>
<td>4</td>
<td>pmdTimeUnitDay</td>
</tr>
</tbody>
</table>

### Location Graphics (45): pmdTblLocGraphic

<table>
<thead>
<tr>
<th>Field</th>
<th>Graphic Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>pmdGfxTypeLibrary</td>
<td>Library</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>pmdGfxTypeQ</td>
<td>Queue / Conveyor</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>pmdGfxTypeTank</td>
<td>Gauge / Tank</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>pmdGfxTypeCounter</td>
<td>Counter</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>pmdGfxTypeText</td>
<td>Text</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>pmdGfxTypeStatus</td>
<td>Status Light</td>
</tr>
<tr>
<td>1</td>
<td>7</td>
<td>pmdGfxTypeEntSpot</td>
<td>Entity Spot</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>pmdGfxTypeRegion</td>
<td>Region</td>
</tr>
</tbody>
</table>
## Library Graphics (Graphic Type Table 1)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGfxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldGfxLibWidth</td>
<td>Width</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldGfxLibHeight</td>
<td>Height</td>
</tr>
<tr>
<td>4</td>
<td>R</td>
<td>pmdFldGfxLibWidR</td>
<td>Real Width (feet or meters)</td>
</tr>
<tr>
<td>5</td>
<td>R</td>
<td>pmdFldGfxLibHtR</td>
<td>Real Height (feet or meters)</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldGfxLibRotat</td>
<td>Rotation</td>
</tr>
<tr>
<td>7</td>
<td>I</td>
<td>pmdFldGfxLibID</td>
<td>ID</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td>pmdFldGfxLibSpotX</td>
<td>Hotspot X value</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>pmdFldGfxLibSpotY</td>
<td>Hotspot Y value</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldGfxLibXpos</td>
<td>Position X value</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldGfxLibYpos</td>
<td>Position Y value</td>
</tr>
<tr>
<td>12</td>
<td>I</td>
<td>pmdFldGfxLibColor</td>
<td>Color</td>
</tr>
<tr>
<td>20</td>
<td>S</td>
<td>pmdFldGfxLibConvWidth</td>
<td>Width on conveyor (Entities only)</td>
</tr>
<tr>
<td>21</td>
<td>S</td>
<td>pmdFldGfxLibConvLength</td>
<td>Length on conveyor (Entities only)</td>
</tr>
</tbody>
</table>

## Queue/Conveyor Graphics (Graphics Type Table 2)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGfxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldGfxQIsQ</td>
<td>Conveyor?</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Conveyor Rule</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Yes</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldGfxQSpeed</td>
<td>Speed (Conveyor Only)</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>pmdFldGfxQLength</td>
<td>Length (Conveyor Only)</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>pmdFldGfxQAccum</td>
<td>Accumulating?</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Accumulating Rule</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Yes</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldGfxQEEntDir</td>
<td>Entity Orientation</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Entity Orientation Rule</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = Lengthwise</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Widthwise</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>I</td>
<td>pmdFldGfxQBrdClr</td>
<td>Border Color</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td>pmdFldGfxQFillClr</td>
<td>Fill Color</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td>pmdFldGfxQStyle</td>
<td>Graphic Style</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Graphic Style Rule</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Solid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = Line</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = Roller</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldGfxQWWidth</td>
<td>Width</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldGfxQIsVis</td>
<td>Invisible?</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Invisible Rule</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Yes</td>
<td></td>
</tr>
</tbody>
</table>
### Gauge/Tank Graphics (Graphics Type Table 3)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGfxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldGfxTnkLeft</td>
<td>Left</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldGfxTnkTop</td>
<td>Top</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldGfxTnkRight</td>
<td>Right</td>
</tr>
<tr>
<td>5</td>
<td>I</td>
<td>pmdFldGfxTnkBotm</td>
<td>Bottom</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>pmdFldGfxTnkBrdrClr</td>
<td>Border Color</td>
</tr>
<tr>
<td>7</td>
<td>I</td>
<td>pmdFldGfxTnkEmptyClr</td>
<td>Empty Color</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td>pmdFldGfxTnkFillClr</td>
<td>Fill Color</td>
</tr>
<tr>
<td>9</td>
<td>R</td>
<td>pmdFldGfxTnkMinVal</td>
<td>Minimum Value</td>
</tr>
<tr>
<td>10</td>
<td>R</td>
<td>pmdFldGfxTnkMaxVal</td>
<td>Maximum Value</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldGfxTnkDir</td>
<td>Direction</td>
</tr>
</tbody>
</table>

**Direction Rule**
1 = Up  
2 = Down  
3 = Left  
4 = Right

12 | I | pmdFldGfxTnkScale | Show Scale? |

**Scale Rule**
0 = No  
1 = Yes

13 | I | pmdFldGfxTnkBrdr | Show Border? |

**Border Rule**
0 = No  
1 = Yes

14 | I | pmdFldGfxTnkIsTank | Tank? |

**Tank Rule**
0 = No  
1 = Yes

### Counter Graphics (Graphics Type Table 4)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGfxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldGfxCtrLeft</td>
<td>Left</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldGfxCtrTop</td>
<td>Top</td>
</tr>
<tr>
<td>12</td>
<td>I</td>
<td>pmdFldGfxCtrRight</td>
<td>Right</td>
</tr>
<tr>
<td>13</td>
<td>I</td>
<td>pmdFldGfxCtrBotm</td>
<td>Bottom</td>
</tr>
<tr>
<td>14</td>
<td>I</td>
<td>pmdFldGfxCtrFrType</td>
<td>Frame Type</td>
</tr>
</tbody>
</table>

**Frame Type Rule**
1 = Invisible  
2 = Plain  
3 = Raised  
4 = Recessed  
5 = Shadow  
6 = None

15 | I | pmdFldGfxCtrFrShape | Frame Shape |
### Frame Shape Rule

1 = Rectangle  
2 = Round Rectangle  
3 = Ellipse  
4 = Diamond

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>I</td>
<td>pmdFldGlxCrtFrClr</td>
</tr>
<tr>
<td>17</td>
<td>I</td>
<td>pmdFldGlxCrtBrdrClr</td>
</tr>
<tr>
<td>20</td>
<td>I</td>
<td>pmdFldGlxCrtFontSize</td>
</tr>
<tr>
<td>21</td>
<td>S</td>
<td>pmdFldGlxCrtFont</td>
</tr>
<tr>
<td>22</td>
<td>I</td>
<td>pmdFldGlxCrtFontClr</td>
</tr>
</tbody>
</table>
### Text Graphics (Graphic Type Table 5)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGfxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldGfxTxtLabel</td>
<td>Label Text</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td>pmdFldGfxTxtLeft</td>
<td>Left</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td>pmdFldGfxTxtTop</td>
<td>Top</td>
</tr>
<tr>
<td>12</td>
<td>I</td>
<td>pmdFldGfxTxtRight</td>
<td>Right</td>
</tr>
<tr>
<td>13</td>
<td>I</td>
<td>pmdFldGfxTxtBotm</td>
<td>Bottom</td>
</tr>
<tr>
<td>14</td>
<td>I</td>
<td>pmdFldGfxTxtFrType</td>
<td>Frame Type</td>
</tr>
</tbody>
</table>

**Frame Type Rule**
- 1 = Invisible
- 2 = Plain
- 3 = Raised
- 4 = Recessed
- 5 = Shadow
- 6 = None

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>I</td>
<td>pmdFldGfxTxtFrShape</td>
<td>Frame Shape</td>
</tr>
</tbody>
</table>

**Frame Shape Rule**
- 1 = Rectangle
- 2 = Round Rectangle
- 3 = Ellipse
- 4 = Diamond

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>I</td>
<td>pmdFldGfxTxtFrClr</td>
<td>Frame Color</td>
</tr>
<tr>
<td>17</td>
<td>I</td>
<td>pmdFldGfxTxtBrdrClr</td>
<td>Frame Border Color</td>
</tr>
<tr>
<td>20</td>
<td>I</td>
<td>pmdFldGfxTxtFontSize</td>
<td>Font Size</td>
</tr>
<tr>
<td>21</td>
<td>S</td>
<td>pmdFldGfxTxtFont</td>
<td>Font Name</td>
</tr>
<tr>
<td>22</td>
<td>I</td>
<td>pmdFldGfxTxtFontClr</td>
<td>Font Color</td>
</tr>
<tr>
<td>23</td>
<td>I</td>
<td></td>
<td>Alignment</td>
</tr>
</tbody>
</table>

**Alignment Rule**
- 1 = Left
- 2 = Center
- 3 = Right

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>I</td>
<td></td>
<td>Rotation</td>
</tr>
</tbody>
</table>

**Rotation Rule**
- 0 = None
- 1 = 90 degrees
- 2 = 180 degrees
- 3 = 270 degrees

### Status Light Graphics (Graphic Type Table 6)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGlxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldGlxLightX</td>
<td>X Position</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldGlxLightY</td>
<td>Y Position</td>
</tr>
</tbody>
</table>
### Entity Spot Graphics (Graphic Type Table 7)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGfxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldGfxSpotX</td>
<td>X Position</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldGfxSpotY</td>
<td>Y Position</td>
</tr>
</tbody>
</table>

### Region Graphics (Graphic Type Table 8)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldGfxType</td>
<td>Graphic Type</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldGfxRgnLeft</td>
<td>Left</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldGfxRgnTop</td>
<td>Top</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldGfxRgnRight</td>
<td>Right</td>
</tr>
<tr>
<td>5</td>
<td>I</td>
<td>pmdFldGfxRgnBotm</td>
<td>Bottom</td>
</tr>
</tbody>
</table>

### Resource Graphics (46): pmdTblResGraphic

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>pmdGfxTypeLibrary</td>
<td>Library</td>
</tr>
</tbody>
</table>

### Entity Graphics (47): pmdTblEntGraphic

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>pmdGfxTypeLibrary</td>
<td>Library</td>
</tr>
</tbody>
</table>

### Background Graphics (49): pmdTblBackGraphic

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td></td>
<td>1=Library, 6=Text</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td></td>
<td>Font color (RGB)</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td></td>
<td>Position Locked? (0 = no, 1 = yes)</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td></td>
<td>X-coordinate of upper left corner of graphic</td>
</tr>
<tr>
<td>9</td>
<td>I</td>
<td></td>
<td>Y-coordinate of upper left corner of graphic</td>
</tr>
<tr>
<td>10</td>
<td>I</td>
<td></td>
<td>X-coordinate of lower right corner of graphic</td>
</tr>
<tr>
<td>11</td>
<td>I</td>
<td></td>
<td>Y-coordinate of lower right corner of graphic</td>
</tr>
<tr>
<td>100</td>
<td>S</td>
<td></td>
<td>Text shown on graphic</td>
</tr>
<tr>
<td>101</td>
<td>I</td>
<td></td>
<td>Frame type (1=invisible, 2=plain, 3=raised, 4=recessed, 5=shadow, 6=no border)</td>
</tr>
<tr>
<td>102</td>
<td>I</td>
<td></td>
<td>Frame shape (1=rectangle, 2=rounded rectangle, 3=ellipse, 4=diamond)</td>
</tr>
<tr>
<td>103</td>
<td>I</td>
<td></td>
<td>Frame border color (RGB)</td>
</tr>
<tr>
<td>120</td>
<td>I</td>
<td></td>
<td>Font size (use negative number to specify point size)</td>
</tr>
<tr>
<td>121</td>
<td>S</td>
<td></td>
<td>Font name</td>
</tr>
<tr>
<td>122</td>
<td>I</td>
<td></td>
<td>Alignment (1=left, 2=center, 3=right)</td>
</tr>
<tr>
<td>123</td>
<td>I</td>
<td></td>
<td>Rotation (0=0 degrees, 1=90 degrees, 2=180 degrees, 3=270 degrees)</td>
</tr>
</tbody>
</table>
### Variable Graphics (60): pmdTblVarGraphic

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>pmdGfxTypeCounter</td>
<td>Counter</td>
</tr>
</tbody>
</table>

### Model Defaults Table (50): pmdTblModelDefaults

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldModDfltModPath</td>
<td>Tools &gt; Options &gt; Default Folders &gt; Models</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>pmdFldModDfltGfxPath</td>
<td>Tools &gt; Options &gt; Default Folders &gt; Graphics Library</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>pmdFldModDfltOutPath</td>
<td>Tools &gt; Options &gt; Default Folders &gt; Output Results</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>Bool pmdFldModDfltSaveSet</td>
<td>Save defaults to .INI file?</td>
</tr>
<tr>
<td>5</td>
<td>I</td>
<td>Bool pmdFldModDfltShowPath</td>
<td>Views &gt; Show Hidden Networks</td>
</tr>
<tr>
<td>6</td>
<td>I</td>
<td>Bool pmdFldModDfltShowRtg</td>
<td>Views &gt; Show Routings</td>
</tr>
<tr>
<td>7</td>
<td>I</td>
<td>Bool pmdFldModDfltShowGrid</td>
<td>Views &gt; Show Grid</td>
</tr>
<tr>
<td>8</td>
<td>I</td>
<td>Bool pmdFldModDfltLongMenu</td>
<td>Tools &gt; Options &gt; Long Build Menu checkbox</td>
</tr>
</tbody>
</table>

### Views Table (55): pmdTblView

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>pmdFldViewName</td>
<td>View &gt; Views &gt; Define &gt; View List</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldViewXOffset</td>
<td>Relative horizontal position of view</td>
</tr>
<tr>
<td>3</td>
<td>I</td>
<td>pmdFldViewYOffset</td>
<td>Relative vertical position of view</td>
</tr>
<tr>
<td>4</td>
<td>I</td>
<td>pmdFldViewWidth</td>
<td>View width in pixels</td>
</tr>
<tr>
<td>5</td>
<td>I</td>
<td>pmdFldViewHeight</td>
<td>View height in pixels</td>
</tr>
</tbody>
</table>

### Queue/Conveyor Joints Table (61): pmdTblQJoint

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>pmdFldQJointXPos</td>
<td>(Distance, in pixels, from Left margin)</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td>pmdFldQJointYPos</td>
<td>(Distance, in pixels, from Top margin)</td>
</tr>
</tbody>
</table>

### Routing Points Table (62):

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Constant</th>
<th>Description or Location in ProModel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td></td>
<td>(Distance, in pixels, from Left margin)</td>
</tr>
<tr>
<td>2</td>
<td>I</td>
<td></td>
<td>(Distance, in pixels, from Top margin)</td>
</tr>
</tbody>
</table>
## Runtime Table.

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Visual Basic Constant</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations</td>
<td>pmrTblLocation</td>
<td>1</td>
</tr>
<tr>
<td>Single Capacity Locations</td>
<td>pmrTblLocSingle</td>
<td>2</td>
</tr>
<tr>
<td>Multi Capacity Locations</td>
<td>pmrTblLocMulti</td>
<td>3</td>
</tr>
<tr>
<td>Resources</td>
<td>pmrTblResource</td>
<td>5</td>
</tr>
<tr>
<td>Resource States (by Percentage)</td>
<td>pmrTblResState</td>
<td>6</td>
</tr>
<tr>
<td>Node Entries</td>
<td>pmrTblNodeEntry</td>
<td>7</td>
</tr>
<tr>
<td>Failed Arrivals</td>
<td>pmrTblFailArrival</td>
<td>8</td>
</tr>
<tr>
<td>Entity Activity</td>
<td>pmrTblEntAct</td>
<td>9</td>
</tr>
<tr>
<td>Entity States (by Percentage)</td>
<td>pmrTblEntState</td>
<td>10</td>
</tr>
<tr>
<td>Variables</td>
<td>pmrTblVariable</td>
<td>12</td>
</tr>
<tr>
<td>Logs</td>
<td>pmrTblLog</td>
<td>13</td>
</tr>
<tr>
<td>Location Costing</td>
<td>pmrTblLocCost</td>
<td>14</td>
</tr>
<tr>
<td>Resource Costing</td>
<td>pmrTblResCost</td>
<td>16</td>
</tr>
<tr>
<td>Entity Activity Costing</td>
<td>pmrTblEntCost</td>
<td>17</td>
</tr>
</tbody>
</table>

### Locations Runtime Fields (1): pmrTblLocation

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldLocEntries</td>
<td>Total Entries</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldLocAvgMins</td>
<td>Avg Min per Entry</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldLocAvgCnt</td>
<td>Avg Contents</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldLocMaxCnt</td>
<td>Max Contents</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldLocCurCnt</td>
<td>Cur Contents</td>
</tr>
<tr>
<td>6</td>
<td>pmrFldLocUtilPct</td>
<td>Utilization %</td>
</tr>
</tbody>
</table>

### Single Capacity Locations Runtime Fields (2): pmrTblLocSingle

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldLocSOperPct</td>
<td>Operation %</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldLocSSetupPct</td>
<td>Setup %</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldLocSIdlePct</td>
<td>Idle %</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldLocSWaitPct</td>
<td>Waiting %</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldLocSBlkdPct</td>
<td>Blocked %</td>
</tr>
<tr>
<td>6</td>
<td>pmrFldLocSDownPct</td>
<td>Down %</td>
</tr>
</tbody>
</table>

### Multi Capacity Locations Runtime Fields (3): pmrTblLocMulti

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldLocEMEmptyPct</td>
<td>Empty %</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldLocEMPartFullPct</td>
<td>Part Occup %</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldLocEMFullPct</td>
<td>Full %</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldLocEMDownPct</td>
<td>Down %</td>
</tr>
</tbody>
</table>
Resource Runtime Fields (5): pmrTblResource

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldResTimesUsed</td>
<td># Times Used</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldResAvgMins</td>
<td>Avg Min per Usage</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldResTrvl2Use</td>
<td>Travel to Use</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldResTrvl2Park</td>
<td>Travel to Park</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldResBlkdTrvlPct</td>
<td>Blocked in Travel %</td>
</tr>
<tr>
<td>6</td>
<td>pmrFldResUtilPct</td>
<td>Utilization %</td>
</tr>
</tbody>
</table>

Resource States (By Percentage) Runtime Fields (6): pmrTblResState

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldResStPctUse</td>
<td>In Use %</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldResStPctTrvl2Use</td>
<td>Travel to Use %</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldResStPctTrvl2Prk</td>
<td>Travel to Park %</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldResStPctIdle</td>
<td>Idle %</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldResStPctDown</td>
<td>Down %</td>
</tr>
</tbody>
</table>

Node Entries Runtime Fields (7): pmrTblNodeEntry

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldNodeTotEntry</td>
<td>Total Entries</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldNodeBlkdEntry</td>
<td>Blocked Entries</td>
</tr>
</tbody>
</table>

Failed Arrivals Runtime Fields (8): pmrTblFailArrival

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldNodeTotFail</td>
<td>Total Failed</td>
</tr>
</tbody>
</table>

Entity Activity Runtime Fields (9): pmrTblEntAct

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldEntTotExit</td>
<td>Total Exit</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldEntCurQty</td>
<td>Cur Qty Sys</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldEntAvgMinSys</td>
<td>Avg Min System</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldEntAvgMinMove</td>
<td>Avg Min Move Logic</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldEntAvgWaitRes</td>
<td>Avg Wait Res</td>
</tr>
<tr>
<td>6</td>
<td>pmrFldEntAvgMinOper</td>
<td>Avg Min Operation</td>
</tr>
<tr>
<td>7</td>
<td>pmrFldEntAvgMinBlkd</td>
<td>Avg Min Blocked</td>
</tr>
</tbody>
</table>

Entity States (By Percentage) Runtime Fields (10): pmrTblEntState

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldEntStPctMove</td>
<td>In Move Logic %</td>
</tr>
</tbody>
</table>
## Runtime Table.

2. pmrFldEntStPctWait | Wait for Res %  
3. pmrFldEntStPctOper | In Operation %  
4. pmrFldEntStPctBlkd | Blocked %  

### Variables Runtime Fields (12): pmrTblVariable

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldVarTotChgs</td>
<td>Total Changes</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldVarAvgMinPer</td>
<td>Avg Min Per Change</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldVarMinVal</td>
<td>Min Value</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldVarMaxVal</td>
<td>Max Value</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldVarCurVal</td>
<td>Current Value</td>
</tr>
<tr>
<td>6</td>
<td>pmrFldVarAvgVal</td>
<td>Avg Value</td>
</tr>
</tbody>
</table>

### Logs Runtime Fields (13): pmrTblLog

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldLogNumObsrv</td>
<td># Observations</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldLogMinVal</td>
<td>Min Value</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldLogMaxVal</td>
<td>Max Value</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldLogAvgVal</td>
<td>Avg Value</td>
</tr>
</tbody>
</table>

### Location Costing Runtime Fields (14): pmrTblLocCost

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldLCostOperDir</td>
<td>$ Operation</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldLCostOperPct</td>
<td>% Operation</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldLCostResDir</td>
<td>$ Resource Cost</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldLCostResPct</td>
<td>% Resource Cost</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldLCostTotDir</td>
<td>$ Total Cost</td>
</tr>
<tr>
<td>6</td>
<td>pmrFldLCostTotPct</td>
<td>% Total Cost</td>
</tr>
</tbody>
</table>

### Resource Costing Runtime Fields (16): pmrTblResCost

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldRCostNonUseDir</td>
<td>$ Non-use Cost</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldRCostNonUsePct</td>
<td>% Non-Use Cost</td>
</tr>
<tr>
<td>3</td>
<td>pmrFldRCostUseDir</td>
<td>$ Usage Cost</td>
</tr>
<tr>
<td>4</td>
<td>pmrFldRCostUsePct</td>
<td>% Usage Cost</td>
</tr>
<tr>
<td>5</td>
<td>pmrFldRCostTotDir</td>
<td>$ Total Cost</td>
</tr>
<tr>
<td>6</td>
<td>pmrFldRCostTotPct</td>
<td>% Total Cost</td>
</tr>
</tbody>
</table>
Entity Activity Costing Runtime Fields (17): pmrTblEntCost

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>pmrFldECostTotDir</td>
<td>$ Total Cost</td>
</tr>
<tr>
<td>2</td>
<td>pmrFldECostTotPct</td>
<td>% Total Cost</td>
</tr>
</tbody>
</table>
### Result Codes (Errors)

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Description of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>pmdErrNoError</td>
<td>No Error.</td>
</tr>
<tr>
<td>1</td>
<td>pmdErrInvalidTableNum</td>
<td>There is no table by that number in ProModel.</td>
</tr>
<tr>
<td>2</td>
<td>pmdErrMethodNotApplicable</td>
<td>Function does not apply to the selected record (e.g. - SelectMainRecord-ByName() on the Processing Table)</td>
</tr>
<tr>
<td>3</td>
<td>pmdErrInvalidRecordNum</td>
<td>Record by that name does not exist, or record has not been selected (when using Set… or Get…)</td>
</tr>
<tr>
<td>4</td>
<td>pmdErrInvalidFieldNum</td>
<td>There is no field (column) by that number in the selected table.</td>
</tr>
<tr>
<td>5</td>
<td>pmdErrDataTypeMismatch</td>
<td>Set… or Get… function does not match data type (e.g. - SetStringField-Value() used on an integer field</td>
</tr>
<tr>
<td>6</td>
<td>pmdErrFieldNotApplicable</td>
<td>Field does not exist for the selected record (e.g. - trying to access the RTI fields for non-RTI macros)</td>
</tr>
<tr>
<td>7</td>
<td>pmdErrNotImplemented</td>
<td>The selected element has not been ActiveX enabled yet.</td>
</tr>
<tr>
<td>8</td>
<td>pmdErrGfxNotImplemented</td>
<td>Graphic element has not been ActiveX enabled yet.</td>
</tr>
<tr>
<td>9</td>
<td>pmdErrValueNotApplicable</td>
<td>Value does not apply for selected field (time units = 6. Arrivals &gt; ent name set to non-existing rec.)</td>
</tr>
<tr>
<td>11</td>
<td>pmdErrParentNotSelected</td>
<td>The parent table has not been selected</td>
</tr>
<tr>
<td>12</td>
<td>pmdErrObsolete</td>
<td>The specified ActiveX element is no longer used</td>
</tr>
<tr>
<td>13</td>
<td>pmdErrDataProtected</td>
<td>The model is protected, so data can't be accessed</td>
</tr>
<tr>
<td>14</td>
<td>pmdErrKeyNotFound</td>
<td>No hardware key, data can't be accessed</td>
</tr>
<tr>
<td>15</td>
<td>pmdErrReadOnlyField</td>
<td>Attempting to write to a read-only field</td>
</tr>
<tr>
<td>16</td>
<td>pmdErrJointNotFound</td>
<td>Attempting to delete queue/conveyor joint, when none exist (i.e. - has only start &amp; end points)</td>
</tr>
<tr>
<td>99</td>
<td>pmdErrOther</td>
<td>Any other kind of error</td>
</tr>
</tbody>
</table>
## Events

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>When does the event fire?</th>
<th>Return Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>pmeUndefined</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>pmeQuit</td>
<td>Just after &quot;Save Current Model?&quot; dialog</td>
<td>True = Cancel Quit</td>
</tr>
<tr>
<td>2</td>
<td>pmeSaveBeforeQuit</td>
<td>&quot;Save Current Model?&quot; dialog</td>
<td>True = Skip Save dialog</td>
</tr>
<tr>
<td>3</td>
<td>pmeSimComplete</td>
<td>Simulation Ends Normally</td>
<td>True = Skip Stats dialog</td>
</tr>
<tr>
<td>4</td>
<td>pmeSimUserEnd</td>
<td>User Selects &quot;Simulation &gt; End Simulation&quot;</td>
<td>True = Skip Collect Stats dialog</td>
</tr>
<tr>
<td>5</td>
<td>pmeSimPauseOn</td>
<td>User Selects &quot;Simulation &gt; Pause Simulation&quot;</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>pmeSimPauseOff</td>
<td>User Selects &quot;Simulation &gt; Resume&quot;</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>pmeSimAbEnd</td>
<td>Simulation Crashes</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>pmeSimStart</td>
<td>Simulation Start (before translation/simulation)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>pmeTranStart</td>
<td>Translation Start (at start of translation for each scenario)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>pmeTranEnd</td>
<td>Translation End (between translation &amp; simulation)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>pmeEditModeOn</td>
<td>Edit Mode Entered (between simulation end and return to build environment)</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>pmeModLoaded</td>
<td>Model Loaded (after successful load)</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>pmeAnimOn</td>
<td>Animation On (when animation turned on)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>pmeAnimOff</td>
<td>Animation Off (when animation turned off)</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>pmeMsgInfo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>pmeMsgOK</td>
<td>&quot;GLB Missing&quot; message box, other message box</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>pmeMsgOkCancel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>pmeMsgRetryCancel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>pmeMsgYesNo</td>
<td>&quot;Couldn't Get Exclusive…&quot; message box</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>pmeMsgYesNoCancel</td>
<td>&quot;Save Current Model?&quot; dialog</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>pmeMsgAbortRetryIgnore</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>pmeMsgPrompt</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Path Colors

<table>
<thead>
<tr>
<th>Field</th>
<th>Constant</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>pmdColorBlack</td>
<td>Black</td>
</tr>
<tr>
<td>128</td>
<td>pmdColorMaroon</td>
<td>Maroon</td>
</tr>
<tr>
<td>255</td>
<td>pmdColorRed</td>
<td>Red</td>
</tr>
<tr>
<td>32768</td>
<td>pmdColorDk_Green</td>
<td>Dark Green</td>
</tr>
<tr>
<td>32896</td>
<td>pmdColorGold</td>
<td>Gold</td>
</tr>
<tr>
<td>65280</td>
<td>pmdColorLt_Green</td>
<td>Light Green</td>
</tr>
<tr>
<td>65535</td>
<td>pmdColorYellow</td>
<td>Yellow</td>
</tr>
<tr>
<td>8388608</td>
<td>pmdColorDk_Blue</td>
<td>Dark Blue</td>
</tr>
<tr>
<td>8388736</td>
<td>pmdColorPurple</td>
<td>Purple</td>
</tr>
<tr>
<td>8421376</td>
<td>pmdColorTeal</td>
<td>Teal</td>
</tr>
<tr>
<td>8421504</td>
<td>pmdColorDk_Gray</td>
<td>Dark Gray</td>
</tr>
<tr>
<td>12632256</td>
<td>pmdColorLt_Gray</td>
<td>Light Gray</td>
</tr>
<tr>
<td>16711680</td>
<td>pmdColorMed_Blue</td>
<td>Medium Blue</td>
</tr>
<tr>
<td>16711935</td>
<td>pmdColorPink</td>
<td>Pink</td>
</tr>
<tr>
<td>16776960</td>
<td>pmdColorCyan</td>
<td>Cyan (Light Blue)</td>
</tr>
<tr>
<td>16777215</td>
<td>pmdColorWhite</td>
<td>White</td>
</tr>
</tbody>
</table>
Menu Ids

This method is defined as: \textit{MenuCommand<MenuId>},<Parameter>

For most commands, Parameter has no meaning and a zero should be passed. The following is a list of menu IDs that have no equivalent method in the CProModel interface.

<table>
<thead>
<tr>
<th>Menu ID</th>
<th>Constant</th>
<th>Description</th>
<th>Window</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1155</td>
<td>pmaMnuCost</td>
<td>Open Cost Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>1170</td>
<td>pmaMnuSimOpt</td>
<td>Open Simulation Options dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>1185</td>
<td>pmaMnuGenInfo</td>
<td>Open General Info Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>1500</td>
<td>pmaMnuFind</td>
<td>Open Find Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>1505</td>
<td>pmaMnuReplace</td>
<td>Open Replace Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>1510</td>
<td>pmaMnuFindNext</td>
<td>Repeat Last Search Replace Operation</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2450</td>
<td>pmaMnuSimRun</td>
<td>Launch SimRunner</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2500</td>
<td>pmaMnuViewStats</td>
<td>Launch Output Module</td>
<td>Main</td>
<td>1 = Open Hidden</td>
</tr>
<tr>
<td>2505</td>
<td>pmaMnuViewTrace</td>
<td>View Trace File</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2600</td>
<td>pmaMnuGfxEdit</td>
<td>Launch Graphic Editor</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2605</td>
<td>pmaMnuShiftDef</td>
<td>Launch Shift Editor</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2650</td>
<td>pmaMnuStatFit</td>
<td>Launch Stat::Fit</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2750</td>
<td>pmaMnuShortcut</td>
<td>View Shortcut Panel</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2755</td>
<td>pmaMnuRefresh</td>
<td>Refresh Layout</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2850</td>
<td>pmaMnuViewDef</td>
<td>Open Views Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2861</td>
<td>pmaMnuView1</td>
<td>Set Layout to 1st View</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2862</td>
<td>pmaMnuView2</td>
<td>Set Layout to 2nd view</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2889</td>
<td>pmaMnuView29</td>
<td>Set Layout to 29th view</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2906</td>
<td>pmaMnuSnapGrid</td>
<td>Toggle “Snap to Grid”</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2908</td>
<td>pmaMnuShowGrid</td>
<td>Toggle Grid On/Off</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2910</td>
<td>pmaMnuFont</td>
<td>Open Edit Table Font Selection Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2920</td>
<td>pmaMnuPMOpt</td>
<td>Open Options Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2942</td>
<td>pmaMnuGridSet</td>
<td>Open Grid Grid Settings Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2944</td>
<td>pmaMnuBackColor</td>
<td>Open Background Color Selection Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2946</td>
<td>pmaMnuPathColor</td>
<td>Open Routing Path Color Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2951</td>
<td>pmaMnuScenarios</td>
<td>Open Scenarios Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2952</td>
<td>pmaMnuModParams</td>
<td>Open Model Parameters Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>2980</td>
<td>pmaMnuResetWin</td>
<td>Reset Window Positions</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>3000</td>
<td>pmaMnuAboutPM</td>
<td>Open About box</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>3005</td>
<td>pmaMnuPMSupport</td>
<td>Go To Support Page on the Web</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>Menu ID</td>
<td>Constant</td>
<td>Description</td>
<td>Window</td>
<td>Parameter</td>
</tr>
<tr>
<td>---------</td>
<td>--------------</td>
<td>-----------------------------------------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>3010</td>
<td>pmaMnuShowHidNet</td>
<td>Toggle “Show Hidden Networks”</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>3015</td>
<td>pmaMnuShowRtgPath</td>
<td>Toggle “Show Routing Paths”</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>3020</td>
<td>pmaMnuColor</td>
<td>Open Edit Table Color Select Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>3200</td>
<td>pmaMnuCntxtMenu</td>
<td>Pop Up Layout Context Menu (general)</td>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td>4415</td>
<td>pmaMnuMakePkg</td>
<td>Open Create Package Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4416</td>
<td>pmaMnuInstallPkg</td>
<td>Open Install Package Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4420</td>
<td>pmaMnuPrint2File</td>
<td>Open Print Text to File Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4500</td>
<td>pmaMnuViewText</td>
<td>View Text</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4600</td>
<td>pmaMnuPrintLayout</td>
<td>Open Print Layout Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4601</td>
<td>pmaMnuPrntrSetup</td>
<td>Open Print Setup Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4602</td>
<td>pmaMnuPrint2Prntr</td>
<td>Open Print Text Dialog</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4650</td>
<td>pmaMnuHelpIndex</td>
<td>Help Index</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4655</td>
<td>pmaMnuHelpCntxt</td>
<td>Context Help</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4710</td>
<td>pmaMnuFile1</td>
<td>Open File #1 in history list</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4714</td>
<td>pmaMnuFile5</td>
<td>Open File #5 in history list</td>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>4803</td>
<td>pmaMnuSimClock</td>
<td>Pop Up Simulation Clock Menu</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4804</td>
<td>pmaMnuTraceOff</td>
<td>Trace Off</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4805</td>
<td>pmaMnuTraceClose</td>
<td>Trace Close</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4806</td>
<td>pmaMnuTraceStep</td>
<td>Trace Step</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4807</td>
<td>pmaMnuTraceContin</td>
<td>Trace Continuous</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4808</td>
<td>pmaMnuTrace2Win</td>
<td>Trace to Window</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4810</td>
<td>pmaMnuTrace2File</td>
<td>Trace to File</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4811</td>
<td>pmaMnuAnimOnOff</td>
<td>Toggle Animation On/Off</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4814</td>
<td>pmaMnuUserPause</td>
<td>Open User Pause Dialog</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4815</td>
<td>pmaMnuShowLegend</td>
<td>Show Legend</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4816</td>
<td>pmaMnuPauseOnOff</td>
<td>Pause Resume</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4817</td>
<td>pmaMnuSimInfo1Loc</td>
<td>Open Location Info Dialog</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4818</td>
<td>pmaMnuSimInfoAll</td>
<td>Open All Locations Info Dialog</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4821</td>
<td>pmaMnuSimInfoVars</td>
<td>Open Variable Info Dialog</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4822</td>
<td>pmaMnuSimInfoArray</td>
<td>Open Array Info Dialog</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4824</td>
<td>pmaMnuSimDebug</td>
<td>Open Debug Options Dialog</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4825</td>
<td>pmaMnuSimInteract</td>
<td>Open Interactive Subroutines Dialog</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4826</td>
<td>pmaMnuDynPlotNew</td>
<td>New Dynamic Plots</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4827</td>
<td>pmaMnuDynPlotConfig</td>
<td>Configure Dynamic Plots</td>
<td>Simulation</td>
<td></td>
</tr>
<tr>
<td>4850</td>
<td>pmaMnuWorkSrch</td>
<td>Resource Work Search</td>
<td>Resources</td>
<td></td>
</tr>
<tr>
<td>4851</td>
<td>pmaMnuParkSrch</td>
<td>Resource Park Search</td>
<td>Resources</td>
<td></td>
</tr>
</tbody>
</table>
Index

A

AddBackgroundBitmap 58
AnimSpeedChange 41
AppendEntitySpot 59
AppendGraphicIcon 60
AppendGraphicIconSize 61
AppendRecord 62
AppendRoutingPoint 63
Arrays Table 101
Arrival Cycles Table 102
values subtable 103
Arrivals Table 99
Attributes Table 100

B

Background Graphics Table 112

C

CloseFile 78
Counter Graphics Table 109

D

DeleteRecord 64

E

EndReplication 9
EndSimulation 10
Entities Table 95
Entity Graphics Table 112
Entity Spot Graphics Table 112
External Files Table 103

F

FieldName 79

G

Gauge/Tank Graphics Table 109
General Information Table 104
GetAnimationSpeed 51
GetAnimationState 50
GetEventsObject 11
GetIntFieldValue 65
GetPositionInfo 80
GetRealFieldValue 66
GetRecordCount 67
GetSelectedsFromType 68
GetSimTime 12
GetStatus 13
GetStatValue 52
GetStringFieldValue 69
GetValue 81
GetVersion 14

I

InputTextPrompt 42
InsertRecord 70

L

Library Graphics Table 108
ListSelectPrompt 44
LoadDefaults 15
LoadModel 16
Location Graphics Table 107
Locations Table 93
clock downtimes subtable 94
entry downtimes subtable 94
setup downtimes subtable 94
usage downtimes subtable 94

M

Macros Table 102
MenuCommand 17
MergeModel 18
Model Defaults Table 113
Model Parameters Table 105
MsgBox 19

N

New 20

O

OpenFile 82
OpenModule 21

P

Path Networks Table 95
interfaces subtable 96
mapping destinations subtable 96
mappings subtable 96
nodes subtable 96
segments subtable 96
PeriodName 83
PMEEventsHandler 39
AnimSpeedChange 41
InputTextPrompt 42
ListSelectPrompt 44
RunError 46
TranslationError 47
UserZoom 48
Populate 71
PositionIsValid 84
Process Table 104
ProModel Application Object 8
EndReplication 9
EndSimulation 10
GetEventsObject 11
GetSimTime 12
GetStatus 13
GetVersion 14
LoadDefaults 15
LoadModel 16
MenuCommand 17
MergeModel 18
MsgBox 19
New 20
OpenModule 21
Quit 22
RedrawLayout 23
RedrawTables 24
RunScenarios 25
Save 26
SaveAs 27
SetMacro 28
SetMenus 29
SetMessageMode 30
SetPan 31
SetView 32
SetViewRect 33
SetWindowPos 34
ShowTranslationDlg 35
Simulate 36
Zoom 37

ProModel Data Object 57
AddBackgroundBitmap 58
AppendEntitySpot 59
AppendGraphicIcon 60
AppendGraphicIconSize 61
AppendRecord 62
AppendRoutingPoint 63
DeleteRecord 64
GetIntFieldValue 65
GetRealFieldValue 66
GetRecordCount 67
GetSelectedsFromType 68
GetStringFieldValue 69
InsertRecord 70
Populate 71
SelectMainRecordByIndex 72
SelectMainRecordByName 73
SetIntFieldValue 74
SetRealFieldValue 75
SetStringFieldValue 76

ProModel Runtime Object 49
GetAnimationSpeed 51
GetAnimationState 50
GetStatValue 52
SetAnimationSpeed 55
SetAnimationState 54
SetStatValue 56
ProModel.CProModelData 57
ProModel.CRuntime 49

Q

Queue/Conveyor Graphics Table 108
Queue/Conveyor Joints Table 113
Quit 22

R

RDBDataServer Object 77
CloseFile 78
FieldName 79
GetPositionInfo 80
GetValue 81
OpenFile 82
PeriodName 83
PositionIsValid 84
RecordName 85
ReplicationNumber 86
ScenarioName 87
SelectData 88
TableName 89
RecordName 85

Resource Graphics Table 108

Resources Table 96
clock downtimes subtable 98
node logic subtable 99
park nodes subtable 98
park search subtable 98
resource points subtable 99
search locations subtable 98
usage downtimes subtable 98
work search subtable 98
Routing Points Table 113
Routing Subtable 105
RunError 46
RunScenarios 25

S

Save 26
SaveAs 27
ScenarioName 87
Scenarios Table 105
parameters subtable 106
SelectData 88
SelectMainRecordByIndex 72
SelectMainRecordByName 73
SetAnimationSpeed 55
SetAnimationState 54
SetIntFieldValue 74
SetMacro 28
SetMenus 29
SetMessageMode 30
SetPan 31
SetRealFieldValue 75
SetStatValue 56
SetStringFieldValue 76
SetView 32
SetViewRect 33
SetWindowPos 34
Shift Assignment Table 100
location index subtable 100
resource index subtable 100
shift file index subtable 100
ShowTranslationDlg 35
Simulate 36
Simulation Options Table 106
Status Light Graphics Table 111

Streams Table 104
Subroutines Table 102
parameters subtable 102

T

Table Functions Table 103
function values subtable 103
TableName 89
Text Graphics Table 111
TranslationError 47

U

User Distributions Table 103
distributions values subtable 103
UserZoom 48

V

Variable Graphics Table 113
Variables Table 101
Views Table 113

Z

Zoom 37
user guide
Disclaimer

The information in this guide is provided by ProModel Corporation to document ProModel. The contents of this manual are subject to change without notice and does not represent a commitment on the part of ProModel Corporation. The software described in this guide is applied under a license agreement and may be copied only under the terms of the license agreement. No part of this guide may be reproduced, transmitted, or distributed by any means, electronic or mechanical, for purposes other than the owner’s personal use without express written permission from ProModel Corporation.

Copyright Information

© 8/08 ProModel Corporation
All rights reserved
Printed in the United States of America

ProModel and SimRunner are registered trademarks of ProModel Corporation.

Text indicator graphics Copyright New Vision Technologies Inc.

Microsoft is a registered trademark and Windows, Excel, and ActiveX are trademarks of Microsoft Corporation.

Stat::Fit is a trademark of Geer Mountain Corporation.

IBM is a registered trademark of International Business Machines Corporation.

Netware and Novell are a registered trademarks of Novell, Inc.

AutoCAD is a registered trademark of Autodesk, Inc.

8/08
# Table of Contents

Table of Contents .......................................................... iii

Introduction ................................................................. 1

- About the User Guide .................................................... 1
- Symbols and Notation .................................................. 3
  - Keyboard ................................................................. 3
  - Text ....................................................................... 3
  - Logic ..................................................................... 3
- Product Support ............................................................ 4
- Modeling Services ....................................................... 5
- Reporting Suggestions .................................................. 5

Chapter 1: Getting Started ................................................ 7

- Welcome to ProModel ................................................... 7
  - Where to Go from here ............................................. 7
- Using ProModel ........................................................ 9
  - Building Models ..................................................... 9
  - Running Models ..................................................... 11
  - Creating Run-Time Models ..................................... 11
  - Trace Window ....................................................... 11
  - Location Information Windows ............................... 12
  - Viewing Output ..................................................... 12
Chapter 4: Modeling Environment .................................................................61

Menu Bar .....................................................................................................61
File Menu ..................................................................................................62
  File Management .................................................................................62
  Model Merging ..................................................................................64
  View/Print Model Text .......................................................................66
  Model Packaging/Data Protection .................................................68
Edit Menu .................................................................................................70
  Editing Tables .....................................................................................70
  Editing Process Records .................................................................71
  Editing Notes Windows .................................................................72
  Editing Logic Windows .......................................................................72
  Editing Background Graphics .........................................................73
  Editing & Moving Graphics .............................................................74
View Menu .................................................................................................76
  Switches .............................................................................................76
  Toolbars ............................................................................................77
  Settings ..............................................................................................77
  Views .................................................................................................77
  Zoom Feature ......................................................................................79
  Layout Settings ..................................................................................80
  Edit Tables ..........................................................................................83
  Commands ...........................................................................................83
Window Menu ............................................................................................84
Help Menu ..................................................................................................85
Toolbars ....................................................................................................85
Right-Click Menu ......................................................................................87

Chapter 5: Building the Model: General Elements .........................................89

Build Menu .................................................................................................89
Locations ....................................................................................................90
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations Editor</td>
<td>90</td>
</tr>
<tr>
<td>Location Edit Table</td>
<td>91</td>
</tr>
<tr>
<td>Location Graphics Window</td>
<td>92</td>
</tr>
<tr>
<td>Location Graphics</td>
<td>94</td>
</tr>
<tr>
<td>Capacities and Units</td>
<td>100</td>
</tr>
<tr>
<td>Location Downtimes</td>
<td>101</td>
</tr>
<tr>
<td>Rules Dialog Box</td>
<td>109</td>
</tr>
<tr>
<td>Entities</td>
<td>112</td>
</tr>
<tr>
<td>Entities Editor</td>
<td>112</td>
</tr>
<tr>
<td>Defining Entities</td>
<td>113</td>
</tr>
<tr>
<td>Entity Graphic Dimensions</td>
<td>113</td>
</tr>
<tr>
<td>Defining Multiple Entity Graphics</td>
<td>114</td>
</tr>
<tr>
<td>Preemtive Entities</td>
<td>115</td>
</tr>
<tr>
<td>Path Networks</td>
<td>117</td>
</tr>
<tr>
<td>Path Networks Editor</td>
<td>117</td>
</tr>
<tr>
<td>A Typical Path Network</td>
<td>119</td>
</tr>
<tr>
<td>Path Segment Edit Table</td>
<td>120</td>
</tr>
<tr>
<td>Automatic Time and Distance Calculation</td>
<td>121</td>
</tr>
<tr>
<td>Interfaces Edit Table</td>
<td>121</td>
</tr>
<tr>
<td>Mapping Edit Table</td>
<td>122</td>
</tr>
<tr>
<td>Nodes Edit Table</td>
<td>124</td>
</tr>
<tr>
<td>Pre-translation check for Path Networks</td>
<td>125</td>
</tr>
<tr>
<td>Resources</td>
<td>126</td>
</tr>
<tr>
<td>Typical Use of Resources</td>
<td>126</td>
</tr>
<tr>
<td>Resources Editor</td>
<td>126</td>
</tr>
<tr>
<td>Static Resources</td>
<td>129</td>
</tr>
<tr>
<td>Dynamic Resources</td>
<td>129</td>
</tr>
<tr>
<td>Multiple Resource Graphics</td>
<td>130</td>
</tr>
<tr>
<td>Multi-Unit Resources vs.</td>
<td>131</td>
</tr>
<tr>
<td>Multiple Single-Unit Resources</td>
<td>131</td>
</tr>
<tr>
<td>Resource Downtimes</td>
<td>131</td>
</tr>
<tr>
<td>Resource Priorities and Preemption</td>
<td>134</td>
</tr>
<tr>
<td>Resource Shift Downtime Priorities</td>
<td>134</td>
</tr>
<tr>
<td>Resource Preemption Matrix</td>
<td>135</td>
</tr>
<tr>
<td>Resource Specifications Dialog Box</td>
<td>136</td>
</tr>
<tr>
<td>Resource Search Routines</td>
<td>138</td>
</tr>
<tr>
<td>Node Logic Editor</td>
<td>140</td>
</tr>
<tr>
<td>Resource Points</td>
<td>141</td>
</tr>
<tr>
<td>Processing</td>
<td>143</td>
</tr>
</tbody>
</table>
Chapter 6: Building the Model: Advanced Elements ................................................................. 217

Attributes .................................................................................................................................. 217
  Attribute Types .......................................................................................................................... 217
  Memory Allocation for Attributes .............................................................................................. 218
  Attributes vs. Local Variables ................................................................................................... 218
  Cloning Attributes .................................................................................................................... 218
  Attribute Edit Table .................................................................................................................. 219
  Example of Attributes in Logic .................................................................................................. 219
  Attributes and the JOIN or LOAD PERM Statement ............................................................... 220
  Attributes and the GROUP/UNGROUP Statements ................................................................. 220
  Attributes and the LOAD/UNLOAD Statements ...................................................................... 221
  Attributes and the COMBINE Statement .................................................................................. 222

Variables ...................................................................................................................................... 223
  Variable Edit Table .................................................................................................................... 223
  Variable Layout ......................................................................................................................... 224
Find Expression .......................................................... 301
Replace Expression ...................................................... 301
Important Notes Regarding Expression Searches ...... 302
Local Find and Replace .............................................. 303
Graphic Editor ............................................................ 304
  Overview ................................................................. 304
File Menu ................................................................. 305
Edit Menu ................................................................. 306
Graphics Menu .......................................................... 308
Options Menu ........................................................... 311
Window Menu ............................................................ 312
Library Edit Buttons ................................................... 313
Manipulating Graphics ............................................. 313
Create New Graphics and Libraries ......................... 314
Naming a Graphic ...................................................... 314
Graphic Tools Button Bar .......................................... 315
Editing a Library Graphic ......................................... 323
Options ................................................................. 325
Customize ............................................................... 327
Power Tools ............................................................. 328
  ProClare ................................................................. 329
  ProSetter ............................................................... 330
  Shift Library .......................................................... 331
  ProActiveX ............................................................ 331
  ProModel Player ..................................................... 334

Chapter 9: Running the Model ............................................. 337
  Simulation Menu ..................................................... 337
  Simulation Options .................................................. 338
    General Options & Settings ...................................... 338
    Output Reporting Options ...................................... 340
    Running a Specific Replication ................................. 341
    Customized Reporting ......................................... 342
  Model Parameters & Scenarios ................................. 342
    Model Parameters ................................................ 342
    Scenarios .......................................................... 343
Running the Simulation .................................................... 345
Run-Time Menus & Controls ........................................... 345
  Run-Time File Menu .................................................. 345
  Run-Time Simulation Menu ...................................... 346
  Run-Time Options Menu ........................................... 346
  Debug Option ............................................................. 347
  Trace Options ............................................................. 351
  Animation Options ..................................................... 353
  Run-Time Information Menu ..................................... 353
  Dynamic Plots ............................................................ 354
  Run-Time Window Menu .......................................... 358
  Run-Time Interact Menu ............................................ 358
  Run-Time Help Menu ................................................ 358
  Run-Time Controls .................................................... 359
  Run-Time Right-Click Menu ..................................... 360
  SimRunner ................................................................. 360

Chapter 10: Reports and Graphs ................................................................. 363

  Output Viewer 3DR .......................................................... 364
    Menu Bar .................................................................... 364
    Toolbar ....................................................................... 369
    Right-click Menu ....................................................... 369
  Creating Reports ............................................................... 372
  Creating Charts ................................................................. 379
    Chart Window ............................................................ 379
    Category Chart ........................................................... 381
    State Chart ................................................................. 382
    Histogram ................................................................... 384
    Time Plot .................................................................... 387

Chapter 11: Language Elements and Expressions ..........................................393

  Language Elements .................................................... 393
  Names ............................................................................. 394
  Keywords .......................................................................... 395
Numbers ................................................................. 396
Character Strings ................................................. 397
Operators ............................................................... 398
  Mathematical Operators .................................... 398
  Relational Operators ......................................... 398
  Comparison Operators ........................................ 398
  Operator Precedence .......................................... 398
  Expressions ......................................................... 398
Numeric Expressions ............................................... 399
Boolean Expressions ............................................ 400
Time Expressions .................................................. 401
String Expressions ............................................... 402
Operator Precedence .............................................. 403

Chapter 12: Routing Rules ......................................... 405
  Routing Rules ....................................................... 405
  Alternate .............................................................. 406
  Backup ................................................................. 407
  Continue .............................................................. 408
  Dependent ............................................................ 410
  Empty ................................................................. 411
  First Available .................................................... 412
  Join ................................................................. 413
  Load ................................................................. 414
  Longest Unoccupied ............................................ 415
  Most Available .................................................. 416
  Probability ......................................................... 417
  Random ............................................................ 418
  Send ................................................................. 419
  Turn ................................................................. 420
  Until Full ........................................................... 421
  User Condition ................................................... 422
Chapter 13: Logic Elements .................................................................425

Functions ......................................................................................425
System Functions ........................................................................425
General Functions ......................................................................425
Statements ..................................................................................426
Distribution Functions .................................................................427
Priorities .....................................................................................428

Chapter 14: Statements and Functions ..................................................429

Accum ..........................................................................................429
Activate .......................................................................................431
Animate .......................................................................................432
ArrayDims() ...............................................................................433
ArrayDimSize() .........................................................................434
Assignment Statement .................................................................435
Begin ............................................................................................436
Break ...........................................................................................437
BreakBlk ......................................................................................438
CalDay() .....................................................................................439
CalDOM() ...................................................................................440
CalHour() ...................................................................................441
CalMin() .....................................................................................442
CalMonth() ................................................................................443
CalYear() ....................................................................................444
Cap() ..........................................................................................445
Char() ........................................................................................446
Clock() .......................................................................................447
Close ............................................................................................448
Combine ......................................................................................449
Comments ..................................................................................451
Contents() ..................................................................................452
Create ..........................................................................................453
Join ................................................................. 494
Jointly Get ....................................................... 496
Last() ............................................................... 497
Ln() ................................................................. 498
Load ................................................................. 499
Loc() ............................................................... 501
LocState() ....................................................... 502
Location() ....................................................... 503
Log ................................................................. 504
MapArr ........................................................... 506
Match .............................................................. 508
Move ............................................................... 510
Move For ......................................................... 512
Move On ........................................................... 513
Move With ....................................................... 514
Next() .............................................................. 516
Order ............................................................... 517
OwnedResource() ............................................. 518
Pause .............................................................. 519
PercentOp() ..................................................... 520
PercentUtil() .................................................... 521
Preemptor() ..................................................... 522
Priority ............................................................ 523
Prompt ............................................................. 524
Rand() ............................................................. 526
Read ............................................................... 527
Real ............................................................... 529
Real() ............................................................. 530
Rename ........................................................... 531
Report ............................................................. 532
Res() .............................................................. 533
Reset .............................................................. 534
Reset Stats ...................................................... 535
Resource() ...................................................... 536
ResourceUnit() ............................................... 537
ResQty() ................................................................. 538
Return ............................................................... 539
Round() ............................................................... 541
Route ................................................................. 542
Send ................................................................. 544
SetRate ............................................................... 546
Sound ............................................................... 548
Split As ............................................................. 549
Sqrt() ................................................................. 551
Stop ................................................................. 552
ThreadNum() ..................................................... 553
TimeLeft() ........................................................ 554
TimesUsed() ...................................................... 555
Trace ............................................................... 556
Trunc() ............................................................. 557
Ungroup ............................................................ 558
Units() .............................................................. 560
Unload .............................................................. 561
Use ................................................................. 563
Variable() ......................................................... 565
View ............................................................... 566
Wait ............................................................... 567
Wait Until ........................................................ 568
Warmup .......................................................... 569
While...Do ....................................................... 570
Write .............................................................. 571
WriteLine ......................................................... 572
Xsub() ............................................................. 573
Xwrite ........................................................... 575

Appendix A ............................................................. 577

Glossary .............................................................. 591
Bibliography ................................................................. 596

Index ............................................................................. 597
Introduction

This chapter will introduce you to the user guide, and provide information regarding assumptions this guide makes. You may also find information on support and consulting services in this chapter.

About the User Guide

The ProModel User Guide is designed as a reference to guide you through the process of building, running, and viewing the results of simulation models. The guide contains detailed information on the use of features and capabilities found within ProModel and serves as a complement to the product training.

Chapter 1
Getting Started

Welcomes you to ProModel and provides information on getting started with the model building process.

Chapter 2
Installation and Registration

Provides step-by-step instructions on how to install ProModel.

Chapter 3
Planning the Model

Introduces you to the theory behind simulation modeling and gives an overview of model building procedure. This chapter outlines six steps to help you plan and create a successful, valid model. It then provides an example scenario, which designs a model from start to finish.

Chapter 4
Modeling Environment

Familiarizes you with the ProModel modeling environment. You will learn how to use many of the menus and windows found in ProModel.

Chapter 5
Building the Model: general elements

Brings you face to face with basic modeling components. Discussion revolves around the nuances of creating and working with locations, entities, path networks, resources, processing records, arrivals, shifts, costs, background graphics, and more.

Chapter 6
Building the Model: advanced elements

Advanced elements ensure that the models you create reflect the exact behavior of your system. Contributing elements include attributes, variables, arrays, spreadsheets, macros, run-time interfaces, subroutines, arrival cycles, table func-
tions, user-defined distributions, external files, and streams.

Chapter 7
Building the Logic
Applying intelligence and decision-making capabilities to your models makes them true to life. The logic builder helps you create and implement logic for operations, routings, shifts, breaks, and more.

Chapter 8
Using Auxiliary Tools
Auxiliary tools allow you to work with many aspects of your model. You may create and modify graphics, search for expressions, or examine which statistical distributions best suit your modeling needs.

Chapter 9
Running the Model
Running the model is the most exciting part of the modeling process. This chapter discusses the various conditions under which you may run a model and how to ensure that the model contains no logical errors.

Chapter 10
Reports and Graphs
With the simulation complete, you are ready to examine the results from the model. Options available include reports, graphs, spreadsheets, and customized output templates.

Chapter 11
Language Elements and Expressions
Describes the basics of the language used to define model objects and logic, as well as expressions and the role they play in creating models.

Discussion focuses on names, reserved words, numbers, strings, operators, and basic syntactical structure, as well as operator precedence and numeric, Boolean, time, and string expressions.

Chapter 12
Routing Rules
Provides syntax and examples for the rules you will use to route between locations in the model.

Chapter 13
Logic Elements
Introduces the different types of functions and statements available to use in building logic for your model and identifies where you may use them.

Chapter 14
Statements and Functions
Provides syntax and examples for the statements and functions you will use to apply intelligence and decision-making capabilities to your model.

Appendix A
Presents a categorized list of all expressions, statements, and functions with a table identifying which fields evaluate at translation and which evaluate continuously.

Appendix B
Gives instructions for the Classic Output Viewer.

Glossary
Contains definitions and descriptions for many of the terms and concepts common to simulation and modeling.
Bibliography
Referenced materials and suggested readings.

Symbols and Notation
To better help you navigate this text, please review the following symbols and conventions.

Keyboard
The names of keys are displayed in capital letters. For example, ESC refers to the Escape key and CTRL refers to the Control key.

Keys are frequently specified in combinations or in a sequence of keystrokes. For example, CTRL + L means to hold down the CTRL key while pressing L. When key commands are set off by commas (e.g., ALT + N, R), press and release each of these keys (or key combinations) in the order listed. The term “arrow keys” refers collectively to the ↑, ↓, ←, and → cursor keys.

Text
Specific text you are asked to type is shown in bold type. For example, if you are directed to type cd pmod, you would type the lowercase letters “cd” followed by a space and the letters “pmod.”

Place holders for things such as file names and directories are shown in italics. For example, if you are directed to type filename.mod, enter the name of the file you wish to use (e.g., model_1.mod).

Logic
All ProModel reserved keywords are in uppercase.

Syntax example:

IF Start_Time = 10 THEN INC Var1
Product Support

Technical support is available to all licensed Pro-Model users with current maintenance and support agreements. Support representatives are glad to answer specific questions you may have and offer direction in solving specific modeling challenges you encounter.

Technical support

Technical support is available via: telephone, fax, ftp, and email. When you contact technical support, please be prepared to provide your user profile and a description of any problems you experience.

User Profile

• Your name and company.
• The license # or serial # found on your security key or ProModel CD.
• Hardware make and configuration.
• Network information (if applicable).
• Version number of Windows and ProModel.

Problem Description

• Brief description of the problem you are experiencing.
• What you were doing when the problem occurred.
• The exact wording of any messages that appeared on your screen.

Telephone   (888) PROMODEL

Speak to a technical support engineer and resolve the problem over the phone. Our support lines are open Monday through Friday from 6:00 AM to 6:00 PM MST. The technical support number is (888) PROMODEL.

After Hours Support   (801) 362-8324

In our ongoing effort to serve you better, technical support is also available after hours. Please have ready your user profile and a description of the problem you encountered.

Fax   (801) 226-6046

Send a fax of the listing created when you select Print Text from the File menu along with your user profile and a description of the problem you encountered.

FTP

For file transfers to and from ProModel Corporation via file transfer protocol, contact technical support

Email   support@promodel.com

When you contact technical support via email, send your user profile and a description of the problem you encountered.
Modeling Services

If you find yourself in need of extra help or specific expertise to complete your simulation project, let us help you. ProModel Corporation Modeling Services will meet all of your needs with fast, accurate results at competitive rates.

Whether simple or complex, partial or complete, ProModel Corporation Modeling Services can create any model you require. With our vast experience in producing simulation models for many diverse applications, we are in a unique position to evaluate your system and isolate specific improvements. We work closely with you during the development process to ensure that the model we create is complete and precise.

With each simulation ProModel Corporation provides a complete, comprehensive analysis of your system. We document conclusions and results derived from the project and present you with statistics suitable for company presentations and briefings. You may even present a limited version of the model which allows repeated executions and minor revision capabilities.

For more information on modeling services, please contact:

Phone (801) 223-4600
Fax (801) 226-6046

Reporting Suggestions

It is our goal to make ProModel the ultimate manufacturing simulation tool. To do this, we rely on your input. Please feel free to submit comments and ideas on how we may improve the ProModel software and documentation.

Send us your comments

ProModel Product Team
ProModel Corporation
556 E. Technology Way
Orem, UT  84097
Phone (801) 223-4600
Fax (801) 226-6046
Email pmteam@promodel.com
Reporting Suggestions
Chapter 1: Getting Started

Welcome to ProModel

ProModel is a powerful, Windows-based simulation tool for simulating and analyzing production systems of all types and sizes. ProModel provides the perfect combination of ease-of-use and complete flexibility and power for modeling nearly any situation, and its realistic animation capabilities makes simulation come to life.

ProModel provides engineers and managers the opportunity to test new ideas for system design or improvement before committing the time and resources necessary to build or alter the actual system. ProModel focuses on issues such as resource utilization, production capacity, productivity, and inventory levels. By modeling the important elements of a production system such as resource utilization, system capacity, and production schedules, you can experiment with different operating strategies and designs to achieve the best results.

As a discrete event simulator, ProModel is intended primarily for modeling discrete part manufacturing systems, although process industries can be modeled by converting bulk material into discrete units such as gallons or barrels. In addition, ProModel is designed to model systems where system events occur mainly at definite points in time. Time resolution is controllable and ranges from .01 hours to .00001 seconds.

- Typical applications for using ProModel include:
  - Assembly lines
  - Job Shops
  - Transfer lines
  - JIT and KANBAN systems
  - Flexible Manufacturing systems
  - Supply chains & logistics

Use of ProModel requires only a brief orientation and virtually no programming skills. With ProModel's convenient modeling constructs and graphical user interface, model building is quick and easy. All you do is define how your particular system operates, mostly through part flow and operation logic. Automatic error and consistency checking help ensure that each model is complete prior to simulation. During simulation, an animated representation of the system appears on the screen. After the simulation, performance measures such as resource utilization, productivity and inventory levels are tabulated and may be graphed for evaluation.

Where to Go from Here

1. In order to use ProModel effectively, you must understand the basics of the Microsoft Windows operating environment. If you are unfamiliar with Windows you should begin by reviewing the help information. To do this, select Help from the Start menu. If you are an accomplished Windows user, you can proceed to the next step.

2. To begin using ProModel you must install the software. This is described in Chapter 2: Installation and Registration.

3. You will want to become familiar with the basic theory of model building, and review
the model building scenario, which is covered in chapter 3: Planning the Model. If you are already familiar with modeling theory, or just want to jump into model building, skip to the next step.

4. ProModel incorporates an easy-to-use as well as intuitive user interface. Chapter 4: Modeling Environment will introduce you to the menus and options you will use to build your model.

5. Build your model. Chapters 5 and 6: Building the Model propel you into model building by describing the Build menu, which gives you access to most of the tools needed to build your model.

6. Refer to Chapter 7: Building the Logic during the model building process to learn the logical elements that will control your model during simulation.

7. Run your model. See your model come to life as its animation runs. Chapter 9: Running the Model outlines the process of running a model.

8. View, analyze, and display the data your model collected during simulation. With this information in hand you are ready to make real-world decisions to achieve your modeling goals. Chapter 10: Reports and Graphs describes the Output Viewer, which presents you with your simulation’s data.

Training

Although the tutorial and documentation are both self-contained, first-time users are strongly encouraged to seek formal training at some point before embarking on a complex modeling project. PROMODEL Corporation holds training courses on a regular basis for beginning and advanced users of PROMODEL simulation products. For details on course dates and times, or to register for the course nearest you, call our main office at (801) 223-4600 and ask for the ProModel Product Team.
Using ProModel

ProModel views a production system as an arrangement of processing locations, such as machines or work stations, through which parts (or entities) are processed according to some processing logic. A system may also include paths, such as aisle-ways for movement, as well as supporting resources, such as operators and material handling equipment used in the processing and movement of parts.

The example below depicts a typical manufacturing workcell with six processing locations (Receiving, NC_301L, NC_302L, Degrease, Inspect, Rework), two entity types (Pallets and Blanks), two operators, and one transporting device (forklift). Models such as this are developed rapidly and easily using ProModel's graphical user interface and point-and-click approach to modeling.

Building Models

Models are created by completing the necessary modules selected from the Build menu shown below. Each module consists of various edit tables and dialog boxes used to supply model information. A layout window also appears with graphical tools for placing locations, path networks and other modeling elements.

<table>
<thead>
<tr>
<th>Build Menu</th>
<th>Simulation Menu</th>
<th>Output Menu</th>
<th>Tools Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locations</td>
<td>Ctrl+L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entities</td>
<td>Ctrl+E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Path Networks</td>
<td>Ctrl+N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td>Ctrl+R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processing</td>
<td>Ctrl+P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrivals</td>
<td>Ctrl+A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Splits</td>
<td>Ctrl+S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attributes</td>
<td>Ctrl+T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variables</td>
<td>Ctrl+B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrays</td>
<td>Ctrl+Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Macros</td>
<td>Ctrl+M</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subroutines</td>
<td>Ctrl+R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>More Elements</td>
<td>Ctrl+E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>General Information</td>
<td>Ctrl+I</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>Ctrl+E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Background Graphics</td>
<td>Ctrl+G</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Modules may be completed in any order and with any amount of switching back and forth between modules. However, with certain exceptions, it is recommended that modules be completed in the general order in which they appear in the menu. For example, it is usually best to identify and place locations in a model, and define the entities to be processed at those locations, before actually defining processing logic. This is generally accepted since processing logic describes the flow of entities from location to location and the operations performed on, for, or in behalf entities at each location.

Edit Tables

Edit tables, such as the Locations edit table, are used extensively throughout ProModel for defining model elements. Edit tables provide direct access to model data without wading though several levels of dialog boxes. Each table consists of records, which consist of fields describing some aspect of the element. Many of these fields have heading buttons you can click (or select and press
F2) to open a dialog box for further definition of the particular element.

### Dialog Boxes

Dialog boxes are used throughout ProModel for selecting options. The Decision Rules dialog shown below contains additional information regarding a location.

### Logic Builder

The Logic Builder in ProModel provides a quick and powerful way to create and insert valid statements and expressions in logic windows or fields. It takes you through the process of creating statements or expressions, as well as providing point-and-click access to every element defined in your model. The Logic Builder handles the syntax for every statement and function, allowing you to define logic by simply filling in the blanks.

To access the Logic Builder, click the right mouse button in any edit box which accepts an expression or anywhere inside an open logic window. You may also click the Build button on the logic window's toolbar.

### Model Merging and Submodels

Another extremely useful feature in ProModel is the ability to merge two or more models into one larger model. This supports the concept of modular model building, where models are created and tested in modules, and then joined together to produce a final model.

The use of sub-models further allows you to build common model elements such as work cells and place them repeatedly in a model. The elements of each sub-model (i.e., locations, entities, resources, etc.) may all be given a common prefix.
or suffix to differentiate them from the same elements of another sub-model.

For more information on merging models, see “Model Merging” on page 64.

**On-Line Help**

Regardless of where you are in the model building process, the on-line help system is available to provide context specific definitions and instructions. The help system can even run in the background, allowing instant access to help whenever you need it.

Like all Windows applications, you can locate the help you need quickly using the standard help tools.

**Running Models**

Completed models are run using the Simulation menu. Model data is automatically checked for consistency and completeness before each simulation begins.

As shown in the dialog below, ProModel allows you to specify a run length, warm-up period, number of replications, and other special options before running a simulation. In addition, you may run the models with or without animation. For more information on running models, see “Running the Model” on page 337.

**Creating Run-Time Models**

One of the most powerful features in ProModel is the ability to create models that may be run by others who do not own the full software. PROMODEL allows you to install the software on any machine to run a model. However, without the security key, the user has limited ability to build or make changes to a model.

You may wish to develop run-time models to allow the user to perform "what-if" analyses with the models. PROMODEL encourages you to develop demonstration models, and allows you to distribute them freely. These models can be run by installing ProModel from the CD-Rom onto a computer without a security key.

**Trace Window**

Several tools are available to help you verify and validate your models. During model execution you may trace the activity of the simulation events to see exactly what is happening in the
model. The example below shows a brief portion of a trace window.

<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00</td>
<td>Wait for available CellOp1.</td>
</tr>
<tr>
<td>00:00</td>
<td>For Cog at NC_Q</td>
</tr>
<tr>
<td>00:00</td>
<td>Process completed.</td>
</tr>
<tr>
<td>00:00</td>
<td>Wait for all its route entities to leave.</td>
</tr>
<tr>
<td>00:00</td>
<td>CellOp1.1 starts work search.</td>
</tr>
<tr>
<td>00:00</td>
<td>Requested by Cog at NC_301L.</td>
</tr>
<tr>
<td>00:00</td>
<td>CellOp1.1 is already available at this location.</td>
</tr>
<tr>
<td>00:00</td>
<td>Cog at NC_301L picked up by CellOp1.1.</td>
</tr>
<tr>
<td>00:00</td>
<td>Start move to Drill_O.</td>
</tr>
<tr>
<td>00:05</td>
<td>Release the captured capacity.</td>
</tr>
<tr>
<td>00:10</td>
<td>CellOp1.1 arrives at Drill_O.</td>
</tr>
<tr>
<td>00:10</td>
<td>Cog is dropped off at Drill_O by CellOp1.1.</td>
</tr>
<tr>
<td>00:10</td>
<td>CellOp1.1 is freed upon completion of delivery.</td>
</tr>
</tbody>
</table>

**Location Information Windows**

In addition to trace files, you may track the activity at any location through a Location Information window. This feature gives up-to-the-minute information about a selected location, such as current contents, total entries, and operational state (i.e., idle, blocked, or in operation).

**Viewing Output**

The output generator gathers statistics on each location, entity, resource, path network, and variable in the system. You may, however, turn off reporting capability for any element you do not wish to include. The default level of statistics is at the summary level (i.e., average values, % values, and final values), although detailed history plots can be gathered on such things as utilization, queue fluctuations, and variable values. For more information about viewing the results of a simulation, see “Reports and Graphs” on page 363.

Simulation results may be presented in either tabular or graphic format, including histograms, pie charts, plots and bar graphs. Multiple output results can even be compared on the same chart.

The example below shows a portion of a general report for a model.

**Graphical Analysis**

In addition to the general report shown above, almost all report elements of a model may be displayed graphically. Below is an example of a Category Chart.
Utilization Graphs

Quickly generate utilization graphs of various types such as the State Chart shown below.

Timeplots

In addition to Category and State Charts, Timeplot Charts, which show variable values as they change over time, can be created.
Chapter 1:
Using ProModel
Chapter 2: Installation and Registration

General Setup Information

This section describes how to install and register ProModel.

Hardware Requirements

Minimum
- Pentium 3 - 800 MHz or better
- 512 MB RAM
- 200 MB Free Disk Space
- 32 MB Video Card (1024 x 768 x 16 bit color)
- CD ROM
- Mouse
- Windows 2000 or higher

Recommended
- Core 2 Duo or better
- 2 GB RAM
- 256 MB Video Card (1280 x 1024 x 32 bit color)
- SVGA Monitor (1280 x 1024 x 32 bit color)
- 1 GB free disk space, CD ROM
- Speakers
- Internet access
- Mouse
- Windows Vista, XP

Installation Procedure for a Stand-alone PC

The installation program will decompress and copy files from the CD-ROM into user specific directories.

Technical Support

If you encounter problems during installation, please call the Product Team at (888) PRO-MODEL between 6:00 AM and 6:00 PM MST, Monday through Friday. We will be glad to help you get up and running.

How to install ProModel:

1. Start Windows.
2. Insert the CD-ROM.
3. Select the language that you would like to use during the installation. By choosing a specific language, you are also choosing to install language-specific demo models and other files.
4. The ProModel Setup program will open automatically, and display the following window.

Please note

If the Setup Program did not open automatically, select Run... from the Windows Start menu. Type x:\install.exe (where x is the CD-ROM drive letter) and press ENTER. The proper dialog will appear

5. Click Next to proceed with the installation

6. Review the License Agreement. If you wish to accept the agreement and continue with the installation, select the button to accept the agreement, and then click Next.

7. Select Standard Package and click Next.

8. From the dialog that appears, choose the components that you would like the Setup program to install. It is recommended that you allow the Setup program to install all components, hard drive space permitting. When you have finished selecting your components, click Next.

9. The next dialog allows you to have the Setup program create backups of any files that might be replaced during the installation. This is helpful if you are installing this version of the ProModel software on a computer that already has ProModel installed on it. If hard drive space permits, it is recommended that you allow the Setup program to backup previous files. When you are ready to continue with the installation, click Next.

10. The Setup program is now ready to install ProModel on your computer. If you wish to make changes to the options you have previously selected, click the Back button to return to any point in the installation you wish. Otherwise, click Next to allow the Setup program to install ProModel.

The Setup program may require you to reboot your computer during the setup. If you do so, the Setup program will automatically launch after the reboot, and the installation will continue.

When you have completed the installation, you can run ProModel from the Windows Start menu.

Upon running ProModel for the first time, you will be prompted to register ProModel. For instruction on doing so, see the section at the end of this chapter on registering ProModel.
Installation Procedure for Network Version

In a multi-user environment, license tracking with multiple keys is difficult. To combat this, PROMODEL Corporation offers a network version of ProModel that allows a single machine to control license usage (via a network connection) for several users. To use this method of license tracking, you must install a network version of ProModel. The network version of ProModel includes a hardware security key and the license manager software you will use to control license usage at your site.

Overview

When you install and run the network version of ProModel, the workstation searches your network for a license key server rather than check its own USB port for a security key. Once it locates the license key server, the workstation asks the license manager software (running on the key server) if a license is available. If a license is available, the license manager software will assign a license to the workstation. When you exit ProModel, the license you used becomes available to another user.

Check the support web page for periodic updates to the installation information, software configuration, and the license server software for ProModel.

http://www.promodel.com/support

Please note

If you are running a network version of ProModel on a routed network and your license key server and workstations are located on different sub-

nets, see “Find a License Key Server on a Routed Network” on page 21.

Set Up Network License Server

The license server consists of the security key that plugs into the license server’s USB port, and the license manager software. When installed, the license server responds to ProModel license requests and allows workstations to run either a full version (if sufficient licenses are available) or a limited run-time version.

Install Program Files

How to install program files:

1. Start Windows.
2. Insert the CD-ROM.
3. The ProModel Setup program will open automatically, and display the following window.

Please note

If the Setup Program did not open automatically, select Run... from the Windows Start menu. Type x:\install.exe (where x is the CD-ROM drive let-
Chapter 2: Installation Procedure for Network Version

4. Click **Next** to proceed with the installation

5. Review the License Agreement. If you wish to accept the agreement and continue with the installation, select the button to accept the agreement, and then click **Next**.

6. From the dialog that appears, select **Network Package**. The dialog will then appear as below:

7. Select **Install program files**, and click **Next**.

8. Select the type of hardware key you are using on the network server. If your license server is on a different subnet, enter the IP address of the server. Click **Next**.

9. From the dialog that appears, choose the components that you would like the Setup program to install. It is recommended that you allow the Setup program to install all components, hard drive space permitting. When you have finished selecting your components, click **Next**.

10. Choose the destination directory for the install. If you wish to change the destination from the default, select the **Browse** button and choose a new directory. When you have chosen the destination directory, click **Next**.

11. The next dialog allows you to have the Setup program create backups of any files that might be replaced during the installation. This is helpful if you are installing this version of the ProModel software on a computer that already has ProModel installed on it. Later, if you choose, you can have the installation rolled back and the original files restored. If hard drive space permits, it is recommended that you allow the Setup program to backup previous files. When you are ready to continue with the installation, click **Next**.

12. The Setup program will add a new Windows Program group containing ProModel program icons to the Program Manager. When you have selected where you want the Program icons to appear, click **Next**.

13. The Setup program is now ready to install ProModel on your computer. If you wish to make changes to the options you have previously selected, click the **Back** button to return to any point in the installation you wish. Otherwise, click **Next** to allow the Setup program to install ProModel.

The Setup program may require you to reboot your computer during the setup. If you do so, the Setup program will automatically launch after the reboot, and the installation will continue.

When you have completed the installation, you must set up a **license server**. See “Set Up License Server” on page 19, for information on how to do so.
Please note

If you are running a network version of ProModel on a routed network and your license key server and workstations are located on different subnets, see “Find a License Key Server on a Routed Network” on page 21.

Set Up License Server

PROMODEL software monitors licensed user activity through a security key attached to the parallel port (for the network version of ProModel, you must have the red key supplied by PROMODEL Corporation). The machine to which you attach the key becomes the license manager—whether it is a dedicated file server or a workstation. The security server can run on Windows 95, 98, 2000, or NT 4.0 and listen for incoming license requests over any of the following network protocols: IPX, TCP/IP, and NetBEUI. If the security server is not functioning, ProModel will start as a limited run-time version.

Please note

If you are running a network version of ProModel on a routed network and your license key server and workstations are located on different subnets, see “Find a License Key Server on a Routed Network” on page 21.

Set Up License Server:

3. The ProModel Setup program will open automatically, and display the following window.

![ProModel Setup Welcome window]

4. Click Next to proceed with the installation.

5. Review the License Agreement. If you wish to accept the agreement and continue with the installation, click Next.
6. From the dialog that appears, select **Network Package**. The dialog will then appear as below:

![Network Package Selection](image)

7. Select **Set up a network license server**, and click **Next**.

8. Select the type of hardware key you are using on the network server, and click **Next**.

9. The Install Wizard for the NetHASP License Manager will appear. Click **Yes**, and follow the on-screen directions to install the manager. If you click **No**, you will have to set up the license server manually, which is described in the next section.

The Setup program may require you to reboot your computer during the setup. If you do so, the Setup program will automatically launch after the reboot, and the installation will continue.

You need to install the device driver only once. However, you must launch the license manager program *each time you reboot the key server machine*. To automatically start the license manager each time you reboot the system, create and place an icon for NHSRVW32.EXE in the workstation’s startup folder.

When you have completed installing either you local machine or server setup, and finished installing the License Server, you are ready to run ProModel.

### Set Up License Server Manually

After successfully running the setup for the license server, if you chose to manually install the device driver for the security key and launch the license manager software, follow the steps below.

#### Install the Device Driver:

1. Open a DOS box and run `HINSTALL -i` from the directory to which you installed the license server.

2. After you receive a confirmation that the driver installed successfully, reboot the workstation.

#### Start the License Manager Software:

1. From the directory to which you installed the license server, run NHSRVW32.EXE. A window will appear and show the network protocols to which the license manager will listen for license requests.

You need to install the device driver only once. However, you must launch the license manager program *each time you reboot the key server*. To automatically start the license manager each
time you reboot the system, create and place an icon for NHSRVW32.EXE in the workstation’s startup folder.

Find a License Key Server on a Routed Network

In order for a workstation to run the network version of ProModel properly, the workstation must check out a license from a license server. To make a license request, the workstation sends a broadcast message out on the network and awaits a response from the license server. If the license server and the workstation running ProModel are on the same sub net of a routed network (or on the same network of a non-routed network), the license server receives the request and responds. Due to the nature of routed networks, if the license server and workstation running ProModel are not on the same sub net of a routed network, the key server will not receive the license request broadcast.

To resolve this problem, the workstation must send a license request directly to the computer on the network set up as the license server. To identify which computer on the network is the license server, you must create and store a text file called NETHASP.INI in the directory to which you installed ProModel on the workstation or file server.

For TCPIP-based network the NETHASP.INI file must contain the following lines

```
[NH_COMMON]
NH_TCPIP=Enabled;

[NH_TCPIP]
NH_TCPIP_METHOD=TCP

NH_SERVER_ADDR=<Enter the license server’s IP address here>
```
Registering ProModel

Your ProModel product must be registered. If you do not register ProModel, you will only have access to a limited, evaluation version of ProModel. This version will not allow expansive model building.

The registration process for ProModel depends on the type of installation you chose.

Registration for a Stand-alone PC Installation

When you run ProModel for the first time after installing it on a Stand-alone PC, you will be prompted to register ProModel. The following screen will appear.

When you have entered your information and clicked next, you will be prompted to enter your Serial Number.

Depending on your organization’s software licensing arrangement, a Serial Number may be included with your CD or possibly obtained by contacting the ProModel Corporation licensing representative for your organization.

If you do not have a Serial Number, you may still register using the instructions “How to Register without a Serial Number” on page 23.

How to Register with a Serial Number

1. When you have obtained a valid Serial Number, enter it into the registration dialog, and then click the Next button.

2. If a connection cannot be made to the ProModel Corporation server, an Internet connectivity issue (firewall, etc.) may exist. If this is the case, you will be prompted that the registration was not successful, in which case you may still register without a serial number. See “How to Register without a Serial Number” on page 23.
3. When the serial number has been successfully sent to the ProModel Corporation server, you will be given a ProModel username and password. Record this information, since you will use it to obtain updates to ProModel in the future.

4. Check the “I have recorded this information for future use” box, and then click Exit to finish the registration.

How to Register without a Serial Number

1. If you do not have a serial number, or your serial number cannot be used due to Internet connectivity issues, choose the “I do not have a Serial Number (or registering with the serial number failed)” option, and click Next.

2. You may choose to email (this step) or phone (next step) ProModel Support to register your product. If you would like to email ProModel Support, follow the “Click to send registration request” link that is next to the Email option.

3. If you would like to register over the phone, call ProModel Support at (888) PROMODEL. A ProModel Support representative will guide you through the rest of registration process.

While waiting for a response from ProModel Support, you may leave the Registration dialog open, or close it until you receive your response.

The reply you receive from ProModel Support will contain a License Key code. If you have closed ProModel, relaunch it, and return to the Phone or Email Registration window. In the “Step 2: Enter License Key” area, enter the License Key code that is in the email reply from ProModel Support.

You may then click “Register” to complete the registration process.

You will now have access to the full version of ProModel.

If you choose not to register ProModel at this time, click Cancel without entering registration information. You will then have access to the limited, evaluation version of ProModel.

Registration for a Network Installation

If you purchased a network version of ProModel, you will have received a hardware key with your ProModel software. To register your network version of ProModel, simply attach the hardware key to your computer’s LPT1 port.

Transferring/Terminating Your Software Key

As you use ProModel it may become necessary to transfer your software key from one PC to another. Please contact ProModel Corporation technical support if you would like to move or terminate your software key.
Chapter 2: Registering ProModel

Checking for ProModel Updates

The Check for ProModel Update feature checks the ProModel Web server for an update to ProModel, downloads any available update, and then installs the update. In order to have access to updates, you will need a ProModel Solutions Cafe username and password, and a current Maintenance and Support agreement. If you have questions regarding your M&S agreement, or username and password, please contact ProModel Technical Support at support@promodel.com.

There are two ways to obtain ProModel Updates:

• Quickly check to see if an update exists by selecting "Check for ProModel Update" from the Help menu in the ProModel application.
• Go to the ProModel Corporation solutions cafe on the ProModel Website (www.promodel.com). You can obtain updates for any of your ProModel products for which you have a current support agreement.

It is recommend that you check regularly for updates to ProModel.

Software License Key FAQ

1. I need to move my software license key to another computer, can I do this?
   Yes. Please contact ProModel Corporation technical support if you would like to move or terminate your software key.

2. I want to upgrade my computer’s operating system, or make a major change to my computer’s configuration, should I be concerned?
   The software license key is sensitive to changes to your computer’s configuration. This is to prevent the key’s unauthorized duplication to multiple computers. If you plan on making major changes to your computer’s configuration, please contact ProModel Corporation technical support for options to preserve your license key.

3. My software license key no longer appears to be functioning. What should I do?
   Your software license key may have been disturbed by changes to your computer’s configuration. Reboot your computer in an attempt to reset the configuration to a point that is recognizable by the license key. If the problem persists, please contact ProModel Corporation support (1-888-PROMODEL).
Chapter 3: Planning the Model

Steps for Doing Simulation

Introduction

Doing simulation requires more than just knowing how to use a simulation product. A simulation study is, by its very nature, a project. Like any project, there are tasks to be completed and resources required to complete them. To be successful, a simulation project should be planned with an understanding of the requirements of each of the tasks involved. Many failures result from hastily jumping into a simulation without first taking time to consider the steps involved and developing a plan for proceeding.

Simulation modeling requires good analytical, statistical, communication, organizational, and engineering skills. The modeler must understand the system being investigated and be able to sort through complex cause-and-effect relationships that determine system performance. At least a basic foundation in statistics is needed to properly design experiments and correctly analyze and interpret input and output data. Ongoing communication with owners, stakeholders, and customers during a simulation study is also vital to ensure that a purposeful model is built and that everyone understands the objectives, assumptions, and results of the study.

General Procedure

A decision to do a simulation usually results from a perception that simulation can help resolve one or more issues associated with the design of a new system or the modification of an existing system. Before launching into a simulation project, one or more individuals should have been assigned to the study who have at least a basic knowledge of the system to be studied and the issues of concern. Enough background information should have been obtained about the nature of the problem to determine whether simulation is a suitable solution. If the simulation is being conducted by individuals inside the company, there may already be a basic knowledge of the operation. For outsiders or those unfamiliar with the operation, a brief description of the system and explanation of key issues should be provided. For an existing system, a facility walk-through is an excellent way of getting familiar with the operation.

Once a suitable application or project has been identified as a candidate for simulation, decisions must be made about how to conduct the study. There are no strict rules on how to perform a simulation study, however, the following steps are generally recommended as a guideline (Shannon, 1975; Gordon, 1978; Law, 1991):

1. Plan the study
2. Define the system
3. Build the model
4. Run experiments
5. Analyze the output
6. Report results

Each step need not be completed in its entirety before moving on to the next step. The procedure for doing a simulation is an iterative one in which activities are refined and sometimes redefined with each iteration. Describing this iterative process, Pritsker and Pegden (1979) observe the following.

The iterative nature of this process is shown next:

**Procedure for Conducting a Simulation Study**

While the requirements for each step vary from simulation to simulation, the basic procedure is essentially the same. The primary value of adopting this systematic procedure, or one like it, is to ensure that the project is conducted in an organized, timely fashion with minimal waste of time and resources and maximum effectiveness in achieving the objectives.

**Step 1: Planning the Study**

Many simulation projects are doomed to failure from the outset due to poor planning. Undefined objectives, unrealistic expectations and a general lack of understanding of requirements frequently result in frustration and disappointment. If a simulation project is to be successful, a plan must be developed which is realistic, clearly communicated and closely followed. Planning a simulation study involves the following sub tasks:

- Defining Objectives
- Identifying Constraints
- Preparing a Simulation Specification
- Developing a Budget and Schedule

Each of these tasks is discussed in the following.

**Defining Objectives**

With a basic understanding of the system operation and an awareness of the issues of concern or interest, one or more objectives can be defined for the study. Simulation should only be used if an objective can be clearly stated and it is determined that simulation is the most suitable tool for achieving the objective. Defining an objective does not necessarily mean that there needs to be a problem to solve. A perfectly valid objective may be to see if there are, in fact, any unforeseen problems. Common types of objectives for a simulation study include the following:

- **Performance Analysis** How well does the system perform under a given set of circumstances in all measures of significance (utilization, throughput, waiting times, etc.)?
• **Capacity Analysis**  What is the maximum processing or production capacity of the system?

• **Capability Analysis**  Is the system capable of meeting specific performance requirements (throughput, waiting times, etc.), and, if not, what changes (added resources or improved methods) are recommended for making it capable?

• **Comparison Study**  How well does one system configuration or design variation perform compared to another?

• **Sensitivity Analysis**  Which decision variables are the most influential on one or more performance measures, and how influential are they?

• **Optimization Study**  What combination of feasible values for a given set of decision variables best achieves desired performance objectives?

• **Decision/Response Analysis**  What are the relationships between the values of one or more decision variables and the system response to those changes?

• **Constraint Analysis**  Where are the constraints or bottlenecks in the system and what are workable solutions for either reducing or eliminating those constraints?

• **Communication Effectiveness**  What variables and graphic representations can be used to most effectively depict the dynamic behavior or operation of the system?

Defining the objective should take into account what the ultimate intended use of the model will be. Some models are built as “throw-away” models to be used only once and then discarded. Other models are built to be used on an ongoing basis for continued “what-if” analyses. Some models need only provide a quantitative answer. Others require realistic animation to convince a skeptical customer. Some models are intended for use by managers with little simulation background and must be easy to use. Some models are used to make decisions of minor consequence. Other models are relied upon to make major financial decisions.

Realizing the objectives of a simulation should consider both the purpose as well as the intended use of the model, the following questions should be asked when defining the objectives of the study:

• Why is the simulation being performed?
• Who will be using the model?
• To whom will the results of the simulation be presented?
• What information is expected from the model?
• Is this a “throw-away” model?
• How important is the decision being made?

### Identifying Constraints

Equally as important as defining objectives is identifying the constraints under which the study must be conducted. It does little good if simulation solves a problem if the time to do the simulation extends beyond the deadline for applying the solution, or if the cost to find the solution exceeds the benefit derived. Objectives need to be tempered by the constraints under which the project must be performed such as the budget, deadlines, resource availability, etc. It is not uncommon to begin a simulation project with aspirations of developing an impressively detailed model or of creating a stunningly realistic animation only to scramble at the last minute, throwing together a crude model that barely meets the deadline.

Constraints should not always be viewed as an impediment. If no deadlines or other constraints are established, there is a danger of getting too involved and detailed in the simulation study and run the risk of “paralysis from analysis.” The
scope of any project has a tendency to shrink or expand to fill the time allotted.

In identifying constraints, anything that could have a limiting effect on achieving the desired objectives should be considered. Specific questions to ask when identifying constraints for a simulation study include the following:

- What is the budget for doing the study?
- What is the deadline for making the decision?
- What are the skills of those doing the study?
- How accessible is the input data?
- What computer(s) will be used for the study?

Preparing a Simulation Specification

With clearly defined objectives and constraints, the simulation requirements can be specified. Defining a specification for the simulation is essential to projecting the time and cost needed to complete the study. It also guides the study and helps set expectations by clarifying to others exactly what the simulation will include or exclude. A specification is especially important if the simulation is being performed by an outside consultant so that you will know exactly what you are getting for your money. Aspects of the simulation project to be contained in the specification include the following:

- **Scope**
- **Level of detail**
- **Degree of accuracy**
- **Type of experimentation**
- **Form of results**

Each of these specification criteria will be discussed in the following pages.

Scope The scope refers to the breadth of the model or how much of the system the model will encompass. Determining the scope of the model should be based on how much bearing or impact a particular activity has on achieving the objectives of the simulation. A common tendency is to model the entire system, even when the problem area and all relevant variables are actually isolated within a smaller subsystem. If, for example, the objective is to find the number of operators required to meet a required production level for a machining cell, it is probably not necessary to model what happens to parts after leaving the cell.

The following figure illustrates how the scope of the model should be confined to only those activities whose interactions have a direct bearing on the problem being studied. Upstream and downstream activities that do not impact the performance measure of interest should be omitted from the model. In the following figure, since the output rate from activity A is predictable, it can be modeled as simply an arrival rate to activity B. Since activity E never constrains output from activity D, it can also be ignored.

![Confining the Scope to Impacting Activities](image)

Level of Detail Project the level of detail defines the depth or resolution of the model. At one extreme, an entire factory can be modeled as a single “black box” operation with a random activity time. At the other extreme, every detailed motion of a machine could be modeled with a one-to-one correspondence depicting the entire machine operation.

Unlike the model scope which affects only the size of the model, the level of detail affects model complexity as well as model size. Determining the appropriate level of detail is an important decision. Too much detail makes it difficult and
time consuming to develop a valid model. Too little detail may make the model too unrealistic by excluding critical variables. The following figure illustrates how the time to develop a model is affected by the level of detail. It also highlights the importance of including only enough detail to meet the objectives of the study.

The level of detail is determined largely by the degree of precision required in the output. If only a rough estimate is being sought, it may be sufficient to model each activity by its time, rather than specific details making up the activity. If, on the other hand, details such as downtimes or move times have an appreciable effect on the outcome of the model, they should be included.

**Degree of Accuracy** The degree of accuracy pertains to the correctness of the data being used. For some models or activities, the information need not be as accurate or exact as it does for others. The required degree of accuracy is determined by the objectives of the study. If the decision is important or a comparison is close, greater accuracy may be required. Accuracy sometimes has to be sacrificed if reliable information is simply unavailable such as when modeling a completely new system.

The required degree of accuracy can have a significant impact on the time and effort required to gather data. It often has little impact, however, on the model building time since a model can be built with estimated values that can later be replaced with more accurate values. Output precision is often governed by the degree of accuracy of the model.

**Type of Experimentation** The number and nature of the alternative solutions to be evaluated should be planned from the outset in order to ensure that adequate time is allotted. This decision is often influenced by the deadline constraints of the study. Where alternatives with only slight differences are to be evaluated, a base model can be developed requiring only minor modifications to model each alternative. If alternative configurations are significantly different, it may require nearly as much effort modeling each configuration as it does developing the initial model.

For studies in which improvements to an existing system are being considered, it is often helpful and effective to model the current system as well as the proposed system. The basic premise is that you are not ready to make improvements to a system until you understand how the current system operates. Information on the current system is easier to obtain than information on areas of change. Once a model of the current system is built, it is often easier to visualize what changes need to be made for the modified system. Both systems may even be modeled together in the same simulation and made to run side by side. During the final presentation of the results, being able to show both “as is” and “to be” versions of the system effectively demonstrates the impact changes can have on system performance.

**Form of Results** The form in which the results are to be presented can significantly affect the time and effort involved in the simulation study. If detailed animation or an extensive report is expected, the project can easily stretch on for several weeks after the experimental phase has been completed. Many times the only result
required is a simple verification of whether a system is capable of meeting a production requirement. In such cases, a simple answer will suffice.

Developing a Budget and Schedule

With objectives and constraints clearly defined and a specification prepared identifying the work to be performed, a budget and schedule should be developed projecting the expected cost and time for completing the simulation project. Obviously, the time to perform a simulation project will vary depending on the size and difficulty of the project. If data is not readily available, it may be necessary to add several additional weeks to the project. A small project can take two to four weeks while large projects can take two to four months. A simulation schedule should be based on realistic projections of the time requirements keeping in mind the following:

• Defining the system to be modeled can take up to 50% of the project time.
• Model building usually takes the least amount of time (10 to 20%).
• Once a base model is built, it can take several weeks to conduct all of the desired experiments, especially if alternative designs are being compared.

While it may have initially been determined that simulation is a suitable tool for achieving the objective, the decision to use simulation may need to be reconsidered in light of projected cost and time estimates. Simulation may be a good solution to the problem at hand, but if the time or the cost of doing the project outweighs the anticipated benefits, either an alternative solution may need to be explored or the objectives may need to be modified to cut down on the level of effort required.

Step 2: Defining the System

With clearly defined objectives and a well-organized plan for the study, the system that will be simulated can begin to be defined in detail. This can be viewed as the development of a conceptual model on which the simulation model will be based. The process of gathering and validating system information can be overwhelming when faced with the stacks of uncorrelated data to sort through. Data is seldom available in a form that defines exactly how the system works. Many data gathering efforts end up with lots of data but very little useful information.

Data gathering should never be performed without a purpose. Rather than being haphazard, data gathering should be goal oriented with a focus on information that will achieve the objectives of the study. There are several guidelines to keep in mind when gathering data.

• **Identify cause-and-effect relationships** It is important to correctly identify the causes or conditions under which activities are performed. In gathering downtime data, for example, it is helpful to distinguish between downtimes due to equipment failure or personal emergencies and planned downtimes for break. Once the causes have been established and analyzed, activities can be properly categorized.

• **Look for key impact factors** Discrimination should be used when gathering data to avoid wasting time examining factors that have little or no impact on system performance. If, for example, an operator is dedicated to a particular task and, therefore, is never a cause of delays in service, there is no need to include the operator in the model. Likewise, extremely rare downtimes, negligible move times and other insignificant or irrelevant activities that have no appreciable effect on
routine system performance may be safely ignored.

• **Distinguish between time and condition dependent activities**  Time-dependent activities are those that take a predictable amount of time to complete, such as customer service. Condition-dependent activities can only be completed when certain defined conditions within the system are satisfied. Because condition-dependent activities are uncontrollable, they are unpredictable. An example of a condition-dependent activity might be the approval of a loan application contingent upon a favorable credit check.

Many activities are partially time-dependent and partially condition-dependent. When gathering data on these activities, it is important to distinguish between the time actually required to perform the activity and the time spent waiting for resources to become available or other conditions to be met before the activity can be performed. If, for example, historical data is used to determine repair times, the time spent doing the actual repair work should be used without including the time spent waiting for a repair person to become available.

• **Focus on essence rather than substance**  A system definition for modeling purposes should capture the key cause-and-effect relationships and ignore incidental details. Using this “black box” approach to system definition, we are not concerned about the nature of the activity being performed, but only the impact that the activity has on the use of resources and the delay of entity flow. For example, the actual operation performed on a machine is not important, but only how long the operation takes and what resources, if any, are tied up during the operation. It is important for the modeler to be constantly thinking abstractly about the system operation in order to avoid getting too caught up in the incidental details.

• **Separate input variables from response variables**  Input variables in a model define how the system works (e.g., activity times, routing sequences, etc.). Response variables describe how the system responds to a given set of input variables (e.g., work-in-process, idle times, resource utilization, etc.). Input variables should be the focus of data gathering since they are used to define the model. Response variables, on the other hand, are the output of a simulation. Consequently, response variables should only be gathered later to help validate the model once it is built and run.

These guidelines should help ensure that the system is thought of in the proper light for simulation purposes.

To help organize the process of gathering data for defining the system, the following steps are recommended:

• Determine data requirements.
• Use appropriate data sources.
• Make assumptions where necessary.
• Convert data into a useful form.
• Document and approve the data.

Each of these steps is explained on the following pages.

**Determining Data Requirements**

The first step in gathering system data is to determine what data is required for building the model. This should be dictated primarily by the scope and level of detail required to achieve the model objectives as described earlier. It is best to go from general to specific in gathering system
Chapter 3: Steps for Doing Simulation

data. The initial focus should be on defining the overall process flow to provide a skeletal framework for attaching more detailed information. Detailed information can then be added gradually as it becomes available (e.g., resource requirements, processing times, etc.). Starting with the overall process flow not only provides an orderly approach to data gathering, but also enables the model building process to get started which reduces the amount of time to build and debug the model later. Often, missing data becomes more apparent as the model is being built.

In defining the basic flow of entities through the system, a flow diagram can be useful as a way of documenting and visualizing the physical flow of entities from location to location. Once a flow diagram is made, a structured walk-through can be conducted with those familiar with the operation to ensure that the flow is correct and that nothing has been overlooked. The next step might be to define the detail of how entities move between locations and what resources are used for performing operations at each location. At this point it is appropriate to identify location capacities, move times, processing times, etc.

To direct data gathering efforts and ensure that meetings with others, on whom you depend for model information, are productive, it may be useful to prepare a specific list of questions that identify the data needed. A list of pertinent questions to be answered might include the following:

1. What types of entities are processed in the system and what attributes, if any, distinguish the way in which entities of the same type are processed or routed?
2. What are the route locations in the system (include all places where processing or queuing occurs, or where routing decisions are made) and what are their capacities (i.e., how many entities can each location accommodate or hold at one time)?
3. Besides route locations, what types of resources (personnel, vehicles, equipment) are used in the system and how many units are there of each type (resources used interchangeably may be considered the same type)?
4. What is the routing sequence for each entity type in the system?
5. What activity, if any, takes place for each entity at each route location (define in terms of time required, resources used, number of entities involved and any other decision logic that takes place)?
6. Where, when and in what quantities do entities enter the system (define the schedule, interarrival time, cyclic arrival pattern, or condition which initiates each arrival)?
7. In what order do multiple entities depart from each location (First in, First out; Last in, First out)?
8. In situations where an output entity could be routed to one of several alternative locations, how is the routing decision made (e.g., most available capacity, first available location, probabilistic selection)?
9. How do entities move from one location to the next (define in terms of time and resources required)?
10. What triggers the movement of entities from one location to another (i.e., available capacity at the next location, a request from the downstream location, an external condition)?
11. How do resources move from location to location to perform tasks (define either in terms of speed and distance, or time)?
12. What do resources do when they finish performing a task and there are no other tasks waiting (e.g., stay put, move somewhere else)?
13. In situations where multiple entities could be waiting for the same location or resource when it becomes available, what method is used for making an entity selection (e.g.,
longest waiting entity, closest entity, highest priority, preemption)

14. What is the schedule of availability for resources and locations (define in terms of shift and break schedules)?

15. What planned interruptions do resources and locations have (scheduled maintenance, setup, changeover)?

16. What random failures do resources and locations experience (define in terms of distributions describing time to failure and time to repair)?

Depending on the purpose of the simulation and level of detail needed, some of these questions may not be applicable. For very detailed models additional questions may need to be asked. Answers to these questions should provide nearly all of the information necessary to build a model.

Using Appropriate Data Sources

Having a specific set of questions for defining the system, we are now ready to search for the answers. Information seldom comes from a single source. It is usually the result of reviewing reports, conducting personal interviews, personal observation and making lots of assumptions. “It has been my experience,” notes Carson (1986), “that for large-scale real systems, there is seldom any one individual who understands how the system works in sufficient detail to build an accurate simulation model. The modeler must be willing to be a bit of a detective to ferret out the necessary knowledge.” Good sources of system data includes the following:

- Time Studies
- Predetermined Time Standards
- Flow Charts
- Facility Layouts
- Market Forecasts
- Maintenance Reports
- On-line tracking systems
- Equipment Manufacturers
- Managers
- Engineers
- Facility Walk-throughs
- Comparisons with Similar Operations

In deciding whether to use a particular source of data, it is important to consider the relevancy, reliability and accessibility of the source. If the information that a particular source can provide is irrelevant for the model being defined, then that source should not be consulted. What good is a maintenance report if it has already been decided that downtimes are not going to be included in the model? Reliability of the source will determine the validity of the model. A manager’s perception, for example, may not be as reliable as actual production logs. Finally, if the source is difficult to access, such as a visit to a similar facility in a remote site, it may have to be omitted.

Making Assumptions

Not long after data gathering has started, you may realize certain information is unavailable or perhaps unreliable. Complete, accurate, and up-to-date data for all the information needed is rarely obtainable, especially when modeling a new system about which very little is known. For system elements about which little is known, assumptions must be made. There is nothing wrong with assumptions as long as they can be agreed upon, and it is recognized that they are only assumptions. Any design effort must utilize assumptions where complete or accurate information is lacking.

Many assumptions are only temporary until correct information can be obtained or it is determined that more accurate information is necessary. Often, sensitivity analysis, in which a range of values is tested for potential impact, can give an indication of just how accurate the data
really needs to be. A decision can then be made to firm up the assumptions or to leave them alone. If, for example, the degree of variation in a particular activity time has little or no impact on system performance, then a constant activity time may be used. Otherwise, it may be important to define the exact distribution for the activity time.

Another approach in dealing with assumptions is to run three different scenarios showing a “best-case” using the most optimistic value, a “worst-case” using the most pessimistic value, and a “most-likely-case” using a best-estimate value. This will help determine the amount of risk you want to take in assuming a particular value.

**Converting Data to a Useful Form**

Data is seldom in a form ready for use in a simulation model. Usually, some analysis and conversion needs to be performed for data to be useful as an input parameter to the simulation. Random phenomena must be fitted to some standard, theoretical distribution such as a normal or exponential distribution (Law and Kelton, 1991), or be input as a frequency distribution. Activities may need to be grouped together to simplify the description of the system operation.

**Distribution Fitting** To define a distribution using a theoretical distribution requires that the data, if available, be fit to an appropriate distribution that best describes the variable. ProModel includes the Stat::Fit distribution fitting package which assists in fitting sample data to a suitable theoretical distribution. An alternative to using a standard theoretical distribution is to summarize the data in the form of a frequency distribution that can be used directly in the model. A frequency distribution is sometimes referred to as an empirical or user-defined distribution.

Whether fitting data to a theoretical distribution, or using an empirical distribution, it is often useful to organize the data into a frequency distribution table. Defining a frequency distribution is done by grouping the data into intervals and stating the frequency of occurrence for each particular interval. To illustrate how this is done, the following frequency table tabulates the number and frequency of observations for a particular activity requiring a certain range of time to perform.

**Frequency Distributions of Delivery Times**

<table>
<thead>
<tr>
<th>Delivery Time (days)</th>
<th>Number of Observations</th>
<th>Percentage</th>
<th>Cumulative Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 1</td>
<td>25</td>
<td>16.5</td>
<td>16.5</td>
</tr>
<tr>
<td>1 - 2</td>
<td>33</td>
<td>21.7</td>
<td>38.2</td>
</tr>
<tr>
<td>2 - 3</td>
<td>30</td>
<td>19.7</td>
<td>57.9</td>
</tr>
<tr>
<td>3 - 4</td>
<td>22</td>
<td>14.5</td>
<td>72.4</td>
</tr>
<tr>
<td>4 - 5</td>
<td>14</td>
<td>9.2</td>
<td>81.6</td>
</tr>
<tr>
<td>5 - 6</td>
<td>10</td>
<td>6.6</td>
<td>88.2</td>
</tr>
<tr>
<td>6 - 7</td>
<td>7</td>
<td>4.6</td>
<td>92.8</td>
</tr>
<tr>
<td>7 - 8</td>
<td>5</td>
<td>3.3</td>
<td>96.1</td>
</tr>
<tr>
<td>8 - 9</td>
<td>4</td>
<td>2.6</td>
<td>98.7</td>
</tr>
<tr>
<td>9 - 10</td>
<td>2</td>
<td>1.3</td>
<td>100.0</td>
</tr>
</tbody>
</table>

**Total Number of Observations = 152**

While there are rules that have been proposed for determining the interval or cell size, the best approach is to make sure that enough cells are defined to show a gradual transition in values, yet not so many cells that groupings become obscured.

Note in the last column of the frequency table that the percentage for each interval may be expressed optionally as a cumulative percentage. This helps verify that all 100% of the possibilities are included.

When gathering samples from a static population, one can apply descriptive statistics and draw reasonable inferences about the population. When gathering data from a dynamic and possibly time varying system, however, one must be sensitive
to trends, patterns, and cycles that may occur with time. The samples drawn may not actually be homogenous samples and, therefore, unsuitable for applying simple descriptive techniques.

**Activity Grouping** Another consideration in converting data to a useful form is the way in which activities are grouped for modeling purposes. Often it is helpful to group activities together so long as important detail is not sacrificed. This makes models easier to define and more manageable to analyze. In grouping multiple activities into a single activity time for simplification, consideration needs to be given as to whether activities are performed in parallel or in series. If activities are done in parallel or with any overlap, the time during which overlapping occurs should not be additive.

Serial activities are always additive. For example, if a series of activities is performed on an entity at a location, rather than specifying the time for each activity, it may be possible to sum activity times and enter a single time or time distribution.

**Documenting and Approving the Data**

When it is felt that all relevant information has been gathered and organized into a usable form, it is advisable to document the information in the form of data tables, relational diagrams and assumption lists. Sources of data should also be noted. This document should then be reviewed by others who are in a position to evaluate the validity of the data and approve the assumptions made. This document will be helpful later if you need to make modifications to the model or look at why the actual system ends up working differently than what was modeled.

In addition to including those factors to be used in the model, the data document should also include those factors deliberately excluded from the model because they are deemed to be either insignificant or irrelevant. If, for example, break times are not identified in the system description, a statement of explanation should be made explaining why. Stating why certain factors are being excluded from the system description will help resolve later concerns that may question why the factors were omitted.

Validating system data can be a time-consuming and difficult task, especially when many assumptions are made. In practice, data validation ends up being more of a consensus or agreement that is obtained confirming that the information is good enough for the purposes of the model. While this approved data document provides the basis for building the model, it often changes as model building and experimentation get under way.

**Step 3: Building the Model**

Once sufficient information has been compiled to define the basic system operation, the model building activity can begin. While starting to build a model too early can be a wasted exercise, waiting until all of the information is completely gathered and validated may unnecessarily postpone the building of the model. Getting the model started before the data is completely gathered may even help identify missing information needed to proceed.

The goal of model building is to provide a valid representation of the defined system operation. Additionally, the model must be able to provide any other statistical or graphical representation needed to satisfy the objectives of the study. A model is neither true nor false, but rather useful or not useful. Once validated, a model is useful when it provides the needed information to meet the objectives of the simulation.

**Progressive Refinement**

One nice feature of simulation is that models do not have to include all of the final detail before
Chapter 3: Steps for Doing Simulation

they will run. This allows a progressive refinement strategy to be used in which detail is added to the model in stages rather than all at once. Not only do models get built and running quicker this way, but it also makes models easier to debug. In the initial stages of a model, for example, attractive graphics are not very useful and, since they are likely to be changed anyway, should not be added until later when preparing for the final model presentation.

The complexity of model building should never be underestimated and it is always better to begin simple and add complexity rather than create an entire complex model at once. It is also easier to add detail to a model than it is to remove it from a model. Building a model in stages enables bugs to be more readily identified and corrected. Emphasizing the importance of applying progressive refinement to model building, Law and Kelton (1991) have advised:

*Although there are few firm rules on how one should go about the modeling process, one point on which most authors agree is that it is always a good idea to start with a simple model which can later be made more sophisticated if necessary. A model should contain only enough detail to capture the essence of the system for the purposes for which the model is intended: it is not necessary to have a one-to-one correspondence between elements of the model and elements of the system. A model with excessive detail may be too expensive to program and to execute.*

**Incremental Expansion**

In addition to adding complexity to a model in stages, models that have a broad scope are sometimes easier to build in phases where additional sections are added incrementally to the model. This method of "eating the elephant one bite at a time" allows a portion of the model to be built, tested and debugged before adding new sections and makes a large task more manageable.

For unusually large models, it may be useful to identify definable boundaries within a model to permit *model partitioning*. Model partitioning is the process of subdividing a model into two or more modules that represent physically separate sections within the system. The purpose of model partitioning is to allow model sections to be built and debugged, possibly even by separate individuals, independently of each other. Once sections are finished, they can be merged together to create the overall model. This “divide-and-conquer” method of model building can greatly reduce the time and difficulty in building and debugging large models.

**Model Verification**

Once a model is defined using a selected software tool, the model must generally be debugged to ensure that it works correctly. The process of demonstrating that a model works as intended is referred to in simulation literature as model verification. It is much easier to debug a model built in stages and with minimal detail than to debug a large and complex model. Eliminating bugs in a program model can take a considerable amount of time, especially if a general purpose programming language (e.g., C++) in which frequent coding errors occur is used. Most simulation languages provide a trace capability in the form of audit trails, screen messages, graphic animation, or a combination of all three. A trace enables the user to look inside of the simulation to see if the simulation is performing the way it should. Good simulation products provide interactive debugging capability which further facilitates the debugging process. A thorough “walk-through” of the model input is always advisable.
Model Validation

During the process of model building, the modeler must be constantly concerned with how closely the model reflects the system definition. The process of determining the degree to which the model corresponds to the real system, or at least accurately represents the model specification document, is referred to as model validation. Proving absolute validity is a non-attainable goal. As Neelamkavil (1987) explains, “True validation is a philosophical impossibility and all we can do is either invalidate or fail to invalidate.” For this reason, what we actually seek to establish is a high degree of face validity. Face validity means that, from all outward indications, the model appears to be an accurate representation of the system. From this standpoint, validating a model is the process of substantiating that the model, within its domain of applicability, is sufficiently accurate for the intended application (Schlesinger, 1979).

There is no simple test to establish the validity of a model. Validation is an inductive process through which the modeler draws conclusions about the accuracy of the model based on the evidence available. Gathering evidence to determine model validity is largely accomplished by examining the model structure (i.e., the algorithms and relationships) to see how closely it corresponds to the actual system definition. For models having complex control logic, graphic animation can be used effectively as a validation tool. Finally, the output results should be analyzed to see if the results appear reasonable. If circumstances permit, the model may even be compared to that actual system to see how they correspond. If these procedures are performed without encountering a discrepancy between the real system and the model, the model is said to have face validity.

Step 4: Conducting Experiments

The fourth step in a simulation study is to conduct simulation experiments with the model. Simulation is basically an application of the scientific method. In simulation, one begins with a theory of why certain design rules or management strategies are better than others. Based on these theories the designer develops a hypothesis which he tests through simulation. Based on the results of the simulation the designer draws conclusions about the validity of his hypothesis. In a simulation experiment there are input variables defining the model which are independent and may be manipulated or varied. The effects of this manipulation on other dependent or response variables are measured and correlated.

In some simulation experiments we are interested in the steady-state behavior of the model. Steady-state behavior does not mean that the simulation produces a steady outcome, but rather the distribution or statistical variation in outcome does not change over time. For example, a distribution warehouse may ship between 200 and 220 parts per hour under normal operating conditions. For many simulations we may only be interested in a particular time period, such as a specific day of the week. For these studies, the simulation may never reach a steady state.

As with any experiment involving a system with random characteristics, the results of the simulation will also be random in nature. The results of a single simulation run represent only one of several possible outcomes. This requires that multiple replications be run to test the reproducibility of the results. Otherwise, a decision might be made based on a fluke outcome, or at least an outcome not representative of what would normally be expected. Since simulation utilizes a pseudo-random number generator for generating random numbers, running the simulation multiple times simply reproduces the same sample. In
order to get an independent sample, the starting seed value for each random stream must be different for each replication, ensuring that the random numbers generated from replication to replication are independent.

Depending on the degree of precision required in the output, it may be desirable to determine a confidence interval for the output. A confidence interval is a range within which we can have a certain level of confidence that the true mean falls. For a given confidence level or probability, say .90 or 90%, a confidence interval for the average utilization of a resource might be determined to be between 75.5 and 80.8%. We would then be able to say that there is a .90 probability that the true mean utilization of the modeled resource (not of the actual resource) lies between 75.5 and 80.8%.

Fortunately, ProModel provides convenient facilities for conducting experiments, running multiple replications and automatically calculating confidence intervals. The modeler must still decide, however, what types of experimentation are appropriate. When conducting simulation experiments, the following questions should be asked:

- Am I interested in the steady state behavior of the system or a specific period of operation?
- How can I eliminate start-up bias or getting the right initial condition for the model?
- What is the best method for obtaining sample observations that may be used to estimate the true expected behavior of the model?
- What is an appropriate run length for the simulation?
- How many replications should be made?
- How many different random streams should be used?
- How should initial seed values be controlled from replication to replication?

Answers to these questions will be determined largely by the following three factors:

1. The nature of the simulation (terminating or nonterminating).
2. The objective of the simulation (capacity analysis, alternative comparisons, etc.).
3. The precision required (rough estimate versus confidence interval estimates).

**Terminating Versus Non-terminating Simulations**

As part of setting up the simulation experiment, one must decide what type of simulation to run. Simulations are usually distinguished as being one of two types: terminating or non-terminating. The difference between the two has to do with whether we are interested in the behavior of the system over a particular period of time or in the steady-state behavior of the system. It has nothing to do, necessarily, with whether the system itself terminates or is ongoing. The decision to perform a terminating or non-terminating simulation has less to do with the nature of the system than it does with the behavior of interest.

A terminating simulation is one in which the simulation starts at a defined state or time and ends when it reaches some other defined state or time. An initial state might be the number of parts in the system at the beginning of a work day. A terminating state or event might be when a particular number of jobs have been completed. Consider, for example, an aerospace manufacturer that receives an order to manufacture 200 airplanes of a particular model. The company might be interested in knowing how long it will take to produce the aircraft along with existing workloads. The simulation run starts with the system empty and is terminated when the 200th plane is completed since that covers the period of interest. A point in time which would bring a terminating simulation to an end might be the clos-
ing of shop at the end of a business day, or the completion of a weekly or monthly production period. It may be known, for example, that a production schedule for a particular item changes weekly. At the end of each 40 hour cycle, the system is “emptied” and a new production cycle begins. In this situation, a terminating simulation would be run in which the simulation run length would be 40 hours.

Terminating simulations are not intended to measure the steady-state behavior of a system. In a terminating simulation, average measures are of little meaning. Since a terminating simulation always contains transient periods that are part of the analysis, utilization figures have the most meaning if reported for successive time intervals during the simulation.

A non-terminating or steady-state simulation is one in which the steady-state behavior of the system is being analyzed. A non-terminating simulation does not mean that the simulation never ends, nor does it mean that the system being simulated has no eventual termination. It only means that the simulation could theoretically go on indefinitely with no statistical change in behavior. For non-terminating simulations, the modeler must determine a suitable length of time to run the model. An example of a non-terminating simulation is a model of a manufacturing operation in which oil filters are produced on a continual basis at the same pace. The operation runs two shifts with an hour break during each shift in which everything momentarily stops. Break and third shift times are excluded from the model since work always continues exactly as it left off before the break or end of shift. The length of the simulation is determined by how long it takes to get a representative steady-state reading of the model behavior.

Running Terminating Simulations

Experiments involving terminating simulations are usually conducted by making several simulation runs, or replications, of the period of interest using a different random seed for each run. This procedure enables statistically independent and unbiased observations to be made on the system response over the period simulated. Statistics are often gathered on performance measures for successive intervals of time during the period.

For terminating simulations, we are usually interested in final production counts and changing patterns of behavior over time rather than the overall average behavior. It would be absurd, for example, to conclude that because two technicians are busy only an average of 40% during the day that only one technician is needed. This average measure reveals nothing about the utilization of the technicians during peak periods of the day. A more detailed report of waiting times during the entire work day may reveal that three technicians are needed to handle peak periods, whereas only one technician is necessary during off-peak hours. In this regard, Hoover and Perry (1990) note:

It is often suggested in the simulation literature that an overall performance be accumulated over the course of each replication of the simulation, ignoring the behavior of the systems at intermediate points in the simulation. We believe this is too simple an approach to collecting statistics when simulating a terminating system. It reminds us of the statistician who had his head in the refrigerator and feet in the oven, commenting that on the average he was quite comfortable.

For terminating simulations, the three important questions to answer in running the experiment are:

1. What should be the initial state of the model?
2. What is the terminating event or time?
3. How many replications will you make?
Many systems operate on a daily cycle, or, if a pattern occurs over a weeks time, the cycle is weekly. Some cycles may vary monthly or even annually. Cycles need not be repeating to be considered a cycle. Airlines, for example, may be interested in the start-up period of production during the introduction of a new airport which is a one-time occurrence.

The number of replications should be determined by the precision required for the output. If only a rough estimate of performance is being sought, three to five replications are sufficient. For greater precision, more replications should be made until a confidence interval with which you feel comfortable is achieved.

**Running Non-terminating Simulations**

The issues associated with generating meaningful output statistics for terminating simulations are somewhat different that those associated with generating statistics for non-terminating systems. In steady-state simulations, we must deal with the following issues:

1. Determining the initial warm-up period.
2. Selecting among several alternative ways for obtaining sample observations.
3. Determining run length.

**Determining the Warm-up Period** In a steady-state simulation, we are interested in the steady-state behavior of the model. Since a model starts out empty, it usually takes some time before it reaches steady-state. In a steady-state condition, the response variables in the system (e.g., processing rates, utilization, etc.) exhibit statistical regularity (i.e., the distribution of these variables are approximately the same from one time period to the next). The following figure illustrates the typical behavior of a response variable, $Y$, as the simulation progresses through $N$ periods of a simulation.

<table>
<thead>
<tr>
<th>Period</th>
<th>$Y$</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
</tbody>
</table>

**Behavior of Response Variable $Y$ for Successive Periods During Simulation**

The time that it takes to reach steady-state is a function of the activity times and the amount of activity taking place. For some models, steady-state might be reached in a matter of a few hours of simulation time. For other models it may take several hundred hours to reach steady-state. In modeling steady-state behavior we have the problem of determining when a model reaches steady-state. This start-up period is usually referred to as the *warm-up period*. We want to wait until after the warm-up period before we start gathering any statistics. This way we eliminate any bias due to observations taken during the transient state of the model.

While several methods have been presented for determining warm-up time (Law and Kelton, 1991), the easiest and most straightforward approach, although not necessarily the most reliable, is to run a preliminary simulation of the system, preferably with several (3 to 5) replications, and observe at what time the system reaches statistical stability. The length of each replication should be relatively long and allow even rarely
occurring events, such as infrequent downtimes, to occur at least two or three times. To determine a satisfactory warm-up period using this method, one or more key response variables should be monitored by period over time, like the average number of entities in a queue or the average utilization of a resource. This approach assumes that the mean value of the monitored response variable is the primary indicator of convergence rather than the variance, which often appears to be the case. If possible, it is preferable to reset the response variable after each period rather than track the cumulative value of the variable, since cumulative plots tend to average out instability in data. Once these variables begin to exhibit steady-state, we can add a 20% to 30% safety factor and be reasonably safe in using that period as the warm-up period. This approach is simple, conservative and usually satisfactory. Remember, the danger is in underestimating the warm-up period, not overestimating it. Relatively little time and expense is needed to run the warm-up period longer than actually required. The following figure illustrates the average number of entities processed each hour for several replications. Since statistical stability is reached at about 10 hours, 12 to 15 hours is probably a safe warm-up period to use for the simulation.

**End of Warm-up Period**

![Plot of Hourly Entity Output to Identify Start of Steady-State](image)

**Obtaining Sample Observations** In a terminating simulation, sample observations are made by simply running multiple replications. For steady-state simulations, we have several options for obtaining sample observations. Two widely used approaches are running multiple replications and interval batching. The method supported in ProModel is running multiple replications.

Running multiple replications for non-terminating simulations is very similar to running terminating simulations. The only difference is that (1) the initial warm-up period must be determined, and (2) an appropriate run length must be determined. Once the replications are made, confidence intervals can be computed as described earlier in this chapter. One advantage of running independent replications is that samples are independent. On the negative side, running through the warm-up phase for each replication slightly extends the length of time to perform the replications. Furthermore, there is a possibility that the length of the warm-up period is underestimated, causing biased results.

Interval batching (also referred to as the batch means technique) is a method in which a single, long run is made with statistics being reset at specified time intervals. This allows statistics to be gathered for each time interval with a mean calculated for each interval batch. Since each interval is correlated to both the previous and the next intervals (called serial correlation or auto-correlation), the batches are not completely independent. The way to gain greater independence is to use large batch sizes and to use the mean values for each batch. When using interval batching, confidence interval calculations can be performed. The number of batch intervals to create should be at least 5 to 10 and possibly more depending on the desired confidence interval.

**Determining Run Length** Determining run length for terminating simulations is quite simple since there is a natural event or time point that defines
Chapter 3: Steps for Doing Simulation

it for us. Determining the run length for a steady-state simulation is more difficult since the simulation can be run indefinitely. The benefit of this, however, is that we can produce good representative samples. Obviously, running extremely long simulations is impractical, so the issue is to determine an appropriate run length that ensures a sufficiently representative sample of the steady-state response of the system is taken.

The recommended length of the simulation run for a steady-state simulation is dependent upon (1) the interval between the least frequently occurring event and (2) the type of sampling method (replication or interval batching) used. If running independent replications, it is usually a good idea to run the simulation enough times to let every type of event (including rare ones) happen at least a few times if not several hundred. Remember, the longer the model is run, the more confident you can become that the results represent a steady-state behavior. If collecting batch mean observations, it is recommended that run times be as large as possible to include at least 1000 occurrences of each type of event (Thesen and Travis, 1992).

Comparing Alternative Systems

Simulations are often performed to compare two or more alternative designs. This comparison may be based on one or more decision variables such as buffer capacity, work schedule, resource availability, etc. Comparing alternative designs requires careful analysis to ensure that differences being observed are attributable to actual differences in performance and not to statistical variation. This is where running multiple replications may again be helpful. Suppose, for example, that method A for deploying resources yields a throughput of 100 entities for a given time period while method B results in 110 entities for the same time period. Is it valid to conclude that method B is better than method A, or might additional replications actually lead the opposite conclusion?

Evaluating alternative configurations or operating policies can sometimes be performed by comparing the average result of several replications. Where outcomes are close or where the decision requires greater precision, a method referred to as hypothesis testing should be used. In hypothesis testing, first a hypothesis is formulated (e.g., that methods A and B both result in the same throughput) and then a test is made to see whether the results of the simulation lead us to reject the hypothesis. The outcome of the simulation runs may cause us to reject the hypothesis that methods A and B both result in equal throughput capabilities and conclude that the throughput does indeed depend on which method is used.

Sometimes there may be insufficient evidence to reject the stated hypothesis and thus the analysis proves to be inconclusive. This failure to obtain sufficient evidence to reject the hypothesis may be due to the fact that there really is no difference in performance, or it may be a result of the variance in the observed outcomes being too high given the number of replications to be conclusive. At this point, either additional (perhaps time consuming) replications may be run or one of several variance reduction techniques might be employed (see Law and Kelton, 1991).

Factorial Design

In simulation experiments we are often interested in finding out how different input variable settings impact the response of the system. Rather than run hundreds of experiments for every possible variable setting, experimental design techniques can be used as a “short-cut” to finding those input variables of greatest significance. Using experimental-design terminology, input variables are referred to as factors, and the output measures are referred to as responses. Once the
response of interest has been identified and the factors that are suspected of having an influence on this response defined, we can use a factorial design method which prescribes how many runs to make and what level or value to be used for each factor. As in all simulation experiments, it is still desirable to run multiple replications for each factor level and use confidence intervals to assess the statistical significance of the results.

One’s natural inclination when experimenting with multiple factors is to test the impact that each individual factor has on system response. This is a simple and straightforward approach, but it gives the experimenter no knowledge of how factors interact with each other. It should be obvious that experimenting with two or more factors together can affect system response differently than experimenting with only one factor at a time and keeping all other factors the same.

One type of experiment that looks at the combined effect of multiple factors on system response is referred to as a two-level, full-factorial design. In this type of experiment, we simply define a high and low level setting for each factor and, since it is a full-factorial experiment, we try every combination of factor settings. This means that if there are five factors and we are testing two different levels for each factor, we would test each of the $2^5 = 32$ possible combinations of high and low factor levels. For factors that have no range of values from which a high and low can be chosen, the high and low levels are arbitrarily selected. For example, if one of the factors being investigated is an operating policy for doing work (e.g., first come, first served; or last come, last served), we arbitrarily select one of the alternative policies as the high level setting and a different one as the low level setting.

For experiments in which a large number of factors are being considered, a two-level full-factorial design would result in an extremely large number of combinations to test. In this type of situation, a fractional-factorial design is used to strategically select a subset of combinations to test in order to “screen out” factors with little or no impact on system performance. With the remaining reduced number of factors, more detailed experimentation such as a full-factorial experiment can be conducted in a more manageable fashion.

After fractional-factorial experiments and even two-level full-factorial experiments have been performed to identify the most significant factor level combinations, it is often desirable to conduct more detailed experiments, perhaps over the entire range of values, for those factors that have been identified as being the most significant. This provides more precise information for making decisions regarding the best factor values or variable settings for the system. For a more concise explanation of the use of factorial design in simulation experimentation see Law and Kelton (1991).

**Use of Random Streams**

One of the most valuable characteristics of simulation is the ability to reproduce and randomize replications of a particular model. Simulation allows probabilistic phenomena within a system to be controlled or randomized as desired for conducting controlled experiments. This control is made available through the use of random streams.

A stream is a sequence of independently cycling, unique random numbers uniformly distributed between 0 and 1 (see the figure on next page). Random number streams are used to generate additional random numbers from other probability distributions (Normal, Beta, Gamma). After sequencing through all of the random numbers in the cycle, the cycle starts over again with the same sequence. The length of the cycle before it
repeats is called the *cycle period* and is usually very long.

![Example of a Random Stream Cycle with a Very Short Period](image)

A random stream is generated using a random number generator or equation. The random number generator begins with an initial seed value after which, each successive value uses the previous value as input to the generator. Each stream used in a simulation has its own independent seed and tracks its own values for subsequent input to the generator. Where the sequence begins in the cycle depends on the initial seed value used by the generator.

Any time a particular number seeds a stream, the same sequence of values will be repeated every time the same seed is used to initialize the stream. This means that various elements within a model can be held constant with respect to their performance while other elements vary freely. Simply specify one random number stream for one set of activities and another random number stream for all other activities.

Because the same seed produces the same sequence of values every time it is used, completely independent functions within a model must have their own streams from the start. For example, arrival distributions should generally have a random number stream used nowhere else in the entire model. That way, activities added to a model that sample from a random number stream will not inadvertently alter the arrival pattern because they do not affect the sample values generated from the arrival distribution.

To show an example of how multiple streams can be useful, consider two copy machines, Copy1 and Copy2, which go down approximately every 4 hours for servicing. To model this, the frequency or time between failures is defined by a normal distribution with a mean value of 240 minutes and a standard deviation of 15 minutes, $N(240,15)$. The time to repair is 10 minutes. If no stream is specified in the normal distribution, the same stream will be used to generate sample values for both machines. So, if the next two numbers in the stream number are .21837 and .86469, Copy1 will get a sample value from the normal distribution that is different from Copy2. Therefore, the two machines will go down at different times.

Suppose, however, that the resource servicing the machines must service them both at the same time, so we would like to have the machines go down at the same time. Using the same stream to determine both downtimes will not bring them down at the same time, because a different random number will be returned from the stream with each call to generate a random normal variate. Using two different streams, each dedicated to a machine's downtime and each having the same initial seed, will ensure that both machines go down at the same time every time. The two streams have the same starting seed value so they will produce exactly the same sequence of random numbers.
Step 5: Analyzing the Output

Output analysis deals with drawing inferences about the actual system based on the simulation output. When conducting simulation experiments, extreme caution should be used when interpreting the simulation results. Since the results of a simulation experiment are random (given the probabilistic nature of the inputs), an accurate measurement of the statistical significance of the output is necessary.

People doing simulation in academia are often accused of working with contrived and often oversimplified assumptions, yet are extremely careful about ensuring the statistical significance of the model results. Simulation practitioners in industry, on the other hand, are usually careful to obtain valid model data, only to ignore the statistical issues associated with simulation output. Maintaining a proper balance between establishing model validation and establishing the statistical significance of simulation output is an important part of achieving useful results.

The most valuable benefit from simulation is to gain insight, not necessarily to find absolute answers. With this in mind, one should be careful about getting too pedantic about the precision of simulation output. With more than 60 combined years of experience in doing simulation modeling, Conway, Maxwell and Worona (1986) caution that attaching a statistical significance to simulation output can create a delusion that the output results are either more or less significant than they really are. They emphasize the practical, intuitive reading of simulation results. Their guideline is "If you can't see it with the naked eye, forget it."

The goal of conducting experiments is not just to find out how well a particular system operates, but hopefully to gain enough insight to be able to improve the system. Unfortunately, simulation output rarely identifies causes of problems, but only reports the symptomatic behavior of problems. Bottleneck activities, for example, are usually identified by looking for locations or queues that are nearly always full which feed into one or more locations that are sometimes empty. Detecting the source of the bottleneck is sometimes a bit trickier than identifying the bottleneck itself. Bottlenecks may be caused by excessive operation times, prolonged delays due to the unavailability of resources, or an inordinate amount of downtime. The ability to draw correct inferences from the results is essential to making system improvements.

Step 6: Reporting the Results

The last step in the simulation procedure is to make recommendations for improvement in the actual system based on the results of the simulated model. These recommendations should be supported and clearly presented so that an informed decision can be made. Documentation of the data used, the model(s) developed and the experiments performed should all be included as part of a final simulation report.

A simulation has failed if it produces evidence to support a particular change which is not implemented; especially if it is economically justified. The process of selling simulation results is largely a process of establishing the credibility of the model. It is not enough for the model to be valid, the client or management must also be convinced of its validity if it is to be used as an aid in decision making. Finally, the results must be presented in terms that are easy to understand and evaluate. Reducing the results to economic factors always produces a compelling case for making changes to a system.

In presenting results it is important to be sensitive to the way in which recommendations are made. It helps to find out whether recommendations are being sought or whether a simple summary of the
Chapter 3:
Steps for Doing Simulation

results is wanted. It is generally wise to present alternative solutions and their implications for system performance without suggesting one alternative over another, particularly when personnel changes or cuts are involved. In fact, where there may be careers on the line, it is best to caution the decision maker that your simulation study looks only at the logistical aspects of the system and that it does not take into account the potential reactions or potential difficulties employees may have in accepting a particular solution.

Animation and output charts have become an extremely useful aid in communicating the results of a simulation study. This usually requires that some touch-up work be done to create the right effect in visualizing the model being simulated. In preparing the results, it is often necessary to add a few touch-ups to the model (like a full dress-rehearsal) so the presentation effectively and convincingly presents the results of the simulation study.

After the presentation is finished and there is no further analysis to be conducted (the final presentation always seems to elicit further suggestions for trying this or that with the model), the model recommendations, if approved, are ready to be implemented. If the simulation has been adequately documented, it should provide a good functional specification for the implementation team.

Summary

A simulation project has distinct phases that must be understood and followed in order to be successful. Simulation requires careful planning with realistic goals and expectations. Steps to performing a simulation study include planning the study, defining the system, building the model, conducting experiments, analyzing the output, and presenting the results. Systematically following these steps will help avoid the pitfalls that frequently occur when conducting a simulation study.

Pitfalls in Simulation

If the steps that have been outlined are followed, the chances of performing a successful simulation project are very good. Typical reasons why simulation projects fail include the following:

- Failure to state clear objectives at the outset.
- Failure to involve individuals affected by outcome.
- Overrunning budget and time constraints.
- Failure to document and get a consensus on input data.
- Including more detail than is needed.
- Including variables that have little or no impact on system behavior.
- Failure to verify and validate the model.
- Basing decisions on a single run observation.
- Basing decisions on average statistics when the output is actually cyclical.
- Being too technical and detailed in presenting the results to management.
Building a Model

ProModel gives you the flexibility to create a model in several ways—the easiest is to use the graphical point-and-click approach. To build a model, you should first define any locations in the system. With locations defined, you are ready to create entities (parts, customers, calls, etc.) and schedule their arrivals to the locations you created. Next, specify the process logic for entities at each location (this will establish the entity flow throughout the model). Finally, define any optional model elements such as attributes, variables, or arrays that you will use in processing entities.

Modeling Scenario

Before we actually begin building a model, let's look at a fictitious scenario for our model building session.

Cogswell Cogs has just secured a contract to produce a new cog for production of the X-95C Family Space Cruiser. The current capacity of the Cogswell facility is not adequate to handle any additional work load while continuing to fill existing orders. Therefore, Mr. Cogswell has ordered the I.E. department to simulate the design of a new workcell dedicated to the production of the new cog.

The process consists of loading a cast blank onto an NC mill for milling of the outside splines. Once the splines have been cut, the cog must be degreased, inspected and loaded with an inner bearing. All operations, including inspection, are to be performed by a single operator.

Model Elements

In building this model we must define all of the basic modeling elements and a few of the optional elements.

Locations

We need some type of receiving location to hold incoming entities. We also need processing locations where entities have value added to them. For the given production rate, Cogswell's engineers have determined that the workcell will require two NC_300 series numerically controlled mills, a degreasing machine, and an inspection/assembly station.

Entities (Parts)

The entity types in this system include Pallets, each carrying six cast Blanks. Blanks become Cogs after processing, and Bearings are loaded at the Inspect station. If a Cog fails the inspection it will be called a Reject.

Arrivals

Cogswell's engineers have determined that Pallets should arrive at the rate of 1 Pallet every 45 minutes.

Processing

The operation at each mill requires an operator to load the Blank, which takes a normally distributed amount of time with a mean of 3 minutes and standard deviation of .2 minutes (i.e., N(3,.2)). After a blank has been loaded, the machining time is a constant 5.7 minutes.

Cogswell's engineers have determined that Pallets should arrive at the rate of 1 Pallet every 45 minutes.

The process consists of loading a cast blank onto an NC mill for milling of the outside splines. Once the splines have been cut, the cog must be degreased, inspected and loaded with an inner bearing. All operations, including inspection, are to be performed by a single operator.

Model Elements

In building this model we must define all of the basic modeling elements and a few of the optional elements.
Chapter 3: Building a Model

Resources
A single operator, CellOp, performs all manual operations.

Path Networks
In order to make CellOp a mobile resource, we must define a path network. We'll call it CellNet.

Attributes
An attribute is simply a “numeric tag” attached to either an entity (entity attribute) or a location (location attribute). Since each Cog is inspected for proper spline depth, we attach an attribute called Test to each Cog, specifying the Pass/Fail status of the Cog.

User Distributions
We will sample from a user defined distribution and set the Test attribute to either 1 (for pass) or 0 (for fail). Ninety six percent of the Cogs pass inspection and have their Test attribute set to one. Four percent fail the inspection and have their Test attribute set to zero.

Phased Modeling Approach
Instead of trying to build a model all at once, you may want to implement a phased modeling approach where you build the model in stages. This will help you understand the basic modeling elements before moving on to more complex ones like attributes and IF-THEN logic. The following elements are those components normally entered during each phase of the model building process.

Phase 1: Basic Model Elements
The first step in building the model is to define the model's basic elements.

General Information
The General Information dialog box, accessed through the Build menu, allows you to name your model and specify default information such as time and distance units. You also specify the
name of the graphics library to use. By default it will be PROMOD5.GLB.

**Importing a Background Graphic**

Simple background graphics are imported easily through the Background Graphics Editor. ProModel also allows you to import complex graphics files such as AutoCAD drawings to use as the background for your simulations. For more information on how to import a background graphic, see “Graphic Editor” on page 304.

Often, importing a background graphic makes the process of placing locations easier, or altogether eliminates the need to create graphic icons for locations.

**Defining Locations**

Locations are defined easily by selecting the desired icon and placing it in the layout window. Each time a location is placed in the layout window, a corresponding record is entered in the Location edit table. This table lists each location along with location parameters such as the capacity, number of units, and downtime information. For more information on how to define a location, see “Locations” on page 90.

**Layout Window (maximized)**

**Location Edit Table**

**Defining Entities**

Once all locations have been defined, we define entities in a similar way by selecting an icon for each entity type. As we do this, a record is created in the Entity edit table for each entity type.
For more information on how to define entities, see “Entities” on page 112.

In this model the Speed (fpm) column is irrelevant since all entities move according to the definition of the mobile resource CellOp. Also, the Stats column shows that we desire detailed statistics for all entity types. “Time series” statistics include throughput history of the entity. “Basic” statistics include only the total exits of each entity type from the system and the final quantity of each entity type in the system.

**Defining Arrivals**

Of the four entity types, only one needs to be scheduled to arrive in the system. Every 45 minutes one Pallet arrives at the Receiving location. The word “INFINITE” in the Occurrences column means that one pallet continues to arrive every 30 minutes as long as the simulation runs. For more information on defining arrivals, see “Arrivals” on page 156.

**Defining Process Logic**

The last step in defining Phase 1 of our model is to define the processing of entities at each location. ProModel simplifies this task by allowing you to select an entity type and then use the mouse to click on the locations in the order in which they will process the entity. Each time you click on a location, a new processing record is added to the Process edit table, defining the process for that entity type at that location. For more information on defining process logic, see “Processing” on page 143, and “Operation Logic” on page 291.

Once the basic entity flow has been defined using the point and click method, operation statements are added to the processing logic. The processing logic can be as simple as a constant operation time or as complex as a nested IF...THEN...ELSE statement.

Process editing actually involves two edit tables that normally appear side by side. The Process edit table specifies what happens to an entity when it arrives at a location, and the Routing edit table specifies where an entity is to be sent once processing is complete.

**Process Edit Table**

<table>
<thead>
<tr>
<th>Entity...</th>
<th>Location...</th>
<th>Operation...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pallet</td>
<td>Receive</td>
<td></td>
</tr>
<tr>
<td>Blank</td>
<td>NC_301L</td>
<td>WAIT N(3,2)</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_302L</td>
<td>WAIT N(3,2)</td>
</tr>
<tr>
<td>Cog</td>
<td>Degrease</td>
<td>Accum 2</td>
</tr>
<tr>
<td>Cog</td>
<td>Inspect</td>
<td>WAIT U(3,2,3)</td>
</tr>
<tr>
<td>Bearing</td>
<td>Bearing_Queue</td>
<td></td>
</tr>
</tbody>
</table>

**Routing Edit Table**

<table>
<thead>
<tr>
<th>Output...</th>
<th>Destination...</th>
<th>Rule...</th>
<th>Move Logic...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>NC_301L</td>
<td>FIRST 1</td>
<td>IF RESQTYCell</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_302L</td>
<td>FIRST 1</td>
<td>IF RESQTYCell</td>
</tr>
</tbody>
</table>

**Process and Routing Logic**

The entire process and routing tables for the Phase 1 model are shown next. The table reads as follows:

1. When an entity called Pallet arrives at location Receive there is no operation time or processing logic (it's just a storage location). The resulting output is six entities called Blank that are routed
to the FIRST available destination of either NC_301L or NC_302L.

2. When Blanks arrive at NC_301L or NC_302L, the processing time is a normal distribution with a mean of 3 and a standard deviation of .2 minutes. The name of the entity is now changed to Cog, and the Cog is sent to the Degrease location (FIRST is the default routing rule).

3. Two Cogs are accumulated at Degrease and processed for 5 minutes. When the degrease cycle is complete, Cogs are routed to location Inspect.

4. The inspection time is a uniform distribution with a mean of 3.2 and a half range of .3 minutes. Ninety six percent of the Cogs pass inspection and exit the system, while four percent of the Cogs fail inspection and become Rejects.

### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pallet</td>
<td>Receive</td>
<td></td>
<td>1</td>
<td>Blank</td>
<td>NC_301L</td>
<td>FIRST</td>
<td>MOVE FOR .5</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_301L</td>
<td>WAIT N(3.2)</td>
<td>1</td>
<td>Cog</td>
<td>Degrease</td>
<td>FIRST</td>
<td>MOVE FOR .5</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_302L</td>
<td>WAIT N(3.2)</td>
<td>1</td>
<td>Cog</td>
<td>Degrease</td>
<td>FIRST</td>
<td>MOVE FOR .5</td>
</tr>
<tr>
<td>Cog</td>
<td>Degrease</td>
<td>ACCUM 2 WAIT 5</td>
<td>1</td>
<td>Cog</td>
<td>Inspect</td>
<td>FIRST</td>
<td>MOVE FOR .5</td>
</tr>
<tr>
<td>Cog</td>
<td>Inspect</td>
<td>WAIT U(3.2,3)</td>
<td>1</td>
<td>Cog</td>
<td>EXIT</td>
<td>0.960</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Reject</td>
<td>EXIT</td>
<td>0.040</td>
<td></td>
</tr>
</tbody>
</table>

### Routing Table
Phase 2: Adding Resources & Variability

In this phase we wish to add the operator, CellOp, to move entities from location to location, and to perform the loading, unloading, and inspection operations. ProModel requires that all dynamic resources travel on a path network. Therefore, for Phase 2, we need to define resources and path networks.

Defining Path Networks

Path Networks consist of nodes and path segments which connect nodes to other nodes. Each location where a resource may stop to pick up, drop off, or process entities must interface with a path node.

We define path networks through the Path Network edit table similar to the previous edit tables. For each network we specify the nodes and path segments connecting the nodes. Some of the heading buttons, such as Paths and Interfaces, bring up other edit tables such as the Path Segment Edit table shown below. For more information on defining path networks, see “Path Networks” on page 117.

Path Network Edit Table

Path Segment Edit Table

Defining Resources

Resources are defined in much the same way as entities. When in the Resource module we simply select an icon to represent the resource and then specify the characteristics of the resource in the Resource edit table. For more information about defining resources, see “Resources” on page 126.
The Resource edit table shown below contains fields for specifying the name and number of units of a resource. It also has fields for specifying resource downtimes (DTs...), the level of statistics to collect (Stats...), which path network used for travel (Specs...), and any work and park search routines (Search...). Clicking the mouse on any of these buttons brings up separate edit tables for specifying this data.

Process Editing

Now that we have defined a resource, we must specify how and when that resource is used in the processing logic.

In the Phase 1 model we used only constant processing times. Now, due to variability associated with the operator, we must represent the loading and inspection times as distributions.

In the example below, CellOp loads the blank at mill NC_302L and is then FREEd to perform other operations. When the Blank has finished processing, the entity is moved with the CellOp to the degreasing machine.

Process Edit Table and corresponding operation logic

Routing Edit Table

Process and Routing Logic

The complete process and routing logic is shown below, with CellOp used to perform the loading operations at each mill and inspect the Cogs at the Inspect location. CellOp is also used to transport entities from location to location. All additions or changes to the Phase 1 model are shown in bold type.
Chapter 3: Building a Model

With the new processing now defined, we have specified all of the necessary modeling elements. We are now ready for the model execution phase. Once again, we shall defer discussion of model execution until we have finished the final phase of the model.

### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pallet</td>
<td>Receive</td>
<td></td>
<td>1</td>
<td>Blank</td>
<td>NC_301L</td>
<td>FIRST 6</td>
<td>MOVE WITH CellOp</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Blank</td>
<td>NC_302L</td>
<td>FIRST</td>
<td>MOVE WITH CellOp</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_301L</td>
<td>WAIT N(3,2) FREE CellOp WAIT 5.7</td>
<td>1</td>
<td>Cog</td>
<td>Degrease</td>
<td>FIRST 1</td>
<td>MOVE WITH CellOp</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_302L</td>
<td>WAIT N(3,2) FREE CellOp WAIT 5.7</td>
<td>1</td>
<td>Cog</td>
<td>Degrease</td>
<td>FIRST 1</td>
<td>MOVE WITH CellOp THEN FREE</td>
</tr>
<tr>
<td>Cog</td>
<td>Degrease</td>
<td>ACCUM 2 WAIT 5</td>
<td>1</td>
<td>Cog</td>
<td>Inspect</td>
<td>FIRST 1</td>
<td>MOVE WITH CellOp</td>
</tr>
<tr>
<td>Cog</td>
<td>Inspect</td>
<td>WAIT U(3,2,.3) FREE CellOp</td>
<td>1</td>
<td>Cog</td>
<td>EXIT</td>
<td>0.960 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Reject</td>
<td>EXIT</td>
<td>0.040</td>
<td></td>
</tr>
</tbody>
</table>

### Routing Table
Phase 3: Additional Operations

In the final phase of our modeling session we want to demonstrate an assembly operation by using the operator to install a Bearing into the center hole of the Cog if (and only if) the Cog passes inspection.

Once we have defined the attribute and distribution table, we must return to the Locations, Entities and Arrivals modules to define a new location called Bearing_Que, a new entity called Bearing, and an arrival schedule for the Bearings.

In addition, we also need to specify a usage based downtime for mills NC_301L and NC_302L from the Location module.

The final step in completing this phase of the model is to edit the processing logic to include the assembly. We will use the built-in JOIN construct to accomplish the assembly.

Defining Attributes

The Attribute module allows you to enter the Attribute edit table to define an Entity Attribute called Test that holds integer values. We set this attribute to one if the Cog passes the inspection, or zero if it fails the inspection. For more information about defining attributes, see “Attributes” on page 217.

Defining a Distribution

In order to determine if an entity passes or fails the inspection, you sample from a user-defined distribution called Dist1 (alternately, you could use the RAND() function). To define the distribution, simply click the mouse on the Table... button and fill in the distribution parameters. In this case, 96% of the entities pass inspection and 4% fail.

New Location, Entity, and Arrival

Before we can assemble the Cog at the Inspect location we must first define the new entity type called Bearing in the Entities module. We must also define a new location, Bearing_Que, to hold the Bearings, and an arrival schedule for the Bearings. To do this we simply open the appropriate module as in Phase 1 and supply the information. For simplicity we'll skip the details and move on to downtime specification.

Defining Location Downtimes

In order to represent machine failure times for the two mills, NC_301L and NC_302L, we click on the DT... button in the Location edit table shown below. This brings up another edit table for specifying a downtime based on machine usage. For more information about defining location downtimes, see “Location Downtimes” on page 101.
In the example above, we have defined failures to occur according to an exponential distribution with a mean of 30 minutes. When a machine fails, resource CellOp is required to service the machine.

### Process and Routing Logic

The process and routing table below shows all of the changes and additions to the Phase 2 model in bold text.

#### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pallet</td>
<td>Receive</td>
<td></td>
<td>1</td>
<td>Blank</td>
<td>NC_301L</td>
<td>FIRST 6</td>
<td>MOVE WITH CellOp</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Blank</td>
<td>NC_302L</td>
<td>FIRST</td>
<td>MOVE WITH CellOp</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_301L</td>
<td>WAIT N(3,.2) FREE CellOp \ WAIT 5.7</td>
<td>1</td>
<td>Cog</td>
<td>Degrease</td>
<td>FIRST 1</td>
<td>MOVE WITH CellOp</td>
</tr>
<tr>
<td>Blank</td>
<td>NC_302L</td>
<td>WAIT N(3,.2) FREE CellOp \ WAIT 5.7</td>
<td>1</td>
<td>Cog</td>
<td>Degrease</td>
<td>FIRST 1</td>
<td>MOVE WITH CellOp THEN FREE</td>
</tr>
<tr>
<td>Cog</td>
<td>Degrease</td>
<td>ACCUM 2 WAIT 5</td>
<td>1</td>
<td>Cog</td>
<td>Inspect</td>
<td>FIRST 1</td>
<td>MOVE WITH CellOp THEN FREE</td>
</tr>
<tr>
<td>Cog</td>
<td>Inspect</td>
<td>WAIT U(3.2,3) Test = Dist1() IF Test = 1 THEN JOIN 1 Bearing WAIT U(1.2,2) FREE CellOp ROUTE 1 END ELSE BEGIN FREE CellOp ROUTE 2 END</td>
<td>1</td>
<td>Cog</td>
<td>EXIT</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>Reject</td>
<td>EXIT</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>Bearing</td>
<td>Bearing_Que</td>
<td></td>
<td>1</td>
<td>Bearing</td>
<td>Inspect</td>
<td>JOIN 1</td>
<td>MOVE FOR .05</td>
</tr>
</tbody>
</table>

This concludes the final phase of our model building session. We now turn our focus to running the model.

### Running a Model

Running a model is a fun and easy process. Models are compiled automatically at runtime, keeping you apart from any complex compilation process. If your model contains any errors, a detailed message explains the nature of the error and points to the module and line number where the error occurred. In most cases you are permitted to make changes on the fly.

ProModel uses concurrent animation, which means that the animation occurs while the simu-
lation is running. Concurrent animation has many advantages over post-simulation animation. By eliminating the two-step process of running the simulation and then animating it, you save valuable time. Concurrent animation immediately allows you to see if a model is working properly.

Simulation Options

When you select Options from the Simulation menu, ProModel displays the Simulation Options dialog. This dialog contains several options for controlling the simulation, such as the run length, warm-up period, clock precision, and the name of the output file. You can also set the number of replications and the level of detail to be collected for the statistics. For more information about Simulation options, see “Simulation Menu” on page 337.

The maximum run length depends on the clock precision and the time unit selected as shown in the following table.

### Animation Screen

The ProModel animation screen has a menu of its own, with selections for controlling many simulation parameters (such as run speed). You can also control the animation through panning, zooming, and pausing.

The screen above shows the speed control bar, along with the clock selection button for controlling the format of the clock readout.

The File menu includes an option for viewing a text file of the model as the model is running. This is an excellent way of checking to make sure the model is doing what it is supposed to do!

Next we'll take a look at two of the other menu items: Options and Information.
Options Menu

The Options menu contains several options that allow you to track events in the system as they occur. The Debugger is a convenient and efficient way to test or follow the processing of any logic defined in your model. The debugger is used to step through logic one statement at a time and examine variables and attributes while a model is running. A Step Trace allows you to step through the system events one at a time by clicking on the left mouse button. A Continuous Trace allows you to step through system events continuously without clicking the mouse.

The following Trace window shows system events as they occur in the animation. The number in the left hand column represents the simulation time when the event occurred, while the text describes the event. Stepping through the events is an excellent way to verify and debug a model.

Other options include: Animation Off, which makes the simulation run considerably faster; Zoom, which allows you to zoom in or out to any degree on the animation; Views, which allows you to quickly and easily access specific areas of the model Layout window (see “Layout Settings” on page 80); and User Pause, which allows you to specify the time of the next simulation pause.

Information Menu

The Information menu contains selections for obtaining system information during the run. For up-to-the-minute location information, such as current location contents and total number of entries, select Locations from the Information menu.

The following Trace window shows system events as they occur in the animation. The number in the left hand column represents the simulation time when the event occurred, while the text describes the event. Stepping through the events is an excellent way to verify and debug a model.
Viewing Model Statistics & Reports

The purpose of any simulation model is to gain a deeper understanding of the system under study. ProModel's Output Viewer 3DR helps you to see the interactions between various system elements through tabular and graphical representation of system parameters such as resource utilization, throughput history, cycle time, and work-in-process levels.

After each simulation run, you are prompted to view the model output. You can select yes to view the results immediately, or select no to continue with some other task. Selecting yes opens the Output Viewer 3DR and automatically loads the output of the most recent model run.

The Output Viewer 3DR can be run directly from within ProModel, or as an independent application separate from ProModel. You can load a single results file or several results files from different models for comparison of selected statistics.

Model output is written to several output files according to the type of data being collected. The main output file contains information of a summary nature such as overall location utilization and number of entries at each location. Other files keep track of information such as location contents over time and the duration of each entity at each location.

In order to see the power and flexibility of the ProModel output generator, see “Reports and Graphs” on page 363 for detailed examples of the output generated by the Output Viewer 3DR.
Chapter 4: Modeling Environment

The Modeling Environment is everything contained within the ProModel window.

When you open a model or select New from the File menu, your screen appears with a menu bar across the top of the screen and a layout window. You will also be given access to the ProModel Shortcut Panel. For now, let's look briefly at the Shortcut Panel and then the menus accessible from the menu bar.

From the ProModel shortcut panel seen above, you may quickly access some of ProModel’s commonly used features:

- **Open a model** Opens an existing model.
- **Install model package** Loads an existing model package.
- **Run demo model** Allows you to run a demonstration model.
- **www.promodel.com** Immediately connects you with the ProModel support page on the PROMODEL Web site.
- **SimRunner** Launches SimRunner.
- **Stat::Fit** Launches Stat::Fit.

To simply begin working on a new model, close the Shortcut Panel and select New from the File menu. The Shortcut Panel can be opened again from the View menu.

Menu Bar

All of the tools necessary to build and run a model and view the corresponding output are accessed through the menu bar. The menu bar is located just beneath the ProModel caption bar and contains the selections listed on the following page. These selections access other menus with selections related to the menu heading.

- **File** The File menu allows you to open new models, save current models, and merge two or more models into one. It also allows you to view a text version of the model and print either the model text file or the graphic layout of the model. For more information, see “File Menu” on page 62.
- **Edit** The Edit menu contains selections for editing the contents of edit tables and logic windows. The selections available from this menu will change according to the module from which the Edit menu is selected. They also vary according to the currently selected window. For more information, see “Edit Menu” on page 70.
- **View** The View menu lets you control ProModel’s appearance. From this menu you can control layout settings, hide or view hidden paths, operate the zoom controls, and more. For more information, see “View Menu” on page 76.
- **Build** The Build menu contains all of the modules for creating and editing a model.
Chapter 4: File Menu

This includes the basic modules such as Locations, Entities, Arrivals and Processing, and the optional modeling elements such as Variables, Attributes, Arrays, and Subroutines. For more information, see “Build Menu” on page 89.

- **Simulation**  The Simulation menu controls the execution of a simulation and contains options for running a model, defining model parameters, and defining and running scenarios. For more information, see “Simulation Menu” on page 337.

- **Output**  The Output selection starts the ProModel Output Viewer 3DR for viewing model output. It also allows you to view the trace generated during run-time. For more information, see “Reports and Graphs” on page 363.

- **Tools**  The Tools menu contains various utilities including the Graphics Editor for creating and modifying graphic icons and a search and replace feature for finding or replacing expressions throughout a model. For more information, see “Tools Menu” on page 299.

- **Window**  The Window menu allows you to arrange the windows (or iconized windows) that are currently displayed on the screen such that all windows are visible at once. It also allows you to bring any individual window to the forefront of the display. For more information, see “Window Menu” on page 84.

- **Help**  The Help menu accesses the ProModel Online Help system. For more information, see “Help Menu” on page 85.

## File Menu

The File menu is the first selection on the menu bar and consists of five major sections divided by horizontal lines. The file management section contains functions related to model files such as saving and retrieving. The view/print section allows the user to view a text listing of the current model and print that listing or model layout. The model packaging section allows the user to create and install model packages consisting of models with associated files. Exit quits ProModel, and the model history section lists the five most recently opened models for quick retrieval. Choosing any model in the model history will open and retrieve that model.

### File Management

The File menu provides five functions related to model files such as saving and retrieving. Files in the ProModel format use the MOD extension. The following table defines each of the selections...
available from the file management section shown previously.

New  Closes any currently opened model so a new model can be built. This command is unnecessary if no other model is open. If the currently opened model has changed, ProModel will ask if you want to save the model before closing it.

Open  Opens a user-specified model and clears previous model data.

Merge  Merges a selected ProModel model or submodel into the current model. The same submodel can be merged multiple times into the same model. See “Merge Model” on page 64.

Save  Saves an open model under the current file name. If no file name has been given, the user is prompted for a file name.

Save As  Saves an open model under a new file name specified by the user. The old file name still exists.

Models saved in current versions of ProModel are not always compatible with previous versions of ProModel.

- version 5.0 to run with versions 5.0, 5.1, 5.2 or 5.3.
- version 4.5 to run with version 4.5.
- version 4.0 to run with versions 4.0 or 4.2.

Please note

There is also an Autosave feature that saves the model file every n minutes as specified in the .INI file. This feature can be disabled. See the discussion later in this section.

File Management Procedures

How to create a new model:

1. Select New from the File menu.
2. Define model elements using their corresponding modules.

How to open an existing model:

1. Select Open from the File menu.
2. Enter the necessary information in the Load Model dialog box.

However, models may be saved as previous versions in order to allow those models created in recent versions of ProModel to be shared with others who may be running a previous version of ProModel.

Models created in version 5.4 or higher must be saved as:
How to save a model:

- Select Save from the File menu. If the model does not already have a name, the Save As dialog box will appear.

How to save a model with a new name:

1. Select Save As from the File menu.
2. Enter the new file name in the Save As dialog box as shown in the following dialog box.
3. Select OK.

Backup File

ProModel also creates a backup file every time a model is saved. The backup file is named the same as the model file, only with a .BAK extension.

Model Merging

Model merging is a powerful feature that allows large or complex models to be built in smaller segments. A model segment may be as small as a single workstation or as large as an entire department. After all segments are ready, they can be merged together to form a single model.

The Merge feature consists of two options: Merge Model and Merge Submodel.

Merge Model

The Merge Model option allows two or more independent (complete or incomplete) models to be merged into a single model. Duplicate elements found in the base model and the merging model are treated differently according to the element type.

1. Entity and attribute names common to both models are considered common elements in the merged model. For example, if both models contain the entity type In-Box, the merged model will contain only the record from the base model in the Entities table for In-Box.
2. Duplicate locations, resources or path networks must first be renamed or deleted from the merging model. Otherwise, an error message occurs and the merge will terminate.
3. If the two models use different graphic libraries, ProModel will give the user the choice to append the merging model's graphic library to the base model's graphic library.
4. All other duplicate model elements cause a prompt to appear with the choice to delete the duplicate element from the merging model or cancel the merge process.

Merge Submodel

The Merge Submodel option allows commonly used submodels to be merged into an existing model in one or more places. Submodels are cre-
ated just like any other model and may be complete or incomplete models.

When specifying a submodel, you are prompted for a “tag” to be attached to each element of the submodel as either a prefix or suffix. For example, you may be developing a model with four workstations. Instead of creating workstations individually, you could create a submodel with only the common elements (e.g., in-box, out-box, telephone, variables, arrays, etc.) and merge the submodel into the main model four times. In the resulting model, you would then fill in the unique portions of each workstation. Entity and attribute names will not be tagged.

In the following example, the tag “A_” is attached as a prefix to every element of the submodel. A location called Queue1 in the submodel becomes A_Queue1 in the main model and so on. Likewise, a variable called Rejects becomes A_Rejects in the merged model.

How to merge a model or submodel into an existing model:

1. Open the initial (base) model.
2. From the File menu select Merge.
3. Select Model or Submodel from the submenu.
4. Specify the name of the model to be merged in the following dialog box.
5. If you select Submodel, specify a prefix or suffix to be attached to each element of the submodel.
6. Click on the layout where you want the model or submodel to appear. A bracket appears on the screen, representing the upper left corner of the merging model’s layout. This bracket moves as you move the mouse, allowing you to correctly position the layout to be merged.
7. Next, you will be asked if you would like to append the graphic library file from the model or submodel to the current graphic library file. Select yes or no depending on your preference.
8. When the model is merged in, the graphical elements remain selected so that you can position the merged model exactly where you want it.

Please note

Tags used as prefixes must begin with a letter, A through Z, or an underscore. For example, the tag “3C_” is invalid and would produce an error message.
adjust the sizes of graphical elements in the merging model to the scale of the original model.

View/Print Model Text

The modular nature of ProModel makes it easy to focus on the individual elements of a model. However, it can still be useful to see an entire model with all of the model elements in view at one time. ProModel provides two ways to accomplish this. The first is through the View Text option and the second is through the Print Text and Print Layout Options.

The second major division of the File menu contains the following options.

Each menu selection is covered in detail in the following pages.

- **View Text** Displays the text of the current model data in a window.
- **Print Text** Prints the text of the current model to either a file or the printer.
- **Print Layout** Prints the model layout to a printer.
- **Printer Setup** Opens a dialog box to allow printers to be selected and controlled.

View Text

The View Text option displays the text of the current model data in a window. This window may be sized or shrunk to an icon for later viewing.

How to view the text of a model:

- Select View Text from the File menu. The model's text is displayed in a window as shown in the following example.

Only the first 30 characters of names will appear in the names column.

Please note

You may leave the View Text window open for reference while editing the model. However, any updates will not appear until you close the window and select View Text again.

Print Text

The Print and Print Layout options allow you to print a model to any printer configured for use with Windows. You may also save a text copy of the file to disk.
How to save a text copy of the current model:

1. Select **Print Text...** from the **File** menu.
2. Select **To Text File** from the submenu.
3. Supply a name for the file in the Print to Text File dialog box. The default file extension is TXT.

How to print the current text to a printer:

1. Select **Print Text...** from the **File** menu.
2. Select **To Printer** from the submenu.
3. Select the desired options from the Print dialog box and click **OK**.

Please note

The entire layout may also be copied to the clipboard for editing and printing in another application.

Print Layout

You may print the layout of any model including all locations, path networks, resources, variables and background graphics to any printer configured for use with Windows. Regardless of the size of the model layout, the layout will be proportioned automatically to print on one standard size sheet of paper.

How to print a model layout:

1. Select **Print Layout** from the **File** menu.
2. Select the desired options from the Print dialog box and click **OK**.
3. Choose the elements to be included in the layout.
Chapter 4:
File Menu

Printer Setup
ProModel allows you to print to any printer configured for use with Windows. At times you may need to switch from the default printer to another printer or plotter. This can be done easily through the Setup option on the print dialog box.

How to change the printer settings:

1. Select Printer Setup... from the File menu to access the Print Setup dialog box.
2. Select the desired options and click OK.

Model Packaging/Data Protection
Model packaging and Data Protection are powerful tools that allow you to distribute copies of your model for others to examine and review, yet maintain the integrity of the model. When you create a model package, ProModel builds an archive of files necessary to run the model and allows you to distribute a copy of the model’s graphics library. When you apply Data Protection, you can prevent others from viewing or altering logic contained in your model.

Create Model Package
Copies the current model and its associated files to a specific directory or disk as <model name>.pkg.

Install Model Package
Copies the files in a *.pkg file to the destination directory you wish to use.

Creating a Model Package
The Create Model Package option allows you to copy the current model and its associated files to a specific directory as a single file entitled <model name>.PKG. This file includes the model file (*.MOD), the graphic library (unless you check the Exclude Graphic Library option), and any external files you defined (e.g., read files, arrivals files, and shift files)—the model package automatically includes bitmaps imported into the background graphics.

When you create a model package, two options are available:

- **Exclude Graphic Library** Excludes the graphics library file from the model package—if not required—and creates a smaller package file.
- **Protect Model Data** Prevents those who install the model package from viewing or editing the model data. When you load a model package, ProModel disables the View Text, Print Text, and Expression Search features, plus the Build menu and portions of the run-time Options and Information menus.
Please note

You may NOT use dynamic plots with protected models.

How to create a model package:

1. Select Create Model Package from the File menu.

2. Enter the name you wish to use for the model package (by default, ProModel uses the name of the current model with a *.pkg extension). You may also use the Browse... button to select the model name and directory.

3. Check the Exclude Graphics Library box if you want to package the model without the graphics library.

4. Check the Protect Model Data box if you want to protect your model data and prevent other users from changing or viewing the model data.

5. Click OK.

Installing a Model Package

Install Model Package copies all files in a model package to a specified destination directory and gives you the option to load the model.

How to install a model package:

1. Select Install Model Package... from the File Menu.

2. Select the model package (*.pkg) from the Install Model Package dialog.

3. In the Destination field, type the name of the directory to which you want to copy the model package.

4. Select OK. After you install the model package, a dialog will appear and allow you to load the model.
Edit Menu

The Edit menu is the second selection on the menu bar. It changes forms depending on which window is currently active when choosing Edit.

- If the active window is an edit table such as the Locations edit table, the Edit menu contains options for inserting, deleting and moving records.
- If the active window is the Processing edit table, the Edit menu contains two additional options for copying and pasting completed process and routing records.
- If the active window is a Notes window, the Edit menu contains selections for cutting, copying, and pasting text within the current window or transferring it to another window.
- If the active window is a logic window, such as the one for the operation column of the processing module, the Edit menu contains an additional selection, Compile, which checks the syntax of the logic in the logic window. This option is additional to the cut and paste functions normally available in a notes window.
- Finally, if the active window is either the Graphic or Background Editor, the Edit menu contains three sections. The first section has choices for cutting, copying, and pasting graphic objects to and from Pro-Model's internal clipboard. The second has options to cut and paste items to and from the Windows Clipboard. The third has options to import and export graphics from other applications.

Please note

The Edit menu is accessible only while working inside a module such as a processing edit table or a Notes edit window. If no module is currently open, the Edit selection is not available. Because multiple edit tables and windows may appear on the screen at the same time, the Edit menu commands pertain only to the currently active window. (To activate a window, click anywhere inside it.)

Editing Tables

When creating or modifying records in an edit table such as a Locations or Entities table, the Edit menu appears as follows.

The following table briefly lists the function of each selection of the Table Edit menu.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deletes a record from the table.</td>
</tr>
<tr>
<td>Insert</td>
<td>Inserts a record in the table above the current record.</td>
</tr>
<tr>
<td>Append</td>
<td>Appends a record to the end of the table.</td>
</tr>
<tr>
<td>Move</td>
<td>Moves the previously marked record in the table above the current record.</td>
</tr>
</tbody>
</table>

How to delete a record from a table:

1. Select the desired record by clicking in any field of the record.
2. Select **Delete** from the Table **Edit** menu.
How to insert a record in a table:

1. Position the cursor in the record below where you wish the new record to be inserted.
2. Select Insert from the Table Edit menu.

How to append a record to the end of a table:

1. Position the cursor in any record of the table.
2. Select Append from the Table Edit menu. A new record will appear below the last record of the table.

How to move a record to a new position in a table:

1. Select the record to be moved by placing the cursor in any field of the desired record.
2. Select Move from the Table Edit menu.
3. Position the cursor in the record that is below the final destination of the selected record and select Move to from the Table Edit menu.

Editing Process Records

When editing the records in the Processing edit table, two additional options for copying and pasting entire process and routing records appear in the Edit menu.

The Processing Edit menu's first five selections are identical to the Table Edit menu. The two additional menu items are as follows:

Copy Record  Copies all fields of the current record for subsequent pasting.
Paste Record  Places a copy of the most recently copied record above the current record.

Please note

Notes on editing process records:

1. A process record consists of all fields in the Process edit table, as well as all corresponding routing records defined in the Routing edit table for the given process.
2. From a Routing edit table, you may only use the Copy Record and Paste Record options to copy routing information to another routing record.
3. These options cannot be used to copy processing or routing records from one model to another.

How to copy information from another record:

1. Select the information to copy from field of the desired record.
2. From the **Edit** menu, select **Copy Record** (or press CTRL + C) to copy the information.

3. In the field you want to place the information, select **Paste Record** from the **Edit** menu (or press CTRL + V).

**Please note**

*Alternately, you may copy information between records using the right-click menu.*

---

**Editing Notes Windows**

You may annotate individual records of the locations, resources, and entities tables through Notes windows. When editing the text of a notes window, the Edit menu changes to the following form.

**How to annotate a record:**

1. Click inside the record to be annotated.
2. Click on the Notes button at the right of the table.

The selections available from the Notes Edit menu are defined as follows.

**Cut**  Removes the selected text and places it in the clipboard.

**Copy**  Copies the current text and places it in the clipboard.

**Paste**  Inserts the contents of the clipboard at the cursor.

**Clear**  Deletes the selected text *without* placing a copy in the clipboard.

In addition to the options in the edit menu, the notes window itself contains four buttons. There are three edit buttons, Cut, Copy, and Paste which work exactly the same as the corresponding options in the Edit menu, and a Print button. The print button prints the text in the notes window. A status bar appearing at the bottom of the Notes edit window shows the current line position of the cursor (e.g., Line: 2).

**Editing Logic Windows**

All multi-line logic windows, such as the operation logic window of the Process edit table, include the editing function buttons shown in the following example. These buttons include cut, copy, paste, undo, local find and replace, build, compile, print, and help. Using the Cut, Copy, or Paste button works exactly the same as using the corresponding option from the Edit menu.
Build  The Logic Builder, which may also be accessed by clicking the right mouse in the logic window button, is a tool that allows you to build logic without typing a single keystroke. Primarily for building logic in the logic windows, it may also be used for building expressions in expression fields.

Compile  The Compile menu item checks the logic in the edit window to see if it is complete and syntactically correct. If an error is found, an information box with details regarding the error(s) appears. For example, the following error is a result of the incorrectly spelled statement “Acum 2.”

Print  Prints text, such as the operation logic for a single location, in a logic window and is helpful when you are trying to debug a model and need to work with particularly complex logic at certain locations.

Help  Provides context-sensitive help. ProModel will provide help with select words or any word with the cursor next to it.

Please note

A status bar is displayed at the bottom of a Logic edit window, and shows the current line position of the cursor (e.g., Line: 2).

Editing Background Graphics

When working with graphic objects in the Background Graphics module, the Edit menu appears as follows.

Cut  Removes the selected object(s) and makes a temporary copy that may be pasted back into the layout window.

Copy  Makes a temporary copy of the selected object(s) for pasting later.

Paste  Adds the most recently cut or copied object(s) to the layout window.

Please note

While in the Background Graphics module, CUT, COPY, and PASTE all use ProModel's internal clipboard. Any objects copied to this clipboard cannot be pasted into other Windows applications. To copy objects to other applications, use COPY TO CLIPBOARD.
Delete  Deletes the selected objects from the layout window.

Select All  Selects all of the objects in the layout window.

Copy to Clipboard  Copies the entire contents of the workspace to the Windows clipboard. Objects cannot be copied individually to the clipboard. ProModel copies the workspace as a bitmap or windows metafile for easy transfer to other graphics packages that use the Windows clipboard.

Paste WMF  Pastes a Windows metafile (WMF) from the Windows clipboard into the Edit window. You must have previously copied a Windows metafile to the Windows clipboard.

Paste BMP  Pastes a bitmap file (BMP) from the Windows clipboard into the Edit window. You must have previously copied a bitmap to the Windows clipboard.

Import Graphic  Imports a WMF, BMP, PCX or GIF file into the layout window.

Export Graphic  Exports the graphic in the layout window to a WMF or BMP file.

How to edit background graphics:

1. Right click on the background graphic you wish to edit.

2. Select Edit Background Graphic from the right-click menu.

3. Edit the graphic as desired.

Editing & Moving Graphics

ProModel allows easy adjustment and fine tuning of the graphics in one window rather than opening individual modules to move each object. This makes it possible to move or rearrange a whole submodel or model after it has been merged. To move any or all graphics in a model, ProModel must be in common mode (all modules must be closed, leaving only the layout window open).

While in common mode, graphics that can be moved and arranged in the layout window include locations, path networks, static and dynamic resources, variables, and background graphics. Multiple graphics can be selected and moved simultaneously. When graphics are selected, the layout can be scrolled and the graphics will remain selected.

How to move graphics:

1. Close all build modules leaving only the layout window open.
2. Left click and drag the selected graphic to the desired position.

3. To move multiple graphics, hold down the Shift key while left clicking the desired graphics to select them and then drag them to the desired position. Using the shift key with a left click deselects a selected graphic.

4. Fine tune the position of the selected graphic(s) by using the arrow keys on the keyboard to move one pixel at a time.

When a submodel or model is merged into another model, all graphics associated with it are selected. This allows for immediate movement by left clicking on the graphics and dragging them to the desired position in the Layout window. You may also scroll the layout first and then move the selected graphics.

Please note

*Multiple graphics can also be selected by dragging a bounding box around the graphics. Holding the left mouse button down, drag the mouse from one corner of the graphics to the opposite corner. The bounding box must completely enclose the graphics you wish to select.*

Special Considerations for Moving Graphics

**Locations** When you click on a location with multiple graphics defined for it (i.e., counter, status light, label) in common mode, it is selected as one graphic. Multiple units of a location can be moved individually. Adjusting the position of an individual graphic in a multiple graphic location must be done in the locations module.

**Routing Paths** Routing paths defined in the Processing module cannot be selected for movement but will move when a location to which they are connected is moved. If a routing path has multiple segments, only the segment connected to the location being moved gets readjusted. However, when both locations on the routing path are moved simultaneously, the whole routing path is moved.

In the examples above, the machine on the right is moved. The routing paths remain connected to each graphic while the path segment connected to the moved graphic is adjusted accordingly.

**Path Networks** Path networks are not resized when moved. Any resource points defined for a dynamic resource are moved when the path network is moved. The resource points remain relative to the node for which they were defined.
Resources  When a dynamic resource is moved, the resource point associated with it moves but not the entire path network.

Sizing  Graphics cannot be sized in common mode.

Snap-to-Grid  Graphics will not snap to the grid in common mode, but their position can be fine-tuned using the arrow keys on the keyboard to move the selected graphic(s) one pixel at a time.

Labels  To view the label or edit a location, path network, resource, or variable graphic, right click on the item. If you double left click on an item, ProModel opens the build module and highlights the record where you defined the element.

View Menu

The View menu provides options for modifying the model editing environment. These options are defaults, used each time the program is started and are not specific to any particular model. The View menu consists of three categories: Switches, Settings, and Commands. Each of these categories is explained in the following sections.

<table>
<thead>
<tr>
<th>View</th>
<th>Build</th>
<th>Simulation</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shortcut Panel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snap to Grid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Grid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Layout Coordinates</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Hidden Networks</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Routing Paths</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toolbars</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Views</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom to Fit Layout</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layout Settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Tables</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh Layout</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Window Positions</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

How to access the View menu:

- Select View from the menu bar.

Switches

The following selections are available from the switches section of the View menu. Switches are
options you can check or uncheck to turn on or off.

Snap to Grid  Check this switch to cause any object subsequently drawn or placed on the layout to be positioned on the nearest grid line. Snap to grid snaps the upper left corner of a graphic.

Show Grid  Check this switch to show the grid in the layout window.

Show Layout Coordinates  Displays cursor’s the coordinates in the upper-left-hand side of the layout window.

Show Hidden Networks  Check this switch to show the invisible path networks during editing. A path network can be made to be invisible by selecting the “invisible” option for the particular network while in the Path Networks editor.

Show Routing Paths  Causes routing paths to be visible during run time as well as edit time. If the option is not checked, the routing paths are visible only while in the processing editor.

Toolbars

Allows you to toggle the various ProModel toolbars on and off. See “Toolbars” on page 85 for more information on each toolbar.

Settings

The following table defines each of the selections available from the settings section of the View menu. These selections and their submenus are discussed in more detail on the following pages.

<table>
<thead>
<tr>
<th>Settings Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap to Grid</td>
</tr>
<tr>
<td>Show Grid</td>
</tr>
<tr>
<td>Show Layout Coordinates</td>
</tr>
<tr>
<td>Show Hidden Networks</td>
</tr>
<tr>
<td>Show Routing Paths</td>
</tr>
</tbody>
</table>

Views  Allows you to define, then quickly and easily access specific areas of the model layout. Once the view is defined, you can select it while editing or running the simulation.

Zoom to Fit Layout  Shrinks or enlarges the layout to include the entire model.

Zoom  Allows you to shrink or enlarge the layout by the percentage selected.

Views

The Views feature allows you to define, then quickly and easily access specific areas of the model layout. Selecting a view scrolls the layout window and adjusts the zoom so you see a specific region of the layout regardless of the layout window’s size. Once a view is defined, you can select it while editing or running the simulation by selecting the view from the View menu or by using the keyboard shortcut.

Defining & Selecting Views

How to define a view:

1.  At edit time, select the View menu.
2. Select the Views item. If no defined views exist, the Views dialog is displayed and not the submenu shown here. If the Views dialog appears, skip step 3.

3. Click Define from the extended menu and the Views dialog appears.

4. With the Views dialog open, select the area in the layout window you want to define as a view using the scroll bars and zoom feature in the View menu. Or size the layout window to the desired view.

5. With the layout window set, type a name for your view in the View Name field at the bottom of the Views dialog, and then click the Add button to define the view you have selected in the current layout window.

6. The name you have entered will appear in your list of views.

### Please note

*Views cannot be defined at run time.*

---

**How to select a view from the menu:**

1. At edit time or run time, select the View menu.

2. Select the Views menu item to display the submenu list.

3. Click on the desired view from the submenu.

**How to select a view with shortcut key CTRL + n:**

- Press CTRL + n to select the desired view where n is the number (1-9) of its position in the view list (e.g., pressing CTRL + 1 would access Single Screen Zoom from the view list above and CTRL + 3 would access the Waiting Time Zoom view). Views beyond nine will not have a CTRL + n shortcut key.

---

**Managing Your Views**

When you click on Define from the Views menu, the Views dialog is displayed. It lists the defined views in the Views List and provides buttons for adding views, removing views, and managing the list. The function of each button is described next.

**Add** Adds the view, which you have named in the View Name field, to the list of views.

**Remove** Deletes the currently highlighted view from the View List.

**Move Up** Moves the currently highlighted view up one position in the list creating a corresponding change to the menu and CTRL+ n order.
**Move Down**  Moves the currently highlighted view down one position in the list creating a corresponding change to the menu and CTRL+ n order.

**Rename**  Renames the currently selected view to the name you have typed into the View Name field.

**Set View**  Sets the highlighted name in the View list to the portion of the model currently visible in the Layout window.

**View Name**  This is the field where you type the name of the view you wish to add.

**Show View**  Checking this box will cause your views to be displayed in the Layout window as you select them in the list.

### Using Views at Run-time

When the simulation is running, you may choose the active view by picking its name from the Views menu or the Views Panel.

The Views menu is accessible during run-time from either the Menu Bar’s Option menu or the Right-Click menu.

The Views menu will display a list of your defined views. There is also an option to open the Views Panel.

The Views Panel is a dialog window with a list of your defined views.

The Views Panel may be moved or resized, and will remain on top of the simulation window until the Panel is closed.

Simply click on the name of a view in the Panel to switch to that view.

### Referencing a View in Model Logic

Once a view has been defined, it may be referenced in the model using the VIEW statement (e.g., VIEW “Service Office”). This is useful for illustrating certain parts of the model at specific times during run-time. For syntax and examples, see “View” on page 566.

### Zoom Feature

The Zoom feature allows you to shrink or enlarge the layout by the percentage selected.

**How to zoom in or out on the layout:**

1. Select **Zoom** from the **View** menu.
2. Choose any preset zoom level, or the **Custom Zoom** option.
Please note

The minimum and maximum zoom levels are calculated automatically depending on the total size of the layout at 100% zoom.

Layout Settings

The following selections are available from the Settings section of the View menu.

The Layout Settings submenu contains selections for changing the grid characteristics, color of the layout window background, and the routing arrow colors. These, as well as default setting changes, apply to any currently loaded model. To change any of these items for the current model only, use the options provided in the General Information dialog. The routing path color can be changed for the current model only by selecting the Path Options button in the Processing module.

The following table defines each of the selections available from the Layout Settings submenu.

<table>
<thead>
<tr>
<th>Grid Settings</th>
<th>Provides options to control the amount of space between grid lines. It also provides the option to define the grid units in terms of distance and time per grid unit.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Color</td>
<td>Allows the user to change the background color in the layout window.</td>
</tr>
<tr>
<td>Routing Path Color</td>
<td>Provides the option to change the routing color used in processing logic.</td>
</tr>
</tbody>
</table>
How to change the colors and resolution of the grid lines:

1. Select **Layout Settings** from the **View** menu.
2. Select **Grid Settings** from the **Layout Settings** submenu.
3. Select the **Ones** or **Tens** option button.
4. Select the desired color.
5. Use the scroll bar to adjust the resolution.

Please note

*To change the color of the grid lines, select the **Ones** button and choose a color. To change the color of every tenth grid line, select the **Tens** button and choose a color.*

Grid Scale

In addition to setting the resolution of the grid lines, you may also associate a time and distance value to each grid unit. This is extremely useful when you are creating conveyors, queues, or path networks to scale and you want the time or distance between nodes to be based on the number of grid units between the nodes.

How to set the default time and distance per grid unit:

1. Select **Layout Settings** from the **View** menu.
2. Select **Grid Settings** from the **Layout Settings** submenu.
3. Select the **Scale** button from the Grid Dialog.
4. Enter the desired time and distance per grid unit.

Please note

*The “Recalculate path lengths when adjusted” option applies to path networks, conveyors, and queues. For details regarding recalculation of times and distances when editing path segments, see “Path Networks” on page 117.*

Background Color

The Background Color option allows the user to change the background color in the layout window.

How to set the background color of the layout:

1. Select **Layout Settings** from the **View** menu.
2. Select **Background Color** from the **Layout Settings** submenu.
3. Select the desired color.
4. Click **OK**.

5. Select **Add to Custom Colors**. The color now appears in one of the 16 custom color boxes.

---

**Routing Path Color**

ProModel allows you to select which colors to use when showing selected, unselected and related routings in the Processing module. This helps in visually identifying the origin and destination of a process routing.

**How to specify the routing colors:**

1. Select **Routing Path Color** from the **View** menu.

2. Click on the desired routing type, **Unselected**, **Selected**, or **Related** from the menu.

3. Select the desired color.

4. Click **OK**.

---

**Routing Path Types**

**Unselected**  All routing lines *not* for currently highlighted process record.
Selected Routing line for currently highlighted routing record.

Related Routing lines for highlighted process record, except highlighted routing record.

Edit Tables

Edit Table Fonts

Edit tables are used extensively in ProModel for data entry. ProModel allows you to specify the font used in these tables.

How to change the edit table font:

1. Select Edit Tables from the View menu.
2. Select Font from the Edit Tables submenu.
3. Choose the desired font by scrolling through the Font selection list box.
4. Choose the Font Style.
5. Choose the Font Size.
6. Click OK.

Edit Table Color

ProModel allows you to specify the table color used in edit tables.

How to change the edit table background color:

1. Select Edit Tables from the View menu.
2. Select Color from the Edit Tables submenu.
3. Choose the desired color.
4. Click OK.

Please note

For information on creating custom colors, see “Background Color” on page 81.

Commands

The Commands section of the View menu contains various selections for controlling the modeling environment.

Refresh Layout Clears and redraws the graphics in the layout window.
Window Menu

The Window menu allows you to rearrange windows and icons and select the active window. These functions are standard to all Windows applications.

<table>
<thead>
<tr>
<th>Window Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile</td>
</tr>
<tr>
<td>Cascade</td>
</tr>
<tr>
<td>Arrange Icons</td>
</tr>
<tr>
<td>1 Layout</td>
</tr>
<tr>
<td>2 The ProModel Shortcut Panel</td>
</tr>
</tbody>
</table>

**Tile**  Causes all open windows to fit in the available screen space. Windows that may be hidden behind other windows become visible.

**Cascade**  Causes all open windows to overlap such that the title bar of each window is visible.

**Arrange Icons**  Causes all icons representing iconized applications to be arranged neatly along the bottom of the screen.

**Please note**

Below [Arrange Icons] is a list of the open windows. The window with the check next to it is the active window.

**How to reset the windows to their default positions:**

- Choose **Reset Window Positions** from the **View** menu.
Help Menu

The ProModel Help menu is a convenient, quick way to look up information about a task you are performing, a feature you would like to know more about, or a command you want to use. ProModel Help is available whenever you see a Help command button, or Help as an item on a menu bar.

The selections from the Help Menu are as follows:

**Index**  Brings up the Main Help Index.

**Context**  Opens the help system to the topic related to the currently active window.

**ProModel Support on the Web**  When you select this option from the help menu, ProModel automatically connects you with the ProModel customer service page on the PROMODEL website.

**About ProModel**  Displays a message containing information about the product.

Toolbars

The ProModel toolbars provides quick access to many of the options found in the menu bar.

The toolbar space may contain up to nine toolbars, which can be toggled on or off in the View menu. These toolbars are described below.

**File**

**New**  Closes any currently opened model so a new model can be built. This command is unnecessary if no other model is open. If the currently opened model has changed, ProModel will ask if you want to save the model before closing it.

**Open**  Opens a user-specified model and clears previous model data.

**Save**  Saves an open model under the current file name. If no file name has been given, you will be prompted for a file name.

**Create Package**  Bundles all files used for a model into one package. See “Creating a Model Package” on page 68 for more information.

**Install Package**  Copies all files in a model package to a specified destination directory and gives you the option to load the model. See “Installing a Model Package” on page 69 for more information.

**Layout**

**Show Grid**  Check this switch to show the grid in the layout window.

**Show Hidden Networks**  Check this switch to show the invisible path networks during editing. A path network can be made to be invisible by
selecting the “invisible” option for the particular network while in the Path Networks editor.

**Show Routing Paths**  Causes routing paths to be visible during run time as well as edit time. If the option is not checked, the routing paths are visible only while in the processing editor.

**View**

**Views**  Allows you to define, then quickly and easily access specific areas of the model layout. Once the view is defined, you can select it while editing or running the simulation. See “Views” on page 77 for more information.

**Zoom to Fit**  Shrinks or enlarges the layout to include the entire model.

**Zoom**  Allows you to shrink or enlarge the layout by the percentage selected.

**Build Basic**

The options in this toolbar open the respective build modules. Mouse over a toolbar button to see its function and then refer to Chapter 5 for information of that build module.

**Build Advanced**

The options in this toolbar open the respective build modules. Mouse over a toolbar button to see its function and then refer to Chapter 6 for information of that build module.

**Simulation**

**Simulation Options**  Opens the simulation options dialog. See “Simulation Options” on page 338 for more information.

**Scenarios**  Opens the scenarios dialog. See “Scenarios” on page 343 for more information.

**Play**  Begins the simulation

**Pause**  Pauses and unpauses the simulation when it is running.

**Stop**  Ends the simulation and prompts you whether to collect and view statistics up to the point where the simulation was stopped.

**Animation On/Off**  Toggles the animation on and off

**View Statistics**  Opens Output Viewer 3DR.

**Simulation Information**

**Location Information**  Select this option and choose a location to view an information box with real time information about the location. Information for all locations may also be displayed.

**Variable Information**  Select this option to show the current state of all real and integer global variables.

**Array Information**  Select this option to show the current value of all cells for arrays of up to three dimensions.

**Define Dynamic Plots**  Allows you to define Dynamic Plots. See “Dynamic Plots” on page 354 for more information.
View Dynamic Plots Allows you to view previously defined Dynamic Plots. See “Dynamic Plots” on page 354 for more information.

Debug

User Pause by Time Allows you to specify by clock time when the simulation should pause next.

User Pause by Date Allows you to specify by calendar date when the simulation should pause next. This option is not available when you are not running the simulation by calendar date.

Trace Step Select this option to step through the trace listing one event at a time. Each time you click the left mouse button, the trace will advance one event. Clicking and holding the right mouse button while in this mode generates a continuous trace.

Filtered Trace Opens the Filtered Trace dialog. See “Trace Mode” on page 351 for more information.

Debug Opens the Debug dialog. See “Debug Option” on page 347 for more information.

Tools

Graphic Editor Opens the Graphic Editor. See “Graphic Editor” on page 304 for more information.

Simrunner Opens Simrunner.

Stat::Fit Opens Stat::Fit.

3D Animator Opens 3D Animator.

Right-Click Menu

To simplify many of the steps required to perform common modeling operations, ProModel includes a variety of right-click menus. From these menus, you can access context-sensitive options and settings for variables, locations, processing, path networks, resources, and other components. The following menu appears when you right-click on the layout.

The right-click layout menu includes the following options:

Edit Background Graphic Only when you have a background graphic defined, this option appears and lets you edit the graphic.

Snap to Grid Selecting this option snaps all graphics to the grid.

Show Grid When you select this option, ProModel displays the background grid.

Show Layout Coordinates Displays cursor’s the coordinates in the upper-left-hand side of the layout window.

Show Hidden Networks Displays all hidden networks.

Show Routing Paths Displays all routing paths used in the model.
Views  From this option, you may select from the views defined in the model.

Zoom to Fit Layout  This option resizes the model to fit the entire image in the layout window.

Zoom  Allows you to select the zoom percentage.

Layout Settings  From here, you may select and define the grid settings, background color, and routing color.

Refresh Layout  This option refreshes the image to reflect recent changes.

Please note

For information about the right-click menus for model elements (e.g., locations, variables, routings, resources, path networks, queues, and conveyors), see “Building the Model: Advanced Elements” on page 217.
Chapter 5: Building the Model: General Elements

Build Menu

The Build Menu is the gateway to all modeling elements used to define a model. Through this menu you specify the locations, entity types, arrival rates, resources, path networks, downtimes, processing logic, variables, attributes, arrays, macros, and subroutines that provide the flexibility needed to model your system.

How to access the Build menu:

• Select Build from the menu options bar.

Each selection from the Build Menu is covered in detail in the following sections of this chapter.

Any element represented by a graphic in the layout window can be edited by holding the CTRL key while clicking on the graphic representing that element.
**Locations**

Locations represent places in the system where entities are routed for processing, storage, or some other activity or decision making. Locations should be used to model elements such as delivery locations, warehouse locations, network servers, and transaction processing centers.

Every location has a name and a name-index number. The name-index number is the location’s numerical position in the list of locations. Logic which refers to a location, such as routing logic, can use either the location's name, or the LOC() function to refer to the location. The LOC() function allows a location whose index number has been stored in an attribute or variable to be referenced. See “Loc()” on page 501.

Locations are defined in the Locations Editor, which is accessed through the Build menu.

The Locations Editor consists of three windows: the Location Graphics window in the lower left portion of the screen, the Location edit table along the top of the screen, and the Layout window in the lower-right portion of the screen. These windows can be moved and resized using the mouse.

The Location edit table contains information about every location in the model, including characteristics such as capacity and number of units. The Location Graphics window is a toolbox used for creating, editing, and deleting locations graphically. Locations are positioned in the Layout window.

**How to create and edit locations**

- Select Locations from the Build menu. The Locations Editor appears.

- Right click on the existing location and select Edit.
Location Edit Table

A location's characteristics can be modified with the Location edit table. The Location edit table contains fields for displaying the graphic icon, specifying the location name, and defining other characteristics of each location. Each of these fields is explained below. You can edit the desired field directly in some cases, or by selecting a record and clicking the column heading button of the desired field.

**Icon**  The graphic icon used to represent the location. Changing location graphics is done using the tools in the Location Graphics window. If multiple graphics have been used to define a location, the first graphic used is shown here. Clicking on the Icon button brings the graphic for the current location into view if it is not currently showing in the layout window.

**Name**  The name of each location. Names can be up to 80 characters in length and must begin with a letter (for more information on naming items, see “Names” on page 394). A location's name can be changed by editing this field. The Search and Replace is automatically called when the name is changed.

**Cap.**  The capacity of the location refers to the number of entities the location can hold or process at any one time. A location's maximum capacity is 999999. Entering INF or INFINITE will set the capacity to the maximum allowable value. If this field contains an expression, it will be evaluated at the start of the simulation before any initialization logic. Accordingly, a location's capacity will not vary during the simulation run.

Please note

**Individual units of a multi-unit location may differ in capacity only if every unit's capacity is greater than 1. For example, in a location with two units, one may have a capacity of 5 and the other a capacity of 10. However, one unit may not have a capacity of one and the other a capacity of five. (See “Multi-Capacity, Multi-Unit, and Multiple Locations” on page 100.)**

**Units**  The number of units of a location, up to 999. A multi-unit location works like several locations with common characteristics. (See “Multi-Capacity, Multi-Unit, and Multiple Locations” on page 100.)

**DTs**  Click on this heading button to define location downtimes, including any setup times. (See “Location Downtimes” on page 101.)

**Stats**  Click on this heading button to specify the level of statistical detail to be gathered for the location. (To view a location's statistics after a simulation run, choose View statistics from the Output menu.) Three levels of data collection are available:

- **None**  No statistics will be collected.
- **Basic**  Only utilization and average time in location will be collected.
- **Time Series**  Collects basic statistics and time series tracking the contents of the location over time.

**Rules**  This field defines (1) how a location selects the next incoming entity from several that are waiting to enter this location, (2) how multiple entities at a location queue for output, and (3) which unit of a multi-unit location is selected by an incoming entity. (See “Rules Dialog Box” on page 109.) To edit any of this information at a
location, click on the heading button to open the Location Rules dialog box.

Notes Enter any optional notes about a location in this field or click on the heading button to open a larger Notes window.

Location Graphics Window

The Location Graphics window provides a graphical means for creating locations and changing their icons.

Icons added to the layout will either represent a new location or be added to an existing location's icon depending on whether the New box at the top left of the window is checked or unchecked.

New Mode

Allows you to create a new location record each time you place any location graphic on the layout. The new location is given a default name which may be changed if desired. New mode is selected by checking the New box [X] at the top of the Graphic Tools window.

Edit Button Displays the Library Graphic Dialog Box used to change the color, dimensions, and orientation of the location graphic.

Erase Button Erases the selected location graphic in the Layout window without deleting the corresponding record in the Location edit table.

View Button Brings the selected location in the edit table into view on the Layout window.

How to define a new location graphically:

1. Check the New Box in the Location Graphics window.
2. Select a location symbol or icon from the Location Graphics window.
3. Click on the Layout window where you want the location to appear.
4. A new record is added automatically to the Location edit table. You may now change the default name to the desired location name.

How to define multiple locations, each having the same graphic:

1. Check the New box inside the Location Graphic window.
2. Select the desired graphic.
3. While holding down the SHIFT key, click on the Layout window where each location should appear.
How to move a location graphic on the layout:

• Drag the graphic to the desired spot on the layout.

How to move all graphics defined for a single location:

• Drag inside the dashed box surrounding the graphic (do not drag on an individual graphic inside the box).

How to move multiple graphics for two or more locations at once:

1. Click outside of any graphic and drag to create a rectangle encompassing all of the graphics to be moved.
2. Drag the rectangle to the desired position on the layout.

How to delete a location:

1. Select the location record to be deleted in the Location edit table.
2. Select Delete from the Edit menu.
or...
1. Right-click on the location graphic in the layout window.
2. Select Delete Graphic. The location graphic disappears, but the location record still exists in the Location edit table.

How to erase a location graphic:

1. Select the location graphic to erase.
2. Select the Erase button in the Location Graphics window or press the <Delete> key. The location graphic disappears, but the location record still exists in the Location edit table.
or...
1. Right-click on the location graphic in the layout window.

How to bring a location graphic into view that is off the layout:

1. Highlight the record of the desired location in the Location edit table.
2. Select the View button in the Location Graphics window or click on the icon heading button.
Add Mode

Allows you to add additional graphics to an existing location, such as a text label, an entity spot, or a status light. A location with multiple graphics will be enclosed by a dashed box. Add mode is selected by unchecking the New box at the top of the Graphic Tools window.

How to add an icon or symbol to an existing location:

1. Uncheck the New Box in the Location Graphics window.
2. Select a location symbol or icon from the Location Graphics window.
3. Click on the Layout window where you want the additional icon to appear.
4. The graphic or symbol is added to the location.

Location Graphics

A location may have any one or more of the following graphics selected from the Location Graphics window.

Counter A counter representing the current number of entities at a location. The options available with counters are explained next.

Gauge A vertical or horizontal sliding bar showing the location’s current contents during the simulation (shown as a percentage of the capacity). This graph will be updated constantly as a simulation runs. The options available with gauges are explained below.

Tank A vertical or horizontal sliding bar showing the continuous flow of liquids and other substances into and out of tanks or similar vessels. This continuous modeling capability can be combined with discrete-event simulation to model the exchange between continuous material and discrete entities such as when a liquid is placed in containers.

Conveyor/Queue A symbol representing a conveyor or a queue. To create joints in a conveyor or queue, click on the conveyor or queue with the right mouse button. Drag the joints to achieve the desired shape. Right click on a joint to delete it. The options available with conveyors and queues are described next.

Label Any text used to describe a location. The label is initially synchronized with the name of the location and changes whenever the location name is changed. The name, size, and color of the text may be edited by double clicking on the label or selecting it and clicking on the edit button (see “Text Tool” on page 315). Once the name on a label is edited, it will no longer be automatically changed when the location name is changed.

Status Light A circle that changes color during the simulation to show the location’s status. For a single capacity location, the states displayed are idle/empty, in operation, blocked, down, waiting, and in setup. For multi-capacity locations, the displayed states are up (operational) and down (off-shift, on break, disabled).

Entity Spot An assignable spot on the layout where the entity or entities will appear while at the location. While an entity is at a location, the entity’s alignment spot (defined in the Graphic editor) will appear exactly on top of the location’s entity spot, allowing the two graphics to align exactly as desired. A multi-capacity location will use as many entity spots as defined (in the order defined) up to the capacity of the location. Entities in excess of entity spots will continue to pile up on the last entity spot defined.

Region A boundary used to represent a location’s area. A region may be placed in the layout over an imported background such as an AutoCAD drawing to represent a machine or other location.
This technique allows elements in the imported background to work as locations.

Library graphic  Any of the graphics appearing in the library graphic menu. Use the scroll bar to view all available graphics. Library graphics may be created or modified through the Graphic Editor. The name for the graphic, the default name of any location created with that graphic, can be saved in the Graphic Editor (see “Naming a Graphic” on page 314).

How to edit a graphic already on the layout:

- Double click on the graphic.

    or...

1. Select the graphic.
2. Click on the Edit button inside the Location Graphics window.

    or...

1. Right-click on the graphic in the layout.
2. Select Edit Graphic from the menu.

Please note

Location graphics notes:

1. Location graphics are painted on the layout in the order of the location list and, for any given location having multiple graphics, in the order that the graphic was added to the layout.

2. A location may include any of the above graphics and symbols. However, a location can have no more than one counter, one gauge, one tank, one queue, one status light, or one region.

3. Clicking on a layout graphic with no edit table on the screen displays the name of the element (location, etc.) represented by the graphic. With any edit table showing, hold down the CTRL key while clicking on the graphic to display the location name.

Counter Dialog Box

To edit the appearance of a counter, double click on the counter on the layout, select the counter and click on the Edit button, or right click on the counter and select edit. The counter dialog box allows you to choose the appearance of a graphic counter that is used to display the contents of a location. To change the digit color of the counter, click on the Digit Color button. To change the counter's background and border, click on the Frame button. The digit's font size and style may be changed by clicking on the Font button.

Gauge/Tank Dialog Box

When you create a gauge or tank, ProModel will prompt you to specify which type you wish to use before you paste it in the layout. To edit a gauge or tank on the layout, double click on the gauge
or tank to display the gauge/tank dialog box, select the gauge/tank and click on the Edit button, or right click on the gauge or tank and select edit graphic. From the gauge/tank dialog, you may change a gauge to a tank and define its appearance, orientation, and fill direction. You may also access this dialog by selecting the gauge or tank and clicking on the Edit button.

Text Dialog Box

To edit the appearance of a location label, you may double-click on the text once it is on the layout, select the text and click on the Edit button, or right click on the text and select edit. The text is typed in an edit window with several edit features available via buttons above the window. The font, color, alignment, rotation and frame may be changed from this dialog box. A sample of the currently chosen options is shown in the lower-left corner.

Library Graphic Dialog Box

To change or edit a library graphic that represents a location, you may double click on the library graphic on the layout, select the graphic and click on the Edit button, or right click on the graphic and select edit. This gives the option to change the icon, orientation, color, or graphic dimensions of the graphic. The default dimensions for the graphic, which are...
created in the Graphic Editor, are displayed above the graphic. To change the dimensions of the graphic, click on the Dimensions button. This gives you the ability to specify horizontal or vertical and feet or meters to change the graphic dimensions.

**Queue/Conveyor Dialog Box**

To control the look and operation of a conveyor or a queue, you may double click on the conveyor/queue in the Layout window, select the graphic and click on the Edit button, or right click on the conveyor/queue and choose edit graphic. The Queue/Conveyor dialog box appears. It also allows you to specify whether you wish to define the location as a conveyor or queue. Use the scroll bar to set the width of the queue or conveyor. Select the style by clicking on solid, roller (i.e., roller conveyor) or line. Click on the border color or fill color to change the color of the queue. If you want the queue to be visible during edit time and invisible during run time, click on the Invisible During Simulation option. See the discussion on conveyors and queues later in this section for more information.

**Queues**

A queue is a location that imitates the progressive movement and queuing of waiting lines. When an entity enters a queue, ProModel executes any operation logic for the entity and then moves it to the end of the queue. To have processing logic execute after an entity arrives at the end of a queue, use a MOVE statement in the operation logic. A MOVE statement causes the entity to move to the end of the queue where any additional operation logic defined will be processed. Operation logic following a MOVE statement actually gets processed after the elapsed time that the entity would have reached the very end of the queue if no other entities were ahead of it. Following a MOVE statement, any operation statement is valid except for CREATE, SPLIT AS, UNGROUP, UNLOAD, or another MOVE statement.

If a MOVE statement is specified that includes a move time (e.g., MOVE for 5.2 sec), the entity speed and length of the queue are ignored. If a move time is not included with the MOVE statement, the move time is based on the entity speed and length of the queue (if no queue length or entity speed is defined, the move time is zero).

Entities in a queue may not be preempted by other entities and, once entities begin movement in a queue, are not allowed to pass each other. After the specified move time, however, entities continue processing any additional operation and output logic. A “No Queuing” rule specified for a queue location allows entities to depart in any order after completing their move time.

Queues are drawn from the beginning to the end of the center-line and are assigned a default length based on the graphic scale. However, the default queue length may be overridden by entering a different length. When a queue is modified graphically, the length will automatically be recalculated based on the graphic scale unless
you checked the “Recalculate path lengths when adjusted” option. You can access this option from the Tools menu under Options.

**Conveyors**

A conveyor is a location that simulates the movement of entities on either an accumulating or non-accumulating conveyor and appears with a conveyor graphic. Entities can only enter a conveyor at the beginning and leave at the end. For accumulating conveyors, if the lead entity is unable to exit the conveyor, trailing entities queue up behind it. For non-accumulating conveyors, if the lead entity comes to a stop, the conveyor and all other entities stop. Entities on a conveyor may not be preempted by other entities.

The capacity assigned to a conveyor limits the number of entities that can access a conveyor. However, the cumulative total length or width of the entities on the conveyor cannot exceed the conveyor length. In fact, the utilization statistics for a conveyor reflect the amount of space utilized on the conveyor throughout the simulation, not the number of entities occupying the conveyor. Unlike other locations, an entity is not routed to the conveyor until there is room at the beginning for the entity to fit, even if the conveyor has capacity to hold it.

ProModel executes operation logic for entities entering a conveyor as soon as they enter unless the logic follows a MOVE statement. If no MOVE statement is encountered, entities begin their move on the conveyor after processing any logic. If a MOVE statement is encountered, entity movement is initiated. Any logic defined after a MOVE statement is processed when the entity reaches the very end of the conveyor.

Move time on a conveyor is based on the length and speed of the conveyor, as well as the length or width of the entity. The move time for an entity on a conveyor is calculated using the following formula:

\[
\text{Time} = \frac{\text{Conveyor Length} - \text{Entity Length or Width}}{\text{Conveyor Speed}}
\]

And the percentage utilization is calculated using this formula:

\[
\text{Util} \% = \frac{\sum_{\text{all entities}} \frac{t_c}{C_c}}{T}
\]

Where:
- \(t_c\) = the time the entity spent on the conveyor whether moving or not
- \(C_c\) = the conveyor capacity for that entity
- \(T\) = the total simulation time

**Please note**

Unlike queues, MOVE statements for conveyors may not include a move time. Processing logic executed at the end of the conveyor may contain any operation statement except for CREATE, SPLIT AS, UNGROUP, or UNLOAD. Additionally, the ACCUM, COMBINE, and GROUP statements are not allowed at the end of non-accumulating conveyors.

Due to the space limitations of a conveyor, certain operation statements at the beginning of a conveyor are invalid including ACCUM, COMBINE, CREATE, GROUP, SPLIT AS, UNGROUP, and UNLOAD.

The default conveyor length is determined by the graphic scale, although this may be overridden by entering a different length. When a conveyor is modified graphically, the length will automati-
cally be recalculated based on the graphic scale unless you uncheck the “Recalculate path lengths when adjusted” option. You can access this option from the Tools menu under Options.

**Conveyor Graphics Display**

When you use conveyors and want the graphics to display properly on the conveyor with no overlapping and little space between entities, use the following:

**Conveyor Animation**

The animation of entities traveling along conveyors is displayed according to the logical length or width of the entity, not the scaled length or width of the entity graphic.

**How to define a conveyor graphically:**

1. Select the conveyor/queue symbol from the Location Graphics window.
2. Click on the Layout window with the left mouse button where the conveyor should start.
3. Add bends to the conveyor by moving the mouse and clicking the left mouse button.
4. Move the mouse in the desired direction and click on the right mouse button to end the conveyor.

---

**How to create bends in an existing conveyor:**

1. Click on the conveyor with the right mouse button. From the menu that appears, select *Add Joint*. A small black square appears on the conveyor.
2. Using the left mouse button, drag the square in the direction you desire to bend.

**Conveyor Options Dialog Box**

The conveyor options dialog box is used to define the specifications for a conveyor. To access the conveyor options dialog box, you may double click on a conveyor, select the conveyor and click on the Edit button from the Location Graphics window, or right-click on the conveyor and select edit. This opens the Conveyor/Queue dialog box from which the Conveyor Options dialog box can be opened by clicking on the Conveyor Options button. The Conveyor Options dialog box presents the following options:

**Accumulating** Select or deselect this option depending on whether the conveyor is to be accumulating or non-accumulating.

**Entity Orientation** Select Lengthwise or Widthwise depending on whether the entity is traveling on the conveyor in the direction of the entity length or in the direction of the width.

**Length** The length of the conveyor expressed in either feet or meters depending on the default specified in the General Information dialog.
Speed  The speed of the conveyor in feet or meters per minute. The distance units can be set in the General Information dialog box.

Capacities and Units

Capacities

A location capacity is the maximum number of entities it can hold at any one time. In general, multi-capacity locations are used to model locations such as queues, waiting areas, or any other type of location where multiple entities may be held or processed concurrently. Consider the following multi-capacity location:

<table>
<thead>
<tr>
<th>Locations</th>
<th>Name</th>
<th>Cap. Units</th>
<th>DTS...</th>
<th>Status...</th>
<th>Rules...</th>
<th>Notes...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mill</td>
<td>3</td>
<td>1</td>
<td>None</td>
<td>Time Se/Oldest</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Units

A location unit is defined as an independently operating station. When multiple, independently operating stations all perform the same operation and are interchangeable, they form a multi-unit location. Consider the following multi-unit location:

<table>
<thead>
<tr>
<th>Locations</th>
<th>Name</th>
<th>Cap. Units</th>
<th>DTS...</th>
<th>Status...</th>
<th>Rules...</th>
<th>Notes...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mill.1</td>
<td>1</td>
<td>3</td>
<td>None</td>
<td>Time Se/Oldest</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mill.2</td>
<td>1</td>
<td>1</td>
<td>None</td>
<td>Time Se/Oldest</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mill.3</td>
<td>1</td>
<td>1</td>
<td>None</td>
<td>Time Se/Oldest</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Multi-Capacity, Multi-Unit, and Multiple Locations

Sometimes it can be unclear whether to use multi-capacity, multi-unit, or multiple locations when defining parallel workstations. Suppose, for example, we have three parallel stations, each performing the same operation as shown below.

There are three possibilities for defining the machines: (1) as a multi-capacity location, (2) as a multi-unit location, or (3) as multiple locations. The method you choose to define the locations depends on your application.

For many situations modeling parallel stations as a multi-capacity location works fine. By placing an additional graphic for each station, both the logic and visual effects of having parallel stations can be achieved. However, you should use a multi-unit location instead of a multi-capacity location when any of the following situations exist:

- Individual units have independent down-times.
- It is important to collect individual statistics on each unit.
- It is important, for visual effect, to see entities select individual units by a routing rule other than First Available (e.g., By Turn, Fewest Entries, Longest Empty, etc.).
- It is important, for visual effect, to have a status light assigned to each unit.

In some situations, it may even be desirable to model multi-unit locations as totally separate locations. Multiple locations should be used instead of multi-unit locations when:
A path network is defined but each location must interface with a different node on the network.

Different units have different processing times.

The input for each unit comes from different sources.

The routing is different for each unit.

Defining a Multi-Unit Location

To create a multi-unit location, enter a number greater than one as the number of units for a location. A corresponding number of locations will be copied below the multi-unit location record in the Location edit table, each with a numeric extension designating the unit number of that location. Successive graphics, representing individual units will be drawn to the right of the original location, but may be moved normally.

The original location record becomes the prototype for the unit records. Each unit will have the prototype's characteristics unless the individual unit's characteristics are changed. In the table below, each unit of the location has a clock-based downtime defined because the parent location, Loc2, was assigned a clock-based downtime. However, Loc2.1 has an additional entry-based downtime and Loc2.2 has an additional usage-based downtime. Any other characteristic, including the icon, can be changed as if the unit were an independent location.

If the number of units is changed, the individual unit location records are automatically created or destroyed accordingly.

Individual units of a multi-unit location can be selected to process an entity according to the Selecting Incoming Entities option in the Rules dialog box. (See the discussion regarding the Rules dialog box later in this section.)

In the output report, scheduled hours for the parent location will be the sum of the scheduled hours for the individual units.

Please note

Multi-Unit notes:

1. It is not possible to create a path network to interface with each unit of a multi-unit location. You must define the locations individually and use multiple locations as discussed above.

2. It is not possible to route an entity to a specific unit of a multi-unit location. For example, typing Loc2.3 in the destination field of the Routing edit table is not allowed.

Location Downtimes

A downtime stops a location or resource from operating. A down resource or location no longer functions and is not available for use. Downtimes may represent scheduled interruptions such as shifts, breaks, or scheduled maintenance. Or, they may represent unscheduled, random interruptions such as equipment failures. Downtimes may also be given preemptive or non-preemptive priority and may require one or more resources for repair times.

For single capacity locations, downtimes may be based on clock time, usage time, number of entities processed, a change in entity type, or called using the DOWN statement. Multi-capacity locations have only clock and called downtimes. If a downtime is occurring at a location and any other downtime starts (except a setup downtime), the
two downtimes are processed together, not sequentially (i.e., downtimes overlap).

**How to specify a location downtime:**

1. Select the desired location in the edit table.
2. Click on the DTs... button. This brings up the downtime selection menu shown here for single-capacity locations. (Multi-capacity locations will only have the Clock and Called options.)
3. Each selection opens an edit table for specifying the required elements of the downtime.

**Please note**

An alternative and more straightforward method for defining downtimes due to breaks or shifts is to use the Shift Editor. The Shift Editor also has the advantage of allowing a downtime to be defined for an entire group of locations.

**Clock Downtime Editor**

Clock downtimes are used to model downtimes that occur depending on the elapsed simulation time, such as when a downtime occurs every few hours, no matter how many entities a location has processed.

The Clock Downtime Editor consists of the edit table shown below. To access the Clock Downtime Editor, select Clock from the menu that appears after clicking the DT... heading button. Most expressions, including distributions, can be included in the Frequency, First Time, and Priority fields. (See the “Appendix A” on page 577 to see if the specific statement or function is valid in a particular field.)

<table>
<thead>
<tr>
<th>Frequency</th>
<th>First Time</th>
<th>Priority</th>
<th>Scheduled</th>
<th>Logic</th>
<th>Disable</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>0</td>
<td>59</td>
<td>Yes</td>
<td>WAIT 19</td>
<td>No</td>
</tr>
</tbody>
</table>

**Frequency** The time between successive downtime occurrences. This option may be an expression. This field is evaluated as the simulation progresses, so the time between downtimes can vary.

**First Time** The time of the first downtime occurrence. If this field is left blank, the first clock downtime will occur according to the frequency field. This time is evaluated after any initialization logic.

**Priority** The priority (0-999) of the downtime occurrence. The default priority is 99, the highest non-preemptive priority.

**Scheduled...** Select YES if the downtime is to be counted as a scheduled downtime. Select NO if the downtime is to be counted as a non-scheduled downtime.

All scheduled downtimes will be deducted from the total scheduled hours reported in the output statistics and, therefore, will not be considered in computing utilization, percent down, and so on.

**Logic** Enter any logic statements to be processed when the downtime occurs. When the logic has completed, the location becomes available. In the most simple case, the logic is simply a WAIT statement with a time value or expression which represents the duration of the downtime. Click on the heading button to open a larger edit window.

**Disable** Select YES to temporarily disable the downtime without deleting it from the table.

The example above shows a simple clock-based downtime where the location is down for 10 minutes every 2 hours (120 min). Because this time
should not be included in the total scheduled or available hours, YES is selected in the “Scheduled” column.

**Entry Downtime Editor**

Entry downtimes are used to model downtimes when a location needs to be serviced after processing a certain number of entities. For example, if a printer needs a new cartridge after printing 2000 shipping orders, an entity downtime should be defined. The downtime occurs after the entity that triggered the downtime leaves the location.

The Entry Downtime Editor consists of the edit table shown below. To access the Entry Downtime editor, select Entry from the menu that appears after clicking the DT... heading button. Entry downtimes are only available for single capacity locations. The Downtime Editor contains fields for defining downtimes based on the number of entries processed at a location. Most functions, including distributions, can be included in the Frequency and First Occurrence fields. (See the “Appendix A” on page 577 to see if the specific statement or function is valid in a particular field.)

**Frequency** The number of entities to be processed between downtime occurrences. This may be a constant value or a numeric expression and is evaluated as the simulation progresses.

**First Occurrence** The number of entities to be processed before the first downtime. This may be a value or a numeric expression. If left blank, the first downtime will be based on the frequency entered.

**Logic** Any logic statements to execute when the downtime occurs. Normally, this logic is simply a time expression representing the length of the downtime. Click on the heading button to open a larger edit window.

**Disable** Select YES to temporarily disable the downtime without deleting it from the table.

In the example above, Robot1 will go down every 100 entries, with the first downtime occurring after only 50 entries. When the downtime occurs, it will require a resource (M1) to service the machine for some amount of time between 3.8 and 4.2 minutes. If resource M1 is unavailable when requested, the robot will remain down until M1 becomes available.

**Please note**

*Entry-based downtimes do not accumulate. For example, if a downtime cannot occur because the priorities of the entities being processed are at least 2 levels higher than the priority of the downtime, only the first downtime resumes after processing the entities. All others are ignored.*

**Usage Downtime Editor**

Usage downtimes are used to model downtimes that occur after a location has been operating for a certain amount of time, such as if a machine fails due to wear after so many hours of operation. Usage downtimes are different from clock downtimes because usage downtimes are based on location operation time, which does not include blocked time. Clock downtimes are based on total elapsed simulation time (operation time, blocked time, idle time). Usage downtimes are available only for single-capacity locations.

The Usage Downtime Editor consists of the edit table shown below. It contains fields for defining location downtimes based on the actual time in use. Most functions, including distributions can
be included in the Frequency, First Time, and Priority fields. (See the “Appendix A” on page 577 to see if a specific function is valid in a particular field.)

**Frequency**  The usage time between downtimes.

**First Time**  The time in use before the first downtime occurrence. Leave blank if the first time is to be based upon the frequency entered.

**Priority**  The priority, between 0 and 999 of the downtime. The default priority is 99, which is the highest non-preemptive priority. Generally, usage downtimes tend to be preemptive and should have priority values greater than 100.

**Logic**  Any logic statements to be processed when the downtime occurs. Typically, this field contains a time expression representing the length of the downtime. Click on the heading button to open a larger edit window.

**Disable**  Select YES to temporarily disable the downtime without deleting it from the table.

In this example, Robot2 will experience breakdowns according to a Gamma distribution with shape and scale parameters 1.7 and 2.3. Maintenance resource M1 will be used to service the robot. The repair time is normally distributed with a mean of 2.4 minutes and a standard deviation of .3 minutes.

**Please note**

*Usage-based downtimes do not accumulate. For example, if a downtime cannot occur because the priorities of the entities being processed are at least 2 levels higher than the priority of the downtime, only the first downtime resumes after processing the entities. All others are ignored.*

---

**Setup Downtime Editor**

Setup downtimes should be used to model situations where a location can process different types of entities, but needs to be setup to do so. Setup downtimes will not overlap but will preempt other downtimes in a manner similar to that of an entity. Setup downtimes are only available for single capacity locations.

Note that a setup downtime is assumed to occur only when an entity arrives at a location and is different from the previous entity to arrive at the location. Consequently, the word ALL in the prior entity field means all *except* the same entity type.

The Setup Downtime Editor consists of the edit table shown below. It contains fields for defining location downtimes based on the arrival of a new entity type.

In this example, Robot2 will experience break- downs according to a Gamma distribution with shape and scale parameters 1.7 and 2.3. Maintenance resource M1 will be used to service the robot. The repair time is normally distributed with a mean of 2.4 minutes and a standard deviation of .3 minutes.

**Entity**  The incoming entity for which the setup occurs. If the setup time for all entity types is identical when shifting from the same prior entity, the reserved word ALL may be entered.

**Prior Entity**  The entity preceding the entity for which the setup occurs. If the setup is the same regardless of the preceding entity, you may enter the reserved word ALL.

**Logic**  Enter any logic statements to be processed when the downtime occurs. Click on the heading button to open a larger edit window.
**Disable**  Select YES to temporarily disable the downtime without deleting it from the table.

This example shows that the time to setup Robot3 depends on the arriving entity and the prior entity. If a GearB follows a GearC, the setup time for the machine will be based on a Lognormal distribution with a mean of 4.5 minutes and a standard deviation of .95 min. But if a GearC follows a GearA, the setup time will be based on a Lognormal distribution with a mean of 2.3 min and a standard deviation of .2 min.

**Called Downtime Editor**

Called downtimes are used in conjunction with the DOWN statement to make a location go down. When the name of the called downtime is referenced during simulation by the DOWN statement, the called downtime will execute its logic.

<table>
<thead>
<tr>
<th>Name</th>
<th>Priority</th>
<th>Scheduled...</th>
<th>Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>MyDown</td>
<td>59</td>
<td>No</td>
<td>WAIT 15</td>
</tr>
</tbody>
</table>

**Name**  The name of the called downtime. This is the name that will be referenced by the DOWN statement.

**Priority**  The priority (0-999) of the downtime occurrence. The default priority is 99, the highest non-preemptive priority.

**Scheduled...**  Select YES if the downtime is to be counted as a scheduled downtime. Select NO if the downtime is to be counted as a non-scheduled downtime.

All scheduled downtimes will be deducted from the total scheduled hours reported in the output statistics and, therefore, will not be considered in computing utilization, percent down, and so on.

**Logic**  Enter any logic statements to be processed when the downtime occurs. When the logic has completed, the location becomes available. In the most simple case, the logic is simply a WAIT statement with a time value or expression which represents the duration of the downtime. Click on the heading button to open a larger edit window.

For more information on the DOWN statement, see “Down” on page 460.

**Location Priorities and Preemption**

Priorities determine which entity or downtime uses a location when more than one entity or downtime is contending for it. Priorities may be any value or expression between 0 and 999, with higher values having higher priority. For simple prioritizing, you should use priorities from 0 to 99. Priorities greater than 99 are used for preempting (bumping or displacing) entities or downtimes currently occupying a location.

Priority values are divided into ten levels (0 to 99, 100 to 199, ..., 900 to 999), with values beyond 99 used for preempting entities or downtimes of a lower priority level. Multiple preemptive levels make it possible to preempt entities or downtimes that are themselves preemptive. This means that an entity, EntA, with a priority of 99 can be preempted by another entity, EntB, with a higher priority level of 199. In turn, another entity, EntC, with a priority of 299 can preempt EntB at the same location.

To preempt an entity currently using a location, a preempting entity or downtime must have a priority at least ONE level higher than the entity currently at the location. To preempt a downtime in effect at a location, a preempting entity must have a priority at least TWO levels higher than the current downtime. Since all overlapping location downtimes are processed concurrently (except
A preempted entity will resume processing where it left off unless the location was in the middle of a setup downtime. If the entity initiated a setup downtime before being preempted, it will begin processing the setup logic from the beginning when it resumes.

Assigning Priorities

An entity or downtime accesses a location based on its priority. An entity is assigned a priority for accessing a location in the Destination column of the Routing edit table. A downtime is assigned a priority in the appropriate Downtime edit table. The first of the following examples shows a priority of 100 assigned to EntA as it tries to claim Loc2. This priority is high enough to preempt any entity at the location having a priority less than 100. It is not high enough, however, to preempt any downtimes at the location.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>USE Res1 FOR N(3,.1)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2, 100</td>
<td>First 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

This example shows a priority of 200 assigned to a usage-based downtime at Loc4. This priority can preempt any entity at the location with a priority less than 200.

The following table shows the minimum priority level requirements for an incoming entity or an upcoming downtime to preempt the current entity or downtime at the location.
Minimum Required Priority Levels for Preempting at a Location

<table>
<thead>
<tr>
<th></th>
<th>To preempt the Current Entity</th>
<th>To preempt the Current downtime</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Incoming Entity</strong></td>
<td>1 priority level higher</td>
<td>2 priority levels higher</td>
</tr>
<tr>
<td><strong>Upcoming Downtime</strong></td>
<td>1 priority level higher</td>
<td>Downtimes overlap</td>
</tr>
</tbody>
</table>

• The upper left quadrant shows that for an entity to gain access to a location already processing another entity, the incoming entity must have a priority at least one level higher than the current entity's priority.

• The upper right quadrant shows that for an incoming entity to gain access to a location where a downtime is currently in effect, the entity must have a priority at least two levels higher than the downtime's priority.

• The lower left quadrant shows that for a downtime to preempt an entity currently processing, the downtime must have a priority one level higher than the currently processing entity.

• The lower right quadrant shows that all location downtimes (except setup) are concurrent or overlapping. Setup downtimes preempt as if they were entities.

The following examples demonstrate the explanations above in greater detail.

**Example 1**

The following example demonstrates what happens when Ent 1 with a priority of 99 is preempted by Ent 2 which has a priority of 100 or greater.

**Entity Preempting an Entity**

![Entity Preempting an Entity](image)

Ent 1 processing resumes upon completion of Ent 2 processing

**Example 2**

This example demonstrates what happens when a downtime having a priority of 99 is preempted by an entity having a priority of 200 or greater.

**Entity Preempting a Downtime**

![Entity Preempting a Downtime](image)

Downtime resumes immediately upon completion of entity processing
Example 3
This example demonstrates the behavior when an entity with a priority of 99 is preempted by a downtime with a priority value of 100 or greater.

**Downtime Preempting an Entity**

```
<table>
<thead>
<tr>
<th>Entity</th>
<th>DT</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>T2</td>
<td></td>
</tr>
<tr>
<td>T3</td>
<td></td>
</tr>
<tr>
<td>T4</td>
<td></td>
</tr>
</tbody>
</table>
```

Remaining entity processing time resumes upon completion of downtime

Example 4
This example illustrates how, regardless of the downtime priority values, downtimes will overlap. The exception is setup downtimes, which preempt downtimes exactly like entities (see Example 5).

**Overlapped/Concurrent Downtimes**

```
<table>
<thead>
<tr>
<th>DT 1</th>
<th>DT 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>T2</td>
</tr>
<tr>
<td>T2</td>
<td>T3</td>
</tr>
<tr>
<td>T3</td>
<td>T4</td>
</tr>
</tbody>
</table>
```

Example 5
This example demonstrates what happens when a setup downtime with a priority of 99 is preempted by a normal downtime having a priority of 100 or greater.

**Downtime Preempting Entity in Setup**

```
<table>
<thead>
<tr>
<th>Entity setup</th>
<th>DT</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>T2</td>
<td></td>
</tr>
<tr>
<td>T3</td>
<td></td>
</tr>
<tr>
<td>T4</td>
<td></td>
</tr>
</tbody>
</table>
```

Remaining setup time resumes upon completion of downtime

Example 6
This example demonstrates what happens when Ent 1 setup downtime with a priority of 99 is preempted by Ent 2 having a priority of 100 or greater.

**Entity Preempting Entity in Setup**

```
<table>
<thead>
<tr>
<th>Ent 1 setup</th>
<th>Ent 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>T2</td>
<td></td>
</tr>
<tr>
<td>T3</td>
<td></td>
</tr>
<tr>
<td>T4</td>
<td></td>
</tr>
</tbody>
</table>
```

Ent 1 setup must start over upon completion of Ent 2 processing
Special Notes Regarding Location Downtimes

1. When an entity preempts another entity (Example 1), or when an entity preempts a downtime (Example 2), or when a downtime preempts an entity (Example 3), any resources owned by the preempted entity or downtime will be freed temporarily until the preempting entity or downtime finishes at the location. At that time, the original entity or downtime will seek to claim the exact units of the resource or resources it owned before the preemption occurred.

2. As shown in examples 5 and 6, an entity that requires a location setup will be treated differently depending on the preempting activity. If the preempting activity is another entity, the current setup in process will have to start over from the beginning. However, if the preempting activity is a downtime, the remaining setup time will finish upon completion of the preempting downtime.

3. Locations will not go down if they are in a blocked state. A location is blocked if it has an entity that cannot be routed because of the unavailability of the next location. This may also include the time an entity waits to enter a location based on a routing condition, such as LOAD.

4. Locations will not go down if any of the occupying entities are waiting for a resource or are waiting at any downtime inhibiting statement.

5. In cases where a downtime or other entity attempts to preempt an entity’s use of a location, a preemption process may be defined to override the default way of handling the preemption. See “Preemption Process Logic” on page 292.

Rules Dialog Box

The Rules dialog box, selected by clicking on the Rules button in the Locations edit table, is used to choose the rule for ProModel to follow when making the following decisions:

- Selecting incoming entities
- Queuing for output
- Selecting a unit

![Rules Dialog Box](image-url)
Selecting Incoming Entities

When a location becomes available and there is more than one entity waiting to enter, a decision must be made regarding which one to admit. The primary determining factor is the priority of the input routing. The entity with the highest routing priority will be admitted regardless of the incoming selection rule. However, if two or more entities have the same priority for claiming the location, then the location selects an incoming entity based on the incoming selection rules listed below.

Oldest by Priority  Selects the entity waiting the longest among those having the highest routing priority.

Random  Selects randomly with equal probability among all waiting entities.

Least Available Capacity  Selects the entity coming from the location having the least available capacity. Ties are broken by the entity waiting the longest.

Last Selected Location  Selects the entity coming from the location that was selected last. Ties are broken by the entity waiting the longest. If no entities are waiting at the last selected location, the Oldest by Priority rule takes effect.

Highest Attribute Value  Selects the entity with the highest attribute value for a specified attribute. Ties are broken by the entity that has been waiting the longest. Location attributes are also valid entries.

Lowest Attribute Value  Selects the entity which has the lowest attribute value for a specified attribute. Ties are broken by the entity waiting the longest. Location attributes are also valid entries.

Queuing For Output

When an entity finishes its operation at a location, other entities to finish ahead of it may not have departed. A decision must be made to allow the entity to leave or to wait according to some queuing rule. If one of the following queuing rules is not specified, “No Queuing” will be used.

No Queuing  Entities that have completed their operations at the current location are free to route to other locations independent of other entities that have finished their operations. If this option is selected it is not displayed in the Rules Box.

First In, First Out (FIFO)  The first entity completing operation must leave for its next location before the second entity completing its operation can leave, and so on.

Last In, First Out (LIFO)  Entities that have finished operations queue for output LIFO so the last one finished is the first to leave.

By Type  Entities that have finished operations queue for output FIFO by entity type so the routing for each entity type is processed independently of routings for all other types.

Highest Attribute Value  Entities that have completed operations queue for output according to the highest value of a specified attribute.

Lowest Attribute Value  Entities that have completed operations queue for output according to the lowest value of a specified attribute.

Selecting a Unit

If the location has multiple units, then incoming entities must select which available unit to use. One of the following rules may be selected. These decision rules apply to multi-unit locations only.

First Available  Selects the first available unit.

By Turn  Rotates the selection among the available units.
**Most Available Capacity**  Selects the unit having the most available capacity. This rule has no effect with single capacity units.

**Fewest Entries**  Selects an available unit with the fewest entries.

**Random**  Selects an available unit randomly.

**Longest Empty**  Selects the unit that has been empty the longest.

When specifying the decision rules for selecting incoming entities at a location, it is important to remember that the routing of an entity is also dependent on the queuing for output decision rules at the previous location. The following example will clarify this principle.

**Rules Dialog Box Example**

Consider a location, Loc1, which has a “Last In, First Out (LIFO)” as the queuing for output rule. Suppose that two other locations, Loc2 and Loc3, have “No Queuing” for the output rule. The three locations, Loc1, Loc2, and Loc3 feed into Loc4 which has an “Oldest by Priority” rule for selecting incoming entities.

Two parts are queued for output at Loc1. The part waiting the longest, EntA, at Loc1 has been waiting 10 minutes. The other part, EntB, which queued for output after EntA, has been waiting 5 minutes. At Loc2, the part queued for output, EntC, has been waiting 7 minutes. At Loc3, the part queued for output that has been waiting the longest, EntD, has waited 3 minutes.

The part to enter Loc4 first is EntC at Loc2 which waited 7 minutes. Even though EntA has been waiting ten minutes, it must wait until EntB has been routed, because EntB is ahead of it in the output queue according to the LIFO queuing rule. Once Loc4 finishes processing EntC, EntB at Loc1 enters Loc4. EntB enters before EntA because entities must be output before a destination selects incoming entities. Next, EntA at Loc1 enters Loc4 after which EntD at Loc3 enters Loc4.
Entities

Anything that a model processes is called an “Entity.” Documents, people, or phone calls should be modeled as entities. Entities may be grouped, such as when several boxes are stacked on a pallet (through the GROUP statement); consolidated into a single entity, such as when two or more documents are joined together (through the JOIN statement); split into two or more entities, such as when a box is opened and the contents removed (through the SPLIT AS statement); or converted to one or more new entities (through the RENAME or CREATE statement or by defining multiple outputs in the routing).

Each entity type has a name and a name index number. In logic and expressions, an entity can be referred to by name or by its name-index number using the ENT() function. The ENT() function allows a statement requiring an entity name to use an expression that may change to reference different entity names as a simulation progresses. See “Ent()” on page 466 for more information.

Entities may also have user-assigned attributes to represent such things as dimensions, weights, pass/fail status, and group identifiers.

How to access the entities editor:

- Select Entities from the Build menu.

or...

- Right click on the existing entity and select Edit.

Entities Editor

Entity types are created and edited with the Entities Editor. The Entities Editor consists of (1) an edit table to define the name and specifications of each entity type in the system, and (2) the Entity Graphics window for selecting one or more icons.
to represent each entity. The fields of the edit table are explained below.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Name</th>
<th>Speed (fpm)</th>
<th>Stats</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gear</td>
<td>150</td>
<td>Time Series</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Belt</td>
<td>50</td>
<td>Time Series</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Box</td>
<td>50</td>
<td>Time Series</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Icon  This is the graphic icon used to represent the entity during the animation. Entity graphics are defined or modified using the Entity Graphics window. This icon can vary during the simulation. See “Defining Multiple Entity Graphics” on page 114.

Name  The entity name. See “Names” on page 394 for more information on naming.

Speed  This entry is optional and applies to self-moving entities such as humans. It defines the speed in feet or meters (depending on the distance units chosen in the General Information Dialog box) per minute to be used for any of the entity’s movement along a path network. When creating a new entity, a default value of 150 fpm (or 50 mpm for metric systems) is automatically entered. This is roughly the speed of a human walking.

Stats  The level of statistical detail to collect for each entity type: None, Basic, or Time Series. Time series statistics must be selected if you wish to view a time series plot in the output module.

Notes  Any information you wish to enter about the entity, such as material, supplier name.

**Defining Entities**

Entities are typically defined graphically by clicking on a desired library graphic in the Entity Graphics window. Alternatively, you may define entities by simply entering their names and characteristics in the Entity edit table. Entity graphics are optional.

**How to define entities graphically:**

1. Select Entities from the Build menu.
2. Check the New box in the Entity Graphics window.
3. Select an icon for the entity. (Use the Graphic Editor to create new icons.)
4. Edit the name and other default entries for the entity in the Entity edit table.

**Entity Graphic Dimensions**

An entity has two sets of dimensions, a logical (length and width) dimension, and a graphical (horizontal and vertical) dimension. An entity's length and width are used to determine the number of entities that can fit on a conveyor, and do not affect the size of the graphic on the screen during a simulation. They are changed in the
fields labeled Length and Width in the Entity Graphics window. If multiple graphics are defined for an entity, each graphic can have a different length and width. Which side a user chooses to call the length or width is unimportant as long as the proper side is referenced when defining a conveyor. If no conveyors are defined in the model, no specifications of a length and width are necessary.

An entity's horizontal and vertical dimensions are used to determine the size of the graphic on the screen. These dimensions can be changed in two ways. The scroll bar to the right of the graphic will scale the graphic. In addition, the horizontal and vertical dimensions can be changed by clicking on the Edit button, then clicking on the Dimensions... button from the resulting dialog box. The default dimensions are determined when an icon is created to scale in the Graphic Editor. If the size is changed using the scroll bar, the change will be reflected in the dimensions listed. If you change either the horizontal or vertical dimension from the dialog box, the size of the icon will change accordingly.

Please note

Since the horizontal and vertical dimensions must remain proportional, only one of the dimensions needs to be changed. The other dimension changes automatically to maintain proportionality.

Defining Multiple Entity Graphics

Entity types can be assigned more than one graphic to represent the entity at various stages of production or traveling in different directions. An entity representing a loan application could be assigned three graphics: the first representing the application before a credit check has been received, the second representing the application after receiving the credit check but before the loan is approved, and the third representing the application after the loan is approved. During the simulation, the application's status could be shown by adding additional graphics to represent each state of the loan process using the GRAPHIC statement (see “Graphic” on page 482 for information).
How to define multiple graphics for an entity type:


2. Click on the desired cell.

3. Select a library graphic from the graphics menu.

4. Repeat steps two and three until all the desired graphics have been assigned to the entity type.

The graphic that represents an entity during a simulation will be the first in this series until an entity's graphic is changed with the GRAPHIC statement.

**Preemptive Entities**

Often during a simulation, it is desirable to have an entity preempt an activity at a location or resource in order to gain access to that location or resource. These situations can be modeled using preemptive priorities. An entity with a high enough priority can take over a location process-

ing an entity or a location that is down. An entity with high enough priority can also take over a resource when it is being used by another entity or when it is off shift. When an entity takes over a location that was down or in use by another entity, the entity has preempted the downtime or the other entity.

In a multi-capacity location, the occupying entity will be preempted only if there is no more capacity at the location and the occupying entity is undergoing an operation time. Further, the occupying entity cannot be one that has been split, created, grouped, combined, ungrouped, or unloaded at the location.

An entity must have a priority one level higher than an occupying entity to preempt the occupying entity. An entity must have a priority that is two levels higher than a downtime to preempt the downtime. If an entity does not have a high enough priority to preempt another entity or downtime at a location, it waits in line (oldest by priority) to access the location (see “Location Priorities and Preemption” on page 105).

Note that the priority of an entity is not defined for the entity itself. For claiming a location, it is defined in the destination field of the routing. For capturing a resource it is defined as part of the GET, JOINTLY GET, or USE statement. A priority may, however, be assigned to an attribute of a referenced entity when it attempts to access a resource or location.

**Example of Preemptive Entities**

In this example entity (EntA) arrives at location Loc1. Immediately upon arrival it requests to use resource Res1 for a normally distributed amount of time. The priority for obtaining the resource is 99, which means that it is a non-preemptive request. When Res1 becomes available, EntA will be first in line because it has the highest non-preemptive priority possible. When processing is.
complete for this entity, it is routed to Loc2 with priority 200. This means that it can preempt another entity or a downtime that may already be in process at Loc2. (See “Location Downtimes” on page 101 and “Resource Downtimes” on page 131 for more details on entity preemption.)

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>Use Res1,99 For N(3,1)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2,200</td>
<td>First 1</td>
<td>MOVE FOR 2.5</td>
</tr>
</tbody>
</table>
Path Networks

When resources are modeled as dynamic resources which travel between locations, they follow path networks. Entities moving by themselves between locations may also move on path networks if referenced in the move logic of the routing. Otherwise, they follow the routing path. Multiple entities and resources may share a common path network. Movement along a path network may be defined in terms of speed and distance, or simply by time. See discussion on Automatic Time and Distance Calculation, later in this section, for more information about movement according to speed and distance or by time.

There are three types of path networks: passing, non-passing, and crane. A passing network is used for open path movement where entities and resources are free to overtake one another. Non-passing networks consist of single-file tracks or guide paths such as those used for AGVs where vehicles are not able to pass. Crane path networks are described in more detail in the section “Crane Systems” on page 261.

Passing and non-passing networks consist of nodes, which are connected by path segments. Path segments are defined by a beginning and an ending node and may be unidirectional or bidirectional. Multiple path segments, which may be straight or jointed, may be connected at path nodes. For all path networks, path nodes define the points where the resources using the network interface with processing locations.

Path Networks are defined in the Path Networks Editor, which is accessed from the Build menu.

How to create or edit a path network:

- Select Path Networks from the Build menu.

or...

- Right click on the existing path network and select Edit.

Path Networks Editor

The Path Networks Editor consists of an edit table with fields for defining basic information about each network, such as the network name, the type of network (Non-Passing or Passing), and the basis for movement along the network (Speed and Distance or Time). Clicking on the
appropriate heading button will bring up a table for defining nodes, path segments, and location node interfaces.

The following explains each field of the Path Networks edit table.

**Graphic**  For passing or non-passing path networks, this button displays the Path Color dialog, which allows you to define the color of the path network. Click on the heading button or double click in this field to bring up the graphic dialog. Both dialogs allow you to specify whether or not the network will be visible at run time.

**Name**  A name that identifies the path network. For more information about valid names, see “Names” on page 394.

**Type**  Set this field to Non-Passing if you want entities and resources to queue behind one another on the path network. If a path is Non-Passing, entities may not pass each other, even if an entity is traveling at a faster speed than the one in front of it. Set this field to Passing if you want entities or resources to pass each other on the path network.

A "Crane" option is also available, which is described in more detail in the section “Crane Systems” on page 261.

**T/S**  Set to either **Time** or **Speed and Distance** as the basis for measuring movement along the network. See the discussion on Automatic Time and Distance Calculation later in this section for more information.

**Paths**  The number of path segments in the network. Clicking on the heading button opens the Path Segment edit table where the user may define the network's node to node connections.

The Path Segment edit table is covered in more detail later in this section.

**Interfaces**  The number of location-node interfaces in the path network. If an entity will be picked up or dropped off at a particular location by a resource, that location must connect to a node through a location-node interface. Clicking on the heading button opens the Interfaces edit table where the user may define nodes that connect to processing locations. The Interfaces edit table is covered in more detail later in this section.

**Mapping**  The number of entries in the Mapping edit table. Clicking on the heading button opens the Mapping edit table where the user may map destinations to particular branches of the network. (The Mapping edit table is covered in more detail later in this section.)

**Nodes**  The number of nodes defined in the Nodes edit table. Nodes are created automatically when graphically defining path segments. Click on this heading button to open the Node edit table, which may be used to define nodes manually or set Node Limits on one or more nodes. Nodes may also be used to control a resource's behavior through node logic or search routines such as work and park searches (see “Resources” on page 126). The Nodes edit table is covered in more detail later in this section.

**How to create a path network graphically:**

1. Set the default time and distance values per grid unit from the Grid dialog box.
2. Choose **Path Networks**... from the **Build** menu.
3. Enter the name of the network in the Path Networks edit table.
4. Select either **Passing** or **Non-passing** as the network type.
5. Select either **Speed and Distance** or **Time** as the travel basis.
6. Click on the **Paths...** heading button to open the Path Segment edit table.
7. Lay out the network using the mouse buttons as described below.

**How to create path segments:**

1. Left click to create a node and begin a path segment.
2. Additional left clicks produce path joints.
3. A right click ends the segment and creates a new node.

**How to modify path segments:**

To **create a new path from an existing node**
- Left click on that node.

To **delete a joint**
- Right click on an existing joint.

To **add a joint**
1. Right-click anywhere on a path segment.
2. Select **Add Node** from the menu.
3. Drag the joint to the desired position.

**Please note**

*If you hold down the CTRL key and move the cursor over a path segment or joint, the Add/Delete joint cursor will appear. From here, left click to add or delete a joint.*

---

**To highlight a path on the layout and in the Path Segment edit table**
- Left click on that path.

**How to create additional nodes or move existing nodes:**

1. Click on the Nodes heading button in the Path Networks edit table.
2. Click the left mouse button to create a node both on the layout and in the Nodes edit table.
3. Drag an existing node to move that node.

**How to move a path network:**

1. Click on the Paths heading button in the Path Networks edit table.
2. Left click on any path segment and drag to the desired position. The entire network will move.

**A Typical Path Network**

The following diagram shows a path network consisting of seven nodes (N1 to N7) connected by path segments. Path segments may be straight lines from one node to another, as in the segment from node N7 to node N6, or they can have any
number of joints, such as the segment from node N2 to node N5.

Path Segment Edit Table

This table is used to define the Path Segments that make up a path network. When specifying travel according to time between nodes, the heading “Distance” changes automatically to “Time.”

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>BI</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>N1</td>
<td>N2</td>
<td>Bi</td>
<td>17.16</td>
</tr>
<tr>
<td>N2</td>
<td>N3</td>
<td>Bi</td>
<td>41.23</td>
</tr>
<tr>
<td>N3</td>
<td>N4</td>
<td>Bi</td>
<td>11.22</td>
</tr>
<tr>
<td>N4</td>
<td>N5</td>
<td>Bi</td>
<td>40.10</td>
</tr>
<tr>
<td>N5</td>
<td>N6</td>
<td>Bi</td>
<td>10.95</td>
</tr>
<tr>
<td>N5</td>
<td>N2</td>
<td>Bi</td>
<td>42.20</td>
</tr>
<tr>
<td>N1</td>
<td>N7</td>
<td>Bi</td>
<td>14.64</td>
</tr>
<tr>
<td>N7</td>
<td>N6</td>
<td>Bi</td>
<td>21.30</td>
</tr>
</tbody>
</table>

The following defines the fields of the Path Segment edit table.

From  The beginning node of the path segment.
To    The ending node of the path segment.
BI    Set to Uni-directional or Bi-directional depending on whether traffic can travel in only one or either direction.

Time  If travel along the network is to be measured in time rather than in speed and distance, then enter the time required for a resource or entity to traverse the path segment. This value may be any numeric expression except for resource and downtime system functions. When travel along a path is measured in time, all resources and entities traveling along the path take the same amount of time to travel it, regardless of their speed. This field's title changes to “Distance” if the T/S field in the Path Networks edit table is set to Speed and Distance.

Distance If travel along the network is to be measured in terms of speed and distance, enter the length of the segment which determines the travel time along the path in conjunction with the speed of the resource or entity.

The value entered may be any numeric expression except for attributes, arrays, and system functions. This expression is evaluated only when the simulation begins.

The distance may be followed by a comma and a speed factor between .01 and 99. This speed factor may be used to model any circumstance affecting the speed of items traveling the path. For example, a resource may normally travel at 150 fpm, but may slow down as it goes around a corner to 80% of the original speed, 120 fpm. This would be entered as 100, .8 for a path segment 100 feet long which traversed the corner. This field's title changes to “Time” if the T/S field in the Path Networks edit table is set to Time.

Please note

Path segment editing notes:

1. If no path segments have been defined for a network, resources and entities will move from node to node in zero time. See “Processing” on
page 143 for more information about the Routing Move dialog box.

2. To move nodes already defined on the layout, click on the Nodes button and move the desired nodes.

3. To insure that all nodes can be seen by the user, two nodes cannot be located at the same point.

**Automatic Time and Distance Calculation**

The distance between two successive nodes or the time required to traverse a segment between two successive nodes is calculated according to the number of grid units between the nodes and the default time and distance values per grid unit. ProModel automatically enters this time or distance in the Time/Distance column of the Path Segments edit table. Although the calculated time or distance may be edited later, relying on the automatic time and distance calculation feature allows path networks to be built to scale and saves time when defining path networks graphically. The time or distance for a path is automatically recalculated whenever the path is edited (lengthened or shortened) unless you unchecked the “Recalculate path lengths when adjusted” box under Options in the Tools menu.

**How to set the default time and distance values per grid unit:**

1. Select **Layout Settings** from the **View** menu.
2. Select the **Grid Settings** button.
3. Click on the **Scale...** button in the Grid dialog box.
4. Enter the time and distance values as shown below.

![Scale dialog box](image)

**Please note**

To set these values as defaults, you must check the **Save as Default Grid Settings** option on the grid dialog box.

**Interfaces Edit Table**

If an entity will be picked up or dropped off at a particular location by a resource, that location must connect to a node through a location-node interface. The Interfaces edit table is used to define location-node interfaces. The graphic below shows how to set node N1 to interface with location Loc1, node N3 to interface with Loca-
tion Loc2, and so on, as in the example at the beginning of this section.

The fields of the Interfaces edit table are described as follows.

**Node**  The node name.

**Location**  The name of any locations which interface with the node. Nodes can interface with several locations, but a location may interface with only one node on the same path network.

**How to create location-node interfaces**

1. Left click on the desired node to begin rubber-band-ing a link or interface.
2. Left click on the desired location to complete the interface.

**Please note**

*A node on a path network may not interface with a particular unit of a multi-unit location (i.e., Loc1.2). A node may interface only with the “parent” location (i.e., Loc1) of a multi-unit location.*

**Mapping Edit Table**

If there are multiple paths emanating from one node to another node, the **default** path selection will be based on the shortest distance for speed & distance networks, and the least number of nodes for time based networks. These defaults can be overridden by explicitly mapping some destination nodes to specific branches that entities and resources will take when traveling out of a “from” node.

The fields of the Mapping edit table are described as follows.

**From**  Entities and resources traveling out of this node will use this mapping record to decide which of the alternate branches will be taken next.

**To**  The “from” node and the “to” node together define the branch to be taken next. This might also be interpreted as the node which entities and resources will go through, to reach one of the destination nodes.

**Dest.**  Entities and resources whose ultimate destination is one of these nodes will be forced to take the branch that directly connects the “from” node to the “to” node.
Please note

When your simulation is compiled and run, ProModel will automatically define destinations for your network mapping, if you have not defined them yourself. These computer-generated mappings will not appear in the Dest. column of the Mappings table, but the From and To columns will contain information on these mappings. Do not delete the information in these columns.

How to create mappings using the mapping edit table:

1. Click on the Mapping... heading button in the Path Network edit table. This will open the Mapping edit table.
2. Click on the From heading button and select the node to be mapped.
3. Click on the To heading button and select the terminating node for the branch to be mapped.
4. Click on the Destination heading button and select the desired node(s).

How to create mappings graphically:

1. Click on the Mapping... heading button in the Path Network edit table. This will open the Mapping edit table.
2. Click on the from node in the Layout Window. This places the selected node in the From field.
3. Click on the to node in the Layout Window. Note that the to node must be directly connected to the from node with a single branch.
4. Click on the destination node(s) in the Layout Window. This places the selected node(s) in the Destination field.

Please note

ProModel automatically calculates and uses the shortest paths on unmapped portions of networks (if the network is time based, the path having the least number of nodes is used). Explicitly indicating shortest paths using mapping constraints will speed up the translation process, especially for models with complex networks.

An example of mapping two branches of a network is given on the following pages.

Mapping Example

The following example uses a path network diagram to demonstrate mapping.

In this example, we wish to force resources and entities enroute from Loc1 to Loc4, Loc5, or Loc6 to take the branch directly connecting node N2 and node N5 to avoid traffic congestion at the intersection of the two main branches at node N3. Since there are multiple ways to go from N2 to N5, a decision as to which alternative will be used has to be made at N2.

In addition, we want resources and entities to follow the same path in the opposite direction when enroute from Loc4, Loc5, or Loc6 to Loc1. In this case, the decision must be made at N5.

Because the combined length of segments connecting N2 to N3 and N3 to N5 is shorter than the length of the single segment from N2 to N5, resources and entities based on speed and distance will normally take the former path to travel.
To force them to take the longer path, we must specify mapping constraints.

This case requires two explicit mapping constraints to override the selection of default paths in each direction: The first table entry forces entities and resources en-route from Loc1 to Loc4, Loc5, or Loc6 to override the default path and take the direct branch from N2 to N5. The second table entry forces entities and resources traveling from N5 (originally from Loc6, Loc5 or Loc4) to Loc1 to take the direct branch from N5 to N2. Entries 3 and 4 are optional, and might be useful to speed up translation, since the restrictions they impose allow the shortest path calculations to be bypassed.

There is a shortcut to force the same non-default path selection constraint to a number of destination nodes: For instance, if the vertical arm of the path network extended up to include many other nodes N8, N9, ..., and locations Loc7, Loc8, ..., then we would change the Mapping edit table as follows:

1. Delete line 1 in the Mapping edit table.
2. Make sure that line 3 is there (it is not optional any more).
3. Include a line which reads: “From: N2, To: N5, Dest:<BLANK>”.

The empty destination column will be interpreted as “all other destination nodes” by ProModel.

**Please note**

For a “from” node (unless there is a branch map with a blank destination column), any nodes not explicitly listed in the destination columns of existing mapping records will be reached via the default path selections.

**Nodes Edit Table**

The Nodes edit table lists the nodes that make up a path network and is used to limit the number of resources and entities that may occupy a node at any given time. In addition to controlling traffic on a path network, nodes also define where resources interface with locations or where entities enter and leave the path network. Nodes may
also be used solely to control a resource or entity's behavior through node logic or search routines such as work and park searches (see “Resources” on page 126).

The following defines the fields of the Nodes edit table.

**Name**  The node name.

**Limit**  The maximum number of resources and entities that may occupy a node at any given moment. A blank entry means there is no limit.

### Pre-translation check for Path Networks

When you run your simulation, ProModel will compile your model and check your path networks for errors. If your model has large, complex path networks, this could cause your model’s compilation time to run quite long.

To combat this, ProModel will perform a pre-translation check for path networks. This means that the first time your model compiles, it will check your path networks for errors. It will then save this information.

Every subsequent time your model compiles, it will read the saved information about your path networks and not check the path networks for errors. This saves compilation time on large models.

However, if you edit one or more of your path networks, ProModel will once again check the modified path networks for errors during compilation. ProModel will consider a path network to have been modified if its name was at any time, since the last compile, highlighted in the Path Network dialog window.
Resources

A resource is a person, piece of equipment, or some other device used for one or more of the following functions: transporting entities, assisting in performing operations on entities at locations, performing maintenance on locations, or performing maintenance on other resources. Resources consist of one or more units with common characteristics, such as a pool of service technicians or a fleet of lift trucks. Resources may be dynamic, meaning that they move along a path network, or static, in which no movement occurs. Resources may also have downtimes.

Every resource has a name and a name-index number. Logic referring to a resource, such as the GET statement, can use either the resource's name, or the RES() function to refer to the resource. The RES() function allows a statement using a resource name to refer to different resources as a simulation progresses. See “Name-Index Numbers” on page 396 and “Res()” on page 533 for more information.

Resources are defined in the Resources Editor, accessed through the Build menu.

How to create and edit resources:

- Select Resources... from the Build menu.

or...

- Right click on the existing location and select Edit.

Typical Use of Resources

The diagram below shows two types of resources: forklifts and an operator. Forklifts are used as resources to transport entities from Loc1 to any of the processing locations, Loc2 through Loc6. The forklifts are dynamic resources and travel along the path network, Net1, explained previously in “Path Networks” on page 117. The operator inspects all parts at Loc7 and never moves from that location. Therefore, the operator is a static resource and does not need a path network.

The remainder of this section defines the elements and the procedures necessary for specifying static and dynamic resources.

Resources Editor

The Resources Editor consists of the Resources edit table and the Resource Graphics window.
These windows are used together to specify the characteristics of a resource.

**Resources edit table** Appears along the top of the workspace with fields for specifying the name of each resource, the number of identical units of a resource, the downtime characteristics of each resource, and other important information, such as the path network the resource uses for movement.

**Resource Graphics window** Contains graphic icons that may be selected to represent a resource during simulation. A resource may have more than one icon to represent different views of the resource, or its status. This window also allows you to define multi-unit resources graphically on the layout. Defining a resource is as simple as selecting an icon from the Resource Graphics window, giving the resource a name, and specifying the characteristics of the resource.

**Resources Edit Table**

The Resources edit table defines the characteristics of each resource in the system. The fields of this table are defined below.

| Icon | The icon selected for this resource. Icons are selected using the Resource Graphics Window. If more than one icon is selected for the resource, the first icon is shown here. |
| Name | The name of the resource. |
| Units | The number of units represented by this resource name between 0 and 999 (or a macro). If the entry is a numeric expression, the expression will be evaluated at the start of the simulation run. Consequently, the number of resource units cannot be changed during the simulation run. If you would like to vary the number of units of a resource during runtime, use downtimes to vary the number of resources available at a given time. (See also “Resource Downtimes” on page 131.) |

**Please note**

*When you use a macro with a value of zero in the units field, you can use SimRunner to find the optimal number of resources needed for your model.*

| DTs... | Select this field to define any optional downtimes for this resource. Only clock and usage based downtimes are permitted for resources. |
| Stats... | The desired statistics, if any, to gather for this resource. Statistics can be collected as a summary report over all units of a resource, or individually for each unit of a resource. The options are as follows: |

- **None**: No statistics are gathered.
- **Summary**: Average utilization and activity times are recorded collectively for all units of the resource.
- **By Unit**: Statistics are gathered for each unit individually as well as collectively.
Specs... Select this field to open the Resource Specifications dialog box. From here you can assign a path network, set the resource speed, and define pickup and deposit times. For more information on the Specification dialog, see “Resource Specifications Dialog Box” on page 136.

Search... If a path network has been assigned, select this field to access the Work Search and Park Search edit tables, used to define optional work and park searches.

Logic... If a path network has been assigned, select this field to define any optional logic to be executed whenever a resource enters or leaves a particular path node. If you have defined a node entry and exit logic, the logic field will show the number of nodes where node entry and exit logic has been defined.

Pts... If a path network has been assigned, select this field to define resource points. Resource points are auxiliary points where multiple resources may appear graphically when parked or in use at a multi-capacity node.

Notes... Enter any notes in this field, or click on the heading button to open a larger Notes window for entering notes.

Resource Graphics Window
The Resource Graphics Window appears when the Resources module is opened and is used to assign graphic symbols to resources. If the New box is checked in the window, selecting a graphic creates a new resource. Multiple graphics are defined for a given resource by selecting the desired resource and unchecking New. This procedure causes a scrollable row of graphic cells to appear which are automatically and sequentially numbered beginning with 1. Graphics may be added or replaced for a given resource by clicking on the desired cell and selecting a library graphic from the graphics menu.

By using the GRAPHIC statement in resource downtime logic, or in the case of a dynamic resource, node logic, any of the multiple graphics assigned to a resource may be activated during simulation. For static resources, you may define a second or third graphic to be used automatically when the resource is busy or down, respectively.

Resource graphics may be sized using the scroll bar or edited by clicking the edit button. Edit options include rotating, flipping horizontally or vertically, and changing the color of the graphic. In addition, you can specify the dimensions of the resource graphic. For more information, see “Dimension” on page 310.

The Layout Position allows you to add or delete resource graphics on the layout. When adding a resource graphic to the layout, ProModel automatically adds a unit and a resource point. When deleting a resource graphic from the layout, Pro-
Model deletes the resource point but leaves the number of units in the units field unchanged.

**Static Resources**

Static resources are resources not assigned to a path network and therefore do not visibly move. A static resource may be needed to perform an operation at only one location, such as an inspection operator, and will appear during the entire simulation in the same place it was defined graphically. Although a static resource is stationary and does not visibly move between locations, it may be used at more than one location or to move entities between locations.

**How to define a static resource:**

1. Select **Resources** from the **Build** menu. This automatically brings up the Resources edit table and the Resource Graphics window, used together to define all resources in the model.
2. Choose a graphic icon for the resource from the Resource Graphics window.
3. Select the **Add** button in the Resource Graphics window.
4. Click on the layout at the desired position of the resource graphic.
5. Add additional resource graphics for the same resource if desired. Every time a resource graphic is placed on the layout for the same resource in the edit table, a new resource point is created.
6. Supply any optional information about the resource, such as downtimes.

**Please note**

*Static resources notes:*

1. When defining the static resource specifications, the default for Resource Search is Least Utilized. The default for Entity Search is Longest Waiting. You may only specify Pick-up and Deposit Time in the Motion box.

2. There is not a status light for a static resource; however, a second and third graphic may be defined for use when the resource is busy or down, respectively. If no second and third graphic are defined, the resource graphic changes color to green when in use and red when down.

**Dynamic Resources**

Dynamic resources are resources that move along an assigned path network and may transport entities between locations as a forklift would. They may also need to process entities at several locations, such as an operator performing tasks at more than one location. For these reasons, it is usually preferable to model the resource's movement using a path network. Defined properly, the resource will travel along the path network during the simulation run.

**How to create a dynamic resource:**

1. Create a path network using the Path Network Editor.
2. Select **Resources** from the **Build** menu. This automatically brings up the Resources edit table and the Resource Graphics window, which are used together to define all resources in the model.
4. Click the **Specs...** button to open the Specifications Dialog.
5. Assign a path network to the resource.
6. If desired, place units of the resource on the layout by selecting the Add button in the Resource Graphics window and clicking on the layout. Every time you create and place a resource graphic on the layout for the same resource in the edit table, ProModel creates a new resource point. See “Resource Points” on page 141 for more information.

7. Supply any optional information about the resource including number of units, downtimes, work and/or park searches, and node logic in the Resources edit table.

Please note

Dynamic resources notes:

1. When defining the resource specifications, the default Resource Search for dynamic resources is Closest Resource. The default for Entity Search is Closest Entity.

2. More than one resource can use the same path network.

Multiple Resource Graphics

ProModel allows you to define several different graphic icons for the same resource. For example, you may wish to change the color of a resource whenever it becomes unavailable due to an unscheduled downtime. Resource graphics for dynamic resources may be changed during a simulation by using the GRAPHIC statement (see “Graphic” on page 482) in either the node or downtime logic. The GRAPHIC statement for static resources can only be used in downtime logic, however, any second and third graphics are automatically used when static resources are busy or down, respectively. If no second and third graphics are defined, the resource graphic turns green when in use and red when down.

How to assign multiple graphics to a resource:

1. Select Resources from the Build menu.

2. Highlight the desired resource in the Resources edit table.


4. Click on the next blank resource graphic cell in the Resource Graphics window.

5. Select the desired resource icon.

6. Change the color, rotation, or other aspect of the new graphic by clicking on the Edit button.

An example of a single resource with multiple graphics is given on the following page.

Multiple Resource Graphics Example
This example shows a forklift with two different orientations. You may define as many graphics as needed for each resource.

**Please note**

When changing the graphic for a resource in downtime logic, or in the case of dynamic resources, node logic, the number after the word GRAPHIC refers to the cell number in the Resource Graphics window as shown above. For example, the statement GRAPHIC 2 would change the forklift to the icon in cell number 2. The default graphic is the graphic in cell number 1 if none is specified. See “Graphic” on page 482 for more information.

---

**Multi-Unit Resources vs. Multiple Single-Unit Resources**

**Multi-Unit Resources**

When a resource is defined as having more than one unit, each resource unit is given a numeric suffix by which it is identified in the output report. For example, a resource (Res1) which has five units will display output statistics for resources called Res1.1, Res1.2, . . . . Individual units of a resource (e.g., GET Res1.1) cannot be requested.

Suppose you define a resource, Technician, which has ten units. You also have ten locations and each resource unit can only interface with one location. For example, Technician.5 can only work at Loc5. Since “USE Technician.5” is invalid, you would need to use multiple single-unit resources instead (e.g., Technician1, Technician2, Technician3).

Multi-unit resources are intended for use when several resources are defined with the exact same specifications and any resource can be used at a number of locations. For example, a computer can be operated by one of three technicians. If you did not use multi-unit resources, you would need to specify “USE Technician1 OR Technician2 OR Technician3,” although this can easily be abbreviated by using a macro to represent the resource expression. When you define three units for a single resource, Res1, you can simply state “USE Res1” and one resource unit will be used based on its availability.

**Multiple Single-Unit Resources**

Multiple single-unit resources are useful when resources have different specifications, follow different path networks, or are used at specific locations. If several resources have the same specifications and travel the same path network but can only do work or interface with specific locations, they must be defined as multiple single-unit resources. This is because a unit of a multi-unit resource must be able to interface with all locations where it is called to work.

**Resource Downtimes**

Resource downtimes refer to the times when a resource is unavailable due to scheduled events like breaks and shift changes, or unscheduled events like illness and random failures. For scheduled events, it is much easier and more straightforward to define these downtimes using the Shift Editor (see “Shifts & Breaks” on page 161). Unscheduled downtimes, based on the elapsed time of the simulation clock or resource usage time, are defined in the Resources edit table by clicking on the downtime heading button.
How to define resource downtimes:

1. Select Resources from the Build menu.
2. Select the resource for which the downtime is to be defined.
3. Click the DTs... button from the Resources edit table.
4. Select the downtime basis: Clock or Usage.
5. Enter the required information in either the Clock Downtime or Usage Downtime edit table. Each of these tables is described in the following pages.

Please note

Unlike location downtimes, multiple resource downtimes occurring within the same time frame are processed sequentially, not concurrently. However, through the use of the DTDelay function, concurrent downtimes can be achieved for resources.

Clock-Based Downtime

Clock-based downtimes for resources are specified through the Clock Downtimes edit table shown below. The fields of this table are defined as follows:

Frequency  The time between downtimes. This may be a constant time as shown above, a distribution, or an expression.

First Time  The time of the first downtime occurrence. Leave this field blank if the first occurrence is to be determined from the frequency field.

Priority  The priority of the downtime (0-999). The default priority is 99, which is the highest non-preemptive priority.

Scheduled...  Select YES if the downtime is to be counted as a scheduled downtime. Select NO if the downtime is to be counted as a non-scheduled downtime. (All scheduled downtimes are deducted from the total hours scheduled in the statistical calculations.)

List  A list of the individual units of the resource to be affected by the downtime. You may list individual units of the resource, specify ALL, or leave blank to affect all units.

- 1,2 Units 1 and 2 only
- 1-3,5 Units 1 through 3 and 5 only
- none You may use none to indicate that no unit will adopt this downtime. This is useful in creating a run-time interface. By using a macro to represent the number of units, the user may select none as an option.

- Macro  The name of a run-time interface macro that allows the user to define the units to be affected by the downtime.

Node  This field applies only to dynamic resources and defines the node to which the resource will travel to go down. If no node is entered, the resource stays at the current node. The actual downtime will not begin until the resource arrives at this node. Traveling to the downtime node is counted statistically as time traveling to park.

Logic...  Specific logic to be performed when the downtime begins, typically a WAIT statement. Resources may be used to service resources that are down if the servicing resource is static, or if the servicing resource is dynamic and uses the same network. (See the "Appendix A" on
page 577 for a list of statements valid in Resource Downtime logic.)

**Disable** Select YES to disable a downtime without removing it from the table.

### Usage-Based Downtime

A usage-based downtime is a downtime based on how long a resource has been used, such as how often a forklift needs to be refueled. Usage-based downtimes for resources are specified through the Usage Downtimes edit table shown below. Actual time in use includes any time that a resource is moving with an entity or is being used by an entity at a location. It also includes any time a resource is being used in downtime logic as a maintenance resource. The fields of this table are defined as follows:

<table>
<thead>
<tr>
<th>Frequency</th>
<th>The time between downtimes, based on the usage time of a resource. This may be a time distribution as shown above, or an expression.</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Time</td>
<td>The time of the first downtime occurrence. Leave this field blank if the first occurrence is to be determined from the frequency field.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the downtime (0-999). The default priority is 99, the highest non-preemptive priority.</td>
</tr>
<tr>
<td>List</td>
<td>A list of the individual units of the resource to be affected by the downtime. You may list individual units of the resource, specify ALL, or leave blank to affect all units.</td>
</tr>
<tr>
<td>• 1, 2</td>
<td>Units 1 and 2 only</td>
</tr>
<tr>
<td>• 1-3, 5</td>
<td>Units 1 through 3 and 5 only</td>
</tr>
</tbody>
</table>

**• none** You may use none to indicate that no unit will adopt this downtime. This is useful in creating a run-time interface. By using a macro to represent the number of units, the user may select none as an option.

**• Macro** The name of a run-time interface macro that allows the user to define the units to be affected by the downtime.

**Node** This field applies only to dynamic resources and defines the node to which the resource will travel to go down. If no node is entered, the resource stays at the current node. The actual downtime does not begin until the resource arrives at this node. Traveling to the downtime node is counted statistically as time traveling to park.

**Logic...** Specific logic to be performed when the downtime begins, typically a WAIT statement. Resources may be used to service resources that are down if the servicing resource is static, or if the servicing resource is dynamic and uses the same network. (For a list of statements valid in Resource downtime logic, see the “Appendix A” on page 577).

**Disable** Select YES to disable a downtime without removing it from the table.

### Please note

Usage-based downtimes do not accumulate. For example, if a downtime is preempted by an entity and another downtime is scheduled to occur while processing the entity, only the first downtime resumes after processing the entity. All others are ignored.
Resource Priorities and Preemption

Priorities for resource requests may be assigned through a GET, JOINTLY GET, or USE statement in operation logic, downtime logic, or move logic (or the subroutines called from these logics). Priorities for resource downtimes are assigned in the Priority field of the Clock and Usage downtime edit tables. The following examples illustrate these points.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>Use Res 1,200 For N(3,.1)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>First 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

When an entity using a resource is preempted by either a downtime or another entity, any processing time for the preempted entity due to a WAIT or USE statement is interrupted until the preempting entity or downtime releases the resource. If an entity is using other resources in addition to the one preempted, the other resources remain in possession of the entity.

In the case of a resource downtime preempting another resource downtime, any remaining time delay, as well as any other downtime logic remaining to be processed by the preempted downtime, is immediately discontinued without resuming and the preempting downtime takes over.

Please note

Resource priorities and preemption notes:

1. If a resource is transporting an entity, it cannot be preempted by another entity or by a downtime until it drops off the current entity at the destination location. Therefore, the resource will deliver the current entity and then immediately come under control of the preempting entity or downtime.

2. If a resource is moving but does not possess an entity, the resource can be preempted by a downtime or entity. The resource will stop at the next node in the path network and travel to the downtime node after which the resource will go down.

Resource Shift Downtime Priorities

In ProModel, you define the shift downtime priorities in the Shift Assignments module. The priority for a resource to start a shift downtime and the priority required for some other task to preempt the downtime must be set in the Shift Assignments module.

Although a resource may be in use during a shift downtime, the scheduled hours in the statistics will still reflect the hours scheduled to be on shift. For example, a resource goes off shift after eight hours. Due to an emergency, the resource is called back two hours later to work on a machine that has gone down. The statistics will still indicate that the scheduled hours for the resource are eight when the resource actually spent more than eight hours in use, because the resource was scheduled to work only eight hours. The resource's total usage time, however, will still indicate the additional time spent working on the downed machine.
Resource Preemption Matrix

The following Preemption Matrix shows the possibilities of entities and downtimes preempting each other in the use of a resource. “Current” refers to the entity or downtime in possession of the resource when the requesting entity or downtime attempts to capture it. Downtimes below refer to clock and usage-based downtimes only.

Priority values are divided into ten levels (0 to 99, 100 to 199,..., 900-999), with values beyond 99 used for preempting entities or downtimes of a lower priority level.

<table>
<thead>
<tr>
<th>Requesting Entity or Another Resource or Location’s Downtime</th>
<th>To Preempt The Current Owner</th>
<th>To Preempt The Current Downtime</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requesting Downtime</td>
<td>1 priority level higher</td>
<td>2 priority levels higher</td>
</tr>
<tr>
<td>1 priority level higher</td>
<td>1 priority level higher</td>
<td></td>
</tr>
</tbody>
</table>

- The upper-left quadrant shows that if an entity tries to seize a resource currently owned by another entity (or another resource’s or a location’s downtime), the entity must have a priority at least one level higher than the current entity to preempt the resource.
- The lower-left quadrant shows that a downtime must have a priority at least one level higher than the entity currently owning a resource if the resource is to be preempted.
- The upper-right quadrant shows that an entity must have a priority at least 2 levels higher than the current downtime priority to preempt a downed resource.
- The lower-right quadrant shows that a preempting downtime must have a priority at least one level higher than the current downtime to preempt it.

The following graphics demonstrate basic pre-emption concepts.

**Preemptive DT vs DT**

`DT 1` (Discontinue)

`DT 2`

T1 T2 T3 T4

DT 2 priority at least 1 level higher than DT 1 priority

**Non-preemptive DT vs. DT**

`DT 1`

`Scheduled DT 2`

`Actual DT 2`

T1 T2 T3 T4

DT 2 priority NOT at least 1 level higher than DT 1 priority
Chapter 5: Resources

**Non-preemptive DT vs. Entity**

- DT 2 priority NOT at least 1 level higher than entity 1 priority

**Preemptive Entity vs. Entity**

- Ent 2 priority at least 1 level higher than Ent 1 priority

**Preemptive DT vs. Entity**

- DT priority at least 1 level higher than entity priority

**Preemptive Entity vs. DT**

- Entity priority at least 2 levels higher than DT priority

**Resource Specifications Dialog Box**

The Specifications dialog box contains information for defining the operating characteristics of
each resource in the system. Many of the items pertain only to dynamic resources (i.e., resources with path networks). If the resource is static (i.e., not assigned to a path network) many of the options will be disabled. The Resource Specifications dialog box includes the following fields:

**Path Network**  The name of the path network along which the resource travels. This should be “none” for a static resource.

**Home**  If a path network has been assigned, this is the name of the home node where the resource is positioned at the beginning of the simulation.

**Return Home If Idle**  If a path network has been assigned, check this box to return the resource to the home node when no other tasks are waiting to be performed and no park searches are defined.

**Off Shift**  If the resource is assigned to a path network and shift, this is the node to which the resource travels to go off shift.

**Break**  If the resource is assigned to a path network and shift, this is the node to which the resource travels to go on break.

**Resource Search**  When an entity that needs a resource must select between several available resource units, it follows this rule. This only applies to multi-unit resources. The following rules may be specified:

- Closest Resource
- Least Utilized Resource
- Longest Idle Resource

**Please note**

*For a non-passing path network, only the Closest Resource rule is allowed since the other rules could cause the network to jam. Static resources only allow Least Utilized and Longest Idle rules since there is no traveling to be done.*

**Entity Search**  When two or more entities of equal priority request a resource at the same time, the resource follows this rule to choose the one to service. The resource first checks for any entities waiting at locations listed in a work search before defaulting to this rule and, if an exclusive work search has been defined, the default entity search rule is not used. The following rules may be specified:

- Longest waiting entity (with highest priority)
- Closest entity (with highest priority)
- Entity with the minimum value of a specified attribute
- Entity with the maximum value of a specified attribute

**Please note**

*Entities look for resources to move them after they capture a location. If several entities are*
waiting to be transported to one location by a resource and you want the entity with the minimum attribute value to arrive next at the location, you must use the Locations edit table to define the rule at the location for incoming entities as minimum attribute value. The Closest entity rule applies to dynamic resources only.

If the path network that the dynamic resource is using is time-based, the closest entity is the entity with the least number of nodes from the resource. If the path network is defined by speed and distance, the closest entity is the entity the shortest distance from the resource.

Motion If a path network has been assigned, the motion fields define the speeds and times required for basic resource movement and contain the following information:

- Speed traveling empty/full*
- Acceleration rate*
- Deceleration rate*
- Pickup time
- Deposit time

Please note

Resource specification notes:

1. The units to the side of these fields change automatically from feet to meters (and vice-versa) depending on the default distance units selected in the General Information dialog box.
2. Pickup and deposit times for resources are included as transit time in the output statistics.

Resource Search Routines

Search routines refer to the instructions a dynamic resource will follow after being freed at a path node where a search routine was defined. Two types of search routines may be specified.

Work Search A list of locations where entities may be waiting for the resource. Work searches may be either exclusive or non-exclusive.

- Use exclusive work searches to limit the locations a resource may search for work. An exclusive work search will cause the resource to search only the locations in the list. If no work is found at any of the listed locations, the resource will either park at a node listed in its park search, go to its home node, or simply become idle until work is available at one of the locations in the exclusive work search list.
- Use non-exclusive work searches to have a resource check for work at certain locations first, and then move on to others. A non-exclusive work search will cause the resource to search the listed locations first and then resort to the default search rule listed in the Resource Search section of the Specifications dialog box (e.g., oldest waiting entity, closest waiting entity).

Park Search Park searches are typically used to get a resource off a main path segment, or send the resource to the next most likely place work will become available. A park search is a list of nodes to which a resource may be sent to park if no work is waiting at either the work or default search locations.
Please note

_A lockup can occur in the model if you define a park search at the home node and specify Return Home If Idle in the Resource Specifications._

Work Search Edit Table

Work searches are defined for dynamic resources through the Work Search edit table shown below. If several resources share the same path network, each resource must have its own work search defined (i.e., resources cannot share work searches).

<table>
<thead>
<tr>
<th>Work Search for Forklift</th>
<th>Location List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>Type</td>
</tr>
<tr>
<td>N3</td>
<td>Non-Exclusive</td>
</tr>
<tr>
<td>N4</td>
<td>Non-Exclusive</td>
</tr>
<tr>
<td>N5</td>
<td>Non-Exclusive</td>
</tr>
<tr>
<td>N6</td>
<td>Non-Exclusive</td>
</tr>
<tr>
<td>N7</td>
<td>Non-Exclusive</td>
</tr>
<tr>
<td>N8</td>
<td>Non-Exclusive</td>
</tr>
</tbody>
</table>

The fields of the Work Search edit table are defined as follows:

Node  The node for which the work search is defined.

Type  Exclusive or non-exclusive work search. See “Resource Search Routines” on page 138 for an explanation of exclusive and non-exclusive work searches.

Location List  A list of locations to be searched for waiting entities when the resource becomes available.

In the edit table above, work searches have been defined at each location where the forklift delivers entities. The purpose of the work search in this example is to force the forklifts to give priority to entities waiting to be delivered to processing locations before taking an entity to a non-processing location. This helps to keep the processing locations busy at all times.

Park Search Edit Table

Park searches are defined for dynamic resources through the Park Search edit table shown next. If several resources share the same path network, each resource must have its own park search defined (i.e., resources cannot share park searches).

<table>
<thead>
<tr>
<th>Park Search for Forklift</th>
<th>Parking Node List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>Parking Node List</td>
</tr>
<tr>
<td>N3</td>
<td>N4</td>
</tr>
<tr>
<td>N5</td>
<td>N1</td>
</tr>
<tr>
<td>N6</td>
<td>N7</td>
</tr>
</tbody>
</table>

The fields of the Park Search edit table are defined as follows:

Node  The node for which the park search is defined.

Parking Node List  A list of nodes to which a resource may be sent to park. The resource will look for available capacity at the first node in the list (Node capacity is defined in the Path Networks edit table in the Nodes window). If there is no capacity at that node, the resource will look to the second node in the list and so on until a node with capacity is found. If no capacity is found at any node in the list, the resource will remain where it is until capacity becomes available at one of the nodes in the list.

In the table above, a park search has been defined for each of the internal path nodes where a forklift might deliver an entity and then be in the way if it has nothing else to do. Specifically, if a forklift makes a delivery and then becomes available at node N3, it will park at node N4. From node N5 it will park at node N1, and from node N6 it will park at node N7.
**Node Logic Editor**

The Node Logic edit table is used to define special logic for a dynamic resource to perform upon entering or exiting a node. Node logic may be defined for any dynamic resource at any node. Typical uses of node logic are:

- Changing a resource graphic using the GRAPHIC statement
- Controlling traffic using WAIT UNTIL statements
- Gathering special statistics on resource movement

The fields of the Node Logic edit table are defined as follows:

<table>
<thead>
<tr>
<th>Node</th>
<th>Entry Logic</th>
<th>Exit Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>N2</td>
<td>IF LASTq = 3 THEN GOWAIT</td>
<td>IF NEXTq = 5 THEN GO</td>
</tr>
<tr>
<td>N4</td>
<td>IF LASTq = 3 THEN</td>
<td></td>
</tr>
</tbody>
</table>

The table above was taken from the example contained on the following pages.

**Node Logic Example**

Suppose that for safety considerations we desire to keep track of the number of times both forklifts simultaneously enter a particular zone of the network consisting of branches N2 to N3, N3 to N4, and N3 to N5. (It is thought that this zone may be particularly susceptible to accidents due to heavy traffic.) We could accomplish this using node logic at the entry and exit points of the zone.

The only way to enter or exit the zone is through nodes N2 and N5. To track the number of forklifts currently in the zone, we increment and decrement a variable called Current. Each time a forklift leaves node N2 or N5 en-route to node N3 we increment variable Current. Each time a forklift enters node N2 or N5 enroute from N3 we decrement variable Current. Finally, each time we increment the variable Current, we check to see if Current > 1. If so, we increment a second variable called Total to record an occurrence of both forklifts in the zone at the same time.

The following windows show the entry and exit logic for node N2, representing one entry to the
Please note

This example follows the rule that allows the LAST() function to be used only in Node Entry Logic, while the NEXT() function may be used only in Node Exit Logic. (See “Resource-Specific System Functions” on page 425).

Resource Points

For a static resource, resource points are the layout coordinates of the resource graphics. For dynamic resources, resource points are auxiliary points where multiple resources may appear graphically when in use or parked at a multi-capacity node. When a resource arrives at a node, it will appear on that node unless a resource point is defined for that resource at that node. The resource will appear on the resource point when it arrives to park or perform a task at a particular node. Resource points prevent resources from appearing on top of each other. In the case of dynamic resources, resource points are defined in terms of an offset from the node to which they are connected. Resource points are defined in terms of an offset from the upper left corner of the layout for static resources.

The following Resource Points edit table shows that node N8 has two resource points attached to it. The horizontal offset is 0 units for each point. The vertical offset is 13 units both up and down from the node position. (For resource points positive distances are up and to the right.)

Whenever a forklift arrives or parks at node N8, it will automatically go to one of the two resource points. This prevents the forklifts from graphically appearing on top of each other if they are both at node N8 simultaneously.

How to add resource points to a node:

1. Select Resources from the Build menu.
2. Click on the resource points heading button, Pts....
3. Click on the node for which a resource point is to be added.
4. Click on the layout where the resource point is to appear.
5. Repeat steps 3 and 4 for each resource point to be added.

Please note

Resource points are automatically added to the home node for each resource graphic placed on the layout.
How to delete resource points:

1. Bring up the Resource Points edit table by clicking on the Pts... heading button in the Resources edit table.
2. Select the point to be deleted by highlighting the edit table record or clicking on the resource point in the layout. (If you click on the point to select it, you must then reactivate the Resource Points window by clicking on the title bar of the table.)
3. Select **Delete** from the **Edit** menu.

How to move resource points:

1. Bring up the Resource Points edit table by clicking on the Pts... heading button from the Resources edit table.
2. Drag the resource point to a new location with the mouse.
Processing

Processing defines the routing of entities through the system and the operations that take place at each location they enter. Once entities have entered the system, as defined in the Arrivals table, processing specifies everything that happens to them until they exit the system.

Processing is defined in the Processing Editor, which is accessed through the Build menu. This section first describes how to create simple processes, then explains each feature of the Processing Editor.

How to create and edit process routings:

• Select Processing from the Build menu.

or...

• Right click on the existing process routing and select Edit.

Using the Processing Editor

This discussion covers the procedures used to define operations and routings using the Processing Editor. As with most other procedures in ProModel, they may be performed graphically using the mouse, or manually by typing the information directly in the edit tables.

Before you begin to specify the processing logic, define all locations and entities to be referenced in the processing. This is done through the Location and Entity Editors. If you reference a location or an entity that has not yet been defined in a location or entity field, you will be prompted to add that location or entity to the respective location or entity list. However, no graphic gets automatically assigned to the location or entity.

The easiest way to define the processing logic is to define the routing or flow sequence using the tools in the Processing Tools window, which appears in the lower left corner of the Processing Editor. These tools have been designed to allow you to easily and rapidly define the flow of entities through the system. It is also a good idea to define the routing rule for each routing as it is created. Once you have defined the from-to relationships between locations for each entity, fill in the details of the operation and move logic for each location. This is typically done by typing the logic in the operation or move logic column manually or by using the Logic Builder, documented at the end of this section.

Defining processes graphically in ProModel requires interaction with all four process editing windows.

• Process Edit Table
• Routing Edit Table
• Tools Window
• Layout Window
Before discussing the procedures for using these windows interactively, let us look briefly at a process flowchart of a simple model.

**Example Model**

Two entity types, EntA and EntB, arrive at Locations 1A and 1B, respectively, according to some specified arrival logic. After a short preparation time, both entities are routed to Location 2 where 1 EntB is joined to 1 EntA. At this point the resulting entity, EntC, is sent to Location 3 for consolidation. Twelve EntC's are accumulated at Location 3 and processed together for 3.0 minutes. Then they exit the system.

In the flowchart above, each block represents a process record for an entity at a location. The lower left portion of a block specifies the operation(s) performed on the entity at the location. The lower right portion of the block represents the number of entities output to the next location.

**Defining Entity Processing**

**How to define entity processing graphically:**

1. Select an entity from the entity list in the Tools window. The selected entity will appear in the edit field at the top of the list—this entity will come into the location, it is not the entity that results from the process.

2. Select the desired editing mode: New Process or Add Routing.

3. Click on the first location where the entity will process. A rubber-banding routing line appears. If you select Add Routing, the rubber-banding routing arrow automatically appears from the current location.

4. To choose a different entity as the output entity, select the desired output entity in the tools window.

5. Click the destination location.

**Please note**

*In the example below, we first clicked on Loc1A and then on Loc2. The records in the Process and Routing edit tables were entered automatically.*

6. Repeat this process until the flow of entities has been completely defined except for exiting the system.

7. From the final processing location route an entity to Exit by clicking on the “Route to Exit” button in the Tools window.
8. Once all routings have been defined, enter the processing logic in the operation field of the Process edit table.

The figure above shows the completed routings for the example model. Note that the operations (for example, Join 1 EntB) have been entered manually in the operation column. These operations could also have been entered by way of the Logic Builder, documented at the end of this section.

Processing Editor

The Processing Editor consists of four windows that appear simultaneously, as shown in the following diagram. Although the windows are shown in their default arrangement, you may arrange them as desired.

- **Process Edit Table** Appears in the upper left corner of the workspace and defines the operations performed for all entities at all locations.
- **Routing Edit Table** Appears in the upper right corner of the workspace and controls the destination of entities that have finished at the location.
- **Tools Window** Appears in the lower left corner of the workspace and is used for graphically defining operations and routings.
- **Layout Window** Appears in the lower right corner of the workspace and shows each location with all from-to routings.

Process Edit Table

The Process edit table is used to create operation logic for each entity type at each location in the system. Processes for entities at locations may be in any order in the edit table, but for the sake of organization you should group them by entity type or location. The only time the order of processes is significant is when the same entity is routed multiple times through the same location, in which case, later processes must appear some-
where after earlier processes. When searching for the next process, ProModel always searches forward in the process list first, and then starts from the beginning of the list.

An explanation of each field of the Process edit table is contained on the following pages.

**Entity**  The entity type for which the process is defined. If all entities at the same location undergo the same operation or have the same routing, the reserved word ALL may be entered in this field. (See discussion on ALL later in this section.) If an entity not previously defined is entered in this field, ProModel will ask if it should create the new entity type.

Click on the heading button to bring up the Entities selection box. If this is a preemption process record, check the box (see “Preemption Process Logic” on page 292) and double click on an entity to automatically place it in the table. You can also click on an entity name and select OK to place it in the table.

The entity list box defaults to the current field entity, the last entity selected, or the first entity defined.

**Location**  The location where the process occurs.

Click on the heading button to bring up the Locations selection box from which you may choose a location.

The location list box defaults to the current location, the last location selected, or the first location defined.

Specifying ALL in the Location field and omitting any routing defines a process for an entity at all locations previously specified as routing destinations for the entity. Because there is no routing,
after the entity finishes that process, ProModel will search ahead in the Process edit table for a process for the entity specific to the actual location. The keyword ALL in the Location field is particularly useful when entities route to different locations having the same operations and then route to a common destination. In most other instances, it is recommended that a subroutine or macro be used to define identical operations.

**Operation** Operation logic is optional, but typically contains at least a WAIT statement for the amount of time the entity should spend at the location. If the entity needs a resource to process or to be combined in some way with other entities, that would be specified here as well. In fact, anything that needs to happen to the entity at the location should be specified here, except for any information specified in the entity's routing.

Statements can be typed directly into the operation field, or inside a larger logic window after double clicking in the field or clicking on the Operation button. Alternatively, the Logic Builder can help build logic and is accessed by clicking the right mouse button inside the operation field or logic window. All of the statements, functions, and distributions available in the operation field are discussed in detail, including examples, in “Statements and Functions” on page 429.

Each entity performs the operation steps defined for it at a particular location, independent of other operations performed on other entities at the same location.

For more information see “Operation Logic” on page 291.

**Using the “ALL” Entity Type**

The reserved word ALL may be entered as the processing entity if all entity types at that location have the same operation. ALL may also be used in the output field of the routing if all entity types at that location have the same routing. If a process record for a location using ALL as the entity follows several process records for the same location using specific entity names, and each process record has a defined routing, the ALL process is interpreted to mean ALL of the rest of the entities. The following examples show how ALL may be used in different situations.

1. **All entities have a common operation and a common routing.**

To define a common operation and routing for all entity types at a location, simply enter ALL for both the process entity name and the output entity name.

In the following example three entity types, EntA, EntB, and EntC, are all sent to a packing station for packaging. The packing time is .5 minutes and the entities move on to a shipping sta-
tion. Though this is a simple example, it shows how one process and routing record is used for all entity types. In contrast, the previous operations at Loc1, Loc2, and Loc3 require separate process and routing records for EntA, EntB, and EntC.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT N(5, .3)</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc2</td>
<td>WAIT U(3, .2)</td>
</tr>
<tr>
<td>EntC</td>
<td>Loc3</td>
<td>WAIT T(3,5,9)</td>
</tr>
<tr>
<td>ALL</td>
<td>Packaging</td>
<td>WAIT .5</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Packaging</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>EntB</td>
<td>Packaging</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>EntC</td>
<td>Packaging</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>ALL</td>
<td>Shipping</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

2. **All entities have common operations but individual routings.**

To define common operations but individual routings, use ALL as the process entity and define the common process, but do not define any routings. Then define individual processes for each entity type at the common location, with a blank operation field and the desired routing.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Packaging</td>
<td>WAIT .5</td>
</tr>
<tr>
<td>EntA</td>
<td>Packaging</td>
<td></td>
</tr>
<tr>
<td>EntB</td>
<td>Packaging</td>
<td></td>
</tr>
<tr>
<td>EntC</td>
<td>Packaging</td>
<td></td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALL</td>
<td>Loc(Att1)</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

If only the destination is different, but move times and output quantities are identical, an alternative method is to assign each entity an attribute that corresponds to the destination's name-index number and then route with the LOC() function as shown in the following example.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Packaging</td>
<td>WAIT .5</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALL</td>
<td>Loc(Att1)</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

3. **All entities have a common routing but individual operations.**

To define individual operations along with a common routing for all entity types at a location, define operations for each entity, but do not define any routings. Then define a process record for ALL at this location and define the common routing for all entity types.
Alternatively, you can assign an attribute to each entity which represents the processing time or some other entity-specific parameter. Then use the attribute as the processing time, or call a subroutine and pass the attribute as a parameter for entity-specific processing.

In the following example, the test time for each entity type is different. This time is stored in an attribute, Oper_Time. The attribute is then listed on a line in the operation logic (with a WAIT statement) to signify an operation time. Once the test time for each entity is completed, the entities are all routed to a packaging location.

### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT .4</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc1</td>
<td>WAIT .5</td>
</tr>
<tr>
<td>EntC</td>
<td>Loc1</td>
<td>WAIT .6</td>
</tr>
<tr>
<td>ALL</td>
<td>Loc1</td>
<td></td>
</tr>
</tbody>
</table>

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALL</td>
<td>Packaging</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

Another situation that does not require routing is when an entity changes its name at a location after a RENAME AS or SPLIT AS statement. Any time during processing logic that an entity changes its name, ProModel searches forward in the Process edit table until it finds a process for the new name at the same location. For example, if the identity of an entity is changed through a RENAME AS statement in the operation logic, then no routing block will apply to the old entity. Instead, the newly named entity will be routed by the process for the new name. (See “Rename” on page 531).

The fields of the Routing edit table are as follows:

**Blk**  This field contains the block number for the current routing block. A routing block consists of one or more alternative routings from which one is selected based on the block rule (e.g., a list of routings where one is selected based on the most available capacity). Since all of the routings using the same rule are part of the same block, only the first line of each routing block contains a
route block number. If no routing blocks have been referenced explicitly in the operation logic (for example “ROUTE n”), all routing blocks will be executed in sequence upon completion of the operation logic (See “Route” on page 542). Multiple routing blocks are processed sequentially with the next block being processed when all of the entities in the previous block have begun executing any move logic defined. To change the routing block number or add a new routing block, see the discussion on the Routing Rule dialog box later in this section.

The following example shows a process record with two separate routing blocks. Note that both routings will execute upon completion of the operation time because no ROUTE statement has been specified. One EntB gets routed to Loc2 and one EntC gets routed to Loc3.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT N(5,3)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntB</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>2</td>
<td>EntC</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td>MOVE FOR 2</td>
</tr>
</tbody>
</table>

Output  If a routing is defined, the name of the entity resulting from the operation must be entered here. This name may be the same as the entity that entered, or it may be another name, or even several names, each on a different line.

Using another name works much like a RENAME-AS statement, except that the entity is routed according to the routing block instead of being processed further at the same location. Using several names on different lines is similar to having a SPLIT AS statement in conjunction with a RENAME-AS statement. The difference is that multiple routing blocks are processed sequentially while split entities get processed concurrently.

If the reserved word ALL was used as the incoming entity type for this process, it may also be entered here. Otherwise, every entity entering the location will change to the specified output entity. (See the discussion on using ALL in the Entities section.)

The entity list box defaults to the current field entity, the last entity selected, or the first entity defined.

To better anticipate the entity entry likely to be made, the entity highlighted in the list box defaults first to the current field entity, then to the last entity selected, and finally to the first entity defined.

The example below shows how an incoming entity, EntA, changes identity and becomes an EntB upon exiting location Loc1. This is done by simply specifying the new entity name as the output entity.
Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT T(2,5,8)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntB</td>
<td>Loc2</td>
<td>FIRST</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

Destination  This is the location to which entities are to move after the operation is complete. Optionally, the destination may be followed by a comma and a routing priority. If no priority is specified, the default is zero.

The location name may be typed directly in the field, or selected by either clicking in the field and then on the heading button, or double clicking in the field. The resulting dialog box looks like this:

Instead of entering a location name, you may use the LOC() function which returns the location name corresponding to the index designated by an expression. For example, LOC(5) routes to the fifth location defined or the fifth record in the location edit table. You can also specify variable destinations such as LOC(Att4). However, the LOC() function may not be used in conjunction with the BY TURN, UNTIL FULL, CON-

Rule  This field defines the rule for selecting the route destination. An output quantity may also be specified as part of the rule. This quantity works much like the SPLIT AS statement. (See the following discussion on the Routing Rule dialog box.) To open the Routing Rule Dialog box, double click in the field or click in the field and then on the heading button.

Move Logic  The Move Logic window allows you to define the method of movement as well as any other logic to be executed between the time the next location is claimed for routing to the time the entity arrives, but not yet enters, the next location. To open the Move Logic window, double click in the field or click the heading button. This window allows you to manually edit the logic or click on the Build button to use the Logic Builder. It also provides other convenient buttons for editing and printing the move logic. For single move statements it is easiest to right click in the move field to open the Logic Builder. If left blank, it is assumed that no time, resources, or path networks are needed to make the move. (See “Routing Move Logic” on page 153.)

Routing Rule Dialog Box  The Routing Rule dialog box provides methods for selecting an entity's destination after finishing a process. The Rule heading button in the Routing edit table, brings up the Routing Rule dialog
The fields of this dialog box are defined in the following example.

**Start new block** Check this box to signal the beginning of a new routing block. Checking this box will place a number in the Blk field for that record.

**New Entity Check Box** In order to let you designate whether a routing block applies to the main entity or if you wish to create a new entity, ProModel includes a New Entity check box in the routing rule dialog. By default, ProModel does not check the first routing block for a process record but does check subsequent blocks unless they share the same input and output name. If you check the New Entity box, an asterisk (*) appears after the block number in the block column of the routing table.

If you check the new entity box, the entity using the routing block will begin routing with new cost and time statistics. If the new entity box remains unchecked, ProModel assumes the entity routing from this block is a main entity (the parent entity), carrying with it all cost and time statistics.

If the new entity field remains unchecked and you enter a quantity field value greater than 1, ProModel behaves just as it does with a SPLIT AS statement, dividing the cost statistics between the split members and resetting all time statistics to zero.

### Please note

*A run-time error occurs if you fail to route one (and only one) main entity for a process. If no routing block executes for the main entity, a “No routing defined for main entity” error occurs. If more than one route block executes for the main entity, a “Main entity already routed” error occurs.*

**Quantity** The number of entities resulting from this routing block. The default is one. Several entities of the same name can be created from a single entity, much like a split AS statement, by entering a number greater than one. Each of the new entities then processes the routing block one entity at a time. For example, suppose an entity called mail_bag enters a location and is separated into 30 individual pieces of mail, called Letters. Enter 30 as the quantity and Letter as the output entity, as in the example below. Only the first line in a routing block can specify a quantity.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>mail_bag</td>
<td>Loc1</td>
<td>WAIT T(2,5,8)</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Letter</td>
<td>Loc2</td>
<td>FIRST 10</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

**Routing Rules** Choose the rule for selecting the next location. Only one rule may be chosen for each routing line. Note that the last three routing rules, alternate, backup and dependent, may not be chosen as the start of a new routing block.
Note also that no more than one of the other rules can appear in a single block (e.g., you cannot mix a First Available rule and a Most Available rule in the same block).

For exact syntax and examples of each routing rule, see “Routing Rules” on page 405.

**Routing Move Logic**

The Move Logic window allows you to define the method of movement as well as any other logic to be executed prior to or after the move actually takes place.

Once the route condition or rule has been satisfied for allowing an entity to route to a particular location, the move logic is immediately executed. The entity does not actually leave the current location until a move related statement (MOVE FOR, MOVE ON, MOVE WITH) is executed or the move logic is completed, whichever happens first. This allows the entity to get one or more resources, wait additional time, or wait until a condition is satisfied before actually leaving the location.

Any statements encountered in the move logic after the move related statement are executed after the move is complete but before the entity actually enters the next location. This is often useful for freeing multiple resources that may have been used to transport the entity.

When defining exit logic, such as incrementing a variable used to track the number of exits from a location, it can generally go before the move statement unless a MOVE WITH statement is used and the entity must capture the resource before making the move. In this situation, a GET statement should be specified first to get the resource. Then the exit logic may be specified followed by the MOVE WITH statement.

Any delay occurring as a result of move logic is reported as part of the entity’s move time. For more information on “Routing Move Logic” on page 153.

**Processing Tools**

The Tools window provides graphical aids that may be used to define processing records and routing records. It is also used to define the graphical paths that entities follow when moving without a path network between locations.

The Tools window, which appears along with the other Processing windows, can define processing in one of two modes, New Process or Add Routing. Each is explained next. Additionally, Find Process Mode is available. To select a mode, click on the desired button. Each of the modes is described on the next page.

In addition to option buttons (New Process, Add Routing, or Find Process) for the process editing mode, the Tools window contains a list of defined entities as well as the reserved word ALL to represent all entity types. The entity in Processing Tools applies to either the process or routing...
entity, depending on what is currently being defined.

**New Process Mode**

New Process Mode is used to create a new process record. A new process is automatically created for the selected entity each time you click on a location.

This mode should be used if you want to create a process for a particular entity at a location. You may even create multiple processes for the same entity and location if you want to re-route an entity through the same location more than once for additional operations. Once a new process is created, the mode automatically changes to Add Routing mode to enable a routing to be defined for the process.

**How to define a new process using the Tools window:**

1. Depress the New Process button.
2. Select the entity for which a new process is to be defined from the Tools window.
3. Click on the location where the entity will be processed in the layout window. A new process record is created in the edit table. The mode is automatically switched to Add Routing mode and a rubber banding line appears that connects the mouse pointer to the location.
4. If a different entity is to be output from the process, select it from the Tools window.
5. Click on the destination location. A new routing record appears in the edit table and the mode switches back to New Process mode.

---

**How to delete a process or routing record:**

1. Click inside the desired record in the Process or Routing edit table.
2. Select Delete from the Edit menu.

---

**Editing a Routing Path**

Once a routing path has been defined you may edit the path (regardless of the current mode) by clicking anywhere on the routing path. This selects the path and allows you to change the source or destination of the routing by dragging the beginning or end of the path to a new location. It also allows you to move any intermediate joint in the path to change the shape. You may also click on a path with the right mouse button to create or delete a joint.

If a process is already defined and a location is moved while in the Location module, the connecting leg of any routing lines will also move.

**Add Routing Mode**

Add Routing Mode is used to create multiple routings for a single process record. Suppose an entity, EntA, can travel to one of three locations depending on which is available first. Selecting the New Process mode and then defining the entity process causes the entity to travel from one location to another location. Selecting Add Routing mode afterwards allows you to define a different destination location within the same routing block.
How to add additional routings to an existing routing block:

1. Select the process record in the Process edit table that needs an additional routing line (you may use the Find Process button to locate the process record).
2. If you wish to insert the routing record rather than simply append the record to the current routing list, highlight the routing record where the routing is to be inserted and choose Insert from the Edit menu.
3. Select the Add Routing button from the Tools window. A rubber-banding line is created.
4. Select the entity in the Tools window to be output in this routing.
5. Click on the desired destination location. This creates a new routing record in the Routing edit table.

Please note

To cancel a routing once a rubber-banding line appears, click on the New Process button or click on the originating location.

How to route a current entity to exit:

1. Click the Add Routing button.
2. From the Tools window, select the entity for which you want to define a new process.
3. Click the Locations button in the process record dialog and select the location from which the entity will exit the system. ProModel creates a new process record in the edit table and displays a rubber-banding line from the selected location.
4. Add joints as needed to define the exit path.
5. Click the Route to Exit button in the tools dialog.

Find Process Mode

To find a previously created process for an entity type at a certain location, use Find Process mode.

How to find a process for an entity at a location:

1. Click on the Find Process button.
2. Click on the desired entity type.
3. Click on the desired location. The first process found for that entity type at the location will be highlighted in the Edit window.

This option always searches forward in the process list. By clearing the entity field in the tools window, the next process for any entity at the location selected is found. If multiple process records exist for the same entity and location, the edit table indexes forward to the next process record each time you click on the location.

View Routing

The View Routing button in the Processing Tools window causes the process record currently highlighted in the edit table to become centered on the layout.

Snap Lines to Border

When you check this option, ProModel snaps the routing lines to the location’s bounding area rather than a specific position on the graphic.

Show Only Current Entity

When you highlight an entity in the list box, checking this option will show only those routings associated with the entity.
Chapter 5: Arrivals

Any time new entities are introduced into the system, it is called an arrival. An arrival record is defined by specifying the following information:

- Number of new entities per arrival
- Frequency of the arrivals
- Location of the arrival
- Time of the first arrival
- Total occurrences of the arrival

Any quantity of any entity type can be defined as an arrival for a location. The frequency of arrivals can be defined as either a distribution or as an arrival pattern which cyclically repeats over time.

How to edit arrivals

- Select Arrivals from the Build menu.

Arrivals Editor

The Arrivals Editor consists of three windows that appear on the screen together. The Arrivals edit table contains the specifications of each arrival to the system and appears across the top of the screen. The Tools window contains tools for defining arrivals graphically and appears at the bottom left corner of the screen. The Layout window appears in the lower right corner of the workspace.

Arrivals Edit Table

The Arrivals edit table lists all scheduled entity arrivals to the system. The various fields are explained next.

**Entity**

The name of the arriving entity.

**Location**

The name of the location where the entity is to arrive.

**Qty each...**

The number (1 to 999999) of entities to arrive at each arrival time interval. Any valid expression may be entered here except for attributes and non-general system functions. This field is evaluated throughout the simulation run and will change if the result of the expression changes.
To fill a location to capacity at every arrival time, use the keyword INFINITE, abbreviated INF.

If you have previously created an arrival cycle and want to use it for this arrival, enter the name of the arrival cycle followed optionally by a quantity. You may also click on the Qty each... heading button to select from the list of defined cycles. See the section on Arrival Cycles for more information about defining cycles.

**First Time**  This option allows you to dynamically vary the time of the first arrival to your model. You may define scheduled arrivals to occur at given intervals (e.g., appointments) or use an arrival cycle to define random arrivals over a period of time (this value is the start time for the first cycle). ProModel evaluates this field only at the beginning of the simulation.

**Occurrences** The number of times per simulation run that ProModel will generate arrivals (1 - 999999). Entering the reserved word INFINITE (abbreviated INF) will cause ProModel to send the specified number of arrivals at every arrival time without limit. This value may be any expression and is evaluated only at the beginning of the simulation. If an arrival cycle is used, this is the number of times to repeat the cycle.

**Frequency** The inter-arrival time or time between arrivals. Any valid expression may be entered here except for attributes and non-general system functions. If an arrival cycle was entered for the arrival quantity, this is the time between the start of each cycle. This field is evaluated throughout the simulation run and will change if the result of the expression changes.

**Logic**  This field defines any optional arrival logic, consisting of one or more general statements, to be executed by each entity upon its arrival (e.g., assigning attribute values to entities as they arrive). Double-click inside this field or click the logic button at the top of the column to define logic for an arrival.

**Disable** Set this field to YES or NO if you want to temporarily disable this arrival without deleting it. This is useful when debugging a model and for verification purposes where you want to follow a single entity through the system.

**Arrivals edit table notes:**

1. When several different entity types are scheduled to arrive at a location simultaneously, they will arrive in the order they are listed in the Arrivals table. To have them alternate their arrivals, enter a 1 in the “Qty each” field and the total entry quantity in the “Occurrences” field.

2. Arrivals defined through an external arrival file will be appended to the arrival list. Therefore, if an external arrival file is the only source of arrivals, the Arrival edit table may be left blank. See the section on External Files for more information on arrival files.

3. If the capacity of the location is insufficient to hold all the arriving entities, the excess entities are destroyed. Therefore, the arrival location should have a capacity at least equal to the “Qty each” in the Arrivals edit table. If more entities are scheduled into the system than are exiting, the arrival location may not have enough capacity to handle all the arrivals.

**Defining Arrivals**

Arrivals may be defined graphically by using the tools in the Tools window, or by manually entering the arrival information directly in the Arrivals edit table.

**How to define arrivals graphically:**

1. Select **Arrivals** from the **Build** menu.
2. Select the desired entity from the Tools window.

![Tools Window](image)

3. Click in the layout window at the location where the entity is to arrive. (You may need to scroll through the layout to bring the desired location into view.)

4. Enter the specifications for the arrival record (e.g., arrival quantity and frequency).

**How to define arrivals manually:**

1. Select **Arrivals** from the **Build** menu.

2. Enter the Entity, Location, and Quantity through either the keyboard or by clicking on the respective heading buttons and choosing the proper information.

3. Enter the First Time, Occurrences, and Frequency using either the keyboard or the statement builder (accessed by right clicking inside the desired field).

4. Enter the time of the first arrival by clicking on the **First Time** button. (See “Independent Arrivals” on page 158 for more information on the First Time dialog.)

5. Click on the **Logic** or **Notes** heading button to enter desired logic or notes.

**Independent Arrivals**

An independent arrival is any arrival assigned to occur at a specific time or at a fixed interval. Independent arrivals include such things as appointments, meeting times, or pickup and delivery times. When defining independent arrivals, remember that simulation can model only *predefined* appointment schedules. This means that dynamically scheduled appointments (e.g., rescheduling return visits to fit into available slots) must take place where you define the appointment schedule.

When defining independent arrivals, you may:

- Define them by elapsed time, day and time, or calendar date.
- Assign them to occur at fixed intervals (e.g., interviews scheduled every fifteen minutes).

**Please note**

*When you define independent arrivals as intervals, the next arrival time is independent of the previous arrival. For example, applicants will arrive for appointments based on the clock time—not the time elapsed since the last arrival.*

- Allow a positive or negative offset to adjust the scheduled time of arrival (e.g., applicants must arrive at least ten minutes prior to their interviews).
- Define a distribution to allow variability from the adjusted arrival time.
- Allow the possibility that an entity will not arrive at all.
- Define specific appointment types for only certain resources or resource types.
How to define independent arrivals:

1. Open the Arrivals module from the Build menu.

2. Click on the Entity button and select the entity type you want to schedule.

3. Click on the Location button and select the location where you want the independent arrival to appear.

4. Click on the Qty Each button and enter the number of entities to arrive at the scheduled time. To model no shows, enter the expression “Rand(1) + <probability of showing>”. For example, if only 90% of applicants show up for scheduled interviews, enter “Rand(1) + .9”

5. Click on the First Time button to open the dialog used to define the independent arrival time for the entity. If you define a block of identical appointments occurring at equal intervals, this is the time of the first appointment in the block. (You may enter the arrival time by elapsed time—since the start of the simulation—by a weekday and time, or by calendar date.)

6. In the offset field, enter any offset you wish to apply to the arrival time. This will direct incoming appointments to arrive earlier (or later) than scheduled. For example, if job applicants are to arrive 10 minutes prior to the time of their appointment, enter “-10”

7. In the variation and offset fields of the First time dialog, enter any optional distribution to define the variation from the adjusted arrival time. Generally, to prevent the arrival from being unrealistically late, you should use a doubly-bound distribution (i.e., uniform, normal, triangular, or beta). The triangular and beta distributions provide the most realistic variation.

Please note

The arrival time must match the time units selected for the simulation run-length. If you defined the elapsed time by calendar date, you must also define the simulation length by calendar date. To edit arrival times, select either day and time or calendar date and click the Edit Arrival Time button.
8. In the Occurrences field of the arrivals edit table, enter the number of times to repeat this appointment definition. (Enter 1 if it will occur only once.)

9. If the number of occurrences you entered is greater than zero, enter a time interval in the frequency field. ProModel assumes this interval to be fixed for each occurrence (if you enter an expression, ProModel evaluates it only once and applies it to each occurrence). The distribution defined in the First Arrival dialog applies it to each occurrence.

10. In the Logic field of the arrivals edit table, enter any attribute assignments you will use to determine the processing of the entity. This might include the resource or appointment type (e.g., interview) and it will be helpful if you define these attributes beforehand.

Arrival Logic

Arrival Logic allows you to perform certain logic as an entity enters the system and is used primarily for assigning initial entity attribute values. Suppose you process three different types of samples at an inspection station and each sample takes either 8, 10, or 12 minutes to test. Fifty percent of the samples take 8 minutes to test, 35% take 10 minutes, and 15% take 12 minutes.

The samples have different processing times depending on the test performed. To differentiate between the different types of samples, we assign an entity attribute called Sample_Type to the samples. We define a discrete, non-cumulative user distribution called Test1 with the following information:

The arrivals logic for the entity called Test1 is as follows:

```
Sample_Type = Test10
```
Shifts & Breaks

Weekly shifts and breaks for locations and resources are defined using the Shift Editor. Shifts and breaks are defined by selecting blocks on a grid divided into days and hours. Once a weekly shift and break schedule have been defined, it may be saved in a shift file with an SFT extension.

How to define a shift:
1. Select Shifts from the Build menu.
2. Select Define from the submenu.

Shift Editor

The Shift Editor window consists of a Main menu button, Quick Access toolbar, Add Work, Add Break and Erase buttons, a Clear All button, the View resolution selection, and a grid representing one week of time.

The remainder of this section describes the Shift Editor interface and the following procedures:
- Adding a block of time to define Work
- Adding a block of time to define a Break
- Editing Work or Break time
- Erasing Work or Break time

Main Menu

The Main menu in the Shift Editor is accessible from the Menu button found at the top left corner of the application.

New Start a new shift file definition. If a shift file is already open, it will be closed. If the shift file was modified, you will be prompted to save the changes before it is closed.

Open Browse to open a shift file for viewing or editing.

Save Saves any changes made to the loaded shift file. If it is a newly defined shift file, the Save As dialog will open.

Save As Save the currently loaded shift file as a different filename.

Recent Shift Files Lists the most recently loaded shift files opened in the Shift Editor.
Quick Access Toolbar
The Quick Access Toolbar is found at the top left of the application and to the right of the Main menu button. The toolbar contains Save, Undo, and Redo buttons.

View Resolution
Work and Break time can be defined down to the nearest 5 minute interval. Other minimum time resolutions can also be used such as 15 minute, 30 minute, and hourly. These are set using the View resolution button.

The view resolution button is a drop down button that gives four choices for setting the minimum time resolution. When a time resolution is selected, the Shift Editor grid will automatically adjust and only allow Work or Break time to be defined to that nearest resolution.

For example, if the View resolution was set to 30 minutes, Work or Break time could only be drawn to the nearest 30 minute period.

Adding, Editing Work and Break Time

Adding Work

1. Click on the Add Work button to designate the drawing mode.
2. Click and begin dragging the mouse from the day and time on the grid the work should begin.
3. Release the mouse button at the day and time the work should end.

Please Note

Work can be added to multiple days simultaneously by dragging the mouse across multiple days.

Adding a Break

1. Click on the Add Break button to designate the drawing mode (or, with the Add Work button selected, press the Ctrl key while dragging the mouse).
2. Click within a defined Work area and begin dragging the mouse from the day and time the Break should begin. Break time cannot be added to an area in the shift where Work is not defined.
3. Release the mouse button at the day and time the Break should end.

Editing Work or Break Time

1. Select the Add Work or Add Break button (or, if adding break time, select the Add Work button and then press the Ctrl key while dragging the mouse).
2. Add Work or Break time to the beginning or end of existing Work or Break time by clicking and dragging the mouse on the grid.
3. Removing Work or Break time is accomplished using the Erase button. (See Erasing Work or Break Time)

Please Note

Break time can be added to multiple days simultaneously by dragging the mouse across multiple days.
Erasing Work or Break Time

1. Select the Erase button (or, with the Add Work button selected, right-click and drag the mouse).
2. Erase Work or Break time by clicking and dragging the mouse on the day and time in the grid where Work or Break time should begin to be removed.
3. Release the mouse at the day and time the Work or Break time should stop being erased.

Shift Assignments

The Shift Assignment module allows you to model everyday, real-life situations involving scheduling and availability issues, and you can easily define logic to control the way your model handles these problems.

If you have an employee that works a split shift, assign two shifts to the resource with the corresponding start times. If you have a processing location that can only be used during specifically scheduled hours, set up a separate shift for that location.

You may have an office or some other operation just starting up, and you need to run a specific shift for the first week and another for two more weeks before going to your full capacity shift schedule. Simply set up three shifts and assign them all to the office in one step, indicating the appropriate start times for each.

If you want to establish a controlled location gateway: Among fulfilling other duties, your employee needs to begin doing something (processing a certain entity at a certain location) at a certain time, so you set up a queue location, a gate location (with a capacity of one), and a processing location. Assign a shift to the gate location so it will come on line at the designated time. Now the gate location begins taking the entities from the queue location and moving them to the processing location, where the employee will be requested at the appropriate priority level.

There are many ways to use shift assignments and shift logic to solve any number of problems in creating a valid model. This chapter explores the features and functionality of the Shift Assignments module, including statements and functions for shift and break logic.

Assigning Shifts

ProModel allows you to can select multiple locations and resources and assign them to a shift in one record. Plus, you can:

- assign a location or resource to multiple shift files with a start time for each shift,
- define off-shift and break priorities, and
- create off-shift and break logic.

The Shift Assignments module allows you to schedule the availability of resources and locations based on shifts and work breaks defined in the Shift Editor. When a location or resource goes off shift or on break, it is off-line or off-duty and is reported in the output statistics as non-scheduled time rather than downtime.

The off-shift and break logic are optional and allow you to control more precisely when a
Chapter 5: Shifts & Breaks

A resource or location may go off shift, on break, and how long before it becomes available again.

When you select Shifts from the Build menu, two options are displayed: Define and Assign. You must define a shift before you can assign a resource or location to it.

How to assign locations and resources to shifts:

1. Select **Shifts** from the **Build** menu, then click on **Assign**. ProModel displays the Shift Assignments edit window shown below.

2. **Select Locations** - Click on the Locations button to display the Select Locations dialog (*shown below*). Click on a location and use the buttons to select or remove it from the Shift Locations list. Double-clicking on a location also selects or removes it. Click **OK** when finished.

3. **Select Resources** - Click on the Resources button to display the Select Resources dialog (*shown next*). Click on a resource and use the buttons to select or remove it from the Shift Resources list. Double-clicking on a resource also selects or removes it. Click **OK** when finished.

4. **Units** Enter the specific units of the selected resource to be assigned to the shift. You may assign one, several, or all units of a resource to a shift. You can also use a macro to specify the units. If left blank, ProModel assigns the default of *All* units to the shift.

   - **1,3** Units 1 and 3 only
   - **1-3,5** Units 1 through 3 and 5 only
   - **All** All units of the resource
   - **None** You may use none to indicate that no unit will adopt this shift. This is useful in
creating a run-time interface. By using a macro to represent the number of units, the user may select none as an option.

**Macro** The name of a run-time interface macro that allows the user to define the units to be affected by the shift.

5. **Select Shift Files** - Click the Shift Files button to display the Select Shift Files dialog (shown next). Click on the Add button to display the File Open dialog and select the shift files you want to use in the model.

![Select Shift Files dialog](Image)

6. **Define Start Times** - Enter the start time for each of the selected shift files. The value will be interpreted according to the time units specified in the General Information dialog unless a unit label is entered after the value (e.g., 10 hr). You can also use a macro to specify the start times. If the Start time is left blank, the shift will begin at the start of the simulation. All shifts specified apply to the locations and resources selected for these shifts in the Shift Assignment record.

During the simulation, the shift with the earliest start time remains in effect for the locations and resources listed until the next start time encountered activates a new shift.

7. **Define Priorities** - Click on the Priorities button. The Priorities button allows you to enter the priorities for going off line due to a break or end-of-shift as well as the priorities of the off-line state in the event that some other activity attempts to bring a particular resource or location back on line. You can also use macros to specify priorities.

![Priorities dialog](Image)

These priorities follow standard ProModel priority level and preemption rules. (See “Locations” on page 90, “Entities” on page 112, and “Resources” on page 126).

- **Priority for Ending Shift** This is the priority for regularly ending the shift. An entity or downtime must have a higher priority level to prevent this location or resource from going off shift at the preset time.

- **Off Shift Priority** This is the priority for the location or resource to stay off shift. In other words, an entity or downtime must have a higher priority level to bring this location or resource back on line before the preset time.

- **Priority for Starting Break** This is the priority for going on break. An entity or downtime must have a higher priority level to prevent this location or resource from going on break at the preset time.

- **Break Priority** This is the priority for staying on break during the break period. In other words, an entity or downtime must have a higher priority level to bring this location or resource back on line before the end of the preset break.
Shift & Break Logic

Shift and break logic are optional and are defined in four distinct logic windows, each executed in a specific sequence throughout the simulation run. You can define logic to control how resources and locations go off line and what happens once they are off-line.

To define shift or break logic, click on the Logic button to display a submenu of four events associated with shifts for which logic may be defined. Selecting an event from the submenu displays a standard logic window. You can enter separate logic for each of these four events to be executed when the event occurs. See the following discussion, Sequence of Events.

You may want to use the Logic Builder to help you enter the logic. Just click on the Build button in the logic window.

Pre-Off Shift or Pre-Break Logic Executed whenever the location or resource is scheduled to go off shift or on break. This occurs before the location or resource is checked for availability, so it is executed regardless of availability. This logic may be used to check certain conditions before actually taking the resource or location off line. The logic is executed for each resource and location listed as members for this shift assignment record. This allows some members to be taken off line while others may be forced to wait. (Pre-off shift and pre-break logic may be referred to in this manual as pre-logic when speaking of either one.)

Off Shift & Break Logic Executed at the instant the location or resource actually goes off line.

How to determine the sequence of events

1. When a location or resource is scheduled to go off line due to a break or the end of a shift, the pre-logic for that particular location or resource is executed.

2. After executing the pre-logic, which may contain conditional (WAIT UNTIL) or time (WAIT) delays, the location or resource is taken off line, assuming it is either available or the priority is high enough for pre-emption.

3. At the instant the location or resource is taken off line, the Off-Shift or Break logic is executed.

4. After executing this logic, the location or resource waits until the time defined in the shift file expires before going back on line.

Please note

If the off-shift and break nodes are not specified in the Resource Specs dialog, the resource will stay at the current node. If no resources or locations are assigned to a shift, the shift is ignored.

Functions and Statements

ProModel uses several functions and statements specifically for shift and break logic: SKIP, PRIORITY, DTLEFT(), FORLOCATION(), and FORRESOURCE(). Following is a brief description of each. For more details, see “Statements and Functions” on page 429.

SKIP If used in pre-logic, it causes the off-shift or break time (including any off-shift or break logic) to be skipped so a location or resource never goes off line. If used in the off-shift or break logic, it causes the off-line time defined in the Shift Editor to be skipped. This allows you to
specify a WAIT statement for the off-line time and SKIP the off-line time defined in the Shift Editor.

**PRIORITY** This statement provides an alternative way to specify off-shift or break priorities. It also allows the priority to be changed after some time being off-shift or on break. If the priority is changed to a value lower than the current value, the system will check to see if any preemption may occur at that time. This statement is *not allowed* in off-shift or break pre-start logic.

**DTLEFT()** This function returns the remaining off-shift time based on when the location or resource is scheduled to go back on shift as defined in the shift file. It may be used in off-shift and break logic to adjust the actual time the location or resource is off-line.

**FORLOCATION()** This function returns TRUE if the member for which the shift or break logic being executed is a location. This may be followed by a test using the LOCATION() function to determine the precise location.

**FORRESOURCE()** This function returns TRUE if the member for which the shift or break logic being executed is a resource. The RESOURCE() function may then be used to determine the precise resource if multiple resources are listed as members.

**RESOURCE()** This returns the name-index number of the resource currently processing the off-shift or break logic.

To illustrate how FORLOCATION() and FORRESOURCE() might be used, consider the following example: Suppose you have locations and resources as members in a shift file assignment and you want to wait until variable *Applications* is equal to zero before allowing a particular resource called *Loan_Officer* to go off shift. You would enter the following pre-off shift logic:

**Pre-off shift logic**

```
IF FORRESOURCE() THEN
    BEGIN
        IF RESOURCE() = Loan_Officer THEN
            BEGIN
                WAIT UNTIL Applications = 0
            END
    END
END
```

In addition to these functions, DTDELAY() may also be called at the beginning of the off-shift or break logic to determine how much time has elapsed between the time the shift downtime was scheduled to start and when it actually started. The length of the shift downtime defined in the shift file would be the sum of DTDELAY() and DTLEFT().

**Preemptions to Off-Shift or Break Logic**

If off-shift or break logic is defined using WAIT or USE statements and happens to get preempted, the logic will resume one statement after the WAIT or USE statement where it was preempted.

**Shift Downtime Principles**

**Locations Shift Downtime Principles**

It is important to understand that when a location or resource goes off shift, it is essentially down. We call this type of downtime a *shift downtime* and it is treated slightly differently from other downtimes. Breaks, which are also part of the shift schedule, are treated exactly like clock-based downtimes. These downtimes are dis-
discussed in “Locations” on page 90 and “Resources” on page 126.

**Shift Downtimes for Locations**

All location shift downtimes have a default priority of 99, the highest non-preemptive priority possible. This means that when a location is scheduled to go off-shift, this downtime will take priority over all other entities with a priority less than 99 waiting for the location. If the location is currently in use, shift downtimes allow the current entity to complete its process at the location. After the entity is finished, the shift downtime proceeds as if it started at its scheduled time. This means that the location becomes available at the start of the next shift regardless of when it actually went off shift. This procedure is demonstrated in the following example.

**Example 1 (a)**

Although the downtime is scheduled to last from time T2 to T4, the actual downtime does not begin until time T3. This is what happens for both locations and resources currently busy when the shift downtime is scheduled to occur.

To preempt a location in which an entity is currently processing, set the priority for going off shift to a number one level higher than the entity’s priority.

**Example 1 (b)**

Since the entity was preempted, the remaining time for the entity to be processed at the location was completed after the location shift downtime was completed.

**Preempting Off-Shift Locations**

An off-shift location may be preempted back into service by an entity. Following the preemption, the shift downtime will resume for any remaining time before the start of the next shift. The following example demonstrates this principle.

**Example 2**

In this example an entity with priority of 200 or greater preempts an off-shift location. The location becomes available to process the entity.
Once processing is complete, the location returns to its off-shift status.

In order for an entity to preempt any location downtime (shift or otherwise), it must have a priority level that is at least 2 levels higher than the downtime's priority. In this example the location shift downtime has a priority level of 99 so the entity must have a priority level of 200 or greater to preempt the shift.

**Overlapping Downtimes**

If a preemptive clock downtime occurs during a shift downtime, the downtimes simply overlap.

**Example 3**

This example shows the effect of a preemptive downtime occurring for a location already off-shift due to a shift downtime. Because location downtimes always overlap, the effect is as if the preemptive downtime never occurred. The location remains off-shift for the total duration of the shift downtime.

The example above could represent the situation where a recurring downtime, such as a lunch or dinner break, has been defined for a single location that is scheduled to be available for a two-shift period. It would be simpler to specify a single downtime for lunch and dinner that occurs once every 8 hours continuously than to define separate downtimes for lunch and dinner. In this case the preempting downtime would represent a meal break occurring while the location was off-shift.

**Resource Downtime Principles**

**Shift Downtimes for Resources**

Resource shift downtimes work exactly like location shift downtimes with the exception that if the off-shift downtime is preempted by some other downtime, the original off-shift downtime never resumes. The following examples show how a resource that is off shift is affected by a preemptive request by another entity (example 1) and by downtime preemption (example 2).

**Example 1**

Suppose a resource, repairman, is off-shift. An important machine goes down unexpectedly. Because this machine is a bottleneck in the opera-
tion, it is vital to repair the machine as quickly as possible. The repairman is called in and takes 30 minutes to fix the machine. The logic for the downtime to call him back is “USE Repairman, 600 FOR 30 min”. This will preempt the shift downtime and use the repairman to repair the machine even though the repairman is off-shift. Once the repairman has repaired the machine, he returns to his shift downtime until he is scheduled to go back on shift. The repairman's shift downtime will end at the originally scheduled time regardless of the fact it was preempted by a repair activity.

Although the shift downtime is scheduled to last from time T1 to T4, the actual downtime lasts from T1 to T2 and then from T3 to T4.

**Example 2**

This example shows the effect of a preemptive downtime occurring for a resource already off-shift due to a shift downtime. Since resource downtimes are not overlapping, as in the case of location downtimes, the shift downtime in progress is discontinued and the preemptive downtime takes control of the resource because it has a priority greater than or equal to five-hundred (remember that a downtime priority needs to be only one level higher than another downtime priority to preempt it). The effect in this example is that the total downtime is actually shorter than it would have been had the original shift downtime been completed.

Although in practice, situations like the example above are unlikely to occur, it is important to understand that the above condition is possible. Typically, preemptive downtimes are due only to some type of location or resource failure, in which case, the downtime occurrence would be based on usage and not clock time. If a preemptive downtime is based on usage, the situation in the example above could not occur because the location or resource would not be in use, and would not accumulate usage time.
General Information

The General Information dialog box allows you to specify basic information about a model, such as its name, default time units, default distance units, and graphic library. You also may specify the model's initialization and termination logic. Finally, a notes window is available for specifying particulars of a model, such as the modeler's name, the revision date, modeling assumptions or anything else about it.

How to open the General Information dialog box:

- Choose General Information from the Build menu.

General Information Dialog Box

The fields of the General Information dialog box are as follows:

Title An optional, brief description of the model. Information will be displayed in the caption bar and included in the model and results files.

Time Units The unit for any time value in the model that does not have an explicitly specified time unit. The smallest unit of time available in ProModel is .00001 second and the largest is 1 day.

Distance Units The units in feet or meters for all distances specified in the model. There is no practical limit on the size of the model.

Model Notes... Brings up a notes window for specifying general notes about the model. Notes are optional and are for user reference only. An alternative way to display notes is using a DIS-PLAY statement (see “Display” on page 457) in the initialization logic.

Graphic Library File Opens a dialog box for selecting the graphic library file to use with the open model. Graphics library files have the extension GLB and are further explained later in this section.

Initialization Logic Opens the Initialization Logic window for specifying initialization logic. An asterisk (*) next to the name of the button means that some initialization logic has been
defined for the model. (See “Initialization Logic” on page 172.)

**Termination Logic** Opens the Termination Logic window for specifying termination logic. An asterisk (*) next to the name of the button means that some termination logic has been defined for the model. (See “Termination Logic” on page 172.)

**Initialization Logic**

Initialization logic allows you to initialize arrays, variables, and other elements at the beginning of a simulation run as shown below:

Other common uses of initialization logic include:

- Reading external files
- Displaying messages
- Prompting for values
- Resetting general read/write files
- Activating independent subroutines that process logic based on a timer. (See “Subroutines” on page 238; also see “Activate” on page 431).

For a discussion of each of the buttons in the Initialization Logic window, see “Editing Logic Windows” on page 72.

**Termination Logic**

Termination logic allows you to summarize data or write special statistics to an output file at the end of a simulation run as shown below:

Other common uses of termination logic include:

- Displaying messages
- Resetting read/write files

See the following page for a discussion on the placement of initialization and termination logic within the sequence of run-time events.

**Please note**

*Although Initialization and Termination logic cannot be tested with the Compile option in the Edit menu, as with Processing or Arrival logic, the logic can be tested by clicking on the compile button in the logic window. ProModel checks all logic automatically upon selecting OK and, if an error in the logic is found, an error message describing the problem will appear.*

**Execution Time of Initialization and Termination Logic**

It is important to understand exactly when initialization and termination logic is executed. When
you select Run from the Simulation menu the following things occur in the order listed:

1. Arrays are initialized based upon the defined Import specifications
2. Variables are initialized to the values specified in the Variables Editor.
3. Macros with a run-time interface are set to their user-specified value.
4. The model is loaded into the simulation module. As the model is loaded, any numeric expressions used to define such things as location capacities or number of resource units are evaluated and assigned a numeric value.
5. Initialization logic is performed.
6. Simulation begins. Initial arrivals and downtimes are scheduled and simulation processes begin.
7. Simulation ends.
8. Termination logic is performed.
9. Statistics are compiled.

Logic elements that figure into a model's structure are evaluated only when the model is loaded into the simulation module. Those logic elements are:

- Simulation warm-up hours
- Simulation run hours
- Node capacity
- Length of path segments
- Resource units
- Location capacity
- Queue length
- Conveyor length
- Conveyor speed

For a complete list of when each field is evaluated, see the “Appendix A” on page 577.

Any variables or arrays used in an expression that change any of these logic elements should be initialized in the Variables Editor, Arrays Import, or run-time interface and not in the initialization logic. The model structure cannot change after the model has been loaded into the simulation module. Thus, any variable or array figuring into a location's capacity and initialized in the initialization logic will be initialized too late to affect the location's capacity.

Variables or arrays which do not figure into a location's capacity may be initialized in the Initialization Logic without any problem. A variable initialized in the initialization logic could be used as the “First Time” for an arrival or downtime occurrence. This is true because arrivals and downtime occurrences are simulation events, and all initialization logic occurs before the first simulation event.

**Graphic Library File**

ProModel allows you to create and store as many graphics libraries as desired. However, only one graphic library may be used for each model. To copy a graphic from one graphic library to another model's graphic library, see “Copying a Graphic from One Library to Another” on page 308.

**How to select the desired graphics library:**

1. Select **Graphic Library File** from the General Information dialog box.
2. Enter the name of the desired graphics library.
3. Select OK.

Please note

*Only files with the extension GLB may be used as graphics libraries. For more information on creating, merging and saving graphics libraries, see “Graphic Editor” on page 304.*
Cost

With ProModel’s costing capability, you can make decisions about your system on a cost basis. Costing dialogs allow you to monitor costs associated with Locations, Entities, and Resources during a model run and the General Statistics Report includes Costing statistics, automatically generated at the start of the simulation.

Cost Dialog Box

Use the Cost Dialog box to define costs for Locations, Entities, and Resources. Fields in the Cost Dialog box vary between Object Types and ProModel evaluates expressions in these fields only during translation at run time. The General Statistics Report includes statistical information automatically generated during run time about cost for locations, entities, and resources.

Object Type  Use this pull-down menu to define costing for the components of the selected object type. Object types include locations, resources, and entities as shown in the following example. All defined model components of the selected type appear in the box below the object type field and ProModel allows you to assign costs to any of these components.

Locations

Operation Rate  This field specifies the cost per unit of time to process entities at the selected location. Cost accrues only while an entity executes a WAIT or USE statement in operation logic. ProModel accepts expressions in this field and evaluates them at translation.

How to use cost

- Choose Cost from the Build menu. The Cost Dialog appears.
With this pull-down menu, you can set the time units for the Operation Rate. Time units may be in seconds, minutes, hours, or days as shown here.

Resources

**Regular Rate** This field specifies the cost per unit of time for a resource used in the model. You can use expressions in this field (evaluated at translation) to set the rate or change it using SetRate. For more information on the SetRate operation statement, see “SetRate” on page 546.

**Per** This pull-down menu allows you to set the time units for the Regular Rate. Times may be in seconds, minutes, hours, or days as shown here.

Cost Per Use This field allows you to define the actual dollar cost accrued each time you use the resource (i.e., the minimum usage cost). The cost per use updates when you obtain the resource and ProModel accepts expressions in this field (evaluated at translation).

Please note

Since ProModel counts a preemption as a use, if you preempt a resource from an entity, the usage cost applies to the resource only when it returns to the entity.

Entities

**Initial Cost** This field allows you to define the initial entity cost for an entity which enters the system through a scheduled arrival, a CREATE statement, or an ORDER statement. ProModel accepts expressions in this field and evaluates them at translation.

Please note

When you implicitly create new entities through a ROUTE statement, ProModel does not add an initial cost to the entity. To add an initial cost, use the INCENTCOST statement. See “IncEntCost” on page 489 for more information.

Building a Model with Costing

When you build a model using the costing feature, you must first define the locations, resources, and entities used in the model. Once you define these model components, you may assign costing information to them through the Cost option in the Build menu. To collect costing information about your model, uncheck the disable costing box from the simulation options dialog of the simulation menu. By default, ProModel
disables costing and sets all defaults to zero. See “Enable or Disable Costing” on page 179.

Please note

The following scenarios assume you defined costs for all model components.

Preemption/Downtime

• If you preempt an entity’s resource, an additional cost per use will apply once you re-acquire the resource. While waiting for the resource to return, the entity does not record operation or resource costs.
• If an entity preempts another entity, the preempted entity continues to record operation time during the entire preemption period. While the preemtping and preempted entities are simultaneously at a location, the location records the cost for both entities. If the preemtping entity obtains a resource, the preempted entity will not record the resource costs during the preemption period.
• If an entity is at a location when a preemtpive downtime occurs, the entity records the downtime as part of its operational costs. This applies to all types of location downtimes, including shifts. The location records the cost of the preempted entity while it remains at the location.
• If an entity’s resource has a downtime which requires the use of another resource, the entity will not record the second resource’s cost. However, the location will record the extra resource’s cost.

Join/Load

• Joined and permanently loaded entities add their costs to their base entities, but not their time statistics.
• Loaded entities do not add their costs or time statistics to their base entities.
• When an UNLOAD occurs, ProModel divides all costs accrued by a loaded entity among the unloaded entities. ProModel adds all other entity statistics calculated during the loaded period to each of the unloaded entities.
• Entities leaving the system that were temporarily loaded onto other entities do NOT report their individual costs, but do report all other statistics. To get the cost of each entity, you must unload the entities before they exit or permanently load them when they are initially loaded using the LOAD PERM statement.

Combine/Group

• Combined entities add their costs to the resultant entity, but not their time statis-
tics. The resultant entity begins with fresh time statistics.
• Grouped entities do not add their costs or statistics to the group shell (a temporary entity representing grouped entities that starts with cost and time statistics of zero).
• When an UNGROUP occurs, ProModel divides all costs accrued by a grouped entity among the ungrouped entities. ProModel copies all other entity statistics calculated during the grouped period to each of the ungrouped entities.
• Entities leaving the system grouped with other entities do NOT report their individual costs, but do report all other statistics. To get the cost of each entity, you must ungroup the entities before they exit.

Special Cost Handling
• As soon as you acquire a resource, it begins to accrue cost.
• Unless obtained in the move logic, ProModel charges the “Cost per use” for a resource to the location that obtained it. Resources obtained in the move logic do not charge a “per use” cost to any location.
• ProModel does not charge any resource time used during move logic to any location.
• ProModel adds initial entity costs defined in the cost module only as entity costs, not location costs.
• If a location uses a resource during a downtime, the location accrues that resource’s cost.
• The USE statement counts as operation and resource cost.
• When you CREATE a new entity, it begins with new time statistics and an initial cost.
• If you RENAME an entity, previous time statistics and costs continue with the entity.
• The SPLIT AS statement divides the cost of the original entity between all entities. Each new entity begins with new time statistics.

Costing Output Statistics
ProModel collects costing statistics only if you uncheck the Disable Cost Statistics option in the Simulation Options menu (see “Enable or Disable Costing” on page 179). Included in the General Statistics Report, ProModel calculates costing statistics.

Locations
• Operational Cost = (Active Operation Time * Rate) + (Any IncLocCost)
• % Operational Cost refers to the location’s percentage of the sum of all operation costs
• Resource Cost = (Utilization * Rate) + (Times Used * Cost per use)

Please note
For Resource Cost, Utilization and Times Used refer to the utilization of a resource while at a location. This applies only to resource use through operation logic.

• % Resource Cost refers to the location’s percentage of the sum of all resource costs
• Total Cost = (Operation Cost + Resource Cost)
• % Total Cost refers to location’s percentage of the sum of all location costs

Resources
• NonUse Cost = (1-% Utilization) * Scheduled Time * Rate
% NonUse Cost refers to the resource’s percentage of the sum of all nonuse costs

Usage Cost = (% Utilization * Scheduled Time * Rate) + (Times Used * Cost per use)

% Usage Cost refers to the resource’s percentage of the sum of all resource usage costs

Total Cost = Usage Cost + NonUse Cost

% Total Cost refers to the resource’s percentage of the sum of all resource costs

Entities

- **Explicit Exits** The number of entities that have explicitly exited. Whenever an entity exits the system, it is an explicit exit except in the following cases:
  - When an entity JOINS, permanently LOADS, or COMBINES with another entity, it implicitly exits the system, and is reported as an exit in the Entity Activity report. However, for costing purposes, the entity did not explicitly exit, but its costing information was added to the entity it was JOINED, permanently LOADS, or COMBINED with.
  - When an entity temporarily LOADS or GROUPS with another entity, and the entire LOADED or GROUPED entity exits the system, the original entity implicitly exits the system, and is reported as an exit in the Entity Activity report. However, for costing purposes, the original entity did not explicitly exit, but its costing information was added to the entire load or group.

- **Total Cost Dollars** Total Cost = cumulative entity cost, or the sum of costs incurred on all locations the entity passed through + the sum of all costs incurred by use of resource + initial cost + any IncEnt-Cost

% Total Cost refers to the entity’s percentage of sum of all entity costs

In the above calculations, the rate defined (per day, hour, minute, and second) converts to the default time units specified in the General Information dialog.

In the above calculations, the rate defined (per day, hour, minute, and second) converts to the default time units specified in the General Information dialog.

Please note

*ProModel does not allow you to generate a Costing Graph. However, if you set a variable equal to GetCost (e.g., Var1=GetCost), you can generate a time series graph to track changing entity costs. See “GetCost()” on page 478 for more information.*

Enable or Disable Costing

To enable the costing feature, be sure that the Disable Cost option in the Simulation Options dialog is not checked.
Tanks

Tanks are simply locations to which ProModel associates a level instead of an entity routing. (As a result, the units and rules fields do not apply to tanks.) Using tanks, you can model the continuous flow of liquids and other substances into and out of tanks or similar vessels. Also, when combined with discrete-event simulation, ProModel’s continuous modeling capability makes it possible to model the exchange between continuous material and discrete entities (e.g., when you place liquid into a container). Other uses include modeling high-rate, discrete part manufacturing systems.

The Tank Submodel

In order to function properly, all tank models should include the tank submodel (TANK-SUB.MOD). The tank submodel contains important subroutines and data elements (arrays and macros) used to simplify tank modeling. Each of these subroutines and data elements has a “Tank_” prefix to help identify it and to prevent any accidental name duplication.

Please note

All user-defined model elements should begin with something other than “Tank_”.

How to define a tank

1. Select the gauge/tank symbol from the Location Graphics window.
2. Click on the layout window where you wish to place the tank and select Create Tank Location from the menu that appears. ProModel places the tank on the layout.

Please note

When you create the first tank in your model, ProModel will display a dialog that allows you to automatically import various subroutines, arrays, macros, and library graphics specific to tanks. If you do not wish to include these new items, you may cancel the action.

3. Enter a capacity (1 to 999999) for the tank in the location capacity field.
4. Define and reference any necessary tank control subroutines.

How to edit a tank or a gauge

1. Double click on the tank or gauge (or right click and select Edit Graphic).
2. From the dialog that appears, make the appropriate changes.
3. Click OK.
How to change between a tank and a gauge

• Double click on the tank or gauge and check or uncheck the tank option.

or...

• Right click on the tank or gauge and select Change Tank to Gauge or Change Gauge to Tank.

In addition to defining a tank graphic, you may add labels and other figures to a tank. For example, you can add a counter to digitally display the fill level of the tank (ProModel rounds the value displayed to the nearest integer). The following are examples of how you can use tanks in ProModel.

Basic Concepts

Since tanks do not process discrete entities, you may not define routings to or from tanks. To control a tank level, ProModel provides predefined subroutines that fill, empty, and transfer tank contents. To monitor tank levels and initiate flows, you must define control subroutines using the Subroutine module. To call these subroutines and operate them independently in the model, use the ACTIVATE statement. For examples of how to use these subroutines, see the discussion at the end of this section. To model tanks effectively, you must understand the following concepts.

Tank Levels

ProModel records tank levels in a pre-defined array called Tank_Level where each element of the array corresponds to each tank location in the location list. For example, the level of TankA is the value of Tank_Level [TankA]. If TankA were the third location in the location list, you could also reference the level of TankA with Tank_Level[3]. For best results, you should control all tank levels using only the pre-defined tank filling and emptying subroutines rather than change the Tank_Level array values directly. This will prevent overfilling or overdrawing and will accurately gather statistics for each tank. For example, calling Tank_Fill (TankA, 500, 30, 0) automatically fills TankA to 500 units at a rate of 30 units per minute. The 0 signifies that the tank will not accept excess material and, as a result, an error message will occur if the tank reaches capacity before the specified amount fills into the tank.
The Flow Time Step

To model continuous flow, ProModel uses a Tank_TimeStep macro. This macro is the time step used when filling/emptying tanks and is an RTI (run-time interface) parameter. Initially, ProModel sets this value to .2 minutes. If you wish to use a different value for the time step, you may change it temporarily (for a particular model) through the Simulation/Parameters menu option, or permanently by changing the macro itself. The larger the time step, the longer the interval between filling and emptying (which speeds up the simulation). For example, suppose you set the time step to .1 minutes. If a tank empties at a rate of 60 gpm, the simulation would actually empty the tank by a discrete amount of 6 gallons every .1 minutes. When filling or emptying a tank, if the remaining quantity doesn't require the full time step, ProModel reduces the time step using a linear interpolation.

Please note

The only adverse effect of using a large time step is that any WAIT UNTIL statement or other test based on the Tank_Level array may be off by as much as the flow amount for the time step. For example, if the time step is .5 minutes and the rate of flow is 60 gpm, the level will change in 30 gallon increments. This means that the tank will not satisfy the statement “WAIT UNTIL Tank_Level[TankA] >= 31” until the level reaches 60.

Rate of Flow

To use flow rates properly, you must define all rates in terms of units (i.e., gallons, pounds) per time unit defined in the General Information dialog. Whenever you call one of the empty, fill, or transfer subroutines, you must specify the rate of flow. The units of flow, however, may change when you move material from one tank to another (e.g., pounds of dry material may transfer into a tank containing gallons of liquid).

To specify a variable rate of flow that changes dynamically with each time step, pass a value of 0. This signals the subroutine to call the Tank_Rate subroutine with each time step. To return the desired rate value for each time step when you use a variable rate, you must modify the Tank_Rate subroutine appropriately.

Tank States

Like other model elements, tanks use states to test and track statistics. ProModel automatically sets these states when you use the predefined tank subroutines to control the tank. The following are defined states:

Tank_Idle The tank is empty and not in use. Set automatically when a tank empties and at the end of a Tank_DoPrep or Tank_GoDown subroutine.

Tank_Operation The tank is active (e.g., mixing, reacting, heating). Set automatically when the model calls the Tank_DoPreparation subroutine.

Tank_Setup The tank is cleaning or preparing for future use. Set automatically whenever you call the Tank_Prep subroutine.

Tank_Filling The tank is filling. Set automatically whenever you fill the tank.

Tank_Emptying The tank is emptying. Set automatically whenever you empty the tank.

Tank_Blocked The tank is full and ready to transfer. Set automatically when the tank fills to capacity.

Tank_Down The tank is down. Set automatically whenever you call Tank_GoDown.
**Tank_ScheduledDown**  Similar to the Tank_Down state, except statistics are not collected.

While ProModel sets these states automatically, you may change the state of the tank at any time by calling the Tank_SetState subroutine. ProModel records statistics for these states in the output report under Locations. Since a tank may fill and empty simultaneously, the output report combines Tank_Filling with Tank_Emptying and reports it all as waiting time.

**Over Filling/Emptying Tanks**

When using the predefined subroutines to fill, empty, or transfer from one tank to another, you may accidentally attempt to over fill or over empty a tank. To prevent these situations, you have the option to terminate the fill/empty subroutine or suspend further filling/emptying until the tank reaches a resume level. If you terminate the subroutine, ProModel temporarily stores the un-filled or un-emptied quantity for immediate access in the global variable, Tank_QtyLeft.

**Tank Downtimes**

For Tanks, you must define downtimes and shifts in a special way. First, you may define only clock downtimes for tanks. Second, when defining a clock downtime for a tank, use the Tank_GoDown subroutine (page 193) in the Downtime Logic field instead of just a WAIT statement. This sets the state of the tank to Tank_Down and gathers the appropriate statistics. Third, when defining a shift for a tank, you should call the Tank_GoDownSched subroutine in the off-shift logic using the DTLeft() function as the time parameter. A SKIP statement should follow this function as shown next.

**SKIP example**

```
Tank_GoDownSched (<TankID>, DTLeft())
SKIP
```

ProModel temporarily suspends tank flow while a tank is down or off shift.

**Tank Logic Builder**

An expanded capability within ProModel, the tank logic builder provides you with what you need to model complex tank and fluid system operations. The logic builder contains all available tank subroutines and provides you with a description of the components required to use each subroutine.
Please note

The subroutine logic is not accessible until you define your first tank location—when you define the tank location, ProModel loads the tank sub-model.

How to access the Logic Builder:

- Click the right mouse button in the logic window or expression edit field. Or click the Build button on the logic window’s toolbar.

For more information about the Logic Builder, see “Logic Builder” on page 285.
Pre-defined Tank Subroutines

Tank_Cap ............................................. page 192
Tank_Dec ............................................. page 190
Tank_DoOperation ............................... page 193
Tank_DoPrep ........................................ page 195
Tank_Empty ......................................... page 186
Tank_FALLTrigger ............................... page 191
Tank_Fill ............................................ page 185
Tank_FreeCap ........................................ page 192
Tank_GoDown ....................................... page 193
Tank_GoDownSched ............................... page 194
Tank_Inc ............................................. page 190
Tank_Rate ............................................ page 199
Tank_RiseTrigger ................................. page 191
Tank_SelectInput .................................. page 198
Tank_SelectOutput ............................... page 196
Tank_SetLevel ..................................... page 189
Tank_SetState ...................................... page 196
Tank_Transfer ...................................... page 187
Tank_TransferDownTo ............................ page 188
Tank_TransferUpTo ............................... page 187
Tank_UpdateStats ................................. page 198

Tank_Fill

Syntax samples

TANK_FILL (<Tank ID>, <Fill Quantity>, <Fill Rate>, <Resume Level>)

TANK_FILL (HoldingTank, 2000, 75, 1500)

Description

Fills a tank using a specific quantity and rate. The default tank state sets to Tank_Filling, then to Tank_Blocked if the tank becomes full.

Use Tank_Fill when the source of the material is not another tank, but an arriving entity or a source that is not part of the model.

Components

<Tank ID>

The tank name or location index number.

<Fill Quantity>

The number of units (gallons, pounds) to fill into the tank. To fill the tank to capacity, enter Tank_Cap(<Tank ID>).

<Fill Rate>

The rate in units (gallons, pounds) per time unit defined in the General Information dialog. To instantly increase the level of a tank, use the Tank_Inc subroutine. To initialize the level of a tank (e.g., at the start of the simulation), use the Tank_SetLevel subroutine. To use a dynamically calculated rate in the Tank_Rate subroutine, enter 0.

<Resume level>

If the tank level reaches capacity before you add the specified quantity, the tank must drop to the resume level before it can continue filling. To terminate filling if the tank reaches capacity, enter Tank_Stop as the resume level. A value of 0 causes an error to occur if the tank becomes full before reaching the fill quantity.

Example
A tanker arrives and fills a storage tank by the quantity stored in the tanker’s attribute, Load_Qty. The rate of fill is 80 gpm and, if the tank fills to capacity before the tanker discharges the entire quantity, the level of the storage tank must drop to 12,000 gallons before it resumes filling. To represent this, enter the following statement in the operation logic for the tanker at the unloading station.

\[ \text{TANK\_FILL(StorageTank, Load\_Qty, 80, 12000)} \]

See Also

“Filling from an Entity” on page 202 and “Initial-izing and Replenishing Supply Tanks” on page 202.

**Tank\_Empty**

**Syntax samples**

- TANK\_EMPTY (<Tank ID>, <Empty Quantity>, <Empty Rate>, <Resume Level>)
- TANK\_EMPTY (TankB, 2000, 40, 0)

**Description**

Empties a tank by a specified quantity and rate. The state is set to Tank\_Emptying, then to Tank\_Idle if the tank becomes empty.

Use Tank\_Empty when the destination is not another tank, but an arriving entity or a source that is not part of the model.

**Components**

- `<Tank ID>`
  - The tank name or location index number.
- `<Empty Quantity>`
  - The number of units (gallons, pounds) to empty. To empty a tank completely of its current contents, enter `Tank\_Level [<Tank ID>]`.
- `<Empty Rate>`
  - The rate in units (gallons, pounds) per time unit defined in the General Information dialog. To instantly decrease the level of a tank, use the Tank\_Dec subroutine. To specify a dynamically calculated rate using the Tank\_Rate subroutine, enter 0.
- `<Resume level>`
  - If the tank level drops to 0 before you empty the specified quantity, the tank must rise to the resume level before continuing to empty. To terminate emptying if the level ever drops to 0, enterTank\_Stop. A value of 0 causes an error to occur if the tank becomes empty before removing the specified quantity.

**Example**

When a chemical tank, ChemTank, is full (state is Tank\_Blocked), workers pump its contents into a rail car at a rate of 60 gpm for transportation to another facility. Since rail cars are always available and the delivery activity is not of interest, it is not necessary to model the rail cars explicitly. Instead, activate a subroutine in the initialization logic with the following statement:

```
Tank\_Loop //logic repeats continuously
{
  WAIT UNTIL Tank\_State[ChemTank]=Tank\_Blocked
  TANK\_FILL(ChemTank, Tank\_Level[ChemTank], 60, 0)
}
```

See Also

“Emptying to an Entity” on page 203.
Tank_Transfer

Syntax samples

TANK_TRANSFER (<FROM Tank ID>, <TO Tank ID>, <Transfer Quantity>, <FROM Rate>, <TO Rate>, <Resume Level>)

TANK_TRANSFER (Tank1, Tank2, 2000, 100, 0, 0)

Description

Transfers a specified quantity from one tank to another. ProModel sets the state of the FROM tank to Tank_Emptying and the TO tank to Tank_Filling. If the FROM tank becomes empty, its state becomes Tank_Idle. If the TO tank becomes full, its state becomes Tank_Blocked. Otherwise, the states remain unchanged.

Use Tank_Transfer when you want to transfer a specific quantity from one tank to another.

Components

<FROM Tank ID>
The name or location index number of the FROM tank.

<TO Tank ID>
The name or location index number of the TO tank.

<Transfer Quantity>
The number of units (gallons, pounds) to transfer. To transfer the entire contents of a tank, enter Tank_Level [<FROM Tank ID>].

<FROM Rate>
The rate in units (gallons, pounds) per time unit defined out of the FROM tank. To use a dynamically calculated rate in the Tank_Rate subroutine, enter 0.

<TO Rate>
The rate in units (gallons, pounds) per time unit defined in the General Information dialog into the TO tank. Use 0 if same as the FROM rate. (The TO rate is automatically the same as the FROM rate if you add 0 as the FROM rate.)

<Resume level>
If the TO tank reaches capacity before the specified quantity transfers, the TO tank must drop to the resume level before continuing with the transfer. To terminate transferring when the TO tank reaches capacity, enter Tank_Stop. A value of 0 causes an error to occur if the tank becomes empty before transferring the specified quantity.

Example

When a mixing tank is ready to mix a new batch of material, 10,000 gallons of water must first transfer from a water supply tank at a rate of 100 gpm. The following logic represents this action:

Tank_Transfer(WaterTank, MixingTank, 10000, 100, 0, 0)

See Also

“Tank Transfers” on page 204.

Tank_TransferUpTo

Syntax samples

TANK_TRANSFERUPTO (<FROM Tank ID>, <TO Tank ID>, <TO Level>, <FROM Rate>, <TO Rate>)

TANK_TRANSFERUPTO (Tank1, Tank2, 8500, 75, 0)
Description

Similar to Tank_Transfer except that Tank_TransferUpTo does NOT terminate a transfer based on the transferred quantity, rather when the TO tank level rises to a certain point. If the tank empties before reaching the TO level, ProModel suspends the transfer until capacity becomes available.

Use Tank_TransferUpTo when you want to raise the level of a tank to a certain value but are not certain of the quantity needed to reach that level (e.g., the tank is draining at the same time you are trying to fill it).

Components

<FROM Tank ID>
The name or location index number of the FROM tank.

<TO Tank ID>
The name or location index number of the TO tank.

<TO Level>
Transfer until the TO tank reaches this level.

<FROM Rate>
The rate in units (gallons, pounds) per time unit defined in the General Information dialog out of the FROM tank. To use a dynamically calculated rate in the Tank_Rate subroutine, enter 0.

<TO Rate>
The rate in units (gallons, pounds) per time unit defined in the General Information dialog into the TO tank. Use 0 if the TO rate is the same as the FROM rate.

Example

An in-process tank supplies several downstream tanks and must maintain a maximum level of 20,000 gallons. Whenever the in-process tank drops below 5,000 gallons, a supply tank refills the tank at a rate of 100 gpm. To model this, define an activated subroutine for the supply tank using the following logic:

Tank_Loop //logic repeats continuously
{
WAIT UNTIL Tank_Level[InProcessTank]<=5000
Tank_TransferUpTo(SupplyTank, InProcessTank, 20000, 100, 0)
}

Tank_TransferDownTo

Syntax samples

TANK_TRANSFERDOWNT0 (<FROM Tank ID>, <TO Tank ID>, <TO Level>, <FROM Rate>, <TO Rate>)

TANK_TRANSFERDOWNT0 (Tank1, Tank2, 1000, 80, 0)

Description

Similar to Tank_Transfer except that Tank_TransferDownTo terminates the transfer when the FROM tank level lowers to a designated level instead of lowering by a specific quantity. If the TO tank becomes full, ProModel suspends the transfer until capacity becomes available.

Use Tank_TransferDownTo when you want to lower the level of a tank to a specific value but you are not certain how much to empty in order to drop to that level (e.g., the tank may fill at the same time it empties).

Components

<FROM Tank ID>
The name or location index number of the FROM tank.

<TO Tank ID>
The name or location index number of the TO tank.

<TO Level>
Transfer until the FROM tank drops to this level.

<FROM Rate>
The rate in units (gallons, pounds) per time unit defined in the General Information dialog out of the FROM tank. To use a dynamically calculated rate in the Tank_Rate subroutine, enter 0.

<TO Rate>
The rate in units (gallons, pounds) per time unit defined in the General Information dialog into the TO tank. Use 0 if the TO rate is the same as the FROM rate.

Example

An in-process tank, TankA, supplies TankB at a rate of 50 gpm. TankA must maintain a minimum level of 200 gallons to insure against pump cavitation. When TankA's level drops to 200 gallons, the tank stops pumping to TankB until the level of TankA rises above 200 gallons. To model this scenario, enter the following logic in the subroutine controlling the flow from TankA to TankB:

Tank_Loop //logic repeats continuously
{
WAIT UNTIL Tank_Level[TankA]>200
Tank_TransferDownTo(TankA, TankB, 200, 50, 0)
}

See Also
“Split Transfers” on page 206.

Tank_SetLevel

Syntax samples

TANK_SETLEVEL (<Tank ID>, <Quantity>)
TANK_SETLEVEL (TankA, 1500)

Description
Instantly sets the level of a tank to a specified quantity. If the quantity is negative or larger than the tank capacity, an error occurs. The tank state sets to Tank_Blocked if you set the tank level to the tank capacity and to Tank_Idle if you set the tank level to 0. Otherwise, the state remains unchanged.

Use Tank_SetLevel when you want to initialize a tank to a specific level.

Components

<Tank ID>
The tank name or location index number.

<Quantity>
The level at which to set the tank (number of gallons, pounds). To completely fill the tank, enter Tank_Cap(<Tank Name>).

Example

When you begin a simulation, you wish to set the initial level of a supply tank, TankX, to 10,000 gallons. To model this, enter the following statement in the initialization logic for the model.

Tank_SetLevel(TankX, 10000)
**Chapter 5: Pre-defined Tank Subroutines**

**See Also**


---

## Tank_Inc

### Syntax samples

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TANK_INC (&lt;Tank ID&gt;, &lt;Quantity&gt;)</td>
<td>Instantly increases the level of a tank by a specified quantity. If the tank has insufficient capacity, the level increases as capacity becomes available. ProModel sets the tank state to Tank_Blocked if the level increases to the tank capacity, otherwise the state remains unchanged. Use Tank_Inc to instantly add a specific quantity to a tank.</td>
</tr>
<tr>
<td>TANK_INC (StorageTank, 5000)</td>
<td></td>
</tr>
</tbody>
</table>

### Components

- **<Tank ID>**
  - The tank name or location index number.
- **<Quantity>**
  - The number of units by which to increment the contents of the tank (gallons, pounds).

### Example

Trucks deliver pellets to a holding bin twice a day. When a truck arrives at the drop-off station, it dumps the entire 5,000 lb load in only 2.5 minutes. To model this, define the following operation logic for the truck at the drop-off station:

```
WAIT 2.5 MIN
Tank_Inc(HoldingBin, 5000)
```

---

## Tank_Dec

### Syntax samples

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TANK_DEC (&lt;Tank ID&gt;, &lt;Quantity&gt;)</td>
<td>Instantly decreases the level of a tank by a specified quantity. If the tank has insufficient quantity, it empties as material becomes available. ProModel sets the tank state to Tank_Idle if you decrease the level to 0. Otherwise the state remains unchanged. Use Tank_Dec to instantly remove a specific quantity from a tank.</td>
</tr>
<tr>
<td>TANK_DEC (SupplyTankB, 1000)</td>
<td></td>
</tr>
</tbody>
</table>

### Components

- **<Tank ID>**
  - The tank name or location index number.
- **<Quantity>**
  - The number of units by which to decrement the contents of the tank (gallons, pounds).

### Example

A fill tank fills one 10-gallon container every 15 seconds. After filling, each container moves to a location called FillStation. To model this activity, define the following activated subroutine (this subroutine creates a filled container every 15 seconds):

```
WAIT 2.5 MIN
Tank_Dec(FillTank, 1000)
```
Tank_Loop //logic repeats continuously
{
WAIT 15 SEC
Tank_Dec(FillTank, 10)
ORDER 1 Container TO FillStation
}

See Also
“Emptying to an Entity” on page 203.

Tank_RiseTrigger

Syntax samples

TANK_RISETRIGGER (<Tank ID>, <Level>)
TANK_RISETRIGGER (TankA, 3000)

Description
Waits until tank contents rises to a specific level. Use Tank_RiseTrigger to initiate some action when a tank rises to a certain level.

Components

<Tank ID>
The tank name or location index number.

Level>
When the tank level rises to this value, ProModel executes any subsequent logic.

Example

A tanker waits at a dispatch station until the level of a finished goods tank rises to 2,000 gallons. Once the tank level reaches this point, a signal dispatches the tanker to the finished goods tank for loading. Meanwhile, the finished goods tank continues filling. To model this situation, define the following process logic for the tanker at the dispatch station:

Tank_RiseTrigger (FGTank, 2000)

Please note

Using the Tank_RiseTrigger subroutine instead of a WAIT UNTIL statement prevents the next tanker from dispatching until the finished goods tank falls back below 2,000 gallons.

See Also
“Defining Trigger Levels” on page 207.

Tank_FallTrigger

Syntax sample

TANK_FALLTRIGGER (<Tank ID>, <Level>)
TANK_FALLTRIGGER (TankB, 500)

Description
Waits until tank contents falls to a specified level. Use Tank_FallTrigger to initiate an action when a tank level falls to a specific level.

Components

<Tank ID>
The tank name or location index number.

<Level>
When the tank level falls to this value, any subsequent logic executes.

---

**Example**

When an in-process tank, TankX, falls to 1000 gallons, it triggers a mixing tank to begin producing more product. To model this, define the following activated subroutine to control the mixing tank:

```plaintext
Tank_Loop //logic repeats continuously
{
    Tank_FallTrigger(TankX, 1000)
    [Insert logic to mix new batch here]
}
```

---

**Please note**

*Using Tank_FallTrigger instead of a WAIT UNTIL statement prevents the action from triggering again until the level first rises above the fall trigger level.*

---

**See Also**

“Defining Trigger Levels” on page 207.

---

**Tank_Cap**

**Description**

Returns the capacity defined for the specified tank.

Use Tank_Cap when you need to know the defined capacity for a tank.

**Components**

<Tank ID>

The tank name or location index number.

---

**Tank_FreeCap**

**Syntax samples**

TANK_FREECAP (<Tank ID>)
TANK_FREECAP (TankA)

**Description**

Returns the available capacity of the specified tank.

Use Tank_FreeCap when you need to know the available capacity of a tank.

**Components**

<Tank ID>

The tank name or location index number.
**Tank_DoOperation**

**Syntax samples**

TANK_DOOPERATION (<Tank ID>, <Operation time>)

TANK_DOOPERATION (TankA, 30)

**Description**

Sets the state of the tank to Tank_Operation and waits for the specified operation time. ProModel sets the state to Tank_Blocked after the operation.

Use Tank_DoOperation when some activity or treatment time is necessary for the material in a tank.

**Components**

<Tank ID>

The tank name or location index number.

<Operation time>

The duration (in time units defined in the General Information dialog) of the operation.

**Example**

After technicians add all the necessary ingredients to the mixing tank, the tank requires a 20 minute mixing time. To define this operation, enter the following statement in the subroutine for the mixing activity:

Tank_DoOperation(MixingTank, 20)

**See Also**

“Mixing and Reactor Tanks” on page 203.

**Tank_GoDown**

**Syntax samples**

TANK_GODOWN (<Tank ID>, <Down time>)

TANK_GODOWN (TankA, 5)

**Description**

Sets the state of the tank to Tank_Down, waits for the specified downtime, then sets the state back to the previous setting. If you defined a downtime using the location downtime dialog, call the Tank_GoDown subroutine in the downtime logic rather than use a WAIT statement. If the downtime is for cleaning, use the Tank_DoPrep subroutine.

Use Tank_GoDown to shut down a tank due to equipment failure (e.g., pump failure). If the downtime occurs periodically, you can define a clock downtime in the downtime logic for the tank location and use Tank_GoDown in place of the WAIT statement.

**Components**

<Tank ID>

The tank name or location index number.

<Down time>

The duration (in time units defined in the General Information dialog) of the downtime.

**Example**

A fill line from a dry supply bin plugs randomly according to an exponential distribution with a mean of 10 minutes. The time to unplug the line is normally distributed with a mean of 5 minutes and a standard
deviation of 1 minute. To define this behavior, define a clock downtime for the bin to occur with a frequency of E(10) minutes. In the logic defined for the downtime, enter the following logic:

```
Tank_GoDownSched
```

**Syntax samples**

```
TANK_GODOWNSCHED (<Tank ID>, <Down time>)
```

TANK_GODOWNSCHED (TankA, 5)

**Description**

Sets the state of the tank to Tank_ScheduledDown, waits for the specified scheduled downtime, then sets the tank state back to its previous setting. If you defined a scheduled downtime using the location downtime dialog, call the Tank_GoDownSched subroutine in the downtime logic rather than use a WAIT statement. If the downtime is for cleaning and you will return the tank status to idle, use the Tank_DoPrep subroutine.

Use Tank_GoDownSched to shut down a tank for a scheduled task or event (e.g., interim mainte-
Components

<Tank ID>
The tank name or location index number.

<Down time>
The duration (in time units defined in the General Information dialog) of the scheduled downtime.

Example

Every 4 hours, a technician must check the fill line from a dry supply bin. The time required to check the line is normally distributed with a mean of 10 minutes and a standard deviation of 3 minutes. To define this behavior, define a clock-based, scheduled downtime for the bin to occur with a frequency of 4 hours. In the logic defined for the downtime, enter the following:

Description

Sets the state of the tank to Tank_Setup, waits for the specified time, then sets the state to Tank_Idle. Use Tank_DoPrep for cleaning activities after you empty a tank.

Use Tank_DoPrep to take a tank off line for cleaning or other preparation time.

Components

<Tank ID>
The tank name or location index number.

<Prep time>
The duration (in time units defined in the General Information dialog) of preparation time.

Example

Workers clean a mixing tank for 30 minutes after each batch produced. To model this, enter the following logic in the mixing subroutine defined for the mixing tank:

Tank_DoPrep

Syntax samples

TANK_DOPREP (<Tank ID>, <Prep time>)
TANK_DOPREP (TankA, 5)

See Also

“Mixing and Reactor Tanks” on page 203.
**Tank_SetState**

**Syntax samples**

TANK_SETSTATE (TankA, Tank_Idle)

**Description**

Sets the state of the tank (e.g., Tank_State[Tank ID]) to a new state and updates the statistics since the last change of state.

Use Tank_SetState to explicitly change the state of a tank. Use Tank_SetState only if the default state changes do not adequately meet modeling needs.

**Components**

- **<Tank ID>**
  The tank name or index number.

- **<State>**
  The new state for the tank. For a list of possible tank states, see “Tank States” on page 182.

**Tank_SelectOutput**

**Syntax samples**

TANK_SELECTOUTPUT (TankA, 3, Tank_InOrder, 5000, 0)

**Description**

Selects an output tank from among several tanks based on a selection rule and optional product type. To use this function, list all tanks included in the selection decision together in the Location module.

**Components**

- **<First Tank>**
  The name or location index number of the starting tank in the range.

- **<Number of Tanks>**
  The number of tanks in the selection range (limit 10).

- **<Selection Rule>**
  The rule for making the selection may be one of the following:

  - **Tank_InOrder** (selects the first idle tank encountered)
  - **Tank_LongestIdle** (selects the tank idle the longest)

- **<Maximum Level>**
  The maximum level of the output tank before considering it for selection. Enter 0 if the output tank must be empty or idle before being considered.

- **<Product Type>**
  An integer specifying the required value of the Product array in order to select the tank. Enter 0 if the tank selection requires no product type match. (This applies only if the maximum level specified is greater than 0.)

**Example**

A supply tank feeds one of 3 output tanks and always gives preference first to Tank1, then to Tank2, and finally to Tank3 based on availability. Furthermore, the supply tank can select a tank only if its contents are less than 8000 gallons. To model this selection, list
Tank1, Tank2, and Tank3 together (and in order) in the location module. Then define the following statement to select the tank using a local variable, Selected_Tank:

```plaintext
INT Selected_Tank

SelectedTank=Tank_SelectOutput(Tank1, 3, Tank_InOrder, 8000,0)
```

The diagram below shows the logic used to make a tank selection:

If you base a tank selection on product type, you must be careful to assign an appropriate integer value to the Product array element corresponding to the tank location.

See Also

“Selecting from Multiple Input or Output Tanks” on page 205.
Chapter 5: Pre-defined Tank Subroutines

**Tank_SelectInput**

**Syntax samples**

TANK_SELECTINPUT (<First Tank>, <Number of Tanks>, <Selection Rule>, <Minimum Level>, <Product Type>)

TANK_SELECTINPUT (Tank1, 5, Tank_ByOrder, 1000, 0)

**Description**

Selects an input tank from among several tanks based on a selection rule. To use this function, you must list all tanks included in the selection together in the Location module.

**Components**

<First Tank>
The name or location index number of the starting tank in the range.

:Number of Tanks>
The number of tanks in the selection range (limit 10).

<Selection Rule>
The rule for making the selection may be one of the following:

  - Tank_InOrder (selects the first blocked tank encountered)
  - Tank_LongestBlocked (selects the tank blocked the longest)

<Minimum Level>
The minimum level of the input tank before considering it for selection. If the tank must be full before considering it for an input source, enter 0.

<Product Type>
An integer specifying the required value for the Product array in order to select the tank. Enter 0 if the tank selection requires no product type match.

**Example**

A tanker arrives at a pick up station to load from one of 5 tanks depending on which tank has been full the longest. The tanker will fill from a partial tank if the tank has any contents at all (at least .1 gallons). To model the tank selection, define the following operation logic for Tanker at PickUpStation:

```
INT SelectedTank
Selected_Tank=Tank_SelectInput(Tank1, 5, Tank_LongestBlocked, .1, 0)
```

**See Also**

“Selecting from Multiple Input or Output Tanks” on page 205.

**Tank_UpdateStats**

**Syntax samples**

TANK_UPDATESTATS (<Tank ID>)

TANK_UPDATESTATS (TankA)

**Description**

ProModel calls this subroutine automatically whenever you call any of the predefined subroutines that affect the tank level. If you change the value of the Tank_Level directly, call the Tank_UpdateStats subroutine afterward. This subroutine updates the current statistics on the tank and sets the state to Tank_Filling (if filling),
Tank_Emptying (if emptying), Tank_Blocked (if full), or Tank_Idle (if empty).

You should not need to use this subroutine unless you defined a customized Tank_Empty, Tank_Fill, or Tank_Transfer subroutine.

**Components**

<Tank ID>
The tank name or location index number.

**Tank Rate**

**Syntax sample**

TANK_RATE (<FROM tank ID>, <TO tank ID>)
TANK_RATE (TankA, TankB)

**Description**

ProModel calls this subroutine automatically if you pass a 0 value as the From Rate when using the Tank_Empty or Tank_Transfer subroutine. To return the desired rate value, enter the necessary logic in the subroutine—ProModel calls the subroutine with each time step. A return value of 0 terminates the flow and returns the remaining amount in the Tank_QtyLeft variable.

**Components**

<FROM Tank>
The name or location index number of the FROM tank (this value should be 0 if there is no FROM tank).

<TO Tank>
The name or location index number of the TO tank (this value should be 0 if there is no TO tank).

The first 0 in the expression above causes the logic defined in the Tank_Rate subroutine to execute and determine the flow rate.

**Example**

TankA fills with 10,000 gallons at a rate of 60 gpm until it reaches a level of 9,700 gallons. Then it fills at a rate of 30 gpm. To model this change of rate, define the following logic in the Tank_Rate subroutine:

IF Tank_ToID=TankA
THEN IF Tank_Level[TankA]<9700
    THEN RETURN 60
ELSE RETURN 30

Now when you fill TankA, enter the following:

Tank_Fill(TankA, 10000, 0, 0)

**See Also**

“Varying the Transfer Rate” on page 206.

**Pre-defined Data Elements**

The ProModel tank submodel provides the following data elements for modeling tanks. Unless otherwise specified, all arrays are single-dimensional and of type integer. Initially, these arrays are 100 elements in size to allow for up to 100 locations. If you define more than 100 locations, you will need to enlarge the array or place tanks toward the beginning of the location list (within the first 100 locations).

**Tank Level array** Stores the level of each tank. Since the values in this array directly control the tank gauge and tank statistics, the array MUST be present in every tank model.
**Tank_State array**  Tracks the state of the tank.

**Tank_Product array**  An optional array used to record or test the product currently at a tank.

**Tank_Statistics array**  A two-dimensional array of type real used to record tank level statistics whenever the level changes. Generally, you will never need to reference this array since values are automatically updated when you use the pre-defined Tank subroutines. All times are in time units defined in the General Information dialog. ProModel always gathers these statistics but reports them only if you check Basic or Time Series statistics for the tank location.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Reset After Warm-up</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Last level</td>
<td>NC</td>
</tr>
<tr>
<td>2</td>
<td>Last change time</td>
<td>Current time in time units defined in the General Information dialog</td>
</tr>
<tr>
<td>3</td>
<td>Cum time-weighted level</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Entries</td>
<td>Value of column 1</td>
</tr>
<tr>
<td>5</td>
<td>Max contents</td>
<td>Value of column 1</td>
</tr>
<tr>
<td>6</td>
<td>Last State Change</td>
<td>Current time in time units defined in the General Information dialog</td>
</tr>
<tr>
<td>7</td>
<td>Cum time Idle</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>Cum time Operation</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>Cum time Setup</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>Cum time Filling</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>Cum time Emptying</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>Cum time Blocked</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>Cum time Down</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>Current downtime count</td>
<td>NC</td>
</tr>
</tbody>
</table>

As shown in the previous table, the statistics collected in the Tank_Statistics array automatically reset after any warm-up period. ProModel reports output statistics under Location statistics and Location States by Percentage. When reporting Location statistics for tanks, note the following:

- **Total Entries**  The number of units (e.g., gallons, pounds) to enter the tank.
- **Avg Minutes Per Entry**  Left blank since there is no individual entry for a tank.

**Tank_Fills array**  An optional array used to track the number of transfers to a tank. This is especially useful when you activate multiple Tank_Fill or Tank_Transfer subroutines for a tank and you wish to know when the fills are complete. The user sets the value of Tank_Fills to zero before activating the subroutines, then defines a WAIT UNTIL statement after the ACTIVATE statement. The Tank_Fills array increments automatically when a Tank_Fill or a Tank_Transfer subroutine executes. See “Mixing and Reactor Tanks” on page 203 for additional information.

### Statistics

**Please note**

\[ TS = \text{Tank}_\text{Statistics array} \]

\[ n = \text{Location index number of tank} \]

### Calculating Location Statistics for Tanks

Entries = \( TS[n, 4]\)

Avg. Time per Entry = (not applicable)

Avg. Contents = \( TS[n,3] / \text{Scheduled Time} \)

Max Contents = \( TS[n,5] \)

Current Contents = \( TS[n,1] \)

Utilization = \( 100 \times TS[n,3] / (\text{Capacity} \times \text{Scheduled Time}) \)
Calculating Location State Statistics for Tanks

\[
\%\text{Operation} = 100 \times TS[n, 8] / \text{Scheduled Time}
\]
\[
\%\text{Setup} = 100 \times TS[n, 9] / \text{Scheduled Time}
\]
\[
\%\text{Idle} = 100 \times TS[n, 7] / \text{Scheduled Time}
\]
\[
\%\text{Waiting} = 100 - \text{Sum of other percentages}
\]
\[
\%\text{Blocked} = 100 \times TS[n, 12] / \text{Scheduled Time}
\]
\[
\%\text{Down} = 100 \times TS[n, 13] / \text{Scheduled Time}
\]

To gather statistics on how much of a particular product was processed, you may define variables to record product processing during the simulation.

Defining Tank Control Subroutines

Unlike defining entity activity at a location (defined in the Processing module), modeling tank location activity requires the use of subroutines. Many of these subroutines are user-defined and called using the ACTIVATE statement. Though you generally activate them from the initialization logic, you may also activate them from another tank subroutine. Tank subroutines consist of logic defined to control when, where, and how much to empty, fill, or transfer from a tank. Often, these subroutines require the use of WAIT UNTIL statements to monitor conditions (e.g., the tank level or state) before making a transfer and may include delays for mixing or cleaning.

At a minimum, you should define a separate control subroutine for any logic that executes independently of any other logic. For example, if TankA fills TankB at the same time TankB transfers to some other tank, you should define two separate subroutines since both sets of logic must be capable of executing independently of each other. On the other hand, if the logic associated with two tanks is interdependent, only one control subroutine is necessary. For example, if TankA fills TankB while TankB waits, then TankB pumps out while tank A waits, you need only a single control subroutine since you control both tanks by a single logic sequence. If a single tank feeds several other tanks independently, you would need a separate subroutine to control each output. In most cases, you will need at least one control subroutine per tank and, in certain situations, you may wish to use a hierarchical control system (i.e., a master or supervisory control subroutine) to activate subordinate subroutines.

Most tank control subroutines should be activated subroutines. In contrast to called subroutines, activated subroutines use the ACTIVATE statement and cause the logic activating the subroutine to continue independently of the activated subroutine. This allows you to execute multiple control subroutines concurrently. Multiple tanks with identical control logic may share the same control subroutine if you activate the subroutine for each tank and pass the tank ID as a parameter.

One of the keys to modeling interactive tank behavior is to effectively use WAIT UNTIL statements. When you use WAIT UNTIL statements based on the Tank_Level array, use them sparingly since this array changes frequently and may slow the simulation.

Examples of Tank Control Logic

The following examples show how to model different tank and flow situations. For full models illustrating these situations, see the reference model in the MODELS\REFS directory within the ProModel directory.
Chapter 5: Pre-defined Tank Subroutines

Filling from an Entity

A typical tank modeling situation is the arrival of an entity (e.g., a tanker or other vehicle) to deliver its contents to a tank. To model this situation, define an arrival or routing for the entity, causing it to enter the location where it will make its delivery. In the entity processing logic at the delivery location, call the Tank_Fill subroutine. By calling rather than activating the subroutine, you will detain the delivering entity until Tank_Fill executes. Note that the material does NOT route from the delivery location to the tank. Instead, the Tank_Fill subroutine simply fills the tank with a specified quantity while the entity waits. Unless the quantity is a constant amount, it is usually a good idea to use an entity attribute to store this quantity value. After filling the contents into the tank, the entity is free to continue processing.

To illustrate how an entity might transfer its contents to a tank, suppose an entity, Tanker, arrives at a location, Delivery, carrying a quantity of gallons stored in an entity attribute called Tanker_Qty. The tanker discharges its contents into a tank, ReceivingTank, at a rate of 200 gallons per minute. Once the ReceivingTank becomes full, the level must drop to 1000 gallons before filling resumes. Since the entity is tied up while it discharges into the tank, use the following statement in the processing logic for Tanker at Delivery to define the logic used to fill the tank:

```
Tank_Fill (ReceivingTank, Tanker_Qty, 200, 1000)
```

The above statement causes each arriving tanker to wait until the quantity stored in its Tanker_Qty attribute adds to the ReceivingTank. Once the tanker delivers this quantity, it is free to execute the routing defined for it at the Delivery location.

Initializing and Replenishing Supply Tanks

A supply tank is an originating tank that is a source of raw material for one or more downstream tanks. Often, supply tanks contain ingredients that feed into a mixing tank or hold chemicals that feed into a reactor. Typically, you replenish a supply tank when it gets low and make it available for use whenever it has an adequate supply. If you always stock the supply tank and it is always available for use, you do NOT need to model it since it poses no constraint on the process. You may set supply tanks to an initial level at the start of the simulation in the initialization logic, then use them as needed by a mixing or other downstream tank. To initialize the level in a supply tank, enter the following statement in the initialization logic:

```
Initialize tank level
Tank_SetLevel (<supply tank>, <qty>)
```

If, for example, you wanted to begin the simulation with the supply tank, WaterTank, filled with 800 gallons of water, you would enter:

```
Start with full tank
Tank_SetLevel (WaterTank, 800)
```

To gradually fill or refill a supply tank whenever it drops below a trigger level, use the Tank_Fill subroutine with a large fill quantity and an appropriate resume level. For example, the following
statement will continue pumping up to 999999 units into TankA at a rate of 200 units per minute. Whenever the tank becomes full, it must drop to 400 units before filling resumes.

**Resume fill with trigger level**

```plaintext
Tank_Fill (TankA, 999999, 200, 400)
```

**Mixing and Reactor Tanks**

Mixing and reactor tanks receive material usually from one or more supply tanks. Once it receives the material, the tank may require a mixing or other reaction time. To illustrate, suppose we have two tanks (Tank1 and Tank2) supplying ingredients to a tank called MixingTank. First, workers pump 2000 gallons of a liquid from Tank1 at 50 gallons per minute followed by the transfer of 300 pounds of dry mix from Tank2 at 20 pounds a minute (the dry mix adds .2 gallons to the level of the MixingTank for every pound transferred, equating to 4 gallons per minute). The ingredients then mix for 15 minutes before transferring to an idle storage tank. After transferring the mix, workers must clean the MixingTank for 50 minutes to prepare it for the next mixing cycle.

The control logic for the mixing tank should be a subroutine activated from the initialization logic which continues to loop throughout the simulation. The subroutine logic might appear as follows:

**Mix and clean the tank**

```plaintext
Tank_DoOperation (MixingTank, 15) //Mix time
Wait Until Tank_State [StorageTank]= Tank_Idle /*
Waits for storage tank availability */
Tank_Transfer (MixingTank, StorageTank,
Tank_Level[MixingTank],40, 0, 0)
Tank_Prep (MixingTank, 50) // Clean mixing tank for 50 minutes.
END
```

If the ingredients feed into the mixing tank at the same time rather than sequentially, activate the Tank_Transfer subroutines for the mixing tank and monitor the Tank_Fills array to know which ingredients enter into the tank. For simultaneous fills, replace the first two transfer statements following the BEGIN statement in the previous subroutine with the following logic:

**Simultaneously mix, then clean tank**

```plaintext
Tank_Fills[MixingTank]=0
ACTIVATE Tank_Transfer(Tank1, MixingTank, 2000,
50, 0, 0)
ACTIVATE Tank_Transfer(Tank2, MixingTank, 300,
20, 4, 0)
WAIT UNTIL Tank_Fills[MixingTank]=2
...
```

**Emptying to an Entity**

Often, tanks deliver material to discrete entities such as containers (or perhaps the material itself converts to discrete entities through a solidification or consolidation process). In either case, you can draw from the delivery tank using the Tank_Empty subroutine if outflow is gradual and defined by a flow rate, or the Tank_Dec subroutine.
Chapter 5: Pre-defined Tank Subroutines

To output material from a tank without modeling the entity to which it outputs, call the Tank_Empty or Tank_Dec subroutine. To transfer material from a tank to entities arriving at a filling station (remember, the filling station itself is NOT a tank), route the entities to the filling station using a SEND or other routing rule, then call the Tank_Empty or Tank_Dec subroutine.

If using the Tank_Dec subroutine, the entity should wait for the fill time before decreasing the tank level since Tank_Dec happens instantly. For example, if a bottling operation fills a 2 gallon container every 6 seconds, define the following processing logic for the container at the fill station:

Wait to fill from tank, then continue

Wait 6 sec
Tank_Dec (Filler, 2)

If the delivery tank has insufficient contents to decrease the level by the specified amount, the processing will automatically pause until enough material is available. Once the specified quantity empties, the entity can continue processing. To create an entity as the result of an emptying operation, define an activated subroutine that empties the desired quantity, then execute an ORDER statement. This will create a new entity at the filling station.

Tank Transfers

When transferring from one tank to another, you must determine whether the source tank makes the decision to transfer to the destination tank (a push approach) or whether the destination tank makes the decision to draw material from a source tank (a pull approach). You should define a control subroutine from the perspective of the tank that makes the decision. If the model requires no tank selection, specify a WAIT UNTIL statement to wait until the FROM or TO tank satisfies the condition required for transfer. For example, if a source tank makes the decision to transfer to a destination tank whenever the destination tank becomes idle, enter the following statement in the subroutine:

Transfer contents when idle

Wait Until Tank_State [<destination tank ID>] = Tank_Idle

If the destination tank makes the decision to transfer (a pull approach), you should base the WAIT UNTIL statement on a required condition for the source tank as follows:
Transfer contents based on condition

Wait Until Tank_State [<source tank ID>] = Tank_Blocked

Following the WAIT UNTIL statement, call the Tank_Transfer, Tank_TransferUpTo, or Tank_TransferDownTo subroutine to transfer from the source tank to the destination tank.

To illustrate how to define a tank transfer using a pull approach, suppose that TankB requires 1000 gallons from TankA whenever TankB becomes empty. TankB will draw material from TankA only when TankA has a minimum level of 1000 gallons. The subroutine to define this logic might appear as follows:

**Tank transfer in a pull system**

Tank_Loop //logic repeats continuously

Begin

Wait Until Tank_Level[TankA] >= 1000 /*Wait for TankA to reach 1000 gallons*/

Tank_Transfer (TankA, TankB, 1000, 200,0,0) /*Transfer 1000 gal to TankB at 200 gpm*/

[Enter TankB processing and emptying logic here]

End

Please note

To select from among multiple input or output tanks, activate this subroutine in the initialization logic.

Selecting from Multiple Input or Output Tanks

To enable one or more tanks to select from several input or output tanks, use the pre-defined subroutine Tank_SelectInput or Tank_SelectOutput (see subroutine descriptions). ProModel bases tank selection on which tank is ready to transfer or receive and that has the same ProductType array value. You must list the tank selections together in the Location module.

For example, if TankX selects from among three input tanks (Tank1, Tank2, and Tank3) based on which input tank has waited the longest to discharge its contents, you would enter the following logic in the control subroutine defined for TankX:

**Select from multiple tanks**

Int SelectedTank

SelectedTank = Tank_SelectInput(TankX, Tank1, 3, Tank_LongestBlocked, 0)

The first statement defines a local variable, SelectedTank, used to assign which tank you select. The second statement calls the SelectInput subroutine specifying that TankX is to select one of three tanks beginning with Tank1. Tank_LongestBlocked causes TankX to select the tank blocked the longest (i.e., tank is full or waiting). Entering 0 at the end prevents selecting a full tank. If no tank is full, the statement does not execute until one of the input tanks fills. With a tank ID assigned to SelectedTank, you can call a transfer subroutine to make the transfer.
Chapter 5: Pre-defined Tank Subroutines

For output tanks, you would define similar logic but include Tank_SelectOutput instead of Tank_SelectInput.

### Split Transfers

Sometimes it is necessary to use a tank or separator to split the flow to several output tanks. To define the concurrent transfer of material from one tank to multiple tanks, define an activated subroutine for each transfer. Suppose, for example, that when TankA fills it begins transferring to TankB at a rate of 30 gpm and to TankC at a rate of 40 gpm. To know when both transfers are complete, define a global variable (e.g., TransferDone) which increments at the end of each transfer. Defining the following logic would initiate this split transfer once TankA is full:

**Initiate split transfer**

```plaintext
ACTIVATE TransferToB () // initiates transfers from A to B
ACTIVATE TransferToC () // initiates transfers from A to C
WAIT UNTIL TransferDone = 2 // Wait until transfers are complete
TransferDone = 0 // reset for next transfer
```

The subroutines TransferToB and TransferToC would each execute a Tank_TransferDownTo command followed by a statement incrementing the value of TransferDone. For example, the logic for TransferToB would be as follows:

**Split transfers subroutines**

```plaintext
TransferDownTo(TankA, TankB, 0, 30, 0)
INC TransferDone
```

**Varying the Transfer Rate**

The transfer or empty rate can change dynamically during an empty, fill, or transfer. To vary the rate of flow, pass 0 as the flow rate when calling any of the transfer, fill, or empty subroutines. This calls the Tank_Rate subroutine automatically with each time step. You should modify the Tank_Rate subroutine so that it returns the appropriate rate value.

Suppose, for example, that TankA transfers to TankB at a rate that decreases from 150 gpm to 50 gpm when the level of TankB reaches 4000. To achieve this, pass 0 as the From Rate when you call the transfer subroutine, then enter the following logic in the Tank_Rate subroutine:

**Vary the transfer rate**

```plaintext
IF (Tank_FromID = TankA) AND (Tank_ToID = TankB)
THEN IF Tank_Level[TankB] >= 4000
THEN RETURN 50
ELSE RETURN 150
```

The transfer or empty rate can change dynamically during an empty, fill, or transfer. To vary the rate of flow, pass 0 as the flow rate when calling any of the transfer, fill, or empty subroutines. This calls the Tank_Rate subroutine automatically with each time step. You should modify the Tank_Rate subroutine so that it returns the appropriate rate value.

Suppose, for example, that TankA transfers to TankB at a rate that decreases from 150 gpm to 50 gpm when the level of TankB reaches 4000. To achieve this, pass 0 as the From Rate when you call the transfer subroutine, then enter the following logic in the Tank_Rate subroutine:

**Vary the transfer rate**

```plaintext
IF (Tank_FromID = TankA) AND (Tank_ToID = TankB)
THEN IF Tank_Level[TankB] >= 4000
THEN RETURN 50
ELSE RETURN 150
```
**Dynamically Suspending Flow**

To momentarily interrupt flow into or out of a tank, use the Tank_GoDown subroutine or set the state of the tank to down (Tank_SetState = Tank_Down). This typically happens if a pump fails but may occur in other situations.

**Dynamically Terminating a Flow**

Normally, the flow into or out of a tank stops once you reach the desired quantity or level. However, in some situations you may wish to terminate a transfer if some event or condition occurs that you cannot predetermine (e.g., a decision to divert flow to a preferred outlet tank that just became available). In this case, you can turn off the flow into or out of a tank by specifying a variable transfer rate instead of a fixed transfer rate (see previous discussion, *Varying the Transfer Rate*). A variable transfer uses the Tank_Rate subroutine to determine the rate for each time step—to terminate a transfer, return a rate value of 0.

**Defining Trigger Levels**

A trigger level is a level to which material in a tank either falls or rises and triggers some action. To continuously monitor when a tank reaches a trigger level, define and activate a trigger subroutine in the initialization logic. The subroutine should call Tank_RiseTrigger or Tank_FallTrigger depending on whether the associated action should execute when the tank level rises or falls to a certain level.

To show how to define a trigger subroutine, suppose that whenever TankA rises to 2000 gallons, an entity called Truck travels to a location called Pickup. The logic for this trigger subroutine might look as follows:

**Trigger subroutine**

```plaintext
Tank_Loop //logic repeats continuously
Begin
    Tank_RiseTrigger (TankA, 2000) /* waits for TankA to rise to 2000 units*/
    Order 1 Truck to Pickup   // order a Truck to Pickup
End
```

Once the tank reaches the trigger level, the Tank_RiseTrigger subroutine prevents further triggering until the level drops back below the trigger level first.

When you use trigger subroutines, use them sparingly because they are CPU intensive. Every time the tank level changes, ProModel tests to see if the tank reached the trigger level. Trigger subroutines are often unnecessary because, unlike an actual tank where sensors report the tank level,
you directly control how much to pump into a tank. For instance, an alternative way to model the previous example without using a triggering subroutine would be to call the Tank_TransferToLevel subroutine to first fill the tank to the 2000 unit level, order the Truck entity and then transfer the rest.

**Processing Multiple Products**

Where you must track several different products through one or more tanks, it may be useful to define macros for naming each product type. For example, setting ProductA equal to 1 and ProductB equal to 2 will improve the readability of the model. To track which product a particular tank is processing, ProModel uses a pre-defined integer array called Tank_Product—the user is responsible for maintaining the array values. If, for example, ProductA begins pumping into Tank1, enter the following after you assign an integer value to ProductA in the Macros module to distinguish it from other products:

**Tracking products**

\[
\text{Tank\_Product}[\text{Tank1}] = \text{ProductA}
\]

**Showing Pipes**

To show pipes connecting the tanks, use paths or background graphics. If you desire to show the material in the pipe, use a long, skinny tank with a capacity of 1 to represent the pipe. You can set the level of this tank to 0 or 1 to show product flow. For example, suppose we define a tank location called Pipe used to represent the connection between Tank1 and Tank2. Whenever transferring from Tank1 to Tank2, you would enter the following:

**Define pipes**

\[
\text{Tank\_SetLevel}(\text{Pipe}, 1) \\
\text{Tank\_Transfer} (\text{Tank1}, \text{Tank2}, \ldots) \\
\text{Tank\_SetLevel}(\text{Pipe}, 0)
\]

**High-Rate Entity Processing**

For systems that process entities at rates higher than one hundred units per minute, using discrete entities could make the simulation extremely slow. For this reason, ProModel uses tanks. To use a tank to model high-rate processing, think of the tank as a buffer where the tank level represents the number of items in the buffer. For example, suppose that bottles feed through a filling station at a rate of 110 per minute. The input buffer, FillerInput, has a capacity of 1200 bottles and the output buffer, FillerOutput, has a capacity of 2000 bottles. If FillerOutput is full, processing stops until the quantity in the output buffer drops to 1500 bottles. An arriving container feeds quantities of 200 bottles to the FillerInput location and it takes 1 minute to unload the container. When the filling station fills 50 bottles, workers put the bottles into a box (represented by an entity) and ship them. Since workers load the boxes as soon
as the bottles complete the filling process, there is no delay time involved.

The operation logic for the container at the arriving location would be as follows:

High-rate processing

WAIT 1 min
Tank_Inc (FillerInput, 200)

To model the processing of bottles from FillerInput to FillerOutput, enter the following statement in the model initialization logic.

High-rate processing

ACTIVATE Tank_Transfer(FillerInput, FillerOutput, 999999, 110, 0, 1500)

This statement causes the FillerInput tank to transfer bottles to FillerOutput at a rate of 110 per minute whenever there are bottles in FillerInput and capacity available in FillerOutput. The resume level is 1500. (Up to 999999 bottles will transfer.)

To model the creation of a 50-bottle box each time the filling station fills 50 bottles, define and activate the following subroutine in the model initialization logic:

Create new, combined unit

Tank Loop //causes logic to repeat continuously
{
    Tank_Dec(FillerOutput, 50)
    Order 1 Box to Shipping

Please note

The Tank_Dec statement automatically removes 50 bottles from FillerOutput whenever there are at least 50 bottles available.

Special Notes

• Since tank models do not stop automatically when there are no more entities or scheduled arrivals, remember to define a run length or a STOP statement.
• When you activate a subroutine, it doesn't process until the current logic (the one activating the subroutine) finishes or becomes blocked. If you want the activated subroutine to process first, enter “WAIT 0” after the ACTIVATE statement.
• Do not define a local variable inside of a Tank_Loop since the loop will create the variable multiple times.
• Make sure all IF...THEN logic and WAIT UNTIL statements based on the Tank_Level array use the “>=” or “<=” operator and not just an “=” operator. (This is because flow occurs in increments and you can’t check for an exact value.)
• Tanks are not legal in multi-unit locations or in locations containing a conveyor or queue.
Background Graphics

Background graphics allow you to enhance a model by adding a background to the animation. A background could show a floor-plan of a factory or any item that is not part of a location, entity, or resource. Backgrounds can be created using the tools in the Background Graphics Editor or by importing an existing background from another application, such as AutoCAD. Imported graphics must have been saved in one of the following formats BMP, EMF, WMF, GIF, or PCX. The Background Graphics Editor is accessed from the Build menu as shown below.

There are two modes for editing in the Background Graphics Editor: Front of Grid and Behind Grid. Generally, most graphics should be laid out in front of the grid. Graphics placed behind the grid should be reserved for large objects such as walls or imported backgrounds.

How to create or edit background graphics:

1. Select Background Graphics from the Build menu.
2. Select Front of Grid or Behind Grid depending on the mode desired.

Background Graphics Editor Modes

ProModel gives you the option of placing the background graphic in front of or behind the grid. This is useful when you want to view the imported background graphic, but you also want to see the grid for drawing and sizing objects on the imported background graphic.

Front of Grid Mode

Creating graphics in this mode places the background graphic in front of the grid as shown below.

Behind Grid Mode

Creating graphics in this mode places the background graphic behind the grid as shown below.
Background Graphics Editor

The Background Graphics Editor allows you to place icons, text and other graphic shapes on the layout behind locations and other system element graphics. The arrangement of the two windows and button bar is shown below.

- The Library Graphics window, containing all the icons in the current graphic library, is located at the top of the workspace.
- The Tools button bar, where you may select a tool for creating and editing graphic shapes, is located at the left of the workspace.
- The Layout window, where all creating and editing of graphic shapes is done, is located in the lower right portion of the workspace.

Library Graphics Window

The Library Graphics window contains the icons of the current graphic library file, specified in the General Information dialog. These icons may be placed on the Layout in the same way as other objects.

You may size the window as desired, or use the scroll bar shown above to scroll through the available icons.

Tools Button Bar

The Tools button bar contains the tools necessary to create objects various shapes. It also contains
tools for editing those objects including flip, rotate, and cut.

The Background Graphics Editor Tools button bar is the nearly the same Tools button bar used in the Graphic Editor. The only difference is that the Background Graphics Editor Tools button bar does not contain an entity spot or status light tool. For more information on the Tools button bar, see “Graphic Tools Button Bar” on page 315.

**Edit Menu**

Use the Edit menu for selecting and duplicating the graphic objects in the current Background Graphics mode. You may also use it to exchange graphics with other applications. To use the Edit menu functions, select the object you wish to edit by clicking on it in the Layout window.

The first four functions apply to the currently selected object. To select multiple objects, hold the shift key while selecting an object. Alternatively, you can drag a rectangle encompassing the objects you want selected. To deselect one of several selected objects, click on the selected object while holding the shift key.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Removes the selected object(s) and makes a temporary copy that may be pasted back into the edit window later.</td>
</tr>
<tr>
<td>Copy</td>
<td>Makes a temporary copy of the selected object(s) for later pasting.</td>
</tr>
<tr>
<td>Paste</td>
<td>Adds the most recently cut or copied object(s) to the Layout window.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected background graphic from the Layout window.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all of the graphic objects in the current mode.</td>
</tr>
<tr>
<td>Copy to Clipboard</td>
<td>Copies all graphic objects in the current mode to the clipboard as a bitmap or windows metafile so they can be pasted into another application such as a word processor.</td>
</tr>
<tr>
<td>Paste WMF</td>
<td>Pastes a Windows metafile (WMF) from the Windows clipboard into the Layout window. You must have previously copied a Windows metafile to the Windows clipboard.</td>
</tr>
<tr>
<td>Paste BMP</td>
<td>Pastes a bitmap file (BMP) from the Windows clipboard into the Layout window. You</td>
</tr>
</tbody>
</table>
must have previously copied a bitmap file to the Windows clipboard.

**Import Graphic** Imports a WMF, EMF, BMP, PCX, or GIF file into the Layout window.

**Export Graphic** Exports all graphic objects in the current mode to a WMF or BMP file.

### Importing a Graphic

Importing a background graphic can bring reality into the model. For example, if a layout is created in a graphic package, it may be desirable to import the entire layout rather than create it in ProModel. This is done by saving the file in a graphic package, such as AutoCAD, as a WMF, EMF, BMP, PCX, or GIF file and importing the graphic into ProModel. This can save you an extensive amount of time.

#### How to import a background graphic into the layout:

1. In a graphics application, save the graphic in one of the following formats, WMF, EMF, BMP, PCX, or GIF.
2. Select **Background Graphics** from the *Build* menu.
3. Select **Front of Grid** or **Behind Grid**.
4. Select **Import Graphic** from the *Edit* Menu.
5. Enter the name of the graphic you would like to import or browse to the directory where the graphic is located.
6. Select **OK** to close the import graphic dialog box. The graphic will then appear in the layout window. The upper left corner of the imported graphic will align with the upper left corner of the layout window.

#### How to move an imported background graphic:

- Place the cursor on the imported background graphic and drag it to the desired location in the layout.

#### How to size an imported background graphic:

1. Place the cursor on one of the four corners of the imported background graphic. The cursor becomes a cross-hair at this point.
2. Drag the cursor to size the background graphic as desired.

#### Please note

*Once imported, the background graphic is not a separate file from the model. It is included in the model. Therefore, when moving or copying a model file from one directory to another, it is not necessary to move or copy the imported background graphic file as well. On the other hand, if the external graphic file is changed, it must be re-imported to update the model layout.*

### Exporting a Graphic

In some cases, it is desirable to export a graphic created in ProModel for use in another application. ProModel will export all objects in the current mode (In Front of Grid and Behind Grid) as one graphic to a WMF or BMP file.

#### How to export a graphic:

1. Select **Export Graphic** from the *Edit* menu.
2. Enter a valid DOS name for the graphic in the resulting dialog box, such as forklift.bmp.

3. Click the OK button in the Export Graphic dialog box.

---

**Graphics Menu**

The Graphics Menu allows you to flip and rotate the selected graphic object(s) in the layout window. It also allows you to specify whether you want the graphic to be behind or in front of the grid. Additionally, it allows you to group selected graphic objects together into a single graphic. Finally, it provides the option to define line styles, fill patterns, line color, and fill color.

<table>
<thead>
<tr>
<th>Graphics Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip Horizontal</td>
</tr>
<tr>
<td>Flip Vertical</td>
</tr>
<tr>
<td>Rotate</td>
</tr>
<tr>
<td>Behind Grid</td>
</tr>
<tr>
<td>Front of Grid</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Ungroup</td>
</tr>
<tr>
<td>Lock</td>
</tr>
<tr>
<td>Unlock</td>
</tr>
<tr>
<td>Alignment</td>
</tr>
<tr>
<td>Line Styles</td>
</tr>
<tr>
<td>Fill Patterns</td>
</tr>
<tr>
<td>Line Color</td>
</tr>
<tr>
<td>Fill Color</td>
</tr>
</tbody>
</table>

**Flip Horizontal**  Horizontally flips the selected object(s).

**Flip Vertical**  Vertically flips the selected object(s).

**Rotate**  Rotates the selected object(s) 90 degrees clockwise. This does not apply for non-true-type fonts.

**Behind Grid**  Moves the selected object in the layout window behind the grid. Once this is done, you must go to Behind Grid mode to edit the graphic.

**Front of Grid**  Moves the selected object in the layout window in front of the grid. Once this is done, you must go to Front of Grid mode to edit the graphic.

**Group**  Combines or groups several graphic objects into a single graphic so they may be sized and edited together.

**Ungroup**  Ungroups several grouped graphic objects so they may be edited individually.

**Lock**  Locks a graphic in place so that it can’t be moved. This is helpful for preventing accidental moving of a graphic that you wish to leave stationary.

**Unlock**  Unlocks a locked graphic, allowing it to be moved on the layout.

**Alignment**  When multiple objects are selected on the layout, they can be aligned side to side, top to top, etc.

**Line Styles**  Allows the user to define the line style including transparent, dashed, line thickness, and optional arrowheads on either end of the line. If any objects are selected, the line styles of the selected objects are changed.

**Fill Patterns**  Allows the user to define the fill pattern for solid objects including slant, grid, crosshatch, backward slant, horizontal, vertical, transparent, solid, vertical gradient, and horizontal gradient. If any objects are selected, the fill patterns of the selected objects are changed.

**Line Color**  Allows the user to define the line color and create custom colors. If any objects are selected, the line color of the selected objects are changed.

**Fill Color**  Allows the user to define the fill color and create custom colors for solid objects. If any
objects are selected, the fill color of the selected objects are changed.

Please note

All functions in the Graphic menu of Background Graphics are nearly the same functions described in the Graphic Editor Graphic menu. Differences are noted below for moving a graphic behind the grid and in front of the grid. See “Graphic Editor” on page 304 for more information on the functions above.

How to move a graphic behind the grid:

1. Select the graphic on the layout using the selector.
2. Select **Behind Grid** from the **Graphics** menu.

How to move a graphic in front of the grid:

1. Select the graphic on the layout using the selector.
2. Select **Front of Grid** from the **Graphics** menu.
Chapter 6: Building the Model: Advanced Elements

Attributes

Attributes are place holders similar to variables, but are attached to specific locations and entities and usually contain information about that location or entity. Attributes may contain integers or real numbers. You may also assign model element names (e.g., StationA) to an attribute, which is stored as the element’s index number but may be referenced by name. Attributes are defined through the Build menu as shown below.

How to create and edit attributes:

1. Select Attributes from the Build Menu.

Attribute Types

Attributes are classified as follows:

Entity Attributes

Entity attributes are place holders assigned to an entity and contain numerical information about that entity. An entity attribute is identified by its name and may be assigned a value or model element name stored as a value. An entity attribute may be examined and acted upon in any of the following places:

- Arrival logic
- Operation logic
- Move logic which refers to the attribute of the entity being routed
- Min or Max attribute rules for locations and resources
- Routing quantity
- Routing destination priority
- Resource pick up and drop off times
- Entity speed
- Debug condition
Location Attributes

Location attributes are place holders assigned directly to a location and contain numerical information about that location. A location attribute is identified by its name and may be assigned a value or model element name stored as a value. A location attribute may be examined and acted on in any of the following places:

- Arrival logic
- Operation logic
- Move logic
- Min or Max attribute for selecting incoming entities as a location rule
- Routing quantity
- Routing destination priority
- Resource pick up and drop off times
- Location down time logic
- Debug condition

Memory Allocation for Attributes

Because locations always exist during a simulation, location attributes always use memory. However, attributes for entities are not created until the first time any of the entity’s attributes are examined or set. At that time, ProModel allocates enough memory for all of the entity’s attributes. When the entity exits the system or is absorbed by another entity through a COMBINE or JOIN statement, ProModel automatically frees the memory allocated for its attributes.

Attributes vs. Local Variables

Attributes are primarily useful where the value of the attribute is assigned in one logic section and evaluated in another logic section or field, perhaps at a different location. If, however, an attribute is assigned a value and evaluated within the same logic section (e.g., an operation logic), it would be more appropriate to use a local variable. Local variables act like temporary attributes and are valid only within the logic in which they are defined (see “Variables” on page 223).

Cloning Attributes

Whenever one entity initiates the creation of other entities through a SPLIT AS, CREATE, or ORDER statement, or as the result of specifying multiple outputs in a routing, the attributes of the original entity are automatically copied to each newly created entity.

The following examples show two methods of splitting an incoming batch of material, called BatchA, into one Tote and six EntA’s. The first method uses a CREATE statement in the operation logic to create the new entities, called EntA. The original entity, BatchA, will have its name changed to Tote in the routing table. In the second example, both of the new entity types are created in the routing table, so no CREATE statement is needed in the operation logic. In both cases, the attributes attached to the original entity, BatchA, are duplicated in both Tote’s and the EntA’s attributes.
Process Logic

<table>
<thead>
<tr>
<th>Entity...</th>
<th>Location...</th>
<th>Operation...</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1A</td>
<td>Attr3 = 6 WAIT N</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc1B</td>
<td>WAIT 1.0</td>
</tr>
<tr>
<td>EntA</td>
<td>Loc2</td>
<td></td>
</tr>
</tbody>
</table>

Notes  A general notes field for describing the attribute. Notes fields contain user comments only and are never analyzed by ProModel. Click on the Notes button or double click in the field to open an edit window for entering detailed notes.

Example of Attributes in Logic

An appliance manufacturer’s model contains an assembly location to join lids to pots. The pots are either aluminum or steel and both types of pots arrive at the same assembly location. If an aluminum pot arrives at the assembly location, it must be joined with an aluminum lid. The same is true for a steel pot and lid. The entities, steel_lids and alum_lids, are waiting at a queue to be joined to the pots.

Obviously, one way to model the different pot types is to use two different entity types. This example shows how to achieve the same effect using a single entity type (pot) with an attribute designating whether it is steel or aluminum.

An attribute called “type,” defined in the attribute edit table, allows the location to tell what type of pot has arrived at the assembly location. We will use a value of 1 to represent a steel pot and a value of 2 to represent an aluminum pot. When a steel pot enters the system, we assign a value of 1 to the attribute TYPE with the statement TYPE=1. When an aluminum pot enters the system, we set its type to 2.

Routing Table

Attribute Edit Table

This edit table is used to define entity and location attributes.

<table>
<thead>
<tr>
<th>ID</th>
<th>The name of the attribute.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of the attribute, real or integer.</td>
</tr>
<tr>
<td>Classification</td>
<td>Entity attribute or location attribute.</td>
</tr>
</tbody>
</table>
At the assembly location, we use the following logic:

```
IF type=1 THEN
  JOIN 1 steel_lid
ELSE
  JOIN 1 alum_lid
```

This logic checks the type of the pot and then joins a lid according to that type.

### Attributes and the JOIN or LOAD PERM Statement

In some cases, one entity joins onto a base entity using the JOIN or LOAD PERM statement (see “Join” on page 494 for more information). If both the joining and base entities possess attributes before the join occurs, the resulting joined entity will possess the attribute values of the base entity. In other words, the entity with the IF Join (or IF Load) routing rule is effectively destroyed when it gets joined or permanently loaded. Consider the following diagram in which EntA joins to EntB:

![Diagram showing EntA joining to EntB](image)

In the above example, EntB would have an attribute value, Att1, equal to 2 after EntA joined to EntB.

### Attributes and the GROUP/ UNGROUP Statements

Suppose several entities, EntA, EntB, and EntC, are grouped together and called Batch (see “Group” on page 483 and “Ungroup” on page 558). Each of the original entities have attributes with values assigned to them before they are grouped. The Batch is processed for 30 minutes, sent to Loc5 and then ungrouped into the original entities.

The attribute values of the individual entities are not transferred to the grouped entity, Batch. In other words, Att1=0 for the entity, Batch. However, once the entities are ungrouped, they retain...
their original attribute values. The following diagram graphically shows the concept of grouping.

The logic for the diagram is as follows:

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>Att1 = 1</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc2</td>
<td>Att1 = 2</td>
</tr>
<tr>
<td>EntC</td>
<td>Loc3</td>
<td>Att1 = 3</td>
</tr>
<tr>
<td>ALL</td>
<td>Loc4</td>
<td>GROUP 3 AS Batch</td>
</tr>
<tr>
<td>Batch</td>
<td>Loc4</td>
<td>WAIT 30</td>
</tr>
<tr>
<td>Batch</td>
<td>Loc5</td>
<td>UNGROUP</td>
</tr>
<tr>
<td>ALL</td>
<td>Loc5</td>
<td>...</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc4</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>EntB</td>
<td>Loc4</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>EntC</td>
<td>Loc4</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>Batch</td>
<td>Loc5</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
<tr>
<td></td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

**Please note**

You can assign an attribute value to a grouped entity. However, once the entities are ungrouped, they retain the attribute values they possessed before they were grouped.

**Attributes and the LOAD/UNLOAD Statements**

The LOAD statement permanently or temporarily loads a specified quantity of entities on to a base entity. Temporary loaded entities retain their identity for future unloading through an UNLOAD statement (see “Load” on page 499 and “Unload” on page 561 for more information). When the entities are temporarily loaded onto the a base entity, the resulting entity retains the attribute value of the base entity.

For example, entities called Box are temporarily loaded onto a base entity, Pallet. The Boxes are assigned an attribute value, Att1=1. Pallets are also assigned an attribute value, Att1=2. Once the Boxes are loaded onto the Pallet, the loaded pallet is renamed Shipment. The Shipment then has an attribute, Att1=2, because it inherits the attribute value of the Pallet. However, we then assign an attribute value to Shipment, Att1=3. After the Boxes are unloaded from the Shipment, the unloaded shipment is renamed back to Pallet and the Boxes retain their original attribute value, Att1=1. Now the Pallet has a different attribute value, Att1=3, which was assigned to the renamed entity, Shipment. Consider the following diagram and logic in which two Boxes are loaded onto a Pallet and renamed Shipment for the output entity:

The logic for the diagram is as follows:
Chapter 6: Attributes

Attributes and the COMBINE Statement

Consider the example where several entities are combined permanently into a single entity, Box. The following diagram demonstrates three entities combining into one entity.

![Diagram of entities combining into a single entity Box]

The logic for the diagram is as follows:

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Loc1</td>
<td>Att1 = 1 WAIT 2 min</td>
</tr>
<tr>
<td>Box</td>
<td>Loc2</td>
<td>Att1 = 2 LOAD 2</td>
</tr>
<tr>
<td>Shipment</td>
<td>Loc3</td>
<td>Att1 = 3 WAIT 20</td>
</tr>
<tr>
<td>Shipment</td>
<td>Loc4</td>
<td>UNLOAD 2</td>
</tr>
<tr>
<td>Box</td>
<td>Loc4</td>
<td>WAIT 10</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Box</td>
<td>Loc2</td>
<td>LOAD 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>Shipment</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td>MOVE FOR 3</td>
</tr>
<tr>
<td>1</td>
<td>Shipment</td>
<td>Loc4</td>
<td>FIRST 1</td>
<td>MOVE FOR .5</td>
</tr>
<tr>
<td>1</td>
<td>Pallet</td>
<td>Loc5</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>Box</td>
<td>Loc5</td>
<td>FIRST 1</td>
<td>MOVE FOR 2</td>
</tr>
</tbody>
</table>

EntA
EntB
Loc4
EntC
Box

Three entities are combined to form a single entity called Box.

In the above example, EntC is the last entity to be combined so the entity Box assumes the attribute value of EntC, Att1=5.
Variables

Variables are of two types: global and local. Global variables are place holders defined by the user to represent changing numeric values. Local variables are place holders which are available only within the logic that declared them. Variables can contain either Real numbers or Integers, including element index values, and are typically used for decision making or recording information. A global variable can be referenced anywhere numeric expressions are allowed in a model. If a variable or attribute is needed only in a single block of logic, it is easier to define a local variable right inside the logic block. Global variables are defined in the Variables Editor, accessed from the Build menu. Local variables are defined with the INT and REAL statements. (See “Local Variables” on page 225 for more information.)

Variable Edit Table

This edit table is used to define Variables used globally in the model. A description of each field is given below.

Icon  This field shows “Yes” if an icon for the variable appears on the layout. A variable’s icon looks like a counter and displays the variable’s value.

ID  The variable’s name.

Type  The type of variable, real or integer.

Initial Value  The initial value of the variable to be assigned at the start of the simulation. By default, initial values are 0, but can be changed in the edit table to whatever value you want. Any expression can be entered here (including previously defined variables) except attributes and system functions.

Stats  ProModel collects statistics for each variable on three levels of detail, None, Basic, and Time Series.

• None  No statistics are collected for this variable during simulation.

• Basic  Collects basic statistics such as total changes, average minutes per change, current value, and average value.

• Time Series  Collects all the basic statistics plus the value history based on time or observations. When you select Time Series, ProModel collects either time-weighted or observation-based statistics.

How to access the variable edit table:

1. Select Variables (global) from the Build menu.
for the variable depending upon the type selected.

<table>
<thead>
<tr>
<th>None</th>
<th>Basic</th>
<th>Time Series</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Time-Weighted Observation-Based</td>
<td>Cancel</td>
<td></td>
</tr>
</tbody>
</table>

**Time-Weighted**  Collects information on the percentage of time the variable was at a specific value. As shown in the above table, the average value of the variable is:

\[
\frac{(6 \times 1) + (6 \times 3) + (5 \times 2) + (5 \times 4)}{10} = 5.4
\]

**Observation-Based**  Collects information on the number of times the variable changed to a specific value. As shown in the above table, the value of the variable is 6, then 5, then 6, then 5. The average would simply be:

\[
\frac{6 + 5 + 6 + 5}{4} = 5.5
\]

**Notes**  A general notes field for describing the variable. Click on the Notes button or double click in the field to open an edit window for entering detailed notes.

---

**Please note**

*In order to create plots or histograms for a variable, Time Series stats must be selected in the variables edit table.*

---

**Variable Layout**

An icon to show a variable’s value during a simulation may be placed anywhere on the layout. The window below shows the icons for the variables Current and Total at the right side of the screen. Each icon has been labeled with a background graphic.

---

**How to place an icon for a variable on the layout:**

1. Highlight the desired variable in the Variable edit table.
2. Click on the layout where the icon is to appear.
3. Size the icon by dragging an edge or corner of the sizing box.
How to remove an icon for a variable from the layout:

1. Double click on the icon.
2. Choose Delete from the resulting menu. The icon is removed from the layout, but the variable remains in the model.

Editing a Variable’s Icon

A variable’s icon can be customized as necessary by simply double clicking on the icon and choosing Edit. A dialog box appears as shown below for specifying the characteristics of the variable icon or counter.

![Variable Icon Dialog Box]

How to edit a variable’s icon:

1. Double click on the icon.
2. Click on the Digit Color, Frame, or Font buttons to adjust the respective setting.
3. Click on OK.
4. All other variable icons that you create from now on will retain these modifications.

Local Variables

Local variables function as though they were temporary attributes defined in a specific logic section which disappear when the logic section is finished executing. Local variables are useful for test variables in loops and storing locally used, unique values for each entity at the current location.

Local variables are used within a block of logic (i.e., operation logic, subroutines) and are declared with an INT or REAL statement. Local variables are only available within the logic in which they are declared and are not defined in the Variables edit table. A new local variable is created for each entity to encounter an INT or REAL statement (See “Int” on page 542 and “Real” on page 529). A local variable is specific to each entity, in much the same way an attribute is specific to an entity, except that the local variable is only available while the entity processes the logic to declare the local variable. Local variables may be passed to subroutines as parameters. Local variables are available to macros.

Example

A plant manufactures valves of 10 different sizes, such as 10", 20", .... All valves are inspected at a common inspection station and then move to a dock where they are loaded onto pallets. The pallets are designed to hold only a certain size valve. Therefore, a pallet designed to hold 10" valves can only hold 10" valves, not 20" valves.

Suppose a Pallet enters a multi-capacity location, Dock. Each Pallet has a different entity attribute, p_type, describing the type of valve it can hold. Valves are loaded onto the Pallet. The 10” valves must be loaded onto the pallet designed to hold the 10” valves. Therefore, the attribute value of the Valve, v_type, must match the attribute value of the Pallet, p_type. We can use local variables
to accomplish this modeling task. The logic is as follows where X is a local variable:

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valve</td>
<td>Inspect</td>
<td>WAIT 5</td>
</tr>
<tr>
<td>Pallet</td>
<td>Dock</td>
<td>INT X&lt;br&gt;X = p_type&lt;br&gt;LOAD 10 IFF&lt;br&gt;X = v_type&lt;br&gt;WAIT 10</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Valve</td>
<td>Dock</td>
<td>LOAD 1</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td>1</td>
<td>Pallet</td>
<td>Delivery</td>
<td>FIRST 1</td>
<td>MOVE FOR 8</td>
</tr>
</tbody>
</table>

If we had not used local variables, we would need to use the following operation logic for Pallet at Dock:

If Dock was a single capacity location, using a global variable would work the same as using a local variable. However, because Dock is a multi-capacity location, it can load valves onto multiple pallets at the same time. If a global variable was used instead of a local variable, the global variable would change each time a pallet entered Dock. If there were two different types of pallets at Dock, there would be only one type of valve loaded on the pallet because the global variable refers to both pallets.

Suppose, for example, a global variable, type, signifies the pallet attribute, p_type. We assign type=p_type at the beginning of the operation logic for location Dock. The first pallet arrives and type=3. Therefore, only valves with v_type=3 are loaded onto the pallet. Another pallet enters Dock and type=5. Now only valves with v_type=5 are loaded onto both pallets.

As can be seen from the two examples of logic, the first example is much easier and more straightforward.

It is important to note that using “LOAD 10 IFF p_type = v_type” in the operation logic would not work for the intended purpose. Attributes referenced in IFF conditions always refer to the entity being loaded. Set the value of a local variable, X, to the pallet attribute, p_type, so it can be referenced in the LOAD statement. The pallet attribute cannot be directly referenced in the LOAD statement.

Please note

**Local variable notes:**

1. You may not use the WAIT UNTIL statement with local variables.
2. The local variable definition only needs to appear somewhere in the logic before being referenced. The entity does not need to execute the local variable definition statement (INT, REAL).

<table>
<thead>
<tr>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF p_type=1 THEN&lt;br&gt;LOAD 10 IFF v_type=1&lt;br&gt;IF p_type=2 THEN&lt;br&gt;LOAD 10 IFF v_type=2&lt;br&gt;IF p_type=3 THEN&lt;br&gt;LOAD 10 IFF v_type=3&lt;br&gt;...&lt;br&gt;IF p_type=10 THEN&lt;br&gt;LOAD 10 IFF v_type=10</td>
</tr>
<tr>
<td>Line: 1</td>
</tr>
</tbody>
</table>
Arrays

An array is a matrix of cells that contain real or integer values. Each cell in an array works much like a variable, and a reference to a cell in an array can be used anywhere a variable can be used. A one-dimensional array may be thought of as a single column of values. A two-dimensional array is like having multiple columns of values (similar to a spreadsheet).

To reference a cell in a one-dimensional array, give the name of the array and enclose the cell number in brackets. For example, if a one-dimensional array containing ten cells is named OpnArray, to reference the fifth cell you would use OpnArray[5]. To reference a cell in a two-dimensional array, simply use the name of the array with the row and column number in brackets. For example, the statement OpnArray[3,4] references a cell on the third row in the fourth column.

Arrays with more than two dimensions are more difficult to picture, but work exactly the same as one and two dimensional arrays. For example, if an array has a third dimension, you can reference any cell simply by adding a comma before the number of the desired cell in the third dimension. For example, Tool[3,5,8]. Four and five-dimensional arrays work the same way. The maximum number of dimensions for an array is 20.

Array cell values are assigned in the exact same way as you would assign a value to a variable. For example, to assign the value 18 to the cell at the fifth row and second column in an array named Arr1 you would use the following statement.

Assign array cell value

Arr1[5,2]=18

Arrays are defined in the Arrays editor accessed through the Build menu.

How to use the arrays editor:

1. Select Arrays from the Build menu.

Example Arrays

The following examples show how elements are referenced in a one-dimensional array with five cells and in a two-dimensional array with fifteen cells.

One-dimensional array

OpnArray[5]

Cell[1]
Cell[2]
Cell[3]
Cell[4]
Cell[5]
Two-dimensional array

Tool[3,5]

<table>
<thead>
<tr>
<th>ID</th>
<th>Dimensions</th>
<th>Type</th>
<th>Import File</th>
<th>Export File</th>
<th>Persist</th>
<th>Notes</th>
</tr>
</thead>
</table>

The Arrays edit table is used to define Arrays that are used in the model. The fields of the Arrays edit table are explained on the following page.

ID: The name of the array.

Dimensions: The size of each dimension of the array in cells. For example, the dimensions of a one-dimensional array of 100 cells is “100.” Likewise, a two-dimensional array with 50 rows and five columns would have dimensions of “50,5.” The number of rows is first, followed by a comma and then the number of columns. An array cannot have more than 20 dimensions.

Type: The type (integer, real, string, or expression) for all cells in the array.

Import File: The name of the spreadsheet from which you will populate the array. You may enter either a fully qualified path to your .xls file or a path relative to your .mod file. For example, if your .xls file is in the same directory as your .mod file, simply enter the name of the .xls file into this field.

See “Export Arrays to Spreadsheets” on page 231 for more information on using the Export dialog.

Disable: Use this option to have the import file, export file, or both ignored during simulation without deleting the name of the import or export files from the Array record. Choose “None” to use the specified import and export files.

Persist: When running multiple replications you may choose to keep the values in the array from one replication to the next or clear (reset) the array values every replication.

For example, if you run a simulation for three scenarios with an array that “Keeps” its values, the data in the array at the end of the first replication will be kept and used as the second replication begins. If you are using an Import File, it will be used to populate the array for the first replication, but ignored for subsequent replications when “Keep” is selected for the array.

If you choose to “Clear” the array, no array information will be kept from one replication to another and the array will be reset with its initial information at the beginning of each replication (see the next heading “Initializing Arrays”). If you are using an Import File, it will be used to populate the array at the beginning of each replication when “Clear” is selected for the array.

Notes: A general notes field for entering descriptive information about the array. Click the heading button or double click in this field to open a larger window for entering notes.

The window pictured above shows how to define the example arrays that appear on the previous page.
Initializing Arrays

By default, all cells in an array are initialized to zero. Initializing cells to some other value should be done in the initialization logic. A WHILE...DO loop is useful for initializing array cell values. The logic below fills a 3 x 5 array (3 rows and 5 columns) with values from an external, general read file.

This example uses the variables Column and Row (which may be defined as local variables) along with two WHILE...DO loops to assign every cell in the array Inventory_Array a value from a general inventory file. The logic first sets the value of the variable Column to one. It then assigns all the cells in column one a value by reading a value from the external file and incrementing the variable Row. When all the cells in column one have a value, the logic increments to the second column and does the inside loop again. It repeats this loop until each cell in the array has a value.

Please note

Assigning values to a cell in an array can be done in any expression or logic field, such as initialization and operation logic. See “Execution Time of Initialization and Termination Logic” on page 172 for a list of logic elements used to define model parameters.

Import Data into Arrays

When you import data, from either an external Excel spreadsheet or SQL database, into an array, ProModel loads the data from left to right, top to bottom. Although there is no limit to the quantity of values you may use, ProModel supports only two-dimensional arrays.

Import from an Excel Spreadsheet

Import File  The name of the spreadsheet you will use. You may enter either a fully qualified path to your .xls file or a path relative to your .mod file. For example, if your .xls file is in the same directory as your .mod file, simply enter the name of the .xls file into this field.

Sheet Name  The name of the sheet from which you will import the array data.

Please note

If your spreadsheet contains only a single data set, ProModel will automatically load the data into the array—you do not have to define any cell information unless you wish to limit the contents of the array to a portion of the data set.
Array import requires Microsoft Excel 97 or later.

Import Start Cell  The first piece of data to place into the array.

Import End Cell  The last piece of data to place into the array.

How to import Excel spreadsheet data into array:

1. Select Arrays from the Build menu.
2. Select or create the array record (row) you wish to import.
3. Click the Import File button on the Arrays dialog.
4. In the File field, enter the name of the spreadsheet you wish to use (you may also browse to select a file).
5. In the Sheet Name field, enter the name of the worksheet that contains the data you wish to use.
6. Enter the Import Start Cell location. The value in this cell will occupy the first position in the array.
7. Enter the Import End Cell location. The value in this cell will occupy the last position in the array.
8. Click OK.

Import from a SQL Database

Connection String  The connection string used to connect to the SQL database including all necessary security parameters.

Query or Stored Procedure  Enter the SQL query or the name of the stored procedure to be executed during the model’s initialization logic to populate the array.

How to import SQL database data into array:

1. Select Arrays from the Build menu.
2. Select or create the array record (row) you wish to import.
3. Click the Import File button on the Arrays dialog.
4. Click on the Database radio button.

5. In the Connection String field enter the necessary string to connect to the desired database.

6. In the Query or Stored Procedure field enter the SQL query or stored Procedure name that will be used to populate the array during the initialization logic.

7. Click OK.

Export Arrays to Spreadsheets

The fields in the Export Arrays dialog have similar functionality as those for the Import Arrays dialog.

If you export multiple times to the same spreadsheet, ProModel will overwrite the spreadsheet with new data. If you wish to prevent your data from being overwritten, you can make a backup of the spreadsheet between each running of the simulation.

If you are running multiple scenarios and/or replications, see step 5 below for a description of how the spreadsheet handles the multiple scenarios/replications.

How to export array data:

1. Select Arrays from the Build menu.
2. Click the Export File button on the Arrays dialog.
3. Enter the name of the spreadsheet file you wish to use, or browse to select a file.
4. Click OK.
5. When the simulation is run, the array data will be saved to the spreadsheet file. If you ran multiple scenarios and/or replications, data from each one will be saved to a separate sheet in the spreadsheet file, as seen below.
Using Arrays

Using arrays can simplify a model. Suppose you need to model an assembly line that attaches components to a computer motherboard. Furthermore, you want to track the usage of component parts over time. Without an array, hundreds of individual entities of various types would have to represent hundreds of individual components. Keeping track of all the components would be very complex, not to mention all of the join operations and routings for performing the assembly. Instead, various cells in a one-dimensional array could track the number of each type of component used during the simulation.

An array can do the job more efficiently. The initial inventory level for each component could be stored in an external file and read into the cells of the array at the start of the simulation. The first cell might contain the inventory level of transistors; the second could contain the inventory level of capacitors and so on. When a motherboard arrives at the location adding the components, each cell’s value is decremented according to the number of that type of component joined to the motherboard. If each motherboard requires twelve transistors and five capacitors, then every time a motherboard arrives at the location, the array’s first cell is reduced by twelve and the second cell is reduced by five. Thus the model becomes much less complex because it requires fewer entities and less logic.

Notes on Arrays

1. If a warm-up time is specified, array values are not reset.
2. Arrays can be nested. For example, if Arr1[2,3] is equal to three, then the statement Arr2[5,Arr1[2,3]] works exactly like the statement Arr2[5,3].
3. You can examine the value of a cell in an array during a simulation by choosing Information and then Arrays. This information can also be printed.
4. Arrays can be used with the WAIT UNTIL statement.
5. Statistics are not generated for arrays. However, if you would like to see the final value of an array’s cell, you can use the array export feature to export to Excel, you can place a PAUSE statement in the termination logic and then view the array under the Information menu, or you could print an array’s values or write them to an external file as part of the termination logic. If you want more statistical information on a particular cell, assign the cell to a variable and then choose basic or time-series statistics for the variable.
## Macros

A macro is a place holder for an often used expression, set of statements and functions, or any text that might be used in an expression or logic field. A macro can be typed once, and then the macro’s name can be substituted for the text it represents anywhere in the model and as many times as necessary. Macros are defined in the Macros Editor, accessed from the Build menu.

### How to create and edit macros:

1. Select Macros from the Build Menu.

### Macro Editor

The Macro edit table is used to assign recurring text to a reference name.

<table>
<thead>
<tr>
<th>ID</th>
<th>Text...</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>FPM</td>
<td>fpm representing a conversion factor from miles per hour to feet per minute. If a number is used in multiple places in a model, then a macro makes it possible to change that number throughout the model simply by changing the macro itself. The second macro, Operation_Time, calculates the various operation times at different locations depending on the attributes at the locations. The last macro, Number_of_AGVs, is a run-time interface variable used to define the number of AGVs in the simulation model (see “Run-Time Interface” on page 234).</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td>Allows you to define the macro as a run-time interface parameter or select a resource group.</td>
<td></td>
</tr>
</tbody>
</table>

### Text

Any text to be substituted where the macro name is called. This text may be a complete expression, an entire logic block, or even part of a logic block.

### Options

Allows you to define the macro as a run-time interface parameter or select a resource group.

The example table above defines three macros. The first macro is simply a numeric constant, with fpm representing a conversion factor from miles per hour to feet per minute. If a number is used in multiple places in a model, then a macro makes it possible to change that number throughout the model simply by changing the macro itself. The second macro, Operation_Time, calculates the various operation times at different locations depending on the attributes at the locations. The last macro, Number_of_AGVs, is a run-time interface variable used to define the number of AGVs in the simulation model (see “Run-Time Interface” on page 234).

A macro is different from a subroutine because a macro cannot pass or return a value. However, because it is simply a text replacement, a macro can reference any expression valid in the expression or logic field that called the macro. For instance, the string “the number of entries is” might be a macro called mac1. This macro by itself is not a valid expression. However, when used with the DISPLAY statement in the operation logic (i.e., DISPLAY mac1), the compiler will recognize the macro as a string.

A macro may be used in any expression field, but may only contain a numeric expression (e.g., Entries (LOC1), U(5,1), Var1+Att2, etc.). In addition, a macro used in an expression field may not contain multiple lines of text. When used in a logic field, the macro may include any logic element valid in that logic field.

Suppose five different locations use the same lines of code. Instead of entering the same logic
five times in five different fields, reference the following macro by typing the macro ID, Mac1, in the operation logic of the machine:

Every time the macro is referenced, the logic is executed. Macros can also be nested within other macros. This means that a macro can consist of one or more other macros. Consider the following Macro edit table:

The macro, Favorite_Quote references other macros, such as Race and Finish. Note that some of the other macros, such as For_Quality, are only portions of a complete line of code. Although the macro is valid, it will not compile as a part of macro logic because the create statement requires an expression and an entity name. The line Favorite_Quote in a logic field would be interpreted as the following line, Create 2 As EntB Take 1 Res1.

Please note

Macro notes:

1. A macro may be used only when the elements contained in the macro are appropriate to the context from which it was called. This restriction means that the macro in the previous example is only valid in operation logic.

2. Because a macro simply substitutes some text for its name, if a macro represents a statement block, then it should contain a BEGIN at the beginning of the block, and an END at the end of the block. This technique is especially important when using a macro immediately after a control statement, such as IF...THEN or WHILE...DO. For more information, see “Statement Blocks” on page 426.

Run-Time Interface

Defining a run-time interface (RTI) for a macro allows the user to easily change simulation/model parameters before the simulation starts. It also provides an experimental framework for defining multiple scenarios to be run in a batch (see “Scenarios” on page 343). An RTI for a macro allows a macro’s text to be changed by the user whenever a simulation run begins. Since macros are allowed in any expression, this gives the user flexibility to edit most model parameters every time a simulation starts without having to directly edit the model data.

The key difference between a macro with an RTI and one without is that when a simulation begins, a macro defined with an RTI provides a menu that allows users to change only the macros you want them to change. An RTI allows you to request a variety of information to substitute for a macro; from simple values (e.g., the initial value...
of a location’s capacity) to complex text (e.g., a line of logic). You may create RTI parameters using the dialog box below, accessed through the macros dialog.

Parameter Name  This text will identify the parameter represented by this macro. It should consist of text that clearly describes the parameter to be changed, for example, Operation Time. The macro name and the parameter name can be different. This provides more flexibility and allows you to view a more descriptive parameter name when defining scenarios.

Prompt  This text will appear if the user decides to change the parameter. You should use it to further specify the information to be entered, for example, “Please enter the amount of time the simulation should run.”

Unrestricted Text  This option allows the user to enter any text, such as the distribution U(8,2). Note that any text that the user enters will be substituted for the macro name in the model. Therefore, the text the user enters must be syntactically correct and valid anywhere the macro name appears.

Record Range  Allows you to enable an arrival or shift record from a range of records. This allows you to test a variety of shift and arrival combinations to find the combination that works best with your model.

Numeric Range  This specifies the lower and upper limits for the parameter if the type is numeric.

How to define an RTI for a macro:

1. Select Macros from the Build menu.
2. Type the macro name and click on the Options button.
3. Choose Define from the RTI submenu.
4. Define the Parameter Name and enter the prompt (optional).
5. Select the parameter type: Unrestricted Text, Record Range, or Numeric Range.
6. If the parameter is numeric, enter the lower value in the From box and the upper value in the To box.
7. Click OK.
8. Enter the default text or numeric value in the Macro Text field.
9. Use the macro ID in the model (e.g., in operation or resource usage time).

Please note

When using a record range, be sure to group all arrival and shift records. This will allow you to select which series of records to include in the macro. Note also that when you define an arrival or shift RTI, ProModel adds “ARRIVAL_” or “SHIFT_” to the name to help you identify the macro more easily.
Run-Time Interface Example

Suppose you build a factory model and determine the first lathe, Lathe_1, is a bottleneck. The model results indicate the throughput is lower than expected. You decide to perform several what-if scenarios with the model by changing the operation time of Lathe_1. Instead of changing the operation time at Lathe_1 within the Process edit table, it is easier to define a macro with an RTI. This technique allows the model user to easily see the effect of installing a faster lathe without ever editing the model itself. The following example represents the dialog used to define the RTI for the macro where the operation time is a numeric value between 12 and 20:

After defining the RTI for the macro, substitute the macro, Oper_Time, for the operation time in the operation logic in the Process edit table for Lathe_1 as shown below:

You are now able to change the operation time at Lathe_1 using the Model Parameters option in the Simulation menu. For more information on changing model parameters and defining scenarios, see “Model Parameters & Scenarios” on page 342.

Please note

For more information concerning the differences between macros and subroutines, see “Macros” on page 233 and “Subroutines” on page 238.

Resource Grouping

Resource grouping allows you to define specific groups of resources rather than define each unit separately. For example, suppose you need a specific technician to perform an operation. If the technician is not available, you may use either another technician or one of two qualified operators to perform the operation. Rather than define each qualified operator as a separate resource, you may define a macro that includes them.

How to define a resource group

1. Select Macros from the more elements section of Build menu.
2. Define a macro ID and enter a list of all resources you wish to include as part of the resource group.

Please note

When you create a list of resources, separate each resource using AND or OR (e.g., Tech_1 AND Tech_2 OR Tech_3 AND Tech_4).
3. Click on the **Options** button and select **Resource Group** from the submenu.

At the end of the simulation, ProModel creates a statistical report containing information collected for each resource included in the resource group, as well as the entire group. This will allow you to track individual, as well as group performance. For information on statistics and how to graph the results, see “Reports and Graphs” on page 363.
Subroutines

A subroutine is a user-defined command that can be called to perform a block of logic and optionally return a value. Subroutines may have parameters (local variables) which act as variables local to the subroutine and that take on the values of arguments (i.e., numeric expressions) passed to the subroutine.

ProModel handles subroutines in three ways. First, a subroutine may be processed by the calling logic as though the subroutine is part of the calling logic. This way is the most commonly used, and is done by simply referencing the subroutine by name in some logic or expression. Second, a subroutine may be processed independently of the calling logic so the calling logic continues without waiting for the subroutine to finish. This method requires an ACTIVATE statement followed by the name of the subroutine (see “Activate” on page 431), or you may use the Interact Menu (see “Run-Time Interact Menu” on page 358). Third, ProModel allows subroutines written in an external programming language to be called through the XSUB() function.

Subroutines are defined in the Subroutines Editor which is accessed from the Build Menu.

How to create and edit subroutines:

1. Select Subroutines from the Build menu.

Subroutine Editor

The Subroutines edit table consists of several fields which identify the components of a subroutine. Each of these fields is described below.

<table>
<thead>
<tr>
<th>ID</th>
<th>Type</th>
<th>Parameters</th>
<th>Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Time</td>
<td>Real</td>
<td>P1, P2, P3, P4, Order-Time, ProdTime, Prod</td>
</tr>
</tbody>
</table>

ID: A name that identifies the subroutine.

Type: The type of numeric value returned by the subroutine can be Real, Integer, None, or Interactive. Use Real and Integer if the subroutine returns a number and None when no return value is expected, as is often the case in initialization or termination logic. Subroutines of type Interactive...
are identical to subroutines of type None, except that interactive subroutines are also accessible for activation by the user through the run-time menu. Interactive subroutines are displayed in the Interact menu during runtime. For more information on Interactive subroutines, see the discussion later in this section.

Parameters  Arguments passed to the subroutine get assigned to local variables called parameters. Items passed to a subroutine as arguments can have different names than the parameters that receive them. Parameters can be real or integer. The first parameter receives the first argument, the second parameter receives the second argument, and so on.

Logic  One or more statements to be executed whenever the subroutine is called. Statements in subroutines must be valid in the logic that calls the subroutine. Subroutine logic may contain a RETURN statement with a value to be returned from the subroutine. (See “Return” on page 539 for the correct syntax and an example of this statement.)

Please note

Subroutine editor notes:

1. If the subroutine is of type Integer and the return value is a real number, the return value will be truncated unless the ROUND() function is used (e.g., RETURN ROUND(<numeric expression>)).

2. If you do not want a stand-alone subroutine referenced in operation logic to be treated as an implicit wait statement, define the subroutine as type None.

3. When using the ACTIVATE statement to call a subroutine, the calling logic continues without waiting for the called subroutine to finish. Therefore, independent subroutines can run in parallel with the logic that called them.

4. Independent subroutines called with the ACTIVATE statement cannot contain entity-specific or location-specific system functions.

Subroutine Format

A subroutine may be named any unique, valid name. The general format for calling a subroutine is as follows:

SubroutineName(arg1, arg2,....,argn)

Subroutine call

GetOpTime(3,7)
DoInitialization()

Please note

Subroutine format notes:

1. If no arguments are specified, open and closed parentheses are still required.

2. Statements in subroutines must be valid in the logic that called the subroutine. For example, if a subroutine is called from the operation logic, the subroutine may contain only those statements valid in the operation logic. Subroutines called from an ACTIVATE statement or from the Interact Menu at run-time can have any general logic statements, including WAIT.

3. A subroutine may be used in any logic field. In addition, a subroutine may be used in any expression field, provided that the RETURN statement is used to return a value to the expression field.
Expression fields include the Qty Each column of the Arrivals edit table and the routing rule for processing.

4. If a subroutine does not return an expression with the RETURN statement, a value of zero will be returned for subroutines of type Real and Integer. No value will be returned for a subroutine of type None or Interactive.

Subroutine Example

Suppose that you build a Copy Center model and it is necessary to define the processing time at the operator assisted machines as a function of two parameters: Order Quantity and Quality Level. In addition, you would also like to write the processing times at each copy machine to a file called Report.Dat.

Because the operation logic is identical at both machines, a subroutine may be used to execute the group of statements required. Notice in the Process Logic pictured next that Subroutine OrderTime is called, and each order’s Quantity, Quality, and Ticket attributes are passed as arguments. The third argument is simply a constant value, 1 or 2, which represents the location from which the subroutine was called (i.e., 1 if called from OpAsist1 or 2 if called from OpAsist2). The operation logic, which calls the subroutine, and routing are shown below. The subroutine itself is shown later in this section.

Subroutines Edit Table

The Subroutine edit table lists the name of the subroutine, the return type, the parameters to be passed to the subroutine, and the logic. Notice that the subroutine ID corresponds to the subroutine name called in the processing logic above and that the subroutine has four parameters (P1, P2, P3 and P4) corresponding to the four arguments passed to the subroutine. Also note that the subroutine is of type real since the return value will be a real valued processing time.

Subroutine Parameters

The subroutine parameters, M (for mean) and SD (for standard deviation), are defined by clicking on the Parameters heading button. These values are unique to each inspection location, and are
passed to the subroutine as parameters of the normally distributed inspection time.

**Subroutine Logic**

The final step in defining the subroutine is to specify the logic to be processed when the subroutine is called. In this example, the logic should include a processing time, a procedure to write the values of the attributes to a file, and a routing decision based on the values of the two attributes. The logic window is accessed by clicking on the Logic heading button.

The first line of the logic calculates the order time as a function of the Quantity and Quality attributes passed as parameters. These parameters are used as arguments in two user-defined functions, ProcTime() and QualFactor(). Function ProcTime() returns a time value based on the number of copies in the order, while function QualFactor() returns a scale factor depending upon the quality level desired. Operation time is determined by simply multiplying the process time by the scale factor.

Once the order time has been determined, this value is written to the file Report.Dat. Included with the operation time is the job number and the location at which the job was processed.

The last line of the logic returns the order time value to the processing logic.

**Interactive Subroutines**

Interactive subroutines are subroutines activated by the user anytime during run-time by choosing the subroutine from the Interact menu. The name appearing in the Interact menu is either the subroutine name or if a string is entered as a comment statement at the beginning of the subroutine logic, the string is used as the name (e.g., # “Arrival Frequency”). Interactive subroutines allow the user to interact with the simulation during run-time. Subroutines are defined as type Interactive in the Subroutine edit table. Normally, subroutines are activated by entities. However, interactive subroutines can be user-activated in addition to being entity-activated. Interactive subroutines can be used for:

- changing model parameters during a simulation run
- changing routings
- calculating and reporting user-defined statistics

Suppose you want to interactively change the arrival frequency for a certain entity, customers, during run time. Define a variable, Var1, and assign it an initial value to be used for the initial arrival frequency. Enter Var1 in the arrival frequency field for the entity customers. Create a
subroutine of type Interactive and enter the following logic:

During run-time, you can then change the arrival frequency for the customers by choosing the Customer Arrivals from the Interact menu (see “Run-Time Interact Menu” on page 358).

Please note

Interactive subroutines may also be called from any logic or expression where no return value is required. See “Statements and Functions” on page 429 for more information.

External Subroutines

There may be some cases where you need to perform actions ProModel is not capable of doing. You may need extended capabilities with more sophisticated commands. ProModel allows you to interface with external subroutines located in thirty-two bit Windows DLL files you have created. This feature could be useful for doing sophisticated file I/O, performing statistical analysis, making your simulation interactive, or helping with other simulation needs.

Because of the intricacies of the Windows development environment, you must have a sound knowledge of your external programming language (C, C++, Pascal) to use external subroutines. In addition, you must also have a good Windows platform knowledge, specifically with respect to creating DLLs in your language. Because it is a 32-bit program, ProModel can load and call only 32-bit DLLs, and requires that you use a 32-bit Windows compiler.

For more information about this feature, you can load, study and run XSUB.MOD in the reference model directory (also see “Xsub()” on page 573). This model uses XSUB.DLL, found in the MODELS directory. The source code and make files for XSUB.DLL (XSUB.CPP, XSUB.MAK, XSUB.IDE) are also included in the MODELS directory. Some general explanation is contained in the comments of this source code.

Due to the complexities of Windows programming and the variety of uses for this advanced feature, PROMODEL Corporation can only provide minimal support for this feature. Many questions regarding Windows programming and other programming languages cannot be handled through our customer support department. Please consult your language programming manuals, language customer service centers, Microsoft, and other resources to resolve these types of problems.

Subroutines vs. Macros

Although subroutines and macros work similarly, they have subtle differences. Any logic may use both macros and subroutines. The main difference is in the way they are used. Only subroutines can be used when you need to pass arguments, get a return value, or activate the independent execution of logic. Only macros can be used when defining run-time interface parameters.
Macros may be used in any expression field, but the macro may only contain an expression (i.e., Entries(LOC1), U(5,1)). When a macro is used in a logic field, the macro may include any logic element valid in that logic field.

Subroutines may also be used in an expression field provided that the RETURN statement is used to return a value to the expression field. When a subroutine is used to represent one or more logic statements, the subroutine may only include statements valid for the particular context.
Chapter 6: Arrival Cycles

Arrival Cycles

An arrival cycle is a pattern of individual arrivals which occurs over a certain time period. Some examples of arrival cycles that exhibit a pattern are the arrival of customers to a store and the arrival of delivery trucks to a truck dock. At the beginning of the day, arrivals may be sparse; but as the day progresses, they build up to one or more peak periods and then taper off. While the total quantity that arrives during a given cycle may vary, the pattern or distribution of arrivals for each cycle is assumed to be the same.

Arrival Cycles are defined in the Arrival Cycles edit table, accessed through the Build Menu.

Arrival Cycles Edit Table

Arrival cycles are defined by entering the proper data into the Cycle edit table. The fields of the Cycle edit table are explained below.

<table>
<thead>
<tr>
<th>ID</th>
<th>The cycle name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Qty / %</td>
<td>Select either Percent or Quantity as the basis for the total number of arrivals per cycle occurrence.</td>
</tr>
<tr>
<td>Cumulative...</td>
<td>Select Yes to specify the % or Qty values in a cumulative format. Select No to specify these fields in a non-cumulative format.</td>
</tr>
<tr>
<td>Table...</td>
<td>Click on this button (or double click in this field) to open an edit table for specifying the cycle parameters.</td>
</tr>
</tbody>
</table>

Arrival Cycles Example

Suppose we are modeling the operations of a bank (or any service or manufacturing system) and we need to specify a pattern for customer arrivals. From past data, we know that customers arrive throughout the day (9:00 AM to 5:00 PM) according to the following approximate percentages.

<table>
<thead>
<tr>
<th>From</th>
<th>Before</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00 AM</td>
<td>10:30 AM</td>
<td>0</td>
</tr>
<tr>
<td>10:30 AM</td>
<td>11:30 AM</td>
<td>10</td>
</tr>
<tr>
<td>11:30 AM</td>
<td>1:00 PM</td>
<td>25</td>
</tr>
<tr>
<td>1:00 PM</td>
<td>4:00 PM</td>
<td>55</td>
</tr>
<tr>
<td>4:00 PM</td>
<td>5:00 PM</td>
<td>70</td>
</tr>
</tbody>
</table>

Defining the Arrival Cycle

The arrival cycle will be named Bank_Arrivals in the Arrival Cycles edit table. Because the data is
expressed in terms of percentages, we select Percent as the basis for the cycle. Also, the percentage values are not cumulative so we specify No in the Cumulative field.

Next, we click on the Table heading button to open another edit table for entering the cycle data.

In this example, even though the percentages of customers that have arrived are not cumulative, the time is always cumulative. Therefore, the table reads as follows: ten percent of the daily customers arrive in the first 1.5 hours, fifteen percent of the daily customers arrive between hour 1.5 and 2.5, and so on. The arrivals are randomly distributed according to a Uniform distribution during the time interval in which they arrive.

The arrival cycle is now defined and can be assigned to an arrivals record in the Arrivals edit table.

### Assigning Arrivals to the Arrival Cycle

After an arrival cycle has been defined, assign an arrival record to the arrival cycle in the Arrivals edit table for the arriving customers. The arrival record for the bank example appears below. (See “Arrivals” on page 156 for more information.)

The total number of customers per day is normally distributed with a mean of 1000 and a standard deviation of 35. The number of occurrences of the cycle is 20, representing 20 working days (1 month) of time. The frequency in this case refers to the period of the cycle or the time between the start of one cycle and the start of the next cycle, which is every 24 hours. Make sure the arrival frequency is defined with the same time unit as the arrival cycle.

Without an arrival cycle, all the Customers for a single day would arrive at the start of the simulation. An arrival cycle will divide the quantity specified in the Qty each... field into various sized groups arriving throughout the day.

To assign the arrival cycle to the arrival record, click on the Qty each... heading button to open a dialog with the names of all defined cycles.

Click on the entry Bank_Arrivals and select OK. The Qty each... field now includes the cycle.
Cumulative Cycle Tables

In the previous example, percentages were expressed non cumulatively. This same data could have been expressed cumulatively as follows:

<table>
<thead>
<tr>
<th>Before</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00 am</td>
<td>0</td>
</tr>
<tr>
<td>10:30 am</td>
<td>10</td>
</tr>
<tr>
<td>11:30 am</td>
<td>25</td>
</tr>
<tr>
<td>1:00 pm</td>
<td>55</td>
</tr>
<tr>
<td>4:00 pm</td>
<td>70</td>
</tr>
<tr>
<td>5:00 pm</td>
<td>100</td>
</tr>
</tbody>
</table>

The data is now expressed cumulatively and could be entered in the cycle table as follows.

To specify cycles in cumulative form, simply choose Yes in the Cumulative... field of the Arrival Cycles edit table.

Please note

*Time values remain cumulative regardless of the form of the percentages.*

Arrival Cycles by Quantity

The previous example was based on the assumption that a certain percentage of arrivals came within a specified time interval. An alternate method of specifying an arrival cycle is to specify the number of arrivals to arrive within each time interval.

**Example 1**

Suppose that in the bank example we knew that for each cycle period, the number of customers to arrive during each time interval within the cycle period is as follows:

<table>
<thead>
<tr>
<th>From</th>
<th>Before</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00 AM</td>
<td>10:30 AM</td>
<td>100</td>
</tr>
<tr>
<td>10:30 AM</td>
<td>11:30 AM</td>
<td>150</td>
</tr>
<tr>
<td>11:30 AM</td>
<td>1:00 PM</td>
<td>300</td>
</tr>
<tr>
<td>1:00 PM</td>
<td>4:00 PM</td>
<td>150</td>
</tr>
<tr>
<td>4:00 PM</td>
<td>5:00 PM</td>
<td>300</td>
</tr>
</tbody>
</table>

With the data in this format, we specify the Arrival cycle by choosing Qty in the “Qty/Percent” field and complete the cycle table as follows:

<table>
<thead>
<tr>
<th>Time (Hours)</th>
<th>Qty / %</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5</td>
<td>100</td>
</tr>
<tr>
<td>2.5</td>
<td>150</td>
</tr>
<tr>
<td>4.0</td>
<td>300</td>
</tr>
<tr>
<td>7.0</td>
<td>150</td>
</tr>
<tr>
<td>8.0</td>
<td>300</td>
</tr>
</tbody>
</table>

This table could also be specified cumulatively by choosing Yes in the Cumulative... field and entering the quantity values in a cumulative format.

Please note

*When specifying Arrival cycles by quantity, the value entered in the “Quantity each” field of the Arrivals edit table changes meaning. Instead of the total arrivals per cycle, it represents a factor by which all entries in the cycle table will be multiplied. This field may be any valid expression which evaluates to a number. This allows the*
same arrival cycle to be entered for more than one arrival record that has a different factor applied to it. For example, you might want to define a different factor to a customer arrival pattern depending on the day of the week. In this case, define an arrival record for each day with a frequency of one week.

Example 2

Suppose we wish to see the effect on the Bank example if the number of arrivals is increased by 50%. The relative quantities per time interval remain the same but now 50% more customers arrive each day. Using the data from the previous example, we enter the same values in the Arrival cycle quantity fields, but specify a value of 1.5 in the quantity field of the Arrival edit table.

![Arrival Qty](image)

The result is an arrival schedule with the following parameters.

<table>
<thead>
<tr>
<th>From</th>
<th>Before</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>9:00 AM</td>
<td>10:30 AM</td>
<td>150</td>
</tr>
<tr>
<td>10:30 AM</td>
<td>11:30 AM</td>
<td>225</td>
</tr>
<tr>
<td>11:30 AM</td>
<td>1:00 PM</td>
<td>450</td>
</tr>
<tr>
<td>1:00 PM</td>
<td>4:00 PM</td>
<td>225</td>
</tr>
<tr>
<td>4:00 PM</td>
<td>5:00 PM</td>
<td>450</td>
</tr>
</tbody>
</table>
Table Functions

Table functions provide an easy and convenient way to retrieve a value based on an argument (i.e., some other value) that is passed to the table. Table functions specify a relationship between an independent value and a dependent value. All table functions are defined in the Table Functions editor which is accessed from the Build menu.

How to access the function table editor:

1. Select More Elements from the Build menu.
2. Select Table Functions.

Table Functions Editor

Table functions are defined by the user and return a dependent (or look-up) value based on the independent (or reference) value passed as the function argument. Independent values must be entered in ascending order. If the independent value passed to a table function falls between two independent values, a dependent value for the unspecified reference value is calculated by linear interpolation. The following two examples show how to specify a linear function (where only two reference values are needed to define the entire function) and a nonlinear function (where more than two reference values need to be specified).

Example 1

The example below shows a relationship that exists between the time required to process an order and the number of entities in the order. As the number of entities increases, the time required to process the order also increases. The relationship in this case is linear, meaning the processing time is directly proportional to the number of copies in the order. Because of the linear relationship, only the two endpoints need to be entered in the function table. (The function table for this example is given in the discussion on the Table Function editor.)

Example 2

In this example the relationship between the independent value and the dependent value is nonlinear and inversely proportional. In addition, interpolation is required to determine the dependent value if the independent value passed to the function lies between the independent values.
given explicitly in the table function.

In the example above the dependent value represents a factor which is to be multiplied by the processing time required to complete an order. Each order is assigned a number, 1 through 5, according to the level of quality desired. In this case, a lower number represents higher quality. (The function table for this example is listed in the following explanation of the Function Table Editor.)

**Table Function Edit Table**

The Function Table Editor is where all function tables are created and edited. The fields of the Function Table editor are defined below.

- **ID** The name of the function table.
- **Table...** Click on this heading button to open a table for defining the independent and dependent values of the function.

The tables for the two example functions are given below.

The independent and dependent values allow any general expression such as numbers, variables, and math functions. The fields are evaluated only at translation, and cannot vary during the simulation.

When calling a user-defined table function, if the independent value is out of range, then the table function will return a zero for the dependent value. Consider the following function table, Operation_Time:

If the function were called with the command “Operation_Time(5),” the independent value passed to the table function Operation_Time would be five. But five is beyond the limits of the table, so the dependent value returned will be zero. Likewise, if the independent value is 1, the dependent value returned will be zero. However, if 2.7 is entered as the independent value, Pro-
Model will interpolate and return a value between 30 and 50.
User Defined Distributions

Occasionally, none of ProModel’s built-in distributions can adequately represent a data set. In these cases, the user may define a User Distribution to represent the data set. User Distributions specify the parameters of user-defined (empirical), discrete, or continuous probability distributions.

How to create and edit user distributions:

1. Choose More Elements from the Build menu.
2. Choose User Distributions.

User Distribution Edit Table

A user-defined distribution is a table of empirically gathered data. User distributions may be either continuous or discrete, and may be cumulative or non-cumulative (more information concerning these options is found later in this section). The data is entered into the User Distribution edit table. The User Distribution edit table’s fields are described below.

- **ID** The name of the distribution. When referencing distribution tables (in the operation logic, for example) the open and closed parentheses after the distribution name must be used, such as Dist1(), OpTime().
- **Type...** Discrete or Continuous depending on the number of possible outcomes.
- **Cumulative...** Yes or No depending on whether the distribution is to be specified in cumulative or non-cumulative format.
- **Table...** Click on this button (or double click in the field) to open an edit table for defining the parameters of the distribution. Once a distribution has been defined, the field changes from “Undefined” to “Defined.”

The combination of Discrete and Continuous distributions, along with the ability to express either in cumulative or non-cumulative terms, creates four possible formats for specifying distributions. The remainder of this section gives examples and procedures for specifying each of these distribution types.

Discrete Distributions

Discrete distributions are characterized by a finite set of outcomes, together with the probability of obtaining each outcome. In the following example, there are three possible outcomes for the group size: 30% of the time the group size will be
10, 60% of the time the group size will be 20, and 10% of the time the group size will be 30.

One way to represent a discrete distribution is by its probability mass function, listing the possible outcomes together with the probability of observing each outcome. A probability mass function for the example above could be expressed as follows (with G representing the group size).

<table>
<thead>
<tr>
<th>G</th>
<th>10</th>
<th>20</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>P(G)</td>
<td>.30</td>
<td>.60</td>
<td>.10</td>
</tr>
</tbody>
</table>

An alternate way to represent a distribution is through a cumulative distribution function, listing each possible outcome together with the probability that the observed outcome will be less than or equal to the specified outcome. A cumulative distribution function for the example above could be expressed as follows.

<table>
<thead>
<tr>
<th>G</th>
<th>10</th>
<th>20</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>P(G)</td>
<td>.30</td>
<td>.90</td>
<td>1.0</td>
</tr>
</tbody>
</table>

In the next example, the number of parts are grouped into a batch according to a user distribution.

### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>GROUP Dist() AS Batch</td>
</tr>
<tr>
<td>Batch</td>
<td>Loc1</td>
<td>WAIT 10 min</td>
</tr>
</tbody>
</table>

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Batch</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

ProModel provides the flexibility to specify discrete distributions according to a probability mass function or a cumulative distribution function. Select Yes or No in the Cumulative field of the Distribution edit table and fill in the table according to the probability mass function or the cumulative distribution function. The following tables show the discrete distribution example defined in both formats.

#### Discrete (probability mass function)

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>10</td>
</tr>
<tr>
<td>60</td>
<td>20</td>
</tr>
<tr>
<td>70</td>
<td>30</td>
</tr>
</tbody>
</table>

#### Discrete (cumulative distribution function)

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>10</td>
</tr>
<tr>
<td>90</td>
<td>20</td>
</tr>
<tr>
<td>100</td>
<td>30</td>
</tr>
</tbody>
</table>
Continuous Distributions

Continuous distributions are characterized by an infinite number of possible outcomes, together with the probability of observing a range of these outcomes. In the following example, there are an infinite number of possible operation times between the values 2.0 minutes and 8.0 minutes. Twenty percent of the time the operation will take from 2.0 to 3.5 minutes, 40% of the time the operation will take from 3.5 to 5.0 minutes, 30% of the time the operation will take from 5.0 to 6.0 minutes, and 10% of the time the operation will take from 6.0 minutes to 8.0 minutes.

As with a discrete distribution, a continuous distribution can be defined in two ways. A probability density function lists each range of values along with the probability that an observed value will fall within that range. Each of the values within the range has an equal chance of being observed, hence the piece-wise linearity of the c.d.f. within each range of values. A probability density function for the example above is expressed as follows.

\[
\begin{align*}
P(0.0 \leq X < 2.0) &= 0.00 \\
P(2.0 \leq X < 3.5) &= 0.20 \\
P(3.5 \leq X < 5.0) &= 0.40 \\
P(5.0 \leq X < 6.0) &= 0.30 \\
P(6.0 \leq X \leq 8.0) &= 0.10 \\
P(8.0 < X) &= 0.00
\end{align*}
\]

The following table represents the p.d.f. for this example.

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2.0</td>
</tr>
<tr>
<td>20</td>
<td>3.5</td>
</tr>
<tr>
<td>40</td>
<td>5.0</td>
</tr>
<tr>
<td>30</td>
<td>6.0</td>
</tr>
<tr>
<td>10</td>
<td>8.0</td>
</tr>
</tbody>
</table>

As with a discrete distribution, a cumulative distribution function for a continuous distribution specifies the probability that an observed value will be less than or equal to a specified value. A c.d.f. for the example distribution is as follows (where x represents the return value).

\[
\begin{array}{cccccc}
x & 2.0 & 3.5 & 5.0 & 6.0 & 8.0 \\
P(X \leq x) & 0 & .20 & .60 & .90 & 1.0
\end{array}
\]

The following table represents this c.d.f.

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2.0</td>
</tr>
<tr>
<td>20</td>
<td>3.5</td>
</tr>
<tr>
<td>40</td>
<td>5.0</td>
</tr>
<tr>
<td>30</td>
<td>6.0</td>
</tr>
<tr>
<td>10</td>
<td>8.0</td>
</tr>
</tbody>
</table>
External Files

External files may be used during the simulation to read data into the simulation or write data as output from the simulation. Files can also be used to specify such things as operation times, arrival schedules, shift schedules, and external subroutines. All external files used with a model must be listed in the External Files Editor which is accessed from the Build menu.

External Files Editor

The External Files Editor consists of an edit table with fields specifying the external files to be used during the simulation. Each of these fields is defined below.

<table>
<thead>
<tr>
<th>ID</th>
<th>Type</th>
<th>File Name</th>
<th>Prompt</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>General Read</td>
<td>c:\promod\models\data</td>
<td>&quot;Can't find Input Data&quot;</td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>General Read</td>
<td>c:\promod\models\report</td>
<td>&quot;Can't find Report No. 1&quot;</td>
<td></td>
</tr>
</tbody>
</table>

ID  An alias to be used in the model for referencing the file. Note that this ID does not have to be the same as the file name.

Type  Click on this heading button to display the following menu. The six file types are discussed in the remainder of this section.

- General Read
- General Write
- Entity Location
- Arrival
- Shift
- DLL
- Array
- Cancel

File Name...  The actual file name, including the path. Press the heading button or double click in this field to browse for a specific file.

Prompt  A prompt to be displayed at run time in the event that the specified file cannot be opened.

Notes...  A general notes field for entering descriptive information about the file. Click the heading button or double click in this field to open a larger window for entering notes.

File Types

External files may be defined as one of several types depending upon the purpose of the file.

General Read File

A General Read file contains numeric values read into a model using a READ statement. Values must be separated by a space, comma, or end of
Any non-numeric data will be automatically skipped when obtaining the next numeric value (See “Read” on page 527 for correct syntax and examples). For example, if you specify a normal distribution such as N(5,1) in the General Read file, ProModel will not return a numeric value following the distribution. Instead, it will read in the first value, 5, and the next value, 1.

A General Read file must be an ASCII file. Data created in a spreadsheet must be saved as a text file.

**General Write File**

A General Write file is used for writing text strings and numeric values using the WRITE and WRITELINE statements. Text strings are enclosed in quotes when written to the file, with commas automatically appended to strings. This enables the files to be read into spreadsheet programs like Excel or Lotus 1-2-3 for custom viewing, editing, and graphing. Write files may also be written to using the XWRITE statement which gives the modeler full control over output and formatting. (See “Write” on page 571, “Write-Line” on page 572, and “Xwrite” on page 575 for correct syntax and examples.)

If you write to an external file during multiple replications or a single, independent run, the data will be appended to the data from the previous replication. However, if the RESET statement is used, the data is overwritten for each replication.

**Entity-Location File**

An Entity-Location file (or expression file) is a spreadsheet (.wk1 or .xls format only) file containing numeric expressions listed by entity and location name. Entity names should appear across the top row, beginning in column 2, while location names should be entered down the first column, beginning on row 2. A numeric expression for each Entity-Location combination is entered in the cell where the names intersect. An example of a spreadsheet file is shown next.

To use the value stored in an Entity-Location file as an operation time, call out the file identifier in the operation logic as shown in the following example. (In this example, “SvcTms” is the File ID of the desired Entity-Location file.)

**Please note**

*If the .wk1 or .xls file contains more than one sheet of data, only the first sheet will be read in.*

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT SvcTms()</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

By specifying SvcTms() with no arguments in the parentheses, a value is returned from the Entity-Location File “SvcTms” for the current entity at the current location, i.e., EntA at Loc1. You may also return the value stored in any other cell of an Entity-Location file by explicitly specifying the entity and location names in the parentheses, e.g., SvcTms(EntB, Loc1) or SvcTms(EntC, Loc2).
Chapter 6: External Files

Arrivals File

An Arrivals file is a spreadsheet (.wk1 or .xls format only) file containing arrival information normally specified in the Arrival Editor. One or more arrival files may be defined and referenced in the External Files Editor. Arrival files are automatically read in following the reading of the Arrival Editor data. The column entries must be as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Entity name</td>
</tr>
<tr>
<td>B</td>
<td>Location name</td>
</tr>
<tr>
<td>C</td>
<td>Quantity per arrival</td>
</tr>
<tr>
<td>D</td>
<td>Time of first arrival</td>
</tr>
<tr>
<td>E</td>
<td>Number of arrivals</td>
</tr>
<tr>
<td>F</td>
<td>Frequency of arrivals</td>
</tr>
<tr>
<td>G through...</td>
<td>Attribute assignments</td>
</tr>
</tbody>
</table>

Columns A through F may have any heading desired as long as the data is of the proper type. If attributes are to be assigned, columns G and higher should have headings that match the names of the attributes being assigned. The following example illustrates these points.

Example

The values in the spreadsheet cells must be a numeric expression as opposed to a formula commonly used in spreadsheets. For example, if cell E4 in the spreadsheet above was actually a formula generating the value 100, the value ProModel generates is zero. ProModel only recognizes expressions for the Qty, Time, Number, and Frequency columns in a spreadsheet.

When defining an External Arrivals File, you do not need to define arrivals in the Arrivals edit table. If several entities are scheduled to arrive at the same time, entities arrive in the system according to the order in which they appear in the arrival list. However, when there is more than one occurrence for the arrival record, the next entity will not arrive until the frequency has elapsed. Meanwhile, other entities listed below the record may be allowed to arrive.

Please note

If the time of the first arrival is zero and there is only one arrival of some quantity, you do not need to complete additional cells. Likewise, if there is only one arrival at a time other than zero, you do not need to fill in additional cells after the Time entry.

Please note

If the .wk1 or .xls file contains more than one sheet of data, only the first sheet will be read in.

Shift File

A shift file record is automatically created in the External Files Editor when you assign a shift to a location or resource. If shifts have been assigned, the name(s) of the shift file(s) will be automatically created in the External Files Editor. If no path is listed for the shift file, ProModel will search in the default models directory.
Please note

Creating a shift file record in the External Files Editor should not be done. It is done automatically through the shift assignment.

DLL File

A DLL file is needed when using external subroutines through the XSUB() function. See “Subroutines” on page 238 for more information.

Excel File

An Excel file is automatically created in the External Files Editor when you assign a shift to an array import file. If the external file has been assigned, the name(s) of the Excel file(s) will be automatically created in the External Files Editor. If no path is listed for the Excel file, ProModel will search in the default models directory.

Other External Files

In addition to allowing the user to define external files, ProModel creates other external files. ProModel automatically creates and/or opens files depending on the specifications in the model. Below is a description of the different files ProModel creates (* indicates files that remain open while the model is running):

<table>
<thead>
<tr>
<th>Extension</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV</td>
<td>ASCII</td>
<td>Export Data (comma delimited)</td>
</tr>
<tr>
<td>MOD*</td>
<td>Binary</td>
<td>Model File</td>
</tr>
<tr>
<td>RDB</td>
<td>Binary</td>
<td>Output Database (basic statistics)</td>
</tr>
<tr>
<td>RDT</td>
<td>Binary</td>
<td>Output Time Series data</td>
</tr>
<tr>
<td>RDW</td>
<td>Binary</td>
<td>Output Reports &amp; Graphs saved for a model</td>
</tr>
<tr>
<td>SED*</td>
<td>Binary</td>
<td>Seed File used to store seed values for each replication</td>
</tr>
<tr>
<td>SFT</td>
<td>Binary</td>
<td>Shift created when defining a shift in the Shift Editor</td>
</tr>
<tr>
<td>TRC*</td>
<td>ASCII</td>
<td>Trace File</td>
</tr>
<tr>
<td>GLB</td>
<td>Binary</td>
<td>Graphic Library Files</td>
</tr>
<tr>
<td>GBM</td>
<td>Binary</td>
<td>Graphic Bit Map file created when loading a model file.</td>
</tr>
</tbody>
</table>

Open Files

Depending on the model specifications, there may be some occasions where several files need to be open simultaneously to execute the model. There is a feature which allows the user to access up to 255 open files at any time. The [General] section of the promod.ini file contains the following statement: OpenFiles=n where n is the number of files between 20 and 255. The default is 40. To change the number of available open files, simply edit the promod.ini file such that OpenFiles equals the desired number and then restart ProModel. There is also the option to close files using the CLOSE statement (see “Close” on page 448).
Chapter 6: Streams

Streams

A stream is a sequence of independently cycling, random numbers. Streams are used in conjunction with distributions. Up to 100 streams may be used in a model. A stream generates random numbers between 0 and 1, which in turn are used to sample from selected distributions. By default, all streams use seed value #1 and are not reset between replications if multiple replications are run. To assign a different starting seed value to a stream or to cause the seed value to be reset to the initial seed value between replications, use the Streams Editor. The Streams Editor is accessed from the Build menu as shown below.

Streams Edit Table

The Streams Editor consists of an edit table with three fields. The fields of the Streams edit table are explained below.

Stream # The stream number (1 to 100). This number identifies each stream.

Seed # The seed value (1 to 100). Streams having the same seed value generate the same sequence of random numbers. For more information on seed values, see “Using Random Number Streams” on page 258.

Reset... Set this field to YES if you want the stream to be reset to the initial seed value for each model replication. Set this field to NO if you want the stream to continue where it left off for subsequent replications.

The Streams Editor pictured above shows five defined streams. Each stream has a unique seed value. Streams 1, 2 and 5 will be reset for each replication, while streams 3 and 4 will continue where they left off for subsequent replications.

Using Random Number Streams

One of the most valuable characteristics of simulation is the ability to replicate and isolate probabilistic functions and activities within a system for specific study. In the real world, events tend to occur randomly, according to a certain statistical pattern or distribution. To help you model this randomness, ProModel uses distributions.

When you include a distribution (e.g., Normal, Beta, and Gamma) in your model, ProModel uses
a random number generator to produce a set sequence or stream of numbers between 0 and 1 (0 <= x < 1) to use in the distribution. Before it can select any numbers, however, ProModel requires an initial seed value to identify the point in the stream at which to begin. Once you specify a seed value, ProModel “shifts” the random number selection (in increments of 100,000 numbers) by that number of positions and starts sampling values. Since there is only one random number stream, this will ensure that the selected values do not overlap. ProModel includes 100 seed values, and each seed produces a unique set of random numbers. If you do not specify an initial seed value, ProModel will use the stream number as the seed value (i.e., stream 3 uses seed 3).

Random Number Stream

100,000 random numbers

Seed 1  Seed 2  Seed 3

When you use a specific seed value (e.g., 17), ProModel produces a unique sequence of numbers to use each time you apply that seed value. This allows you to maintain the consistency of some model elements and permit other elements to vary. (To do this, specify one random number stream for the set of activities you wish to maintain constant, and another random number stream for all other sets of activities.) In fact, because each seed value produces the same sequence of values every time, completely independent model functions must use their own streams. For example, Arrival distributions specified in the Arrival Module should have a random number stream used nowhere else in the model. This will prevent activities that sample random stream values from inadvertently altering the arrival pattern (i.e., the activities will not affect the sample values generated from the arrival distribution).

Please note

The random number generator is a prime modulus multiplicative linear congruential generator. The C code implementation for most of the random variates was written by Stephen Vincent and based on the algorithms described by Law and Kelton (see the “Bibliography” on page 596).

Stream Example

The following example shows one reason why multiple streams are useful.

Two machines, Mach1 and Mach2, are to go down approximately every 4 hours for servicing. To model this, the frequency or time between failures is defined by a normal distribution with a mean value of 240 minutes and a standard deviation of 15 minutes, N(240, 15). (For more information on distributions, see “User Defined Distributions” on page 251). The machines will go down for 10 minutes. Because no stream is specified in the normal distribution, ProModel uses stream number one to generate sample values for both machines. So if the next two numbers in stream number one result in sample values of 218.37 and 264.69, Mach1 will receive 218.37 and Mach2 will receive 264.69. Therefore, the two machines will go down at different times, Mach1 after almost four hours and Mach2 after somewhat more than four hours.

Suppose, however, that the resource to service the machines must service them both at the same time. The machines would have to go down at the same time. Stream number one will not bring them down at the same time because stream number one sends the machine’s distributions two different numbers. Using two streams (in the example below numbered ten and eleven) with the same initial seed will ensure that the
machines receive the same random number every time. The two streams have the same starting seed value so they will produce exactly the same sequence of random numbers. The first number of stream ten will be exactly the same as the first number of stream eleven; the second numbers will be the same; indeed, every number will be the same.

The Streams window below shows streams ten and eleven with the same seed values.

By assigning stream ten to Mach1 and eleven to Mach2, both machines will go down at exactly the same time.

This first clock downtime for each machine will occur at the beginning of the simulation. After that, the first downtime occurs at 218.37 minutes for both machines. Defining different seed values for the streams would produce different sequences and therefore different downtimes. Using the same stream number for the clock downtimes would also produce different values. But two different streams with the same seed value will bring both machines down at the same times.

Note that if a third machine were to use one of the streams, for example if Mach3 were to use stream eleven, the two machines would no longer go down together. Mach1 would use the first value from stream ten; Mach2 would use the first value from stream eleven; and Mach3 would use the second value from stream eleven. The first time Mach1 and Mach2 went down, they would go down at the same time because the first number in streams ten and eleven is the same. But thereafter they would not. The second time they would go down at different times because Mach1 would receive the second value from stream ten, Mach2 would receive the third value from stream eleven, and Mach3 would receive the fourth value from stream eleven.

**Please note**

**Stream notes:**

1. If a stream value is not specified for a distribution, the stream is assumed to be stream one. Stream #1 does not automatically reset after each replication.

2. The stream parameter is always the last parameter specified in a distribution unless a location parameter is also specified. See “Distribution Functions” on page 427 for details.
Material Handling Systems

The following section provides advanced techniques to model Material Handling Systems.

Crane Systems

To implement cranes in ProModel, the Path Network module allows three types of networks: non-passing, passing, and cranes. From this module, you can lay down and orient a crane envelope, define the bridge separation distance, and define the graphics for rails and bridges in the bay. Additionally, the Resources module allows you to define bridge and hoist speeds, and hoist graphics for one or more cranes operating in the same bay.

Creating Multi-Bridge Crane Systems

Modeling multiple cranes operating in the same bay has never been so easy!

User defined bridge separation distances, extensions to regular dynamic resource usage statements, and a set of new priority rules have been introduced in order to let you manage conflicting movements in the same envelope zone.

Crane Envelope

The parallelogram-shaped area represented by a crane type path network, bounded by two rails and the lines connecting the endpoints of those rails. The lines connecting the endpoints of rails are effectively the two extreme positions of the center-lines of any bridges operating within the envelope. ProModel uses the end of one of the rails as the envelope origin to serve as a reference point for all logical distance calculations within the envelope.

Bridge Separation

The minimum distance you want to maintain between center-lines of two neighboring bridges. This distance is not related to how close a bridge center-line can get to one of the extreme endpoints of the envelope. Caution: if bridge B tries to move to a node N that lies very close to the left end of the envelope, and bridge A is to the left of bridge B, a run-time error will occur if the space remaining between node N and bridge A is less than the bridge separation distance. To avoid such problems, define the crane envelope wide enough to allow sufficient space beyond any serviceable nodes.

Crane Priorities, Preemption & Bridge Bump-Away

ProModel associates two types of priorities with the operation of crane resources: (1) resource request priority, and (2) crane move priority.

Resource Request Priorities

Used to resolve any conflicts that arise between multiple tasks requesting the same resource at the same time. This priority scale follows the rules that regular dynamic resource priorities do (i.e., 10 levels of 100). Use this priority to preempt crane resources from lower priority tasks to serve higher priority tasks.

Crane Move Priorities

Used for multiple bridges operating in the same envelope, to decide which crane bridge has priority over another while moving. This priority scale is also in the range [0...999], but does not have any preemption levels. Any higher value has overriding priority over a lower value. You can assign priorities to crane resources temporarily, on a task-by-task basis via extra parameters in the GET, JOINTLY GET, USE, and MOVE WITH statements. Therefore, you can only use priorities for cranes that are either moving to respond to a resource request or moving to deliver a part. Moving to downtime, off-shift or break nodes has the default (0) move priority. Moving to park has the lowest move priority (the same as an idle crane).

You can further sub-divide crane move priorities into three categories:

- Task Move Priority

Assigned by the modeler via parameters passed to resource usage statements (GET, MOVE WITH, etc.). Used
as the base move priority for travel to pick up and travel to deposit.

- **Claim Priority**  If crane A’s bridge is headed towards its ultimate (task) destination, the claim priority is equal to the task move priority of crane A. Otherwise (if crane A’s bridge is moving under the influence of crane B), claim priority is equal to the claim priority of the claim inducer bridge (bridge B).

- **Effective Claim Priority**  Applies only to envelopes with three or more cranes. If multiple crane bridges are moving in the same direction with overlapping claims, the effective claim priority of any bridge in the overlapping region is the maximum of all the claim priorities of those bridges.

### Crane Operations

The operation of cranes in ProModel has been designed to closely resemble the real-life operation of cranes. Under most circumstances, you need not be concerned with how ProModel handles crane movements. The following operational specifications are intended as a reference only and are not essential in order to model cranes using ProModel.

### Crane Animation

During a simulation run, entities picked up by a crane appear graphically on the entity spot for the hoist. The hoist graphic appears above the entity graphic and the bridge of the crane appears on top of the entity and hoist graphics.

### Crane Specifications

When you define cranes for your model, consider the following:

- **Crane Graphics**  In the Resources module, the selected graphic represents the hoist. You may define, edit, and size multiple graphics for the same hoist the same way you create multiple graphics for other resources.

- **Units & Multiple Cranes**  Crane resources limit you to one unit. When you define multiple cranes operating in the same envelope, define them as separate resources—each assigned to the same crane network.

- **Downtimes**  In addition to the clock and usage downtimes you may define for cranes, you can assign cranes to shifts in the same way you assign other resources. When a crane goes down, it moves to the downtime node specified in the DTs dialog. If you do not associate a node with the crane downtime, the crane goes down at its current position.

- **Specifications**  Cranes require separate values for bridge and hoist speed and acceleration. You must enter Speed (Empty), Speed (Full), and Accelerate and Decelerate values for bridge movement along the rails and hoist movement across the bridge. In each field, the format is Bridge Value, Hoist Value (e.g., if you enter “150, 20” in the speed field, the bridge moves at 150 and the hoist at 20 feet per minute). Although you must enter speed values, acceleration and deceleration values are optional (if you leave them blank, ProModel assumes the crane to have an infinite acceleration and deceleration capability. (Hint: this provides better run-time computational efficiency).

- **Crane Searches**  Define Work and Park searches in the same way you define searches for other resources.

- **Node Logic**  Define entry and exit logic for cranes at nodes in the same way you define node logic for other resources.
Handling Zone Claims In Multi-Crane Envelopes

If a crane is in one of the following states, it will be referred to as “immovable at a node.” No other crane will be able to push this crane away, regardless of its priority.

- Picking up or depositing an entity.
- Being used at a location.
- Having a downtime, off-shift time, or break time.

Extended Movement Zone  The net zone that it needs to traverse ± bridge separation distance (± depending on the direction that it will go).

Before starting to move, any <crane A> attempts to claim its extended movement zone (zone A) for the entire movement duration.

ProModel can reject the claim attempt of crane A for zone A for several reasons:

- If there are immovable cranes in zone A
- If there are any cranes in zone A with move priorities greater than or equal to\(^1\) the move priority of crane A, if they are going in the opposite direction, or they are going in the same direction with conflicting destinations.\(^2\)

Case Examples of Zone Claims

The following cases illustrate specific situations with examples:

Case 1

Bridge B starts moving first, from \([B]\) to \([B']\) and claims the zone \([B'~B]\) in the \(\_\) direction. Bridge A wants to move from \([A]\) to \([A']\) in the opposite direction. If the move priority of A is less than or equal to the move priority of B, we let bridge A start moving towards \([B' - bridge separation]\) only. If A has a higher move priority, B is stopped immediately and sent back to \([A' + bridge separation]\). In the latter case, A may queue up behind B.

Case 2

Bridge B starts moving first, from \([B]\) to \([B']\), then bridge A wants to move from \([A]\) to \([A']\). Bridge B claims zone \([B~B']\) in the \(\_\_\_\) direction. Since bridge A wants to move in the same direction and their destinations do not conflict (assuming that \(B'~A'\) is greater than the bridge separation), bridge A moves all the way. If B has already cleared the zone \([A~(A' + bridge separation)]\) by the time A wants to start moving, A moves independently. Otherwise, A may queue up behind B. (If the distance \(B'~A'\) is less than the given bridge separation and the move priority of A is greater than the move priority of B, bridge A

---

1. Special case treatment not “\(\geq\)” but strictly “\(>\)” if all of the following conditions hold: (1) if the bridge that A is trying to oppose is stationary, (2) unless crane A is trying to move just to park (if A has a task or if it is trying to move out of the way of another bridge), (3) if the one A is trying to push is idle or its bridge was blocked before reaching its destination.

2. Destination Conflict Test: If \(\text{sign}(B' - A' - \text{sign(existing claim)} \times (\text{bridge_separation})) = \text{sign(existing claim)}\) then not conflicting.
will push away bridge B, and crane B will not respond to the request while passing over [B']).

**Case 3**

Bridge B starts moving first, from [B] to [B'], then bridge A wants to move from [A] to [A']. Bridge B claims the zone [B→B'] in the AE direction. Since bridge A wants to move in the same direction and their destinations do conflict, priorities will be considered. If the move priority of A is not greater than the move priority of B, bridge A starts moving towards [A'' = B' - bridge separation] only. Otherwise, A will push B away, and B will not respond to the request while passing over [B']. In both cases, A may queue up behind B.

**Case 4**

Bridge B starts moving first from [B] to [B'], claiming zone [B→B'] in the AE direction. Bridge A wants to move from A to A' and starts moving behind B. Bridge C wants to move in the opposite direction with a higher move priority than both of the other bridges. ProModel interrupts bridges A and B and lays a new course for both bridge B [B'' = C' - bridge separation] and bridge A [A'' = B'' - bridge separation]. In this case, B may queue up behind A, and C behind B.

**Case 5**

This is an extension of Case 4. Assume that the move priorities for crane bridges A, B, and C are 3, 1, and 2 respectively. When bridge C tries to claim zone [C→C] in the " direction, it faces an "effective priority" of 3 and is unsuccessful in its original claim, so it starts moving towards [B' + bridge separation]. Bridge B goes outside the effect of bridge A in the second part of its movement, [(A' + bridge separation) → B'] at time t0. However, bridge C does not override bridge B and start moving towards [A' + 2 * bridge separation] until the first “reclaim trigger event” after time t0.

If ProModel rejects the original claim of crane A, crane A claims the largest available portion of the original zone, and implements the procedure described below to move its bridge through the subset zone. The crane waits until a “reclaim trigger event” occurs, and then repeats the claim attempt to let its bridge traverse the remaining

---

1. In this special case, bridge A's claim priority competes with the task move priority of bridge B.

2. Discussed later in this section.
distance. The hoist, on the other hand, moves directly to its relative destination on the bridge, independent of the bridge zone claim results. In case of bridge interruption, the hoist does not stop moving. Therefore, for any particular crane move, the combined trajectory of hoist and bridge may change depending on zone availability at the time of the claim.

If crane A accepts the claim attempt, all cranes inside the claimed extended zone bump away at the time of the claim. This claim also prevents any other cranes with move priority less than or equal to the move priority of A from entering the claimed zone in conflicting directions.

**Zone Claim Notes**

Zone Claim Notes

1. A crane cannot do a pickup or deposit while another crane pushes it away, even though the request might be on its way.
2. When you interrupt a crane bridge and ask it to make a new claim (or update its claim), its speed is reset to zero and ProModel re-evaluates its mobility characteristics. ProModel recalculates the move time with these new parameters. This rule also applies to bridges that are moving when a bridge behind them with a higher priority and a conflicting destination makes a new claim to go in the same direction. See Case 3 (when priority of A is greater than priority of B) for an example.

**Treatment of Potential Queue-Up Situations**

For all bridge claims with the potential of having two bridges queue up after one another (mentioned in the example cases above), the following rule applies:

The acceleration rate \( a \), maximum speed \( s \) and deceleration rate \( d \) of the following bridge \( F \) are compared with the \( a \), \( s \), and \( d \) of the leading bridge \( L \). If all of the following conditions are true, bridge \( F \) moves independent of bridge \( L \).

**Conditions for No Queue-Up**

1. \( a_F \leq a_L \) The following bridge cannot accelerate faster than the leading bridge.
2. \( s_F \leq s_L \) The following bridge’s maximum speed cannot be greater than the leading bridge.
3. \( d_F \geq d_L \) The following bridge can decelerate equally or faster than the leading bridge.

If any one of the above conditions fail, bridge \( F \) moves at the same speed as bridge \( L \), maintaining the distance that existed between them at the time \( F \) started moving.

**Please note**

Condition 3 usually creates a deviation from the typical real life situation, but it is necessary to avoid time consuming computations that can adversely affect the run-time performance of models with crane resources. To avoid unrealistic queue-ups when modeling multiple bridges with different mobility characteristics in the same crane envelope, make either no bridge deceleration entry (infinite deceleration), or use the same overall average deceleration rate for all crane bridges in that envelope.
Chapter 6: Material Handling Systems

**Bridge Motion after Queue-Up**

If bridge A is queued up behind bridge B, bridge A goes through up to two stages of movement. The first stage occurs throughout the movement of bridge B. Bridge A mimics bridge B’s motion, maintaining its original distance from bridge B. The second stage occurs after bridge B stops. Bridge A continues traveling with the former average speed of bridge B until it reaches its destination.

If bridge B is moving to accomplish its own task (as opposed to just moving out of A’s zone), then bridge A might stop earlier, without going through the second stage. In this case, the total traveling time for bridge A is calculated as if bridge A were traveling with bridge B’s average speed.

When a bridge arrives at its destination, it triggers a chain queue-up re-evaluation that penetrates the crane envelope in the opposite direction that the stopped bridge was moving. This chain re-evaluation handles cases in which there were multiple bridges queued up behind the stopped bridge.

**Moving Idle Cranes can Respond to Resource Requests**

A crane can be idle and moving at the same time (moving to park or being pushed away by another). Independent of its current position and movement direction, the crane still has the capability to respond to resource requests coming from anywhere in the envelope. If allocated to a task with high enough travel-to-pickup move priority, the crane may reverse direction or terminate its move early, bumping other crane bridges on its way.

Whenever a crane bridge changes its claim, it checks to see if there are any bridges behind it that are going in the same direction with overlapping claims. If there are any, the newly claiming crane triggers a chain queue-up re-evaluation towards the following cranes. The following example demonstrates this case.

At time t0, crane A is called for a task and starts moving to [A'] with move priority mpA, pushing idle bridge B to [B' = A' + bridge separation]. At time t1 (bridge A and B are still moving), a request for crane B comes from [B'' (1 or 2)] with move priority mpB. Bridge B is allocated to the task immediately since it is available at the time. If the new destination of bridge B is [B''1], the new claim of bridge B does not conflict with the existing claim of bridge A, so the move priorities are not significant. ProModel re-evaluates all motion values for crane B (acceleration, deceleration, empty and full speeds for both the hoist and the bridge) and crane B starts moving to its new destination. If the bridge motion expressions for crane B have changed their values between t0 and t1, the queue-up status between bridges B and A (and any others behind A) may change, so
ProModel performs a chain queue-up re-evaluation.

If the new destination of bridge B is [B"2], the new claim of bridge B conflicts with the existing claim of bridge A, so ProModel considers the move priorities:

- If \( mp_B \leq mp_A \), then B does not have enough priority to stop A before A gets to its destination. Bridge B will have to go on moving until [B'] and wait until it can claim the region \([B'2 \sim B']\) in the \( AE \) direction.
- If \( mp_B > mp_A \), then B does have overriding priority over A. Bridge B stops bridge A at \([B'2 - bridge separation]\), starting a chain move termination which tells bridge A to stop any other followers with the appropriate bridge separation distances between each. In this case, bridge A (and other possible followers) will have to wait until the next reclaim trigger event to attempt reaching their original destinations.

**Reclaim Trigger Events**

Unsuccessful claims of all crane bridges in an envelope are re-attempted when a reclaim trigger event occurs in that envelope. The following events are considered to be triggers for claim re-evaluations in the related envelope:

- The duration of a USE <crane> statement expires.
- You free a crane using the FREE statement.
- A crane completes a deposit (unless you specify the KEEP option).
- A crane completes a pickup and the crane is about to start moving to deliver.
- A crane downtime ends.
- You preempt a crane resource.
- A bridge arrives at its task destination (before elapsing pickup/deposit time).
- There are no moving task bridges left (for envelopes with 3 or more cranes only).

In the first six cases, a crane changes state from “immovable” to a finite move priority. The seventh case may change the “effective move priorities” of other cranes. ProModel requires the eighth case for envelopes with three or more bridges with overlapping operation zones: It ensures that two or more unsatisfied, opposing claims with the same move priority will resolve their conflict based on earlier task assignment time instead of locking up the crane system. Hence, all of the above cases create a potential to realize previously unsuccessful claims.

The reclaim trigger events for each envelope echo in the trace together with the triggering reason for model debugging purposes. The results of reclaim attempts for each crane resource and its effects on other crane resources in the same envelope are also displayed.

**Other Crane Operation Rules**

1. If an entity currently possesses a crane, all move logic for the entity must use a MOVE WITH statement (until you free the crane)—the entity cannot move without the crane.
2. Although an entity cannot possess more than one crane at a time, the entity may possess a crane and a resource of another type.
3. If a crane is in one of the following states, another crane cannot push it away.
   a) Picking up or depositing an entity.
   b) Being used at a location.
   c) Experiencing a downtime, off-shift time, or break time.
4. The hoist moves to its relative destination on the bridge independent of the bridge zone claim attempt outcomes. The hoist does not stop for bridge interruption so, for any particular crane move, the combined trajectory of hoist and bridge may change depending on zone availability at the time of the claim.
5. When a crane pushes away an idle crane, the idle crane comes under the control of the
work and park search lists defined for the node closest to its bridge.

Crane Operations Notes

ProModel allows definition of resource points for crane resources on envelope nodes to achieve the three dimensional look for “lowering the hoist” upon arriving at a node. Since cranes can only have one unit, only the first resource point for any crane at any node is meaningful. Also, ProModel only uses the resource points if the crane resource arrives at the node to perform a task. In other words, the hoist does not lower if the crane arrives at a node to park or just ends up there after a bump.

In general, once ProModel makes a match between a resource request and a resource of the requested type, the resource is allocated for that job and the simulation engine does not go on looking for other matches that can actually reach to the requester sooner. Since cranes blocking other crane resources is a common phenomenon in multi-bridge envelopes, extra care should be used while designing the active operation zones and resource request logic in such models.

Nodes, Work, and Park Searches

ProModel “registers” all cranes to their home nodes at the beginning of a simulation run. When a crane starts to move, ProModel erases registration, and re-establishes it when the crane stops, according to the following rules:

1. Cranes assigned to a task (pick up, drop off, down) remain unregistered throughout intermediate stops and register to the task destination node upon arrival.
2. Idle cranes that are bumped away, or cranes that were unsuccessful in claiming the entire bridge region to go parking register themselves to the node closest to their bridge when they stop. If there are multiple nodes closest to the bridge, ties are broken by the minimum distance to the hoist and then the order of appearance in the nodes edit table. If the hoist is still moving at the time the bridge stops, the registry procedure executes by considering the destination of the hoist.

Please note

Only users can instruct cranes to park on nodes. However, as a result of bump-aways, a crane can end up standing still at positions that do not necessarily correspond to nodes. In any case, ProModel registers an idle stationary crane to a node and places it under the control of work and park searches of that node.

Cranes follow the same rules as regular dynamic resources while searching for assignments (returning to preempted jobs, exclusive & non-exclusive work searches, requests coming from nodes not included in the work search, etc.). There are some additional steps to handle interactions with other cranes operating in the same envelope. Upon completion of its task, a crane goes through these extra steps:

1. Lets other cranes in the same envelope re-attempt their claims, possibly generating an induced claim on its bridge.
2. Even though other cranes might bump away its bridge, the crane executes the work search defined for it at its current node. (If requests are waiting at different locations of the same work search record, ProModel takes the resource request priorities into consideration.)
3. If it was not allocated to a task or bumped away, the crane executes the park search defined for it at its current node, or attempts going home if return home is checked.
Please note

A crane bridge moving to park cannot bump other idle bridges out of its way. In such a case, the bridge goes as far as it can towards its destination and registers itself to the closest node upon stopping (using the rules discussed above).

Crane Resource Statistics

The statistics reported for cranes are very similar to regular dynamic resource statistics. The following definitions highlight the differences in the interpretations.

In Use Includes the following states:

- Stationary use at a location via GET, JOINTLY GET, and USE statements.
- Gross move time while delivering — actually carrying an entity from one location to another.
- Pickup and deposit times before and after the move to deliver.

Travel To Use Is the gross move time to start being used — traveling to respond to a request for either stationary use or use to pickup and deliver an entity to another location.

Gross Move Time May include the following times:

- Moving towards the actual destination.
- Possibly moving away from the destination when bumped away by a higher priority bridge in the same envelope.
- Stationary blockage times during which the bridge is waiting for a higher move priority bridge in the same envelope to lower its move priority.

Blocked Time Tally blocked time by subtracting the internally computed, hypothetical net traveling time from the actual incurred gross move time. ProModel defines the net time as the time a crane would have taken to get to its destination if it were the only bridge in its envelope.

Please note

The first component of gross travel time (moving towards the actual destination) may be greater than the net travel time, since it may include going back towards the destination after another crane bumps it away. It may also involve deviations from the bridge’s original motion values when queued-up behind slower bridges.

Special Case—Blocked Time Accrual for Moving to Park

Remember that an idle crane registers itself to the closest node whenever its bridge stops. If the hoist is still moving, ProModel uses the destination of the hoist to break any ties between nodes that are equidistant to the bridge position.

In case of an unsuccessful claim attempt to move to park, the crane bridge needs to stop before reaching the instructed park node, and ProModel ignores the hoist travel for statistics purposes. The “travel to park” statistic terminates at the time the bridge stops, not when bridge or hoist stop time reaches its maximum value. In this case, the net moving time to park computes as the bridge move time from current position to the endpoint of the claim, using original bridge motion values for the crane resource. Blocked time can accrue if this bridge queues up after a slower bridge that is already moving (remember that a crane moving to park cannot bump another crane).

Conveyors

A conveyor is any moving track, belt, chain, or roller which transports parts from one location to
another. This section will help you better understand conveyors and how to model them using ProModel.

ProModel determines the capacity of a conveyor by its speed and load spacing rather than a stated capacity. Specifically, capacity is a function of the minimum allowable interload spacing on a conveyor (which is the length of a queue position in the case of accumulation conveyors) and its length. It may be desirable, however, to impose a limit to the number of loads permitted on the conveyor at any one time.

Conveyors usually do not pick up and drop off loads as in the case of lift trucks, AGVS, and cranes. You must place loads onto and remove them from conveyors.

Depending on the nature of the conveyor and its operation, modeling a conveyor can be straightforward or complex. For single conveyor sections, modeling is very simple. Conveyor networks, on the other hand, give rise to several complexities (recirculating, merging, etc.) that become more difficult to model.

Conveyor Simulation Benefits

Simulating your conveyor system will help you address design and operational issues, answering the following questions:

- What is the minimum conveyor speed that still meets rate requirements?
- What is the load rate capacity of the conveyor?
- What is the load delivery time for different activity levels?
- How much queuing do accumulation conveyors need?
- How many carriers do trolley or power-and-free conveyors need?
- What is the optimum number of pallets to maximize productivity in a recirculating environment?

Conveyor Types

You may represent conveyors as one continuous span of randomly spaced parts (e.g., belt conveyor) or as intermittent spaces or carriers located at fixed intervals (i.e., trolley conveyor).

Accumulating & Non-Accumulating

In addition to continuous or intermittent conveyors, some conveyors permit loads to accumulate or queue if conditions impede forward motion progress. ProModel refers to these conveyors as accumulating conveyors. Other conveyors provide no queuing and halt all activity if forward progress of the leading part or load stops. ProModel refers to these types of conveyors as non-accumulating conveyors.

The following figure illustrates how entities can continue to accumulate after the leading load stops on an accumulating conveyor. How a non-accumulating conveyor can accept one additional entity if the leading entity stops, however it is unable to advance any further since the entire conveyor stopped.

The different combination of continuous or intermittent conveyors and transport or accumulation conveyors result in the following four different kinds of conveyors that ProModel is capable of modeling.
For best results, you should model carriers or part holding devices on intermittent, accumulating conveyors as though the devices were entities waiting for you to load and unload other entities to and from them (see "Load" is ProModel User Guide) as you move parts. An alternative but similar method is to use a JOIN statement and then specify two routings when you want the part removed (see Example E in "Modeling Conveyor Systems" in the next section). Yet another way of modeling parts with carriers on a conveyor, is to simply set a part attribute equal to a particular value if the part is on a carrier. If the part is not on a carrier, assign a different value to the same attribute. Operations may occur at either the beginning or end of a conveyor as shown here.

### Single Section Conveyors
Conveyors used for simple queuing or buffering often consist of a single stretch or section of conveyor. Loads enter at one end and exit at the other end. Load spacing is generally random. These types of conveyors are generally quite easy to model. The modeler merely defines the length and speed and states whether the conveyor is an accumulating or non-accumulating conveyor.

### Conveyor Networks
A conveyor network consists of two or more sections that are connected together to enable part merging, diverting, and recirculating. In such instances, a conveyor may have one or more entry points and one or more exit points. Furthermore, part entry and exit may not always happen at the beginning or end of the conveyor. In ProModel, loads or entities must always enter at the beginning and exit at the end of conveyor networks. To model merging or branching in the middle of the conveyor, break the conveyor into smaller sections.

### Modeling Conveyor Systems
A conveyor system is a combination of one or more types of conveyors which interact to move parts. Such a system may include branching, merging, and looping. The process of dividing conveyors into logical sections is fairly straightforward if you understand what constitutes a conveyor section.

For modeling purposes, a conveyor section is defined as any independently driven segment of conveyor of the same type. Conveyor turns are irrelevant as long as the conveyor remains unchanged and both are actuated or stopped together.

In ProModel, an accumulating conveyor section must end at the point where parts are permitted to

---

<table>
<thead>
<tr>
<th>Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous, Non-Accumulating</td>
<td>Belt, chain</td>
</tr>
<tr>
<td>Intermittent, Non-Accumulating</td>
<td>Tray, trolley</td>
</tr>
<tr>
<td>Continuous, Accumulating</td>
<td>Roller</td>
</tr>
<tr>
<td>Intermittent, Accumulating</td>
<td>Power-and-free, towline</td>
</tr>
</tbody>
</table>

On-conveyor operations must occur at the beginning or end of a conveyor section.
accumulate or back up. This generally occurs at a transfer point or process location.

**Modeling Conveyors**

While not essential, it is visually more effective to draw conveyors to scale on the layout. You should also size entities traveling on a conveyor to scale when you create them. Setting the length of a conveyor different from the scale length or conveying entities that have a length or width that is not to scale will result in the appearance of load overlapping or excessive load spacing. The underlying logic and simulation is still valid, regardless of whether the graphics are to scale. Loads may appear to jump when transferring from the end of one conveyor to another conveyor. This is a result of ProModel not allowing a load to transfer onto a conveyor until there is room for the load. Including a transfer time in the Move Logic column of the Routing edit table can result in smooth movement between conveyor sections. Defining a variable called Transfer_Time and using that variable rather than entering the actual time allows for experimentation with various conveyor speeds with minimal modeling changes.

Clock precision is also important. Note that movement of one foot at 40 feet per minute will take .025 minutes. If clock precision is set at .1 minutes, truncation will result in zero time. Make sure you check your model for the correct clock precision. For most conveyors, a clock precision of .001 is adequate. ProModel may require greater precision for high-speed conveyors where speeds are greater than 200 fpm.

Modeling conveyors in ProModel is quite easy. Select the conveyor icon in the Locations Graphics window and place the beginning and ending points of the conveyor using the mouse. Clicking the right mouse button will end the conveyor. Left-click to add or delete a joint and allow the conveyor to bend. Some users prefer to display the grid and select the Snap to Grid option in the View menu. Others will leave Snap to Grid off. You may find that the precise positioning of a conveyor is easier when you turn Snap to Grid off and set the Zoom sufficiently high. When you need to change the type of conveyor to accumulating, double-click on the conveyor icon in the layout, select the Conveyor Options button, and select Accumulating from the Conveyor Options dialog.

The following six examples show various ways of modeling conveyors:

**Example A** Routes one or more parts from one or more non-conveyor locations to any conveyor location.

**Example B** Routes one or more parts from any conveyor location to one or more non-conveyor locations.

**Example C** Routes single parts from any conveyor location to one or more other conveyor locations.
**Example D** Joins one or more parts from one or more non-conveyor locations to another transporting entity (e.g., a pallet or carrier) at any conveyor location.

**Example E** Accumulates multiple parts coming from one or more non-conveyor locations onto a conveyor location.

**Example F** Splits parts at a conveyor location sending one or more parts to a non-conveyor location and a single part (e.g., a pallet or carrier) onto the conveyor.

### Automated Guided Vehicle Systems

An automated guided vehicle system (AGVS) is a path network along which computer-controlled, driverless vehicles transport loads. One of the modeling requirements of AGVS is to accurately describe the method for controlling traffic. You can usually accomplish this in one of two ways:

- Zone blocking
- On-board vehicle sensing

**Zone Blocking** The most common method of traffic control, it involves placing control points along the guide path. Each point usually allows only one vehicle to access it any one time, thus blocking any other vehicle from entering any segment of the path connected to that point. Once the vehicle leaves a control point to travel to the next point on the path, any vehicle waiting for access to the freed control point can resume travel.

**On-Board Vehicle Sensing** Works by having a sensor on-board the vehicle that detects the presence of a vehicle ahead of it and stops until it detects that the vehicle ahead of it has moved.

### Modeling AGVS

Modeling an AGVS is very similar to modeling an industrial vehicle, such as a lift truck, (which it is in a sense) except you control the operation more and there exists less freedom of movement. Paths are generally unidirectional and do not allow vehicle passing.

One of the challenges in modeling an AGVS is finding the shortest routes between any two stops in a system. ProModel provides built-in capability to automatically determine the shortest routes between points in a complex network.
Chapter 6: Material Handling Systems

AGVS Simulation Benefits
Simulating your AGV system will help you address design and operational issues, answering the following questions:

- What is the best path layout to minimize travel time?
- Where are the potential bottleneck areas?
- How many vehicles do you need to meet activity requirements?
- What are the best scheduled maintenance/recharging strategies?
- Which task assignment rules maximize vehicle utilization?
- What is the best idle vehicle deployment to minimize response time?
- Is there any possibility of deadlocks?
- Is there any possibility of collisions?

Manual Material Handling Systems
Manual material handling systems (MMHS) are probably the most common systems for handling, moving, storing, retrieving, and managing materials. ProModel easily allows you to model manual labor. With shifts, breaks, and downtimes (illness, training, etc.), model people as resources.

Whether carrying parts from one station to another or stocking shelves in a grocery store, people can be modeled as resources to do just about anything in ProModel. Such resources are dynamic and move along assigned path networks. Since people can think, you can model them very much like automated guided vehicles with on-board vehicle sensing.

MMHS Simulation Benefits
Simulating your manual labor material handling system will help you address design and operational issues, answering the following questions:

- What is the best path layout to minimize travel time?
- Where are the potential bottleneck areas?
- How many people do you need to meet activity requirements?
- What are the best shift and break schedule strategies?
- Which task assignment rules maximize utilization?
- What is the best idle person deployment that minimizes response time?

Industrial Vehicles
Industrial vehicles include all push or powered carts and vehicles that generally have free movement. Utilize powered vehicles such as lift trucks for medium distance movement of batched parts in a container or pallet. For short moves, use manual or semi-powered carts. Single load transporters are capable of moving only one load at a time from one location to another. Such devices are fairly straightforward to model because they involve only a single resource and a single destination for each move.

Multiple load transporters, on the other hand, can move more than one load at a time from one or more sources to one or more destinations. Defining capacity and operation for multiple load transporters can be extremely difficult since there may be special rules defining when to retrieve additional loads and when to deliver the loads already on board.

Modeling Industrial Vehicles
Modeling an industrial vehicle involves modeling a resource that moves along a path network. Paths are typically open aisles in which bi-directional movement is possible and passing is permitted. You may also need to define deployment strategies (work searches, idle vehicle parking, etc.).
Since people generally operate industrial vehicles, they take breaks and may be available only during certain shifts. So in addition to modeling the vehicle, you may need to model an operator that takes breaks and works on shifts or you may just want to assign shifts and breaks to the vehicle resource itself, in effect, modeling the vehicle and the operator as one resource.

**Industrial Vehicle Simulation Benefits**

Simulating your industrial vehicles will help you address design and operational issues, answering the following questions:

- What is the required number of vehicles to handle the required activity?
- What is the best deployment of vehicles to maximize utilization?
- What is the best deployment of vehicles to minimize response time?

**Automated Storage/Retrieval Systems**

An automated storage/retrieval system (AS/RS) is “a combination of equipment and controls which handles, stores, and retrieves materials with precision, accuracy, and speed under a defined degree of automation” (The Material Handling Institute 1977). The goal of an AS/RS is to provide random, high density storage with quick load access, all under computer control.

**Modeling AS/RSs**

At a simple level, an AS/RS move time may be modeled by taking a time from a probability distribution that approximates the time to store or retrieve a load. More precise modeling incorporates the actual crane (horizontal) and lift (vertical) speeds. Each movement usually has a different speed and distance to travel which means that movement along one axis is complete before movement along the other axis begins. From a modeling standpoint, it is usually only necessary to calculate and model the longest move time.

In modeling AS/RS, the storage capacity is usually not a consideration and the actual inventory of the system is not modeled. It would require lots of overhead to model the complete inventory in a rack with 60,000 pallet locations. Since it is primarily only the activity that is of interest in the simulation, actual inventory is ignored. In fact, it is usually not even necessary to model specific stock keeping units (SKUs) being stored or retrieved, but only distinguish between load type insofar as it affects routing and subsequent operations.

**Modeling an AS/RS as a Vertical Bridge Crane**

One way to model an AS/RS with greater accuracy is to use the bridge crane construct. An AS/RS is really just a vertical crane with the same characteristics as a bridge crane.

**AS/RS Simulation Benefits**

Simulating your AS/RS will help you address design and operational issues, answering the following questions:

- How many aisles do you need to handle the required activity?
- What is the best sequence of stores and retrievals to maximize throughput?
- What is the best stationing of empty S/R machines to minimize response time?
Modeling Tips

The following section provides advanced Modeling Tips.

Using Entity Attributes

Entity attributes are a powerful construct that enable a user to “tag” entities with characteristics to distinguish them from other entities of the same name.

Entity attributes are place holders associated with individual entities which usually contain information about that entity. Attributes may contain integers or real numbers. Unlike variables, attributes are not global. To define attributes, use the Attributes module found under the More Elements option of the Build menu.

One use of an entity attribute is to represent a processing time. This is especially useful when you base processing times at a location on some characteristic other than entity type, such as size or condition.

Suppose several types of tires enter a machining center that places the steel belts on the tire. The processing time of the tire increases as the diameter of the tire increases. The following example shows that for a tire entering a machining location, the processing time uses the value of the attribute “Proc_time.” You can make the attribute assignment in the “Logic” field of the Arrivals module.

In this example, ProModel attaches the attribute “Proc_time” (short for process time) to the entity, tire, which contains a value representing the process time at Machine_1. You can assign a value to “Proc_time” in the Operation field or, as mentioned above, in the Logic field in the Arrivals module. The latter allows you to assign a value to the attribute for each entity as they arrive in the system.

When using attributes instead of operation times, ProModel substitutes the value assigned to the attribute directly into the Operation field. So, if “Proc_time=4.5” were your attribute assignment and the default units for time were in minutes, the resulting operation time would be 4.5 minutes.

You may also use attributes to determine the routing of an entity. Note that the Routing Rule dialog offers a “User Condition” routing rule. In this field, you can enter an expression that evaluates the value of an attribute for the entity currently at that location. Hence, ProModel selects the routing destination based on the attribute.

In this example, an entity attribute called “Inspected” has a value of zero or one. For unin-
spected tires, Inspected=0. For inspected tires, Inspected=1. Set the attribute value equal to 1 in the Operation field of the Inspection location to indicate an inspected tire.

At some other location in the model, ProModel makes a routing decision based the tire’s inspection status. The example above shows that the entity, tire, will route to either Inspect or Machine_2 based on the attribute value.

Another use for entity attributes is for assigning entity characteristics such as number of times reworked, color, model type, lot size, order number, etc. You may do this to reduce the number of system entities defined.

In the following example, to show that you reworked a casting, each entity that goes through the location Rework has its “Reworked” attribute set equal to 1.

You may assign values to entity attributes in the Operation field in the Processing edit table, the Logic field in the Arrivals edit table, and the Move Logic in the Routing edit table.

---

**Customizing Graphics**

Background graphics can enhance the look of your models and provide valuable visual information to convey meaning and lend credibility to your models. Several file types can be imported from various sources including CAD drawings.

**How to Import a background graphic:**

1. Choose **Background Graphics** from the **Build** menu.
2. Select **Front of Grid** or **Behind Grid**.
3. Choose **Import Graphic** from the **Edit** menu.

**Front of Grid**  When the grid is on, the grid lines will not cover or obstruct the imported graphic.

**Behind Grid**  The imported graphic will be behind the grid lines when the grid is on.

You may paste any *.BMP or *.WMF image copied to the Windows clipboard on the Layout by choosing Paste BMP or Paste WMF from the Edit menu.

Once you select Import Graphic from the Edit menu and select the desired file and type, ProModel imports the image into the layout. Once this procedure is complete, you may select or activate the graphic by clicking with the left mouse button on the graphic. You may then drag the mouse to move the graphic to the desired position on the layout. You may stretch or compress the graphic to the size you desire using any of its four sizing handles.

ProModel allows you to import *.BMP, *.WMF, *.GIF, and *.PCX file types. BMPs and WMFs can also be copied to the clipboard from other applications and pasted directly into the background. To import a CAD drawing, you must save it to one of the file formats described above.
Batching & Unbatching Entities

Batching refers to congregating or consolidating multiple entities of the same or different type for processing or movement purposes. Batching may be either temporary or permanent. For temporary batching, use the GROUP statement. For permanent batching, use the COMBINE statement.

Temporary Batching Using GROUP/UNGROUP

The GROUP statement allows you to group entities together and ungroup them at a later time. You may group entities by individual entity type by defining a process record for the type to group, or group them irrespective of entity type by defining an ALL process record. To combine multiple entity types in which you must control the quantity of each type requires controlling the routing which sends parts to the grouping location. ProModel maintains all of the identities and attributes of the grouped entities and allows them to remain with the individual entities after an UNGROUP command.

To illustrate how GROUP/UNGROUP works, suppose we want to consolidate 20 incoming entities into a group called Batch. If the current location performs no additional operation steps once you group the entities, you can simply use the statement “GROUP 20” to group the 20 entities and then specify an output of 1 Batch in the routing. If, on the other hand, the current location performs additional operation steps after the grouping occurs, use the statement “Group 20 as Batch” and define no output routing for the grouped entities. Instead, the entities become a new entity called “Batch” that needs a process record defined afterwards for the same location where you batched them.

Once you accomplish the purpose for which you grouped the entities, such as moving them, you can unbatch the entities using the UNGROUP statement as shown next. Note that after the ungrouping takes place, you must define processes for each potential entity that could have been in the group (alternatively you could define an ALL process record).

COMBINE Statement

ProModel uses the COMBINE statement to accumulate and consolidate a specified quantity of entities into a single entity, optionally with a different name. The entities may be the same type of entity or they may be different. Combined entities lose their identities and attributes and you cannot ungroup them later. When defining the location, the location capacity where you use the COMBINE statement should be at least as large as the
combined quantity. The following shows the correct syntax for combining 5 Castings into a single entity called Pallet (the location, Out, should have a capacity of at least 5).

LOAD/UNLOAD Statements

Another method of batching and unbatching involves the LOAD and UNLOAD statements. As with the GROUP statement, ProModel maintains the identities and attributes of the batched entities. Therefore, when you use the UNLOAD statement, each entity still has its attribute assignments.

The difference between LOAD and GROUP is that LOAD requires a “base” entity on which you temporarily load other entities that might represent a pallet or container. Also, the entities you are going to load, travel to the loading location on an “If load request” routing rule.

In the following example, four Gears are loaded onto a pallet. Pallet is the entity which issues the LOAD statement. In addition, the example includes a time element (LOAD 4 in 10 min). This means “load 4 gears or wait 10 minutes, whichever occurs first.” If after 10 minutes only 3 gears arrive, the entity loaded with the 3 gears continues.

Note that the loaded entity, Gear, has “LOAD” in the Routing Rule field as shown here. This tells ProModel that the gear only goes to Loc2 when a Load command requests it.

Since the example does not specify an entity type as part of the LOAD statement, ProModel will load temporarily any entity type waiting for the LOAD request. To control which entity types the model loads, use the “IFF” option with the LOAD statement (e.g., LOAD 4 IFF Entity()=gear).

Once the batch moves to its destination, the model uses the UNLOAD statement to break it into individual components (Gear and Pallet). You must define a routing for the entity Gear after the UNLOAD takes place. Typical uses for LOAD/UNLOAD are palletizing operations, AGV systems, and AS/RS systems.
ACCUM Statement

The ACCUM statement is short for “accumulate.” Its use is slightly different than the GROUP and LOAD statements. ACCUM does not “batch together” entities, but rather holds entities at a location until a certain number accumulate. It behaves much like a gate restricting entities until a certain number arrive at the location. After the required number accumulate, ProModel releases them for downstream processing. This allows you to model a certain type of batching which involves simply the accumulation of parts and their subsequent release—all at a single location. When using the ACCUM statement, make sure the capacity of the location where you are using the ACCUM statement is at least as large as the amount accumulating.

Modeling Priorities

Priorities are an important part of modeling any system. They range from determining which location has priority for processing parts to choosing the appropriate resource. Priorities allow you to determine the order in which events occur in the simulation. The three most common uses of priorities deal with choosing processing destinations, selecting resources, and prioritizing downtimes.

Choosing a Processing Destination

When one downstream destination exists and there are two or more upstream entities competing to get there, you can use priorities. In the following example, two entities at different locations are both trying to get to Process C.

How to enter a priority for a destination:

Enter a priority value directly in the destination field, making sure there is a comma separating the destination and priority.

or...

Click the Destination... button and enter the priority in the appropriate field.

Selecting Resources

Similar to the previous example, this type of prioritizing refers to which of two or more pro-
cesses, requesting the same resource will have priority in capturing the resource. In the Operation field, in conjunction with the USE or GET statements, the process with the higher priority number gets the resource first.

Downtimes and Preemption
ProModel uses priorities in conjunction with resource or location downtimes to determine which defined downtime takes priority. Downtimes with priorities that are 99 or less do not interrupt or “preempt” the activity, but begin after the current process completes. Downtimes with a priority of 100 or higher preempt the current activity. After the downtime, the activity resumes from where it left off.

Displaying Statistics On Screen
Effective use of statistics lends meaning and credibility to simulation models. This section is designed to show ways of displaying statistics on screen while the simulation is running. It also provides examples you can incorporate into any model.

Displaying on-screen statistics is valuable for adding model clarity as well as providing a way to keep track of what is happening in the model. The technique used for displaying statistics is to define variables within your model, perform certain functions on those variables (e.g., addition, subtraction, etc.), and then display those variables on the screen.

ProModel defines variables as symbols (e.g., x, y, and var1) that hold numeric values. They are defined in the Variables edit table. When defining variables, you must include the following information:

• Name (may be alphanumeric combination)
• Type (real or integer)
• Initial value (may be any value)

After defining a variable, you may display it anywhere on the layout screen by simply clicking with your mouse in the desired position with the variable highlighted in the edit table.

How to show system throughput on the screen:

1. Define the variable “thruput.”
2. Display the variable on the screen.
3. In the processing edit table, increment the variable by one each time an entity leaves the system.

Another common, on-screen statistic is work in process (WIP). To show this statistic on the screen, follow the first two steps above. To accurately indicate the WIP in your model, increment a variable as entities enter the system and use the decrement statement as they exit the system.

How to display the total system time for entities:

1. Assign the simulation clock time to an entity attribute at the beginning of your simulation.
2. Subtract that attribute from the current clock time at the ending location and assign it to a variable you can display.

For example, to display total system time for entities in the system, define a variable and an attribute. The entity attribute, Input_Time, records the time an entity entered the system. The variable, Sys_Time, records the elapsed time each entity spent in the system (clock-input time). By displaying the variable on the layout, you will have a dynamic value showing system time of the exiting entity.
Creating Pull Systems

Types of Pull Systems
A pull system is a system in which locations produce parts only on downstream demand. There are two types of pull systems:

- those based on limited buffer or queue sizes.
- those based on more distant “downstream” demand.

The first method, that of limited buffer sizes, is quite easily to model using ProModel. By simply defining limited capacity locations, a preceding location will not send parts until capacity is available. This method works fine for most pull systems. The second method, triggering part movement, based on more distant downstream demand requires use of the SEND statement to trigger part movement.

There are additional ways to model pull systems using ProModel. As you review the modeling requirements of your own pull system, you should verify that these constructs will satisfy your needs.

This section shows how to use the SEND statement to model a pull system. The diagram below shows the pull system we will model. Orders for finished goods arrive at the OrderQue. The arriving order triggers the release of a unit from the location Stores. The order continues to wait at OrderQue until the unit goes through Processes 1 and 2. At Process_1, Unit processes for two minutes. At Process_2, Unit processes for four minutes. Finally, the Unit joins to the requesting order waiting in the OrderQue.

Creating the Pull System

Now let's examine the ProModel steps to build this pull system.

1. Define four locations: Stores, Process_1, Process_2, and OrderQue.
2. Define two entities: Order and Unit.
3. Define the processing as shown previously.
4. Define the arrivals. Schedule Units to arrive at location Stores. Schedule Orders to arrive at location OrderQue.
5. The entity Order “drives” the system by sending Units to Process_1 to fulfill the order. In the operation logic at OrderQue, use the SEND statement to send a Unit to Process_1 from location Stores. A corresponding SEND rule must be used as a Routing Rule for Unit at Stores.
6. After the SEND statement in the operation logic at the OrderQue, use a JOIN statement to join a Unit to an Order. A corresponding JOIN rule must be used as a Routing Rule for Unit at Process_2.
7. Place the processing times for the Unit at Process_1 and Process_2.
When you finish, the processing and routing should appear as shown below.

### Making Assemblies

An assembly occurs when you attach specific items or entities to another entity such as a base part or frame. To assemble entities, use the JOIN or LOAD PERM statement. Implementing JOIN is a two-step process:

1. Employ the JOIN statement at the designated assembly location.
2. Use the JOIN routing rule for all joining entities.

It is helpful to designate one of the joining entities to be the “base” entity which issues the JOIN statement. In the following example, “Comp” is the base entity. All other joining entities must travel to the assembly location on an “If Join Request” routing rule. Note that for “Monitor” traveling to the assembly location, the word “JOIN” appears in the Rule field. This indicates that “Monitor” will go to the location Assembly only if a JOIN statement requests it elsewhere in the model.

Several other ProModel statements similar to JOIN exist such as GROUP/UNGROUP, COMBINE, LOAD, and ACCUM. You generally use these statements for temporary or permanent batching. To learn more about these statements, see the discussion on Batching and Unbatching earlier in this section.

For more information see “Join” on page 494.
Chapter 6:  
Modeling Tips
Chapter 7: Building the Logic

Logic Builder

The Logic Builder provides a quick and powerful way to create valid statements and expressions in logic windows or fields. It takes you through the process of creating statements or expressions, as well as providing point-and-click access to every element defined in your model. The Logic Builder knows the syntax of every statement and function, and allows you to define logic simply by filling in the blanks.

How to access the Logic Builder:

Click the right mouse button in the logic window or expression edit field. Or click the Build button on the logic window’s toolbar.

Using the Logic Builder

When the Logic Builder is opened from a logic window, it remains on the screen until you click the Close button or close the logic window or table from which it was invoked. This allows you to enter multiple statements in a logic window and even move around to other logic windows without having to constantly close and re-open the Logic Builder. The Logic Builder closes automatically when pasting to an expression field.

You can move to another logic window or field while the Logic Builder is still up by right clicking in that field or logic window. The Logic Builder is then reset with only valid statements and elements for that field or window, and will paste the logic you build into that field or window.
How to build a statement or expression:

1. Right click in an expression field or logic window to open the Logic Builder or click on the Build button in a logic window.

2. Select the statement or expression you want to use from the list box. When opened from a logic window, you have the option to click on the Build Expression button to create only an expression.

3. Enter the parameters for the statement or expression. These may be expressions using model elements and/or functions or other statements. Parameters may be edited or entered manually in the Parameter Entry field.

4. Paste the results into the logic field or window by clicking the Paste button.

Logic Builder Components

When invoking the Logic Builder from a logic window, you have the option of building either statements or expressions. Different buttons and lists appear in the Logic Builder as you use the Logic Builder’s options depending upon whether you are selecting a statement or building an expression. The Logic Builder shown at the beginning of this section shows a statement being selected for building.

At the top of the Logic Builder is a display (logic text box) of the statement or expression you are building exactly as it will appear after it is pasted into the logic window. A brief description of the selected statement or function is displayed in the logic text box. This description is replaced with the statement or function syntax when you type a parameter, click a parameter or logic button, or double-click on the statement name. Other components of the Logic Builder are as follows:

- **Parameter buttons** Below the logic text box are one or more buttons to control which parameter to enter for the statement or expression. Parameters can be expressions, statements, or functions. These buttons only appear when parameters may be required by the statement, and may change when you select a different statement. The name of the currently selected button appears immediately below the row of buttons and indicates whether or not the parameter is optional.

- **Parameter entry field** This edit field allows you to enter or edit the current parameter. This only appears when parameters may be required by the statement. As soon as something is entered in this field, the Logic Builder switches to build mode to allow selection of functions or elements of the model.
**Keypad button**  Click on this button to display the numeric keypad for entering numbers in the parameter entry field without using the keyboard.

![Keypad](image)

**Logic buttons**  These buttons can be used to insert logical operators and other punctuation in the parameter entry field above. When you click the button, the operator is inserted at the cursor position in the field. A button appears only when the currently selected parameter can use that particular logical operator.

- **Logical & String Operators:**

  - **Time Unit Operators:**

**Category**  This combo box allows you to select which type of statements appear in the statement selection list below it. You can select all or a specific type.

**Build Expression button**  This button allows you to create only an expression. It displays the logic elements list (see below) for you to create the expression. An expression consists of a combination of numbers, model elements, and/or functions, but does not include statements.

**Statement selection list**  Choose which statement you wish to use from this list. Only valid statements are displayed for the logic window or field you are using.

**Paste button**  This button pastes the text of the logic text box into your logic window or field. It is only available once the minimum requirements of the statement or expression have been completed. The Paste button closes the dialog if you are pasting to a field.

**Clear button**  This button clears whatever you have done since the last paste and allows you to start over.

**Close button**  Closes the Logic Builder without pasting the current logic text box.

**Help button**  Launches the context sensitive help system.

**Logic Elements**  When editing an expression in the parameter entry field, the Statement selection list is replaced by Logic Elements. The box on the left lists logic and model element types. The box on the right lists individual selections from the logic or model element type selected.

**Return and Cancel Buttons**  When editing the parameters of a function or nested statement, two additional buttons appear to the right of the parameter edit box: Return and Cancel.
• **Return button**  This button (available only when required parameters have been entered) returns to the previous parameter entry field and pastes the function or statement at the last cursor position.

• **Cancel button**  Aborts editing of the function or nested statement and returns to editing the previous statement or function.

### Selecting Statements

The first thing to do in creating a statement with the Logic Builder is to select the desired statement from the statements list box. You can restrict the list of statements to choose from using the Statement Type combo box above the statement list. If you are just starting to use ProModel, you may want to select the Basic Statements type to list only the most commonly used statements.

To select a statement, left click on the statement name in the list box. The statement name appears in the logic text box along with a brief description. The parameter buttons also appear just below the logic text box.

Before you begin editing the parameters of the statement, you can select a different statement. However, once you begin defining a parameter, you must click the Clear button to abandon that statement and select another.

### Editing Statement Parameters

Building a statement is simply a matter of filling in the parameters. To enter a parameter, click the appropriate parameter button below the logic text box. The parameter name is displayed above the parameter entry field. Whatever you type in this field or select from the Logic Elements list replaces the parameter name in the logic text box. The parameter name reappears when the entry field is cleared. The names of optional parameters are not displayed in the logic text box.

An optional shortcut to begin editing the statement’s first parameter is to double click on the statement name in the statement list box.

### Selecting Logic Elements

The Logic Elements list box, containing model elements and functions, appears with a selection list box to its right. A number pad element is included in the list, which can also be accessed using the Keypad button.

When you click on an item in the Logic Elements list, the model elements or functions related to that item are listed in the selection box on the right. For example, when you click on Entities, the selection list is entitled Entities and it contains all the entities defined in the model.
How to place a model element in the parameter entry field:

1. Left click on the desired element type in the Logic Elements list box. The elements for that type will be placed in the selection list box.
2. Left click on the desired element to paste it into the parameter entry field at its current cursor position. Note that the element is highlighted in the parameter field; clicking on another element will replace it.

How to place a function in the parameter entry field:

1. Left click on the desired function type or on All functions in the Logic Elements list box. The functions for that type will be placed in the selection list box.
2. Left click on the desired function to paste it into the parameter entry field at its current cursor position. The Logic Builder jumps into build mode for that function’s parameter(s). Note that two new buttons are placed to the right of the parameter edit field: Return and Cancel.
3. To fill in the function’s parameter(s), repeat steps one and two. If you do not want to use this function, abandon it by clicking on the Cancel button.
4. Once the function’s parameters are complete, click on the Return button. The parameters you just completed will be pasted into the function’s parameter entry field, and the completed function with its parameters is pasted into the original statement’s parameter entry field.

Nested Functions & Statements

When you select a function as the parameter for your statement, you must also define that function’s parameter(s). In defining the function’s parameter(s), you may use another function which will also require defined parameters. This second function is called a nested function. In addition, a function may be nested within a nested function. Functions can be nested as many levels as you like. In this way, the logic builder helps you create complex expressions that would be difficult to enter manually.

Control statements such as IF...THEN and WHILE...DO contain parameters that are themselves statements. These are called nested statements. For example, an IF...THEN...ELSE statement might look something like this:

**Nested IF, THEN, ELSE**

```plaintext
If (Variable1 > 10) Then
    
    
Else
    
    
```

One or more statements may appear in the block between the curly braces. The Logic Builder allows you to define the first statement of the block. To add other statements to the block, place the cursor in the logic edit window where you want the next statement and use the Logic Builder to write the statement and paste it in. For
example, in the following Logic Builder window, an IF...THEN...ELSE statement is being built.

The ELSE statement is built with the parameter button labeled Else and the statement following THEN is built using the button labeled Statement. When you click on the parameter button labeled Statement, the statement list box is displayed where you can select from the list of valid logic statements. Click on paste in the above example and you get:

The parameters of nested statements may be model elements or functions, and within those functions you may have nested functions. This allows you to easily build complex control state-

ments without worrying about syntax and placement of nested statements and functions.

Creating Expressions or Pasting Logic/Model Elements Only

In addition to creating statements, the Logic Builder can also be used to create just an expression or to simply paste a particular element such as a variable or resource name. You may not need to create a complete statement, or the field may not accept statements. Pressing the Build Expression button allows you to build and paste expressions, including individual logic or model element names, into your logic window or field.

The expression being built or element being selected is displayed at the top of the window in the logic text box. Use the parameter edit field to build the expression. You can use model elements and/or functions in your expression. When you are finished, click the Paste button to place the expression or selected logic/model element in the logic window or edit field.
Operation Logic

Operation logic defines what happens to an entity when it enters a location. Operation logic is optional, but typically contains at least a WAIT statement for the amount of time the entity should spend at the location. For modeling purposes, the exact nature of the operation (joining, grouping, etc.) is irrelevant. What is essential is to know what happens in terms of the time consumed, the resources used, and any other logic that impacts system performance. For operations requiring more than a time and resource designation, detailed logic may need to be defined using IF...THEN or action statements.

Special operation statements are provided to define the activities that are to occur. By using operation logic, any of the following activities can be defined:

• Detain an entity for a specified length of time while an activity is performed.
• Detain an entity until one or more resources are obtained.
• Detain an entity until one or more additional entities are joined to it.
• Detach one or more entities from the current entity.
• Consolidate one or more entities into a group.
• Separate an entity into two or more entities.
• Detain an entity until a particular system condition is reached.
• Destroy an entity.
• Create one or more new entities.
• Execute a block of logic (assignment of variables, etc.).
• Signal the start of some other action in the system (e.g., place an order).
• Make some decision about further routing.

Statements can be typed directly into the operation field, or inside a larger logic window after double-clicking in the field or clicking on the Operation button. Alternatively, the Logic Builder can help build logic and is accessed by clicking the right mouse button inside the operation field or logic window. All statements, functions, and distributions available in the operation field are discussed in detail, including examples, in “Statements and Functions” on page 429.

Example

Each entity processes the operation statements defined for it at a particular location, independent of other operations performed on other entities at the same location. The following example presents the operation logic for an entity joining an entity, EntB, and renaming the entity as EntC.
Preemption Process Logic

With Preemption Process Logic, ProModel makes it possible to control preemption rather than limit you to default preemption priority levels and values. This feature pertains only to the preemption of entities using a location. It does not include preemption of downtimes.

Normally, if an entity or downtime attempts to preempt an entity that is using a location, the location is immediately preempted (assuming it is preemptable). Once the location finishes the preempting activity, the original preempted entity regains possession of the location and resumes processing where it left off.

To override this default preemption procedure, in the case of entities that are preempted by another entity or a downtime, ProModel allows a Preemption Process Record to be defined which postpones the actual preemption of the location until after the current entity explicitly releases it.

The Preemption Process Record, allows you to control if and when the location is given up. In the case of a preemptive request for a location, the preemption process record allows the entity to be routed elsewhere if desired. If a preemption process is defined, the actual preemption does not occur until the preemption process explicitly frees the location.

After the location is given up, the entity may (1) elect to use an alternative location to complete the process, or (2) seek to regain access to the same location to complete the process.

While an entity is executing a preemption process, it cannot be preempted by any other entity or downtime.

How to create a preemption process record:

1. Using the same entity and location names, create a process record somewhere following the process record where the preemption may occur.

2. Click on the Entity button to display the Entities dialog shown here.

3. Check the Preemption Process option box and click OK.

4. Click on the Operation button to enter the preemption logic. You can use any valid operation logic including delays. It is recommended that you enter a comment as the first line in the logic indicating that this is a preemption process. This will make the record easily identifiable as a preemption process.

Please note

*When a preemption occurs, the entity looks forward and then from the beginning of the process*
list trying to find a preemption process that matches the same entity and location (a process with ALL as the entity name will match any entity). If a match is found, the preemption process gets executed. Otherwise the default preemption occurs. Only the first preemption process encountered will be executed in the event that multiple preemption processes are defined with the same entity and location names.

Possible Effects of Delayed Preemption

Several circumstances can be created through the use of preemption process records. An entity delaying a preemption, for example, may find at the conclusion of the delay that the preemption is no longer required, or that it faces an even higher preemption priority.

In cases where an entity has multiple locations or resources from which to choose, a preemptive request for any one of them is not necessarily a commitment to select that particular location. If any of the alternative locations becomes available, the entity will select it and withdraw the preemption request.

Functions for Defining Logic in a Preemption Process

The Preemption Process Logic feature includes the following functions for use in the preemption logic.

PREEMPTOR() Identifies whether a downtime or entity is making the preemptive request. It returns a 0 if the preemptor is a downtime, otherwise it returns the index number of the preempting entity.

TIMELEFT() Returns the amount of time remaining if the preemption occurred during a WAIT or USE statement. It returns a time value in default time units (real). If multiple entities are preempted from a location, it returns the longest remaining time for all of the entities.

Please note

The values returned by these functions must be checked before any processing delay occurs since they are updated whenever a preemption takes place. If the values must be referred to later, they should be assigned to the entity’s attribute or to a local variable.

Preemption Process Example

In this example, a Gear may be preempted in its occupancy of the Lathe. This preemption may be because of either a preempting entity or downtime. Before the actual preemption takes place, the operation time for the Gear is interrupted and the Gear immediately begins processing the operation logic defined in the preemption process.

In the preemption process, the remaining operation time is stored in Attr1. The Gear routes to Lathe_Backup where it finishes processing. Because the backup lathe is not as efficient as the other Lathe, it takes 50% longer to process the Gear on Lathe_Backup. Therefore, we multiply the time left to process the Gear by a factor of 1.5.
Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gear</td>
<td>Lathe</td>
<td>WAIT 10 min</td>
</tr>
<tr>
<td>Gear</td>
<td>Lathe</td>
<td>Attr1=TIMELEFT()</td>
</tr>
<tr>
<td>Gear</td>
<td>Lathe_Backup</td>
<td>WAIT Attr1*1.5</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gear</td>
<td>Mill</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Gear</td>
<td>Lathe_Backup</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Gear</td>
<td>Mill</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>

Routing Move Logic

To accommodate the use of multiple resources for entity movement, the Move Logic window allows you to define the method of movement as well as any other logic to be executed upon movement.

Once the route condition or rule has been satisfied for allowing an entity to route to a particular location, the move logic is immediately executed. The entity does not actually leave the current location until a move related statement (MOVE FOR, MOVE ON, or MOVE WITH) is executed or until the move logic is completed, whichever happens first. This allows the entity to get one or more resources, wait additional time, or wait until a condition is satisfied before actually leaving the location.

Any statements encountered in the move logic after a move related statement are executed after the move is complete, but before the entity actually enters the next location. This is often useful for freeing multiple resources used to transport the entity.

When you access the Processing module in the Build menu, the Routing edit table appears with the Move Logic button in the right hand column as shown here.
When you click the Move Logic the following Move Logic window appears.

![ProModel 295 User Guide](image)

This window allows you to manually edit the logic or click on the Build button to use the Logic Builder. It also provides other convenient buttons for editing and printing the move logic.

**Move-Related Statements**

Admissible statements in the Move Logic window include the new move-related statements listed here. A brief description of how each statement functions in ProModel follows the list. See “Statements and Functions” on page 429 for complete syntax, description, and examples of these statements.

**MOVE statements**

MOVE FOR <time>  
MOVE WITH <res1> {, {p1}} {FOR <time>} {THEN FREE}  
MOVE ON <path network>

**MOVE FOR <time>**  Used to specify the amount of time required to move the entity. If the <time> is zero, events for other entities occurring at the same simulation time will be processed before any additional logic is processed for the current entity.

**MOVE WITH**  This statement is used to move an entity using a designated resource, such as a fork-lift. With the OR operator, you can designate alternative resources for making the move. In this case, the statement captures the first available alternative resource designated in the expression and makes the move. If one of the resources is already owned by the entity, that resource will be used. Please note that you cannot use the AND operator to capture (and move with) more than one resource with this statement. To move an entity with multiple resources, you must use a GET statement to capture the additional resources.

This statement also allows you to set the priority (p1) for accessing the designated resource. If the resource is already owned by the entity, this priority is ignored.

If the resource is static, a time (FOR <time>) may be specified for the move.

The resource used to make the move is only freed if the THEN FREE option is used.

**MOVE ON <path network>**  Use this statement to move an entity along a path network.
Please note

Not entering no move related statement in the Move Logic window causes entities to move immediately to the next location when the move logic is completed and begin executing the operation logic for that location.

Related Logic Statements

In addition to these routing specific statements, all statements and functions allowed in exit logic may be used in the Move Logic window. Note, however, that the LOCATION() function returns the current location when executed before the MOVE statement and returns the destination location when executed after the MOVE statement. Additional statements permitted before a move-related statement include: WAIT, WAIT UNTIL, GET, JOINTLY GET, and USE.

See “Statements and Functions” on page 429 for full description, elements explained, and examples.

Statement Processing

Statements executed before a MOVE related statement are processed after the entity claims the next location but before the entity actually departs from the current location.

Statements executed after a MOVE related statement are processed after the move has been completed but before the entity enters the location. If there is no move logic, the entity continues processing until it encounters an implicit WAIT. However, if “MOVE FOR 0” is placed in the move logic, the event list is broken and other processes scheduled to occur at the same time are executed. Once these processes are executed, the entity enters the destination location.
Shift & Break Logic

Shift & Break Logic

Shift and break logic are optional and are defined in four distinct logic windows. Each logic window is executed in a specific sequence throughout the simulation run. You can define logic that controls how resources and locations go off duty or off line and what happens once they are off line.

To define shift or break logic, click on the Logic button in shift assignments to display a submenu of four shift events for which logic may be defined. Selecting an event from the submenu displays a standard logic window. You can enter separate logic for each of these four events to be executed when the event occurs. See Sequence of Events below.

You may want to use the Logic Builder to help you enter the logic. Just click on the Build button in the logic window.

Pre-Off Shift or Pre-Break Logic Executed whenever the location or resource is scheduled to go off shift or on break. This occurs before the location or resource is checked for availability, and is executed regardless of availability. This logic may be used to check certain conditions before actually taking the resource or location off line. The logic is executed for each resource and location listed as members for this shift assignment record. This allows some members to be taken off line while others may be forced to wait. (Pre-off shift and pre-break logic may be referred to in this manual as pre-start logic when speaking of either one.)

Off Shift & Break Logic Logic executed at the instant the location or resource actually goes off line.

How to determine the sequence of events

1. When a location or resource is scheduled to go off line due to a break or the end of a shift, the pre-start logic for that particular location or resource is executed.
2. After executing the pre-start logic, which may contain conditional (WAIT UNTIL) or time (WAIT) delays, the location or resource is taken off line, assuming it is either available or the priority is high enough for preemption.
3. At the instant the location or resource is taken off line, the Off-Shift or Break logic is executed.
4. After executing this logic, the location or resource waits until the time defined in the shift file expires before going back on line.

Please note

If the off-shift and break nodes are not specified in the Resource Specs dialog, the resource will stay at the current node. If no resources or locations are assigned to a shift, the shift is ignored.

Functions and Statements

ProModel uses several functions and statements specifically for off-shift and break logic: SKIP, PRIORITY, DTLEFT(), FORLOCATION(), FORRESOURCE(), and RESOURCE(). Following is a brief description of each. For more details, see “Statements and Functions” on page 429.
**SKIP**  If used in pre-start logic, it causes the off-shift or break time (including any off-shift or break logic) to be skipped so that the location or resource never goes off line. If used in the off-shift or break logic, it causes the off-line time defined in the shift file to be skipped. This allows you to specify a WAIT statement for the off-line time and then SKIP the off-line time defined in the shift file.

**_PRIORITY**  This statement provides an alternative way to specify off-shift or break priorities. It also allows the priority to be changed after some time being off-shift or on break. If the priority is changed to a value lower than the current value, the system will check if any preemption may occur at that time. This statement is not allowed in pre-off shift or pre-break logic.

**DTLEFT()**  This function returns the remaining off-shift time based on when the location or resource is scheduled to go back on shift as defined in the shift file. It may be used in off-shift and break logic to adjust the actual time that the location or resource is off-line.

**FORLOCATION()**  This function returns TRUE if the member for which the shift or break logic being executed is a location. This may be followed by a test using the LOCATION() function to determine the precise location.

**FORRESOURCE()**  This function returns TRUE if the member for which the shift or break logic being executed is a resource. The RESOURCE() function may then be used to determine the precise resource if multiple resources are listed as members.

**RESOURCE()**  This returns the name-index number of the resource currently processing the off-shift or break logic.

In addition to these functions, the LOCATION() and DTDELAY() functions are particularly useful when defining off-shift and break logic.
Chapter 8: Using Auxiliary Tools

Tools Menu

The Tools menu gives you access to powerful tools to help you through the model building process.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expressions Search</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphic Editor</td>
<td>Stat::Fit</td>
<td>3D Animator</td>
</tr>
<tr>
<td>License Manager</td>
<td>Options</td>
<td>Customize</td>
</tr>
<tr>
<td>QuickBar</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Expression Search**  Allows you to perform global search and replace functions on expressions throughout any part of the model.

**Graphic Editor**  Allows you to create, edit, rearrange, or delete library graphics for use as entities, locations, resources and background graphics.

**Stat::Fit**  Launches Stat::Fit and allows you to fit analytical distributions to user data.

**3D Animator**  Launches 3D Animator if it is installed. If 3D Animator is not installed, a dialog will provide information about purchasing 3D Animator or obtaining a demonstration version.

**License Manager**  Launches the license manager. Since license changes cannot be made while ProModel is running, you will be prompted to close ProModel prior to running the License Manager.

**Options**  Allows you to set various directory and display defaults.

**Customize**  Allows you to customize the Tools menu.

**Additional Tools**  Tools can be added to the Tools menu by using the Customize option. These tools are discussed in the latter part of this chapter.
Expression Search

The Expression Search feature is used to find or replace text entered into logic windows and expression fields, such as location downtime logic or location capacity. Name fields can be found, but not replaced. Reference fields can be found and replaced. However, when the name of a location, resource, or entity is changed, the user will be prompted to automatically change all references to the new name. There are three types of searches: Find expression, Replace expression, and Search Next expression.

How to perform an expression search:

* Select Expression Search from the Tools menu.

Expression Search Sub-Menu Choices

Find

A dialog box gives you the following options after choosing Find from the Expression Search submenu:

Modules to Search  Check the modules you want to search. “Other” includes all other edit tables and some dialog boxes where text is entered for defining the model, such as attributes or arrays.

Search Notes  Check this box to include Notes fields in the text search.

Whole Words Only  Check this box to search for only whole words or groups of whole words that match the text to find. For example, searching for “Attr” without the Whole Words Only box checked will find “Attr1” and “Attr2” whereas a search with the box checked would find neither.

Text to Find  Enter the text expression you want to find.

Replace

Choosing replace gives you these options in addition to the find options:

Prompt on Replace  Check this box if each time ProModel finds a match, you want ProModel to ask if you want that particular match changed to the replacement text. The prompt will give you the option to replace that particular match, skip that particular match, or to cancel the search altogether.

New Text  Enter the text you want to replace the search text.

Search Next

Choosing Search Next in the Expression Search submenu will resume the most recently canceled search. For example, suppose you begin a search and then break out of the search to adjust something in the model. If you want to continue the original search, you can select Search Next and ProModel will start the search again at the place you stopped searching.
Find Expression

The Find Expression option allows you to find each occurrence of an expression in a model.

How to find an expression:

1. From the Tools menu, select Expression Search.
2. Select Find... from the submenu.
3. Supply the necessary details in the Find dialog box shown below. Clicking Select All or Deselect All button will check or uncheck every module.
4. Click OK.

Once the Expression Search has found the first occurrence of an expression, a dialog box will appear giving information on exactly where the text was found. Then ProModel will display the following dialog, including a box displaying the entire line on which the text was found, with the search expression highlighted.

How to find the next match of a text expression:

- Click on Search Again

Replace Expression

The Replace Expression option allows you to find each occurrence of an expression in a model and replace that expression with a new expression.

How to replace an expression with another expression:

1. Select Replace... from the Expression Search submenu.
2. Supply the necessary details in the Replace dialog box shown below. Clicking Select All or Deselect All button will check or uncheck every module.

![Replace Dialog Box]

3. Click on OK. If you have chosen “Prompt on Replace,” ProModel will then display the following dialog box if it finds the text you specified.

![Replace Dialog Box with Text Find and New Text]

4. Choose:

   - Yes to change the text and search for the next match.
   - Change All to change every match.
   - No to skip this match and search for the next match.
   - Go to Module to edit the text directly.
   - Cancel to leave the match intact and stop searching.

---

### Important Notes Regarding Expression Searches

1. Not every field of every module is included. Fields such as statistics, text in graphics, or yes/no fields which may not be edited cannot be searched for or replaced. To replace record identifiers, see number six.

2. Under “Modules to Search,” the Other option refers to information entered in places not listed in the dialog box, including the Simulation Options dialog box.

3. Notes fields are not part of the actual model data, therefore they are not automatically included in the search. Notes also include comments in the model. If you want to search or replace Notes fields, check the Search Notes option in the Find or Replace dialog boxes.

4. The Whole Words Only option interprets words loosely enough to distinguish words not separated by spaces. For example, searching for “Attr1” in the expression Attr1=Attr1+Attr2, would find both occurrences. You can search for expressions longer than a whole word, such as “Attr1=Attr1+Attr2,” as whole word expressions. To find a portion of a name, like “Attr” in “Attr1,” deselect the Whole Words Only option.

5. Once the Expression Search has found the first occurrence of an expression, a dialog box will appear giving information on exactly where the text was found. This includes a box displaying the entire line on which the text was found, with the search expression highlighted. In some cases the box may be too small to display the entire line. To see the hidden portion of the text, left click with the left mouse button on the text, and use the left and right arrow keys to scroll the text horizontally.
6. The Replace feature cannot be used to change an element identifier. To change all occurrences of a model element name (such as a location name), change the name of the element where it is defined and all other expressions containing the name, as well as any references to this record, will be changed automatically.

**Local Find and Replace**

In the process of creating logic, you may need to search for specific text. The local find and replace button in the operation logic window opens a dialog that will allow you to search the logic for specific text.
Graphic Editor

The Graphic Editor allows you to create, edit, rearrange, or delete library graphics within a particular graphics library file. You can also copy graphics from one library to another. Graphics from several libraries can even be merged into a single graphic. Each graphics library is saved with the grid size and scaled used to create the graphics.

How to access the graphic editor from within ProModel:

- Select Graphic Editor from the Tools menu.

How to access the graphic editor from the program manager:

- Double click the Graphic Editor icon in the ProModel Group. This method allows you to use the Graphic Editor as a separate application from ProModel.

Overview

The Graphic Editor consists of a menu bar, a Graphic Tools button bar, a Graphic Library menu, Library Edit buttons, an Edit window, and a set of icons representing the graphics in the graphics library.

Each of the tools in the Graphic Tools button bar is discussed in this section, including the procedures for creating and editing a graphic’s components (called “objects”) using the drawing tools.

Graphic Editor Menus

The Graphic Editor menu bar includes the following menus:

File The File menu allows you to open a graphics library for editing and saving a current library. It also allows you to print a single graphic or an entire library.

Edit The Edit menu provides functions for selecting and duplicating one or more objects that comprise a library graphic. In addition, it provides functions to import and export graphics from other applications.

Graphics The Graphics menu is for manipulating one or more objects that comprise a library graphic. With this menu, you can group several objects together, flip and rotate objects, and alter the color, fill pattern and line style of objects.
You can also adjust the dimensions of the entire graphic.

**Options** The Options menu controls the editing environment. With this menu you can use a grid to help you align component objects, edit that grid, and require objects to snap to it. Finally, the Options menu allows you to zoom in and out on the graphic so you can edit the graphic at different sizes.

**Window** The Window menu allows you to arrange the windows (or iconized windows) currently displayed on the screen such that all windows are visible at once. It also allows you to bring any individual window to the forefront of the display. This is particularly useful when you are opening multiple graphic libraries and want to view all libraries simultaneously.

### File Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates an empty graphics library.</td>
</tr>
<tr>
<td>Open</td>
<td>Brings up the Open Library Graphics dialog box for specifying which graphics library file to retrieve. Graphics library files have the file extension GLB.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current graphic library.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves an open graphics library under the current file name or prompts you for a name if the graphics library has not been named.</td>
</tr>
<tr>
<td>Save As</td>
<td>Brings up the Save As dialog box for saving the current Graphics library file under a new filename. Graphic Library files have the file extension GLB.</td>
</tr>
<tr>
<td>Print Graphic</td>
<td>Prints the graphic in the Edit window only.</td>
</tr>
<tr>
<td>Print Library</td>
<td>Prints the entire current graphic library.</td>
</tr>
<tr>
<td>Exit</td>
<td>Quits the Graphic Editor with an option to save the current library if changes have been made since the last save.</td>
</tr>
<tr>
<td>Recently Opened Files</td>
<td>Lists the five most recently retrieved graphics libraries. Selecting one of these options will retrieve the listed graphics library.</td>
</tr>
</tbody>
</table>

### Opening a Graphics Library File

All individual library graphics are loaded from and saved to the current graphics library, which, by default, is the one specified for the current model. However, other graphic libraries may be opened for editing at any time. The name of the current library is displayed in the title bar of the window for each library. More than one library can be opened and viewed on the screen at a time. Opening more than one graphic library simultaneously facilitates copying graphics between libraries.

**How to open another graphics library file:**

1. Choose **Open** from the **File** menu.
2. Enter or select the name of the desired graphics library.
3. To view all open graphic libraries, choose **Tile** or **Cascade** from the **Window** menu.
Please note

A history list is given at the bottom of the File menu so you are able to quickly retrieve the last five libraries opened.

Closing a Graphics Library File

When you are finished working with a graphics library, you can close it to save screen space and memory. This option will not affect the graphic library used with any model.

How to close a graphics library file:

• Choose Close from the File menu.

Saving a Graphics Library File

Once a graphic has been created or edited and placed in the current library, the library file must be saved in order to make the changes permanent.

How to save a graphics library file:

• Select Save from the File menu to save the library with the same name.

How to save a graphics library file with a new name:

• Select Save As from the File menu to save the library with a new name.

Printing an Individual Graphic

How to print an individual graphic:

1. Double click the mouse on the desired graphic’s icon, or select the graphic’s icon and click the Edit button.
2. Select Print Graphic from the File menu.
3. Choose the desired options from the resulting Print dialog box and click OK.

Printing an Entire Graphics Library

How to print an entire graphics library:

1. Select Print Library from the File menu.
2. Choose the desired print options from the Library Print dialog box and select OK.

Please note

If more than one graphic library is open, Pro-Model will print the active graphic library only.

Edit Menu

Use the Edit menu for selecting and duplicating the individual objects comprising a library graphic. You may also use it to exchange graphics with other applications. To use the Edit menu functions, load the graphic you wish to edit by
selecting its icon from the library and clicking the Edit button, or double click the icon.

<table>
<thead>
<tr>
<th>Cut</th>
<th>Removes the selected object(s) and makes a temporary copy that may be pasted back into the edit window later.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Makes a temporary copy of the selected object(s) to be pasted later.</td>
</tr>
<tr>
<td>Paste</td>
<td>Adds the most recently cut or copied object(s) to the current graphic.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected objects from the current graphic.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all of the objects comprising the current graphic.</td>
</tr>
<tr>
<td>Copy to Clipboard</td>
<td>Copies the entire graphic to the clipboard as a bitmap so it can be pasted into other applications including word processors.</td>
</tr>
<tr>
<td>Paste WMF</td>
<td>Pastes a Windows metafile (WMF) from the Windows clipboard into the Edit window. You must have previously copied a Windows metafile to the Windows clipboard in another application.</td>
</tr>
<tr>
<td>Paste BMP</td>
<td>Pastes a bitmap file (BMP) from the Windows clipboard into the Edit window. You must first copy a bitmap file to the Windows clipboard.</td>
</tr>
<tr>
<td>Import Graphic</td>
<td>Imports a WMF, EMF, BMP, PCX or GIF file into the Edit window.</td>
</tr>
<tr>
<td>Export Graphic</td>
<td>Exports the graphic in the Edit window to a WMF or BMP file.</td>
</tr>
</tbody>
</table>

**Importing a Graphic**

**How to import a graphic into a graphic library:**

1. Select the box to which you would like to add the graphic in the library. If you want to create a new graphic, choose the blank box at the end.
2. Select **Import Graphic** from the **Edit** menu.
3. Enter the name of the graphic you would like to import.
4. Select **OK** to close the import graphic dialog box.
5. Click on the **Save** button on the top right side of the library window.

**Exporting a Graphic**

**How to export a graphic:**

1. Double-click the mouse on the desired graphic’s icon, or select the graphic’s icon and click the Edit button.
2. Select **Export Graphic** from the **Edit** menu.
3. Enter a valid DOS name for the graphic in the resulting dialog box.
4. Click the **OK** button in the export graphic dialog box.
Copy a Graphic from One Library to Another

How to copy an icon from one library to another

1. Open both libraries.
2. Drag the graphic’s icon from the first graphic library to the second graphic library (preferably left to right).
3. Save the destination library by choosing Save from the File menu.

Graphics Menu

The Graphics menu is for manipulating one or more objects that comprise a library graphic. With this menu, you can group several objects together, flip and rotate objects, and alter the color, fill pattern and line style of objects. You can also adjust the dimensions of the entire graphic.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip Horizontal</td>
<td>Horizontally flips the entire graphic or any selected objects of the current graphic. This menu item works like the button of the same name described later in this chapter.</td>
</tr>
<tr>
<td>Flip Vertical</td>
<td>Vertically flips the entire graphic or any selected objects of the current graphic. This menu item works like the button of the same name described later in this chapter.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotates the entire graphic or any selected objects of the current graphic 90 degrees clockwise. This menu item works like the button of the same name described later in this chapter.</td>
</tr>
<tr>
<td>Move to Front</td>
<td>Moves the selected object in front of all other objects. Use this option to see an object obscured by other objects. This menu item works like the button of the same name described later in this chapter (to move an object one position forward at a time, use the Graphic Tools).</td>
</tr>
<tr>
<td>Move to Back</td>
<td>Moves the selected object behind all other objects. Use this option to send an object obscuring other objects to the background. This menu item works like the button of the same name described later in this chapter.</td>
</tr>
<tr>
<td>Group</td>
<td>Combines or groups several objects into a single object for sizing and editing.</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Ungroups several grouped objects so they may be edited individually.</td>
</tr>
<tr>
<td>Line Styles</td>
<td>Allows the user to choose the line style including solid, dashed, line thickness, and optional arrowheads on either end of the line.</td>
</tr>
<tr>
<td>Fill Patterns</td>
<td>Allows the user to choose the fill pattern for solid objects including transparent, slant, backward slant, grid, crosshatch, vertical, horizontal, solid, vertical gradient, and horizontal gradient.</td>
</tr>
<tr>
<td>Line Color</td>
<td>Allows the user to choose the line color and create custom colors.</td>
</tr>
<tr>
<td>Fill Color</td>
<td>Allows the user to choose the fill color and create custom colors for solid objects.</td>
</tr>
</tbody>
</table>
Dimension  Brings up the Dimensions dialog box for defining the graphic dimension. The dimension can be height or width. The units can be feet or meters.

Please note

Line Styles, Fill Patterns, Line Color, and Fill Color set the feature and cause the setting to be applied to the currently selected elements.

Group

When using the graphic tools to create an icon, it is often helpful to group several graphics into a single graphic for editing purposes. For example, you may create an icon using the square, line, and circle tool and want to work with them as a single item.

How to group objects together:

1. Use selector to select all objects you desire to group. Hold the shift key down to select more than one object at a time.
2. Choose Group from the Graphics menu.
3. Manipulate the group as necessary.

Ungroup

The Ungroup option allows you to ungroup several grouped objects.

How to ungroup previously grouped objects:

1. Use the selector to select the object you desire to ungroup.

2. Choose Ungroup from the Graphics menu.

Line Styles

You may choose different styles for the lines and borders of objects by choosing Line Styles in the Graphic Editor Graphics menu.

How to change the line style or border style of an object:

1. Select the desired object(s) using the Selector.
2. Choose Line Styles from the Graphic Editor Graphics menu.
3. Click on the desired style.
**Please note**

*The arrowhead color is the same as the line color and is defined through the Line Color in the Graphics menu.*

---

**Fill Patterns**

Various patterns may be used to fill each object by choosing Fill Patterns from the Graphic Editor Graphics menu.

2. Choose **Fill Patterns** from the Graphic Editor Graphics menu.

3. Click on the desired fill pattern.

---

**Line and Fill Color**

You may also select a custom color for your lines and graphics.

**How to change line or fill color**

1. Select the line or graphic you want to change.

2. Choose **Line Color** or **Fill Color** from the Graphics menu.

3. From the dialog below, click on the color you wish to use.

---

**Dimension**

You can define the height or width of an object in feet or meters from the Dimensions Dialog box. This will determine how large the graphic appears when placed on a model layout. For example, to change the width of a graphic loaded

---

**How to change the fill pattern of an object:**

1. Select the desired object(s) using the Selector.
in the Edit window to 5.00 feet, enter the following in the Dimensions dialog box:

![Dimensions dialog box]

**How to change the graphic’s dimensions:**

1. Load a graphic into the Edit window.
2. Select **Dimension** from the **Graphics** menu.
3. Enter the new graphic dimension and click **OK**.

For example, a graphic of a computer is displayed in the Graphic Edit window. The size of the graphic in the Graphic Edit window is 1.40 x 1.00 as shown below.

![Dimension: 1.40 x 1.00]

However, the computer is really 2 feet wide. To change the graphic’s dimensions, select **Dimension** from the Options menu. Type 2 for the horizontal dimension and click **OK**.

![Dimension: 2.00 x 1.43]

Notice the vertical dimension is automatically adjusted to 1.43. You can only define either the horizontal or vertical dimension of the graphic. If you define one dimension, the software will automatically calculate the other according to the proportions of the graphic in the Edit window. If you know the graphic is actually 2.00 x 1.50 feet, you will need to adjust the proportions of the graphic accordingly by using various tools from the Tools button bar.

**Options Menu**

The Options menu controls the editing environment. With this menu you can use a grid to help align objects, edit that grid, and require objects to snap to it. Finally, the Options menu allows you to zoom in and out on the graphic so you can edit the graphic at different sizes.

**Grid Settings**  Brings up the Grid dialog box for choosing the size, color and visibility of the grid.

**Show Grid**  Causes the grid to appear in the background for editing purposes. If the grid is on, choosing this option will turn it off. This is the same as choosing Grid On in the Grid dialog box.

**Snap to Grid**  Positions any object subsequently drawn or moved on the layout on the nearest grid line. This option works whether the grid is visible or not.

**Background Color**  Brings up the color dialog box for choosing a background color for the layout window.

**Zoom**  Shrinks or enlarges your view of the graphic by the percentage selected.

**Grid Settings**

The grid size is changed by using the scroll bar to the right of the grid dialog box. Move the scroll bar up to increase the grid size and move the
scroll bar down to decrease the grid size. To change the color of the fine grid lines, select the Ones button and then choose a color. To change the color of the coarse grid lines, select the Tens button and choose a color.

Instead of viewing boxes as the grid units, you may choose dots by selecting the dots box. You may also choose to switch the grid, as well as the grid snap, on in this same area.

Show Grid

How to show the grid on the layout window:

- Choose Show Grid from the Options menu.

Snap to Grid

How to have all new and edited objects snap to the grid:

- Choose Snap to Grid from the Options menu.

Background Color

How to change the background color of the edit window:

- Choose Background Color from the Options menu.

Zoom

How to magnify a graphic:

1. Choose Zoom from the Options menu.
2. Choose the level of magnification from the sub-menu.

Window Menu

The Window menu is used to manipulate the various windows in the Graphic Editor and follows
the Microsoft Windows standard for Window menus.

<table>
<thead>
<tr>
<th>Tile</th>
<th>Cascade</th>
<th>Arrange Icons</th>
</tr>
</thead>
</table>

**Tile**  Causes all open windows to fit in the available screen space. Windows that may be hidden behind other windows will become visible. This is useful when desiring to view more than one graphic library on the screen at a time.

**Cascade**  Causes all open windows to overlap such that the title bar of each window is visible.

**Arrange Icons**  Takes all active iconized windows and arranges them neatly along the bottom of the screen.

**Open Libraries**  Displays all graphic libraries currently open in the Graphic Editor. To switch to another open library, click on the desired name.

### Library Edit Buttons

The Graphic Editor contains four library edit buttons: Edit, Save, Delete, and Clear.

![Library Edit Buttons]

**Edit**  Retrieves a selected graphic from the library to the edit window.

**Save**  Saves a graphic from the Edit window to the library. For a new graphic to be added to the library, the blank box at the end of the library must be selected. Otherwise, the graphic in the Edit window will replace whichever graphic’s icon is selected.

**Delete**  Deletes the selected graphic from the library.

**Clear**  Clears the contents of the edit window.

### How to edit a graphic:

- Double-click on the graphic in the library. This method clears the contents of the Edit window before loading the new graphic.

or...

- Select the graphic by clicking once on the graphic and then click the **Edit** button. This method clears the contents of the Edit window before loading the new graphic.

### Manipulating Graphics

Among other things, a graphic can be reduced, enlarged, combined, and reordered.

### How to change a graphic’s size:

1. Select the graphic in the Edit window using the selector.
2. Choose **Group** from the **Graphics** menu.
3. Select one of the small gray boxes at the graphic edge to reduce or enlarge the graphic size. The selector will change to a cross-hair when you are near a gray box.
4. Drag the box to the desired size.

Several graphics can be combined together to create a single graphic. For example, a desk and a chair are separate graphics but would be easier to use if they were combined to form a single graphic.
How to combine two graphics:

1. Load the first graphic into the edit window.
2. Drag the second graphic into the edit window.
3. Position and size the two graphics as desired.
4. Click the blank box in the graphic library.
5. Click the Save button.

How to change the order of graphics in a graphic library:

- Drag a graphic to the desired location in the library.

Create New Graphics and Libraries

How to create a new graphic

1. Select Graphic Editor from the Tools menu.
2. Use the drawing tools to create the new graphic.
3. Click the Save button on the graphic editor.
4. The image appears at the end of the existing icons.

How to create a new graphic library

1. Select Graphic Editor from the Tools menu.
2. Select New from the File menu.
3. Use the drawing tools to create any graphics you wish to use in your library. You may also copy and paste graphics from existing libraries.
4. After you finish preparing each new image, click the Save button on the graphic editor.

Naming a Graphic

Graphics can be named for resources, locations, and entities, or merely for easier identification. When a named graphic is chosen while building a model, instead of entering a default name, such as Loc1, ProModel will enter the graphic's name, such as Desk. If the name already exists for a location or resource graphic, a number will be appended (Desk1, Desk2, etc.). If the name already exists for an entity graphic, a letter will be appended (ChairA, ChairB, etc.). This will make the model easier to understand and use.

How to name a graphic:

1. Enter the desired name at the bottom left of the screen where it says “Name.”
2. Click the Save button to save the named graphic.

Please note

Correct syntax for location, resource, and entity names should be used when entering a name in the Name field if the graphic is intended to represent locations, resources, or entities. Graphic names are allowed to have spaces which automatically convert to underscores “_” when used for locations, resources, or entities.
Graphic Tools Button Bar

The Graphic Tools Button Bar contains the tools necessary to create and edit a graphic’s component objects. The drawing tools are the main tools through which graphics are created and edited in the Editing window. The drawing tools include the following:

- Selector
- Entity Spots
- Text
- Status Lights
- Lines
- Flip Horizontal
- Arcs
- Flip Vertical
- Triangles
- Rotate
- Regular Squares and Rectangles
- Cut
- Rounded Squares and Rectangles
- Copy
- Circles and Ellipses
- Paste
- Chords
- Step Back
- Pies
- Step Front
- Polygons
- Line Color
- Raised Squares and Rectangles
- Fill Color

Selector

The Selector is a pointing device that allows you to select one or more objects of a graphic. It also allows you to move, size, and shape all graphic objects.

![Selector](image)

**How to move an object:**

1. Click on the Selector button.
2. Drag the object to the desired location.

**How to size or shape an object:**

1. Click on the Selector button from the button bar.
2. Select the desired object.
3. Drag the sizing points. The arrow will turn into a cross-hair when it approaches the sizing points.

Text Tool

Text may be placed anywhere in the graphic by using the Text tool.

![Text Tool](image)
How to place text in a graphic:

1. Select the Text tool from the button bar.
2. Click where the text is to appear. The Text dialog box will open.
3. Enter the desired text in the Text dialog box below. Set the desired options for the text. When finished, click the **OK** button.

How to edit text already in the graphic:

- Double click on the text.

Lines

Lines may consist of several segments and are drawn using the line tool.

How to draw lines in the graphic editor:

1. Select the Line tool.
2. Click the left mouse button where the line is to begin.
3. Move the mouse to the end of the line segment.
4. Click the left mouse button to create a joint and begin the next segment.
5. Double click the left mouse button or click the right mouse button to end the line.

Please note

*Lines can be drawn at 15 degree increments by holding the shift key while moving the end of a line segment.*
Arcs

Arcs are drawn using the Arc tool.

How to draw an arc in the graphic editor:

1. Select the Arc tool from the Tools window.
2. Press the left mouse button at one end of the desired arc.
3. Drag the mouse to the other end of the arc and release the left mouse button.

Please note

To have the arc bow left, start the arc from the top and drag down. To have the arc bow right, start the arc from the bottom and drag up.

Triangles

Triangles are drawn using the Triangle tool.

How to draw a triangle in the graphic editor:

1. Select the Triangle tool from the Tools button bar.
2. Press the left mouse button where the center of the base of the triangle is to be located.
3. Drag the mouse until the triangle’s base is the desired size, but do not release the mouse button.
4. Press the shift key and move the mouse to adjust the size of the other two sides. Release the mouse button when done.
Squares and Rectangles

Squares and rectangles may be drawn using the regular rectangle tool, the rounded rectangle tool, or the raised rectangle tool.

How to draw a rectangle in the graphic editor:

1. Select either the regular, rounded, or raised rectangle tool from the Tools window.
2. Press the left mouse button at the top left corner of the desired rectangle.
3. Drag the mouse to the lower right corner of the rectangle and release the mouse button.

How to draw a square in the graphic editor:

• Hold the shift key while drawing or editing a rectangle.

Circles and Ellipses

Circles and ellipses may be drawn using the ellipse tool.

How to draw an ellipse in the graphic editor:

1. Select the ellipse tool from the Tools window.
2. Press the left mouse button at one end of the desired ellipse.
3. Drag the mouse to the other end of the ellipse and release.

How to draw a circle in the graphic editor:

• Hold the shift key while drawing or editing an ellipse.
Chords and Pies

Chords and pies are drawn using the Chord tool and Pie tool.

How to draw a chord or pie in the graphic editor:

1. Select the chord tool or pie tool from the tools menu.
2. Press the left mouse button at one end of the desired chord or pie.
3. Drag the mouse to the other end of the chord or pie and release the left mouse button.

How to draw a circular chord or pie in the graphic editor:

- Hold the shift key while drawing a chord or pie.

How to adjust the size of the “slice” in the chord or pie after the graphic has been drawn:

1. Select a corner of the “slice” on the graphic.
2. Press the left mouse button at the corner of the “slice.”
3. Drag the mouse to the desired position of the “slice” and release the left mouse button.

Polygons

Polygons are drawn using the Polygon tool.

How to draw a polygon in the graphic editor:

1. Select the Polygon tool from the Tools window.
2. Click the left mouse button to begin the first point of the polygon.
3. Click the left mouse button at each successive point of the polygon.
4. Click the right mouse button or double-click the left mouse button to end the polygon.

Please note

The sides of a polygon may be drawn at 15 degree increments by holding down the shift key while moving the mouse to the next vertex.
Positioning Spot

A positioning spot controls the positioning of an entity on a location, resource, or path. It also controls the positioning of an entity or resource on a path. There are two types of positioning spots: entity spots and alignment spots.

Entity spots can be defined for a graphic in either the Graphic Editor or in the Locations module. Alignment spots can only be defined for a graphic in the Graphic Editor. In the Graphic Editor, the button showing the red circle with the white X represents the positioning spot. The default type is entity spot. To change the type, the user may double click on the spot to display the Spot Type dialog. This allows the user to define the type of positioning spot.

A graphic may have any number of entity spots. A graphic may also have any number of alignment spots. However, only the first alignment spot defined will be used. An entity or alignment spot is ignored if it is inapplicable for the model element it is used to represent. The following definitions explain uses of the entity and alignment spots for locations, entities, and resources.

Location Graphics  May only use entity spots. Whenever an entity arrives at the location, the entity graphic will be placed on the first entity spot defined for the location. The next arriving entity will use the entity spot defined second, and so forth. If entity spots are defined for a location graphic in the Locations module, they are used ahead of any entity spots defined in the Graphic Editor. If no entity spot is defined for the location graphic, no entity is shown on the location.

Entity Graphics  Use only alignment spots. When an alignment spot is defined for an entity graphic, the entity graphic will be positioned so the alignment spot of the entity graphic and the entity spot for the location or resource graphic are aligned. If the entity is traveling along a path, the entity graphic will move along the path with the alignment spot and the path segment or node aligned. If no alignment spot is placed on an entity graphic, the center of the entity graphic is used for alignment.

Resource Graphics  May use both entity spots and alignment spots. An entity spot on a resource graphic may be used to locate an entity a resource is carrying. An alignment spot can be placed on a resource graphic so that when the resource travels along a path, the resource graphic will move along the path with the alignment spot and the path segment or node aligned. If no alignment spot is placed on a resource graphic, the center of the graphic is used for alignment.

How to place a positioning spot on an icon:

1. Select the positioning spot tool from the button bar.
2. Click on the icon where the entity is to appear.

Location Graphics  May only use entity spots. Whenever an entity arrives at the location, the entity graphic will be placed on the first entity spot defined for the location. The next arriving entity will use the entity spot defined second, and so forth. If entity spots are defined for a location graphic in the Locations module, they are used ahead of any entity spots defined in the Graphic Editor. If no entity spot is defined for the location graphic, no entity is shown on the location.

Entity Graphics  Use only alignment spots. When an alignment spot is defined for an entity graphic, the entity graphic will be positioned so the alignment spot of the entity graphic and the entity spot for the location or resource graphic are aligned. If the entity is traveling along a path, the entity graphic will move along the path with the alignment spot and the path segment or node aligned. If no alignment spot is placed on an entity graphic, the center of the entity graphic is used for alignment.

Resource Graphics  May use both entity spots and alignment spots. An entity spot on a resource graphic may be used to locate an entity a resource is carrying. An alignment spot can be placed on a resource graphic so that when the resource travels along a path, the resource graphic will move along the path with the alignment spot and the path segment or node aligned. If no alignment spot is placed on a resource graphic, the center of the graphic is used for alignment.
**Status Lights**

A status light is a circle that changes color depending on the status of a location. A status light can be placed anywhere relative to a location to show the status or current state of the location. At run time, a window can be displayed showing what status each color represents.

![Status Light]

**How to place a status light on an icon:**

1. Select the Status Light tool from the button bar.
2. Click on the icon where the status light is to appear.

**Please note**

*Status lights for location graphics may also be defined in the Locations Editor.*

**Flip and Rotate**

Objects may be flipped about the horizontal axis and vertical axis or rotated by 90 degrees using the flip and rotation tools from the Tools button bar.

![Flip and Rotate](image)

**How to flip or rotate an object:**

1. Select the desired object(s).
2. Click on the Flip Horizontal, Flip Vertical, or Rotate buttons.

Using the flip and rotate buttons is the same as choosing flip and rotate options under the Graphics menu.

The figure below shows an object that has been flipped horizontally, vertically, and rotated through all phases.
Chapter 8: Graphic Editor

Cut, Copy, and Paste

To speed the development of complex graphics, you may cut, copy, and paste objects from one area of the workspace to another. Each of these buttons works exactly the same as the corresponding item from the Edit menu.

How to cut an object:

1. Select the desired object(s) using the Selector.
2. Click the Cut button. The object is removed from the Edit window but remains in the Graphic Editor’s internal clipboard.

How to copy an object:

1. Select the desired object(s) using the Selector.
2. Click the Copy button. The original object remains on the screen and a copy is placed on the Graphic Editor’s internal clipboard.

How to paste an object:

1. Click on the Paste button. The contents of the internal clipboard are pasted next to the last object cut or copied.
2. Move the new object to the desired location using the Selector.

Step Back and Step Front

You can move an object behind or in front of another object. The Step Back option allows you to move a selected object behind another object. The Step Front option allows you to move a selected object in front of another object.

For example, suppose you have five graphic objects displayed and you want to move the top object to the third object. You can use the Step Back or Step Front option.

How to move an object behind or in front of another object:

1. Select the object to move using the Selector.
2. Click on the Step Back or Step Front tool from the button bar.
3. Continue to press the Step Back or Step Front button until the selected object is behind the desired object.

Please note

If you would like to move an object behind or in front of all objects, use the Move to Back or Move to Front option in the Graphics Menu. Alternatively, use the Page Up or Page Down keys.
Line and Fill Color

An object’s line and fill colors can be chosen using the Line tool and the Fill tool. You may use one of the predefined colors or create your own custom color. Each tool’s color changes according to the color chosen.

How to define the line color or fill color:

1. Select the object(s) to change using the Selector.
2. Click on the Line or Fill tool from the button bar.
3. Choose the desired color. The tool will change to the color specified.

Please note

*The line color and fill color can also be defined in the Graphic Editor Options menu.*

Editing a Library Graphic

Various editing functions allow you to alter the objects that comprise a library graphic. These functions may be applied to the entire graphic or to one of the objects from which the graphic is constructed. The following is a description of how to edit a graphic (All mouse actions are performed using the left button unless stated otherwise).

<table>
<thead>
<tr>
<th>TO...</th>
<th>DO THIS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an object.</td>
<td>Choose the Selector tool and click on the object.</td>
</tr>
<tr>
<td>Select multiple</td>
<td>Drag in an empty region until a bounding rectangle encompasses the objects.</td>
</tr>
<tr>
<td>objects.</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Shift+Click on each of the objects you want selected (Shift + Click again on a selected object deselects it).</td>
</tr>
<tr>
<td>Move one or more</td>
<td>Drag the selected object(s).</td>
</tr>
<tr>
<td>selected objects.</td>
<td>Press the Delete key.</td>
</tr>
<tr>
<td>Delete selected</td>
<td>or</td>
</tr>
<tr>
<td>objects.</td>
<td>Select Cut from the Edit menu (This method puts the object on the clipboard for subsequent pasting).</td>
</tr>
<tr>
<td>Copy selected</td>
<td>Press the Copy button to copy the selected objects to the clipboard. Then press the Paste button to place a copy of the selected objects into the Edit window.</td>
</tr>
<tr>
<td>objects.</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Choose Copy from the Edit menu. Then choose Paste from the Edit menu.</td>
</tr>
<tr>
<td>Edit text.</td>
<td>Double click on the text to bring up the text editor dialog box.</td>
</tr>
<tr>
<td>Change the shape of</td>
<td>Drag one of the sizing points of the selected object.</td>
</tr>
<tr>
<td>a selected object.</td>
<td></td>
</tr>
<tr>
<td>Add a vertex to a</td>
<td>Right click on the line or polygon where the vertex is to be added.</td>
</tr>
<tr>
<td>selected line or</td>
<td></td>
</tr>
<tr>
<td>polygon.</td>
<td></td>
</tr>
<tr>
<td>Delete a vertex of</td>
<td>Right click on the vertex.</td>
</tr>
<tr>
<td>a selected line or</td>
<td></td>
</tr>
<tr>
<td>polygon.</td>
<td></td>
</tr>
<tr>
<td>TO...</td>
<td>DO THIS</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change the fill pattern for a selected object.</td>
<td>Choose Fill Patterns from the Graphics menu and select the desired pattern.</td>
</tr>
<tr>
<td>Change the color of a selected object.</td>
<td>Click on the Line or Fill Color button with one or more objects selected.</td>
</tr>
<tr>
<td>Change the line style for a selected object.</td>
<td>Choose Line Styles from the Graphics menu. Then choose the desired line style.</td>
</tr>
<tr>
<td>Flip or rotate a selected object.</td>
<td>Click on the flip or rotate button with one or more objects selected.</td>
</tr>
<tr>
<td>Move a selected object in front of another object.</td>
<td>Click on the Step Front button until the selected object is in front of the other objects.</td>
</tr>
<tr>
<td>Move the selected object in front of all other objects.</td>
<td>Choose Move To Front from the Graphic menu.</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Press the Page Up key.</td>
</tr>
<tr>
<td>Move a selected object behind another object.</td>
<td>Click on the Step Back button until the selected object is behind the other objects.</td>
</tr>
<tr>
<td>Move a selected object behind all other objects.</td>
<td>Choose Move To Back from the Graphic menu.</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Press the Page Down key.</td>
</tr>
<tr>
<td>Nudge a selected object one pixel left.</td>
<td>Press the Left arrow key.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TO...</th>
<th>DO THIS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nudge a selected object one pixel right.</td>
<td>Press the Right arrow key.</td>
</tr>
<tr>
<td>Nudge a selected object one pixel up.</td>
<td>Press the Up arrow key.</td>
</tr>
<tr>
<td>Nudge a selected object one pixel down.</td>
<td>Press the Down arrow key.</td>
</tr>
<tr>
<td>Size a background graphic proportionally.</td>
<td>Select the graphic, group it, then size using the handles.</td>
</tr>
<tr>
<td>Create a perfect circle or square.</td>
<td>Select a graphic and, while holding down the shift key, size the graphic.</td>
</tr>
</tbody>
</table>
Options

The Options dialog contains default folders, selections for displaying the long build menu, defaults for record deletion, and the time between auto-saves.

**Default Folders**  These fields contain the default folders for your model.

**Default File: Graphics Library**  This field allows you to specify a default graphic library file for every new model you create.

**Auto-Save time interval**  Allows you to select how often ProModel will automatically save your model.

**Confirm record deletion**  Use this option to have ProModel display a dialog box confirming that the user wants to delete a record from an edit table.

**Show shortcut panel at start-up**  Check this option to display the shortcut panel at start-up.

**Long build menu**  Allows the user to view the long build menu.

**Recalculate path lengths when adjusted**  Recalculates the time or distance of a path network or conveyor as it is graphically lengthened or shortened.

**Directories**

The Directories section of the Settings dialog allows you to specify which drives and folders to use for storing models, graphic libraries, and output results.

**How to change the default folders:**

1. Select Options from the Tools menu.
2. Click on the Browse button next to the Folder name you would like to change.
3. Specify the desired folders for models, graphics libraries, output results, and auto-save.
4. Click OK.

**Long Build Menu**

The Long Build Menu option reorganizes the Build menu. The long build menu takes the first section of the More Elements submenu and places it in the Build menu. This includes attributes, variables, arrays, macros, and subroutines. Using the long build menu is especially helpful when using these elements frequently.

**How to display the long menu:**

1. Choose Options from the Tools menu.
2. Check the Long build menu option.

Please note

To display the short menu, follow the same procedure above and uncheck the Long build menu option.

AutoSaving Files

ProModel automatically saves the open model every few minutes, which is useful in the event of unforeseen crashes and power outages. ProModel uses a model file called “AUTOSAVE.MOD” for all autosaves and only modifies the original file when Save is chosen from the File menu.

How to specify the amount of time between AutoSaves:

1. From the Tools menu, select Options.
2. In the Time between autosaves field, enter the time.
3. Click OK.

Please note

Models are always autosaved at the start of a simulation run. To deactivate the auto-save feature, set the time between auto-saves to 0.

How to specify the autosave directory:

1. From the Tools menu, select Options.
**Customize**

You can add direct links to applications and files right on your ProModel toolbar. Create a link to open a spreadsheet, a text document, or your favorite calculator—it’s your menu.

To create or modify your Custom Tools menu, select Customize from the Tools menu.

This will pull up the Custom Tools dialog window. The Custom Tools dialog window allows you to add, delete, edit, or rearrange the menu items that appear on the Tools drop down menu in ProModel.

Three tools come already added to the Custom Tools menu by default: QuickBar, Models to Go, and Model Package Association. These tools can be added to or deleted from the Tools menu.

**Add a new menu item:**

1. Click on the New button.

2. In the Name text box, type the name of the item you will be referencing, as you want it to appear on the drop menu.
3. Click the Browse button.
4. Use the browse window to find the file or application that you wish to have launched, then double click on it or click Open.
5. The file or application name and path will appear in the Source window.

**Delete a menu item**

1. In the Menu Items list, click on the name of the item you would like to delete.
2. Click the delete button.

**Edit a menu item**

1. In the menu Items list, click on the name of the item you would like to edit. Its properties will appear in the Edit Item panel, on the right.
2. Change the name that appears in the Name text box.
3. To redirect the item to another file or application, change the path and file name in the Source text box by either typing in a new source, or using the Browse window.

**Rearrange items on the menu**

1. You can rearrange the order in which menu items appear on the Tools menu, or add separators to divide them into logical groups. To move an item up in the list, select the item you wish to move.
2. Click on the Up or Down button to move the menu item’s position in the menu list.
Add a Separator

1. Clicking on the Separator button adds a Separator line to the drop down list. In the Menu Items list, this line is represented as --<Separator>--, in the Tools menu it appears as a single solid line.

2. The Separator line is inserted into the menu list above the highlighted Menu Item. Its placement can then be adjusted similar to other menu items, using the Up and Down buttons.

Please note

Custom Tool settings are saved in your Windows Registry. They are not a part of your model file or model package. If you have multiple installations of ProModel Corporation products (such as a LAN version, MedModel, or ServiceModel) your Customized Tool menu will be available to your other ProModel Corporation products as well.

Power Tools

Packaged with ProModel are several powerful tools that can help you better use and understand your ProModel software and the statistical data it creates. These tools include:

- ProClare
- ProSetter
- Shift Library
- ProActiveX

Any of these tools can be added to the custom Tools menu using the steps outlined in the section “Add a new menu item:” on page 327.
ProClare

ProClare is a quick way to add new variables, attributes, macros and arrays into your ProModel Corporation product without having to leave where you are in the model building process. This is extremely useful if, for example, you are into heavy logic and need to add a new variable. With this tool you can add the new variable without losing your place.

Tools

Startup  Loads the default ProModel Corporation product for model building and editing. You can choose to specify a model to be loaded.

Please note

When using the ProClare tools, if no ProModel Corporation products is currently open, ProClare will launch the default ProModel Corporation product for you.

Attributes  This allows for the addition of new attributes. The attribute name, type, and value can also be configured.

Arrays  This allows the user to add arrays, with their corresponding name, dimensions and type.

Options

Select the Options button to customize ProClare in these additional ways:

Always on Top  This option allows ProClare to always be on top of all other windows, which is useful if you plan on adding a lot of new items.

Auto Roll-up  When enabled, ProClare is reduced to just the title bar when the mouse cursor is outside the window. When the cursor is inside the window, the window is restored to normal size.

Variables  This will allow the addition of new variables into the model. The name, initial value, type, and RTI stats can be set here.
ProSetter

This tool is useful only if you have more than one ProModel Corporation product installed. This includes having more than one installation of ProModel, or having every ProModel Corporation product installed.

When you start this tool, it will scan all your hard-drives for ProModel Corporation products (ServiceModel, ProModel, MedModel, or multiple installations of any one of these). To change the default product, click which product you want to be your default. If you have multiple copies of a product, select which location. Having made your selection, you must then click the “Make Default” button to process the change. When you make a product the default product, it will modify the registry, indicating to Windows that this product is now your default product. It will also reset your icon cache to reflect the new file association.

Locations

When you click on a product, it will populate the location box with all of the locations to which that product is installed. The default product location will have a “(Default)” caption next to it to indicate that it is the default.

Products

This tool supports ServiceModel, ProModel and MedModel. It supports multiple installations of these products as well.

Each product has 2 labels: Installed and Default. Both labels say either Yes or No next to them to reflect whether it is installed, and indicate if it is the default product.
Shift Library

For your convenience, predefined shift files are now included with your ProModel Corporation product. When installed they will appear in a Shift subfolder under the Shift Editor installation folder (i.e. C:\Program Files\ProModel Corporation\Tools\Shift Editor\Shifts\shift_file.sft.)

These files have common nomenclature to simplify the process of identification and implementation of the proper shifts. Each shift file is named in the following fashion:

####x_####x_#(_###).sft. The first four numbers tell you what time the shift starts along with a letter to designate am or pm. The second four numbers specify what time the shift ends along with a letter designating am or pm. The third number specifies how many days of the week for which there is a shift definition. The numeral 1 means the shift occurs one day out of seven; seven means the shift is defined for every day of the week; a Monday through Friday schedule would be represented with the number five. The last value in brackets is only used when breaks are defined for the shift. The first of these three numbers indicates the number of breaks in a day, and the next two numbers indicate the cumulative minutes of those breaks.

Example

7a_330p_5_360.sft

This file name represents a shift that starts at 7:00 a.m. and ends at 3:30 p.m., five days a week. There are three breaks defined, one for 15 minutes, one for 30 minutes, and another for 15 minutes. These breaks add up to a cumulative 60 minutes of break time, represented by 360.

ProActiveX

Overview

The ProActiveX spreadsheet is designed to help you understand how to use ProModel’s ActiveX components. The worksheets and macros give clear and functional examples of how to access all currently enabled data elements.

The ProActiveX spreadsheet may be used “as is” or modified to suit your specific needs. With ProActiveX and a fundamental knowledge of Visual Basic for Applications, you can create customized user interfaces for ProModel—or let our consulting division do it for you!

ProActiveX.xls has nineteen data worksheets corresponding to the module with the same name in ProModel. Additionally, there is one hidden sheet with data for drop-down lists used on the other sheets.

Please note

ProActiveX is only compatible with Excel 2000 or newer.

Worksheets

Drop-down lists, check boxes and text boxes

Many of the worksheets in ProActiveX have drop-down lists which make it easier to fill in the required data. In all cases, the value you select will be inserted into the selected cell or range of cells. However, the assigned macros do not prevent you from selecting a different column than the one with the drop-down used.

Using a combo box with a pre-defined list is one way to ensure consistency in the data. In most cases, the numeric value of the list selection is
temporarily recorded on the hidden sheet (named Hidden Sheet). On the Simulation Options sheet, instead of filling in a cell or range, the value shows in the drop-down box itself and the numeric value is hidden in the cell behind it.

The Simulation Options sheet also contains several check boxes and a text box. The values for the check boxes are hidden in the cells behind them. The method used for hiding the values is simply to make the text color the same as the background color.

**Not Enabled and Partially Enabled**

A few of the worksheets have data columns defined for methods which have not yet been implemented in the ProModel Data Object. These columns have been included to acknowledge that these elements were not forgotten when ProActiveX was created—these data elements will be enabled in future releases of ProModel.

**Shift Editor Button**

The Shift Assignments worksheet has a button to the far right labeled Shift Editor. Clicking on this button will show the Shift Editor, just like when you invoke the menu call from your default ProModel Corporation product.

**Browse Button**

The General Info worksheet has a Browse... button that uses the Microsoft Common Dialog to display a file selection window.

**Comments**

Several worksheets have comments in the cells of the title rows. These comments are included to give you important information about the data contained in that column—like limitations or formatting requirements.

**Panes and Sections**

In each worksheet where the data columns go beyond the right-hand border of a single screen, separate panes have been created and ‘frozen’ to allow you to scroll through the columns without moving the column that identifies the record. The title rows have also been frozen, so that the user can scroll down the sheet without losing sight of the titles.

In each worksheet, title labels spanning more than one column indicate that all the columns beneath that title pertain to that type of information. For example, on the Resources worksheet, there are several columns for downtime data which have duplicate titles, but different section labels. In some cases, the labels are used merely to make the titles easier to read.

**Controls Sheet**

The first sheet of the ProActiveX file is the Controls Sheet. The options available on this sheet are described below.

**Get (All)**

The Get button copies ActiveX enabled data elements from the currently open model to the ProActiveX spreadsheet.

ProModel must be running and a model loaded. When all of the data has been copied to the spreadsheet, a message box will appear saying, “Process Complete.”

**Build Model**

The Build Model button copies all ActiveX enabled data elements from the ProActiveX spreadsheet to the currently open model.

ProModel must be running and a model loaded. When all of the data has been copied to the model, a message box will appear saying, “Process Complete.”
Save Model
The **Save Model** button saves all updates to the loaded model. ProModel must already be open with a model loaded.

Run Simulation
The **Run Simulation** button starts the simulation for the loaded model. To view the simulation, you will have to manually select ProModel from your Windows Task Bar, to bring it forward.

Open ProModel
The **Open ProModel** button starts ProModel, but does not load a model.

Load Model
The **Load Model** button gives the user an opportunity to specify a model and then open it in ProModel. If ProModel is not already running, the **Load Model** button will start ProModel and then load the selected model. This button gives you an example of a custom dialog box.

Macros
All of the processing logic for ProActiveX is contained in Excel macros. In most cases each macro is in a separate module. The controlling modules are named **Get_ALL_Model_Data** and **Pop_ALL_Model_Data**. There are also macros in some of the Excel Sheet Objects. For example, Sheet04 (Resources) has subroutines that dynamically fill in the Path Network drop-down list (using the information on the Path Networks sheet) every time the Resources sheet is activated. This is one method for keeping the drop-down list in sync whenever you update the data.

When the user clicks on the **Build All** button on the Controls Sheet, the **create_model** subroutine is started (found in the POP_ALL_Model_Data module). This subroutine then calls subroutines in other modules to process each type of data. The order in which the subroutines are called is important, since many of the modules in ProModel depend on information in other modules. For example, the Locations module must be built before the Path Networks module, because the Path Networks module references Locations.

All of the subroutines in ProActiveX use the constants established in the **PM_CONSTANTS** module. You will also find this module recorded in the file called **PM_CONSTANTS.bas**. The main purpose of the constants is to provide a method for accessing the parameters to the ProModel properties and methods data, without having to remember the numbers associated with each table and field.

There are some other useful subroutines that are used throughout the program to do things like showing the right error message or replacing Excel style carriage returns with ProModel style carriage returns.

In many cases when you look at the tables in ProModel, what you actually see on the screen is a main table and one or more sub tables.

The subroutines in ProActiveX must process the data for all tables simultaneously by using **For...Next** or **Do While...** loops.

In many of the data tables, the first field is a **Name** or **ID** field that identifies each record in the table and does not allow duplicates. In the subroutines that populate these types of tables, the logic is designed to search for an existing ProModel record with the same name or ID. If a record is found, all of its fields will be updated. If no record is found, a new one will be appended. In tables that have no identifying field, records are always appended.
**ProModel Player**

ProModel Player is a browser plug-in for Microsoft’s Internet Explorer that allows users to view the animation and statistics of a model. ProModel Player is automatically installed on your computer as you install ProModel.

**Viewing Simulation Models**

To view, or “play,” a simulation model in Windows Internet Explorer, you may:

- Select the model file in Windows Explorer, then right-click on the package and select Play from the menu that appears. Three packages, Semiconductor.pkg, DaySurgery.pkg, and TollPlaza.pkg, are installed on your computer when you install ProModel. The are found in the following directory: C:\Program Files\ProModel Corporation\Tools\PMPlayer.


When you open a package on your computer, or click on a package link on the Internet, an Internet Explorer window will open and you will see the following image in your browser window while the package is loaded:

![After the model has been loaded, the layout window of the model appears in the main browser window.](image)

**Using ProModel Player**

Simulations in ProModel Player are controlled through the Toolbar.

- : Runs the animation.
- : Pauses the animation.
- : Stops the animation.
- : Toggles the Animation on/off. Turning the animation off increases the speed of the simulation.
Allows you to zoom in or out on the layout.

Toggles the Auto Zoom on/off. When selected, this option will zoom the animation to fit within the browser window.

Opens an options window, which gives you several options for controlling your animation.

Opens this Help file.

To run the model animation, click ProModel Player’s play button. If you have selected to view the output, as soon as the simulation is complete, the output statistics and graphs will open in the browser window. Only predefined output graphs will come up, the user cannot define new graphs through ProModel Player.

To close the Output window and return to the animation window, click on the red "x" on the toolbar.

Please Note

A user who has installed this plug-in, but has not installed any other ProModel Corporation products will not have access to any of ProModel’s model building capability, they may only view the simulation animation and the statistical output results. Users who have a valid ProModel Corporation registration key will have access to ProModel Player Gold, which is described in the next section.

ProModel Player Gold

If you have a valid registration key on your computer for a ProModel Corporation product, ProModel Player will automatically launch ProModel Player Gold.

The Gold version of ProModel Player is functionally similar to the regular version of ProModel Player, but it contains the added functionality of scenarios and macros.

ProModel Player Gold allows you to view values for scenarios that are packaged with any .pkg file.

The scenario viewing area is accessible through the green bar underneath the ProModel Player toolbar.

If there are any bar graphs defined, as in the Semicon report, the user can get a detailed pie chart of the individual bar by left-clicking on the bar of the desired statistic.
Clicking on the arrow on the far left of the green bar will open the scenario and macro window.

From this window you can select the scenarios you wish to run, and view the available macros.
Chapter 9: Running the Model

Simulation Menu

All of the run-time controls are accessed through the Simulation menu located on the menu bar. This menu contains options for running a model, specifying multiple replication statistics, defining scenario data, and other extended run-time options.

<table>
<thead>
<tr>
<th>Simulation</th>
<th>Output</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>F10</td>
<td></td>
</tr>
<tr>
<td>Save &amp; Run</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scenarios</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimRunner</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Each of the selections available on the Simulation menu is explained below.

**Run**  Choose Run to begin simulating the current model using the options previously selected in the Simulation Options dialog box. Choosing Run does not save the models to the current model file. However, the model data will be saved to the file AUTOSAVE.MOD. To run several scenarios, you must select Run Scenarios from the Scenarios dialog mentioned below. Otherwise, it will run the RTI default values.

**Save & Run**  Saves the current model, then runs it.

**Options**  Select Options to bring up the Simulation Options dialog box used to specify important run-time information such as run length, warm-up period, number of replications, and multiple replication statistics. (See “Simulation Options” on page 338.)

**Model Parameters**  Choose Model Parameters to open the Model Parameters dialog box. The dialog box allows you to modify the current settings for the RTI (Run-Time Interface) parameters defined in the Macros module. (See “Run-Time Interface” on page 234.)

**Scenarios**  Select Scenarios to open the Scenarios dialog box. The dialog box allows you to define different scenarios using defined RTI (Run-Time Interface) parameters. (See “Scenarios” on page 343.)

**SimRunner**  SimRunner takes your existing ProModel simulation models, evaluates them for you, then performs tests to find better ways to achieve the results you desire. (See “SimRunner” on page 360.)
Simulation Options

The Simulations Options dialog provides you with a number of options to control the simulation, such as run length, warm-up time, clock precision, and the output. You also control the type of statistics reporting you want from the simulation, including period length and number of replications.

In addition to reporting standard statistics based on one or more replications of a simulation, ProModel allows you to average statistics across intervals of a single replication (batch mean) for analyzing steady-state systems or take the average of the average statistics for specific time periods over multiple replications (periodic) for non-steady state systems. You may choose from three statistical reporting options.

How to open the simulation options dialog:

1. Select the Simulation option from the menu bar.
2. Select Options to open the Simulation Options dialog.

General Options & Settings

Output Path  Contains the path of the output file (the name of the file is automatically created using the name of the model). ProModel records all statistical output in this file for your analysis.

If this field is left blank, the default path is used, which points to the Output directory in the ProModel directory.

When you change the default path, be sure the path you enter actually exists, or an error will occur at run time.

Define Run Length by  ProModel allows you to define a run length for your model based on the duration you will test.

• Time Only  The total run length in hours.

• Weekly Time  The total run length by week, day, and time.

• Calendar Date  The total run length by a specific calendar date and time.
• **Warm-up Period**  The amount of time to run the simulation before collecting statistics. Usually this is the amount of time it takes for the model to reach steady state. The warm-up period uses the same units as the run length.

**Clock Precision**  Select the clock precision value from the drop down box. Then click the radio button for the clock units you want to display at run time.

---

**Please note**

The maximum run length depends on the clock precision and time unit selected. The following table shows the maximum run hours for each precision setting.

<table>
<thead>
<tr>
<th>TIME UNIT</th>
<th>CLOCK PRECISION</th>
<th>Clock Precision</th>
<th>Maximum Run</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seconds (sec)</td>
<td>.01</td>
<td>.001</td>
<td>.0001</td>
</tr>
<tr>
<td>11,930 hrs</td>
<td>1,193 hrs</td>
<td>119 hrs</td>
<td>11 hrs</td>
</tr>
<tr>
<td>Minutes (min)</td>
<td>.001</td>
<td>71,582 hrs</td>
<td>7,158 hrs</td>
</tr>
<tr>
<td>Hours (hr)</td>
<td>.001</td>
<td>4,294,967 hrs</td>
<td>429,496 hrs</td>
</tr>
<tr>
<td>Days (day)</td>
<td>.001</td>
<td>1,030,792,128 hrs</td>
<td>103,079,208 hrs</td>
</tr>
</tbody>
</table>

**Disable: Animation**  Use this option to improve run-time speed by shutting down the animation. If you choose to disable animation, you cannot choose the Generate Animation Script option.

**Disable Array Exports**  This option disables the exporting of data to external arrays. This is helpful for skipping the array exporting at the end of simulation, which may save time if the data being exported is large.

**Disable Cost**  When you select this option, ProModel disables all cost information collection for in the model.

**Disable: Time Series**  Use this option to improve run-time speed by foregoing time series statistics. This also saves disk space used to store the collected statistics.

**At Start: Pause**  To pause the simulation at the start of the run, use this option. The simulation will pause until you select Resume from the Simulation menu in the Simulation module.

**At Start: Display Notes**  Use this option to display the notes from the General Information dialog at the beginning of the simulation.

**General: Adjust for Daylight Saving**  This option is only available when you have defined Run Length by Calendar Date. When checked, the
simulation clock will account for the hour shift of daylight saving time in April and October.

**General: Generate Animation Script** When checked, the simulation will generate a 3D animation script for use with ProModel Corporation’s 3D Animator application. The animation script records the graphical events of the simulation for later 3D rendering in 3D Animator.

**General: Common Random Numbers** This feature is a variance reduction technique used primarily when running multiple scenarios, each with multiple replications. It is intended to help reduce the number of replications required to determine the statistical significance of differences between scenario results. When enabled, common random numbers will ensure that the sequence of starting seed values for each stream in a set of replications for one scenario is identical to the starting seed values for corresponding replications in every other scenario.

For example, if you have this option disabled, the match between starting seed values for each stream in corresponding replications for each scenario will not be guaranteed. The net effect of this is that you may have to run more replications to get the same confidence interval that you are able to obtain by running with common random numbers.

When common random numbers are enabled, you can theoretically establish the statistical significance of differences in output results between multiple scenarios with fewer replications than by not enabling common random numbers. Specifically, it reduces the amount of variation in differences between outputs of corresponding replications by ensuring that these differences are due to true differences in performance and not to differences due to randomness of the streams.

For more information on random number streams, see “Using Random Number Streams” on page 258.

**General: Skip Resource DTs if Off-shift** When checked, the simulation will ignore resource downtimes if the resource is off-shift.

### Output Reporting Options

<table>
<thead>
<tr>
<th>Output Reporting</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Output Reporting Options" /></td>
</tr>
</tbody>
</table>

**Standard** When you select Standard output reporting, ProModel collects output statistics for one or more replications. No interval length can be specified when using this option. From the output program, statistics can be viewed for each replication; although, by default they are displayed as an average over all the replications.

**Batch Mean** The method of batch means, or interval batching, is a way to collect independent samples when simulating steady-state systems as an alternative to running multiple replications. The advantage over running multiple replications is that the warm-up period runs only once. When you select Batch Mean output reporting, the output statistics are collected for each time interval indicated in the Interval Length field. The number of intervals is determined by dividing the run length by the interval length. The interval length may be an expression but will only be evaluated once at model translation, so it is always a fixed interval. The Number of Replications edit field is not used when this option is selected since it replaces the need for running multiple replications.

**Example**
The Content History graph below shows that the contents of Lathe1 varied throughout the simulation. The interval length was set to 0.5 hours and the simulation ran a little over 3 intervals (1 1/2 hours). The average or mean of the intervals were 2.7, 3.09, and 3.15, so the average of the interval averages is the batch mean or 2.98.

Periodic

Useful primarily in terminating or non-steady state simulations where you are interested in the system behavior during different periods (e.g., peak or lull periods) of activity.

When you select Periodic output reporting, the output statistics are collected by period where the length of a period is defined in the interval length field. The interval length may be an expression but will only be evaluated once at model translation, so it is always a fixed interval. To define unequal intervals, see “Customized Reporting” on page 342. The time unit is defined in the General Information dialog. The interval length need only be specified when using Batch Mean or Periodic reporting.

You may gather statistics for a periodic report over multiple replications. From the output program, you can view each replication averaged over the periods, each period averaged over the replications, or the pooled average (the average for each period averaged over all of the replications).

Example

The content history table below shows how the contents of Lathe1 varied throughout the simulation and from one replication to the other. The interval length was set to 0.5 hours and the simulation ran a little over 3 periods (1 1/2 hours) with two replications. The results are shown below.

<table>
<thead>
<tr>
<th>Periodic Output</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replication 1</td>
<td>2.70</td>
<td>3.09</td>
<td>3.15</td>
</tr>
<tr>
<td>Avg.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replication 2</td>
<td>2.20</td>
<td>3.13</td>
<td>3.01</td>
</tr>
<tr>
<td>Avg.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pooled Average</td>
<td>2.45</td>
<td>3.11</td>
<td>3.08</td>
</tr>
</tbody>
</table>

Interval Length

Enter the interval length as the number of time units for each interval or period. The interval length may be an expression but will only be evaluated once at model translation, so it is always a fixed interval. To define unequal intervals, see “Customized Reporting” on page 342. The time unit is defined in the General Information dialog. The interval length need only be specified when using Batch Mean or Periodic reporting.

Number of Replications

Enter the number of replications you want the simulation to run in this field. Number of replications only needs to be specified when using Standard or Periodic reporting.

Running a Specific Replication

ProModel allows you to run a specific replication in order to produce time series graphs in the Output Program. To run a specific replication, enter the “@” symbol in the “Number of Replications” box followed by the replication number. For example, “@5” will run only the fifth replication.
Customized Reporting

For customized reporting, you may want to take advantage of the following statements: REPORT, RESET STATS, and WARMUP. See “Report” on page 532, “Reset Stats” on page 535, and “Warmup” on page 569 for syntax and examples.

**REPORT** A general statement called from any logic. When the statement is called, a full set of statistics is saved to be viewed as a snapshot report in the output processor. Optionally, the statement allows you to reset the statistics after the report is saved, giving you a batch or period for any time interval you define.

**RESET STATS** A general statement called from any logic and generally used in connection with the REPORT statement. When this statement is used, all statistics are set to zero. The output database is not erased (see WARMUP).

**WARMUP** A general statement called from any logic. When this statement is used, all statistics are set to zero and the output database is erased. Use this statement in conjunction with the WAIT UNTIL statement to wait until specific parameters in the system being modeled are at a steady state or other conditions are appropriate to declare the warm-up period over.

Model Parameters & Scenarios

**Model Parameters**

The Model Parameters dialog box allows you to modify the current settings for the Run-Time Interface (RTI) parameters defined in the macros module. This provides a convenient interface for making model changes without using the Build modules. To define and run multiple scenarios using RTI parameters, select the Scenarios option from the Simulation menu (see discussion on Scenarios later in this section). Model parameter settings are saved with the model for future use.

![Model Parameters Dialog Box](image)

**Parameter** The name of the macro defined in the model as the RTI (Run-Time Interface) parameter. The parameter name does not need to be the same name as the macro.

**Current Setting** The current setting of the parameter.

**Change** Allows you to change the current setting of the parameter.

**Reset All** Resets all parameters to the default RTI setting defined in the Macros module.

**Run** Runs the model with the defined current model parameter settings.
How to define an RTI parameter:

1. Choose **More Elements** from the **Build** menu.
2. Choose **Macros...**
3. Type the macro name, choose the RTI button, and select Define.
4. Define the Parameter Name.
5. Enter the Prompt (optional).
6. Select the parameter type, Unrestricted Text or Numeric Range.
7. If defining a Numeric Range, enter the lower and upper boundary for the range.
8. Click **OK**.
9. Use the macro ID in the model (e.g., operation time, resource usage time, etc.).

Please note

For more information on RTI, see “Run-Time Interface” on page 234.

Scenarios

ProModel gives you the option of defining several scenarios for a model using RTI parameters specified for the model. A scenario is a set of runtime parameters with settings defined by the user. Using scenarios allows you to alter various model parameters to run a series of “what-if” scenarios without changing the model directly.

Scenarios can also be helpful for allowing other users of your model, who may not have experience using model logic, to make changes to the model through RTI parameters.

Scenarios are saved with the model for future use.

Scenarios are saved with the model for future use.

**Add**  Opens the Scenario Parameters dialog box to add a scenario.

**Edit**  Opens the Scenario Parameters dialog box to edit an existing scenario.

**Duplicate**  Duplicates the selected scenario and opens the Scenario Parameters dialog box, allowing you to give the newly created scenario a name and edit its data.

**Delete**  Deletes the selected scenario.

**Disable/Enable**  Disables or enables the selected scenario.

**Run Scenarios**  Runs the model with the defined scenarios. When running several scenarios, clicking on the Abort button during translation will terminate all scenarios instead of just the current scenario.

**Scenario Parameters Dialog**

The Scenario Parameters dialog box is displayed when choosing Add, Edit, or Duplicate from the
Scenarios dialog box. This allows you to control the specifics of a scenario.

<table>
<thead>
<tr>
<th>Scenario Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario Name: Test Case 1</td>
</tr>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>CellOps</td>
</tr>
<tr>
<td>Cost per CellOperator</td>
</tr>
<tr>
<td>Cost per Machine</td>
</tr>
</tbody>
</table>

**Scenario Name**  The name of the scenario. This name is chosen by the user and may contain any alphanumeric characters.

**Parameter**  The name of the parameter as defined in the RTI (Run-Time Interface) definition dialog box invoked from the Macro editor.

**Current Setting**  The current setting of the parameter.

**Change**  Allows you to change the current setting of the parameter.

**Reset All**  Resets all parameters to their default settings.

**Please note**

*Only macros defined as RTI parameters will be displayed as parameters for the scenario. (See “Macros” on page 233.)*

**How to define a scenario:**

1. Choose **Scenarios...** from the **Simulation** menu.
2. Choose the **Add** button.
3. Define the scenario name by typing text in the Scenario Name box.
4. Double click on the Parameter to bring up the parameter dialog box or select the Parameter and click the **Change** button.
5. Type the text in the box in the Parameter dialog box.
6. Select **OK** in the Parameter dialog box.
7. Repeat for every parameter desired.
8. Select **OK** in the Scenario Parameters dialog box.
Running the Simulation

Choosing Run begins the simulation of the current model. The model is automatically saved in a file called autosave.mod. Therefore, if the simulation is terminated abnormally, ProModel will ask you if you would like to load the latest autosave.mod file when you re-open ProModel. If you choose Save & Run, the model will be saved in the AUTOSAVE.MOD file as well as the <model name>.mod file.

Once you choose the Run option, a translation status window appears, showing which data is currently being translated. This gives you the option to abort the simulation run at any time. As shown below, the path networks are being mapped.

![Translation Status: Model Parameters]

- **Abort**  Allows you to cancel model translation at any time during translation.
- **Continue**  Allows you to continue model translation when a warning message is displayed.
- **Detailed Status**  Allows you to view more specific information about the data in translation.

Run-Time Menus & Controls

Once a simulation begins, a new menu bar appears at the top of the screen with selections for controlling and interacting with the simulation. As shown below, these menu items appear above the animation speed control bar and simulation clock.

![Run-Time Menus & Controls]

Each of the menu selections and the tools for controlling the animation are described in the remainder of this chapter.

Run-Time File Menu

The Run-Time File menu contains only one selection, View Text.

![Run-Time File Menu]

**View Text**  Choose this option to bring up a window with a text listing of the current model. This feature is extremely useful for debugging and verifying models.
Please note

You may switch back and forth between a full size View Text window and the animation screen by choosing the desired window from the Window menu option.

Run-Time Simulation Menu

The Run-Time Simulation menu has two options: End Simulation and Pause/Resume Simulation.

**End Simulation** Choose this option to end the simulation. You will then be prompted to collect statistics or return to the model editor without collecting statistics. If running multiple scenarios, End Simulation will terminate all scenarios.

**Pause/Resume Simulation** Choose Pause Simulation to pause the simulation for an indefinite amount of time. With the simulation paused, you may begin a trace, zoom in or out, set up the next pause, examine different locations in the model, or interact with the model in a number of other ways. Choose Resume Simulation when the simulation is paused to continue running the simulation.

Run-Time Options Menu

The run-time Options menu has several selections that allow you to interact with the simulation while the model is running. These options are described in the following pages.

<table>
<thead>
<tr>
<th>Options</th>
<th>Information</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animation Off/On</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Views</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trace Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debug...</td>
<td>User Pause...</td>
<td>User Pause by Date/Time</td>
</tr>
</tbody>
</table>

**Animation Off/On** Turns the animation on or off. Off greatly speeds up the simulation. Animation speed may also be set with the ANIMATE statement. (See “Animate” on page 432 for information).

**Zoom** Zooms in or out on the animation.

**Views** Allows you to select a view, which you have defined while building the model. This option is only available if you have previously defined a view.

**Trace Options** Lists events as they happen during a simulation. This listing may be Step by Step, Continuous, or Filtered.

**Debug** Brings up the Debugger Options Dialog box for debugging the model.

**User Pause** Allows the user to enter a simulation clock time for the simulation to pause.

**User Pause by Date/Time** Allows the user to enter a calendar date and simulation clock time for the simulation to pause. This option is only available if you chose "Calendar Date" as the Run Length in the Simulation Options dialog.
Debug Option

Debugging ProModel Logic

The Debugger is a convenient and efficient way to test or follow the processing of any logic defined in your model. The debugger is used to step through logic one statement at a time and examine variables and attributes while a model is running.

Before discussing the details of the Debug option, it is important to understand the following terms:

Statement A statement causes ProModel to take some action or perform some operation. This includes statements such as GET, JOIN, and SPLIT AS. (See “Statements and Functions” on page 429 for more information).

Logic Logic refers to the complete set of statements defined for a particular process record, downtime event, initialization logic, or termination logic for a simulation.

Thread A thread is a specific execution of any logic. A thread is initiated whenever a logic needs to be executed. This can be an entity running through an operation logic, the initialization logic, a resource running a node logic, a downtime logic, or any other logic. Note that the same logic may be running in several threads at the same time. For example, three entities of the same type being processed simultaneously at the same multi-capacity location would constitute three threads.

A thread or logic execution can be suspended by any statement, causing simulation time to pass (e.g., GET Res1, WAIT 5, etc.). After such a statement completes its task, the thread is resumed. During the time a thread is suspended, other threads may be initiated, suspended, resumed, or completed. This is called thread switching.

Please note

Even though several threads can execute the same logic at the same time in the simulation, the simulation processor can only process them one at a time. So there is really only one current thread while all other threads are suspended (either scheduled for some future simulation time, or waiting to be executed after the current thread at the same simulation instant).

Example

To better explain the above concepts, consider the following operation logic for a multi-capacity location.

The logic includes all statements shown on previous page. Let’s assume that there are three different entities currently executing this operation logic. Each executing entity constitutes a thread. A possible scenario for this case is the following: Thread 1 is an entity using two units of resource Oper_3 for N(35,5) minutes. Thread 2 is an entity waiting for resource Oper_1 to become available. The last thread is a different entity which has completed 10 minutes of the 15 minute wait executed at the beginning of the logic. Note that two entities arriving at a multi-capacity location at nearly
the same time could both execute the same WAIT or USE time in the logic, only in different threads.

In general, for a logic block containing statements that pass simulation time, any number of threads can wait for the required simulation time to elapse, corresponding to each time elapsing statement. These threads are scheduled to resume at some future simulation time.

There can also be many threads (any number of threads corresponding to each of the time elapsing statements within the logic) which have completed their waiting time, but await their turn to continue execution. These threads are on hold because the simulation engine is busy with another thread scheduled for the same simulation time. There is only one thread executed at any real time instant by the simulation engine.

The debugger window will display a unique identification number for the current, active thread. This thread ID number will help you differentiate between different instances of the same logic block while you are debugging your models.

---

**Debugger Options Dialog Box**

The Debugger Options dialog box allows the user to specify when to display the Debugger dialog box during the simulation run.

**Debugger Options**

- **Disable debugger**  Disables the debugger completely. By default the debugger is enabled. Running the model with the debugger disabled increases the run speed. When running multiple replications or scenarios, or when the animation is disabled, the debugger will automatically be disabled.

- **DEBUG statement**  Displays the Debugger dialog box every time a DEBUG statement is encountered in an enabled process while running the simulation. See “Debug” on page 455 for more information.

- **Global Change**  Displays the Debugger dialog box every time a global change occurs to a specified variable or array. The Debugger dialog box shows the original and new value of the element. Only one global name can be specified in this box.

- **User Condition**  Displays the Debugger dialog box when a defined user condition written as a Boolean expression becomes true, for example, when Var1=5. Only one expression can be specified in this box, although several conditions can
be tested by using the OR operator. See “Boolean Expressions” on page 400 for more information.

**Check Condition** Allows the user to define how often to check the user condition. The options include:

- **Before each statement** The condition, such as Var1=1, will be checked before each statement is executed. This option is the most precise way to tell exactly when the user condition becomes true, but it slows down the simulation the most.
- **At each thread switch** The condition, such as Var3>17, will be checked only if a statement from a different thread follows the current statement being executed.
- **At each thread initiation** The condition, such as Att1=5, will be checked only if the next statement to be executed is the first statement in a thread (the first statement in a thread is also the first statement of a logic).

**Debug button** Pressing the Debug button displays the Debugger dialog box before the next statement executes.

**OK** Closes the Debugger Options dialog box and continues to run the simulation model.

**Debugger Dialog Box**

The Debugger can be used in two modes: Basic and Advanced. The Basic Debugger appears initially with the option of using the Advanced Debugger. The Basic Debugger dialog box is shown below:

- **Error Display Box** Displays the error message or reason why the Debugger dialog box is displayed, such as the User-Condition becoming true.
- **Logic Display Box** Displays the statements of the current logic being executed.
- **Context Box** Displays the module, operation, and line number (in which the debugger stopped) in the Information box.
- **Information Box** Displays local variables and entity attributes with non-zero values in the Information box.
- **End Simulation** Choose this option to terminate the simulation. This will prompt you about collecting statistics.
- **Run** Continues to run the simulation, but still checks the debugger options selected in the Debugger Options dialog box.
- **Next Statement** Jumps to the next statement in the current thread. If the last statement executed suspends the thread (e.g., the entity is waiting to capture a resource), another thread meeting the
Debugger conditions may be displayed as the next statement.

**Next Thread**  Brings up the Debugger at the next initiated or resumed thread.

**Into Subroutine**  Steps to the first statement in the next subroutine executed by this thread. Again, if the last statement executed suspends the thread, another thread meeting debugger conditions may be displayed first. If no subroutine is found in the current thread, a message is displayed in the Error Display box.

**Options**  Brings up the Debugger Options dialog box. You may also bring up this dialog box from the Simulation menu.

**Advanced**  Changes the Debugger to Advanced mode, provides additional options discussed next.

### Advanced Debugger Dialog Box

The Advanced Debugger contains all options in the Basic Debugger plus a few advanced features.

![Advanced Debugger Dialog Box](image)

**Next (Thread)**  Jumps to the next initiated or resumed thread. This button has the same functionality as the Next Thread button in the Basic debugger.

**New (Thread)**  Jumps to the next initiated thread.

**Disable (Thread)**  Temporarily disables the debugger for the current thread (see also enable).

**Exclusive (Thread)**  The debugger displays the statements executed within the current thread only. When the thread terminates, the exclusive setting is removed.

**Next (Logic)**  Jumps to the next initiated or resumed thread that is not executing the same logic as the current thread.

**New (Logic)**  Jumps over any resumed threads to the next initiated thread not executing the same logic as the current thread.

**Disable (Logic)**  Temporarily disables the debugger for all threads executing the current logic (see also enable).

**Exclusive (Logic)**  The debugger displays only the statements executed in any thread executing the current logic.

**Enable disabled threads and logics**  Enables the threads and logics which were disabled previously.

### Debugger Options Examples

#### Debug Statement Example

A simulation model demonstrates a proposed flexible manufacturing system which produces castings. A variable, WIP, is used to track the work in process for the system. Suppose we want to display the Debugger when the variable, WIP, reaches a value of 300. We could place an IF...THEN statement including DEBUG after the
statement incrementing the variable, WIP, as shown below:

By checking the box next to the DEBUG statement in the Debugger Options dialog, the Debugger is displayed when the variable, WIP, reaches 300.

**Global Change Example**

Suppose we want to know when the variable, COUNT, is incremented. We would check the box to the left of Global Change and type COUNT in the Global Change field. This will display the Debugger dialog box each time COUNT changes. It will also display the previous and changed value of COUNT.

**User Condition Example**

Suppose we want to follow a casting through the entire system (i.e., from when an entity enters the system to when it exits). We would set an attribute equal to a unique number in the arrival logic for a single casting (Att1=3). In other words, only one casting in the system should have Att1=3. We would then check the User Condition box and enter the condition as “Att1=3.” We would then select At Each Thread Initiation as the Check Condition. The debugger is displayed each time a particular customer initiates a new thread. For example, the debugger may display the following information:

**Debugger syntax**

Casting @ loc1: GET Oper_1  
WAIT N(5,3)  
INC Var1  
Casting @ loc2: JOIN 1 Fixture  
...
...
...

**Trace Options**

A trace is a list of events occurring over the course of a simulation. For example, a trace statement might state “EntA arrives at Loc1, Downtime for Res1 begins.” A trace listing also displays assignments, such as variable and array element assignments. A trace listing of a simulation run may be viewed in several ways through the trace options provided.

**Trace Mode**

A trace listing is generated in one of three modes, Step, Continuous, or Filtered.

**Trace Off**

Select this option to discontinue a current trace.

**Trace Step**

Select this option to step through the trace listing one event at a time. Each time you click the left mouse button, the trace will advance one event. Clicking and holding the right mouse button while in this mode generates a continuous trace.
Trace Continuous

Select this option to write the trace continuously to the output device selected from the Trace Output submenu. This is useful when you do not know exactly where to begin or end the trace. Clicking and holding the right mouse button stops the trace until you release the button.

Filtered Trace...

When you view the Trace during simulation, you see a list of all the events that occur as your model is running.

Although it may be helpful to view every event in the simulation, there are many times when you will want to focus on just the events that affect specific elements (locations, resources, variables, etc.) of your model.

The Trace feature contains an optional, custom filter, which allows you to pick the elements of your model, or custom text string, that you wish to view in the Trace window.

From the Custom Trace Options dialog, you may choose which elements of your model you want displayed in the Trace window.

The Custom Filter works by showing the specified elements in the trace according to the following:

- Specified elements found in the main heading of the Trace will be displayed along with the entire contents of the sub-headings.
- Specified elements found in a sub-heading will only display the main heading and the sub-heading with the specified element. All other sub-headings of the main heading, which do not contain the specified elements, will not be displayed.
The Enable button in the Custom Trace Options dialog must be checked for the Trace Filter to take effect.

**Output to File**

Select this option to send the trace listing to a text file. Trace statements are automatically written to a `<model name>.TRC` file.

**Animation Options**

In addition to the debug and trace options, animation options allow you to control the animation screen.

**Animation Off** Choose this option to temporarily suspend the animation. To resume the animation, select this option again. (The selection automatically changes to “Animation On.”) Note that running with animation off greatly increases the run speed, especially for models with a large amount of graphic detail. To increase the run speed to an even faster rate, check the Disable Animation in the Simulation Options before running the model (see “Animation Options” on page 353).

**Zoom** Select this option to zoom in or out on the animation. When this option is selected, you may choose a preset zoom level, enter your own zoom level, or choose Zoom Full to fit the entire animation on one screen. The Zoom function zooms to the center of the screen. If the zoom factor causes the model layout to appear outside the layout window, the zoom function will automatically pan to show at least part of the layout.

To zoom in a specific area of the simulation layout, press and hold the CTRL key, then click and drag the mouse to create a rectangle around the area in which you would like to zoom. Release the mouse, then the CTRL key. The layout will zoom in on the selected area.

**Views** Click on this menu item to display the available views. Select the desired view.

**User Pause** Choose this option to enter a time for the simulation to pause. The proper format for specifying a user pause is hh:mm:xx where hh represents hours, mm represents minutes, and xx represents hundredths of a minute.

**Run-Time Information Menu**

The Run-Time Information menu allows you to see the status of locations in two different ways. In addition, you may view the current state of all variables and array elements. Each of these options is defined in the following pages.
Chapter 9: Run-Time Menus & Controls

Status Light  Select this option to bring up the Status Light Legend.

Locations  Select this option and choose a location to view an information box with real time information about the location. Information for all locations may also be displayed.

Variables  Select this option to show the current state of all real and integer global variables.

Arrays  Select this option to show the current value of all cells for arrays of up to three dimensions.

Dynamic Plots  Allows you to graphically monitor the performance of model elements during run time and store statistical data in an Excel® spreadsheet.

Location Status Legend

The Location Status Legend shows the different colors of a location status light and the meaning of each color. Single capacity locations may be in any of several states, while multi-capacity locations appear only as up or down. This window may remain open during the simulation.

Dynamic Plots

Dynamic plots allow you to select certain metrics for various model elements and observe value changes for those metrics dynamically as the model runs. Configurations of one or more plot windows can be saved and later retrieved to quickly view a customized set of graphs.

Features include:

• Up to six elements many be graphed on the same chart at the same time.
• More than one chart may be active at a time.
• Charts can be resized.
• Plots display a meaningful scale for both axes.
• Improved customization for graph appearance
• Chart settings may be saved to use over from one simulation run to the next.
• Dynamic plots work with multiple replications and scenarios.

Basic Operation

Please note

The Dynamic Plot dialog is only accessible during simulation run-time. If you will be creating saved chart views, you may wish to pause the simulation, define Chart views, then resume the simulation.

Starting Dynamic Plots

Dynamic plots are set up using the Information | Dynamic Plots menu during simulation. Under
Dynamic Plots you will find two sub-items, New and Configurations...

New opens a window similar to the one below.

Each plottable item displays a checkbox to its left. When checked, the item is added to the list of currently plotted items below the tree view and the chart view begins to plot the value of the item. When unchecked, the item is removed from the list of currently plotted items, and the item is removed from the chart view. Items can also be added or removed from the chart view by double-clicking the item. If the item was not checked, this will check the box next to the item, add it to the current item list and the chart view, and switch immediately to the chart display. If the item was checked, this will uncheck the box next to the item, remove it from the current item list and the chart view, and switch immediately to the chart display.

The maximum number of statistics that can be plotted on a single chart is six. When six items are being charted and you attempt to add an additional item by either clicking the box next to the item or by double-clicking the item, nothing will happen and no changes to the chart will take place.

Statistic List

The item list below the tree view contains the items currently being graphed, arranged into two columns: a label and a statistic name. The label
initially consists of only the text directly right of the item icon in the tree view, while the statistic name is composed of the names of the item ancestor nodes and the name of the item node itself. For example, for the "Avg Min per Entry" item under the Input location, the label would initially be set to "Avg Min per Entry" and the statistic name would be "Locations\Input\Avg Min per Entry."

**Please note**

*When you click on the Label portion of the item in the list to select it and then click again, the label becomes editable, and you can type over or edit the existing text. This text becomes the new label for the item, and will now be displayed in the legend in the chart view.*

The **Remove** button removes the selected item, if any, from the list, unchecks it in the tree view, and removes it from the chart view. Clicking the **Clear** button does this for every item in the statistic list.

Clicking the dividing lines between headings and dragging left or right resizes the columns in the statistic list.

**Chart View**

The chart view is where graphical representations of changing model elements are displayed. It consists of a chart area and, optionally, any combination of the following: toolbar, legend, x- and y-axis scales, x- and y-axis labels, vertical and horizontal gridlines, and a chart title. An example of a chart view is shown below.

The x-axis indicates time elapsed from the start of the simulation, measured in clock precision units specified in the Simulation Options dialog. The y-axis measures values of the items being plotted. Both axes are re-scaled when necessary so that all data points fit within the chart area. When in the chart view, the maximize button in the title bar expands the chart itself to completely fill the area within the dialog, removing the “Stats to Plot” and “Chart” tabs and extra spacing. This may be helpful when you want to size the chart window as small as possible and still view the chart update. Clicking the minimize button will restore the chart to its normal state. The items being plotted are color-coded and the key is on the right-hand side of the window. Many of the chart options such as title and colors are customizable; simply click the right mouse button and select **Properties…** from the context sensitive menu options.

**Dynamic Plot Configurations**

*Information | Dynamic Plots | Configurations...* is disabled if no saved configurations exist for the model and no dynamic plot windows are open. If enabled, selecting it opens a dialog box like the one below. The dialog box consists of a list box
containing the names of any saved dynamic plot configurations for the model, an edit field, and Load, Rename, Delete, Save, and Exit button.

If you select a configuration from the list and click Load, the indicated saved configuration of chart(s) will be loaded, with all of the previous settings as far as selected data items, chart style, colors, fonts, visible elements, screen position and size, etc. If any of the previously selected data items no longer exist in the model, they will simply not be displayed. For example, if a statistic had been selected for a location that was later deleted from the model, it will no longer be selected.

Double-clicking on a configuration in the list has the same effect as selecting it and clicking the Load button.

The Delete button removes the selected configuration from the list and deletes the associated data from the model.

The Rename button changes the name of the currently selected configuration to the text in the Save/Rename As edit field.

Clicking the Save button saves all settings of any open dynamic plot windows, including selected data items, chart style, colors, fonts, visible elements, screen position and size to a configuration with the name specified in the edit field. If the name matches one of the configurations in the configuration list, this data will replace the previous data for that name.

The Save button does not actually save data into the model file. Rather, it creates or modifies a set of configuration data associated with a particular configuration name in memory and tags the model as being modified. If you exit the program, load a model, or execute the New command from the File menu you will be prompted to save the model. Using the Delete or Rename buttons in the configuration dialog also tags the model as modified.

Advanced Operation

To enhance your simulations and presentations you can turn your dynamic plots on and off using the DynPlot “” statement in your model logic. Predefine the statistics to be graphed and a chart name, then open your plot through subroutines or processing logic.
Run-Time Window Menu

The Run-Time Window menu allows you to rearrange windows and icons and select the active window. These functions are standard to all Windows applications.

<table>
<thead>
<tr>
<th>Window</th>
<th>Interact</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal Run</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tile**  Causes all open windows to fit in the available screen space. Windows hidden behind other windows become visible.

**Cascade**  Causes all open windows to overlap such that the title bar of each window is visible.

**Arrange Icons**  Causes all icons representing iconized applications or windows to be arranged neatly along the bottom of the screen.

Run-Time Interact Menu

The Run-Time Interact menu displays the Interact dialog box. It allows you to execute interactive subroutines during run-time. Interactive subroutines are defined in the Subroutines edit table (see “Subroutine Editor” on page 238).

![Interact dialog box](image)

**How to execute an interactive subroutine during run-time:**

1. Select Interact from the run-time menu.
2. Select the identifier for the subroutine from the list box in the Interact dialog box.
3. Choose the Activate button.

Run-Time Help Menu

The Run-Time Help menu contains selections for accessing the ProModel on-line help system. It operates the same here as in the model editing functions.

![Help menu](image)

**Index...**  Choose this option to bring up the Main Help Index.
Context Choose this option to go directly to the help screen that corresponds to the active window. If no context sensitive help exists for the active window, the Main Help Index will appear.

About... Choose the option to display a message containing software version information.

Run-Time Controls

In addition to the animation options discussed in the previous section, you may pan the animation screen in any direction, control the speed of the simulation, and change the format of the simulation clock display. These and other procedures are discussed in this section.

How to pan through the animation:

1. Press and hold the left mouse button anywhere on the animation screen. This point then becomes the “anchor point” by which the entire animation is moved.

2. Drag and release the mouse where you desire the anchor point to be located. The following diagram illustrates this procedure.

How to control the simulation speed:

- Move the animation speed control bar to the left to decrease the simulation speed or to the right to increase the simulation speed.

Please note

The speed of the animation may be altered by model logic with the use of the ANIMATE statement (See “Animate” on page 432).

How to change the format of the simulation clock display:

1. Click on the simulation clock button.
2. Select a format for the clock display.

[Selectable formats shown]

How to identify any location on the layout during the simulation:

- Click on a location while holding the CTRL key. (An identifier box appears and allows you to bring up the location information window for that location.)

Run-Time Right-Click Menu

Right clicking in the simulation window will bring up a right-click menu, which gives you easy access to several animation controls.

- **Animation Off**  Turns off the animation, which makes the simulation run faster.
- **Zooms**  Allows you to choose a level of zoom.
- **Views**  Allows you to choose a view that you have previously defined. See “Views” on page 77 for information on defining views.
- **Pause/Resume Simulation**  Allows you to toggle the simulation’s pause on and off.
- **Trace Options**  Lists events as they happen during a simulation. This listing may be Step by Step, Continuous, or Filtered.
- **Dynamic Plots**  Opens the Dynamic Plots window.

**Please note**

Right clicking to bring up the right-click menu will pause the simulation as long as the right-click menu is open.

SimRunner

SimRunner takes your existing ProModel simulation models, evaluates them for you, then performs tests to find better ways to achieve the results you desire. Typically, most people use simulation tools to predict and improve a system’s performance by modeling the actual location (e.g., a plant floor, a bank lobby, or emergency room) or abstract process (i.e., a logical process). Through testing various “what-if” scenarios, SimRunner can help you determine the most ideal way to conduct operations—we call this optimization.

When you conduct an analysis using SimRunner, you build and run projects. With each project, SimRunner runs sophisticated optimization algorithms on your model to help you optimize multiple factors simultaneously. For each project, you will need to provide SimRunner with a model to analyze or optimize, identify which input factors to change, and define how to measure system performance using an objective function. SimRunner can conduct two types of tests: Pre-Analysis (Statistical Advantage) and Simulation Optimization.
**SimRunner Benefits**

Using SimRunner will help you find accurate solutions for your modeling needs. No longer must you sit and experiment with what you think might work, only to find that your solution actually interferes with productivity in other parts of the model. SimRunner will help you locate true solutions by monitoring how changes affect each part of the model. In other words, SimRunner will not let you improve one area of your model at the expense of another—the results you get are beneficial to the entire model.

**Starting a New Project**

The following describes how to start and prepare a project for analysis. Remember that you must create and validate your model prior to analyzing or optimizing it in SimRunner.

**How to select a model:**

1. Click the New button on the button bar or select New Project from the File menu.
2. From the Open dialog, select the model file you wish to use.
3. Click OK.
4. Once you select a model, the model’s name will appear in the Project Information dialog.

**How to define the input factors:**

1. Click on the Inputs button.
2. To select input variables, click next to each variable in the Selected column. SimRunner will mark the selected items.

**Please note**

SimRunner will optimize only single value RTI macros.

**How to define the objective function (output variables):**

1. Click the Outputs button.
2. In the Objective Function Setup dialog, select the category of the item(s) you wish to minimize or maximize.
3. Highlight an item in the list.
4. Select Maximize, Minimize, or Custom to select the type of optimization you wish to use for the variable.
5. Enter the Weighting. This number represents the importance of Maximizing or Minimizing the item. (The higher the number, the higher the importance.)
6. After you set the values for the item, click the right arrow to place the item in the selected list. To remove an item from the selected list, select the item and click the left arrow. (Alternatively, you may double click on an item to add it to or remove it from the list of selected variables.)

**Stage one: Pre-Analysis**

With the model built, the input factors selected, and an objective function defined, you are ready to conduct a Pre-Analysis. Also known as Statistical Advantage, the Pre-Analysis runs several tests to identify the initial bias (warm-up period), determine appropriate run-length to reach steady-state, find the number of replications necessary to ensure that each event occurs at least once, and locate the model averages.
Stage two: Simulation Optimization

Simulation Optimization is a multi-variable optimization that tries different combinations of input factors to arrive at the combination that provides the best objective function (output) value. Depending on the number of selected input factors and the complexity of the solution space, this process can take a long or short time. Optimizations with many factors and complex solutions take longer to run.

How to run an optimization:

1. Click on the Optimize! button or select Start Optimization from the Project menu.
2. Click Play on the dashboard to begin.
Chapter 10: Reports and Graphs

Once your model has been built, and the simulation run, you are ready to begin making important decisions about your real-world process based on your simulation’s data. To help you make the most of the data collected during simulation, ProModel comes with a powerful, easy-to-use Output Viewer 3DR. This Output Viewer 3DR allows you to view your data numerically, in spreadsheet format, or graphically in a variety of charts.
Output Viewer 3DR

Output Viewer 3DR organizes and displays the data gathered during your model’s simulation. You can open Output Viewer 3DR from ProModel or from the Window’s Start menu in the ProModel program group. Output Viewer 3DR’s Menu bar and Toolbar give you the controls necessary to create the reports and charts needed to help interpret your data.

Menu Bar

The Menu bar contains all of the tools necessary to view your simulation’s data. The Menu bar is located just beneath the Output Viewer 3DR caption bar, and allows access to the following menus:

File Menu

The File menu allows you to open and close data files, export data, and print data.

Table: File Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Export Data...</td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Print Setup</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl+Q</td>
</tr>
</tbody>
</table>

Output Viewer 3DR opens files with the .idb extension; however, .rdb files, which are generated by ProModel can be converted to .idb files when they are opened using Output Viewer 3DR. Data can be exported to a .csv (comma-delimited) file using the Export Data option. This allows you to later import the data into other data viewing programs, such as Excel.

Reports and Charts

The first five selections in the View menu display the output data in different ways:

- **Report** Spreadsheets of the data collected during the simulation. see “Creating Reports” on page 372.
- **Category Charts** Bar charts of your data. see “Category Chart” on page 381.
- **State Charts** Stacked bar charts of state variables such as location and resource states. see “State Chart” on page 382.
- **Histogram** Displays graphically the frequency of occurrences of time plot data. see “Histogram” on page 384.
- **Time Plot** Shows variables, states and events over time. see “Selection Window” on page 386.

Sheet/Chart Properties

The title of the last option in the View menu will vary between Sheet Properties and Chart Properties, depending on whether a spreadsheet report or graphical chart is currently displayed. This selection brings up a window where you can...
choose the data you want to appear in the open report or chart.

**Sheet Properties - Display Items**

If you choose Sheet Properties while you are working with a Report, the following window appears. The default Display Items Tab is described below.

- **Display gridlines with this desired color:** When this box is checked gridlines will appear in the data sheet in the selected color. Unchecking this box will hide all grid lines for the data sheet.

- **Display header with desired settings:** When this box is checked the header will appear with the font styles selected when you click the Font & Color button. If you uncheck this box, no heading will be displayed above the sheet.

- **Caption:** The text displayed in the sheet heading. The default caption uses the following construct: [model name] ([scenario name] - [replication information]).

- **Additional Records:** The options in this area allow you to display additional replication information, which includes: the min and max, standard deviation, and various confidence interval information for the replications.

**Please note**

*If you are working with a database that does not contain multiple replications, the Additional Records field of the Sheet Properties window is not applicable, and therefore not accessible.*

**Sheet Properties - Columns**

The “Columns” tab for Sheet properties is described below.

- **Columns:** You may choose to show or hide columns by checking or unchecking the boxes in this list. The available columns in this list will vary depending on the sheet you have selected.

- **Column Headers:** Choose the font styles of the column headers.
• **Non-scrolling columns from the left:** Use this column to lock columns in place as you scroll horizontally through your sheet data. For example, entering “1” in this field will lock the left-most column in place, so that it will not scroll with the rest of the sheet’s columns.

• **Display time values in:** By default, time values are shown is hours, but you may choose to have time units shown in seconds, minutes, hours, days, or weeks.

**Chart Properties**

The Chart Properties dialog will vary depending on what type of chart you choose to view properties for. See each chart type description (beginning with “Category Chart” on page 381) for more information on the options available from its Chart Properties dialog.

**Tools Menu**

The Tools menu allows access to the View Manager and Output Viewer 3DR options.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Manager...</td>
<td>Ctrl+M</td>
<td></td>
</tr>
<tr>
<td>Next View</td>
<td>F2</td>
<td></td>
</tr>
<tr>
<td>Previous View</td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Set Report as Default Style</td>
<td>Ctrl+U</td>
<td></td>
</tr>
<tr>
<td>Options...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**View Manager**

The View Manager allows you to save customized report and chart views for quick retrieval. The View Manager is great for creating custom presentations. Views are associated with the model, so the next time the model is run the same view appears.

A view describes the way a report or chart appears. For instance, you may choose to create a category chart as explained on page 381.

That chart may then be customized using the tools in the Chart toolbar, page 379, and the right-click menu, page 369.

In the example shown, the fonts, coloring and window size were changed, but the data remains the same.
This particular customized view of the chart can be saved using the View Manager.

The View Manager contains a field with the names of your views and the following tools:

- ◀️: Creates and saves a new view based on the report or chart you currently have selected in the Output Viewer 3DR.
- ◀️: Saves a view after you have modified it.
- ◐: Deletes the view you have selected in the View Manager.
- ✏️: Renames a selected view.
- 🔧, 🔧: Moves the name of a selected view up or down within the list in the View Manager. This is helpful for creating an ordered list of customized views. The first view in the list is the initial view displayed after rerunning the model again and opening the Output Viewer 3DR.

**How to Save a Customized View**

1. Open a report or chart window. See “Reports and Charts” on page 364 for a list of possible reports and charts.
2. Customize the report or chart as desired using the tools in the Chart toolbar, page 379, and the right-click menu, page 369.
3. Open the Views Manager by clicking on the tool in the Output Viewer 3DR toolbar, or selecting View Manager from the Tools menu.
4. Click the New Icon, ◀️, in the View Manager and give the view a name.
5. Click OK to save your new view.

**Next/Previous View**

The Next/Previous View options in the Tools menu allows you to scroll through the views you have saved in the View Manager.

**Set as Default Style**

This option allows you to set the characteristics of a report or chart as your default style. This is helpful, for instance, if you customize the color scheme of a chart, and want it to apply to all the charts you open.

Setting a default style is different from saving a view, which will only save color and font changes for just one report or graph.

If a report or chart is selected when you choose the Set as Default Style option, all of the font and color changes you have made to the selected report or chart will be applied to any new reports or charts you open.

The default style settings can be restored from the Options window described next.
Options

The Options window allows you to change basic settings for the Output Viewer 3DR.

The decimal precision can be changed to increase or decrease the number of digits that appear for all real numbers that are displayed.

You can choose to have the current database close whenever you open a new database.

Selecting the check box for Enable Multi-create Dialogs will leave the Select Report and Select Chart windows open until you close them. This allows you to open multiple reports or charts at the same time without having to reopen the creation window each time.

This option is checked by default. If you want the selection widow to close when you open a report or chart, uncheck the box.

If you have changed your report or chart style as described in the previous heading, you can restore the default styles by using the Reset Defaults menu and Reset button.

How to Reset Default Styles

1. Select Report or Chart Defaults from the pull-down menu in the Options window.
2. Click the Reset button.
3. Click OK to close the Options window. The default styles will be reset for reports or charts.

Window Menu

The Window menu contains useful tools for making multiple data windows easier to view and compare with one another.

- **Tile Horizontally** Sizes and places each open window horizontally across the screen so none of them overlap. Since most data in the Output Viewer is arranged horizontally within a window, this option is very helpful for comparing data from one window with another.
- **Tile Vertically** Sizes and places each open window vertically across the screen. This makes comparing data across two or more windows convenient when the data in the window is arranged vertically.
- **Cascade** Places windows on top of each other in an overlapping manner.
- **Arrange Icons** If you have report or chart windows minimized within the Output Viewer 3DR window, this options will align them in a row along the bottom of the Output Viewer 3DR window.
- **Close All** Closes all open windows in the Output Viewer 3DR.
- **Open Windows** This last field in the Window menu displays the names of all the open windows. This is helpful for navigating
through data windows when you have many open at one time.

Help Menu

The Help menu gives you access to the Output Viewer’s help file as well as information about the Output Viewer 3DR.

Toolbar

The Output Viewer 3DR Toolbar gives you quick access to some of the options found in the Menu bar.

File Tools

The File tools allow you to quickly open data files, export data, and print files.

- : Opens an .idb or .rdb data file.
- : Exports data.
- : Prints the data.

For more information on these features see “File Menu” on page 364.

Report and Chart Tools

The Report and Chart tools gives quick access to options found in the View menu.

- : Creates a report.
- : Creates a category chart.
- : Creates a state chart.
- : Creates a histogram.
- : Creates a time plot chart.

For more information on these features see “View Menu” on page 364.

Option Tools

These tools allow you to access some of the features in the Tools menu as well as the Sheet Properties window.

- : Displays Sheet Properties.
- : Displays the Options window.

For more information of Sheet Properties, see “Sheet/Chart Properties” on page 364. For more information on the Options windows, see “Tools Menu” on page 366.

Help Tool

- : Starts the Output Viewer 3DR Online Help.

View Manager Tools

The View Manager tools are located on the far right of the toolbar. These tools allow you to quickly select a view.

- : Allows you to select a view from the pull-down menu.
- : Scrolls through your views.
- : Displays the View Manager window.

For more information on Views and the View Manager, see “View Manager” on page 366

Right-click Menu

The Right-click menu provides a shortcut for editing the appearance and structure of your reports and charts.

The Right-click menu is available in report and chart windows. Additionally, the options that appear when you right-click in the Output Viewer
3DR vary depending on which area you right-click on.

**Right-click Menu in Reports**

When you right-click anywhere in a report window, the following menu appears.

- **Format Cells**  This option brings up a window that allows you to edit the size and alignment of the cell fonts, and the color of the cells.
- **Copy**  Copy transfers the contents of the highlighted cells to the clipboard. This is useful for transferring select information to a separate spreadsheet.
- **Sheet Properties**  This option brings up the Sheet Properties of the current report. For more information on this window see “Sheet/Chart Properties” on page 364.

When you right-click anywhere in a report window that contains numerical values, the Right-click menu contains two additional options depending on whether the values are percentage values or not.

- **Create Chart**  If you right-click on a column of numerical value, including percentage value, you can choose to have that data displayed as a Category Chart. The Category Chart that’s created is the same as one created using the Category Chart option. See “Category Chart” on page 381 for more information.
- **Create State Chart**  If you right-click on a column that contains percentage values, you can choose to have that data displayed, together with all other percentage columns on the sheet, as a State Chart. The State Chart that’s created is the same as one created using the State Chart option. See “State Chart” on page 382 for more information.

**Right-click Menu in Charts**

The Right-click menu that appears for charts is different than the menu for reports.

There are three areas within a Chart window that you can right-click to bring up a different menu:

- On the legend area.
- In the Chart area.
- On a title or label.

**Right-click Menu for the Legend Area**

The legend area is located within the Chart window, and gives an explanation of the chart’s color codes.

An example of a legend area is shown below.
When you right-click anywhere in the legend area, the following menu appears.

![Menu](image)

There are four areas in this menu:

- **Font**  This feature lets you change the font options for the legend labels.
- **AutoSize**  The AutoSize option resizes the legend area to fit the labels in the legend.
- **Legend Position**  The position of the legend area can be moved to any one of the four sides of the Chart window, or it can float in its own window.
- **Hide**  Selecting this option makes the legend disappear. You can bring the legend back by opening the Chart Properties window in the View menu.

**Right-click Menu for the Chart Area**

Right clicking anywhere in the Chart window, except for the legend area, brings up the following window.

![Menu](image)

- **Color**  This will allow you to change the color of the area your mouse was positioned over when you opened the Right-click menu.

This could be the color of the background or bars in the chart.

- **Toolbar**  Toggles the toolbar for chart windows on and off. This is helpful, for example, to make the chart appear less cluttered during a presentation of the data or on a printout of the chart. For more information on the chart window toolbar see “Chart Toolbar” on page 379.
- **Chart Properties**  Opens the Properties window. For more information on this window see “Sheet/Chart Properties” on page 364.
- **Modify Chart Items**  This option opens the chart's data dialog, which was initial dialog shown when you first created the chart. This option is only available for Histogram and Time Plot chart types.

For more information on the data dialog see the corresponding chart descriptions, beginning with “Category Chart” on page 381.

**Right-click Menu for Titles and Labels**

Titles and labels are the text within the chart area. Right-clicking on either of these two will bring up a Right-click menu similar to that of a chart area’s menu, but with two additional options.

![Menu](image)

- **Edit Title**  Edits the text for the title of the chart or axes.
- **Font**  Allows you to change the font characteristics for the titles and labels.
Creating Reports

Reports contain the numerical data that is collected during your simulation.

This information is presented in spreadsheet form, and grouped into the following categories:

- General
- Entity Activity
- Entity Costing
- Entity States
- Failed Arrivals
- Location Costing
- Location States Multi
- Location States Single/Tank
- Locations
- Logs
- Node Entries
- Resource Costing
- Resource States
- Resources
- Variables

For more information on each of these categories see “Report Data” on page 373.

How to create a report

1. Choose the Reports option from the View menu or the Reports icon, from the Toolbar.

2. If the model you ran had multiple scenarios or replications, the following window appears.

3. From this window you may choose which scenarios and replications to view.

4. Click on the Create button. This will open a new window with the chosen report.

Please note

If your model was run for only one replication and one scenario, the report window will open immediately after selecting the Reports option.

Report Window

The Report window contains the categorized information from your simulation.

The data appears in spreadsheet format, and is grouped by the categories listed by tabs along the top of the Report window. Selecting a tab will bring up a new table, and additional tabs can be accessed using the left and right arrows.
The caption of a report can be renamed by either double clicking on it and then typing in the new name or opening the sheet properties window and typing a new name in the Caption area.

Report Data
The spreadsheet for each button contains the following information.

Please note
The default time units shown in the report will be one unit longer than the unit selected in the Simulation Options dialog box. For example, if you select minutes in Simulation Options, the time displayed in the report will be in Hours. You may also notice that Day is the last option available in Simulation Options, in which case the time unit will be in weeks for the report.

General
• Run Date/Time The date and time the model was run for the displayed output.
• Model Title The name of the model.
• Model Path/File The path and name of the model file.
• Warmup Time The amount of initial time the simulation spent in a warmup state. No statistics were gathered during this time. The time unit used is one unit longer than defined in the Clock Precision field of the Simulation Options dialog.
• Simulation Time The total simulation time, including the warmup time. The time unit used is one unit longer than defined in the Clock Precision field of the Simulation Options dialog.

Entity Activity
Entity activity is reported for only those entities that have exited the system.
• Total Exits The number of entities that completely exit the system either through the EXIT routing or when they are joined, renamed, or combined. In some cases, entities also exit the system when you use the SPLIT AS, UNGROUP, or ROUTE statements.
• Current Quantity In System The total number of entities remaining in the system at the time the simulation ends. These are entities that have not exited.
• Average Time In System The average total time the entity spends in the system.
• Average Time In Move Logic The average time the entity spent traveling between locations, including any delays incurred in move logic.
• Average Time Waiting The average time the entity spent waiting for a resource or another entity (to join or combine). Also includes time waiting in queue behind a blocked entity.
• Average Time In Operation The average time the entity spent processing (i.e., WAIT or USE statements) at a location or traveling on a conveyor/queue.
• Average Time Blocked The average time the entity spent waiting for a destination location to have available capacity.

Entity Costing
• Explicit Exits The number of entities that have explicitly exited. Whenever an entity exits the system, it is an explicit exit except in the following cases:
- When an entity JOINS, permanently LOADS, or COMBINES with another entity, it implicitly exits the system, and is reported as an exit in the Entity Activ-
ity report. However, for costing purposes, the entity did not explicitly exit, but its costing information was added to the entity it was JOINED, permanently LOADED, or COMBINED with.

- When an entity temporarily LOADS onto a base entity or GROUPS with another entity, and the entire LOADED or GROUPED entity exits the system, the original entity implicitly exits the system, and is reported as an exit in the Entity Activity report. However, for costing purposes, the original entity did not explicitly exit, but its costing information was added to the entire load or group.

- **Total Cost Dollars**  Total Cost = cumulative entity cost, or the sum of costs incurred on all locations the entity passed through + the sum of all costs incurred by use of resource + initial cost + any IncEntCost

- **% Total Cost**  % Total Cost refers to the entity’s percentage of sum of all entity costs

In the above calculations, the rate defined (per day, hour, minute, and second) converts to the default time units specified in the General Information dialog.

**Please note**

ProModel does not allow you to generate a Costing Graph. However, if you set a variable equal to GetCost (e.g., Var1 = GetCost), you can generate a time series graph to track changing entity costs.

**Entity States**

Reported by entity type for only those entities that have exited the system.

- % In Move Logic  The percentage of time the entity spent traveling between locations, including any delay time incurred in move logic.

- % Waiting  The percentage of time the entity spent waiting for a resource, a WAIT UNTIL condition, another entity to join or combine, or behind other entities. (100% - Sum of %’s for all other states.)

- % In Operation  The percentage of time the entity spent in processing at a location or traveling on a conveyor/queue. If an entity is on a conveyor behind another entity which is blocked because the next location is unavailable, the time the entity spent behind the other entity is considered % in Operation.

- % Blocked  The percentage of time the entity spent waiting for a the next location to become available.

**Failed Arrivals**

The number of entities that failed to arrive at a specific location due to insufficient capacity.

**Location Costing**

- **Operation Cost Dollars**  Operational Cost = (Active Operation Time * Rate) + (Any IncLocCost)

- **% Operation Cost**  Refers to the location’s percentage of the sum of all operation costs

- **Resource Cost Dollars**  Resource Cost = (Utilization * Rate) + (Times Used * Cost per use)

**Please note**

For Resource Cost, Utilization and Times Used refer to the utilization of a resource while at a location. This applies only to resource use through operation logic.
• **% Resource Cost**  Refers to the location’s percentage of the sum of all resource costs

• **Total Cost Dollars**  Total Cost = (Operation Cost + Resource Cost)

• **% Total Cost**  Refers to location’s percentage of the sum of all location costs

### Location Setup

- **Name**  The name of the location where the setup downtime occurred.

- **Entity**  The name of the entity that caused the setup downtime.

- **Total Setups**  The number of times this location/entity combination resulted in a setup downtime.

- **Avg Time Per Setup (HR)**  The average time in hours the location was down for each setup downtime.

### Location States (Multiple Capacity)

- **Scheduled Time**  The total amount of time the location was scheduled to be available. This value is now in decimal format, not truncated. (Excludes off-shift time, break time, and scheduled downtimes.)

- **% Empty**  The percentage of time the location had no entities.

- **% Partially Occupied**  The percentage of time the location has entities but was not filled to capacity (100% of time - %Full - %Empty).

- **% Full**  The percentage of time the location was full to capacity with entities.

- **% Down**  The percentage of time the location was down as the result of unscheduled downtimes. This does not exclude the possibility of overlap with any of the previous three states.

### Location States (Single Capacity/Tank)

- **Scheduled Time**  The total amount of time the location was scheduled to be available. This value is now in decimal format, not truncated. (Excludes off-shift time, break time, and scheduled downtimes.)

- **% Operation**  The percentage of time the location was actually processing an entity.

- **% Setup**  The percentage of time the location spent in setup in order to process the entities.

- **% Idle**  The percentage of time no entities were at the location, but the location was not down.

- **% Waiting**  The percentage of time the location was waiting for a resource, another entity, or a WAIT UNTIL condition in order to begin processing or move to the next location. Any delays in processing move logic (even WAIT statements) are counted as waiting time and include the following statements:

  - JOIN
  - LOAD
  - MATCH

- **% Blocked**  The percentage of time entities spent waiting for a freed destination.

- **% Down**  The percentage of time the location was down due to unscheduled downtimes.

### Locations

- **Scheduled Time**  The total amount of time the location was scheduled to be available. This value is in decimal format, not truncated. (Excludes off-shift time, break time, and scheduled downtimes.)

- **Capacity**  The capacity defined in the location’s module for this location.

- **Total Entries**  The total number of entities that entered the location, not including entities arriving to be joined and loaded. Entities
split, unloaded, or ungrouped from another entity at a location do not count as additional entries. Arriving entities that have been previously grouped or loaded to form a single entity only count as one entry.

• **Average Time Per Entry**  The average time each entry spent at the location. This time may include partial times from the beginning and end of the actual run time.

• **Average Contents**  The average number of entries at the location.

• **Maximum Contents**  The maximum number of entries which occupied the location over the course of the simulation.

• **Current Contents**  The number of entities remaining at the location when the simulation ended.

• **% Utilization**  The percentage of capacity occupied, on average, during the simulation.

\[
\text{Cumulative Occupancy Time} \times 100 \\
\text{Capacity} \times \text{Scheduled Time}
\]

Cumulative Occupancy Time refers to the sum of the clock time each entity spends at a location for processing.

**Logs**

• **Numbers of Observations**  The number of log entries that occurred during the simulation for the given Log Name.

• **Minimum Value**  The minimum log entry value during the simulation for the given Log Name.

• **Maximum Value**  The maximum log entry value during the simulation for the given Log Name.

• **Average Value**  The average value of all log entries during the simulation for the given Log Name.

---

**Please note**

*Log statistics are set up by the user with a LOG statement to track the time entities spend between any two points in the model.*

---

**Node Entries**

A node entry summary is generated for each non-passting path network in the system. It contains the following information.

• **Path Name**  The name of the path the node resides on.

• **Total Entries**  The number of times that a resource entered the path node.

• **Blocked Entries**  The number of times a resource tried to claim a path node occupied by another resource.

**Resources Costing**

• **NonUse Cost Dollars**  \[\text{NonUse Cost} = (1-% \text{Utilization}) \times \text{Scheduled Time} \times \text{Rate}\]

• **% NonUse Cost**  Refers to the resource’s percentage of the sum of all nonuse costs.

• **Usage Cost Dollars**  \[\text{Usage Cost} = (% \text{Utilization} \times \text{Scheduled Time} \times \text{Rate}) + (\text{Times Used} \times \text{Cost per use})\]

• **% Usage Cost**  Refers to the resource’s percentage of the sum of all resource usage costs.

• **Total Cost Dollars**  \[\text{Total Cost} = \text{Usage Cost} + \text{NonUse Cost}\]

• **% Total Cost**  Refers to the resource’s percentage of the sum of all resource costs.

**Resource States**

• **Scheduled Time**  The total amount of time the resource was scheduled to be available. (Excludes off-shift time, break time, and scheduled downtimes.)
• **% In Use**  The percentage of time the resource spent transporting or processing an entity, or servicing a location or other resource that was down. This also includes deposit time.

• **% Travel To Use**  The percentage of time the resource spent traveling to a location or other resource to transport or process an entity, or to service a location or other resource. This also includes pickup time. (This information is not available if your model does not have dynamic resources.)

• **% Travel To Park**  The percentage of time the resource spent traveling to a path node to park or traveling to its downtime node. (This information is not available if your model does not have dynamic resources.)

• **% Idle**  The percentage of time the resource was available but not in use.

• **% Down**  The percentage of time the resource was unavailable due to unscheduled downtimes.

**Resources**

• **Units**  The number of units defined in the Resources module for that resource.

• **Scheduled Time**  The total amount of time the resource was scheduled to be available. (Excludes off-shift time, break time, and scheduled downtimes.)

• **Number of Times Used**  The total number of times the resource has been acquired to transport or process an entity or to service locations or other downed resources.

• **Average Time Per Usage**  The average time the resource spent transporting or processing an entity, or servicing a location or other resource. Includes any pickup and drop-off time as well as any blocked time while in use. (See note on time units.)

• **Average Time Travel To Use**  The average time the resource spent traveling to a location or other resource to transport or process an entity, or to service a location or other resource. Does not include any pickup time, but does include any blocked time. (This information is not available if your model does not have dynamic resources.)

Average Time Travel to Use = total Time Travel to Use / (divided by) Number of Times Used

• **Average Time Travel To Park**  The average time the resource spent traveling to either a park node or a downtime node. (This information is not available if your model does not have dynamic resources.)

• **% Blocked In Travel**  The percentage of time the resource was unable to move to a destination because the next path node along the route of travel was blocked (occupied by another resource). (This information is not available if your model does not have dynamic resources.)

• **% Utilization**  The percentage of time the resource spent traveling to be used, transporting or processing an entity, or servicing a location or other resource.

\[
\text{Total Travel to Use Time} + \text{Total Time In Usage} \times \frac{100}{\text{Total Scheduled Time}}
\]

**Please note**

ProModel reports resource groups and multi-unit resources both by unit and collectively. The collective unit (aggregate) report for a resource totals the first three fields and averages the last five fields discussed above.

**Variables**

• **Total Changes**  The total number of times the value of the given variable changed during the simulation.
• **Average Time Per Change**  The average time a given variable remained at any one value.

• **Minimum Value**  The lowest value of the variable during the simulation.

• **Maximum Value**  The highest value of the variable during the simulation.

• **Current Value**  The final value of the variable when the simulation ended.

• **Average Value**  The average value of the variable during the simulation. This value is time weighted.

---

**Please note**

*In the report, if a variable name is followed by an asterisk (*), the variable is an observation-based variable. Otherwise, it is a time-weighted variable. This determination is made in the Variable edit table where the variable is defined.*

*The initial value for observation-based variables is not accounted for in the statistics.*
Creating Charts

Charts provide visual representations of the data contained in Reports. The Output Viewer 3DR can display four main types of charts with several sub-types:

- Category Charts
- State Charts
- Histograms
  - Time-Weighted Values
  - Simple Values
- Time Plots
  - Time-Weighted Values
  - Simple Values
  - State Values
  - Counts

Chart Window

The chart window contains your chart and options to modify your chart.

Regardless of the type of chart you open, all chart windows have options and fields in common:

- Chart Toolbar
- Legend Field
- Chart Area
- Display and Alias

Chart Toolbar

The toolbar that appears in a Chart window gives you several options to change the way the information is presented in your chart.

- : Toggles between a three-dimensional and two-dimensional bars in your chart. Three-dimensional is the default view.
- : Toggles between bars and cylinders in the Chart area.
- : Expands the chart along the z-axis to show multiple scenarios in layers. This option will not be available if only one scenario was run.
- : Shows the results in a stacked bar chart.
- : When the chart is three-dimensional, this option will allow you to rotate the view using the cursor.
- : Use this tool to enlarge regions of your chart. Select this tool then click and drag to outline the chart area you want to enlarge. You can continue to zoom in on an area, or you can reset the view to the default zoom level by selecting this tool again.
- : Use this tool to change the colors in the Chart area. Selecting this tool will open a menu with color options. Choosing a color will change your cursor to a paint bucket. Position the bucket over the area you want to change, and click to fill the area with the new color.
- : Opens the chart’s properties dialog.
Chapter 10: Creating Charts

- Opens a dialog, which allows you to modify the items displayed in the chart. This option is only available for Histogram and Time Plot charts.

- Allows you to change the chart’s titles and labels.

- Allows you to change the font characteristic of the chart’s titles and labels.

- Toggles the point labels on and off. Point labels are the numbers that the bars in your chart represent. These numbers will appear at the top of the bars when this option is selected.

- Toggles the point makers on and off. Point markers are small graphics that show the data points on your graphs.

- Toggles the Legend area on and off.

- Toggles the Display and Alias field on and off. For more information on this field see “Display and Alias” on page 380.

- Toggles the vertical grid lines in the chart on and off.

- Toggles the horizontal grid lines in the chart on and off.

- Copies the chart to the Windows clipboard as a bitmap, a metafile, or as plain text (data only).

Please note

The Bar/Cylinder, tool is not available for Simple Values and Time-weighted Values time plot charts, since they do not use bars to represent data.

Legend Field

The Legend field shows the definition and color-coding of the bars in your chart.

Chart Area

The Chart area contains your chart.

The appearance of this chart will depend on the type of chart you are viewing; i.e. category, histogram, etc.

Display and Alias

The Display and Alias field, which can be toggled on and off from the toolbar, allows you to quickly select the data items you wish to display in the chart and optionally assign aliases to the data items.

Select which series and items you would like displayed in the chart by checking the box in the
Visible column. To show or hide all the items you can click check or uncheck the box in the <ALL> row or click on any box while holding the CTRL key.
Double click on a series or item name to rename it with an alias.

Category Chart

Category Charts displays bar charts for columns of data found in reports.
The Category Chart is an excellent way to visually compare the different items in your reports. It is also helpful for organizing data attractively for presentations.
To display a Category Chart, select Category Chart from the View menu or the Category Chart icon from the Toolbar. As a shortcut, you can also right-click on any column of data in a report and select Category Chart from the drop-down menu. When you choose to view a Category Chart, the Category Chart Selection dialog will be displayed.

From this menu you can select the scenarios, replications, periods (only available if Batch Mean or Periodic Output Reporting is selected in the Simulation Options dialog) and categories of the data you want displayed.
For information on each category, see “Report Data” on page 373.
Chapter 10: Creating Charts

Category Chart Properties
Choosing the properties option for a category chart will open the Chart Properties dialog.

- **Display Properties**: Select the angle of the text for the X-Axis labels.
- **Axis Range - X-Axis Range (min-max)**: These two boxes show the range of items displayed in the X-Axis.
- **Axis Range - Y-Axis Range (min-max)**: In the first box choose the value for the minimum range for the Y-Axis. The maximum range is entered in the second box.
- **Axis Zoom Range - X-Axis Range (min-max)**: Choose which range of X-Axis items to zoom in on by using these two boxes.
- **Axis Zoom Range - Y-Axis Range (min-max)**: Choose which range of Y-Axis values to zoom in on by using these two boxes.

Please Note

Changes to a chart’s properties does not apply to other charts or persist when the chart is closed and then regenerated.

Category Chart Example
An example of a Category Chart is shown below.

Please Note

Positioning your cursor over a bar on the chart will display specific information about that particular bar. The appearance and structure of your chart can be edited using the chart toolbar or the right-click menu. For more information see “Chart Toolbar” on page 379 or “Right-click Menu” on page 369.

State Chart

State Charts show stacked bar charts of location, resource, and entity states. States describe the condition of these objects.

This type of chart is useful for quickly seeing what your locations, resources, and entities spent their time doing. Such visualizations can help identify problem areas in your process.

To display a State Chart, select State Chart from the View menu or the State Chart icon from the Toolbar. As a shortcut, you can also right-click on any column of data in a report containing per-
centage values and select State Chart from the drop-down menu.
When you choose to view a State Chart, the State Chart Selection dialog will be displayed.

State Chart Selection Window

From this menu you can select the scenarios, replications, periods (only available if Batch Mean or Periodic Output Reporting is selected in the Simulation Options dialog) and state categories of the data you want displayed.

State Chart Properties
The State Chart Properties window is functionally equivalent as the Category Chart Properties window. See “Category Chart Properties” on page 382.

State Chart Example
An example of a State Chart is shown below.

This chart shows the percentage of time by scenario each location spent in the six different states: operation, setup, idle, waiting, blocked, and down.
Right click on any bar in the chart, and choose Create Pie Chart to have that item’s state information displayed as a pie chart.

Please Note

Positioning your cursor over a bar on the chart will display specific information about that particular bar. The appearance and structure of your chart can be edited using the chart toolbar or the right-click menu. For more information see “Right-click Menu” on page 369.
**Histogram**

A histogram is a bar chart showing the percentage of time or times that time plot data fell within a particular range of values.

There are two types of histograms that can be displayed:

- **Time-weighted Values**  
  Percentage of total simulation time that the values fell into a specific range. (e.g. the Contents variable of a location.)

- **Simple Values**  
  Percentage of total simulation time that a variable was within a range of values (e.g. cycle times).

**Time Weighted Values Histogram**

The time weighted values histogram shows the percentage of total simulation time the values fell into specific ranges. The example further explains how values are grouped.

**Selection Window**

Choose the scenarios and replications you would like displayed for the data item selected. Double click on an item to move it from the Available Items area to the Selected Items area or back again. You may also use the arrow buttons to move items between the two areas.

If you check the Manual Bar Width option, you may choose the range value for each bar shown in the chart. If you leave this field unchecked, 3DR will automatically calculate the range value for each bar, which will not necessarily be the value in the Bar Width field.

**Chart Properties**

Choosing the properties option for time weighted values histogram will open a window with two tabs: Data and Display

**Chart Properties: Data**

- **Display Series**: This is a list of the series data displayed in the histogram.
- **Min/Max Values**: Choose whether to display the minimum and/or maximum values for all replications in the histogram.
- **Mean/Median/Mode Values**: Choose whether to display the mean, median, and/or mode values for all replications in the histogram.
• **Percentile:** Displays the maximum value the series could reach for the chosen percentage of total simulation time. For example, if you choose to display an 80 percentile for a location’s contents, 80% of the simulation time the location’s contents were at the displayed value or less.

• **Data Properties:** Displays the time units used to calculate the histogram’s values, and optionally allows you to choose your own bar widths, which are the range of values each bar will display. Entering a smaller bar width results in more bars, while the greater the bar width the fewer bars will be displayed.

**Chart Properties: Display**

The Display tab for the time-weighted histogram properties window is functionally equivalent as the Category Chart Properties: Display window, with the exception of the “Discrete label the X-Axis” option.

• **Discrete label the X-Axis:** When this option is checked the full range of each bar is shown in the X-Axis.

See “Category Chart Properties” on page 382.

**Chart Example**

The example chart below shows the time-weighted histogram contents of a queue.

Along the X-Axis is the contents of the queue divided into bar units of 10. The Y-Axis shows the percentage of total simulation time the contents of the queue were at the values along the X-Axis.

The mouse over shows that for 18.21% of the total simulation time, for all replications, the contents of the queue were between exactly 20 and almost 30 (29.99).

The average minimum and maximum contents of the queue, for all replications, were 18 and 64 respectively, while the mean contents were 39.81. The 80% Percentile line shows that for 80% of the total simulation time the contents of the queue were 50 or less.
Chapter 10: Creating Charts

Simple Values Histogram

The simple values histogram shows when, by percentage of total simulation time, a variable’s value was within a certain range.

Selection Window

Choose the scenarios and replications you would like displayed for the data item selected. Double click on an item to move it from the Available Items area to the Selected Items area or back again. You may also use the arrow buttons to move items between the two areas.

If you check the Manual Bar Width option, you may choose the range value for each bar shown in the chart. If you leave this field unchecked, 3DR will automatically calculate the range value for each bar, which will not necessarily be the value in the Bar Width field.

Chart Properties

The chart properties for the simple values histogram are the same as for the time-weighted values histogram. See “Chart Properties” on page 384.

Chart Example

The example chart below shows the simple values histogram for the variable WIP.

The X-Axis shows the value of the WIP variable divided into bar units of 4. The Y-Axis shows the percentage of times the WIP variable fell into the ranges shown on the X-Axis.

This chart also shows the median value of the WIP value for all replications. The 80% Percentile shows that for 80% of the counts the value the WIP variable was 19 or less.
**Time Plot**

Time plots show state and performance values as they occur over time. This allows you to see trends and spikes in activity as the simulation progressed.

Time plots can only be displayed if the user has selected Time Plot as the statistics type for objects as the model was being built.

There are four types of time-plot statistics that can be displayed:

- **Time-weighted Values** Variable values weighted by time (e.g. the Contents variable of a location.)
- **Simple Values** Variable values as they change over time (e.g. cycle times).
- **State Values** Shows location states over time.
- **Counts** The number of occurrences of some particular event (e.g. the number of exits from a location).

**Time Weighted Values Time plot**

The time-weighted time plot chart shows variable values over time.

The chart’s X-Axis shows time periods, while the Y-Axis shows variable values for each time period.

**Selection Window**

Choose the scenarios and replications you would like displayed for the data items selected. Double click on an item to move it from the Available Items area to the Selected Items area or back again. You may also use the arrow buttons to move items between the two areas.

If you check the “Average data by period” box, all the values in each period of selected time will be averaged together. If left unchecked, each value will be displayed.

**Chart Properties**

Choosing the properties option for time weighted values time plot will open a window with two tabs: Data and Display

**Chart Properties: Data**

The chart properties: data for the time-weighted values time plot are the same as for the time-weighted values histogram. See “Chart Properties” on page 384.
Chart Properties: Display
The Display tab for the time-weighted time plot properties window is functionally equivalent as the Category Chart Properties: Display window, with the exception of the “Line Properties” option.

- **Line Properties:** Choose the pattern and thickness for the lines on the chart.

See “Category Chart Properties” on page 382.

Chart Example
The example chart below compares the time-weighted time plot contents of a queue for two scenarios.

The X-Axis shows the time periods for the chart. The Y-Axis shows the average content values of the queue for the time periods in the X-Axis. The One Operator scenario additionally displays the minimum and maximum contents of the queue for each time period for all replications, as well as the contents 99.99% confidence interval, which means that 99.99% of all queue contents will be within the two confidence interval lines by period.

This chart shows the impact that an additional operator has on the contents of a queue.

Simple Values Time plot
The simple values time plot shows the change in variable values over time.

Selection Window
Choose the scenarios and replications you would like displayed for the data items selected. Double click on an item to move it from the Available Items area to the Selected Items area or back again. You may also use the arrow buttons to move items between the two areas.

Choose the number of hours in each period that will be displayed along the X-Axis.

Chart Properties
Choosing the properties option for simple values time plot will open a window with two tabs: Data and Display.

Chart Properties: Data
The chart properties: data for the simple values time plot are the same as for the time-weighted values histogram. See “Chart Properties” on page 384.

Chart Properties: Display
The Display tab for the time-weighted time plot properties window is functionally equivalent as
the Category Chart Properties: Display window, with the exception of the “Line Properties” option.

- **Line Properties:** Choose the pattern and thickness for the lines on the chart.

See “Category Chart Properties” on page 382.

**Chart Example**

The example chart below compares the value of the variable “WIP” over time for two scenarios.

The Y-Axis shows the value of the WIP (work in progress) variable over the time in the X-Axis. The example shows how adding two additional resources to the demo model increases WIP and reduces the fluctuation in WIP.

**State Values Time plot**

The state values time plot shows location state statistics over time.

**Selection Window**

Choose the scenarios and replications you would like displayed for the data items selected. Double click on an item to move it from the Available Items area to the Selected Items area or back again. You may also use the arrow buttons to move items between the two areas.

**Chart Properties**

Choosing the properties option for state values time plot will open a window with two tabs: Data and Display.

**Chart Properties: Data**

The only option available from this properties window is to change the time units shown in the X-Axis.

**Chart Properties: Display**

The Display tab for the state values time plot properties window is functionally equivalent as the Category Chart Properties: Display window. See “Category Chart Properties” on page 382.
**Chart Example**

The example chart below compares the location states of a location for two scenarios.

The Y-Axis shows the state of the location for the time in the X-Axis. This example shows how adding two resource units can impact a location’s state over time.

**Counts Time Plot**

The counts time plot shows the number of occurrences of some particular event in the simulation (e.g. the throughput of an entity).

**Selection Window**

Choose the scenarios and replications you would like displayed for the data item selected. Double click on an item to move it from the Available Items area to the Selected Items area or back again. You may also use the arrow buttons to move items between the two areas. Choose the number of hours in each period that will be displayed along the X-Axis.

**Chart Properties**

Choosing the properties option for the counts time plot will open a window with two tabs: Data and Display.

**Chart Properties: Data**

The chart properties: data for the counts time plot are the same as for the time-weighted values histogram. See “Chart Properties” on page 384.

**Chart Properties: Display**

The Display tab for the counts time plot properties window is functionally equivalent as the Cat-
egory Chart Properties: Display window, with the exception of the “Line Properties” option.

- **Line Properties:** Choose the pattern and thickness for the lines on the chart.
See “Category Chart Properties” on page 382.

**Chart Example**
The example chart below compares the throughput of a pallet entity for two scenarios.

![Chart Example Image]

The X-Axis show time periods. The Y-Axis shows the throughput count for the pallet entity for the time periods in the X-Axis.
This chart shows the improvement in pallet throughput when an extra resource is added to the model.
Chapter 11: Language Elements and Expressions

Language Elements

Language elements are the smallest units of the language used to define a model’s objects and logic. Language elements include:

• Names
• Keywords
• Numbers
• Character Strings
• Operators
Names

A name or identifier is any combination (up to eighty characters long) of letters, numbers, and underscores (“_”), used to identify model elements such as locations, entities, variables, and functions. Although any valid name can refer to any object, it is best to use names which describe the object they identify (e.g., using “ClientA” to describe an entity that represents a client).

Names, like all words in ProModel, are case insensitive, meaning that ProModel sees “PARKING_A,” “Parking_A,” and “PaRkInG_a” as identical.

Names must use the following conventions:

- Names may contain the letters A through Z (upper or lower case), digits (0-9) and the underscore “_”. Names may not contain spaces. When opening an older model, ProModel flags improper use of these restricted characters.
- Do not use a digit as the first character of a name. After the first character, any character may be a digit. For example, “2Var” is an invalid name, but “V2”, is a valid name.
- Names may not be keywords, but names may contain keywords. For example, “For” is an invalid name, but “Forklift” is a valid name. Similarly, “Queue2” and “Order-Qty” are both valid.
- No matter what they identify, every name in a model must be unique. For example, you cannot name both a location and an entity “Server.” You may, however, name one “Server1” or “Server_Location” and the other “Server2” or “Server_Resource.”
Keywords

Keywords are words that ProModel reserves for special use as commands or function calls. Keywords may not be used as names, although names may contain keywords. Keywords, like all words in ProModel, are case insensitive.

<table>
<thead>
<tr>
<th>accm</th>
<th>dep</th>
<th>hr</th>
<th>ms*</th>
<th>send</th>
</tr>
</thead>
<tbody>
<tr>
<td>activate</td>
<td>dispatch*</td>
<td>if</td>
<td>off*</td>
<td>setrate</td>
</tr>
<tr>
<td>all</td>
<td>display</td>
<td>iff</td>
<td>or</td>
<td>show*</td>
</tr>
<tr>
<td>alt</td>
<td>do</td>
<td>ig</td>
<td>order</td>
<td>skip</td>
</tr>
<tr>
<td>and</td>
<td>dosload</td>
<td>in</td>
<td>ownedresource</td>
<td>snapshot*</td>
</tr>
<tr>
<td>as</td>
<td>drop*</td>
<td>inc</td>
<td>p5</td>
<td>sound</td>
</tr>
<tr>
<td>backup</td>
<td>dtleft</td>
<td>intest</td>
<td>p6</td>
<td>split as</td>
</tr>
<tr>
<td>begin</td>
<td>else</td>
<td>infinite</td>
<td>pause</td>
<td>stop</td>
</tr>
<tr>
<td>bi</td>
<td>empty</td>
<td>int</td>
<td>percentage*</td>
<td>take</td>
</tr>
<tr>
<td>board*</td>
<td>end</td>
<td>join</td>
<td>pick*</td>
<td>then</td>
</tr>
<tr>
<td>break</td>
<td>ent</td>
<td>jointly</td>
<td>preemptedres*</td>
<td>threadnum</td>
</tr>
<tr>
<td>breakblk</td>
<td>entity</td>
<td>keep</td>
<td>preemptor</td>
<td>timeleft</td>
</tr>
<tr>
<td>by</td>
<td>er</td>
<td>lifo</td>
<td>priority</td>
<td>to</td>
</tr>
<tr>
<td>cancel*</td>
<td>exit</td>
<td>load</td>
<td>prompt</td>
<td>trace</td>
</tr>
<tr>
<td>calday</td>
<td>fifo</td>
<td>loc</td>
<td>queue*</td>
<td>turn</td>
</tr>
<tr>
<td>calhour</td>
<td>first</td>
<td>log</td>
<td>random</td>
<td>ungroup</td>
</tr>
<tr>
<td>calmin</td>
<td>for</td>
<td>location</td>
<td>read</td>
<td>unload</td>
</tr>
<tr>
<td>case*</td>
<td>forlocation</td>
<td>loc</td>
<td>real</td>
<td>until</td>
</tr>
<tr>
<td>char</td>
<td>format</td>
<td>location</td>
<td>recently*</td>
<td>up*</td>
</tr>
<tr>
<td>claim*</td>
<td>forresource</td>
<td>log</td>
<td>rename</td>
<td>use</td>
</tr>
<tr>
<td>close*</td>
<td>free</td>
<td>lu</td>
<td>report</td>
<td>variable</td>
</tr>
<tr>
<td>combine</td>
<td>full</td>
<td>maparr</td>
<td>res</td>
<td>view</td>
</tr>
<tr>
<td>condition</td>
<td>geo</td>
<td>match</td>
<td>reserve*</td>
<td>wait</td>
</tr>
<tr>
<td>cont</td>
<td>get</td>
<td>min</td>
<td>reset</td>
<td>warmup</td>
</tr>
<tr>
<td>convey</td>
<td>getcost</td>
<td>mod</td>
<td>reset stats</td>
<td>while</td>
</tr>
<tr>
<td>create</td>
<td>getresrate</td>
<td>most</td>
<td>resource</td>
<td>wk</td>
</tr>
<tr>
<td>day</td>
<td>goto</td>
<td>move</td>
<td>resqty</td>
<td>write</td>
</tr>
<tr>
<td>debug</td>
<td>graphic</td>
<td>move for</td>
<td>return</td>
<td>writeln</td>
</tr>
<tr>
<td>dec</td>
<td>group</td>
<td>move on</td>
<td>route</td>
<td>xsub</td>
</tr>
<tr>
<td>default</td>
<td>hide*</td>
<td>move with</td>
<td>sec</td>
<td>xwrite</td>
</tr>
</tbody>
</table>
Numbers

ProModel uses two types of numbers: real numbers and integers. ProModel also uses a special category of integers, called “name-index numbers.” This section discusses real numbers, integers, and name-index numbers. It then discusses converting between the different types.

Integers

An integer number is a whole number ranging from -2,147,483,648 to 2,147,483,647. Integer values may not include commas. Therefore, the number 5,380 should be entered as 5380. Name-index numbers (described in this section) work just like integer numbers.

Examples of integers

-2234798
0
32

Real Numbers

A real number is any number ranging from $1.7 \times 10^{-308}$ to $1.7 \times 10^{+308}$, including decimals. Real values may not include commas. As such, the number 5,380.5 should be entered as 5380.5.

Examples of real numbers

-2.875638
844.2
65.0

Name-Index Numbers

When a simulation begins, locations, resources, and entities are all assigned numbers according to their position in their respective edit tables. The number assigned to the element is called its name-index number. For example, the third entity in the Entity edit table will have the number three for its name index number. The name of an element may be used in an expression to reference its name-index number.

For example, if EntityA were the third entity in the Entity edit table, the statement, “Attr1 = EntityA,” would assign the number three to Attr1, because attributes take numbers. Additionally, you may also test for an index number by referencing the element name with a statement like, “IF Var5 = Location3 THEN.” In fact, when using a name-index number to identify a location, resource, or entity (as in the previous examples), it is usually best to use the name of the element, because inserting or deleting an element from the edit table, may change the name-index number assigned to other elements.

If you need to refer to a location, resource, or entity by name but only know its name-index number, use the name functions: LOC(), RES(), and ENT(). These functions allow name-index numbers and variables or attributes containing name-index numbers to be converted back to their actual names for use in statements or expressions requiring the element name.

Consider the statement, “Attr1 = PASSENGER.” Although this statement only stores the name index number of the element in the attribute, the name-index number can then be used in conjunction with LOC(), ENT(), and RES() to get the actual name of the location. For example, if PASSENGER is the fifth entity in the Entity edit table, the statement JOIN 1 ENT(Attr1) works the same as JOIN 1 PASSENGER. Additionally,
a name-index number can be used with the name functions to output a name to the screen or a file.

**Converting Between Numeric Types**

When an expression expects one type of value but receives another, ProModel automatically takes care of converting between the two, so most often the difference will not matter. However, when ProModel expects an integer but receives a real value, it truncates the real value at the decimal point. For example, say the variable Integer1 is assigned the value 3.9, as in the following statement: Integer1 = 3.9. The variable Integer1 would hold the value 3, not 4. To round 3.9 when assigning to an integer variable would require the statement, Integer1 = Round(3.9).

Converting from name-index numbers to the name of an element requires the ENT(), LOC(), and RES() functions as ProModel does not automatically convert numbers to names. For information on how to output the name of an element based on its name-index number, see “String Expressions” on page 402.

**Character Strings**

A string is any collection of characters enclosed in quotes, such as “Now Boarding.” Unlike some programming languages, ProModel uses character strings exclusively for output either to a file or to the screen. Strings may contain any of the 256 ASCII characters. (ASCII characters not on the keyboard can be included in string expressions with the CHAR() function.) Strings may include keywords and names, but those keywords and names will not be executed in or used by the logic.

Additionally, the symbol “\n” can be used to divide a string into multiple lines when it is output, as in the example below.

The statement, DISPLAY “The simulation \nis half over.” displays this dialog box:

```
Display

The simulation is half over.

OK   Cancel
```

**Examples of character strings**

“EntA exited the system.”

“Location 3 is operating at capacity.”

“ProModel”

Although ProModel does not provide string variables, it does allow the names of model elements to be stored in variables and attributes as name-index numbers (see “Name-Index Numbers” on page 396). The name referenced by a name-index number may be used in statements and output to the screen or a file with the ENT(), LOC(), and RES() functions. See “String Expressions” on page 402 for more information.
Operators

Operators are symbols used to perform operations on elements in an expression. ProModel operators include Boolean operators, mathematical operators, and a string operator. Unlike reserved words, you may not use operators as any part of a name. The following sections explain the use of these operators for different expression types.

Mathematical Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>A=B+C</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
<td>A=B-C</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td>A=B*C</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>A=B/C</td>
</tr>
<tr>
<td>Mod or @</td>
<td>Modulus</td>
<td>A=B Mod C</td>
</tr>
<tr>
<td></td>
<td>(assigns the remainder of B divided by C to A)</td>
<td></td>
</tr>
<tr>
<td>**</td>
<td>Exponentiation</td>
<td>A=B**C</td>
</tr>
<tr>
<td></td>
<td>(assigns the value of B raised to the C power)</td>
<td></td>
</tr>
</tbody>
</table>

Comparison Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>TRUE if both expressions are TRUE</td>
</tr>
<tr>
<td>OR</td>
<td>TRUE if one expression is TRUE</td>
</tr>
<tr>
<td>NOT</td>
<td>Makes TRUE expressions FALSE and FALSE expressions TRUE</td>
</tr>
</tbody>
</table>

Operator Precedence

As in conventional mathematics, ProModel evaluates expressions with more than one operator according to certain rules of precedence. Expressions with more than one operator evaluate in the following order:

1. Terms inside parentheses: ( )
2. Exponentiation: **
3. Multiplication: *; Division: /; and Modulus: @
4. Addition: +; Subtraction: -
5. Equalities and Inequalities: =, <>, >, >=, <, <=
6. NOT
7. AND
8. OR
9. Concatenation: $; (For string expressions only.)

For more information and additional examples of operator precedence, see “Operator Precedence” on page 403.

Expressions

Expressions consist of a value or combination of values (even of different types), variables, attributes, functions, and operators that result in a value. Many consider an expression to be a string expression if it evaluates to a string, a numeric expression if it evaluates to a number, and so on. (For information on how to handle different value
types in the same expression, see “Converting Between Numeric Types” on page 397.)

The following are the different expression types used in ProModel:

• Numeric Expressions
• Boolean Expressions
• Time Expressions
• String Expressions

**Numeric Expressions**

A numeric expression is a combination of numeric elements (such as numbers, variables, and functions) and operators that evaluates to a numeric value.

An expression can contain any of the following in any combination:

- Arrays
- Mathematical operators
- Attributes
- Name-Index numbers
- Boolean operators
- Numbers
- Distributions
- Subroutines
- Macros
- System functions
- Math function table
- Variables

The following mathematical operators are available:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>A=B+C</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
<td>A=B-C</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td>A=B*C</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>A=B/C</td>
</tr>
<tr>
<td>Mod or @</td>
<td>Modulus</td>
<td>A=B Mod C (assigns the remainder of B divided by C to A)</td>
</tr>
<tr>
<td>**</td>
<td>Exponentiation</td>
<td>A=B**C (assigns the value of B raised to the C power)</td>
</tr>
</tbody>
</table>

You can perform additional mathematical operations using math functions. For more information on operator precedence rules and expression nesting, see “Operator Precedence” on page 403.

**Please note**

In each of the examples above, if A is an integer number and B and C are both real numbers, the
result will be truncated unless $ROUND()$ is used (e.g., $A = ROUND(B+C)$).

**Boolean Expressions**

Boolean expressions are relational comparisons between numeric expressions resulting in a value of either True or False. Boolean expressions are used most often in IF...THEN and other control statements. The following relational operators are used in Boolean expressions:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>$=$</td>
<td>Equal to</td>
</tr>
<tr>
<td>$&gt;$</td>
<td>Greater than</td>
</tr>
<tr>
<td>$&lt;$</td>
<td>Less than</td>
</tr>
<tr>
<td>$\geq$</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>$\leq$</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>$&lt;&gt;$</td>
<td>Not equal to</td>
</tr>
</tbody>
</table>

**Relational operator examples**

- $A = B$
- $A > B$
- $A < B$
- $A \geq B$
- $A \leq B$
- $A <> B$

Spacing between the terms and operators within a numeric expression is optional. However, for operators with two characters (for example, $\geq$, $\leq$, $<>$), no spaces are allowed between characters in the operator.
Additionally, the following operators compare two Boolean expressions.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>TRUE if both expressions are TRUE</td>
</tr>
<tr>
<td>OR</td>
<td>TRUE if one expression is TRUE</td>
</tr>
<tr>
<td>NOT</td>
<td>Makes TRUE expressions FALSE and FALSE expressions TRUE</td>
</tr>
</tbody>
</table>

For information on operator precedence and nesting rules, see “Operator Precedence” on page 403.

## Time Expressions

A time expression is a numeric expression followed optionally by a time unit (WK, DAY, HR, MIN, SEC) which defines a duration. If no time unit is specified, the default time unit specified in the General Information dialog box is assumed. ProModel knows whether an expression is a time expression based on the context. Time expressions are not valid within a function call. For example, E(10 sec) is invalid, while E(10) sec is valid. If a negative value is used for a time expression, it is automatically converted to zero.

### Syntax for time expressions

<numeric expression>{<time units>}

### Examples

- 2 hr
- E(10) min
- Var1+40.25 min

Note that time units cannot be mixed (e.g., 3 min 21 sec), unless you use colon notation.
Colon Notation for Time Values

Colon notation allows for more complex time expressions. You may use colon notation in the following manner to express time values.

Colon notation

\(<\text{hours expression}>:\<\text{minutes expression}>:\<\text{seconds expression}>\)

Colon notated time expressions evaluate from right to left as illustrated in the following examples:

<table>
<thead>
<tr>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>:05</td>
<td>5 seconds</td>
</tr>
<tr>
<td>5:00: or 5::</td>
<td>5 hours</td>
</tr>
<tr>
<td>5:00 or 5:</td>
<td>5 minutes</td>
</tr>
<tr>
<td>2:40:</td>
<td>2 hours and 40 minutes</td>
</tr>
<tr>
<td>15:02:05</td>
<td>15 hours, 2 minutes and 5 seconds</td>
</tr>
<tr>
<td>3:25</td>
<td>3 minutes and 25 seconds</td>
</tr>
<tr>
<td>Attr1::Var2</td>
<td>Attr1 hours and Var2 seconds</td>
</tr>
</tbody>
</table>

String Expressions

Any text to be written to a file or displayed on the screen is created with a string expression. String expressions are created from a combination of the following:

- Character strings
- Concatenation operators "$"
- Numeric Expressions
- CHAR()
- ENT()
- LOC()
- RES()
- FORMAT()

A string expression must begin with a concatenation operator ($) or with a string constant in quotes (i.e., "..."). The concatenation operator combines components together, and must be between all components of a string expression. For example, if Attr1 is 7.83, then the expression “STRING1$ ATTR1 $ STRING2” evaluates to “String17.83String2.”

To output the name of a location, entity, or resource, use the appropriate function inside a string expression: LOC() for locations, ENT() for entities, and RES() for resources. For example, the following logic checks the first ten locations in a model and displays the name of any location that is completely full.

Display name of full location

Var1 = 1
While Var1 <= 10 Do
    Begin
        If FreeCap(Loc(Var1)) = 0 Then
            DISPLAY Loc(Var1) $ “is full.”
            INC Var1
        End
    End

String expressions are valid only as part of the following statements and functions: DISPLAY,
PAUSE, PROMPT, STOP, WRITE, WRITELINE, TRACE, XSUB(), and XWRITE.

**String expressions**

If a model had been running for six days, the statement

`DISPLAY “The simulation ran \n” $ CLOCK(DAY) $ “days.”`

would display the following dialog box.

![Display dialog box](image)

**Operator Precedence**

As in conventional mathematics, ProModel evaluates expressions with more than one operator according to certain rules of precedence. Expressions with more than one operator are evaluated in the following order:

1. Terms inside parentheses: ( )
2. Exponentiation: **
3. Multiplication: *, Division: /; and Modulus: @
4. Addition: +; Subtraction: -
5. Equalities and Inequalities: =, <>, >, >=, <, <=
6. NOT
7. AND
8. OR
9. Concatenation: $; (For string expressions only.)

When evaluating more than one operator with the same precedence, ProModel works from left to right.

Arithmetic and boolean expressions may include nested expressions (expressions in parentheses) to indicate precedence in complex expressions such as the following examples:

**Nested expressions**

```
A+B*(C+D)
((A>B) OR (B>C)) AND (C>D)
```

The expression (C+D) is a nested expression which is evaluated first. Multiple nesting is permitted, with the innermost nesting being evaluated first.

**Example 1**

```
15 - MATRIX[4]**2 + CLOCK(MIN) / 60
```
In this expression, Matrix[4]**2 is evaluated first, with the result being subtracted from 15. This value is then added to the value obtained from Clock(min)/60.

Example 2

\[(A>B) \text{ OR } (A>C) \text{ AND } (A=D)\]

would evaluate

\[(A>B) \text{ OR } ((A>C) \text{ AND } (A=D))\]
Chapter 12: Routing Rules

Routing Rules

Routing rules determine the next location for the processing entity. They are specified in the “Rule” field of the Routing edit table. They may be typed manually or selected from the Routing Rule Dialog box shown below by clicking on the Rule button. For more information about routing, see “Routing Edit Table” on page 149.
Alternate

Syntax samples

ALT

Description

Causes a location to be selected as an alternate destination if it has available capacity and the condition for a preceding routing rule is not met. If the ALTERNATE location is unavailable, the entity waits until it becomes available or until the preceding routing rule is satisfied.

ALTERNATE routings are common to all primary routings, except the Probability and User Condition rules, and should therefore be listed after the last primary routing but before any backup routings.

For example, a high-speed machine might be preferred, but alternatively, a slower machine can be used when the faster machine is unavailable.

Valid In

The rule field of the Routing edit table only. An ALTERNATE routing may be specified after any other type of routing (including other ALTERNATE routings) except for BACKUP, CONTINUE and DEPENDENT routings.

Example

After Shaft completes a 3 minute operation at Drill, it routes to either Lathe1 or Lathe2 if a SEND statement somewhere in the model directs an EntA to be sent to one of those locations. If no SEND request is waiting, an alternate routing will route the entity to Lathe3. If no capacity is available at Lathe3, the entity will wait until capacity becomes available at Lathe3 or a SEND statement that matches the entity and the location in one of the SEND routings executes somewhere in the model.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shaft</td>
<td>Drill</td>
<td>WAIT 3</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Shaft</td>
<td>Lathe1</td>
<td>Send 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shaft</td>
<td>Lathe2</td>
<td>Send</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shaft</td>
<td>Lathe3</td>
<td>ALT</td>
<td></td>
</tr>
</tbody>
</table>

See Also

See the other routing rules for exceptions and special cases. Also see “Processing” on page 143.
Backup

Syntax samples

BACKUP

Description

Locations specified by this rule are selected only if all of the destinations (primary or alternate) listed in the preceding routings of the same block are unavailable due to any downtime, including a shift. One use of BACKUP is to handle a machine that is not functioning, and entities need another destination to continue.

Valid In

Inside the rule field of the Routing edit table, at the end of a routing block, after one or more primary routings or even an ALTERNATE rule. Conditions for using Backup routings with either USER CONDITION and PROBABILITY routing rules are given in the notes for these rules.

Example

After an entity, Chip, completes a 3 minute operation at CNC, it is routed to Stamp1 when Stamp1 becomes available. Only if Stamp1 and the alternate location (Stamp2) are both down will it be routed to Stamp3. If Stamp3 is also unavailable, Chip will wait for Stamp3 only as long as both Stamp1 and Stamp2 remain down.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip</td>
<td>CNC</td>
<td>WAIT 3</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chip</td>
<td>Stamp1</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chip</td>
<td>Stamp2</td>
<td>ALT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chip</td>
<td>Stamp3</td>
<td>BACKUP</td>
<td></td>
</tr>
</tbody>
</table>

See Also

ALTERNATE routing rule. Also see “Processing” on page 143.
Continue

Syntax samples

CONT 1

Description

Leaves an entity at the current location for further processing. ProModel searches the process list forward and then from the beginning until a process is found for the output entity at the current location. If the entity name remains the same and no additional processes for that entity type are defined at the location, the original process will repeat continuously unless a condition bypasses the routing block with the CONTINUE rule.

The CONTINUE routing rule also allows dynamic priority changes. This means a low priority entity that enters a location can be dynamically upgraded to a higher priority without leaving the location. Move Logic for the routing block with the CONTINUE rule will not be executed.

Neither a time value nor a movement rescue is allowed in the Move Logic column for a route block containing a CONTINUE rule. This rule is one way to route an entity from a single capacity location to the same location without causing a deadlock. The CONTINUE rule can also simulate an unlimited supply of a raw material at a location.

Statistics for a location using the CONTINUE rule are collected as one entry for the entity.

Valid In

The rule field of the Routing edit table only. A CONTINUE rule must be the only routing in a routing block and must always take a quantity of one.

Example

This example simulates an unlimited supply of ore at a location. After the Extract location extracts the Iron from the Ore, two routing blocks execute. The first routing block routes the Iron just extracted on to a molding location. The second routing block routes another unit of ore back to the location, where the process begins again.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ore</td>
<td>Extract</td>
<td>WAIT 100</td>
</tr>
<tr>
<td>Iron</td>
<td>Mold</td>
<td></td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td>Iron</td>
<td>Mold</td>
<td>FIRST 1</td>
<td>MOVE FOR 10</td>
</tr>
<tr>
<td>2</td>
<td>Ore</td>
<td>Extract</td>
<td>CONT 1</td>
<td></td>
</tr>
</tbody>
</table>
...  | ...    | ...         | ...   | ...        |

See the next example for an illustration of dynamic priority changing.

Example

Dynamic Priority Changing Suppose a gear enters a location. The gear has a low priority. If another type of gear enters the system with a higher priority, the second gear may preempt the first gear. Another worker in the plant needs the first gear immediately or else he will miss his deadline. Now the first gear’s priority is higher than the second gear. Using the CONTINUE routing rule allows you to change the priority of the first gear. An entity that enters a location with a prior-
ity 99 can increase its priority to 999 without ever leaving that location. In addition, this functionality will also allow you to specifically control which entities in a multi-capacity location will be preempted by another incoming high priority entity.

---

### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gear</td>
<td>Loc1</td>
<td>WAIT 2</td>
</tr>
<tr>
<td>Gear</td>
<td>Loc2</td>
<td>WAIT 3</td>
</tr>
</tbody>
</table>
|        |          | IF CLOCK() > 1 THEN
|        |          | BEGIN
|        |          | var = 999
|        |          | ROUTE 2
|        |          | END
|        |          | ELSE ROUTE 1 |
| Gear   | Loc2     |                |

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gear</td>
<td>Loc2, 99</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>Gear</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>2</td>
<td>Gear</td>
<td>Loc2, var</td>
<td>CONT 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Gear</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

### See Also

“Processing” on page 143.
Dependent

Syntax samples

DEP

Description

Selects a location if, and only if, the routing immediately preceding it is selected. An ALTERNATE routing which follows a dependent routing is an alternate to the last major routing preceding the dependent condition and not to the dependent routing itself.

A dependent routing should be used when one process results in two different types of entities that should go to different locations. For example, a dependent routing could simulate the separation of a customer and his or her order placed at the drive-through window at a restaurant. While the customer continues on to the cashier window, the order is sent on to the counter for fulfillment.

Valid In

The rule field of the Routing edit table only. A DEPENDENT routing may be specified after any other routing rule (including other DEPENDENT routings) except for a CONTINUE routing.

Example

After an entity named “Lamp” completes a 3-minute preparation at Prep, the paint shop will paint it. If the paint shop has capacity, the Base routes to the paint shop and the Shade routes to the Waiting area based on the dependent rule. But if the paint shop does not have capacity, the lamp stays together and routes to Storage on an alternate routing.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamp</td>
<td>Prep</td>
<td>WAIT 3</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Base</td>
<td>Painting</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shade</td>
<td>Waiting</td>
<td>DEP</td>
<td></td>
</tr>
<tr>
<td>Lamp</td>
<td>Storage</td>
<td>ALT</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See Also

“Processing” on page 143.
Empty

Syntax samples

EMPTY {<expression>}

Description

Selects a location only if it is completely empty. This routing rule is similar to the UNTIL FULL rule except that a location must be completely empty before it is initially selected. Once an empty location is selected, it continues to be selected until it is full. If no location is empty, the output waits until one becomes empty.

The EMPTY condition is designed for the situation where two or more multi-capacity locations are being filled from the same source and the modeler desires each location to completely fill and completely empty in an alternating fashion.

Valid In

The rule field of the Routing edit table only.

Components

<expression>

Total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

After EntA completes a 25 second operation at Loc1, it is routed to one of three multi-capacity locations (Loc2, Loc3 or Loc4) as soon as one becomes empty. Subsequent routings continue to the same location until it is full, and then to the next location that is empty. Once all locations are filled, no more routings occur until one of the locations becomes empty.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 25 sec</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>EMPTY 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3</td>
<td>EMPTY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc4</td>
<td>EMPTY</td>
<td></td>
</tr>
</tbody>
</table>
First Available

Syntax samples

FIRST {<expression>}

Description

Selects the first location available among one or more locations listed in a routing block. Specifying multiple First Available routings in a routing block has the same effect as specifying a First Available routing followed by one or more ALTERNATE routings. An example of using the First Available rule in a routing block is given below.

The First Available rule is the default rule when defining the initial routing in the Process Editor. In this case, the First Available routing can be interpreted to be the “primary” routing.

Valid In

The rule field of the Routing edit table only.

Components

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see the “Processing” on page 143.

Example

After EntA completes a 4 minute operation at Loc1, it is routed to Loc2, Loc3 or Loc4 depending on which location is the first to have available capacity.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 4</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3</td>
<td>FIRST</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc4</td>
<td>FIRST</td>
<td></td>
</tr>
</tbody>
</table>

See Also

“Processing” on page 143.
Join

Syntax samples

JOIN {<expression>}

Description

Selects a location whenever a JOIN request is issued at that location. Since a joining entity does not require capacity, there is no need to check for available capacity at the destination. Multiple JOIN requests are filled according to the oldest waiting request with the highest priority. Entities routed with the JOIN routing rule are not actually sent to their destination until a JOIN statement is encountered at the destination location.

Valid In

The rule field of the Routing edit table only.

Components

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

After EntA completes a 5.2 minute operation at Loc1, it routes to Loc2, Loc3 or Loc4 to join to some other entity that issued a JOIN request for an EntA.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 5.2</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>JOIN 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3</td>
<td>JOIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc4</td>
<td>JOIN</td>
<td></td>
</tr>
</tbody>
</table>

See Also

JOIN statement. Also see “Processing” on page 143.
Load

Syntax samples

LOAD {<expression>}

Description

Selects a location whenever a LOAD request is issued at the destination location. Since a loading entity does not fill capacity, there is no need to check for available capacity at the destination. Multiple LOAD requests are filled according to the oldest waiting request with the highest priority.

Valid In

The rule field of the Routing edit table only.

Components

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

After EntA completes a 3 minute operation at Loc1, it is routed to Loc2, Loc3 or Loc4 to be loaded onto some other entity that has issued a LOAD request.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 3</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>LOAD 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3</td>
<td>LOAD</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc4</td>
<td>LOAD</td>
<td></td>
</tr>
</tbody>
</table>

See Also

LOAD statement. Also see “Processing” on page 143.
Longest Unoccupied

Syntax samples

LU {<expression>}

Description

Selects one of the locations listed in a block of routings based on which has been unoccupied the longest. If several multi-capacity locations all have one or more current entities, the location with the most available capacity will be selected. If no capacity is available at any location, the first one that becomes available is selected. This rule is useful in situations where residual effects must diminish before further usage of a location (e.g., an oven cooling to an ambient temperature, the vapor clearing out of a paint booth, etc.).

Please note that this routing rule is not valid for single-capacity locations

Valid In

The rule field of the Routing edit table only.

Components

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

After EntA completes a 2.5 minute operation at Loc1, it routes to Loc2, Loc3 or Loc4 depending on the location unoccupied the longest.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 2.5</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Plane</td>
<td>Gate1</td>
<td>LU 1</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td></td>
<td>Plane</td>
<td>Gate2</td>
<td>LU</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td></td>
<td>Plane</td>
<td>Gate3</td>
<td>LU</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td></td>
<td>Plane</td>
<td>Gate4</td>
<td>LU</td>
<td>MOVE FOR 2</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>LU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3</td>
<td>LU</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc4</td>
<td>LU</td>
<td></td>
</tr>
</tbody>
</table>

See Also

“Processing” on page 143.
Chapter 12: Most Available

Most Available

Syntax samples

MOST \{<expression>\}

Description

Selects one of the locations listed in a block of routings based on which has the most available capacity. If no capacity is available at any of the locations listed, the first one that becomes available is selected. Use the MOST routing rule to equalize queues in front of workers. This rule is useful in cases where inventory levels need to be balanced among several downstream queues.

Valid In

The rule field of the Routing edit table only.

Components

\(<expression>\)

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

After EntA completes a 4 minute operation at Loc1, it is routed to Loc2, Loc3 or Loc4 depending on which location has the most available capacity at the current time.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 4</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>MOST 1</td>
<td></td>
</tr>
<tr>
<td>EntA</td>
<td>Loc3</td>
<td>MOST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EntA</td>
<td>Loc4</td>
<td>MOST</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See Also

“Processing” on page 143.
Probability

Syntax samples

<probability> {<expression>}

Description

Randomly selects a location listed in a block of routings based on a probability. Several probability routings should be used together and the sum of all probabilities must equal one. The entity will wait to be routed until the selected location has available capacity. Unlike most primary routings, an ALTERNATE and BACKUP routing may be specified after each PROBABILITY routing in a single routing block. If the selected location has no ALTERNATE routing and has no available capacity, the entity will wait for the location until it has available capacity.

Valid In

The rule field of the Routing edit table only.

Components

<probability>

The chance of the routing being taken, expressed as a decimal less than one. All probabilities in a single routing block must add up to one. This number must be a value and may not be an expression.

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

EntA completes an eight minute operation at Loc1, and routes to Loc2 80% of the time, Loc3 15% of the time, and to Loc4 5% of the time. If EntA selects Loc2 but the location has no available capacity, EntA will select an alternate location, Loc2A. If both Loc2 and Loc2A are down, EntA selects a backup location (Loc2B). Loc3 has an alternate location (Loc3A) in case it is unavailable, but has no backup location. Loc4 has neither an alternate location nor a backup location.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT8</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>.800 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc2A</td>
<td>ALT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc2B</td>
<td>BACKUP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3</td>
<td>.150</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3A</td>
<td>ALT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Claim</td>
<td>Loc4</td>
<td>.050</td>
<td></td>
</tr>
</tbody>
</table>

See Also

“Processing” on page 143.
Random

Syntax samples

RANDOM {<expression>}

Description

Randomly selects one of several available locations listed in a block of routings such that each location having available capacity is equally likely to be selected. If none of the locations listed has available capacity, the first location that becomes available will be selected.

Valid In

The rule field of the Routing edit table only.

Components

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

After EntA completes a 3 minute operation at Loc1, it is randomly routed to Loc2, Loc3, or Loc4.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 3</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>RANDOM 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc3</td>
<td>RANDOM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Loc4</td>
<td>RANDOM</td>
<td></td>
</tr>
</tbody>
</table>

See Also

PROBABILITY routing rule. Also see “Processing” on page 143.
Send

Syntax samples

SEND {<expression>}

Description

Causes an entity to remain at the current location until one of the listed destinations issues a SEND. Once a location has been selected, capacity must be available at that location before the routing actually takes place. Multiple alternative SEND destinations may be specified in a block.

Valid In

The rule field of the Routing edit table only.

Components

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

Purchase Orders (PO’s) are held at a holding location until final approval is received. Once a SEND request has been generated at some other location in the system, the PO is sent to the appropriate vendor.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO</td>
<td>Holding</td>
<td></td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PO</td>
<td>VendorA</td>
<td>SEND1</td>
<td>MOVE FOR 48 Hr</td>
</tr>
<tr>
<td></td>
<td>PO</td>
<td>VendorB</td>
<td>SEND</td>
<td>MOVE FOR 48 Hr</td>
</tr>
<tr>
<td></td>
<td>PO</td>
<td>VendorC</td>
<td>SEND</td>
<td>MOVE FOR 48 Hr</td>
</tr>
</tbody>
</table>

See Also

“Processing” on page 143.
**Turn**

**Syntax samples**

```
TURN {<expression>}
```

**Description**

Selects the locations listed in a block of routings in rotation by availability. If none of the locations listed are available, the first one that becomes available is selected. A particular location may be listed more than once in a routing block if it is to have a greater proportion of turns than the others.

**Valid In**

The rule field of the Routing edit table only.

**Components**

```
<expression>
```

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

---

**Example**

In this example, Purchase Requests (PR’s) are entered into an on-line accounting system at location Keypunch. They are then assigned on a rotating basis to Buyer1, Buyer2, or Buyer3.

<table>
<thead>
<tr>
<th>Process Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>PO</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Routing Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blk</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**See Also**

“Processing” on page 143.
Until Full

Syntax samples

FULL {<expression>}

Description

This rule continues to direct all output to the first location specified until it fills to capacity and then to the next location until it fills and so on. If all locations are full, the first one that becomes available is selected.

Valid In

The rule field of the Routing edit table only.

Components

<expression>

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

In this example, pallets are scanned at a barcode location before being placed in storage in a warehouse. The policy at the warehouse calls for keeping Aisle1 completely full before storing anything in Aisle2. Similarly, Aisle2 must be kept full before storing anything in Aisle3.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pallet</td>
<td>Barcode</td>
<td>USE Scanner FOR U(2,3,4)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pallet</td>
<td>Aisle1</td>
<td>FULL 1</td>
<td>MOVE FOR 5</td>
</tr>
<tr>
<td></td>
<td>Pallet</td>
<td>Aisle2</td>
<td>FULL</td>
<td>MOVE FOR 6</td>
</tr>
<tr>
<td></td>
<td>Pallet</td>
<td>Aisle2</td>
<td>FULL</td>
<td>MOVE FOR 7</td>
</tr>
</tbody>
</table>

See Also

“Processing” on page 143.
User Condition

Syntax samples

\(<\text{Boolean expression}>\) \{\text{<expression>}\}

Description

Selects one of several locations listed in a routing block based upon a user-defined condition. Several User-Condition routings usually are used in the same routing block. At least one of the user-defined conditions in a block must be true or an error message will appear and the simulation will terminate. Capacity must be available at the location before the routing actually takes place. Unlike most primary routing rules, an ALTERNATE or BACKUP routing may be specified after each USER CONDITION routing in the same routing block.

Components

\(<\text{Boolean expression}>\)

Any expression which evaluates to TRUE or FALSE.

\(<\text{expression}>\)

The total entities output from the process. This expression is valid only for the first routing of a routing block. For more information on this expression, see “Processing” on page 143.

Example

Customers bring their cars to a local service station for emissions testing and state inspection. After each car completes a 10-minute inspection operation at location Inspect, they are put in the proper service bay depending on the car’s engine type. Late-model (post-1975) cars are tested in Bays 1 and 2, pre-1975 cars are tested in Bay3, and diesel engine cars are tested in Bay4. If Bay1 is selected but not available, an alternate location (Bay2) is selected. If both Bay1 and Bay2 are down, a backup location (Bay3) is selected. Bay3 also has an alternate location (Bay4) in case it is unavailable, but has no backup location. Bay4 has neither an alternate location nor a backup location.

Valid In

The rule field of the Routing edit table only.
**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAR</td>
<td>Inspect</td>
<td>WAIT 10</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CAR</td>
<td>Bay1</td>
<td>IF Type=1 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAR</td>
<td>Bay2</td>
<td>ALT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAR</td>
<td>Bay3</td>
<td>BACKUP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAR</td>
<td>Bay3</td>
<td>IF Type=2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAR</td>
<td>Bay4</td>
<td>ALT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAR</td>
<td>Bay4</td>
<td>IF Type=3</td>
<td></td>
</tr>
</tbody>
</table>

**See Also**

“Processing” on page 143.
Chapter 13: Logic Elements

Functions

Functions return information such as a location’s capacity, the amount of time the simulation has been running, or a random number. A function is a keyword followed by parentheses, which may contain data that the function needs to complete its operation. You should be aware that if a function or variable expecting an integer gets a real number, it will ignore everything to the right of the decimal point.

System Functions

The following list describes the function types available in ProModel.

General System Functions

General system functions return information about the simulation, such as the length of time that the simulation has run, and may be referenced in any numeric expression.

Entity-Specific System Functions

Entity-specific system functions return information about the processing entity, such as the number of entities in an entity group. For that reason, these functions may be used only where an entity is processing some type of logic. This includes Arrival, Operation, and Location Exit logic.

Resource-Specific System Functions

Resource-specific system functions may only be used in resource node logic when a resource enters or leaves a node.

Downtime-Specific System Functions

ProModel permits you to use downtime-specific system functions only in downtime logic.

Shift & Break System Functions

ProModel allows you to use these functions only in shift and break logic.

General Functions

Math Functions

Math functions are built-in functions used for performing mathematical operations on numeric expressions.

Type Conversion Functions

When two types of numbers are used in an expression, as when a real value is assigned to an integer variable, they must all be converted to the same type before ProModel can evaluate them. ProModel performs this conversion automatically and, in most instances, this conversion will be satisfactory. The only place where the user may want to use a different conversion is when ProModel converts from a real to an integer.
When converting from a real to an integer, ProModel ignores everything to the right of the decimal point. When converting from an integer to a real, ProModel simply adds a decimal point to the integer. ProModel handles name-index numbers exactly like integers. Most often, these automatic conversion will be sufficient, but occasionally it will be necessary to convert between the types differently. For these situations, use the conversion functions.

**Statements**

Statements cause ProModel to take some action or perform some operation. Unlike functions, statements neither return a value nor use parentheses, and logic may contain comments. (See “Comments” on page 451.) Statements can use spacing (including a new line) before each word in a statement, and are case insensitive so any letter may be either upper or lower case.

**General Action and Control Statements**

General statements can be divided into two main categories: action and control statements. They are called general because they can be used in any logic. Action statements cause some action to occur in the model, such as changing an entity’s graphic or writing to a file. Control Statements determine the next statement to be executed, such as loops, branches, and statement blocks.

**Resource- and Entity-Related Operation Statements**

Operation Statements perform specific actions on entities and resources at locations throughout the system whenever they are encountered by an entity in the operation logic. They are valid only in certain areas. See each statement for a list of places where it is valid.

There are two subsets of operation statements: entity-related and resource-related. Entity-related operation statements perform specific actions on entities only. Resource-related operation statements involve resources alone (for example, GET and FREE) or resources and entities together (for example, USE).

**Statement Blocks**

A statement block is a group of statements that begin with the keyword BEGIN, or the symbol “{”, and end with the keyword END, or the symbol “}”. Two examples appear below. See BEGIN and END for more extensive examples of statement blocks.

**Statement blocks**

```
BEGIN  {  
  Statement 1  Statement 1  
  Statement 2  Statement 2  
  Statement 3  Statement 3  
  ...  ...  
  Statement n  Statement n  
  END  }
```
Distribution Functions

Distribution functions are built-in functions which, in conjunction with streams, return random values according to a statistical distribution. The following table is a summary of available distribution functions. They are valid in any numeric expression.

<table>
<thead>
<tr>
<th>Distribution</th>
<th>Syntax</th>
<th>Individual Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beta</td>
<td>B(a,b,c,d{,&lt;s&gt;})</td>
<td>a=shape value 1, b=shape value 2, c=lower boundary, d=upper boundary</td>
</tr>
<tr>
<td>Binomial</td>
<td>BI(a,b{,&lt;s&gt;})</td>
<td>a=batch size, b=probability of “success”</td>
</tr>
<tr>
<td>Erlang</td>
<td>ER(a,b{,&lt;s&gt;})</td>
<td>a=mean value, b=parameter</td>
</tr>
<tr>
<td>Exponential</td>
<td>E(a{,&lt;s&gt;,&lt;ax&gt;})</td>
<td>a=mean</td>
</tr>
<tr>
<td>Gamma</td>
<td>G(a,b{,&lt;s&gt;,&lt;ax&gt;})</td>
<td>a=shape value, b=scale value</td>
</tr>
<tr>
<td>Geometric</td>
<td>GEO(a{,&lt;s&gt;})</td>
<td>a=probability of “success”</td>
</tr>
<tr>
<td>Inverse Gaussian</td>
<td>IG(a,b{,&lt;s&gt;,&lt;ax&gt;})</td>
<td>a=shape value, b=scale value</td>
</tr>
<tr>
<td>Lognormal</td>
<td>L(a,b{,&lt;s&gt;,&lt;ax&gt;})</td>
<td>a=mean, b=standard deviation</td>
</tr>
<tr>
<td>Normal</td>
<td>N(a,b{,&lt;s&gt;})</td>
<td>a=mean, b=standard deviation</td>
</tr>
<tr>
<td>Pearson5</td>
<td>P5(a,b{,&lt;s&gt;,&lt;ax&gt;})</td>
<td>a=shape value, b=scale value</td>
</tr>
<tr>
<td>Pearson6</td>
<td>P6(a,b,c{,&lt;s&gt;,&lt;ax&gt;})</td>
<td>a=shape value 1, b=shape value 2, c=scale value</td>
</tr>
<tr>
<td>Poisson</td>
<td>P(a{,&lt;s&gt;})</td>
<td>a=quantity</td>
</tr>
<tr>
<td>Triangular</td>
<td>T(a,b,c{,&lt;s&gt;})</td>
<td>a=minimum, b=mode, c=maximum</td>
</tr>
<tr>
<td>Uniform</td>
<td>U(a,b{,&lt;s&gt;})</td>
<td>a=mean, b=half range,</td>
</tr>
<tr>
<td>User-defined</td>
<td>&lt;name&gt;{,&lt;s&gt;}</td>
<td>Name of a user-defined distribution as defined in the User Distribution section</td>
</tr>
<tr>
<td>Weibull</td>
<td>W(a,b{,&lt;s&gt;,&lt;ax&gt;})</td>
<td>a=shape value, b=scale value</td>
</tr>
</tbody>
</table>

General Components

<s> The optional stream to use in conjunction with the distribution’s probabilities. If this option is omitted, ProModel will use stream one. For more information on streams, see “Streams” on page 258.

<ax> An optional axis shift. The distributions, E, G, W, L, IG, P5, and P6 all normally have a minimum value of zero. Use an axis shift to alter the distribution’s minimum value and at the same time shift the entire distribution. Any time an axis shift is specified, a stream must be specified also. Any negative value returned by a distribution that is used for a time expression will be automatically converted to zero.
Priorities

Many statements in this manual use <priority> as a component. A priority determines the order in which competing commands are fulfilled. For example, priority determines which of two competing requests to USE a resource gets fulfilled, or which of two competing requests to SEND the same entities to different locations gets fulfilled. Commands or entities with high enough priority can even bring back up locations that are down, or force a location to stop processing one entity and process another instead. This is called “preemption.” All priorities must be an expression that evaluates to a number between 0 and 999.

For a complete explanation of priorities and preemption, see “Location Priorities and Preemption” on page 105, “Resource Shift Downtime Priorities” on page 134, “Preemptive Entities” on page 115, and “Preemption Process Logic” on page 292.
Chapter 14: Statements and Functions

Accum

Entity-Related Operation Statement

Syntax samples

ACCUM <expression>
ACCUM 10
ACCUM Var1

Description

Accumulates, without consolidating, the specified quantity of entities at a location. ACCUM works like a gate that prevents entities from processing until a certain number arrive. Once the specified number of entities have accumulated, they will go through the gate and begin processing individually, independent of each other.

ACCUM can be used to model situations where several entities should be accumulated before they get processed. For example, when a resource processes orders at a work station, it may be more efficient to accumulate several orders before requesting the resource.

If you specify an ACCUM operation in a process for an individual entity, accumulation will occur by individual entity type. However, if you specify ALL as the processing entity, all entity types at that location will participate in the same accumulation.

Valid In

The operation column of process edit tables only. ACCUM must be used at a location with enough capacity to accumulate the specified quantity.

Components

<expression>

The number of entities to accumulate. If this expression results in zero or one, it is ignored. If it results in a number greater than the location’s capacity or a negative number, the simulation will stop with an error.

This expression is evaluated every time an entity to be accumulated arrives, so the quantity to be accumulated can vary as the entities to be accumulated arrive. If an entity arrives that changes this expression to a number lower than the number of entities already accumulated, all of the accumulated entities begin to process.

Example

Entities named “Pallet” arrive at a location named “Loading” and accumulate in batches of 20. Entities named “Box” also arrive at Loading and accumulate in batches of 10. Only after the right number of boxes or pallets accumulates does ProModel request the forklift. The accumulation of Boxes and Pallets at Loading is entirely independent because the accumulation state-
ments are in different records. Note that the forklift is used for two minutes per pallet or box, because each pallet and box process individually after accumulating all of them. While the accumulation of entities at Loading is by entity type, the accumulation at the location, “Storage” is independent of entity type since the ALL keyword denotes common processing for all entities at this location.

### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pallet</td>
<td>Loading</td>
<td>ACCUM 20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USE Forklift FOR 2</td>
</tr>
<tr>
<td>Box</td>
<td>Loading</td>
<td>ACCUM 10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USE Forklift FOR 2</td>
</tr>
<tr>
<td>ALL</td>
<td>Storage</td>
<td>ACCUM 30</td>
</tr>
</tbody>
</table>

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pallet</td>
<td>Storage</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
<tr>
<td>1</td>
<td>Box</td>
<td>Storage</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
<tr>
<td>1</td>
<td>ALL</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

### See Also

COMBINE, JOIN, and GROUP.
Activate

General Action Statement

Syntax samples

ACTIVATE <subroutine>({parameter1},<parameter2>...})
ACTIVATE Sub1()

Description

Starts an independent subroutine. The calling logic then continues without waiting for the called subroutine to finish. Therefore, independent subroutines can run in parallel with the logic that called them. Independent subroutines are not entity or location dependent and run without regard to what happens inside the logic that called them.

Use ACTIVATE to process logic that has WAIT or WAIT...UNTIL statements when you do not want to use an entity to process the WAIT or WAIT...UNTIL statements. For example, an ACTIVATE in the initialization logic could call a subroutine that adjusts the arrival frequency for a type of entity depending on the time of day.

Independent subroutines called with ACTIVATE cannot use entity-specific or location-specific system functions. If the subroutine has a return value, then that value is ignored. External subroutines cannot be called with ACTIVATE, although they may be called from within an activated subroutine.

Valid In

Any logic.

Components

<subroutine>

The name of the subroutine to run. This name should appear exactly as if the subroutine were being called normally. Any return value for this function is ignored. See “Subroutines” on page 238.

<parameters>

The parameters that the subroutine normally takes.

Example

This example uses ACTIVATE in a model’s initialization logic to start a subroutine named Res_Log(). Res_Log() is a user-defined subroutine that logs every time that all units of a resource named Worker are in use. After it logs the time that all units were busy, it waits ten minutes to check again. Note that the WHILE...DO loop in the subroutine is never exited. This technique allows the subroutine to run during the entire simulation.

Initialization Logic:

Activate Res_Log()

Res_Log()

INT X = 1
WHILE X = 1 DO
BEGIN
IF FREEUNITS(Worker)=0
THEN LOG "All workers busy at ",0
WAIT 10
END

See Also

XSUB(). Also see “Subroutines” on page 238.
Animate

General Action Statement

Syntax samples

ANIMATE <expression>
ANIMATE 70
ANIMATE Var1

Description

Sets the simulation’s animation speed. The higher the value, the faster the animation. ANIMATE is used primarily to speed up or slow down a model for cursory or detailed observation whenever a particular condition is encountered. Another common use is to set the animation speed to one-hundred in the Initialization Logic to rapidly advance the simulation to some point in time.

Valid In

Any logic.

Components

<expression>

The new speed of the animation. This expression can be any number from 0 to 100 and is evaluated every time the ANIMATE statement is encountered. The default speed is 56.

Example

This example shows the use of the ANIMATE statement in the downtime logic for the location Press. Whenever Press goes down for service, the animation speed is slowed to 30 percent of maximum. This allows the modeler to more easily view which resource (RES1 or RES2) is captured to service the location.

See Also

GRAPHIC and SOUND.
ArrayDims()

General System Function

Syntax samples

ARRAYDIMS(<arrayname>)
ARRAYDIMS(MyArray)

Description

Returns the number of dimensions in an array.

Valid In

Any Logic

Components

<arrayname>

The name of the array for which you wish to know the number of dimensions.

See Also

ArrayDimSize().
Chapter 14:
ArrayDimSize()

ArrayDimSize()

General System Function

Syntax samples

ARRAYDIMSIZE(<arrayname>, <dim_num>)
ARRAYDIMSIZE(MyArray, 2)

Description

Returns the size of a dimension in an array. You must provide the name of the array and the particular dimension of the array for which you want to know the size.

Valid In

Any Logic

Components

<arrayname>
The name of the array.
<dim_num>
The number of the dimension for which you wish to know the size.

See Also

ArrayDims().
Assignment Statement

Syntax samples

<variable, array element, or attribute> = <numeric expression>

Description

Assigns the value of a numeric expression to a designated variable, array element, or attribute.

Valid In

Any Logic

Example

Var1 = 300
Attr2 = Clock(hr) - Attr3

Please Note

If you assign an expression that evaluates to a real number to a variable, array, or attribute of type integer, the number truncates unless you use the ROUND() function.
Begin

General Control Statement

Syntax samples

BEGIN or {

WHILE FREECAP(Loc1) > 5 DO
    BEGIN
        INC Var2, 5
        WAIT 5 sec
    END

IF Var1 > 5 THEN
    {
        INC Var2, 5
        WAIT 5 sec
    }

Description

Defines a statement block with a corresponding END statement. BEGIN and END are almost always used in conjunction with other control statements such as IF...THEN and DO...WHILE. Every BEGIN statement must pair with an END statement.

Valid In

Any logic.

Example

Compare the following logic examples:

The example below includes a BEGIN and END statement. In this logic, if the attribute Attr1 equals one, ten entities are ordered and the variable Var1 increments. ProModel executes the statements within the BEGIN and END only if Attr1 equals one.

IF Attr1 = 1 THEN
    BEGIN
        ORDER 10 EntA
        INC Var1
    END

Just as in the logic above, if Attr1 in the following example equals one, ten entities are ordered. However, Var1 increments regardless of the value of Attr1. The IF...THEN applies only to the very next statement, no matter how you format the logic.

IF Attr1 = 1 THEN
    ORDER 10 EntA
    INC Var1

See Also

END, IF...THEN...ELSE, DO...WHILE, WHILE...DO, and DO...UNTIL.
Break

General Control Statement

Syntax samples

BREAK

Description

Exits the innermost WHILE...DO, DO...WHILE, or DO...UNTIL loop. The next statement to be executed will be the one immediately following the END statement associated with the innermost loop. If a BREAK is encountered outside any loop, then ProModel exits the entire logic.

Valid In

Any logic.

Example

Normally, a WHILE...DO loop repeats a statement block until a certain condition becomes false. This example shows the use of a BREAK statement to exit the loop based on a condition not included in the WHILE...DO loop. As long as the variable V1 is less than three and the variable V3 is less than or equal to five, both the three-minute wait and the five-minute wait will be executed for a total of eight minutes. However, if V3 becomes greater than five, the total wait will be six minutes: three minutes in the main part of the loop and another three minutes inside the IF...THEN statement block. The five minute wait will not be executed because the BREAK statement exits the loop entirely.

The line “//Break to here” is a comment that marks the next line of logic executed after the BREAK.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claim</td>
<td>Station1</td>
<td>WHILE V1&lt;3 DO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEGIN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT 3 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IF V3&lt;=5 THEN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEGIN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT 3 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BREAK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>END</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT 5 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>END</td>
</tr>
<tr>
<td></td>
<td></td>
<td>//Break to here</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Station2</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

BREAKBLK.
BreakBlk

General Control Statement

Syntax samples

BREAKBLK

Description

Exits from the innermost statement block. The next statement to be executed will be the one immediately following the END statement of the innermost statement block. If a BREAKBLK is executed outside any statement block, ProModel will exit the logic completely.

Valid In

Any logic.

Example

This example uses BREAKBLK in the logic for a shipping department that handles two types of entities, Letters and Packages. Both packages and letters need to be addressed, but packages may need to be wrapped before they are addressed. When a package arrives, shipping increments the variable No_of_Pkg to keep track of the number of packages it ships. Attr1 is then checked to see if the package has been wrapped. If the package has been wrapped (if Attr1 = 1), the BREAKBLK statement exits the statement block that wraps packages. If the package has not been wrapped, a resource, Wrapper, wraps the package. Finally, all entities that Shipping processes are addressed by the same statement and routed to the location Post_Office. The line “// Breakblk to here” is a comment which marks the next statement executed after the BREAKBLK.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Shipping</td>
<td>IF ENTITY() = Letter THEN INC No_of_Let IF ENTITY() = Pkg THEN BEGIN INC No_of_Pkg IF Attr1 = 1 THEN BREAKBLK USE Wrapper FOR 8 Attr1 = 1 END //Breakblk to here USE Addresser FOR 3</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALL</td>
<td>Post_Office</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

BREAK.
**CalDay()**

**General System Function**

**Syntax samples**

```plaintext
CALDAY()
```

**Description**

The CALDAY() function corresponds to the weekday of the calendar date you defined as part of the warm-up period or simulation begin date under simulation options. Since CALDAY() resets with the advent of a new week, every weekday will return the same value (i.e., Wednesday will always return a value of 3).

**Valid In**

Any logic.

**Please note**

*CALDAY() works only when you select calendar date in the simulation options dialog.*

**Example**

Suppose that shipment arrival types vary from day to day. Since Monday’s Shipment_Type_A arrival patterns are unique, you will need to use a distribution specific to those patterns.

```plaintext
IF CALDAY()=1 THEN
    BEGIN
        Shipment_Type_A = Monday_Distribution_A
        USE Forklift FOR Unload_Time
    END
```

**See Also**

CALDOM(), CALHOUR(), CALMIN(), CALMONTH(), and CALYEAR().
CalDOM()

General System Function

Syntax samples

CALDOM()

Description
The CALDOM() function corresponds to the calendar day of the month you defined as part of the warm-up period or simulation begin date under simulation options. Values returned by this function will be integers in the range of 1 to 31.

Valid In
Any logic.

Please note

CALDOM() works only when you select calendar date in the simulation options dialog.

See Also
CALDAY(), CALHOUR(), CALMIN(), CALMONTH(), and CALYEAR().
CalHour()

General System Function

Syntax samples

CALHOUR()

Description

The CALHOUR() function corresponds to the hour of the calendar date you defined as part of the warm-up period or simulation begin date under simulation options. Since this function ties directly to the 24-hour clock displayed on the screen during simulation, CALHOUR() will never return a value higher than 23.

Valid In

Any logic.

Please note

CALHOUR() works only when you select calendar date in the simulation options dialog.

Example

The following example implements a change in personnel used to perform an operation. After the simulation runs for 18 hours, the technician becomes available to perform the activity.

IF CALHOUR() > 18 THEN
USE Worker FOR N(10,4)
ELSE USE Technician FOR N(8,2)

See Also

CALDAY(), CALDOM(), CALMIN(), CALMONTH(), and CALYEAR().
CalMin()

General System Function

Syntax samples

CALMIN()

Description
The CALMIN() function corresponds to the minute of the calendar date you defined as part of the warm-up period or simulation begin date under simulation options. Since this function ties directly to the 24-hour clock displayed during simulation, CALMIN() will never return a value higher than 59.

Valid In
Any logic.

Please note
CALMIN() works only when you select calendar date in the simulation options dialog.

Example
Suppose parts have a fixed shipping time of 4:30 PM. The following logic would order parts to the shipping area.

IF CALHOUR() = 16 AND CALMIN() = 30 THEN
ORDER 1 Part TO Shipping_Area

See Also
CALDAY(), CALDOM(), CALHOUR(), CALMONTH(), and CALYEAR().
CalMonth()

General System Function

Syntax samples

CALMONTH()

Description

The CALMONTH() function corresponds to the month of the year you defined as part of the warm-up period or simulation begin date under simulation options. Values returned by this function will be integers in the range of 1 to 12.

Valid In

Any logic.

Please note

CALMONTH() works only when you select calendar date in the simulation options dialog.

Example

If CalMonth()=12 THEN WAIT 20
Else Wait 10

See Also

CALDAY(), CALDOM(), CALHOUR(), CALMIN(), and CALYEAR().
CalYear()

General System Function

Syntax samples

CALYEAR()

Description

The CALYEAR() function corresponds to the year of the calendar date you defined as part of the warm-up period or simulation begin date under simulation options.

Valid In

Any logic.

Please note

CALYEAR() works only when you select calendar date in the simulation options dialog.

See Also

CALDAY(), CALDOM(), CALHOUR(), CALMIN(), and CALMONTH().
Cap()

General System Function

Syntax samples

CAP (<location>)
GROUP CAP(Loc1)

Description

Returns the total capacity of a location. CAP() can be used to prepare a batch of entities to fill a location.

Valid In

Any logic and any expression evaluated after translation. For a list of expressions evaluated after translation, see the “Appendix A” on page 577.

Components

<location>

The name of the location to examine. If this component is the name of a multi-unit location, CAP() will return the capacity of the entire location. For example, if each unit of a five-unit location has a capacity of five, CAP() will return twenty-five. This component can also be the name of an individual unit in a multi-unit location.

Example

The individual ovens of a ceramics plant have different capacities, but otherwise they are exactly the same. While each oven could be modeled as an individual location, it would be easier to model this situation as a multi-unit location. This example uses CAP() in the processing logic of the parent location to accumulate enough Sinks to fill each oven. The LOCATION() function returns the value of the current location.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sink</td>
<td>Oven</td>
<td>ACCUM CAP(LOCATION())</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sink</td>
<td>Cool</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

FREECAP(), LOC(), and LOCATION().
Char()

String Function

Syntax samples

CHAR(<expression>)
CHAR(10)

Description

Returns the ASCII character for the number that the expression evaluates to. This function is most useful for outputting ASCII characters that cannot be typed, such as accented characters. This function is most often used in conjunction with a string expression and the concatenation (“$”) operator.

The number corresponding to the ASCII character varies with each computer depending on the character set specified in the config.sys file of your computer. To determine the number corresponding to the ASCII character at your computer, run the model CHAR.MOD found in the MODELS\REFS directory. View the file this model generates called CHAR.TXT found in the same directory as the model.

Valid In

Any string expression.

Components

<expression>

Any expression that evaluates to a number between 0 and 255. The expression is evaluated every time the CHAR() function is encountered.

Example

The logic below displays the combined cost of all the Parts ordered through a particular service center. The simulation has kept a tally of all the parts it has ordered in the variable Parts, and each part cost 25 English pounds. The logic displays the cost of the parts with the pound symbol (£), which is ASCII code 156.

DISPLAY “Total cost of parts:” $ CHAR(156) $ Parts * 25

See Also

“String Expressions” on page 402.
Clock()

General System Function

Syntax samples

CLOCK({<time unit>})
IF CLOCK(DAY) >= 1.5 THEN PAUSE
Attr1 = CLOCK()

Description

Returns value of the elapsed simulation time in the units specified. Clock units should be kept consistent when comparing values. If an attribute has been assigned a time in minutes, any time value compared with that attribute should also be in minutes.

When no units are specified in the parentheses in the clock function, ProModel returns the default time unit specified in the General Information.

Valid In

Any logic and most fields, except those fields evaluated at translation. For a list of fields evaluated at translation, see the “Appendix A” on page 577.

Components

<time unit>

The elapsed simulation time will be returned in this unit. This may be HR, MIN, SEC, DAY, WK. If omitted, the value returned will be in the default time units as specified in the General Information dialog box. When using CLOCK() to capture a time for later use with the LOG statement, the units should be omitted.

See Also

“General Information” on page 171 and “Time Expressions” on page 401.
Close

General Operation Statement

Syntax samples

CLOSE <file ID>
CLOSE Arrival_File
CLOSE ALL

Description

Closes a file that has previously been written to with WRITE, WRITELINE, XWRITE, or read with READ. Use CLOSE when finished with a file to free system resources. A file will automatically be re-opened to be read or written if it has been closed. All opened files are automatically closed at the end of a simulation. When you are using many external files and you want to conserve system resources, this statement is especially helpful.

Valid In

Any logic.

Components

<file ID>

The file ID of the desired file as defined in the External Files editor.

See Also

READ, WRITE, WRITELINE, XWRITE, and RESET.
Combine

Entity-Related Operation Statement

Syntax samples

```
COMBINE <expression> {AS <new entity name>}
COMBINE Var1
COMBINE 3 AS EntQ
COMBINE Var1 as ENT(Attr1)
```

Description

Accumulates and consolidates a specified quantity of entities into an entity, optionally with a different name. Unlike the GROUP statement, combined entities lose their identities and attributes and cannot be ungrouped later. Use COMBINE when several entities need to be combined, such as when eight spark plugs are combined in a box. Note that after several entities have been combined at a location, no additional statistics will be collected for any of the combined entities at that location.

When specifying COMBINE <expression> AS <new entity name> in the operation logic, there must be another operating block at the same location. In this case, the incoming entity at the new operating block is the new entity name specified in the COMBINE statement.

Valid In

Operation logic only. COMBINE may not be used in combination with CREATE, GROUP, UNGROUP, LOAD, UNLOAD, SPLIT AS, or other combine statements in the same process logic.

Components

```
<expression>
```

The number of entities to combine. Negative values generate an error message. If this expression evaluates to zero, it is ignored. If it evaluates to one, then no entities are actually combined, but the entity that encountered the combine statement is renamed (if the AS option has been specified).

This expression is evaluated every time an entity encounters the COMBINE statement, so the amount of entities to be combined can vary as the simulation progresses. If an entity arrives that changes this expression to a number lower than the number of entities already waiting to be combined, all of the entities waiting to be combined are combined, including the entity that just arrived.

```
AS <new entity name>
```

The optional name of the resulting entity. If left off, the new entity will have the same name as the last combined entity or the output entity name.

Explicit Entity Actions

COMBINE passes cost on to new entities but not statistical information. ProModel counts combined entities as exits.
Example

A manufacturing plant makes computer motherboards. After manufacture and inspection, when the motherboards are ready for shipping, workers combine them into sets of twenty to distribute to the company’s customers. A COMBINE statement will work well for this example, because workers do not inspect or use the individual motherboards again. At the final assembly location, workers group motherboards into totes of twenty, and route the totes to the shipping department.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>mboard</td>
<td>Assembly</td>
<td>COMBINE 20</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tote</td>
<td>Shipping</td>
<td>FIRST</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

GROUP, ENT(), ACCUM, and LOAD. Also see the “Attributes” on page 217.
**Comments**

**Documentation Symbols**

**Syntax samples**

```
#
//
/*...*/
```

**Components**

#

The pound sign signals the start of a one-line comment. ProModel will ignore any characters on the rest of the line.

//

Two forward slashes signal the start of a one-line comment. ProModel will ignore any characters on the rest of the line. This symbol works exactly the same as the # sign.

/*...*/

A slash followed by an asterisk signals the start of a multi-line comment. ProModel will ignore all characters after the "/*" until it finds an asterisk followed by a slash, "*/". Use this type of comment for long explanations and to prevent ProModel from executing long portions of logic during debugging. Comments using // or # may be nested inside multi-line comments.

**Description**

Comments are notes to the modeler inside blocks of logic. ProModel ignores them, but they can be particularly useful to explain logic when more than one person will be using a model.

**Valid In**

Any logic.

**Example**

The logic below has several notes to explain it. Additionally, ProModel ignores the ELSE statement and the ELSE statement’s block.

```plaintext
IF Parts_Available > Attr2 THEN
//Parts needed is stored in attribute 2
BEGIN
JOIN Attr2#Join the number of parts
# needed only if there are
# enough parts available.
WAIT Attr1
END
/* ELSE
BEGIN//Start operation
INC Var1
WAIT Attr3
END */
```

```
### Contents()

**General System Function**

**Syntax samples**

CONTENTS(<location>{,<entity type>})
LOAD CONTENTS(Loc1)
JOIN CONTENTS(Loc1, EntA) EntA

**Description**

Returns either the total number of entities at a location or the number of a certain type of entity at a location. Use CONTENTS() to make decisions based on how busy a location is. Using CONTENTS() to keep track of the number of entities at a location requires fewer steps and allows more flexibility than using variables to count the number of entities that enter and exit a location. For example, the second syntax does in one statement what would require several statements without the CONTENTS() function.

**Valid In**

Any logic and all fields except those fields evaluated at translation only. For a list of the fields evaluated only at translation, see the “Appendix A” on page 577.

**Components**

<location>

The name of the location to examine.

<entity type>

The optional name of the type of entity to look for. If omitted, CONTENTS() will return the total of all entities at the location.

### Example

An assembly line has a location called Clean that often gets too busy for one operator to handle and the supervisor then comes to help. The processing logic below models this situation with an IF...THEN statement and the CONTENTS() function. As long as the location contains fewer than five entities, a worker processes any arriving entities. However, if the location’s contents are greater than five, the Supervisor processes them.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Clean</td>
<td>IF CONTENTS(Clean)&lt;5 THEN USE Worker FOR 10 ELSE USE Worker FOR 10 OR Supervisor FOR 10</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALL</td>
<td>Mold</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

**See Also**

FREECAP(), LOC(), ENT(), and FREEUNITS().
Create

Entity-Related Operation Statement

Syntax samples

CREATE <expression1> {AS <entity name>}
   {TAKE {<expression2>} <resource>,...}
CREATE 10 AS EntX
CREATE 2 AS EntB TAKE 1 Res1, 2 Res2
CREATE Var1 AS Ent(Var2) TAKE Var3 Res(Var4)

Description

Creates a specified number of entities in addition to the original entity and copies all attributes of the original entity to each new entity. The first entity created can optionally take any of the resources owned by the parent entity. The newly created entities require no additional capacity at the location and are processed immediately.

The CREATE statement can simulate the creation of paperwork that needs to be hand-carried to another location to be approved while the base entity continues to process. Before the base entity can exit the location, the paperwork must be approved and routed back to the original location where it is joined to the base entity.

Valid In

The operation column of process edit tables only. CREATE may not be used in combination with LOAD, UNLOAD, GROUP, UNGROUP, SPLIT AS, or other CREATE statements in the same processing logic.

Components

<expression1>

The number of new entities to create. This expression is evaluated every time the create statement is encountered.

AS <entity name>

The name of the new entities. ProModel will search the process list for the new entity type and begin processing them before it finishes processing the entity that created them. If omitted, the entities will be named the same as the currently processing entity.

TAKE <expression2>

The first created entity will take any resources listed here from the parent entity. This component is optional. The second syntax example above creates two EntB’s. The first of the two will own one unit of Res1 and two units of Res2.

<resource>

The name of the resource whose ownership should be transferred to the first new entity. Using the keyword ALL here will take all resources owned by the parent entity.

Explicit Entity Actions

The CREATE statement forms a new entity with new statistical information and cost. ProModel adds an initial cost to explicitly created entities (i.e., entities created with the CREATE statement).

Implicit Entity Actions

ProModel allows you to use the CREATE statement implicitly as part of the routing definition. To do this, define a route block and check the New Entity option. ProModel does NOT add an initial cost to implicitly created entities.
Example

The following example shows how one entity, Record, creates two new entities. Note that there is no routing defined in this process for the new entities, Copy. The new entities are handled according to the logic defined in the subsequent process.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Station1</td>
<td>WAIT N(8,.3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CREATE 2 AS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Copy</td>
</tr>
<tr>
<td>Copy</td>
<td>Station1</td>
<td>WAIT U(3,.3)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record</td>
<td>Station2</td>
<td>FIRST</td>
<td>MOVE FOR 5</td>
</tr>
<tr>
<td>1</td>
<td>Copy</td>
<td>File_Cab</td>
<td>FIRST</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

ORDER, SPLIT AS, ENT(), and RES().
Debug

General Action Statement

Syntax samples

DEBUG

Description
Brings up ProModel’s debugger. Use DEBUG to step through logic one statement at a time and examine variable and attribute values while developing a model. After a model is working, DEBUG statements are generally removed.

Valid In
Any logic.

Example
If you were having trouble with a Client’s logic at a particular location, we could start the processing logic with a DEBUG statement, as in the following example. This would allow you to watch each Client’s logic execute, statement by statement, revealing problems with the logic’s flow.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Recep</td>
<td>DEBUG IF Attr1=1 THEN GRAPHIC WAIT 5 min</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Client</td>
<td>Waiting</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

During run time, the ProModel debugger would appear displaying the following information:

See Also
“Debug Option” on page 347.
Dec

General Operation Statement

Syntax samples

DEC <name>{, <expression>}  
DEC Var1  
DEC Attr1, 5

Description

Decrements a variable, array element, or attribute by the value of a specified numeric expression. To decrement a variable, attribute, or array element when the current entity actually leaves a location, use DEC in the move logic.

Valid In

Any logic.

Components

<name>

Any variable, array element, or attribute.

<expression>

The amount to decrement the value. If this expression is omitted, the value will be decremented by one. This can be a negative number.

Example

The example below shows two variables decremented in exit logic. The variable Num_in_system is decremented by one, while variable Var3 is decremented by 20.

See Also

INC. Also see “Numeric Expressions” on page 399.
Display

General Action Statement

Syntax samples

DISPLAY <string expression>
DISPLAY “Var1 =” $ Var1 $ “and Attr1 =” $ Attr1
DISPLAY “Now beginning 100th process”
DISPLAY Number_in_Queue

Description
Pauses the simulation and displays a message. The simulation will resume when the user selects OK. The concatenation operator ($) should be used to combine a numeric value into the string (as in the first syntax example above). Using the ENT(), LOC(), and RES() functions will display the name of the entity, location, or resource.

Valid In
Any logic.

Components

<string expression>
The message to be displayed. To display a numeric value, use the concatenation operator ($) as in the first syntax example.

Example

This simple example displays the value of both Var1 and of Attr1 if Attr2 is 1. This logic will display the dialog box below if Attr2 is 1. If Attr2 is not 1, an error message will appear.

Operation (min)

IF Attr2=1 THEN
DISPLAY “Var1 =” $ Var1 $ “and Attr1 =” $ Attr1
ELSE
DISPLAY “Error”

Please note

The “\n” character starts new lines.

See Also

PROMPT, PAUSE, CHAR(), and FORMAT().
Do...Until

General Control Statement

Syntax samples

DO <statement block> UNTIL <Boolean expression>

DO INC Var1 UNTIL Array1[Var1] <> 10

DO
BEGIN
INC Var2, 5
WAIT 5 sec
END
UNTIL FreeCap(Loc1) > 5

Description

Repeats a statement or statement block continuously while a condition remains false. DO...UNTIL is an exit-condition loop, meaning that the loop will always be executed at least once. Use DO...UNTIL when an operation will always be executed at least one time and possibly more times.

Valid In

Any logic.

Components

<statement block>

The statement or block of statements to execute.

<Boolean expression>

As long as this expression is FALSE, the loop will continue. This expression is evaluated for each iteration of the loop.

Example

A machining station can manufacture parts of increasing complexity from the same entity, called a Blank. When a Blank arrives at the station, the value stored in Attr1 determines the complexity of the part and the amount of time needed to create the new part. The following logic models this situation with a DO...UNTIL loop. All blanks that arrive go through a five minute processing time, and then go through the operation several more times depending on the value of Attr1.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>Machining</td>
<td>INT Count = 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DO</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEGIN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT 5 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INC Count</td>
</tr>
<tr>
<td></td>
<td></td>
<td>END</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UNTIL Count = Attr1</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Base</td>
<td>Painting</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>
Do...While

General Control Statement

Syntax samples

DO <statement block> WHILE <Boolean expression>

DO INC Var1 WHILE Array1[Var1] <> 10

DO
   BEGIN
      INC Var2, 5
      WAIT 5 sec
   END
WHILE FreeCap(Loc1) > 5

Description

Repeats a statement or statement block continuously while a condition remains true.
DO...WHILE is an exit-condition loop, meaning that the loop will always execute at least once.
Use DO...WHILE for processes that must be executed one time and possibly more.

Please note

Use caution when using a DO...WHILE with a system function (e.g., FREECAP()) to ensure that the system does not enter an infinite loop. For example, eliminating the “WAIT 5 sec” in the syntax sample will cause the system to enter an infinite loop because there is no time delay within the loop.

Valid In

Any logic.

Components

<statement block>
The statement or block of statements to execute.

<Boolean expression>
As long as this expression is TRUE, the loop will continue. This expression is evaluated for each iteration of the loop.

Example

The logic below orders a minimum of ten cases to location Receiving every time it is encountered. As long as the location has a capacity greater than ten, it will send additional sets of ten entities to the location.

DO
   ORDER 10 Cases to Receiving
   WHILE FREECAP(Receiving) > 10

See Also

BEGIN, END, DO...UNTIL, and WHILE...DO.
Down

Downtime-Specific System Function

Syntax samples

DOWN <dtname>, {<priority>}

Description
Makes a location, with the specified called downtime, attempt to go down.

This statement is used in conjunction with the Called Downtime dialog, where you have previously defined the called downtime’s name, priority, and logic.

When this statement is executed, the called downtime will attempt to execute its logic. The timing of the execution of the called downtime’s logic will depend on the location’s state and the called downtime’s priority.

Valid In
Any logic, except Initialization and Termination logic.

Components

<dtname>
The name of the called downtime. This name is defined in the Called Downtime dialog, found in the Locations table.

<priority>
You may optionally define a priority. This will override the priority you defined in the Called Downtime dialog for the specified called downtime.

Please Note
The DOWN statement does not need to be called from the processing logic at the location that is to go down. It can be called from any logic in your model, except Initialization and Termination logic, and still cause the location’s Called Downtime to execute.

See Also
“Called Downtime Editor” on page 105, and “Location Priorities and Preemption” on page 105.
DownQty()

General System Function

Syntax samples

DOWNQTY(<location> or <resource>)
IF DOWNQTY(Loc1) > 3 THEN ROUTE 2
DISPLAY “Total Res1 Down Now:” $ DOWNQTY(Res1)

Description

Returns the number of location or resource units down at the time of the call. Use this function to make decisions based on how many resource or location units are down. For example, if too many units are down, a foreman could preempt several units back into service.

Valid In

Any logic and all fields except those fields evaluated at translation only. For a list of the fields evaluated only at translation, see the “Appendix A” on page 577.

Components

<location>

The name of the location to examine. LOC() can be substituted for the name of a location.

<resource>

The name of the resource to examine. RES() can be substituted for the name of a resource.

Example

Two resources, Welders, weld brackets onto steel frames at a location, Man_Weld, in 6.5 minutes. An automatic welding machine, Auto_Weld, can perform the same task, but it takes 9.3 minutes. However, if only one Welder is available and the other Welder is down (e.g., on break), it takes one Welder 13.0 minutes to weld the brackets to the frames. Therefore, if one Welder is down, the frames should route to the automatic welding machine, Auto_Weld.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame</td>
<td>Buffer</td>
<td>IF DOWNQTY(Welder)&gt;0 THEN ROUTE 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ELSE ROUTE 2</td>
</tr>
<tr>
<td>Frame</td>
<td>Auto_Weld</td>
<td>...</td>
</tr>
<tr>
<td>Frame</td>
<td>Man_Weld</td>
<td>...</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Frame</td>
<td>Auto_Weld</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>2</td>
<td>Frame</td>
<td>Man_Weld</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

See Also

FREECAP, FREEUNITS(), and UNITS().
DTDelay()

Downtime-Specific System Function

Syntax samples

DTDELAY(<time unit>)
WAIT Att1 - DTDELAY(Min)
DISPLAY “The downtime delay was”$DTDelay(DAY)$“days.”

Description
Returns the difference between the time when you scheduled a non-preemptive downtime to occur and the time it actually occurred. Use DTDelay to determine if downtimes are being postponed because of incompleted work. You can use DTDelay in downtime logic to ensure that a location comes back up at a specific time.

Also returns the difference between the time when a downtime is preempted and the time it resumes.

Valid In
Any downtime logic including off-shift and break logic. This function returns a real number.

Components

<time unit>
The function will return the downtime delay in any of the following units: SEC, MIN, HR, DAY, and WK.

Example

The following statement models a situation where a location is supposed to go down at 12:00 and always goes back up at 1:00, even if it stays up past 12:00 to finish processing an entity. If the downtime was missed entirely (meaning that the downtime delay was greater than an hour), then the downtime takes no time at all. If the downtime was not missed entirely, then it lasts one hour minus the delay.

IF 60 - DTDelay(min) > 0 THEN WAIT (60 - DTDelay(min))

See Also
DOWNQTY().
DTLeft()

Shift & Break System Function

Syntax samples

DTLEFT <time units>
Shift_Time = DTLeft()

Description

The DTLEFT function returns the balance of the off-shift or break time remaining for a location or resource before it resumes normal activities. Unless passed as an argument (e.g., DTLeft(hr)), the return value uses the time units defined in the General Information Dialog (see “General Information” on page 171).

Valid In

This function can only be referenced in off-shift and break logic (either the pre-start or main logic).

Components

<time units>

The time units, if different from the default found in the General Information dialog, in which you want the return value expressed.

Example

Suppose a technician is frequently working on a job when the end of the shift rolls around and that the priority for ending the shift is not high enough to interrupt the job. To ensure that the technician gets a minimum of 14 hours off before coming back to work, even though the shift file specified 16 hours between shifts, you could enter the following off-shift logic:

IF DTLEFT(hr) < 14 THEN
BEGIN
WAIT 14 hr
SKIP
END

Please note

In the above example, the SKIP statement is important to skip over the defined time in the shift file.

See Also

DTDELAY()
DynPlot()

General Action Statement

Syntax samples

DYNPLOT “<chart name>”
DYNPLOT “my dynamic plot name”
DYNPLOT “Chart 1”
DYNPLOT “”

Description

The DynPlot statement is used to automatically turn on predefined Dynamic Plot windows. Its usage is similar to that of the View statement. Dynamic Plot windows are predefined during simulation mode. These predefined Chart views can then be called from any logic statement, invoking the display of the designated chart during simulation.

Valid In
Any Logic.

Components

<Chart name>
The name of the Dynamic Plot chart as defined in the Dynamic Plots dialog. Enclose the name in quotation marks.

Example

You are giving a presentation to management. Two hours into the simulation, you want a chart to be displayed showing the value of a WIP variable plotted against average part cost. Four hours into the simulation, you want this chart to disappear.

To do this, define a Chart view from the Dynamic Plots dialog, naming your Chart view “WIP vs Cost.” Define a subroutine and call it in the initialization logic using the ACTIVE statement. Enter the following logic in the subroutine:

WAIT 2 HR
DYNPLOT “Wip vs Cost”
Wait 2 HR
DYNPLOT “”

Please note

Using the statement with a null value (no name defined between the quotation marks) will close all currently open Dynamic Plot windows.
End

General Control Statement

Syntax samples

END or }

WHILE FREECAP(Loc1) > 5 DO
    BEGIN
        INC Var2, 5
        WAIT 5 sec
    END

Description

Defines a statement block along with a corresponding BEGIN statement. BEGIN and END are almost always used in conjunction with other control statements such as IF...THEN and DO...WHILE. Every END must pair with a BEGIN.

Valid In

Any logic.

Example

Compare the following examples:

The example below includes a BEGIN and END statement in the form of the “{” and “}” symbols. In this logic, if the attribute Attr1 equals one, ten Cases are ordered and the variable, Var1, increments. ProModel executes the statements within the BEGIN and END only if Attr1 equals one.

IF Attr1 = 1 THEN
    {
        ORDER 10 Case
        INC Var1
    }

Just as in the logic above, if Attr1 in the following example equals one, ten Cases are ordered. However, Var1 increments no matter what the value of Attr1. Without a statement block, the IF...THEN applies only to the very next statement, no matter how you format the logic.

IF Attr1 = 1 THEN
    ORDER 10 Case
    INC Var1

See Also

BEGIN, IF...THEN, DO...WHILE, WHILE...DO, DO...UNTIL, and END.
Ent()

Type Conversion Function

Syntax samples

ENT(<entity name-index number>)
SEND 10 ENT(Var1) TO Loc1
DISPLAY “Ent A has been combined with” $ ENT(Var1)

Description
Converts a name-index number or integer to an entity name. Use this function when a statement or function needs the name of an entity whose name index number is stored in an attribute, variable, or some other expression. ENT() can also be used to vary the entity that a statement references by using an expression for the name-index number. When used in an expression expecting a string, such as in the second syntax example above, ProModel will convert the name-index number to the actual name of the entity.

Valid In
Any logic where an entity name is normally used.

Components

<entity name-index number>
The name-index number of the entity desired. This component may be an expression which allows the referenced entity to change as the simulation progresses. Real numbers will be treated as integers.

Example

The logic below orders three batches of five different entity types to a location, Receiving.

Var1 = 1
WHILE Var1 <= 3 DO
BEGIN
ORDER 5 ENT(Var1) TO Receiving
INC Var1
END

See Also
LOC(), RES(), ENTITY(), and LOCATION().
Entity()

Entity-Specific System Function

Syntax samples

ENTITY({_<expression>_{}})
ENTITY()
ENTITY(Var1)

Description

Returns the name-index number of the current entity or a particular entity in an entity group. This function is especially useful in macros and subroutines that vary depending on which entity calls them. Use ENTITY() to determine what type of entity is processing when an entity type of ALL is specified at a location. For example, if a common area handles several different parts with essentially the same process, use an IF...THEN statement in conjunction with an ENTITY() to have individual statement blocks handle the details of the operation. This function returns an integer.

Valid In

Speed fields, traveling time fields, conveyor speed fields, Resource fields, operation logic, routing fields, arrival logic, debug user-condition field.

Components

<expression>

The number of the entity in a group to inspect. For example, ENTITY(3) returns the name-index number of the third entity in the group. If this option is omitted, the name-index number of the calling entity is returned.

Example

All cars from the motor pool must be washed after use. All cars except vans require ten minutes to wash, and vans require an additional ten minutes. The logic below models this situation.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Wash1</td>
<td>WAIT 10 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IF ENTITY() = Van THEN WAIT 10 min</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALL</td>
<td>Parking</td>
<td>FIRST 1</td>
<td>MOVE FOR 30</td>
</tr>
</tbody>
</table>

See Also

ENT() and LOCATION().
Entries()

General System Function

Syntax samples

ENTRIES(<location>)
DISPLAY “LocA has had” $ ENTRIES(LocA) $ “entries.”

Description

Returns the total entries to a location. This function returns an integer.

Valid In

Any logic and any field except those evaluated only at translation. For a list of fields evaluated at translation see the “Appendix A” on page 577.

Components

<location>

The location to examine.

Example

A location, Stores, sends entities, Orders, to a location, Shipping. A variable, Batch_Time, tracks the amount of time it takes to process 50 Orders. After Loc1 processes 50 entities, we want to reset Batch_Time to zero.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Stores</td>
<td>IF ENTRIES(Loc1) = 50 THEN Batch_Time = 0</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Order</td>
<td>Shipping</td>
<td>FIRST 1</td>
<td>MOVE FOR 30</td>
</tr>
</tbody>
</table>

See Also

IF...THEN...ELSE.
**Exp()**

**Math Function**

**Syntax samples**

```plaintext
EXP(<expression>)
Real1 = EXP(Real2)
```

**Description**

Returns the exponential of an expression. This function is equivalent to $e^x$.

**Valid In**

Any expression. This function returns a real number.

**Components**

`<expression>`

EXP() returns the exponential of this expression.

**See Also**

LN().
ForLocation()

Shift & Break System Function

Syntax samples

FORLOCATION()

IF FORLOCATION() THEN Priority 100

IF FORLOCATION() THEN
    INC Arr1 [1, 2]
ELSE
    INC Arr1 [2, 2]

Description

This function returns TRUE if the object executing the shift or break logic is a location.

Valid In

Shift or break logic.

Example

We assign three resources (Oper1, Oper2, and Oper3) and two locations (Mill1 and Mill2) to a shift. When the locations go off-shift, the example uses a resource called Maint for 10 minutes to clean up around the machines. Because we assigned the same shift to locations and resources, we need to check if the object executing the off-shift logic is a location. We place the following logic in the off-shift logic:

IF FORLOCATION() THEN USE Maint FOR 10 min

See Also

FORRESOURCE(). Also see “Shift & Break Logic” on page 297.
**Format()**

String Function

**Syntax samples**

FORMAT(<expression>, <total number of characters in expression> {,<digits after decimal>})

DISPLAY “The value of Var1 is” $ FORMAT(Var1, 5)

**Description**

Converts a number to a string in the format specified. FORMAT() should most often be used with the concatenation operator (“$”) and another string, as in the syntax example above. Format is often used in conjunction with the XWRITE statement to produce formatted output.

**Valid In**

Any string expression.

**Components**

<expression>

This expression will be evaluated and converted to a string. If the expression results in an integer, it will be converted to a real.

<total number of characters in expression>

This expression formats the number so that it occupies a total space equal to the number of digits before + number of digits after the decimal + one character for the decimal point. For example if you were to do the following logic: XWRITE file1 Format (10.0 4 1) XWRITE file1 Format (1.0 4 1), it will show up in the file as 10.0 1.0 with a space before the 1.0.

<digits after decimal>

An expression that evaluates to the maximum number of digits to the right of the decimal. If there are more digits to the right of the decimal than this number, the excess digits will be truncated. If there are fewer digits, ProModel will pad the number with zeros.

**Example**

The logic below writes formatted output to a file with XWRITE and FORMAT.

XWRITE File1, “The variable Var1 is” $ FORMAT(Var1,5,2)

In this example, if the value of Var1 is 378.87654, it would be written to the file as:

The variable Var1 is 378.87

(Two spaces)

**See Also**

WRITE and WRITELINE.
ForResource()

Shift & Break System Function

Syntax samples

FORRESOURCE()
IF FORRESOURCE() THEN GET Res1

Description

This function returns TRUE if the object executing the shift or break logic is a resource.

Valid In

All Shift or Break logic.

Example

A shift called DAYS.SFT has five resources and eight locations assigned to it. When the resources go off-shift, it is desired to write the resource name and simulation time to a file called RES_TIME. The following logic is placed in the off-shift logic.

IF FORRESOURCE() THEN
BEGIN
XWRITE res_time, “Shift for” $ RES(Resource()) $ “ended at” $ Clock(hr) $ “.”
END

See Also

FORLOCATION(). Also see “Shift & Break Logic” on page 297.
Free

Resource-Related Operation Statement

Syntax samples

FREE {<quantity>} <resource>, {{quantity} <resource>...}
FREE Res1, 2 Res2, 5 Res3A
FREE ALL
FREE RES(Attr1)

Description

Frees resources which are currently “owned” by the current entity. These resources must have been captured through a GET or JOINTLY GET statement.

Valid In

Location processing logic and downtime logic.

Components

<quantity>

The number of the following resource to free. A value of zero is ignored and values less than zero result in an error. This quantity may be any numeric expression and is evaluated and truncated to an integer every time the FREE statement is encountered.

<resource>

The name of the resource to free. The ALL keyword may be used here to free all resources owned by an entity. Any resource which is not owned by the entity will be ignored.

Example

In the following example, EntA arrives at Loc1 for a multi-step process requiring the use of resources Res1 and Res2. The first step requires the simultaneous use of Res1 and Res2 for a normally distributed amount of time. ProModel then frees Res1 while Res2 performs the second step of the process according to a Lognormal distribution.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>JOINTLY GET Res1 AND Res2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT N(4.5,.2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREE Res1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT L(3.4,.23)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREE Res2</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

GET and JOINTLY GET.
FreeCap()

General System Function

Syntax samples

FREECAP(<location>)
SEND FREECAP(Loc1) EntA TO Loc1

Description

Returns the available capacity of a location. This function returns an integer.

Valid In

Any logic and any field except those fields evaluated only at translation time. For a list of fields evaluated only at translation time, see the “Appendix A” on page 577.

Components

<location>

The name of the location to examine. The LOC() function may also be used here.

Example

Suppose the entities, Plates and Cams, travel through an assembly line. The location, Assembly (capacity=1) joins Cams with the Plates. When a Cam finishes processing at Station2, it should not enter Station3 unless a Plate is waiting to join with it further down the assembly line at Assembly. If there is no Plate at Assembly, another location, Buffer, sends one. The logic for Cam at Station2 is as follows:

IF FREECAP(Assembly) = 1 THEN
SEND 1 Plate TO Assembly

See Also

CAP().
FreeUnits()

General System Function

Syntax samples

FREEUNITS(<location> or <resource>)
USE (FREEUNITS(Res1)) Res1 FOR 5 min

Description

Returns the free units of a location or resource.

Valid In

Any logic and any field except those fields evaluated only at translation time. For a list of fields evaluated only at translation time, see the “Appendix A” on page 577.

Components

<location>
The name of the location to examine.

<resource>
The name of the resource to examine.

Example

This example uses FREEUNITS() to assign a team of Specialists to rework a problem. The size of the team, stored in the local variable T_Size, is determined by all the free Specialist units. Team_Time is a table function that varies the amount of time it takes to solve a problem (the amount of time in the USE statement) based on the number of units on the team.
Get

Resource-Related Operation/Move Logic Statement

Syntax samples

GET \{<quantity}\} <resource> \{,<priority}\}
   \{AND or OR \{quantity\} <resource> \{,<priority}\}...\}
GET Res1
GET 3 Res1, 5
GET 2 Res1 OR 3 Res2
GET Res1, 3 AND (Res2 OR Res3)
GET Res(Skill_required)

Description

Captures a specified number of resources as they become available. If the entity already possesses one of the requested resources, the entity will still try to capture an additional unit of that resource. When capturing multiple resources, each resource will be captured as soon as it becomes available until all resources are captured.

A resource captured with the GET statement at one location and then released with a FREE statement at another location will not be used to move the entity between locations unless it is also specified in a MOVE WITH statement in the routing move logic. Otherwise, it is the entity that is moving the resource from one location to the next and the resource will not be visible when moving with the entity.

Resources captured by a GET statement can only be preempted when the entity owning the resource is undergoing a WAIT or USE time except in move logic. If the resource is preempted during one of those times, the time will continue where it left off when the resource becomes available.

Every GET must have a corresponding FREE or an error occurs when the entity exits the system. If an entity owns one or more resources and is subsequently temporarily loaded onto or grouped with another entity, it cannot free the resource(s) until it is unloaded or ungrouped.

Valid In

Location processing, downtime, move, and shift logic. A GET statement cannot follow a move related statement in move logic.

Components

<quantity>

The number of resources to get. A value of zero is ignored and values less than zero return an error. This numeric expression is evaluated and truncated every time the GET statement is encountered.

<resource>

The name of the resource to GET. You can substitute RES() for the resource name.

<priority>

When multiple entities are waiting for the same resource to become available, the entity with the highest priority will capture the resource first. This expression should be a number between 0 and 999.

Example

To start a semi-automatic welding process, we need a static resource named “Operator.” Midway through the process, the Operator tests the weld with a resource named “Tester,” shared with other operators. After the test, the operator restarts the welder. The Operator stays with the welder until he or she completes the last part of the operation. After the welding process the
operator moves the part to the buffing area, completes the buffing operation and then is freed.

### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assy</td>
<td>Weld</td>
<td>USE Operator FOR 4 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GET Operator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USE Tester FOR U(2,.5)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT 4 min</td>
</tr>
<tr>
<td>Assy</td>
<td>Buffer</td>
<td>WAIT T(7,10,11)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREE Operator</td>
</tr>
</tbody>
</table>

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assy</td>
<td>Buffer</td>
<td>FIRST 1</td>
<td>MOVE FOR 1.5</td>
</tr>
<tr>
<td>1</td>
<td>Assy</td>
<td>Checker</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

### See Also

JOINTLY GET and USE.
GetCost()

Cost Related Function

Syntax samples

GETCOST()

Description

Returns the cost of the current entity executing the logic. Use this function to return the entity’s actual, accumulated dollar amount.

Valid In

Operation logic only.

Example

The following example shows how to use the GETCOST() function to generate a Time Series plot that tracks changing entity cost as entities exit the system. (See table below.)

• Create a variable (e.g., Var1), select it to be of type real, and select time series statistics.
• For any location where an entity exits the system, place the following as the last line in operation logic:

 Var1 = GETCOST()

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Opn (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Shipping</td>
<td>WAIT N(3,.52) Var1=GETCOST()</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Exit</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>

See Also

INCENTCOST, INCLOCCOST, and SETRATE.
GetReplicationNum()

General System Function

Syntax samples

GETREPLICATIONNUM()

Description

Returns the number of the currently running replication.

Valid In

Any Logic.

Example

Based on the current replication, you may want to make a decision regarding the exporting of array data.

In this case, you could use an IF THEN statement combined with the GETREPLICATIONNUM() function to decide what data to export based on the currently running replication.
GetResRate()

Cost Related Function

Syntax samples

GETRESRATE({<resource>})
GETRESRATE()
GETRESRATE(Operator1)

Description

Returns the cost rate specified in the Cost dialog or through the SETRATE() function for a resource currently owned by the entity making the function call. When used without the optional <resource> parameter, this function returns the cost rate of the entity’s most recently captured, owned resource.

If an entity owns multiple units of a resource, the function returns the cost rate of the entity’s most recently captured resource unit.

Valid In

Operation and move logic.

Components

<resource>

A resource currently owned by the entity making the function call. When you use GETRESRATE without this parameter, this function returns the cost rate of the entity’s most recently captured, owned resource.

Example

A clerk normally works an 8-hour shift. However, if the clerk does not finish entering all the orders in his Input_Queue at the end of the day, he must stay and finish them. Since the clerk is paid time-and-a-half for any overtime, you must increment the cost of the resource by an additional half of the normal rate to get the overtime rate. To do this, set a variable equal to 1 in the pre-off-shift logic for the resource, indicating the resource should go off-shift. If the variable is equal to 1, increment the cost of a resource by half the original rate. (Since each unit of the clerk has a different rate, you must obtain the cost rate for the resource owned by the entity.)

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Opn (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order_desk</td>
<td>GET Clerk, 399</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT N (4.5, .3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IF Off_Shift_Var=1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>THEN INCRESCOST</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GETRESRATE() *.50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREE Clerk</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Order</td>
<td>Shipping</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

See Also

GETCOST(), INCENTCOST, INCLOCCOST, INCRESCOST, and SETRATE.
Goto

General Control Statement

Syntax samples

GOTO <label ID>
GOTO LabelA

Description

Jumps to the statement identified by the designated label. A label should follow the normal rules for names except that it is followed by a colon in the logic. GOTO statements may be replaced by IF...THEN...ELSE statements.

Valid In

Any logic.

Components

<label ID>

The name of the label to switch to. Omit the colon on the label name here.

Example

This example shows how a GOTO statement is used to skip over the first two increment statements based on the value of an attribute.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Receive</td>
<td>IF Attr&gt;1 THEN GOTO L1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INC V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INC V2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L1: INC V3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Box</td>
<td>Stores</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

IF...THEN...ELSE, BREAK, and BREAKBLK.
Chapter 14: Graphic

Graphic

General Operation Statement

Syntax samples

GRAPHIC <expression>
GRAPHIC 2
GRAPHIC Var1

Description

Changes the entity’s or resource’s current graphic. Entities and resources are assigned graphics from the graphics library in the Entity or Resource editor. Use the GRAPHIC to show the result of a process. For example, when a customer sits down, the graphic could change from a standing person to a sitting person.

Valid In

When used in node entry, node exit, and resource-downtime logic, GRAPHIC changes a resource’s graphic. When used in location processing logic, move logic, and arrival logic, GRAPHIC changes an entity’s graphic.

Components

<expression>

The number of the entity’s or resource’s new graphic.

Example

In the example below, EntA arrives at Loc1 for a two step operation. Upon arrival, the graphic icon of the entity changes to Graphic 2. After the first two minute processing time the icon changes to Graphic 3. Finally, the icon changes to Graphic 4 after the second two minute processing time. (The difference between the two graphics may only be color, but the two could be completely different.)

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>GRAPHIC 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT 15 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRAPHIC 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT 25 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GRAPHIC 4</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>
Group

Entity-Related Operation Statement

Syntax samples

GROUP <expression> {AS <entity name>}
GROUP (Var1+Var2)
GROUP 10 AS EntX

Description
Accumulates and temporarily consolidates a specified quantity of entities into a single GROUP shell entity.

The shell entity retains the same attributes as the first entity that was grouped into the shell. However, if the GROUP AS statement is used, the new shell entity does not retain any attribute values, even if the same name is used for the GROUP shell entity as the entities that have been grouped.

The individual entities comprising the group retain their identities, attributes, and resources and are divided from the group when an UNGROUP statement is encountered. The first entity processed from the group takes any resources the group owns. Entities in a group can be grouped into a larger group at another location.

Valid In
The operation column of process edit tables only. GROUP may not be used in combination with COMBINE, CREATE, LOAD, UNLOAD, SPLIT AS, other GROUP statements in the same processing logic, or with conveyors. An exception to this rule is that an UNGROUP statement may follow a GROUP statement in the same process.

Components

<expression>
The number of entities to group. If this expression is zero, the statement is ignored. If it is less than zero, it generates an error.

This expression is evaluated every time an entity encounters the GROUP statement, so the amount of entities to be combined can vary as the simulation progresses. If it becomes less than or equal to the number of entities already waiting to be combined, the entity that encountered the GROUP statement will be grouped with all the waiting entities.

AS <new entity name>
The optional name of the resulting entity. If left off, the new entity will have the same name as the last entity to complete the group.

Explicit Entity Actions
GROUP creates a shell (a temporary entity representing grouped entities that starts with cost and time statistics of zero) to which ProModel assigns all cost and time statistics for the group. Each grouped entity retains its individual cost and time statistics and, when you ungroup the entities and the shell disappears, ProModel divides all statistics and cost (accrued by the shell) between them.
Example

In this example, Man, Woman, and Child are grouped together at Floor1 before getting on an elevator. The group of entity types, called Grp_A, is then routed to Floor2 where it will be ungrouped. (See the UNGROUP statement example.)

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Man</td>
<td>Floor1</td>
<td>WAIT E(2.0)</td>
</tr>
<tr>
<td>Woman</td>
<td>Floor1</td>
<td>WAIT U(3,1)</td>
</tr>
<tr>
<td>Child</td>
<td>Floor1</td>
<td>WAIT N(2.1,2)</td>
</tr>
<tr>
<td>ALL</td>
<td>Waiting</td>
<td>GROUP 10 AS Grp_A</td>
</tr>
<tr>
<td>Grp_A</td>
<td>Waiting</td>
<td>GET Elevator</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Man</td>
<td>Waiting</td>
<td>FIRST 1</td>
<td>MOVE FOR 0.5</td>
</tr>
<tr>
<td>1</td>
<td>Woman</td>
<td>Waiting</td>
<td>FIRST 1</td>
<td>MOVE FOR 0.5</td>
</tr>
<tr>
<td>1</td>
<td>Child</td>
<td>Waiting</td>
<td>FIRST 1</td>
<td>MOVE FOR 0.5</td>
</tr>
<tr>
<td>1</td>
<td>Grp_A</td>
<td>Floor2</td>
<td>FIRST 1</td>
<td>MOVE WITH Elevator</td>
</tr>
</tbody>
</table>

See Also

COMBINE, ACCUM, GROUPQTY(), and ENTITY(). Also see “Attributes” on page 217.
**GroupQty()**

**Entity-Specific System Function**

**Syntax samples**

GROUPQTY({<entity name>})
ORDER GROUPQTY(Part1) Part2 TO Loc1
IF GROUPQTY(Part1) > 5 THEN...

**Description**

Returns the number of entities of a specified type in a grouped or loaded entity. If no name is specified, it returns the entire group quantity. If it is a loaded entity, it will only return the number of temporarily loaded entities, not the base entity. For example, if four Castings are temporarily loaded onto a Pallet and called Batch, the GroupQty() will return the number of Castings (i.e., 4), which does not include the base entity Pallet.

In the case of hybrid nested groups with several mixed and nested levels of groups and loads, GroupQty() returns the number of entities in the uppermost level only.

**Valid In**

Speed fields, traveling-time fields, conveyor-speed fields, Resource fields, operation logic, routing fields, arrival logic, and debug user-condition fields. This function returns an integer.

**Components**

*<entity name>*

The optional specific type of entity to search for in the group.

**Example**

A group of entities called GRPA arrives at Loc1 and process for some amount of time according to a Normal distribution. If the group contains three or more entities it routes to Loc2, otherwise it routes to Loc3. Routing requires 1.2 minutes.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRPA</td>
<td>Loc1</td>
<td>WAIT N(3,.1) IF GROUPQTY() &gt; 2 THEN ROUTE 1 ELSE ROUTE 2</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GRPA</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td>MOVE FOR 1.2</td>
</tr>
<tr>
<td>2</td>
<td>GRPA</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td>MOVE FOR 1.2</td>
</tr>
</tbody>
</table>

**See Also**

GROUP, UNGROUP, and ENT().
If...Then...Else

General Control Statement

Syntax samples

IF <Boolean expression> THEN <statement 1> {ELSE <statement 2>}

IF Var1 = 5 THEN WAIT 2 min

IF (Attr2 = 5) OR (Var5 <> 0) THEN WAIT 2 min ELSE WAIT 3 min

IF Var1 > Attr2 THEN BEGIN
    Var1 = Attr2
    WAIT Attr1
END ELSE BEGIN
    INC Var1
    WAIT Attr2
END

Description

Executes a statement or statement block if the Boolean expression is true. If an ELSE statement is included and the Boolean expression is false, an alternate statement or statement block is executed. For an IF...THEN statement to be broken into more than one line, the first item on the next line must be THEN, AND, or OR. IF...THEN statements only apply to the next statement or statement block in a logic. Any statements outside of the BEGIN and END will execute normally. See BEGIN and END for examples.

Valid In

Any logic.

Components

<Boolean expression>

The condition to be tested.

THEN <statement 1>

The statement or block to be executed if the condition is true.

ELSE <statement 2>

The statement or block to be executed if the condition is false.

Example

In the following example an IF...THEN...ELSE test is made to see if the simulation clock is less than eight hours. If so, the Client is routed to Office1, otherwise the Client is routed to Office2.
Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Loc1</td>
<td>IF CLOCK(Hr) &lt; 8 THEN ROUTE 1 ELSE ROUTE 2</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Client</td>
<td>Office1</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
<tr>
<td>2</td>
<td>Client</td>
<td>Office2</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

BEGIN, END, DO...WHILE, WHILE...DO, and DO...UNTIL.
Inc

General Operation Statement

Syntax samples

INC <name>{, <expression>}
INC Var1
INC Attr2, 5+Var1

Description
Increments a variable, array element, or attribute by the value of a specified numeric expression. When counting the number of entities a location has processed, increment a variable at the end of the processing logic.

Valid In
Any logic.

Components

<name>
The name of any variable, array element, or attribute.

<expression>
The amount to increment the value. If this expression is omitted, the value will be incremented by one. This can be a negative number.

Example

The following example increments two variables in the exit logic. Num_complete is incremented by one, and Count is incremented by the expression Attr1*Attr2.

See Also
DEC.
**IncEntCost**

Cost Related Statement

Syntax samples

```
INCENTCOST <expression>
INCENTCOST 15
INCENTCOST -15
```

Description

Enables you to increment the cost (positively or negatively) of the current entity by a given amount. Use this function to add to the entity’s actual, accumulated dollar amount.

Please note

When working with new entities created through a ROUTE statement, use INCENTCOST to assign an initial cost to entities. Initial entity cost defined for an entity in the cost module applies to entities entering the system through a scheduled arrival, the CREATE statement, or the ORDER statement.

Valid In

Operation and Move logic.

Components

```
<expression>
```

The positive or negative change to the value of cost.

Example

The logic below allows you to add an initial cost to an entity implicitly created through the ROUTE statement. In the following example, a Pallet of entities, PalletA, arrives at Unload_Loc where workers unload entities called Box every 20 seconds until the pallet is empty. ProModel determines the number of Boxes unloaded from PalletA by the value of PalletA’s attribute, Qty_Attr. In Move Logic, the statement “IncEntCost 10” adds an initial cost of 10 dollars to each implicitly created entity, Box.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Opn (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PalletA</td>
<td>Unload_Loc</td>
<td>int x = 0&lt;br&gt;WHILE x &lt; Qty_Attr DO&lt;br&gt;{INC x&lt;br&gt;WAIT 20 sec&lt;br&gt;ROUTE 2} ROUTE 1</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PalletA</td>
<td>Exit</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>2*</td>
<td>Box</td>
<td>Conveyor1</td>
<td>FIRST 1</td>
<td>INCENT-COST 10</td>
</tr>
</tbody>
</table>

See Also

GETCOST, GETRESRATE(), INCLOCCOST, INCRESCOST, and SETRATE.
IncLocCost

Cost Related Statement

Syntax samples

INCLOCCOST <expression>
INCLOCCOST 15
INCLOCCOST -15

Description

Enables you to increment the cost (positively or negatively) of the current location by a given amount. Use this function to add to the location’s actual, accumulated dollar amount.

Valid In

Operation logic.

Components

<expression>

The positive or negative change to the value of cost.

Example

The logic below shows how to add a cost per entry to a location for an entering entity. ProModel automatically tracks operation cost per time unit specified in the cost dialog, however, you may assign a one time cost each time an entity enters a location.

In the following example, an entity, EntA, arrives for inspection at location Inspect. We define no rate of operation cost for Inspect because each inspection accrues a one time cost regardless of how long the entity remains at Inspect. At Inspect, workers inspect EntA. After inspection, ProModel adds the cost to the location through the IncLocCost statement and then to the entity with the IncEntCost statement.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Opn (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Inspect</td>
<td>WAIT N(3,.7)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INCLOCCOST 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INCENTCOST 3</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Packaging</td>
<td>PROBABILITY .93</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntA</td>
<td>Rework</td>
<td>.07</td>
<td></td>
</tr>
</tbody>
</table>

See Also

GETCOST, GETRESRATE(), INCENTCOST, INCRESLOCST, and SETRATE.
**IncResCost**

**Cost Related Statement**

**Syntax samples**

```
INCRESCOST <cost expression> {,<resource>}
INCRESCOST 10
INCRESCOST GETRESRATE(Operator1)*20, Operator1
```

**Description**

Enables you to increment the cost (positively or negatively) of a resource currently owned by the entity executing the statement. Use this function to add to the resource’s actual, accumulated dollar amount. When used without the optional `<resource>` parameter, this statement increments the cost rate of the entity’s most recently captured, owned resource.

If an entity owns multiple units of a resource, the cost distributes evenly to each unit.

**Valid In**

Operation and move logic.

**Components**

- `<cost expression>`
  
  The positive or negative change to the value of cost.

- `<resource>`
  
  A resource currently owned by the entity executing the statement. When used without the parameter, this statement increments the cost rate of the entity’s most recently captured, owned resource.

**Example**

A clerk normally works an 8-hour shift. However, if the clerk does not finish entering all the orders in his Input_Queue at the end of the day, he must stay and finish them. Since the clerk is paid time-and-a-half for any overtime, you must increment the cost of the resource by an additional half of the normal rate to get the overtime rate. To do this, set a variable equal to 1 in the pre-off-shift logic for the resource, indicating the resource should go off-shift. If the variable is equal to 1, increment the cost of a resource by half the original rate.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Opn (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order_desk</td>
<td>GET Clerk, 399&lt;br&gt;WAIT N (4.5, .3)&lt;br&gt;IF Off_Shift_Var=1&lt;br&gt;THEN INCRESCOST&lt;br&gt;GETRESRATE() *.50&lt;br&gt;FREE Clerk</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Order</td>
<td>Shipping</td>
<td>FIRST 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

**See Also**

GETCOST(), GETRESRATE(), INCENTCOST, INCLOCCOST, INCRESCOST, and SETRATE.
Chapter 14:

Int

Local Variable Declaration Statement

Syntax samples

```
INT <name1>{= <expression1>, <name2>=<expression2>...}
INT Count
INT Count = 1
INT Count = 1, Test = FREECAP(Loc2)
```

Description

Creates a local variable of type integer. Local variables work much the same as attributes, except that they only are available within the logic that declares them. A new variable will be created for each entity that encounters an INT statement. Local variables are not directly available to subroutines, which have their own local variables. However, a local variable may be passed to a subroutine as a parameter. Local variables are available inside referenced macros.

Use local variables where ever possible for the test variable in WHILE...DO, DO...WHILE, and DO...UNTIL loops.

Valid In

Any logic. Variables declared with INT are valid in any expression within the logic where a normal integer number is valid.

Components

- `<names>`
  An identifier for the local variable. This identifier must be a valid name.

- `<expressions>`
  The variable will initially be assigned this value. This expression is evaluated every time the INT statement is encountered.

Example

A plant manufactures pipes of 12 different types, such as 2" steel, 4" aluminum, etc. All workers inspect pipes at a common inspection station after which they move to a dock where other workers load them into boxes. The boxes are designed to hold only certain types of pipes. Therefore a box designed to hold 2" steel pipes can only hold 2" steel pipes, not 4" aluminum pipes.

Suppose a Box, enters a multi-capacity location, Dock. Each Box has a different entity attribute, b_type, describing the type of pipe it can hold. Workers load pipes into the Box. Workers must load the 2" steel pipes into the box designed to hold the 2" steel pipes. Therefore, the attribute value of the Pipe, p_type, must match the attribute value of the Box, b_type. We can use local variables to accomplish this modeling task. In the following example, we defined X as a local variable and set it equal to b_type:
## Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipe</td>
<td>Inspect</td>
<td>WAIT 5</td>
</tr>
<tr>
<td>Box</td>
<td>Dock</td>
<td>INT X=b_type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LOAD 5 IFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X=p_type</td>
</tr>
<tr>
<td>Box</td>
<td>Dock</td>
<td>WAIT 10</td>
</tr>
</tbody>
</table>

## Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pipe</td>
<td>Dock</td>
<td>LOAD 1</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td>1</td>
<td>Box</td>
<td>Delivery</td>
<td>FIRST 1</td>
<td>MOVE FOR 8</td>
</tr>
</tbody>
</table>

## See Also

REAL. Also see “Local Variables” on page 225.
Join

Entity-Related Operation Statement

Syntax samples

JOIN <expression> <entity name> {,<priority>}
JOIN 4 EntA
JOIN Var1 EntA, 1

Description

Joins a specified quantity of a designated entity type to the current entity. The entities joined to the current entity lose their identities and any resources owned by the joining entities are transferred automatically to the base entity. Use JOIN to simulate a component being assembled to a main part, such as when wings are attached to the fuselage of an airplane.

Entities to be joined must be routed to the current location with a JOIN rule. The current entity waits until enough entities to fill its request have been routed to the current location with a JOIN rule.

The resulting entity retains the attributes and name of the base entity. To transfer attributes from the joining entity to the current entity, in the exit logic for the joining entity, copy the desired attribute to a global variable. Then assign the global variable to the attribute of the base entity after the JOIN statement in the processing logic.

All resources owned by the joining entity are transferred to the base entity.

To JOIN an entity with a specific attribute value to another entity with the same attribute value, use the LOAD PERM statement.

Valid In

Operation logic only. More than one JOIN statement may be used in the same logic.

Components

<expression>

The number of entities to be joined. A zero value is ignored and a negative value generates an error. This expression is evaluated when each entity first encounters it, but is not re-evaluated as the requested entities are joined.

<entity name>

The entity type to be joined to the base entity. Joining entities must come from a JOIN routing and lose their identity once joined.

<priority>

An entity with a higher priority will have arriving entities joined to it before one with a lower priority. This expression should be a number between 0 and 999. For more information on priorities, see Priorities, at the beginning of this section.

Explicit Entity Actions

JOIN passes cost on to the base entity but not statistical information. ProModel counts joined entities as exits.
Example

A certain location on an assembly line manufacturing cars attaches doors built on another assembly line. When the Body of the car arrives at the Assembly location, we attach a left door, Ldoor, and a right door, Rdoor, with a JOIN statement. The paint station paints the doors and routes them to Assembly with a JOIN rule. Note that the Body will wait until we join both doors before routing to the next location.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rdoor</td>
<td>Paint</td>
<td>WAIT 30</td>
</tr>
<tr>
<td>Ldoor</td>
<td>Paint</td>
<td>WAIT 30</td>
</tr>
<tr>
<td>Body</td>
<td>Assembly</td>
<td>JOIN 1 Ldoor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JOIN 1 Rdoor</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rdoor</td>
<td>Assembly</td>
<td>JOIN 1</td>
<td>MOVE FOR 30</td>
</tr>
<tr>
<td>1</td>
<td>Ldoor</td>
<td>Assembly</td>
<td>JOIN 1</td>
<td>MOVE FOR 30</td>
</tr>
<tr>
<td>1</td>
<td>EntB</td>
<td>Cleaning</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

LOAD, COMBINE, and GROUP. Also see “Attributes” on page 217.
Jointly Get

Resource-Related Operation Statement

Syntax samples

JOINTLY GET {<quantity>} <resource> {,<priority>}
{AND or OR {<quantity>} <resource> {,<priority>}}

JOINTLY GET 3 Res1,5
JOINTLY GET 2 Res1 OR 3 Res2
JOINTLY GET Res1,3 AND (Res2 OR Res3)
JOINTLY GET 2 Res(Attribute1)

Description
Captures a specified number of resources when that number of resources is available. When capturing multiple resources, none of the resources will be captured until all are available. If the entity already possesses one or more of the requested resources, the entity will still try to capture additional units of the specified resources.

Valid In
Location processing, downtime, move, and shift logic.

Components

<quantity>
The number of resources to get. A value of zero is ignored and values less than zero return an error. This numeric expression is evaluated and truncated every time the JOINTLY GET statement is encountered.

<resource>
The name of the resource to JOINTLY GET. RES() can be substituted for the resource name.

<priority>
When multiple entities request a resource, the requests will be filled in order of priority. This expression should be a number between 0 and 999.

Example

In the following example (which also demonstrates the FREE statement) EntA arrives at Loc1 for a multi-step process. Because the first step of the process uses Res1 and Res2 simultaneously, a JOINTLY GET statement is issued to ensure that both resources are available before the process begins. The resources are then freed independently.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>JOINTLY GET Res1 AND Res2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT N(4.5,.2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREE Res1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT L(3.4,.23)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FREE Res2</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

See Also
GET and USE.
**Last()**

**Resource-Specific System Function**

**Syntax samples**

```
LAST()
Var1=LAST()
IF LAST() = 13 THEN Var3 = 0
IF LAST() = PathNet1.N1 THEN INC Var1
```

**Description**

Returns the name-index number of the node from which a resource has just traveled. LAST() can be useful to choose the appropriate graphic or to reset a variable. You can also check the name-index number of the last node by specifying `<path network name>_<name of the node>`. For example, if you wanted to know if the last node was N5 on the network Net3, you could specify “IF LAST() = Net3.N5 THEN...” in the node entry logic.

**Valid In**

Node entry logic.

---

**Example**

This Entry Logic window shows that whenever a resource enters a particular node a check is made to see if the name-index number of the last node equals one. If so, the resource graphic is changed to Graphic 2, otherwise it is changed to Graphic 3.

```
IF LAST() = 1 THEN
  GRAPHIC 2
ELSE
  GRAPHIC 3
```

**See Also**

NEXT() and WAIT...UNTIL.
Ln()  

Math Function  

Syntax samples  

\[ \text{LN}(<\text{expression}>) \]  
\[ \text{Real1} = \text{LN}(<\text{Real2}>), \text{Real2} > 0 \]  

Description  

Returns the natural logarithm of an expression.  

Valid In  

Any expression. This function returns a real number.  

Components  

<expression>  

\[ \text{LN}() \] returns the natural logarithm of this expression.  

See Also  

EXP().  

Please note  

To get a logarithm to a particular base, use the following formula:  

\[ \log_{\text{base}}<\text{expression}> = \frac{\text{LN}<\text{expression}>}{\text{LN}<\text{base}>} \]
Load

Entity-Related Operation Statement

Syntax samples

LOAD <expression> {PERM} {IFF <Boolean expression>} {IN <time>} {,<priority>}
LOAD 5, 99
LOAD 5 IFF Attr3 > 2 IN 5 min
LOAD Pallet_Capacity LOAD 5 PERM IN 10 min

Description

Loads a specified quantity of entities onto a base entity. Temporarily loaded entities retain their identity and may be unloaded with an UNLOAD statement. Permanently loaded entities, using the PERM option in the LOAD statement, do not retain their identity and cannot be unloaded later. Loaded entities must be routed to the loading location using the LOAD routing rule. Additional entities may be added to an entity’s existing load with additional LOAD statements. Use LOAD to model parts placed into a container or pallet when they must be removed later. If a base entity owns a resource when the entities are unloaded the resource stays with the base entity. Any resources owned by permanently loading entities are transferred automatically to the base entity. Any resources owned by temporary loading entities are kept and cannot be freed until the entities are unloaded.

Valid In

Operation logic only. A process may contain multiple load statements and no more than one UNLOAD statement following all LOAD statements. LOAD may not be used in the same process with SPLIT AS, CREATE, COMBINE, GROUP, or UNGROUP.

Components

<expression>

The number of entities to load onto the base entity. This expression is evaluated at the time the entity encounters the LOAD request.

PERM

This option causes the LOAD to behave the same as the JOIN statement. It will permanently join entities to the base entity executing the LOAD statement. Any resources owned by the permanently loading entities are transferred automatically to the base entity.

IFF <Boolean expression>

This option allows the LOAD command to be conditional. Any attributes, entity functions, or location functions apply to the entity to be loaded, not to the base entity. This technique allows only entities with certain properties to be loaded onto the base entity. To use attributes, entity functions, and location functions that apply to the base entity, assign the desired value to a local variable and use the local variable in the Boolean expression.

IN <time>

The entity will load entities up to the specified limit for this amount of time and then go on. Entities loaded with this option may have a load smaller than the specified amount.

<priority>

Waiting entities will load arriving entities by priority. This expression should be a number between 0 and 999.

Explicit Entity Actions

LOAD does not transfer cost or statistics of the loaded entity. However, if the PERM option is used, the cost of the loading entity does get transferred to the base entity.
Example

In this example, boxes are loaded onto a semi-truck. The quantity is determined by the value of the Truck’s attribute, Attr1. The resulting entity retains the name Truck and is sent on to its final destination, New York, Chicago, or Boston.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Shipping</td>
<td>WAIT 2 min</td>
</tr>
<tr>
<td>Truck</td>
<td>MfgSite</td>
<td></td>
</tr>
<tr>
<td>Truck</td>
<td>Dock</td>
<td>LOAD Attr1 IN 2 hr</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Box</td>
<td>Dock</td>
<td>LOAD 1</td>
<td>MOVE FOR 45 sec</td>
</tr>
<tr>
<td>1</td>
<td>Truck</td>
<td>Dock</td>
<td>FIRST 1</td>
<td>MOVE FOR 10 min</td>
</tr>
<tr>
<td>1</td>
<td>Truck</td>
<td>NewYork</td>
<td>FIRST 1</td>
<td>MOVE FOR 24 hr</td>
</tr>
<tr>
<td></td>
<td>Truck</td>
<td>Chicago</td>
<td>FIRST</td>
<td>MOVE FOR 12 hr</td>
</tr>
<tr>
<td></td>
<td>Truck</td>
<td>Boston</td>
<td>FIRST</td>
<td>MOVE FOR 28 hr</td>
</tr>
</tbody>
</table>

See Also

LOAD, GROUP, UNLOAD, ACCUM, COMBINE, JOIN, GROUPQTY(), and ENTITY(). Also see “Attributes” on page 217.
**Loc()**

**Name-Index-Number Conversion Function**

**Syntax samples**

LOC(<location name-index number>)
ORDER 10 EntA TO LOC(5)
DISPLAY “EntA arrived at” $ LOC(5)

**Description**

Converts a name-index number or integer to a location name. Use this function when a statement or function needs the name of a location but whose name-index number is stored in an attribute, variable, or some other expression. It can also be used to vary a selected location based on the name-index number stored in the expression. When used in a string expression, as in the second syntax example above, ProModel will convert the name-index number to the actual name of the location. If the expression points to a unit of a multi-unit location, then the LOC() function will return the name of the parent location.

**Valid In**

Any statement where a location name is normally used, including the Destination field of the Routing edit table. Also used in string expressions.

**Components**

<location name-index number>

The name-index number of the desired location. This component may be an expression, allowing the location to vary as the simulation progresses. Real numbers will be truncated to integers.

**Example**

Suppose there are five locations which appear one after the other in the Location edit table as follows: Dock1, Dock2, Dock3, Dock4, Dock5. Shipments could be ordered to each of the five locations in rotation with the following logic. Note that Dist() is a user-defined distribution that returns an integer value for the number of Shipments to order.

INT Var1 = 1
WHILE Var1 <= 5 DO
BEGIN
ORDER Dist() Shipments TO LOC(Var1)
INC Var1
END

**See Also**

ENT(), RES(), and LOCATION().
Chapter 14: LocState()

LocState()

General System Function

Syntax samples

LOCSTATE (<locationname>)

Description

Returns a value indicating the current state of the specified location. Return values will range from 1-7, which translate to the following:

1 = idle/empty
2 = setup
3 = operating
4 = blocked
5 = waiting
6 = up (multi-capacity location)
7 = down

Valid In

Any Logic.

Components

<locationname>

The name of the location.
Location()

Location-Specific System Function

Syntax samples

LOCATION()
Attr1 = LOCATION()
IF LOCATION() = 2 THEN WAIT 4 MIN

Description

Returns the current location’s name-index number. This function is especially useful in macros and subroutines that vary depending on which location’s logic calls them. By using a LOCATION() function with an IF...THEN statement, the macro or subroutine can act differently depending on the location that called it. Also, the same technique can be used to determine which location is carrying out a process when ALL is used as the process location.

Valid In

Any logic.

Example

The individual ovens of a ceramics plant have different capacities, but are otherwise exactly the same. While each oven could be modeled as an individual location, it would be easier to model this situation as a multi-unit location. This example uses CAP() and LOCATION() in the processing logic of the parent location to accumulate enough Sinks to fill each oven.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sink</td>
<td>Oven</td>
<td>ACCUM CAP(LOCATION())</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sink</td>
<td>Cool</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

LOC() and ENTITY().
Log

General Action Statement

Syntax samples

LOG <string>, <expression>
LOG “Activity Time”, Attr1

Description

ProModel assumes that the time stored in the expression is in the model’s default time units set in the General Information dialog box. Use the LOG statement to record the time from one statement to another statement by storing the time of the first statement in an attribute, variable, or array element with CLOCK() and using the same attribute, variable, or array element as the expression in the LOG statement. Use the LOG statement to determine throughput time or throughput in a particular section of the facility.

Valid In

Downtime logic, location processing logic, node entry and exit logic, and routing exit logic.

Components

<string>
This string will be stored in the file before the result of the log expression and may not be a string expression. Use this string to identify the number that follows.

<expression>
The result of this expression subtracted from the model’s current time will be stored in the file <model name>.LAP, after the string above.

Example

The example below shows a LOG statement used to capture each Client’s total throughput time as they travel through the system. Time starts when the Client arrives at Receptionist and stops when the Client exits through the door. The first process sets attribute CT equal to the current clock time. Next, Clients are sent randomly to one of three offices. Finally, when a Client leaves the system at location OutDoor, the LOG statement records the cycle time by subtracting the time stored in attribute CT from the current simulation time.
### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Reception</td>
<td>CT=CLOCK()</td>
</tr>
<tr>
<td>Client</td>
<td>Auditor</td>
<td>WAIT T(5,6,8)</td>
</tr>
<tr>
<td>Client</td>
<td>Loan</td>
<td>WAIT T(4,5,5,7)</td>
</tr>
<tr>
<td>Client</td>
<td>Service</td>
<td>WAIT N(6.2,1.1)</td>
</tr>
<tr>
<td>Client</td>
<td>OutDoor</td>
<td>LOG &quot;Cycle Time&quot;, CT</td>
</tr>
</tbody>
</table>

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Client</td>
<td>Auditor Loan</td>
<td>RANDOM 1</td>
<td>MOVE FOR 1.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Service</td>
<td>RANDOM</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Client</td>
<td>OutDoor</td>
<td>FIRST 1</td>
<td>MOVE FOR 0.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RANDOM</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Client</td>
<td>OutDoor</td>
<td>FIRST 1</td>
<td>MOVE FOR 0.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RANDOM</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Client</td>
<td>OutDoor</td>
<td>FIRST 1</td>
<td>MOVE FOR 1.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RANDOM</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Client</td>
<td>EXIT</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### See Also

WRITE, WRITELINE, and READ. Also see “External Files” on page 254.
MapArr

General Action Statement

Syntax samples

```
MAPARR <array name>{TO <variable name>}
MAPARR Array1 TO Var10
MAPARR Array5
```

Description

Starting with the variable you specify, the MAPARR statement maps each individual cell of an array to a unique variable (i.e., if you define 12 cells for the array, the array will map to 12 variables). To display the cell value of a mapped array, create a variable graphic for the variable to which you mapped the array cell. ProModel collects statistics for an array cell through the variable to which you mapped the cell. (Choose “Basic” or “Time Series” statistics for a mapped variable, then view the variable in the Statistics Output program.)

If you do not specify the optional variable name in the statement, ProModel will unmap the array from the variables to which you originally mapped it. You can remap arrays by using the MAPARR statement again.

Valid In

Any logic.

Components

```
<array name>
```

Map, unmap, or remap this array. The brackets, [ ], are unnecessary after the array name in the statement.

```
TO <variable name>
```

The optional name of the variable to which you map the first cell in the array. If you do not specify a name, ProModel will unmap the array from the variables.

Example

Suppose you want to dynamically view an array, Storage_Array, during simulation. The array has a dimension of 2x3x2 (a three-dimensional array with 2 cells in the first dimension, 3 cells in the second, and 2 cells in the third) and contains a total of 12 cells (multiply all the dimensions together).

Since you already used the first 8 of the 30 variables defined in the model, Var1 through Var30, you will start mapping the array with Var9 and end with Var20 (the 12th variable from Var9 listed in the Variables module). In the initialization logic, use the following statement:

```
MAPARR Storage_Array TO Var9
```

The cells in Storage_Array will map to variables Var9 to Var20 in the following order:

```
[1,1,1] ... Var9
[1,1,2] ... Var10
[1,2,1] ... Var11
[1,2,2] ... Var12
[1,3,1] ... Var13
[1,3,2] ... Var14
[2,1,1] ... Var15
[2,1,2] ... Var16
[2,2,1] ... Var17
[2,2,2] ... Var18
[2,3,1] ... Var19
[2,3,2] ... Var20
```

In the Variables module, create graphics for variables Var9 through Var20 and place them on the layout. This will allow you to view them during the simulation.
Please note

Changing the cell value of a mapped array will change the value stored in the array cell AND the value of the variable to which you mapped the specific cell. Changing the value of a variable (e.g., INC Var12), however, will change ONLY the variable value and NOT the cell value of the mapped array cell. Also, when you use a mapped array in an expression, the array returns the value of the variable mapped to it.
Chapter 14: Match

Match

Entity-Related Operation Statement

Syntax samples

MATCH <attribute>
MATCH Attr1

Description

Causes the current entity to wait until the value of the specified attribute matches the value of another entity’s same attribute. Both entities must have a corresponding MATCH statement specified for the same attribute name. The two entities may be at any location in the model, including the same location and two completely unrelated locations. Therefore, the value of the attribute to MATCH should almost always be assigned to the value of a global variable incremented for each entity that will be matched, as in the following example.

Locations using the MATCH statement usually should be multi-capacity because otherwise they would not be able to process any other entities until the MATCH was made. Additionally, locations using MATCH usually should be non-queuing to allow the entities to move out of sequence when the MATCH is fulfilled.

Use the MATCH statement to pair two specific parts before assembling them, or to match a work order to a completed job.

Valid In

The operation column of process edit tables only.

Components

<attribute>
Any attribute associated with the processing entity.

Example

You can use a MATCH to recombine the parts of an entity which has been split using multiple routing blocks. In the example below, every time an EntAB arrives at the location, the variable Count increments. ProModel assigns Attr1 for EntAB the value of count, which ensures that each EntAB will have a unique value for Attr1. Additionally, when each EntAB is split into EntA and EntB, both of the resulting entities, (EntA and EntB) will have the same value for Attr1. EntA and EntB then travel independently through their respective processing steps, denoted by the ellipses. Finally, EntA and EntB arrive at Loc10A and Loc10B respectively, where each piece must wait for its matching half to arrive before consolidating the entities with the JOIN construct.
### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntAB</td>
<td>Loc1</td>
<td>INC Count Attr1= Count</td>
</tr>
<tr>
<td>EntA</td>
<td>Loc2</td>
<td>...</td>
</tr>
<tr>
<td>EntA</td>
<td>Loc10A</td>
<td>MATCH Attr1</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc3</td>
<td>...</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc10B</td>
<td>MATCH Attr1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JOIN 1 EntA</td>
</tr>
</tbody>
</table>

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST 1 MOVE FOR 5</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>EntB</td>
<td>Loc3</td>
<td>FIRST 1 MOVE FOR 5</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc10B</td>
<td>JOIN 1 MOVE FOR 30 sec</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>EntAB</td>
<td>Loc11</td>
<td>FIRST 1 MOVE FOR 5</td>
<td></td>
</tr>
</tbody>
</table>

### See Also

WAIT...UNTIL and LOAD.
Move

Entity-Related Operation Statement

Syntax samples

MOVE {FOR <time expression>}
MOVE FOR .25 min
MOVE FOR 3.2
MOVE

Description

Moves the entity to the end of a queue or conveyor location. Use the MOVE statement to explicitly control the movement of an entity through a queue or conveyor.

Please note

*If there is no MOVE statement, when an entity enters a queue or conveyor, it executes all the processing logic defined for the entity at that location and then moves to the end of the queue or conveyor. For queues, its movement time is based on the entity’s speed and the queue’s length. For conveyors, its movement time is based on the conveyor speed and length.*

If an entity processing at a queue or conveyor encounters a MOVE statement, the entity stops executing the processing logic, moves to the end of the queue or conveyor in the appropriate amount of time, and then resumes the processing logic. The move-time for an entity on a conveyor is calculated using the following formula:

\[
\text{Time} = \frac{(\text{Conveyor Length} - \text{Entity Length or Width})}{\text{Conveyor Speed}}
\]

For queues only, a MOVE may optionally be followed by a FOR statement and then a move-time. If a move-time is specified, the entity moves through the queue in the specified amount of time regardless of the entity’s speed and the queue’s length. Entities with shorter move times will catch up to, but will not pass, entities with longer move times.

If a queue is not empty when an entity enters the queue, then the move-time will continue to elapse even though the arriving entity’s graphic may have stopped moving. When an entity’s move-time has elapsed, an entity will begin executing any logic following the MOVE statement and then will be available for routing, even if graphically the entity does not appear to be at the end of the queue.

For a conveyor, if additional logic follows a MOVE statement, the entity must advance to the last position on the conveyor before the remaining logic is executed.

Valid In

The operation column of process edit tables only, and only if the location is a queue or a conveyor. MOVE may only be used once per logic.

Components

*time expression*

The amount of time needed for the entity to travel through the queue. This expression is ignored for conveyors. It is evaluated every time the statement is encountered and should be on the same line as the MOVE command.
Example

The example below shows the processing steps necessary to mimic the behavior of a queue system using MOVE statements. Locations Queue1, Queue2 and Queue3 should each be represented graphically with a queue symbol. The time value in the MOVE statement represents the time required to traverse each queue section from beginning to end when the queue is empty.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Queue1</td>
<td>MOVE FOR 2.5</td>
</tr>
<tr>
<td>ALL</td>
<td>Queue2</td>
<td>MOVE FOR 3.5</td>
</tr>
<tr>
<td>ALL</td>
<td>Queue3</td>
<td>...</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ALL</td>
<td>Queue2</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>ALL</td>
<td>Queue3</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

See Also

“Locations” on page 90. Also see WAIT.
Move For

Entity-Related Move Logic Statement

Syntax samples

MOVE FOR <time>
MOVE FOR 0
MOVE FOR 2.5 + CleanupTime
MOVE FOR N(8, .5) + 3 sec

Description
Used to specify the amount of time required to move the entity. A move-time of zero may be entered to cause events for other entities occurring at the same simulation time to be processed before any additional logic is processed for the current entity. If no move related statement (MOVE FOR, MOVE ON, MOVE WITH) is specified, the entity instantly enters the next location and immediately begins executing the operation logic for that location.

Valid In
This statement is valid in Move Logic. MOVE FOR may be encountered only once by an entity in the same logic.

Components

<time>
The length of time the system takes to execute the move. This expression is evaluated whenever the statement is encountered. If no time unit is specified, the default time unit specified in the General Information dialog is applied.

Example

It takes 4 minutes for the entity, Cutter, to move from one location, Grinder, to the next location, Profiler.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutter</td>
<td>Grinder</td>
<td>GET Operator WAIT 1</td>
</tr>
<tr>
<td>Cutter</td>
<td>Profiler</td>
<td>WAIT Attr1</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cutter</td>
<td>Profiler</td>
<td>FIRST 1</td>
<td>MOVE FOR 4</td>
</tr>
<tr>
<td>1</td>
<td>Cutter</td>
<td>Exit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See Also
MOVE ON and MOVE WITH. Also see “Routing Move Logic” on page 294.
Move On

Entity-Related Move Logic Statement

Syntax samples

MOVE ON <path network>
MOVE ON StatPath2

Description

Use this statement to move an entity along a path network.

Valid In

This statement is valid only in Move Logic. MOVE ON may only be encountered once by an entity in the same move logic.

Components

<path network>

Any valid path network name.

Example

An entity, EntA, moves from StationA to StationB along a network called Net1.

---

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>StationA</td>
<td>WAIT 2</td>
</tr>
<tr>
<td>EntA</td>
<td>StationB</td>
<td>...</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>StationB</td>
<td>FIRST 1</td>
<td>MOVE ON Net1</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

**See Also**

MOVE FOR and MOVE WITH. Also see “Routing Move Logic” on page 294.
Move With

Entity-Related Move Logic Statement

Syntax samples

MOVE WITH <res1> {,p1}
   OR <res2> {,p1}
   {FOR <time>} {THEN FREE}

MOVE WITH Technician, 100
MOVE WITH Operator1, 399 FOR 3 min
MOVE WITH Truck1, 99 THEN FREE
MOVE WITH Operator1 OR Operator2

Description

This statement is used to move an entity using a designated resource such as a person or forklift. With the OR operator, you can designate alternative resources for making the move. In this case, the statement captures the first available resource designated in its expression and makes the move. As soon as the destination becomes available, the entity implicitly gets the resource. However, if one of the resources is already owned by the entity, it will use that resource.

It also allows you to set the priority (p1) for accessing the designated resource. If the resource is already owned by the entity, this priority is ignored.

If the resource is static, you may specify a time (FOR <time expression>) for the move. If a resource is dynamic, a time (FOR <time expression>) is not valid. If you use “FOR <time>” with a dynamic resource, ProModel ignores the time. The resource will travel based on either the time or speed/distance defined in the path networks module.

The resource used to make the move is freed only if the THEN FREE option is used.

Valid In

This statement is valid only in Move Logic. MOVE WITH may only be encountered once by an entity in the same move logic.

Components

<res1>
Resource to be captured and used to transport the entity.

<res2>
Alternate resource to be captured and used to transport the entity.

<priority>
The priority for accessing the resource. If the resource is already owned by the entity, this priority is ignored.

<time>
The length of time the system takes to execute the move. Used only if the resource is static. This expression is evaluated whenever the statement is encountered. If no time unit is specified, the default time unit specified in the General Information dialog is applied.
Example

An entity moving from Station A to Station B may use either Tech1 or Tech2 to move the entity depending on which one is available first. The resource is freed after the move.

MOVE WITH Tech1 OR Tech2 THEN FREE

The same thing could be accomplished in longer form:
GET Tech1 OR Tech2
MOVE WITH OwnedResource()
FREE OwnedResource()

See Also

MOVE FOR and MOVE ON. Also see “Routing Move Logic” on page 294.
Next()

Resource-Specific System Function

Syntax samples

NEXT()
Var1=NEXT()
IF NEXT() = PathNet5.N11 THEN Var5=3

Description

Returns the name-index number of the resource’s destination node. Use NEXT() to determine the direction an entity is headed and choose the appropriate graphic. This function can be used to control interference between multiple transporters on the same path network. You can also check the name-index number of the next node by specifying <path network name>. <name of the node>. For example, if you wanted to know if the next node is N5 on the network Net3, you could specify “IF NEXT() = Net3.N5 THEN...” in the node exit logic.

Valid In

Node exit logic. This function returns a name-index number.

Example

This Exit Logic window shows that whenever the resource leaves a node a check is made to see if the name-index number of the next node equals 1. If so, the resource graphic is changed to Graphic 3. (Otherwise it is changed to Graphic 2.)

See Also

LAST() and WAIT...UNTIL.
Order

General Action Statement

Syntax samples

ORDER <expression> <entity> {TO <location>}
ORDER 10 EntA TO Loc2
ORDER Order_Qty_Attr ENT(Entity_Attr) TO LOC(Loc_Attr)

Description

Causes the specified number of entities to be created and placed into the system at the designated location. If the location does not have enough capacity for all the new entities, the excess entities will be destroyed. Attributes from the creating entity will be copied to the resulting entities. Use ORDER to replenish inventories when a particular condition occurs. Such as when an inventory reaches the minimum level.

Valid In

Any logic.

Components

<expression>

The number of new entities to be ordered. This field is evaluated every time the ORDER statement is encountered, allowing the number ordered to vary as the simulation progresses.

<entity>

The name of the new entities. ENT() may be used for an entity name.

<location>

The destination of the new entities. LOC() may be substituted for the names of locations. If no location is specified, the entities will be ordered to the location of the ORDER statement.

Example

In this example, EntA arrives at LocA1 and triggers an order for 100 EntB’s to LocB1.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>LocA1</td>
<td>ORDER 100 EntB TO LocB1</td>
</tr>
<tr>
<td>EntB</td>
<td>LocB1</td>
<td>...</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>LocA</td>
<td>FIRST 1</td>
<td>MOVE WITH Forklift</td>
</tr>
</tbody>
</table>

See Also

SEND, CREATE, and SPLIT AS.
**OwnedResource()**

**Resource-Specific System Function**

**Syntax samples**

OWNEDRESOURCE ({<expression>})
OWNEDRESOURCE (2)
OWNEDRESOURCE (ResQty())
OWNEDRESOURCE ()

**Description**

Returns the name-index number of the nth resource currently owned by the entity or downtime making the function call. The function parameter indicates the position of the resource in the chronological list of owned resources. For example, OwnedResource(1) returns the longest owned resource in the list and so on.

When used without a parameter, this function returns the most recent resource that the entity captured and still owns. If the parameter value is not within the range of the resource list, or if the entity or downtime currently does not own a resource, the function will return a 0 (zero) without a warning or error message.

A preempted resource is NOT removed from the list but marked temporarily to indicate that the preemptee does not own the resource. After the resource resumes the original process after being preempted, it retains its original rank in the list.

**Valid In**

Entity speed fields, traveling-time fields, resource fields, resource downtime logic, location processing logic, location downtime logic, routing fields, arrival logic, debug user-condition fields, and move logic.

**Components**

<expression>

The nth resource currently owned by the entity or downtime making the function call. When this parameter is not used, the function returns the last resource captured that is still owned by the entity.

**Example**

Suppose an entity owns two resources. The first resource was captured using the statement GET Worker. The second resource was captured using the statement GET Oper1 OR Oper2. We know the entity owns the resource Worker, but we do not know if the entity owns Oper1 or Oper2. It is time to release the second resource so we use the following logic:

FREE OWNEDRESOURCE()  

**See Also**

RES(), GET, JOINTLY GET, USE, and FREE. Also see “Resources” on page 126.
Pause

General Action Statement

Syntax samples

PAUSE {<string expression>}
PAUSE
PAUSE “Var1 =” $ Var1
PAUSE “Reached the midpoint of the simulation.”

Description
Pauses the simulation and optionally displays a message at some point of interest. This pause allows the user to examine the system in detail. An information dialog box will appear on the animation screen when the pause occurs. The simulation will continue only when the user selects Resume Simulation from the Simulation menu.

Valid In
Any logic.

Components

<string expression>
The optional message to display.

Example

The simple example below pauses the simulation after the 100th EntA has been processed at Loc1. The purpose for doing this might be to view the current state of the system at this particular point in time.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT N(3.2,.1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INC Total</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IF Total &gt;= 100 THEN PAUSE</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>

See Also

STOP, DISPLAY, and PROMPT.
PercentOp()

General System Function

Syntax samples

PERCENTOP (<locationname>)

Description

Returns the cumulative operation time percentage for the specified, single-capacity location. The value returned by this function represents the cumulative percentage of time the location was actually processing an entity up to the point where the function was called.

If PercentOp() is called for a multiple-capacity location, the value returned will always be zero, since operation time percentage is not calculated for multiple-capacity location

Note: The method used to calculate operation percentage for this function is the same method used in the output statistics.

Valid In

Any Logic.

Components

<locationname>

The name of the location.
PercentUtil()

General System Function

Syntax samples

PERCENTUTIL (<locationname>)

Description

Returns the cumulative utilization percentage for the specified location. The value returned by this function represents the cumulative percentage of capacity occupied at the location, on average, at the time the function was called.

\[
\text{Cumulative Occupancy Time} \times \frac{100}{\text{Capacity} \times \text{Scheduled Time}}
\]

Cumulative Occupancy Time in the above equation refers to the sum of the clock time each entity spends at a location for processing.

PercentUtil() may be called to return percent utilized for both multi- and single-capacity locations.

Note: The method used to calculate utilization percentage for this function is the same method used in the output statistics.

Valid In

Any Logic.

Components

<locationname>

The name of the location.
Preemptor()

Preemption Logic System Function

Syntax samples

PREEMPTOR()
Var1=PREEMPTOR()

Description

Identifies whether a downtime or entity is making the preemptive request. The function returns the name index number of the preempting entity; however, it returns a 0 if the preemptor is a downtime.

Valid In

Operation logic defined as a preemptive process.

Example

Workers may process an entity, bracket, at one of two locations, Punch_1 or Punch_2. You may preempt the bracket at Punch_1 by either an entity with a preemptive priority or a location shift downtime with a preemptive priority. If an entity preempts the bracket, workers send the bracket to Punch_2 to finish processing. Punch_1 and Punch_2 are on the same shift, and are scheduled to go off-shift at the same time. Therefore, if a shift downtime preempts the bracket at Punch_1, the bracket would not be able to go to Punch_2. In this case, the bracket is sent to a location called Punch_Wait where it waits for Punch_1 to come back on-shift. The PREEMPTOR() function determines whether an entity or shift downtime preempts the bracket.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bracket</td>
<td>Punch_1</td>
<td>WAIT 3 min</td>
</tr>
<tr>
<td>Bracket*</td>
<td>Punch_1</td>
<td>IF PREEMPTOR()&gt;0 THEN ROUTE 1 ELSE ROUTE 2</td>
</tr>
</tbody>
</table>

* Preemptive Process Record

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bracket</td>
<td>Inspect</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Bracket</td>
<td>Punch_2</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Bracket</td>
<td>Punch_Wait</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>

See Also

“Preemption Process Logic” on page 292.
Priority

Shift & Break Logic Statement

Syntax samples

PRIORITY <expression>
PRIORITY 199

Description
This statement is used to change the priority of the off-line state of the location or resource. If the priority is less than the value set previously, the system will check if the location or resource can be preempted.

Valid In
Shift and break main logic only. This statement is not valid in pre-off shift or pre-break logic.

Components

<expression>
Any expression that yields a value between 0 and 999. Standard ProModel priority levels apply.

Example

Suppose you want to insure that the resource is non-preemptable for the first four hours it is off-shift. Simply enter a high (e.g., 999) off-shift priority value in the priority dialog in the Shift Assignments module. Enter the following off-shift logic to lower the priority (to 99) four hours into the off-shift period:

WAIT 4 hr
PRIORITY 99
WAIT 4 hr
SKIP

See Also
“Shift & Break Logic” on page 297.
Prompt

General Operation Statement

Syntax samples

PROMPT <string expression>, <name>{,
    <choice1>:<expression1>,
    <choice2>:<expression2>,
    <choice3:<expression3>...}

PROMPT “Enter the number of entities to process:”, Var2

PROMPT “Enter the size of batches to accumulate:”, Var1, “Large”: 20, “Medium”: 15, “Small”: 10

Description

Pauses the simulation and displays either a message and input field or a menu for selecting a choice. The value entered or selected is then assigned to the designated variable, array element, or attribute. To have PROMPT present a menu, specify one or more choices as in the second syntax example above. The value already in the variable, array element, or attribute is used as the default value in the dialog box. One use of PROMPT is to give the user the option to change the operation time represented by a variable during a simulation.

Valid In

Any logic.

Components

<string expression>

The message to display. This expression should tell the user what value to enter or choose.

{name}

The name of the variable, array element, or attribute to give the value. The value already in this item will be used as the default value.

<choices>

A string expression identifying the choice. Any number of choices may be specified, and all must have corresponding expressions.

<expressions>

The value to assign the variable, array element or attribute if the user selects the corresponding choice from the menu.

Example

The logic below uses PROMPT to let the user select any size of a batch. Attr1 represents the batch size for EntA. If the batch size has not been set (if Attr1=0), then the user is prompted to enter the batch size. The SPLIT AS statement then splits the single entity into the number of entities specified in the prompt dialog box. The PROMPT statement in this example displays the following dialog box.

IF Attr1=0 THEN
PROMPT “Enter the Batch Size”, Attr1
SPLIT Attr1 AS EntA

![Prompt dialog box image]
**Example**

This logic works similarly to the logic in example one, except that it uses PROMPT to let the user select from one of three different sized batches. The PROMPT statement in this example displays the dialog box below.

IF Attr1=0 THEN
SPLIT Attr1 AS EntA

### See Also

PAUSE; DISPLAY. Also see “Run-Time Interface” on page 234.
Rand()

Math Function

Syntax samples

RAND(<expression>)
RAND(10) min
ORDER RAND(10) EntA TO Loc1
IF RAND(100) > 45 THEN ROUTE 1

Description

Returns a random value n between 0 and X (0 <= n < X) where X is the result of the expression.

To generate random numbers between the expression and a number other than zero use the expression as the range between the maximum and minimum values. Then add the minimum to the random number. For example, the statement Attr1 = 2+RAND(3) generates a random number from two up to, but not including, five. An alternate method is to use a uniform distribution. Note that the RAND() function works very similar to a uniform distribution. For more information on Distributions, see “Distribution Functions” on page 427.

This function returns a real number, although the real value may be converted to an integer. To have the RAND() function generate random integer values between zero and some upper bound, use the formula, Integer_Value = RAND(X+1), where X is the greatest integer that should be returned by the function. For example, to generate a random integer value between zero and six, use the formula, Integer_Value = RAND(7). The RAND(7) part of this formula will actually generate a real value between 0 and 6.999, but will be truncated to a whole number between 0 and 6 when assigned to an integer value. Therefore, when generating integer values, make sure that the result of the RAND() function is assigned to an integer value, or is used in an expression where it will be truncated to an integer.

Valid In

Any expression.

Components

 Zamagi

Example

Two resources, Oper_1 and Oper_2, perform the same task at a location, Press. Oper_1 works at several other locations. As a result, Press only uses him 30% of the time. The other 70% of the time, Oper_2 performs the task.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axle</td>
<td>Press</td>
<td>IF RAND(100) &lt; 30 THEN USE Oper_1 ELSE USE Oper_2</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Axle</td>
<td>Lather</td>
<td>FIRST 1</td>
<td>MOVE FOR 3</td>
</tr>
</tbody>
</table>

See Also

“Streams” on page 258.
Read

General Action Statement

Syntax samples

READ <file ID>, <name>
READ File1, Var1

Description

Reads the next numeric value from a general read file and assigns that value to a name. General read files are defined in the External Files Editor. When reading from a file, ProModel skips all non-numeric data, such as text, and reads the next numeric value. Thus comments and notes may be included in a read file. Multiple replications of a model will continue reading from a file where the previous replication left off unless reset with the RESET statement.

Please note

ProModel reads a period (.) in a General read file as a zero. To avoid this, you should use the comment symbol (#) in front of notes and comments that contain a period.

Valid In

Any logic.

Components

<file ID>

The file identifier as defined in the External Files Editor.

<name>

The variable, array element, or attribute to be assigned the value.

Example

The example below shows an outside file being read in the Arrival logic for entity type Box. In this case three values representing the length, width and depth of each Box are listed on each line of a file called “Size.Dat.” The File ID for this file is simply Size. Length, Width, and Depth are all entity attributes.

READ can read ASCII files. Most spreadsheet programs can convert spreadsheets to ASCII files (.TXT) and comma-delimited files (.CSV).

If a read statement is not assigning the right values to the proper name, there may be numeric information in the read-file’s header information (notes and comments). Additionally, if the values are being read into an array, the array indices may not be incremented properly between reads.
See Also

“External Files” on page 254. Also see RESET and CLOSE.
Real

Local Variable Declaration Statement

Syntax samples

REAL <name1>{= <expression1>, <name2>= <expression2>...}

REAL Var1
REAL Counter = 0
REAL Var1 = CLOCK(SEC), Random_Num = RAND(10)

Description

Creates a local variable of type real. Local variables work much the same as attributes, except that they only are available within the logic that declares them. A local variable will be created for each entity that encounters a REAL statement. Local variables are not directly available to subroutines, which have their own local variables. However, a local variable may be passed to a subroutine as a parameter. Local variables are available to macros.

Valid In

Any logic. Variables declared with REAL are valid in any expression within the logic where a real number is valid.

Components

<names>

An identifier for the first local variable. This identifier must be a valid name.

<expressions>

The variable will initially be assigned this value. This expression is evaluated every time the REAL statement is encountered.

Example

The example below uses a local real variable to track the total time an entity waits for another entity to be joined to it. A shipping area has an operation where invoices are joined to boxes to produce packages. The user wants to know exactly how long an invoice must wait before a box arrives to be joined. By setting the value of a local variable, Start, to the clock time just before the JOIN statement and using a LOG statement immediately after the JOIN, we can determine how long each invoice had to wait before a box arrived. A local variable is a better choice here than an entity attribute because the only place the information is needed is inside this logic.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Packing</td>
<td>WAIT N(10,3)</td>
</tr>
<tr>
<td>Invoice</td>
<td>Shipping</td>
<td>REAL Start = CLOCK()</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JOIN 1 Box</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LOG &quot;Delay:&quot;, Start</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Box</td>
<td>Shipping</td>
<td>JOIN 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td>1</td>
<td>Package</td>
<td>Dock</td>
<td>FIRST 1</td>
<td>MOVE FOR 3</td>
</tr>
</tbody>
</table>

See Also

INT. See “Variables” on page 223.
Real()

Type Conversion Function

Syntax sample

REAL(<expression>)
Var2 = Var1 + REAL(Var3)
Attr3 = 1.05 * REAL(Var5)

Description
Converts an integer to a real number. ProModel automatically converts integers to real when needed.

Valid In
Any expression.

Components

<expression>
REAL() converts this expression to a real number.

See Also
ROUND() and TRUNC().
Rename

Entity-Related Operation Statement

Syntax samples

RENAME {AS} <new entity name>
RENAME EntB
RENAME AS EntB
RENAME AS ENT(Var2)

Description

Renames the processing entity to the new entity name. After a RENAME statement is encountered, the entity then searches forward in the process list and again from the beginning until a process is found at the current location that has been defined for the new entity type. No further logic will be executed for the entity under its original name. Use RENAME to start collecting statistics for an entity under a new name. Usually, the easiest and most efficient way to rename an entity is simply by using the new name as the output entity in the routing.

Valid In

The operation column of process edit tables only.

Components

<new entity name>

The new name of the processing entity. ENT() may be substituted for the entity name.

Explicit Entity Actions

With RENAME, statistics and cost continue on with the entity.

Implicit Entity Actions

ProModel allows you to define the RENAME action implicitly as part of the routing definition. To do this, define a route block with a different input and output name and the New Entity option unchecked.

Example

The following example shows how two entities, EntA and EntB, join together at Loc2. Once the join is complete, ProModel renames the resulting entity EntC and processes it according to a normal distribution N(9.4,.3). RENAME is the last statement in the process because as soon as you rename an entity, ProModel searches the processing logic for a process for the entity with the new name.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 1.5 min</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc2</td>
<td>JOIN 1 EntA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RENAME AS EntC</td>
</tr>
<tr>
<td>EntC</td>
<td>Loc2</td>
<td>WAIT N(9.4,.3)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>JOIN 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>EntC</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>

See Also

COMBINE, SPLIT AS, and GROUP.
Chapter 14: Report

General Action Statement

Syntax samples

REPORT {WITH RESET} {AS <string expression>}
REPORT
REPORT WITH RESET
IF thruput = 50 THEN REPORT AS “RepOvr50”

Description
Calculates and reports the current statistics to the output database. This is useful to get a snapshot of the model while it is running.

The REPORT statement may be followed by the WITH RESET option to reset the statistics after the report is made to the database. When you use the WITH RESET option, you generally want to provide some looping or event creation that will call the report function at the appropriate time.

Used with the AS option, REPORT creates a report with the name specified in the expression that can be accessed in the Output Program when creating a General Stats report.

Valid In
Any logic.

Components

<string expression>
A unique name given to the report so it can be easily identified in the General Stats dialog in the Output Program. If any reports have the same name, a number is tacked on the end of the name to make it unique.

Example

To get a snapshot report every 40 hours, enter the following:

WHILE Clock(hr) < 10000 DO
BEGIN
WAIT 40 hr
REPORT AS “40HOUR”
END

This results in reports named, 40HOUR, 40HOUR2, 40HOUR3....

Please note

If you use the REPORT statement even once, a final overall report will NOT be created since the report generated with your use of the statement may be the final report desired. In this case, you must use the REPORT statement at the end of termination logic in order to create a final report if desired. If a REPORT statement is never used, a final overall report is created automatically.

See Also
RESET STATS and WARMUP.
**Res()**

**Name-Index-Number Conversion Function**

**Syntax samples**

```
RES(<resource name-index number>)
USE 10 RES(Var1) for 1.5 min
FREE RES(Var1)
DISPLAY “Now using” $ RES(Var1)
```

**Description**

Converts a name-index number or integer to a resource name. Use this function when a statement or function needs the name of a resource whose name index number is stored in an attribute, variable, or some other expression. When used in a string expression expecting, such as in the third syntax example above, ProModel will output the actual name of the resource.

Use RES() to assign a properly skilled operator according to the attribute of the part or to change the duties of resources as the simulation progresses.

**Valid In**

Any statement where a resource name is normally used, except in the Move Logic field in the Routing edit table. Also used in string expressions.

**Components**

**<resource name-index number>**

The name-index number of the resource desired. This component may be an expression. Real numbers will be truncated to integers.

**Example**

The logic below uses five different resource types for ten minutes in rotation.

```
INT Var1 = 1
WHILE Var1 <= 5 DO
BEGIN
USE RES(Var1) FOR 10 min
INC Var1
END
```

**See Also**

ENT(), LOC(), and GRAPHIC.
Reset

General Action Statement

Syntax samples

RESET <file ID>
RESET Times
RESET (Times)

Description

Starts a general read file over from the beginning. RESET is used primarily in the Initialization or Termination logic to reset a general read or write file at the beginning or end of multiple replications and single, independent runs. RESET can also be used to re-read cyclic data in the same simulation run. The parentheses are optional and are included only to insure compatibility with older models.

Valid In

Initialization and termination logic, node entry and exit logic, down-time logic, location processing logic, routing exit, and arrival logic.

Components

<file ID>

The file identifier as defined in the External Files Editor.

Example

The example below shows how a general read file, Times, is reset in the Initialization logic. Each time a simulation begins, whether a single replication or one of several multiple replications, the Times file is reset so that calls to the Times file start at the beginning of the file.

See Also

“External Files” on page 254. Also see READ, WRITE, XWRITE, and RESET.
Reset Stats

General Action Statement

Syntax samples

RESET STATS
IF Total = 20 THEN RESET STATS

Description
Resets the simulation statistics. Useful in connection with the REPORT statement to manually control statistics for reporting purposes in case specific or event logic.

Valid In
Any logic.

Example
Suppose you want to generate a new output report for each 20-hour period of the simulation. Enter the following logic in an independent subroutine which is activated at the beginning of the simulation:

WHILE Clock(hr) < 10000 DO
BEGIN
WAIT 20 hr
REPORT
RESET STATS
END

See Also
REPORT and WARMUP.
Resource()

Shift & Break System Function

Syntax samples

RESOURCE ()

Description
Returns the name-index number of the resource currently processing the off-shift or break logic.

Valid In
Off-shift and break logic.

Example

Suppose you have locations and resources as members in a shift file assignment and you want to wait until variable Parts_To_Process is equal to zero before allowing a particular resource called Operator to go off shift. You would enter the following pre-off shift logic:

IF FORRESOURCE() THEN
BEGIN
IF RESOURCE() = Operator THEN
BEGIN
WAIT UNTIL Parts_To_Process = 0
END
END

See Also
LOCATION(), FORLOCATION(), and FORRE-SOURCE().
ResourceUnit()

Shift & Break System Function

Syntax samples

RESOURCEUNIT()

Description
Returns the unit number of the resource being used.

Valid In
Off-shift and break logic.

Example
When a multi-unit resource goes on shift, it is sometimes helpful to know which unit of the resource is going off shift. Depending on the resource unit you may want to skip the shift or update a variable that is used elsewhere in your model.
ResQty()

Entity-Specific System Function

Syntax samples

RESQTY({<resource name>})
IF RESQTY(Res1) > 5 THEN FREE 5 Res1

Description

Returns the number of units of the specified resource that the current entity owns. RESQTY() can be used to determine the amount of time necessary to process an entity based on the number of resources an entity owns.

Valid In

Entity speed fields, traveling-time fields, resource fields, location processing logic, routing fields, arrival logic, debug user-condition fields, and exit logic. This function returns an integer.

Components

<resource name>

The name of the resource to check for. If no resource name is specified, the total number of units of all resource types owned by the entity is returned. RES() may be substituted for a resource name.

Example

The example below demonstrates the use of RESQTY() to adjust the processing time for an entity based on the number of resources available to process it. Before EntA's arrive at Loc1, they capture a certain number of resources named Res1. Processing logic at Loc1 determines how many Res1’s each EntA captured and processes it accordingly. The more resources an entity captures, the more workers available to work on the project, and the less time it takes. ProModel then routes EntA’s on to Loc2. The logic at Loc2 makes sure that no EntA owns more than one Res1.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT 120/RESQTY(Res1)</td>
</tr>
<tr>
<td>EntA</td>
<td>Loc2</td>
<td>IF RESQTY(Res1)&gt;1 THEN FREE (RESQTY(Res1)-1) Res1</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc3</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>

See Also

FREECAP(), FREEUNITS(), and GROUPQTY().
Return

General Action Statement

Syntax samples

RETURN {<expression>}
RETURN
RETURN Attr1**Sqrt(Attr2)

Description
Sends a value from a subroutine to the logic that called the subroutine. In the same way that parameters send information from the calling logic to the subroutine, RETURN sends information from the subroutine to the calling logic. After the RETURN is executed, no more logic in the subroutine is executed. When subroutines return values, the RETURN statement must be followed by an expression.

When used in logic that is not a subroutine, RETURN functions like a very powerful BREAK or BREAKBLK statement. Whereas BREAK and BREAKBLK exit only the innermost loop or statement block, RETURN exits the logic completely, no matter how deeply nested inside loops and statement blocks.

Valid In
Any logic, but used most often in user-defined subroutines.

Components

<expression>
The value to return. This expression must be on the same line as the RETURN. If a subroutine was activated, then the return value is ignored.

Example
The following example uses a subroutine to check the supply of items in a storage location. If the free capacity of the location is greater than 10, the user is prompted for an order quantity; otherwise no new items will be ordered. If an order is made, the order time is returned; otherwise the variable OrdTm remains unchanged. The logic for Sub1() appears in the logic window.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item99</td>
<td>Stores</td>
<td>WAIT N(3.2,2)</td>
</tr>
<tr>
<td>Item99</td>
<td>Shipping</td>
<td>OrdTm = Sub1()</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item99</td>
<td>Shipping</td>
<td>SEND 1</td>
<td>MOVE FOR 15</td>
</tr>
<tr>
<td>1</td>
<td>Item99</td>
<td>EXIT</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>
See Also

“Subroutines” on page 238. Also see BREAK and BREAKBLK.
Round()

Math Function

Syntax samples

ROUND(<expression>)
Integer1 = ROUND(3.5)

Description

Rounds the expression to the nearest whole number. Use this function to override ProModel’s default, truncation.

Valid In

Any expression. This function returns an integer.

Components

<expression>

The expression to be rounded.

See Also

TRUNC() and REAL().
Route

Entity-Related Operation Statement

Syntax samples

ROUTE <expression>
ROUTE 2
ROUTE Attr1
ROUTE Dist1()

Description

Executes a routing block for the processing entity. The process does not continue until all of the entities being routed for the particular block have begun executing their move logic. The processing logic may contain several ROUTE statements. These statements may be selected individually using IF...THEN statements, or they may be processed sequentially, with or without other process statements in between. If any ROUTE statement appears in a process logic, then ProModel assumes all routing for that process will be activated by the user and therefore does no automatic routing. If no ROUTE statement appears in the processing logic, then all routing blocks will be executed automatically once processing logic has been completed.

The ROUTE Statement is most often used with IF...THEN statements to make routing decisions based on complex logic that is not available through other ProModel features (such as system functions or the User Condition routing rule). ROUTE, if used with IF...THEN properly, will insure that only one of the routing blocks is activated.

This statement can be used to route one or more entities and leave behind a “ghost” entity that will process the remaining logic after the route statement. The “ghost” entity is also referred to as the parent entity. The child entity takes the route specified by the ROUTE statement. If the child entity cannot go to the next location and is blocked, the parent entity is also blocked and will not continue logic execution until the child entity is no longer blocked. For more information, see “Entities” on page 112.

Valid In

The operation column of process edit tables only.

Components

<expression>

The integer result of this expression determines the routing block that the entity will take. The expression is evaluated every time it is encountered, allowing the chosen block to vary during the simulation.

Example

This example illustrates a “nested” probability routing. The initial entity, EntAB, enters Loc1 and ProModel makes a decision based on the user-defined distribution Dist1() whether to route the resulting entities according to Route 1, Route 2, or Route 3. If ProModel chooses Route 1, it sends an EntA 60% of the time, or an EntB 40% of the time, to Loc2. If ProModel chooses Route 2, it sends an EntA 20% of the time, or an EntB 80% of the time, to Loc3. If ProModel chooses Route 3, it sends an EntA 30% of the time, or an EntB 70% of the time, to Loc4.
### Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTAB</td>
<td>Loc1</td>
<td>Route Dist1()</td>
</tr>
</tbody>
</table>

### Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>.600</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td></td>
<td>EntB</td>
<td>Loc2</td>
<td>.400</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td>2</td>
<td>EntA</td>
<td>Loc3</td>
<td>.200</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td></td>
<td>EntB</td>
<td>Loc3</td>
<td>.800</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td>3</td>
<td>EntA</td>
<td>Loc4</td>
<td>.300</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td></td>
<td>EntB</td>
<td>Loc4</td>
<td>.700</td>
<td>MOVE FOR 2</td>
</tr>
</tbody>
</table>

### See Also

“Routing Rules” on page 405.
Send

General Action Statement

Syntax samples

SEND <expression> <entity name> TO <destination>{,<priority>}
SEND 2 EntA TO Loc2
SEND 1 Grp_A TO Grp_A_Processing, 10

Description

Sends the specified number of a particular entity type to the destination. The entities to be sent must be waiting with a SEND routing rule. The entity that issued the SEND command continues processing whether or not entities of the type requested are waiting to be sent. If no entities are waiting to be sent, a SEND notice is automatically posted so that entities will be sent when they become available.

The SEND statement can model a system based on demand, rather than on entity arrival, (called a pull system). Customer orders cause a SEND to be issued for a main assembly. Main assembly issues SEND commands for sub-assemblies. The example model SEND has an excellent example of this technique.

The SEND statement can also be used as a control device to limit the amount of work-in-progress (WIP) in certain critical areas. Quantities are only sent to the production area when the WIP level falls below a certain point.

Valid In

Any logic.

Components

<expression>

The number of entities to send to the destination. Negative values will generate an error message.

<entity name>

The type of entity to send to the destination. You may substitute ENT() for an entity name.

<destination>

The name of the location to which the entities will be sent. You may substitute LOC() for the location name.

<priority>

Multiple SEND requests for the same entity type are filled according to the longest waiting request having the highest priority. This expression should be a number between 0 and 999. For more information on priorities, see Priorities, at the beginning of this section.

Example

In this example, EntA’s arrive at LocA1 and trigger the sending of EntB’s to LocB2. The value of EntA’s Attr2 determines the number of EntB’s sent to LocB2.
Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>LocA1</td>
<td>WAIT U(3,.5) SEND Attr2 EntB TO LocB2</td>
</tr>
<tr>
<td>EntB</td>
<td>LocB1</td>
<td>Wait 5 min</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>LocA2</td>
<td>FIRST 1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>EntB</td>
<td>LocB2</td>
<td>SEND 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntB</td>
<td>LocB3</td>
<td>SEND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EntB</td>
<td>LocB4</td>
<td>SEND</td>
<td></td>
</tr>
</tbody>
</table>

See Also

ORDER, JOIN, ROUTE, WAIT...UNTIL, and LOAD.
SetRate

General Operation Statement

Syntax samples

SETRATE <resource name>, <expression>, <unit #>

SETRATE Operator, 25, 3

Description

Allows you to define the regular rate of cost for resources contained in a model. If you have already defined the regular rate in the Cost module, this statement will override that rate. You can use SetRate to set different rates for each unit of a resource.

Valid In

Initialization logic.

Components

<resource name>

The name of the resource whose rate you wish to set.

<expression>

The rate assigned to the resource.

<unit #>

The unit number of the resource. Where multiple instances of a resource exist, you must specify which instance of the resource to use (e.g., Tech1, Tech2, Tech3, etc.). The keyword ALL may be used to indicate all instances of a resource.

Please note

SETRATE uses the time units defined for the model. (By default, SETRATE uses hours.)

Example

The logic below displays how you can uniquely assign the regular rate for each unit of a resource, Operator. Operator has three units, meaning that each unit can perform the same task. However, each of the three Operators has a different hourly rate. We set these rates in the Initialization logic using the following:

![Initialization Logic]

See Also

GETCOST, GETRESRATE(), INCENTCOST, INCLOCCOST, and INCRESCOST.
Skip

Shift & Break Logic Statement

Syntax samples

SKIP

Description

In pre-off-shift or pre-break logic, a SKIP statement causes any off-shift or break main logic to be skipped as well as the off-shift or break time defined in the shift file so that the affected location or resource stays on line.

In off-shift or break logic, a SKIP statement causes the off-shift or break time defined in the shift file to be ignored. This is useful if you want to define your own off-shift or break time as part of the logic rather than use the time defined in the shift file.

Valid In

Shift logic only.

Example

Suppose a Worker is scheduled to go on break at 10:15 for fifteen minutes. However, if there are more than two parts in queue, the Worker will skip his or her break to stay on schedule. The following logic is entered in the pre-break logic for the resource, Worker.

IF Contents(Worker_Que) > 2 THEN SKIP

See Also

“Shift & Break Logic” on page 297. Also see FORLOCATION() and FORRESOURCE().
Sound

General Action Statement

Syntax samples

SOUND <string expression>
SOUND “Chimes.wav”
SOUND “Tada.wav”

Description

Plays a wavefile. Wavefiles, which have the extension .WAV, may be purchased commercially or created with a sound card. A few sounds, such as the examples here, come with Windows and are found in the Windows directory. Use SOUND to alert a model’s user that some event has taken place.

Valid In

Any logic.

Components

<string expression>

The DOS name of the wavefile to be played. This expression must evaluate to a valid DOS file. It may include a path.

Example

The example below shows an entity’s operation logic. A variable called Total is used to keep track of the number of entities passing through the location. Every 100th entity to pass through the location will cause the sound “Tada” to sound, thus notifying the user of the 100th entity. In addition, ProModel resets the counter.

See Also

PAUSE, DISPLAY, and PROMPT.
Split As

Entity-Related Operation Statement

Syntax samples

SPLIT <expression> AS <new entity name>
SPLIT 10 AS Entx

Description

Splits an entity into the number of entities you specify, changes the entity names, and divides all cost and time statistics accrued by the base entity between the new entities. ProModel counts the old entity as an exit and the resulting entities share the same attribute values as the original entity.

Any entity you wish to split must release all owned resources using the FREE statement. Use SPLIT AS to divide pieces of raw material into components. The entities formed by the SPLIT AS statement at a location will not appear in the statistics for this location.

Valid In

The operation column of process edit tables only. ProModel does not allow SPLIT AS on conveyors, and not at the end of a queue. You also may not use SPLIT AS after a ROUTE statement. Do not use SPLIT AS in combination with COMBINE, CREATE, GROUP, UNGROUP, LOAD, UNLOAD, or other split statements in the same process logic.

Components

<expression>

Split the entity into this number of entities. ProModel evaluates this expression every time it encounters the statement.

<new entity name>

The name of the resulting entities. Each split entity searches forward in the process list, and then from the beginning of the list, until it finds a process for the new entity type at the current location.

Explicit Entity Actions

When you use the SPLIT AS statement, ProModel divides the accrued cost between the new entities and counts the old entity as an exit. Each new entity begins with new statistical information.

Implicit Entity Actions

ProModel allows you to use the SPLIT AS statement implicitly as part of the routing definition. To do this, define a route block with a Quantity field output value greater than 1 and the New Entity option unchecked.

Example

In the following example, a batch of entities, Batch A, arrives at Loc1 for a 2 hour processing time. Once the processing completes, BatchA splits into individual entities called EntA. ProModel determines the number of EntA’s resulting from the SPLIT AS statement by the value of BatchA’s attribute, Attr3.
Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BatchA</td>
<td>Loc1</td>
<td>WAIT 2 Hr SPLIT Attr3 AS EntA</td>
</tr>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>USE Res1 FOR U(2,.3)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td></td>
</tr>
</tbody>
</table>
Sqrt()

Math Function

Syntax samples

SQRT(<expression>)
Real1 = SQRT(Real2)

Description

Returns the square root of an expression.

Valid In

Any expression. This function returns a real number.

Components

<expression>

SQRT() returns the square root of this expression.

See Also

ROUND().

Please note

To get a root other than the square root, use the exponentiation operator as shown in the following formula:

\[ X^{*(1/Y)} \]

For example, where Y is the desired root, the formula 9**(1/3) returns the cube root of 9.
Stop

General Operation Statement

Syntax samples

STOP {<string expression>}
STOP
STOP “Normal termination”

Description
Terminates the current replication and optionally displays a message. The simulation will then continue with the next replication. Use STOP to end a replication when the simulation has run long enough to provide sufficient statistical data.

Valid In
Any logic.

Components

<string expression>
An optional message to display when the replication stops.

Example

In the example below, a STOP statement is used in Operation Logic to end the simulation whenever the variable Total_Complete reaches 100.

See Also
BREAK, BREAKBLK, RETURN, and PAUSE.
ThreadNum()

General System Function

Syntax samples

THREADNUM()
IF THREADNUM()=215 THEN DEBUG

Description
Every time any logic is executed, it is executed by a thread which is assigned a unique number. THREADNUM returns the number of the thread that called the function. This function is most useful in conjunction with the IF...THEN and DEBUG statements to bring up the debugger at a certain process. See below for a detailed example. Note that if the model does not change between simulation runs, every thread will have the same number from run to run, but not from replication to replication. Also, most changes in a model will cause threads to have different numbers on subsequent runs.

Valid In
Any logic

Example
For example, suppose that when the 50th entity of a certain type arrives at a certain location, the model always crashes. A DEBUG statement at the beginning of the processing logic would be cumbersome because the debugger would come up forty-nine times before it was needed. However, when the error occurs, the debugger displays the process and logic that caused the error, as shown below.

By adding the statement, “IF THREADNUM() = 210 THEN DEBUG” before the statement that causes the error, the simulation will run until the proper process and then bring up the debugger. The debugger can then be used to step through the process to find the particular statement causing the error.

See Also
DEBUG.
TimeLeft()

Preemption Logic System Function

Syntax samples

TIMELEFT()
Attr1=TIMELEFT()

Description
Returns the time remaining if the preemption occurred during a WAIT statement. The value returned is in default time units and must be checked before any processing delay occurs since the value is updated whenever a preemption takes place. If the value is referred to later, it should be assigned to the entity’s attribute or to a local variable.

If several entities were preempted at a location, the value returned by the function to each entity will be taken from whichever entity has the largest time remaining in the WAIT statement.

When no units are specified in the parentheses in this function, it returns the default time unit specified in the General Information dialog.

Valid In
Operation logic defined as a preemptive process.

Example
You may preempt an entity called Gear while it processes at a location called Lathe1. When you preempt the Gear, it should go to a location called Wait_Area where it waits to return to Lathe1. When it returns to Lathe1, the lathe should continue processing the Gear from where it left off when you preempted the Gear. For example, if Lathe1 must process the Gear for a total of 10 minutes, but it only processes for 8 minutes before you preempt the Gear, Lathe1 should process it for only 2 additional minutes when it returns to Lathe1. To do this, we assign the remaining process time using TIMELEFT() to an attribute, Att1. We also check Att1 at Lathe1 to determine if it is greater than 0 to know whether the Gear was executing the process for the first time or as a preempted entity. Processing should be as follows:

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gear</td>
<td>Lathe1</td>
<td>IF Att1=0 THEN WAIT 10 ELSE WAIT Att1</td>
</tr>
<tr>
<td>Gear *</td>
<td>Lathe1</td>
<td>Att1=TIMELEFT()</td>
</tr>
<tr>
<td>Gear</td>
<td>Wait_Area</td>
<td></td>
</tr>
</tbody>
</table>

* Preemptive Process Record

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gear</td>
<td>Lathe2</td>
<td>FIRST</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>Gear</td>
<td>Wait_Area</td>
<td>FIRST</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>Gear</td>
<td>Lathe1, 99</td>
<td>FIRST</td>
<td>1</td>
</tr>
</tbody>
</table>

See Also
“Preemption Process Logic” on page 292.
**TimesUsed()**

**General System Function**

**Syntax samples**

\[\text{TIMESUSED}(<\text{resource}>)\]

\[\text{IF TIMESUSED(Res1)} > 5 \text{ then USE Res2 for 10}\]

**Description**

Returns the number of times a resource has been used.

**Valid In**

Any logic and any field evaluated after translation. For a list of fields evaluated after translation, see the “Appendix A” on page 577.

**Components**

\(<\text{resource}>\)

The name of the resource to examine. RES() may be used here.

**Example**

In the example below, when an EntA arrives at Loc1, it will only use the resource Res1 if the resource has been used five or fewer times. If the resource has been used more than five times, EntA will use Res2 instead.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>IF TIMESUSED (Res1) &gt; 5 THEN USE Res2 FOR 10 ELSE USE Res1 FOR 10</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
</table>

**See Also**

UNITS().
Trace

General Action Statement

Syntax samples

TRACE {<message>} {STEP or CONT or OFF or CLOSE}
TRACE “Begin Test for Resource A”
TRACE CONT
TRACE CLOSE

Description

Turns tracing on and off. Trace listings will appear in a separate window on the screen. Use trace to follow the logical flow of a model.

Valid In

Any logic.

Components

<message>

The message to appear in the trace listing when the TRACE statement is encountered. The message can be any string expression.

STEP

Makes ProModel wait for the user to click the left mouse button to execute the next statement or trace continuously while the right mouse button is held down. TRACE statements default to step.

CONT

Steps continuously without user intervention. Clicking the right mouse button will step through the logic.

OFF

Turns tracing off but does not close the trace listing.

CLOSE

Turns tracing off and closes the trace listing.

Example

In this example, a message will appear in the trace listing whenever Agent1 and Agent2 have been captured and the downtime for Gate1 begins. Another message will appear in the trace listing at the end of the downtime.

See Also

DEBUG.
Trunc()

Type Conversion Function

Syntax samples

TRUNC(<expression>)
Integer1=TRUNC(3.9)

Description

Returns a real expression truncated to an integer. Any digits to the right of the decimal place will be removed. When necessary, ProModel automatically converts real values to integers by truncating them. For more information about ProModel automatically converting between reals and integers, see “Converting Between Numeric Types” on page 397.

Valid In

Any expression. This function returns an integer.

Components

<expression>

The expression to be truncated.

See Also

ROUND().
**Ungroup**

**Entity-Related Operation Statement**

**Syntax samples**

UNGROUP {LIFO}
UNGROUP
UNGROUP LIFO

**Description**
Separates entities that were grouped with the GROUP statement. Each of the resulting entities searches ahead in the process list and then from the beginning of the list until a process is found that has been defined for that entity type at the current location. The first entity processed from the group takes any resources the group owns. If a grouped entity has members that are also grouped entities, only the top level group is ungrouped with an UNGROUP statement. An additional UNGROUP will ungroup any member groups.

**Valid In**
The operation column of process edit tables only. You may not use UNGROUP on conveyors nor at the end of a queue. UNGROUP may not be used in combination with COMBINE, CREATE, UNGROUP, LOAD, UNLOAD, SPLIT AS or other UNGROUP statements in a processing logic. It may follow a GROUP statement no more than once in the same processing logic to allow batch processing.

**Please note**

*If you are trying to ungroup an entity that has never been grouped, ProModel ignores the UNGROUP statement.*

**Components**

**LIFO**
Last In, First Out. Starts the ungrouped entities processing from last to first, rather than from first to last. If this option is not specified, the ungrouped entities will be processed FIFO, or First In, First Out.

**Explicit Entity Actions**

With an UNGROUP, ProModel dissolves the temporary shell and divides costs among the ungrouped entities (ungrouped entities may include smaller clusters of grouped entities).

**Example**

The example below is the continuation of the GROUP statement example where EntA, EntB and EntC were grouped to form Grp_A. Now the entities are ungrouped with all of their original properties. (See the GROUP statement example.)
Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grp_A</td>
<td>Loc3</td>
<td>UNGROUP</td>
</tr>
<tr>
<td>EntA</td>
<td>Loc3</td>
<td>USE Res1 FOR 2 min</td>
</tr>
<tr>
<td>EntB</td>
<td>Loc3</td>
<td>USE Res1 FOR 2 min</td>
</tr>
<tr>
<td>EntC</td>
<td>Loc3</td>
<td>USE Res1 FOR 2 min</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc4</td>
<td>FIRST 1</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td>1</td>
<td>EntB</td>
<td>Loc5</td>
<td>FIRST 1</td>
<td>MOVE FOR 2</td>
</tr>
<tr>
<td>1</td>
<td>EntC</td>
<td>Loc6</td>
<td>FIRST 1</td>
<td>MOVE FOR 2</td>
</tr>
</tbody>
</table>

See Also

GROUP, LOAD, JOIN, COMBINE, and SPLIT AS. See “Attributes” on page 217 for more information.
Units()

General System Function

Syntax samples

UNITS(<location> or <resource>)

PAUSE “There are” $ UNITS(Res1) $ “Res1’s in the system.”

Description

Returns the total units of a location or resource.

Valid In

Any logic and any field except those evaluated before translation. For a list of fields evaluated before translation, see “Appendix A” on page 577.

Components

<location>

The name of the location to examine. You may substitute LOC() for the name of a location.

<resource>

The name of the resource to examine. You may substitute RES() for the name of a resource.

See Also

FREEUNITS() and RESQTY().
Unload

Entity-Related Operation Statement

Syntax samples

UNLOAD <expression> {IFF <Boolean expression>}
UNLOAD 5
UNLOAD 5 IFF Entity() = EntA

Description

Unloads a certain quantity of entities, or a certain quantity of those entities depending on a condition. Use UNLOAD to unload entities from a carrier entity that was previously loaded with LOAD. The unloaded entities are processed ahead of the entity which unloaded them. Each unloaded entity searches ahead in the process list, and then from the beginning of the list, until a process is found for that entity type at that location.

Valid In

The operation column of process edit tables only. UNLOAD is not valid at conveyors, after routing, or at the end of a queue. You may not use UNLOAD in combination with COMBINE, CREATE, GROUP, UNGROUP, and SPLIT AS or other UNLOAD in the same process logic. If the process contains LOAD statements, UNLOAD can only appear once after all of them.

Components

<expression>

The number of entities to unload. A value of zero is ignored and a negative value produces an error. If the quantity specified for unloading is greater than the number of entities that have been loaded, the extra quantity is ignored. This expression is evaluated every time the statement is encountered.

IFF <Boolean expression>

This option allows the UNLOAD command to be conditional. Any attributes, entity functions, and location functions apply to the entity to be unloaded, not to the base entity. This technique allows only entities with certain properties to be unloaded from the base entity. To use attributes, entity functions, and location functions that apply to the base entity, assign the desired value to a local variable and use the local variable in the Boolean expression.

Explicit Entity Actions

UNLOAD divides up costs and copies statistical information accrued while loaded, to each unloading entity.

Example

The following example is a continuation of the LOAD statement example and shows how the loaded entity (Truck) is unloaded, resulting in the original Truck and the boxes that were loaded onto it. Boxes continue to the next location while Truck is returned to its starting location, Factory. (See the Load statement example.)
Chapter 14: Unload

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Shipping</td>
<td>WAIT 2 min</td>
</tr>
<tr>
<td>Truck</td>
<td>MfgSite</td>
<td></td>
</tr>
<tr>
<td>Truck</td>
<td>Dock</td>
<td>LOAD Attr1 IN 2 Hr</td>
</tr>
<tr>
<td>Truck</td>
<td>NewYork</td>
<td>WAIT (20,30,60) UNLOAD 5</td>
</tr>
<tr>
<td>Box</td>
<td>NewYork</td>
<td></td>
</tr>
<tr>
<td>Truck</td>
<td>Chicago</td>
<td>WAIT (20,30,60) UNLOAD 5</td>
</tr>
<tr>
<td>Box</td>
<td>Chicago</td>
<td></td>
</tr>
<tr>
<td>Truck</td>
<td>Boston</td>
<td>WAIT (20,30,60) UNLOAD 5</td>
</tr>
<tr>
<td>Box</td>
<td>Boston</td>
<td></td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Box</td>
<td>Dock</td>
<td>LOAD 1</td>
<td>MOVE FOR 45 sec</td>
</tr>
<tr>
<td>1</td>
<td>Truck</td>
<td>Dock</td>
<td>FIRST 1</td>
<td>MOVE FOR 10 min</td>
</tr>
<tr>
<td>1</td>
<td>Truck</td>
<td>NewYork</td>
<td>FIRST 1</td>
<td>MOVE FOR 24 Hr</td>
</tr>
<tr>
<td></td>
<td>Truck</td>
<td>Chicago</td>
<td>FIRST 1</td>
<td>MOVE FOR 12 Hr</td>
</tr>
<tr>
<td></td>
<td>Truck</td>
<td>Boston</td>
<td>FIRST 1</td>
<td>MOVE FOR 28 Hr</td>
</tr>
<tr>
<td>1</td>
<td>Truck</td>
<td>MfgSite</td>
<td>FIRST 1</td>
<td>MOVE FOR 24 Hr</td>
</tr>
<tr>
<td>1</td>
<td>Box</td>
<td>NY_Recv</td>
<td>FIRST 1</td>
<td>MOVE FOR 5 min</td>
</tr>
<tr>
<td>1</td>
<td>Truck</td>
<td>MfgSite</td>
<td>FIRST 1</td>
<td>MOVE FOR 12 Hr</td>
</tr>
<tr>
<td>1</td>
<td>Box</td>
<td>Chi_Recv</td>
<td>FIRST 1</td>
<td>MOVE FOR 5 min</td>
</tr>
<tr>
<td>1</td>
<td>Truck</td>
<td>MfgSite</td>
<td>FIRST 1</td>
<td>MOVE FOR 28 Hr</td>
</tr>
<tr>
<td>1</td>
<td>Box</td>
<td>Bos_Recv</td>
<td>FIRST 1</td>
<td>MOVE FOR 5 min</td>
</tr>
</tbody>
</table>

See Also

LOAD, COMBINE, JOIN, GROUP, and UNGROUP. Also see “Attributes” on page 217 for more information.
Use

Resource-Related Operation Statement

Syntax samples

USE {<quantity>} <resource> {,<priority>}
   FOR <time> {AND or OR {<quantity>}
   <resource> {,<priority>} FOR <time>... }

USE 2 Res2, 5 FOR 4:23:03
USE 2 Res1 FOR 2.0 min OR 3 Res2 FOR 1.5 min
USE Res1, 3 FOR 1 hr AND (Res2 FOR 5 OR Res3 FOR 5)
USE Oper_Attr RES(Type_Attr) FOR Time_Var1 Hr

Description

Captures a resource or combination of resources as each resource becomes available. Once the resource has been captured it is used for the specified amount of time, and then freed when the specified duration is over. If the entity already possesses one of the specified resources from a previous GET, JOINTLY GET, or MOVE WITH statement, the entity will still try to capture an additional unit of that resource.

Please note

If an entity uses a USE statement to capture a resource, the resource must complete its operation before you can preempt the entity. However, if the entity uses a GET, WAIT, FREE sequence, you may preempt the entity during the WAIT portion of the logic.

Valid In

Location processing logic, downtime logic, and move logic.

Components

<quantity>

The number of resources to get. ProModel ignores a value of zero and values less than zero return an error. ProModel evaluates and truncates this numeric expression every time it encounters the USE statement.

<resource>

The name of the resource to USE. You can substitute RES() for the resource name.

<priority>

When multiple entities request a resource, ProModel fills the requests in order of priority. This expression should be a number between 0 and 999.

<time>

The length of time the entity will tie up the resource. ProModel evaluates this expression whenever it encounters the statement. If you specify no time unit, ProModel applies the default time unit specified in the General Information dialog.

Example

This simple example shows how Clients arriving at location Reception must USE the Secretary for some amount of time according to the user-defined distribution, Dist1. Clients are then sent to a waiting area until the desired next location becomes available.
Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Reception</td>
<td>USE Secretary FOR Dist1()</td>
</tr>
<tr>
<td>Client</td>
<td>Waiting</td>
<td></td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Client</td>
<td>Waiting</td>
<td>FIRST 1</td>
<td>MOVE FOR 30 sec</td>
</tr>
<tr>
<td>1</td>
<td>Client</td>
<td>Loan</td>
<td>.400 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td></td>
<td>Client</td>
<td>Auditor</td>
<td>.350 1</td>
<td>MOVE FOR 1</td>
</tr>
<tr>
<td></td>
<td>Client</td>
<td>Service</td>
<td>.250 1</td>
<td>MOVE FOR 1</td>
</tr>
</tbody>
</table>

See Also

GET, JOINTLY GET, and MOVE WITH.
**Variable()**

**General System Function**

**Syntax samples**

VARIABLE(<numeric expression>)
VARIABLE(Attr) = 124
VARIABLE(x) = VARIABLE(y)
N=VARIABLE(x) + VARIABLE(y) - 1

**Description**

Converts a name-index number or integer to a variable name. Use this function when a numeric expression uses a variable whose name-index number is stored in an attribute, array, or variable.

**Valid In**

Any logic.

**Please note**

*You cannot use VARIABLE() in a PROMPT, INC, DEC, or READ statement.*

**Components**

<numeric expression>

The name index number for a variable. You can determine the name-index number associated with a particular variable by the position of the variable record in the Variables module.

**Example**

In the example below, parts of different types arrive at location In_QUEUE. Each entity type has a unique value for Attr1 that corresponds to the name-index number of a variable in the Variables module. Once parts arrive at In_QUEUE, they increment the variable specific to that entity type before routing to the location Process_Loc.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>In_QUEUE</td>
<td>VARIABLE(Attr1) = VARIABLE(Attr1) + 1</td>
</tr>
</tbody>
</table>

**Routing Table**

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>All</td>
<td>Process_Loc</td>
<td>FIRST1</td>
<td>MOVE 1</td>
</tr>
</tbody>
</table>

**See Also**

LOC(), ENT(), and RES().
View

General Action Statement

Syntax samples

VIEW “view name”
VIEW “Cell5”
VIEW “View10”

Description
Use this statement to change the view in the Layout window from within your logic. Once the view has been defined from the View menu in main menu, you can use it in the logic.

Valid In
All logic.

Components

&view name>
The name of the view defined in the Views dialog. Enclose the name in quotation marks.

Example

You are giving a presentation on the use of simulation for airport design. Two hours into the model run, you want to zoom in on the baggage area to show the activity there. Three hours into the simulation, you want to zoom out to show the entire airport. You are giving a presentation to management on the factory floor using simulation. Two hours into the simulation, you want to zoom in on a particular cell in the factory to show the activity there. Three hours into the simulation, you want to zoom out to show the entire factory.

To do this, define two views called Cell1 and Factory using the Views editor on the View menu. Define an independent subroutine and call it in the initialization logic using the ACTIVATE statement. Enter the following logic in the subroutine:

INT X=1
WHILE X=1 DO
BEGIN
IF CLOCK(hr) = 2 THEN VIEW “Cell1”
IF CLOCK(hr) = 3 THEN VIEW “Factory”
WAIT 1 hr
END

See Also
“Commands” on page 83.
Wait

Entity-Related Operation Statement

Syntax samples

WAIT <time expression>
WAIT 3 min
WAIT 0
WAIT 2.5 + CleanupTime
WAIT N(8,.5) + 3 sec

Description

Simulates the time it takes to process an entity. WAIT delays further processing of the entity until the specified time has elapsed. The rest of the model continues to process while an entity waits. If the expression evaluates to zero, the current entity will not finish processing until all other processes scheduled for that moment in the simulation have finished.

Please note

*You may use the “^” symbol in place of a “WAIT” statement.*

Valid In

Location processing, downtime, and move logic. Independent subroutines may also use WAIT statements which function as timers. (For more information about Independent subroutines, see “Subroutines” on page 238.)

Components

<time expression>

The length of the WAIT. This expression is evaluated whenever the statement is encountered. If no time unit is specified, the default time unit specified in the General Information Dialog is applied.

Example

In the following example, customers arrive at a fast-food restaurant and place their orders at location Counter. How long customers wait depends on the type of meal ordered. If they order meal one, two, or three, they wait 2 minutes. Otherwise they wait 5 minutes. The example below shows WAIT statements used in an IF...THEN...ELSE expression. If the value of EntA’s attribute, Attr1, is greater than zero, the time delay is 5.0 minutes. Otherwise the delay is 2.5 minutes.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>IF Attr1&gt;0 THEN WAIT 5 min ELSE WAIT 2.5 min</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>EntA</td>
<td>Loc2</td>
<td>FIRST 1</td>
<td>MOVE FOR 10</td>
</tr>
</tbody>
</table>

See Also

WAIT UNTIL can stop additional processing until a condition is true.
Wait Until

Entity And Resource-Related Operation Statement

Syntax samples

WAIT UNTIL <Boolean expression>
WAIT UNTIL Var1 > 3
WAIT UNTIL Var1 < Attr3 AND Var2 >= 5

Description

Delays processing of the current logic until the Boolean expression is true. The rest of the model continues to process during the delay. Note that if the expression is initially evaluated to be false, it is only reevaluated when a location attribute, variable, or array element in the expression changes. Multiple entities waiting on the same condition are released one at a time. This allows a released entity to change a variable value that will prevent the other waiting entities from being released.

Valid In

Node entry and node exit logic delays processing for resources, and location processing logic delays processing for entities. Independent Subroutines. (See “Subroutines” on page 238.)

Components

<Boolean expression>

The condition that must be satisfied to continue processing the entity or resource. Elements of this expression are limited to location attributes, variables, and array elements.

Example

The example below uses the WAIT UNTIL statement to group a variable quantity of entities. As each EntA arrives at Loc1, a variable (Total) is incremented to keep track of the total entities waiting at the location. The WAIT UNTIL statement causes processing of all EntA’s to halt at this point until the variable, Var1, reaches or exceeds 500. Then all of the waiting EntA’s are GROUPed together as a BatchA.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>INC Total</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT UNTIL Total &gt;= 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GROUP Total AS Batch</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
</table>

See Also

DO...WHILE, WHILE...DO, and DO...UNTIL.
Warmup

General Action Statement

Syntax samples

WARMUP
WARMUP
IF thruput = 50 THEN WARMUP

Description
Instructs the simulation to end the warmup period by resetting all the statistics and erasing relevant time series files. Only one WARMUP statement may be used in the simulation.

Please note

If multiple WARMUP statements are encountered or a WARMUP statement is used in addition to the warmup time specified in the Run Options dialog, ProModel will generate a warning to inform you that this has occurred. Only the first warmup encountered (the statement or the Run Options setting) will actually be executed. While the statement will be encountered within the logic, the Run Options setting will be executed at the specific time indicated in the dialog.

Valid In
Any logic.

Example

Suppose you want to base the warmup period on 2,000 entities being processed rather than on a lapse of time. You could increment a variable (e.g., Total_Processed) whenever an entity exited the system. Enter the following logic in an independent subroutine activated from the initialization logic:

WAIT UNTIL Total_Processed = 2000
WARMUP

See Also
See “Simulation Options” on page 338 for more information on warm-up periods.
While...Do

General Control Statement

Syntax samples

WHILE <Boolean expression> DO <statement block>
WHILE Array1[n] <> 10 DO INC n
WHILE FREECAP(Loc1) > 5 DO
   BEGIN
      INC Var2, 5
      WAIT 5 sec
   END

Description
Repeats a statement or statement block continuously while a condition remains true. WHILE...DO is an entry-condition loop, meaning that the loop will not be executed once unless the Boolean expression is true.

Valid In
Any logic.

Components

<Boolean expression>
As long as this expression is TRUE, the loop will continue. This expression is evaluated for each iteration of the loop.

<statement block>
The statement or block of statements to execute.

Example
The example below shows the arrival logic window for an entity that arrives every 40 hours to reset the values of Array1 elements 1 through 100 to 0.

See Also
BEGIN, END, DO...WHILE, and DO...UNTIL.
Write

General Operation Statement

Syntax samples

WRITE <file ID>, <string or numeric expression> {,<maximum digits before decimal>, <digits after decimal>}

Description

Writes information to a general write file. The next item written to the file will appear immediately after this item. WRITE always appends to the file unless the file is RESET. This holds true for multiple replications as well as single, independent runs. Any file that is written to with WRITE automatically becomes a text file and will have an end of file marker attached automatically to the end when it is closed. For more flexible WRITE capability, use XWRITE.

WRITE and WRITELINE automatically separate values by commas

Valid in

Any logic.

Components

<file ID>

The name of the file as previously defined in the External Files Editor.

<string or numeric expression>

The string or numeric expression to be written to the file. In the output file, quotes will automatically be added to string expressions so that most spreadsheet programs can easily read the file.

<maximum digits before decimal>

The maximum number of digits before the decimal. This value is used to line up any numeric values into columns on the decimal point. This value may be any numeric expression.

<digits after decimal>

The number of spaces to save after the decimal point. Use this option to line up any labels appearing after numbers.

Example

The following example uses both WRITE and WRITELINE to record the time when EntA completes processing at Loc1 in a general write file called Rpt.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT N(7.3,.4)</td>
</tr>
</tbody>
</table>
|        |          | WRITE Rpt,"EntA Complete at:"
|        |          | WRITELINE, Rpt CLOCK(min).3,2 |

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
</table>

See Also

XWRITE, WRITELINE, RESET, READ, and FORMAT(). Also see “External Files” on page 254.

Please note

The sum of the maximum digits before and after the decimal must be less than 20.
**WriteLine**

**General Operation Statement**

**Syntax samples**

```
WRITELINE <file ID>, <string or numeric expression>{,<maximum digits before decimal>, <digits after decimal>}
```

**Description**

Writes information to a general write file and starts a new line. WRITELINE always appends to the file unless the file is RESET. Any file that is written to with WRITELINE automatically becomes a text file and will have an end of file marker attached to the end when it is closed.

WRITE and WRITELINE automatically separate values by commas.

**Valid In**

Any logic.

**Components**

<number ID>

The name of the file as previously defined in the External Files Editor.

<string or numeric expression>

The string or numeric expression to be written to the file. In the output file, quotes will automatically be added to string expressions so that most spreadsheet programs can easily read the file.

<maximum digits before decimal>

When writing real numbers, the maximum number of digits before the decimal.

<digits after decimal>

When writing real numbers, the maximum number of digits after the decimal.

**Example**

The following example uses both WRITE and WRITELINE to record the time when EntA completes processing at Loc1 in a general write file called Rpt.

**Process Table**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EntA</td>
<td>Loc1</td>
<td>WAIT N(7.3,.4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WRITE Rpt, “EntA Complete at:”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WRITELINE Rpt, CLOCK(min),3,2</td>
</tr>
</tbody>
</table>

**Routing Table**

```
Blk | Output | Destination | Rule | Move Logic
--- | ------ | ----------- |------|-----------
```

**See Also**

WRITE, RESET, XWRITE, READ, and FORMAT(). Also see “External Files” on page 254.

**Please note**

The sum of the maximum digits before and after the decimal must be less than 20.
**Xsub()**

External Subroutine Call

**Syntax samples**

XSUB(<file ID>, <ordinal function number> or <function name> {<parameter1>, <parameter2>...})

XSUB(Interface, 1, 5)

XSUB(LogDLL, "_Log_B_of_X", 10, 5)

**Description**

Calls an external subroutine inside a DLL file. XSUB() is perhaps the most powerful statement in ProModel, because by using it the user can access the entire functionality of any 32-bit Windows programming language such as C, C++, Delphi, or Visual Basic. XSUB() can be used for sophisticated file IO and to make simulations interactive. In fact, subroutines called with XSUB() can do anything that the language they were written in allows. Because of its power, however, XSUB() should be used with caution. When called, the simulation is suspended until the external subroutine finishes execution.

The subroutine inside the DLL must have been compiled as exportable by a Windows 32-bit compiler and have a return type of IEEE format double real. XSUB() will copy the parameters following the function name to a block of memory, then pass the function a pointer to that block of memory.

The function can take only one parameter: a pointer to void. But the function may access any number of parameters through structure overlaying. The function should define a structure to match the type and order of the parameters, and assign the pointer just passed to a pointer to that type of structure. The parameters can then be used through structure overlaying. Integers are passed as four byte values and reals are passed as eight byte IEEE values.

**Please note**

For Windows Programmers Only  The handle to the run-time simulation frame window will be the last parameter passed. Most subroutines can completely ignore this parameter, but it will be needed if the subroutine displays a window.

**Valid In**

Any expression or logic.

**Components**

**<file ID>**

The file ID assigned to an external DLL file as defined in the External Files editor. This file should be a 32-bit Windows DLL file.

**<ordinal function number>**

The ordinal number of the function inside the DLL. This function must be exportable. When DLL’s are compiled, every exported function inside them is numbered. The individual functions can then be accessed by calling the program by number. This field may be an expression that evaluates to an ordinal function number that is valid inside the DLL. Use an ordinal function number or the function name.

**<function name>**

The name of the function inside the DLL. This function must be exportable. Note that when most compilers compile DLL’s, they adjust the name of the functions inside them. The function name inside the XSUB statement must be the adjusted name, not the original name.

Most C compilers add an underscore to the function name; so a function called “Test1” would be compiled...
as “.Test1.” For most C++ compilers, valid ProModel external function names will be mangled to “@<function name>$pv.” Different compilers will vary, however, so the user should be aware of the particular compiler’s quirks.

<parameters>

The parameters to pass to the function. These may be any variable, number, or expression. They are only limited by the type of field or logic that uses the XSUB function. Each parameter should be separated by a comma. See above for how the external subroutine will access these parameters.

Example

An external function written to the ProModel specification, called Log\_B\_of\_X and written in C, returns the log of a value to a variable base. The function, reproduced below, has been compiled into the DLL, “XSUB.DLL.” The function itself is reproduced on the left below, and the source code can be found in the file “XSUB.CPP.”

The ProModel logic statements assign the base five logarithm of the real variable R1 to the real variable R2. Each statement assumes that the file XSUB.DLL has been assigned the identifier “Log” in the External Files Editor. The first statement accesses the function as if the DLL had been compiled in C++ by using the mangled function name. The second statement accesses the function as if it had been compiled in C by using the C adjusted function name. The third statement accesses the function using the ordinal function number.

ProModel Logic

\[ R2 = \text{XSUB(Log, "@Log\_B\_X$pv", 5.0, R1) } \]
\[ R2 = \text{XSUB(Log, ",_Log\_B\_X", 5.0, R1) } \]
\[ R2 = \text{XSUB(Log, 2, 5.0, R1) } \]

XSUB.CPP

```
struct TEST_SUB_PARAMS
{
    double base;
    double x;
    HWND hWndFrame;
};
extern "C" //This makes this a C function rather than a C++ function
{
    /* On compile, Borland and Microsoft add a leading underscore to a 'C' name! */
    double _export Log_B_of_X(void *p)
    {
        //Parameters come in a structure pointed to by p;
        TEST_SUB_PARAMS * params;
        params = (TEST_SUB_PARAMS*) p;
        MessageBox (GetTopWindow (params->hWndFrame),
                    "Executing Log\_B\_of\_X function.", "XSUB", MB_OK);
        return log (params->x) / log (params->base);
    }
}
```

See Also

“Subroutines” on page 238 (normal subroutines are less powerful, but much easier to create and use).
Xwrite

General Operation Statement

Syntax samples

XWRITE <file ID>, <string or numeric expression>

Description

Writes information to a general write file in any text format the user chooses. XWRITE is for writing user-formatted files, while WRITE and WRITELINE are for writing special formatted text files. XWRITE always appends to a file unless the file is RESET. Note that any time a WRITE or WRITELINE writes to a file, the file will automatically be a text file. No end of file marker is appended to files written only with XWRITE. In subsequent replications, additional items are appended to the end of the file unless the file is RESET. ProModel does not format the string expression, although you can use the FOR-MAT statement to manually format data. To add an end of file marker to a user-formatted file, use XWRITE CHAR(26).

Valid In

Any logic.

Components

<file ID>

The name of the file as previously defined in the Exter-nal Files Editor.

<string or numeric expression>

The string expression to be written to the file.

Example

The following example uses XWRITE to record the time each Box completes processing at location Ship.

Process Table

<table>
<thead>
<tr>
<th>Entity</th>
<th>Location</th>
<th>Operation (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>Ship</td>
<td>WAIT N(7.3,.4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XWRITE Rpt, “Box Shipped at:”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$ FORMAT(CLOCK(min),3,2)</td>
</tr>
</tbody>
</table>

Routing Table

<table>
<thead>
<tr>
<th>Blk</th>
<th>Output</th>
<th>Destination</th>
<th>Rule</th>
<th>Move Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dock</td>
<td>Doc</td>
<td>FIRST 1</td>
<td>MOVE FOR 5</td>
</tr>
</tbody>
</table>

See Also

WRITE, WRITELINE, and RESET. Also see “External Files” on page 254.
Appendix A

ProModel evaluates various fields and logic at different times during a simulation run. Some evaluate only once when the model prepares to run a simulation, called the translation time. ProModel evaluates others as necessary throughout the simulation. Below is a list of all expressions and statements by category, and a table telling which fields evaluate at translation and which fields ProModel evaluates continuously during a simulation. The table also tells where you may use an expression or statement.

Expression and Statement Groups

1. General Expression
Numbers, Variables, Math Functions, Functions Table, Distribution Functions, XSUB(), and Name Functions (i.e., RES(), ENT(), LOC()).

2. Arrays
Arrays of any dimension.

3. Location Attributes
Referencing a location attribute in any expression or assigning to a location attribute.

4. Entity-Specific System Functions and Attributes
Entity(), GroupQty(), ResQty().

5. General System Functions
Cap(), CalDay(), CalDom(), CalHour(), CalMin(), CalMonth(), CalYear(), Clock(), Contents(), DownQty(), Entries(), FreeCap(), FreeUnits(), OwnedResource(), TimesUsed(), Units(), and Variable().

6. Location-Specific System Function
Location().

7. Resource-Specific System Function
Resource().

8. Node Logic-Specific System Functions
Last(), Next(). (The Last function is valid only in Node Entry Logic and the Next function is valid only in Node Exit Logic.)

9. Downtime-Specific System Function
DTDelay().

10. Shift-Specific System Functions
ForLocation(), ForResource().

11. Preemption Logic-Specific System Functions
Preemptor(), TimeLeft().
12. Off-Shift & Break Logic-Specific System Functions & Statements
DTLeft(), Priority, and Skip.

13. Cost Functions & Statements
GetCost(), GetResRate(), IncEntCost, IncLocCost, and IncResCost.

14. General Statements: (Run-Time Only)
Activate, Animate, Assignment, Begin End, Break, BreakBLK, Close, Comment(#,
//, /*...*/), Debug, Dec, Display, Do...Until, Do...While, Goto, If...Then/If...Then...Else, Inc,
Int, Local Variable, Log, MapArr, Order, Pause, Prompt, Read, Real, Reset, Reset Stats, Return,
Report, Send, SetRate, Stop, String Expressions, Sound, Trace, View, WarmUp, While...Do, and
Write/Writeline/XWrite. (You may not use the Log statement in Initialization or Termination
Logic.)

15. Operation Statements (Group 1)
Accum, Combine, Create, Group, Join, Load,
Match, Move, Rename, Route, Split As,
Ungroup, and Unload.

16. Operation Statements (Group 2)
Free, Get, Jointly Get, and Use.

17. Operation Statements (Group 3)
Wait.

18. Move Logic-Specific Statements
Move For, Move On, and Move With.

19. External Spreadsheet File
Entity Location Expression File.

20. Graphic Statement
Graphic.

21. Wait Until Statement
Wait until.

Macros and Subroutines
A macro may be used in any expression field, but the macro may only contain expressions which
return a value (e.g., Entries(LOC1), U(5,1)). When a macro is used in a logic field, the macro
may include any logic element that is valid in that logic field. A subroutine may also be used in an
expression field provided that the Return statement is used to return a value to the expression
field. When a subroutine is used in a logic field, the subroutine may include any logic element that
is valid in that logic field.
Valid Expression and Statement Groups by Field

When running a simulation, expressions and statements are either evaluated 1) once at translation (before initialization logic and before any events are created) or 2) continuously during the simulation run. The following chart categorizes the edit fields in this manner and shows the expression and statement groups that can be used in each field. Fields are classified as either expression fields or logic fields. Fields not listed on this chart are either menu fields or expression fields that accept only numbers.

Fields Evaluated Only at Translation

| Field Name (evaluated at translation) | Field Type | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 |
|--------------------------------------|------------|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Variables                            |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Initial Value                        | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Function Table                       |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Dependent Value                      | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Independent Value                   | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Simulation Options                   |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Warm-up Hours                        | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Run Hours                            | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Replications                         | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Interval Length                      | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Path Networks                        |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Node Capacity                        | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Segment Distance                     | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Speed Factor                         | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Resources                            |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Resource Units                       | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Locations                            |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Location Capacity                    | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Conveyor                             |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Length                               | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Speed                                | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Queue                                |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Queue Length                         | Exp        | • | • |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Field Name               | Field Type | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 |
|--------------------------|------------|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Shifts                   |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Shift Start Time         | Exp        | • |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Entities                 |            |   |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Entity Length            | Exp        | • |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
| Entity Width             | Exp        | • |   |   |   |   |   |   |   |   |    |    |    |    |    |    |    |    |    |    |    |    |    |
# Fields Evaluated During Simulation

<table>
<thead>
<tr>
<th>Field Names (during simulation)</th>
<th>Field Type</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
<th>16</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Logic</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initialization Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Termination Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Entities</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Speed</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Path Networks</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Traveling Time per Path Segment</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Resources</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acceleration</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deceleration</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Empty Load Speed</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Load Speed</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pickup Time</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deposit Time</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node Entry Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node Exit Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Location Clock DT</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Occurrence</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clock DT Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Location Entry DT</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Occurrence</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entry DT Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Location Usage DT</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Occurrence</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage DT Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field Names (during simulation)</td>
<td>Field Type</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>Location Setup DT</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setup DT Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resource Clock DT</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Occurrence</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clock DT Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resource Usage DT</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Usage DT Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preemption</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preemption Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Routing</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority for Destination</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destination</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entity Output Quantity</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Condition Rule</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrivals</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Occurrence</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Occurrences</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Qty of Each Arrival</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrival Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Off Shift Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priorities</td>
<td>Exp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pre-Off Shift Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Off Shift Logic</td>
<td>Logic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field Names (during simulation)</td>
<td>Field Type</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>Pre-Break Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Break Logic</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Subroutines</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interactive Subroutines</td>
<td>Logic</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Debugger</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debug Condition</td>
<td>Exp</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Program Defaults

This section discusses and lists the default settings when you first run ProModel.

As in most software packages, ProModel makes certain assumptions regarding the most useful settings for the program. While your models may require different settings, an effort has been made to select the most common and helpful default settings.

Since ProModel can be used for a wide variety of applications, you may require different settings. As your models differ, so will the need to change these settings from their default. However, when ProModel is first launched and no INI file exists for it, the defaults in the following table apply. Some defaults involve edit field values, some are check box settings, etc.

Many defaults can be changed by selecting one of the Model Default options under the Tools menu. Other defaults can only be changed in the Build modules. Still others can only be changed by directly editing the .INI file.

After ProModel is first launched, the promod.ini(initialization) file is created. To change the .INI file defaults, you must edit the it using an ASCII text editor (e.g., Windows Notepad). DO NOT attempt to edit the .INI file unless you are fully comfortable doing so and only after you make a backup copy of the original .INI file.

Default Values

<table>
<thead>
<tr>
<th>Build Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic library</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conveyor/queue style</td>
</tr>
<tr>
<td>Conveyor/queue width</td>
</tr>
<tr>
<td>(feet)</td>
</tr>
<tr>
<td>Conveyor speed (fpm)</td>
</tr>
<tr>
<td>Conveyor accumulating</td>
</tr>
<tr>
<td>Conveyor entity orientation</td>
</tr>
<tr>
<td>Location statistics</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Entities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity speed</td>
</tr>
<tr>
<td>Entity statistics</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path Networks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time/speed</td>
</tr>
<tr>
<td>Path color</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
</tr>
<tr>
<td>Entity search</td>
</tr>
<tr>
<td>Resource search</td>
</tr>
<tr>
<td>Resource statistics</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Processing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap to border</td>
</tr>
<tr>
<td>Variable statistics</td>
</tr>
</tbody>
</table>
### Tools Menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long build menu</td>
<td>on</td>
</tr>
<tr>
<td>Confirm record delete</td>
<td>on</td>
</tr>
<tr>
<td>Recalculate path lengths when adjusted</td>
<td>on</td>
</tr>
</tbody>
</table>

### View Menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap to grid</td>
<td>off</td>
</tr>
<tr>
<td>Show grid</td>
<td>off</td>
</tr>
<tr>
<td>Grid size (VGA full layout)</td>
<td>90 grid units</td>
</tr>
<tr>
<td>Scale - distance</td>
<td>1 ft/grid unit</td>
</tr>
<tr>
<td>Scale - time</td>
<td>.01 min/grid unit</td>
</tr>
<tr>
<td>Background color</td>
<td>lt. gray</td>
</tr>
<tr>
<td>Edit table font</td>
<td>Arial 8 Regular</td>
</tr>
<tr>
<td>Edit table color</td>
<td>Gray</td>
</tr>
</tbody>
</table>

### Directories

<table>
<thead>
<tr>
<th>Directory</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Models</td>
<td>c:\ProModel\models</td>
</tr>
<tr>
<td>Glib</td>
<td>c:\ProModel\glib</td>
</tr>
<tr>
<td>Output</td>
<td>c:\ProModel\output</td>
</tr>
</tbody>
</table>

### INI Defaults

#### Graphic Editor

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text alignment</td>
<td>center</td>
</tr>
<tr>
<td>Text frame type</td>
<td>transparent</td>
</tr>
<tr>
<td>Text frame shape</td>
<td>rectangle</td>
</tr>
<tr>
<td>Text font</td>
<td>Arial 8 Bold</td>
</tr>
<tr>
<td>Text color</td>
<td>black</td>
</tr>
<tr>
<td>Text frame border color</td>
<td>black</td>
</tr>
<tr>
<td>Text frame fill color</td>
<td>white</td>
</tr>
</tbody>
</table>

#### Variables

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digit font</td>
<td>Arial 8 Bold</td>
</tr>
<tr>
<td>Digit color</td>
<td>yellow</td>
</tr>
<tr>
<td>Digit frame type</td>
<td>recessed</td>
</tr>
<tr>
<td>Digit frame shape</td>
<td>rectangle</td>
</tr>
<tr>
<td>Digit frame border color</td>
<td>black</td>
</tr>
<tr>
<td>Digit frame fill color</td>
<td>royal blue</td>
</tr>
</tbody>
</table>

#### Conveyors/Queues

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue border color</td>
<td>black</td>
</tr>
<tr>
<td>Queue fill color</td>
<td>dark gray</td>
</tr>
</tbody>
</table>

#### Gauges/Tanks

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gauge/tank fill color</td>
<td>maroon</td>
</tr>
<tr>
<td>Gauge/tank border color</td>
<td>black</td>
</tr>
<tr>
<td>Gauge/tank empty color</td>
<td>white</td>
</tr>
<tr>
<td>Gauge/tank - no border</td>
<td>checked</td>
</tr>
<tr>
<td>Gauge/tank - show scale</td>
<td>checked</td>
</tr>
</tbody>
</table>

#### Other

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autosave (in minutes)</td>
<td>10</td>
</tr>
<tr>
<td>Print layout - print options dialog - bkgrmd color</td>
<td>unchecked</td>
</tr>
</tbody>
</table>
**ActiveX Objects**

ProModel’s ActiveX Automation capability allows you to externally create, view, and edit model elements such as locations, entities, and variables. Using Visual Basic (or any other ActiveX-enabled language), you can add capabilities to ProModel including:

- Customized user interface with table inputs
- Custom-designed parameter screens
- Automatic model creation from external data sources (e.g., Excel spreadsheets, databases, or ASCII text files)
- Software execution from another application

You can also use ProModel’s ActiveX capability to access any of the following actions and tables (any table not mentioned in the following list is not currently ActiveX enabled).

More information on ActiveX Automation can be found in the ActiveX User Guide, which is located in the documentation folder within the ProModel directory.

**Program Operations**

- Start program
- Quit program
- Pause simulation model
- Query status of model (e.g., running, paused, etc.)
- Enter Run-time Interface parameters from external data source
- Access any data field provided in output database

**Location Table**

- Name
- Capacity
- Units
- Stats
- Incoming selection rule
- Incoming rule, max attribute
- Incoming rule, min attribute
- Queuing for Output rule
- Queuing rule, max attribute
- Queuing rule, min attribute
- Multi-unit selection rule
- Notes
- Operation rate (cost)
- Time units (cost)

**Clock Downtime Subtable**

- Frequency
- First time
- Priority
- Scheduled
- Logic
- Disable

**Entry Downtime Subtable**

- Frequency
- First time
- Logic
- Disable
Usage Downtime Subtable

- Frequency
- First time
- Priority
- Logic
- Disable

Setup Downtime Subtable

- Entity
- Prior entity
- Logic
- Disable

Entity Table

- Name
- Speed
- Stats
- Notes
- Initial cost

Resource Table

- Name
- Units
- Stats
- Resource search rule
- Entity search rule
- Entity search, min attribute
- Entity search, max attribute
- Speed empty
- Speed full
- Acceleration
- Deceleration
- Pickup time
- Drop-off time
- Return home flag
- Notes
- Network
- Home node
- Shift node
- Break node

- Operation rate (cost)
- Time units (cost)
- Cost per use

Clock Downtime Subtable

- Frequency
- First time
- Priority
- Scheduled
- List
- Node
- Logic
- Disable

Usage Downtime Subtable

- Frequency
- First time
- Priority
- List
- Node
- Logic
- Disable

Processing & Routing Tables

- Entity name
- Preemption process flag
- Location name
- Operation logic
- Routing block number
- Output entity name
- Destination name
- Destination priority
- Begin new block flag
- New entity check box
- Output quantity
- Output rule
- Output probability
- Output user condition
- Move logic
Path Networks Table
- Color
- Visible
- Name
- Type
- Basis (time or speed)

Path Segments Subtable
- From
- To
- Bi-directional
- Time

Interfaces Subtable
- Node
- Location

Mappings Subtable
- From node
- To node
- Destinations

Nodes Subtable
- Coordinates
- Name
- Capacity

Arrivals Table
- Entity name
- Location name
- Quantity of each arrival
- Qty each (cycle table name)
- First time
- Number of occurrences
- Frequency of arrivals
- Arrival logic
- Disable flag

Shift Assignments
- Locations
- Resources
- Units

- Shift files
- Start time
- Priorities
- Logic
- Disable

Scenarios
- Name
- Enabled

Model Parameters

Parameter Subtable
- Value

Attribute Table
- Attribute name
- Type
- Classification (entity or location)
- Notes

Variables Table
- Variable name
- Type
- Initial value
- Stats
- Stats basis
- Notes

Arrays Table
- Array ID
- Dimensions
- Type
- Import File
- Export File
- Notes

Macro Table
- Identification (name)
- Text
- Resource grouping
Subroutine Table
• Subroutine name
• Operation logic

User Distributions
• Distribution name
• Type
• Cumulative
• Percentage
• Value

External Files Table
• Filename
• File type
• Path
• Prompt
• Notes

General Information Dialog
• Model title
• Default time units
• Default distance units
• Graphics library file name
• Initialization logic
• Termination logic
• Model notes

Simulation Options Dialog
• Output path
• Run length type
• Warm-up period flag

Time Only
• Warm-up hours (time only)
• Run hours

Weekly
• Warm-up start (day, hr, min)
• Simulation begin (day, hr, min)
• Simulation end (day, hr, min)

Calendar Date
• Warm-up start (month, day, year, hour, minute)
• Simulation begin (month, day, year, hour, minute)
• Simulation end (month, day, year, hour, minute)
• Output report method
• Output report interval length
• Number of replications
• Clock precision
• Clock units
• Disable time series flag
• Disable animation flag
• Disable costing flag
• Pause at start flag
• Display notes flag

More on ActiveX

For detailed information regarding ActiveX objects and methods, contact:

ProModel Sales and Support Team
Phone (888) PRO-MODEL
Fax (801) 226-6046

For detailed information regarding ActiveX objects and methods, contact:

ProModel Sales and Support Team
Phone (888) PRO-MODEL
Fax (801) 226-6046
Suggested readings

To expand your knowledge and understanding of simulation, its practices, and its applications, consider the following texts.


Glossary

Cost Statistics
Statistics collected on a cost basis (e.g., total cost and average, non-use cost). You have control of how ProModel collects these statistics. You may collect information through statements, base them on the system clock, or use a combination of both.

Counter
A counter is a location or variable graphic used to display the contents of a location or the current value of a variable during animation. A counter consists of a frame, a specification of the digit color, and the font. If the number being displayed requires more digits than the maximum specified, the counter simply expands to the left. ProModel displays real values showing only 2 decimal places. For example, a variable equal to 4.8936 would display 4.89 on the screen.

Dialog Box
A dialog box is a pop-up window used to enter information or select options. Movement from field to field in a dialog box is accomplished by clicking in the field with the left mouse button or by using the Tab key. To accept input made to a dialog box press Enter or click on the OK button. To cancel any changes made to the dialog press Esc or click on the Cancel button. For help on the dialog, press F1 or click on the Help button. If no Help button is shown, you may select Help from the main menu.

Edit Tables
An edit table is a powerful editing window used to add, delete and edit modeling and language elements such as entities or locations. It is similar to a spreadsheet editor in that it provides maximum visibility of element lists while still allowing each field of a particular element to be directly edited.

File Name
A file name is any name used to identify a file. File names may include a path (e.g., C:\REPORTS\DATA) as well as a terminating period with up to three additional characters as an extension (e.g., DATA.TXT). File names are case insensitive.

Font
A font is a collection of characters sharing the same attributes such as height, width, and typeface. A font determines the appearance of text. Select fonts using the font dialog which shows how the font will appear.

Frame
A frame is a graphical border or background for placing text or displaying values. Frames have a
type (raised, recessed, transparent), shape, color and size. Frames are optional and you may use them only to enhance the appearance of the graphic layout. If you do not desire a frame, select Transparent as the type.

**Gauge**

A gauge is a graphic bar that extends and retracts to represent the current contents of a location. You define a gauge by the fill color, the empty color, and the gauge border color. You also specify the fill direction (up, down, left or right).

**Integer Number**

An integer number is a whole number ranging from -2,147,483,648 to 2,147,483,647. Integer values may not include commas, so enter the number 5,380 as 5380.

**Library Graphic**

A library graphic is a graphic defined and edited using the Library Graphics Editor. Use library graphics to represent locations, resources or entities, or as part of the layout background with no association to any model entity.

When used to represent a processing location, library graphics may have entity spots defined for them so entities that enter the location will appear graphically on the entity spot.

You may reference a Library graphic multiple times and each reference may have a unique size, horizontal or vertical inversion, rotation, and color.

**Main Entity**

The original or input entity used in routing logic. You may create new entities from the main entity using the CREATE statement or through multiple routing blocks.

**Main Menus**

The main menus are listed along the main menu bar at the top of the application window and provide access to all of the dialogs and commands necessary to build, run, and analyze simulation models.

**Name Index**

During simulation run time, ProModel converts the name of each location, entity, and resource to a list index number for efficient access and flexibility in assigning names to variables, attributes, etc. The index number corresponds to the order in which the elements appear in the edit table list. If five locations were defined, they will be identified by the index numbers 1 through 5 at run time. A name index may be assigned to a variable or attribute by referencing the name itself (e.g., Attr1 = EntityA). You may also test for a name index by referencing the name (e.g., if Var5 = Loc3).

**Note**

A note is any comment or other information typed by the user that is for information only and disregarded by ProModel.

**Numeric Type**

A numeric type specifies whether a numeric expression is of type real or integer. If, for example, a variable is of type “real,” then the variable can only represent some real number.

**Numeric Value**

A numeric value is any real or integer number such as 3.68 or 52.
**Parameter**

Parameters are variables used in a subroutine which are local to or have scope only within the subroutine. Arguments or numeric expressions passed to a subroutine are assigned to the parameters for use inside the subroutine.

**Park Search**

A park search defines the sequence where a resource looks for nodes at which to park after completing a task assuming no other tasks are waiting.

**Paths**

Paths define the course of travel for entities and resources between locations. You may define a path for a specific entity and routing, or a network of paths shared by several resources and entities. Define movement along a path in units of time, or speed and distance.

Path networks consist of nodes connected by path segments. Any node may have multiple input and output segments.

**Positioning Spot**

An entity spot is simply a graphic position relative to a location or resource and displays any entities occupying the location or resource.

For any given location you may place one or more entity spots on the graphics layout. Entities to enter a location appear on the first available entity spot in the order they are placed. If an entity enters a location and all the entity spots are filled, the entity will appear on the last entity spot.

For resources, place the entity spot where it appears when a resource carries the entity.

**Preemption**

Preemption is the act of bumping or replacing an activity currently using a location with an activity of a higher preemptive priority. ProModel handles preempted activities differently depending on the location preempted.

For locations, ProModel puts the preempted activity (any current entity or downtime) in a preemption list for that particular location until it can resume its activity at that specific location unit.

**Real Number**

A real number is a number ranging from $1.7 \times 10^{-308}$ to $1.7 \times 10^{+308}$. Real values may not include commas, so enter the number 5,380.5 as 5380.5.

Examples: -2.87563, 844.2, 65.0

**Reference**

A reference is a name entry in an edit field that references a defined model element. If you change the name of the model element, all references to the element automatically change to reflect the change in name.

**Region**

A region is a rectangular area on the graphic layout that represents a location. Defining a region is useful when you import a layout from a CAD drawing and you want to designate a portion of the layout to represent a particular processing location. A region should have one or more entity spots associated with it in order to be meaningful.

**Resource**

A resource is a person or item used to perform an operation or activity. Common resources include human operators, inspectors, forklifts, and other
vehicles. Use resources used to perform operations on entities at a location, transport entities between locations, or perform activities on a location during a downtime.

**Resource Point**

A resource point is a screen position where a resource will appear when it arrives to park or perform a task at a particular node. When a resource arrives at a node, it will appear on that node unless you define a resource point for that resource at that node. Resource points provide a way to have several resources positioned at the same node without all appearing on top of each other.

**Routing Priority**

A routing priority is the priority given to a routing for accessing a destination when capacity becomes available. ProModel defines the routing priority as part of the Destination field in the Routing Edit Table. A routing priority applies where two or more entities wait at a location for a routing destination to become available. The routing priority breaks a tie when deciding which entity has access to the destination location first when it becomes available. (See Selecting Incoming Entities in the Location Rules Dialog.)

**Scroll Arrow**

You can use the scroll arrows on either end of a scroll bar to move the contents of a window or list box. Clicking once on a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls continuously.

**Scroll Box**

A scroll box is a small box in a scroll bar that shows the position of what is currently in the window or list box relative to the contents of the entire window.

**Scroll Bar**

A scroll bar is a Windows control for scrolling the contents of a window. Scroll bars operate in three different ways:

1. Click on the scroll arrows at either end of the scroll bar for incremental scrolling.
2. Click on either side of the scroll box for scrolling one window at a time.
3. Drag the scroll box with the mouse to scroll to a specific position.

**Shell**

The temporary entity (representing grouped entities) to which ProModel assigns all costs and statistics until you ungroup the entities. Once ungrouped, ProModel divides all costs among the entities.

**Status Lights**

A status light is a circle that lights up with different colors depending on the status of the location. You can place a status light anywhere relative to a location for showing the status or current state of the location. At run time, you can display a window showing what status each color represents.

**String**

A string is a series of characters enclosed in double quotes (e.g., “Station A”). You may use strings to write text to a file or to display a message on the screen.

**System Menu**

The system menu appears as a dash mark at the upper left corner of most windows. The main function of the system menu is to close the window. To do this, by either double-click on the
menu button or click on the button once and select Close from the menu options that appear. ALT + <space bar> also pulls up the system menu.

**Text**

Text refers to words that you wish to display on the graphic layout. Each specification of text has an associated font, color, frame, and orientation (up, down, left or right). You can rotate only true-type fonts.

**Time Statistics**

Statistics collected on a time basis (e.g., time in system, average minutes per entry, and average contents). You cannot control how ProModel collects these statistics since ProModel bases them solely on the system clock.

**Work Search**

A work search defines the sequence in which a resource looks for work at locations where work may wait to be performed.
Bibliography


Index

Symbols

- 398, 399, 403
# 451
$ 398, 402, 403
( ) 398, 403
* 152, 398, 399, 403
** 398, 399, 403
+ 398, 399, 403
/ 398, 399, 403
/*...*/ 451
// 451
< 398, 400, 403
<= 398, 400, 403
<> 398, 400, 403
= 398, 400, 403
> 398, 400, 403
>= 398, 400, 403
@ 341
@ or Mod 398, 399, 403

A

Acceleration rate 138, 265
ACCUM 98, 109, 280, 283, 429, 578
Accumulate
  see accum
Accumulating
  conveyor 99
Accumulating conveyor 98
Accumulating conveyors 270
Accuracy, degree of 29
ACTIVATE 181, 238, 239, 431, 566, 578
Active operation zone 268
ActiveX objects 586
Activity
  grouping 35
time and condition dependent 31
Add
  joint 119
  mode 94
  resource points 141
  resources & variability 48, 52
  routing mode 154
  view 78
Addition 398, 399, 403
Additional operations 48, 55
AGV 117
AGVS
  see automated, guided vehicle systems
Alignment
  graphics 214
  text 96
ALL 146, 150, 153, 293, 430, 453, 467, 473, 503, 546
  entity type 147
ALTERNATE 406, 407, 412, 417, 422
Alternative systems 42
Analysis
  capability 27
  capacity 27
  constraint 27
  decision/response 27
  graphical 12
  output 45
  performance 26
  sensitivity 27
AND 398, 401, 403, 486
ANIMATE 359, 432, 578
Animation
  charts 46
  conveyor 99
  disable 353
  off 58
  on/off during run time 346
  options 353
  panning during run time 359
  screen 57
user pause 353
views 353
zoom 353
Append
  appending a record to a table 71
  record to a table 70
Arc
draw 317
Arrange icons 84
Arrays 89, 227, 399, 506, 577
  accessing 227
  assigning cell values 227
  definition 227
  dimensions 228
  disable 228
  displaying information during run time 86, 354
  edit table 228
  examples 227
  export file 228
  import file 228
  initializing 229
  notes 232
  persist 228
  referencing 227
  statistics 232
  type (real or integer) 228
  usage 232
Arrivals 47, 156
  accessing 156
  cycles 244
    accessing 244
    assigning arrivals 245
    cumulative 244, 246
    cycle tables 246
    defining 244
    edit table 244
    examples 244
    percent 244
    quantity 244, 246
    table 244
  define 50, 157
    graphically 157
    manually 158
  definition 156
  destroyed 157
  disable 157
  edit table 156
  editor 156
  entity field 156
  external arrival file 157
  files 256
    example 256
  first time 157
  frequency 157
  independent 158
  location field 156
  logic 157
  new 55
  occurrences 157
  quantity each field 156
  rates 89
AS 532
AS/RS
  see automated storage/retrieval systems
ASCII 446
  characters 397, 446
  files 527
  text editor 584
Assemblies
  making 283
Assembly lines 7
Assignment 435, 578
Attributes 48, 89, 217
  accessing 217
  cloning 218
    example 219
  combine statement with attributes 222
  define 55, 217
  edit table 219
  entity attributes 217
  example 219
  group statement with attributes 220
  join statement with attributes 220
  load statement with attributes 221
  location 577
  location attributes 218
  memory allocation
    for attributes 218
  see entity attributes
  types 217
  ungroup statement with attributes 220
  unload statement with attributes 221
Automated guided vehicle systems 273
Automated guided vehicles
  modeling 273
  on-board vehicle sensing 273
  simulation benefits 274
  zone blocking 273
Automated storage/retrieval systems 275
  modeling 275
  simulation benefits 275
  vertical bridge crane 275
AutoSave
  directory 326
files 326
  time between saves 325, 326
AUTOSAVE.MOD file 345
Axis shift 427

B

Background color 88
  edit table 83
  layout window 81
Background graphics 74, 210, 277
  accessing 210
  alignment 214
  behind grid 214
    mode 210
  bmp 277
  cad 277
  copy
    object 73
    to clipboard 74
  create 210
  deleting an object 74
  edit 73, 87, 210
    menu 212
  editor 211
    modes 210
  exporting a graphic 74, 213
  fill
    color 214
    patterns 214
  flip
    horizontal 214
    vertical 214
  front of grid 214
  mode 210
  graphics menu 214
  group 214
  importing 49, 74, 213
  layout window 211
  library graphics window 211
  line
    color 214
    styles 214
  lock 214
  move
    behind grid 215
    imported background graphic 213
    in front of grid 215
  paste
    bmp 74
  object 73
    wmf 74
  removing an object 73
  rotate 214
  selecting all graphics 74
  sizing an imported background graphic 213
  tools
    button bar 211
  ungroup 214
  unlock 214
  wmf 277
BACKUP 406, 407, 417, 422
Backup file 64
Basic 354
Basic model elements 48
Batch means technique 41
Batching 278
Batching, interval 41
BEGIN 234, 436, 465, 578
Behind grid 277
Behind grid mode 210
Beta distribution 427
Binomial distribution 427
Block
  number
    * 152
  routing block 149
Blocked time 269
BMP
  importing a background graphic 213
Boolean
  expressions 399, 400
  operators 399
Border
  change line or border style 309
  tank 180
Bottleneck 274
Bottlenecks, identifying 45
BREAK 437, 539, 578
Break logic-specific system functions & statements 578
dtleft() 578
priority 578
skip 578
BREAKBLK 438, 539, 578
Breaks 137
  colors
    customize 162
  logic 166
  see shift & break logic
  see shift definition & shift assignment
Bridge
  and hoist trajectory 267
following 265
leading 265
motion after queue-up 266
multiple bridges 266
separation 261
separation distance 263
speed 261
Budget for simulation project 30
Build
expression button
logic builder 287
menu 89
description 61
models 9, 35, 47
Bump-away 268
BY TURN 151

C

CALDAY() 439, 440, 577
CALDOM() 577
CALHOUR() 441, 577
CALMIN() 442, 443, 444, 577
CALMONTH() 577
CALYEAR() 577
CAP() 445, 503, 577
Capability analysis 27
Capacity
analysis 27
location 91, 100
maximum location capacity 91
Capacity, load rate 270
Cascade 84
Category Chart 381
Cause-and-effect relationships
identify 30
CHAR() 397, 402, 446, 575
Character strings 393, 397, 402
Characters
ascii 397, 446
Charts 379
Chord
circular 319
draw 319
Circle
draw 318
Claim
attempt rejection 263
priority 262
zone 263
Clearing text in a notes window 72
Clock
clock-based downtime 132
display during run time 359
selection 57
Clock precision 272
CLOCK() 403, 447, 504, 577
CLOSE 448, 578
Collisions 274
Colon notation 402
Color
background 80, 81, 88
create custom 82
custom 82
edit table 83
fill 310, 323
grid lines 81
line 310, 323
routing path 80, 82, 88
shift & break
customize 162
text 96
COMBINE 98, 109, 177, 278, 283, 449, 483, 499, 549, 558, 561, 578
Commands 76, 83
Comments 451, 578
Common mode 74
Communication effectiveness 27
Comparison
study 27
with similar operations 33
Comparison operators
and, or, not 398
Compiling within a logic window 73
Concatenation operators 398, 402, 403
Conducting experiments 37
Confidence intervals (CI) 38
Confirm record deletion 325
Constraints
analysis 27
identify 26, 27
CONT, see CONTINUE
CONTENTS() 452, 577
Context 85
CONTINUE 151, 406, 408, 410
dynamic priority changing 408
continuous modeling 180
Continuous trace 58
Control statements 426
Convert
data to useful form 34
Convert between numeric types 397
Conveyors 94, 97, 98, 269
  accumulating 98, 99
  animation 99
  capacity 98
  conveyor networks 271
  conveyors in promodel 272
  creating bends graphically 99
define
  color 97
  graphically 99
definition 98
display graphics 99
draw to scale 272
entity orientation 99
examples 272, 273
intermittent 271
length 98, 99
load delivery time 270
load overlap 272
load rate capacity 270
load spacing 272
modeling conveyor systems 271
  networks 271
  non-accumulating 98
operational limitations 98
  options 99
  queuing 270
run-time visibility 97
set
  style 97
  width 97
simulation benefits 270
single section 271
speed 100, 270
types 270
  accumulating 270
  non-accumulating 270
Copy 322
  graphic editor 308
information
  between records 71
  from another record 71
  record in a table 71
  text in a notes window 72
Cost 175
  building a model with costing 176
  combine/group 177
  cost dialog box 175
  cost per use 176
  initial cost 176
  object type 175
  operation rate 175
  per 176
  regular rate 176
disable costing 179
enable costing 179
entities 176, 179
  initial cost 176
  join/load 177
  locations 175, 178
  operation rate 175
  per 176
  output 178
  preemption/downtime 177
resources 176, 178
  cost per use 176
  per 176
  regular rate 176
special cost handling 178
statistics 178, 591
Cost-related functions & statements 578
  getcost() 478
  getresrate() 480
  incentcost 489
  incloccost 490
  increscost 491
Counter 94, 95
  see glossary 591
Cranes 261
  bridge and hoist speeds 261
  bridge separation 261
  crane envelope 261
  crane move priorities 261
    claim priority 262
    effective claim priority 262
    task move priority 261
  crane operations 262
    envelope 261
    horizontal speed 275
    idle 266, 267, 268
    immovable 267
    modeling multiple cranes 261
    move priority 261
    multi-crane envelopes
      claim attempt rejection 263
      extended movement zone 263
      queue-up situations 265
      zone claims 263
    node searches 268
    operation rules 267
    operations notes 268
    other rules 267
    park searches 268
    queue-up situations
bridge motion after queue-up 266
no queue-up 265
reclaim trigger events 267
resource request
  priorities 261
  response 266
resource statistics 269
  blocked time 269
  gross move time 269
  in use 269
  special case, blocked time 269
  travel to use 269
searches 268
vertical bridge 275
vertical speed 275
work searches 268
zone claims
  examples 263
  speed and mobility 265
CREATE 97, 98, 178, 218, 449, 453, 483, 489, 499, 549, 558, 561, 578
Create
  model package 68
  run-time models 11
Creating Charts 379
Creating Reports 372
CSV files 257
Cumulative distribution function 252
Custom
  colors 82
  reporting 342
  zoom 79
Customize 299, 327
Customizing graphics
  background graphics 277
Cut 322
  cutting text in a notes window 72
Cycle period 44

D

Data
  approving 35
  converting to a useful form 34
  documenting 35
  gathering 32
  protection
    model data 68
    model packaging 68
  read 254
requirements
  determine 31
  sources 33
  write 254
DAY 401, 403, 447, 462
Deadlocks 274
DEBUG 348, 350, 351, 455, 553, 578
example 350
Debug 346
  check condition 349
dep button 349
dep dialog 349
  advanced 350
context 349
end simulation 349
error display box 349
into subroutine 350
logic display box 349
next statement 349
next thread 350
options 350
run 349
disable dep 348
examples 347, 350
global change 348
example 351
logic 347
  disable 350
  enable 350
  exclusive 350
  new 350
  next 350
options dialog 348
process
  disable 350
  exclusive 350
  new 350
  next 350
process thread 347
statement 347
user condition 348
example 351
DEC 456, 578
Deceleration
  infinite 265
  rate 265
Deceleration rate 138
Decision
  response analysis 27
  rules
    for locations 109
Default graphics library 325
Defaults
  default values table 584
  program 584
Define
  arrivals 50
  attributes 55
  distribution 55
  entities 49, 113
  location downtimes 55
  locations 49
  multiple entity graphics 114
  objectives 26
  path networks 52
  processing 50
  resources 52
  system 30
Degree of accuracy 28, 29
Delete
  deleting a record from a table 70
  joint 119
  location 93
  graphic 93
  process 154
  routing record 154
DEPENDENT 406, 410
Deposit time 138
Design of experiments (DOE) 42
Destination, choosing 280
Detail of a simulation project 28
Developing a budget and schedule 26
Dialog box 10
  see glossary 591
Dimensions
  entity graphic 113
  graphic 310
Directories 325
Disable costing 179
DISPLAY 171, 397, 403, 457, 578
Display statistics on screen
  see statistics
Distance 120
  per grid unit 81
  change 312
  units 171
Distribution functions 399, 427
  axis shift, optional 427
  beta 427
  binomial 427
  erlang 427
  exponential 427
  gamma 427
  general components 427
  geometric 427
  inverse gaussian 427
  lognormal 427
  normal 427
  pearson5 427
  pearson6 427
  poisson 427
  stream, optional 427
  triangular 427
  uniform 427
  user-defined 427
  weibull 427
Distributions
  continuous 253
  define 55
  discrete
    cumulative distribution function 252
    probability mass function 252
  empirical 34
  fitting 34
  frequency
    example 34
    user-defined 34
Division 398, 399, 403
DO...UNTIL 437, 458, 492, 578
DO...WHILE 436, 437, 459, 465, 492, 578
Documentation symbols
  #, //, /*...*/ 451
DOWN 460
DOWNQTY() 461, 577
Downtimes 89, 91, 274, 281
  clock 132
  define location downtimes 55
  define resource downtimes 132
  downtime-specific system functions 425, 460, 462, 577
  location 101
    called 105
    clock 102
    entry 103
    setup 104
    special notes 109
    usage 103
  overlapping shift downtimes 169
  preemption 177
  resource 131
    clock 132
    usage 132, 133
Draw
  arc 317
  chord 319
  circle 318
  circular chord 319
ellipse 318
lines 316
polygon 319
rectangle 318
square 318
triangle 317
DTDELAY() 167, 298, 462, 577
DTLEFT() 167, 297, 463, 578
DTLENGTH() 166
Dynamic Plots 354, 358
Dynamic priority changing 408
Dynamic resources 129, 268

E

Edit
arrivals 156
background graphics 73, 87
editing preferences
confirm record deletion 325
long build menu 325
recalculating adjusted paths 325
existing graphic 95
graphics 74
logic windows 72
menu 70
background graphics 212
description 61
notes windows 72
preferences 83
process 53
table 9, 70, 83
color 83
edit table font 83
see glossary 591
table font 83
tank or gauge 180
Edit Tables 10
Ellipse
draw 318
ELSE 290
Empirical distribution 34
EMPTY 411
Enable costing 179
END 436, 437, 438, 465, 578
Engineers 33
ENT() 112, 396, 397, 402, 457, 466, 517, 531, 544, 577
Entity 47, 112
accessing 112
actions
implicit 453, 531, 549
activity
general statistics report 373
all as type 147
attributes 399
assigning values 277
entity characteristics 277
operation time 276
processing time 276
user condition routing 276
using 276
batching 278
accum 280
combine 278
group/ungroup 278
load/unload 279
characteristics 277
cost 176, 179
general statistics report 373
defining 49, 113
graphically 113
multiple entity graphics 114
entities editor 112
entity-related move logic statements
move for 512
move on 513
move with 514
entity-related operation statements 426
accum 429
combine 449
create 453
graphic 482
group 483
join 494
load 499
match 508
move 510
rename 531
route 542
split as 549
ungroup 558
unload 561
wait 567
wait...until 568
entity-specific attributes 577
entity-specific system functions 425
entity() 467
groupqty() 485
resqty() 538
graphics 320
dimensions 113
icon 113
location file 255
name 113
new 55
new entity check box 152
notes 113
orientation
  on conveyor 99
preemptive 115
  example 115
processing
  define 144
select
  by turn 110
  fewest entries 111
  first available 110
  highest attribute value 110
  last selected location 110
  least available capacity 110
  longest empty 111
  lowest attribute value 110
  most available capacity 111
  oldest by priority 110
  random 110, 111
show
  current 155
speed 113
spot 94
states
  by percentage 374
stats 113
types 89
unbatching 278
ENTITY() 467, 577
ENTRIES() 468, 577
Envelope
  crane 261
  multi-bridge 268
  multi-crane 263, 265
Equal to 398, 400
Equalities 398
Equipment manufacturers 33
Erlang distribution 427
Errors, run-time
  already routed 152
  no routing defined 152
Exclude graphic library 68
Exclusive work search 268
EXIT 373
EXP() 469
Expansion, incremental 36
Experiments
  conducting 37
types 29
types of 29
Exponential distribution 427
Exponentiation 398, 399, 403
Exporting
  background graphics 213
  graphic editor 307
Expression search 299, 300
  definition 300
  find 300, 301
  important notes 302
  performing 300
  replace 300, 301
  search next 300
Expressions
  boolean 399, 400
  expression and statement groups 577
  numeric 399
  string 397, 399, 402
    char() 402
    ent() 402
    format() 402
    loc() 402
    numeric 402
    res() 402
    time 399, 401
      colon notation 402
  types of 398
Extended movement zone 263
External files 254
  accessing 254
  define 254
  editor 254
  open files 257
  types 254
    arrivals file 256
    dll file 257
    entity-location file 255
    excel file 257
    general read file 254
    general write file 255
    other 257
    shift file 256
    usage 254
External spreadsheet file 578
External subroutine calls
  xsub() 573
Face validity 37
Facility 33
  layouts 33
  walk-throughs 33
Factorial design 42, 43
  fractional-factorial 43
  full-factorial 43
  two-level 43
Factors 42
  impact 30
Failed arrivals
  general statistics report 374
FIFO 558
  see locations, rules
Figures
  add to gauge or tank 181
File
  exclude graphic library file 68
  extensions 257
  external 254
    define 254
    editor 254
    open 257
    other 257
    types 254
  graphic library 173
  management 62, 63
  menu 62
    description 61
    during run time 345
    during run-time 345
  name
    see glossary 591
  open external 257
  types
    arrivals file 256
    entity-location 255
    general read 254
    general write 255
    shift file 256
Files
  ascii 527
  external spreadsheet 578
Fill
  color 310
    background graphics 214
    define 323
    tank 180
  pattern
  background graphics 214
  change 310
Find and replace, local 303
Find process mode 155
Finite move priority 267
FIRST AVAILABLE 412
First in, first out
Flexible manufacturing systems 7
Flip object 321
  horizontal 308
  vertical 308
Flow
  charts 33
  rate of flow 182
  time step
    tanks 182
Focus of simulation 31
Following bridge 265
Font 96
  edit table 83
    see glossary 591
FOR 510, 514
  FORLOCATION() 166, 167, 297, 470, 577
  Form of results 28, 29
  FORMAT() 402, 471, 575
  FORRESOURCE() 166, 167, 297, 472, 577
Fractional factorial design 43
Frame
  see glossary 591
  text 96
FREE 267, 473, 476, 496, 578
  FREECAP() 474, 577
  FREEUNITS() 475, 577
Frequency distributions
  example 34
Front of grid 277
Front of grid mode 210
FULL 421
Full-factorial design 43
Functions 425
  cost-related 478, 480
    general 425
      math 425
      system 577
      type conversion 425
    name 396
    nested 289
    new 357
    system 425
      downtime-specific 425
      entity-specific 425
      general 425
Gamma distribution 427
Gauge 94, 95
  add labels and figures 181
  change to tank 181
  edit 180
  see glossary 592
GBM files 257
General action statements 426
  activate 431
  animate 432
  debug 455
  display 457
  log 504
  maparr 506
  order 517
  pause 519
  read 527
  report 532
  reset 534
  reset stats 535
  return 539
  send 544
  sound 548
  trace 556
  view 566
  warmup 569
General control statements
  begin 436
  break 437
  breakblk 438
  do...until 458
  do...while 459
  end 465
  goto 481
  if...then...else 486
  while...do 570
General expressions 577
General functions 425
  math 425
  type conversion 425
General information 171
  accessing 171
  dialog 48
  dialog box 171
  distance units 171
  graphic file library 171, 173
  selection 173
  initialization logic 171, 172
  logic execution time 172
  model notes 171
  termination logic 172
  time units 171
  title 171
  usage 171, 210
General operation statements 578
  close 448
  dec 456
  graphic 482
  inc 488
  prompt 524
  setrate 546
  stop 552
  write 571
  writeline 572
  xwrite 575
General read file 254
General statistics report
  entity activity 373
  entity costing 373
  entity states by percentage 374
  location setup 375
  location states by percentage
    multiple capacity 375
    single capacity 375
  locations costing 374
  logs 376
  node entries 374
  resource states by percentage 376
  resources 377
    costing 376
    grouped 377
General system functions 425, 577
  calday() 439, 440, 577
  caldom() 577
  calhour() 441, 577
  calmin() 442, 443, 444, 577
  calmonth() 577
  calyear() 577
  cap() 445, 577
  clock() 447, 577
  contents() 452, 577
  downqty() 461, 577
  entries() 468, 577
  freecap() 474, 577
  freecap() 474, 577
  freeunits() 475, 577
  ownedresource() 577
  percentop() 520
percentutil() 521
threadnum() 553
timesused() 555, 577
units() 560, 577
variable() 565, 577
General write file 255
Geometric distribution 427
GET 115, 134, 153, 261, 269, 295, 296, 476, 578
GETCOST() 478, 578
GETRESRATE() 480, 578
GIF
  importing a background graphic 213
GLB files 257
GOTO 481, 578
GRAPHIC 114, 128, 130, 131, 140, 482, 578
Graphic
  new 314
Graphic editor 299, 304, 305
  accessing 304
  arc tool 317
  background color 311, 312
  changing a graphic's size 313
  changing the order of the graphics in the library 314
  chord tool 319
  circle tool 318
  clear button 313
  closing a graphics library 306
  combining two graphics 314
  copy
    button 322
    graphic 308
  cut button 322
  delete button 313
  dimensions 309, 310
  edit
    button 313
    library graphic 323
    menu 304, 306
  ellipse tool 318
  exporting a graphic 307
  file menu 304, 305
  fill
    color 308
    color button 323
    patterns 308, 310
  flip
    buttons 321
    horizontal 308
    vertical 308
  graphic tools button bar 315
  graphics menu 304, 308
  grid
  show 311, 312
  size & scale 311
  snap to grid 311, 312
  grouping graphics 308, 309
  importing graphics 307
  library edit buttons 313
  line
    color 308
    button 323
    styles 308, 309
  tool 316
  manipulating graphics 313
  move
    to back 308
    to front 308
  naming a graphic 314
  opening a graphics library 305
  options menu 305, 311
  order of graphics in the library
    change 314
  overview 304
  paste
    button 322
    graphics 307
  pie tool 319
  polygon tool 319
  positioning spot 320
  print
    graphic 305, 306
    graphics library 305, 306
  rectangle tool 318
  rotate
    button 321
    graphic 308
  save
    button 313
    graphic 305
    graphics library 306
  selector 315
  size
    change 313
  square tool 318
  status light 321
  step back & front buttons 322
  text tool 315
  triangle tool 317
  ungrouping graphics 308, 309
  usage 304
  window menu 305, 312
  zoom 311, 312
Graphic library
  create new 314
Graphical analysis 12
Graphics
background 277
alignment 214
behind grid 214
delete an object 74
edit 87
export 74, 213
fill
color 214
patterns 214
flip
horizontal 214
vertical 214
front of grid 214
group 214
import 49, 74, 213
line
color 214
styles 214
lock 214
move
behind grid 215
imported graphic 213
in front of grid 215
paste
bmp 74
wmf 74
removing an object 73
right-click editing 74
rotate 214
size an imported graphic 213
ungroup 214
unlock 214
customizing 277
behind grid 277
front of grid 277
importing 277
define multiple entity 114
dimensions 310
editing & moving 74
entity 320
graphic dimensions 113
library 95
file 171, 173
exclude 68
selection 173
graphic 96
location 94, 320
graphics window 92
edit button 92
erase button 92
view button 92
move 75
multiple
assign to resource 130
resource 320
multiple 130
Graphs
utilization 13
Greater than 398, 400
or equal to 398, 400
Grid
lines
change color 81
change resolution 81
scale 81
settings 88
grid scale 81
show 77, 85, 312
size 80
snap to 77
unit
default time 81
distance per unit 81
change 312
GROUP 98, 109, 177, 278, 283, 449, 453, 483, 499, 549, 558,
561, 578
Group
activity 35
graphics 214, 309
objects 309
resource 233
GROUPQTY() 485, 577

H

Hardware requirements 15
Help
index 85
menu 85
description 62
on-line 11
accessing 73
Hidden networks
show 87
Hide
conveyors and queues 97
networks 77, 85
Histogram 384
Hoist
and bridge trajectory 267
lower 268
speed 261
Home
  return if idle 137
Horizontal speed 275
Hours 401, 402, 447, 462
HR 401, 447, 462
Hypothesis testing 42

I

Icon
  add to location 94
locations 91
Idle
  return home if 137
Idle cranes 267, 268
  moving 266
IF EMPTY 151
IF...THEN 234, 289, 291, 350, 436, 437, 452, 465, 467, 486,
  503, 542, 553, 578
IF...THEN...ELSE 50, 289, 481, 486, 578
Immovable cranes 267
Impact factors 30
Import
  background graphics 49, 213
  graphic editor 307
tank submodel 180
Importing
  background graphics 277
  INC 488, 578
  INCENTCOST 489, 578
  INCLOCCOST 490, 578
Incremental expansion 36
INCRESCOST 491, 578
Independent arrivals 158
Industrial vehicles 274
  deployment strategies 274
  modeling 274
  multiple load transporters 274
  simulation benefits 275
Inequalities 398
INF 91
INFINITE 91, 157
Infinite deceleration 265
Information menu 58
  during run time 353
Initial
  cost  create 176
incentcost 176
  order 176
  route 176
  state 38
  warm-up period 41
Initial value 281
Initialization logic 171, 172
  execution time 172
Input variables 31
Insert
  record in a table 70, 71
Install model package 68, 69
Installation
  see setup and installation 15
INT 223, 225, 492, 578
Integer number
  see glossary 592
Integers 396
Interact menu 358
Interactive subroutines 241, 358
Interfaces
  edit table 121
  location-node 122
Intermittent conveyor 271
Interval batching 41
Inverse Gaussian distribution 427

J

JIT systems 7
Job shops 7
JOIN 55, 109, 112, 220, 282, 283, 375, 413, 494, 529, 578
Join 177
Joint
  add 119
  delete 119
JOINTLY GET 115, 134, 261, 269, 296, 496, 578

K

KANBAN systems 7
KEEP 267
Keyboard 3
Keywords 393, 395
<table>
<thead>
<tr>
<th>Label</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to gauge or tank</td>
<td>181</td>
</tr>
<tr>
<td>Text</td>
<td>94</td>
</tr>
<tr>
<td>Language elements</td>
<td></td>
</tr>
<tr>
<td>Character strings</td>
<td>393, 397</td>
</tr>
<tr>
<td>Keywords</td>
<td>393, 395</td>
</tr>
<tr>
<td>Names</td>
<td>393, 394</td>
</tr>
<tr>
<td>Conventions</td>
<td>394</td>
</tr>
<tr>
<td>Numbers</td>
<td>393, 396</td>
</tr>
<tr>
<td>Converting between numeric types</td>
<td>397</td>
</tr>
<tr>
<td>Integers</td>
<td>396</td>
</tr>
<tr>
<td>Name-index</td>
<td>396</td>
</tr>
<tr>
<td>Real numbers</td>
<td>396</td>
</tr>
<tr>
<td>Operators</td>
<td>393, 398</td>
</tr>
<tr>
<td>Comparison</td>
<td>398</td>
</tr>
<tr>
<td>Mathematical</td>
<td>398</td>
</tr>
<tr>
<td>Precedence</td>
<td>398</td>
</tr>
<tr>
<td>Relational</td>
<td>398</td>
</tr>
<tr>
<td>Types of 393</td>
<td></td>
</tr>
<tr>
<td>Last in, first out</td>
<td></td>
</tr>
<tr>
<td>LAST()</td>
<td>497, 577</td>
</tr>
<tr>
<td>Layout</td>
<td></td>
</tr>
<tr>
<td>Printing a layout</td>
<td>67</td>
</tr>
<tr>
<td>Settings</td>
<td>80, 88</td>
</tr>
<tr>
<td>Background color</td>
<td>80, 81</td>
</tr>
<tr>
<td>Grid settings</td>
<td>80, 81</td>
</tr>
<tr>
<td>Routing path color</td>
<td>80, 82</td>
</tr>
<tr>
<td>Window</td>
<td>49</td>
</tr>
<tr>
<td>Leading bridge</td>
<td>265</td>
</tr>
<tr>
<td>Length</td>
<td></td>
</tr>
<tr>
<td>Conveyor</td>
<td>99</td>
</tr>
<tr>
<td>Less than 398</td>
<td>400</td>
</tr>
<tr>
<td>Or equal to 398</td>
<td>400</td>
</tr>
<tr>
<td>Level</td>
<td></td>
</tr>
<tr>
<td>Of detail</td>
<td>28</td>
</tr>
<tr>
<td>Tank</td>
<td>181</td>
</tr>
<tr>
<td>Library</td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>314</td>
</tr>
<tr>
<td>Library graphic</td>
<td>95</td>
</tr>
<tr>
<td>See glossary</td>
<td>592</td>
</tr>
<tr>
<td>License key</td>
<td></td>
</tr>
<tr>
<td>Transferring</td>
<td>23</td>
</tr>
<tr>
<td>LIFO</td>
<td>558</td>
</tr>
<tr>
<td>See locations, rules</td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Change line or border style</td>
<td>309</td>
</tr>
<tr>
<td>Color</td>
<td>310</td>
</tr>
<tr>
<td>Background graphics</td>
<td>214</td>
</tr>
<tr>
<td>Define</td>
<td>323</td>
</tr>
<tr>
<td>Draw</td>
<td>316</td>
</tr>
<tr>
<td>Styles</td>
<td>309</td>
</tr>
<tr>
<td>Background graphics</td>
<td>214</td>
</tr>
<tr>
<td>LN()</td>
<td>498</td>
</tr>
<tr>
<td>LOAD</td>
<td>109, 177, 221, 226, 279, 283, 375, 396, 414, 449, 453, 483, 499, 549, 558, 561, 578</td>
</tr>
<tr>
<td>Load</td>
<td></td>
</tr>
<tr>
<td>Delivery time</td>
<td>270</td>
</tr>
<tr>
<td>Jumping</td>
<td>272</td>
</tr>
<tr>
<td>Overlap</td>
<td>272</td>
</tr>
<tr>
<td>Rate capacity</td>
<td>270</td>
</tr>
<tr>
<td>Spacing</td>
<td>272</td>
</tr>
<tr>
<td>LOC()</td>
<td>90, 151, 396, 397, 402, 457, 461, 474, 501, 517, 544, 560, 577</td>
</tr>
<tr>
<td>Local find and replace</td>
<td>303</td>
</tr>
<tr>
<td>Local variable</td>
<td>578</td>
</tr>
<tr>
<td>Declaration statements</td>
<td></td>
</tr>
<tr>
<td>Int</td>
<td>492</td>
</tr>
<tr>
<td>Real</td>
<td>529</td>
</tr>
<tr>
<td>Local variables</td>
<td>225</td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Attributes</td>
<td>577</td>
</tr>
<tr>
<td>Location-specific system functions</td>
<td>577</td>
</tr>
<tr>
<td>Location()</td>
<td>503</td>
</tr>
<tr>
<td>LOCATION()</td>
<td>296, 298, 445, 503, 577</td>
</tr>
<tr>
<td>Locations</td>
<td>47, 90</td>
</tr>
<tr>
<td>Accessing</td>
<td>90</td>
</tr>
<tr>
<td>Add mode</td>
<td>94</td>
</tr>
<tr>
<td>Adding symbol to existing location</td>
<td>94</td>
</tr>
<tr>
<td>Attributes</td>
<td>218</td>
</tr>
<tr>
<td>Capacity</td>
<td>91, 100</td>
</tr>
<tr>
<td>Maximum</td>
<td>91</td>
</tr>
<tr>
<td>Conveyor/queue</td>
<td>94</td>
</tr>
<tr>
<td>Cost</td>
<td>175, 178</td>
</tr>
<tr>
<td>Costing</td>
<td></td>
</tr>
<tr>
<td>General statistics report</td>
<td>374</td>
</tr>
<tr>
<td>Counter</td>
<td>94, 95</td>
</tr>
<tr>
<td>Create</td>
<td>90</td>
</tr>
<tr>
<td>Define</td>
<td>49, 90</td>
</tr>
<tr>
<td>Multiple locations</td>
<td>92</td>
</tr>
<tr>
<td>Multi-unit locations</td>
<td>101</td>
</tr>
<tr>
<td>New location graphically</td>
<td>92</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>93</td>
</tr>
<tr>
<td>Location graphic</td>
<td>93</td>
</tr>
<tr>
<td>Destination</td>
<td></td>
</tr>
<tr>
<td>Processing</td>
<td>151</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Information during run time</td>
<td>86, 354</td>
</tr>
<tr>
<td>Location name</td>
<td>95</td>
</tr>
<tr>
<td>Downtimes</td>
<td>91, 101</td>
</tr>
<tr>
<td>Called</td>
<td>105</td>
</tr>
</tbody>
</table>
shift & break 166, 297
  break logic 297
  functions & statements 297
off-shift logic 297
pre-break logic 297
pre-off shift logic 297
sequence of events 166, 297
subroutines 241
windows
  edit 72
Logic elements
distribution functions 427
  axis shift, optional 427
general components 427
stream, optional 427
functions 425
  downtime-specific 425
entity-specific 425
general 425
resource-specific 425
shift & break 425
system 425
general functions 425
  math 425
    type conversion 425
priorities 428
resource request logic 268
statement blocks 426
statements 426
  control 426
  entity-related operation 426
general action 426
resource-related 426
Lognormal distribution 427
Logs
general statistics report 376
Long build menu 325
  view 325
LONGEST UNOCCUPIED, (LU) 415
Lower the hoist 268
LU, see LONGEST UNOCCUPIED

M

Macros 89, 233, 399
  accessing 233
  and subroutines 578
  create 233
  definition 233
  edit 233
  table 233
  example 233
  macros vs. subroutines 233
  rti 233, 234
  see also run-time interface
  subroutines vs. macros 242
text 233
  usage with begin/end 234
  valid usage 233, 234
Main entity 592
  errors
    already routed 152
    no routing defined 152
  Main menus
    see glossary 592
Maintenance reports 33
  Maintenance, scheduled 274
Managers 33
Manual material handling systems 274
  modeling labor 274
  simulation benefits 274
MAPARR 506, 578
Mapping
  create 123
  edit table 122
  example 123
Market forecasts 33
MATCH 109, 375, 494, 508, 578
Math functions 425
  exp() 469
  ln() 498
  rand() 526
  round() 541
  sqrt() 551
Mathematical operators 398, 399
Matrix, resource preemption 135
Maximum run length 339
Maximum speed 265
Memory
  allocation
    for attributes 218
Menu
  bar 61
Merge
  models 10, 63, 64
  submodel 64
MIN 401, 447, 462
Minutes 401, 402, 462
MMHS
  see manual material handling systems
MOD files 257
Model
build 9, 35, 47
create new 63
data
  protect 68
  elements 47
    basic 48
example of building a model 47
execution 337
merge 63, 64
new 63
notes 171
open 63
package
  create 68
  data protection 68
  install 68, 69
parameters 337, 342
  define 343
partitioning 36
phased modeling approach 48
results, reporting 45
run 11
run-time 11
save 63
save as 63, 64
text
  print 66
  view 66
validation 37
verification 36
Modeling
  services 5
Modeling conveyors 272
  conveyor systems 271
Modeling priorities
  see priorities
Modulus 398, 399, 403
MOST 416
Motion, bridge 266
MOVE 97, 98, 294, 296, 510, 578
Move
  along path network 138
  finite move priority 267
  graphics 74
    special considerations 75
gross move time 269
idle cranes 266
location 75
location graphic 93
logic 151, 153, 294
  get, jointly get, use 296
move-related statements 295
  statements
    processing 296
logic statements 578
  free 473
  get 476
  jointly get 496
  move for 512
  move on 513
  move with 514
  use 563
moving a record in a table 70, 71
multiple location graphics 93
object
  behind 322
  in front 322
path networks 75, 119
resource 76
  points 142
routing paths 75
to park 269
MOVE FOR 153, 294, 295, 512, 578
MOVE ON 153, 294, 295, 512, 513, 578
MOVE WITH 153, 261, 267, 294, 295, 476, 512, 513, 514, 578
Moving Graphics, common mode 74
Multi-bridge
  crane systems 261, 266
  envelopes 268
Multi-crane envelopes 263, 265
Multiple capacity location 100
Multiple load transporters
  see industrial vehicles
Multiple locations 92
Multiple single-unit resources 131
Multiple streams 44
Multiplication 398, 399, 403
Multi-unit
  locations 100
  resources 131

N

Name
  index
    see glossary 592
location 91
Name-index numbers 396, 399
conversion functions
  loc() 501
  res() 533
Names 281, 393, 394
conventions 394
functions
    ent() 396
    loc() 396
    res() 396
Nested functions & statements 289
Network
    non-passing 117
    passing 117
    path 117
    resource path network 137
    show hidden 87
    show networks 77, 85
version
    installation procedure 17
New
    arrival 55
    entity 55
    entity check box 152
        block number *
        152
    location 55
    mode 92
    model 63
        create 63
        process
            create 154
New & modified features
    activex objects 586
New & modified statements and functions 357
New graphic
    create 314
New graphics library
    create 314
NEXT() 516, 577
No queue-up 265
Node
    add resource points to 141
    break 137
    home 137
    logic 128
        editor 140
        example 140
    off shift 137
Node logic-specific system functions 577
Nodes 268
    serviceable 261
Non-accumulating conveyor 98
Non-accumulating conveyors 270
Non-exclusive work search 268
Non-terminating simulation 38, 39
running 40
Normal distribution 427
NOT 398, 401, 403
Not equal to 398, 400
Notation
colon 402
Notes
    field 92
    see glossary 592
    windows
        editing 72
Numbers 393, 396, 399
    converting between numeric types 397
    integers 396
    name-index 396
    numeric type
        see glossary 592
    random
        streams 258
    real numbers 396
Numeric expressions 399
Numeric Type, glossary 592
Numeric types, converting between 397

O

Objectives, defining 26
Observation-based statistics 224
Off-shift
    locations, preempting 168
    logic 166
    node 137
Off-shift & break logic specific system functions & statements 578
On-board vehicle sensing 273
One-dimensional array 227
On-line tracking systems 33
Open
    model 63
Operation
    crane 262, 267, 268
    statements 578
time
    using entity attributes 276
    zone 268
Operation logic 53
    processing 147
Operator precedence 398, 403
addition, + 403
and 403
concatenation, $ 403
division, / 403
equalities 403
examples 403
exponentiation, ** 403
inequalities 403
modulus, @ or mod 403
multiplication, * 403
not 403
or 403
parentheses, ( ) 403
subtraction, - 403
Operators 393, 398
comparison 398
mathematical 398
relational 398
Optimization
simrunner 360
study 27
Options 299, 325
menu
debug option 347
during run time 346
simulation 57, 337
OR 398, 401, 403, 486
ORDER 218, 489, 517, 578
Output
analyzing 45
charts 46
costing statistics 178
output menu 62
reporting options 340
batch mean 340
interval length 341
number of replications 341
periodic 341
running a specific replication 341
standard 340
viewing 12
Output Viewer 3DR 364
Overlap
load 272
OWNEDRESOURCE() 518, 577

P

Pan 57
Parameters
see glossary 593
subroutines 240
Parentheses 403
Park and work search 268
Park search 128, 138
edit table 139
see glossary 593
Park, travel to 269
Partitioning, model 36
Paste 322
record in a table 71
text in a notes window 72
Path
networks, see path networks
routing
move 75
show 77, 86, 87
types 82
see glossary 593
segment
edit table 52
Path networks 48, 75, 89, 117
accessing 117
automatic time and distance calculation 121
default time and distance values 121
define 52
color of path network 118
graphically 118
editor 117
example 119
interfaces edit table 121
location interface points 118
mapping 118
edit table 122
example 123
move 119
name 118
nodes 118
creating additional 119
edit table 124
non-passing 117
paths 118
paths 118
creating segments 119
recalculating adjusted paths 325
segment edit table 120
segments 119
pre-translation check 125
resource 137
speed/distance measurement 118
time measurement 118
types
non-passing 118
passing 118
Path networks, see path networks
routing
move 75
show 77, 86, 87
types 82
see glossary 593
segment
edit table 52
Path networks 48, 75, 89, 117
accessing 117
automatic time and distance calculation 121
default time and distance values 121
define 52
color of path network 118
graphically 118
editor 117
example 119
interfaces edit table 121
location interface points 118
mapping 118
edit table 122
example 123
move 119
name 118
nodes 118
creating additional 119
edit table 124
non-passing 117
paths 118
paths 118
creating segments 119
recalculating adjusted paths 325
segment edit table 120
segments 119
pre-translation check 125
resource 137
speed/distance measurement 118
time measurement 118
types
non-passing 118
passing 118
PAUSE 232, 519, 578
Pause simulation 57
PCX
  importing a background graphic 213
Pearson5 distribution 427
Pearson6 distribution 427
People as resources 274
PercentOp() 520
PercentUtil() 521
Performance analysis 26
Pickup time 138
Pitfalls in simulation 46
Planning the study 26
Points
  resource 141, 142
Poisson distribution 427
Polygon
  draw 319
Positioning spot
  place on an icon 320
  see glossary 593
Power Tools 328
Pre-analysis 361
Pre-break logic 166
Precedence, see Operator precedence
Predetermined time standards 33
Preemption
  creating a preemption process record 292
  downtime 177
  entities 115
  locations 105
  off-shift locations 168
  process
    example 293
    logic 292
      possible effects of delayed preemption 293
    new functions 293
    resources 134, 135
    examples 135
    see glossary 593
  shift & break logic 167
Preemption logic 281
  and downtimes 281
  system functions 577
  preemptor() 522
timeleft() 554
PREEMPTOR() 293, 522, 577
Pre-off-shift logic 166
Preparing a simulation specification 26
Pre-translation check 125
Print
  graphic 306
  library 306
  layout 66
  model text 66
  printer setup 66, 68
    change the printer settings 68
  text 66
Printing text within a logic window 73
Priorities 428
  assign 106
  claim 262
crane move 261, 262
dynamic priority changing 408
effective 264
finite move 267
for a destination 280
locations 105, 106
modeling 280
  downtimes 281
  preemption 281
  processing destination 280
  selecting resources 280
resource request 261, 268
resources 134
shift 165
task move 261
PRIORITY 166, 167, 297, 523, 578
ProActiveX 331
PROBABILITY 407, 417
Probability mass function 252
Processing 47, 143
  add routing mode 154
  create and edit process routings 143
define 50, 143
    graphically 144
deleting a process or routing record 154
destination location 151
editing 53
editor 145
    accessing 143
    using 143
entity 144, 146
example 144
find process mode 155
layout window 145
location 146
logic 50, 53, 56, 89
move logic 151, 153
new process mode 154
operation logic 147
output part 150
process edit table 50, 53, 145
processing tools 153
records
edit 71
routing
adding additional blocks 155
block number 149
edit table 145, 149
entity to exit 155
path editing 154
rules 151
view routing button 155
tools window 145
using all entity type 147
Processing time
using entity attributes 276
ProClare 329
Product support 4
Program defaults 584
default values table 584
Progressive refinement 35
Promodel Player
promodel player 334
promodel player gold 335
PROMPT 524, 578
ProSetter 330
Protect model data 68
Pull systems
creating 282
send statement
pull systems 282
steps to build 282
types of 282

Q

Quantity 152
Queue 94, 97
by type 110
define 97
color 97
drawing 97
entity preemption 97
first in, first out (fifo)
highest attribute value 110
last in, last out (lifo)
lowest attribute value 110
move 97
no queuing 110
run-time visibility 97
style 97
width 97

Queue-up
bridge 266
conditions 265
situations 265
unrealistic 265
Queuing 270

R

RAND() 55, 526
RANDOM 418
Random
numbers 258
streams 43
Rate of flow 182
Rate, tank flow 182, 193, 195
RDB files 257
RDT files 257
RDW files 257
READ 448, 527, 578
Read data 254
REAL 223, 225, 529, 578
Real number
see glossary 593
Real numbers 396
REAL() 530
Recharging strategies 274
Reclaim trigger events 264, 267
Record
append
to table 71
copy 71
information 71
between records 71
delete
from a table 70
insert in a table 71
move in a table 71
paste 71
Rectangle
draw 318
Reference
see glossary 593
view 79
Refinement, progressive 35
Refresh layout 83, 88
Region
see glossary 593
Registration
network installation 23
stand-alone pc 22
Rejection, claim attempt 263
Relational operators 398
Relationships
cause-and-effect 30
Remove view 78
RENAME 112, 178, 531, 578
Rename
views 79
RENAME AS 149, 150
Replace, find and 303
Replications 37, 39
running a specific replication 341
REPORT 342, 532, 535, 578
Reports 372
view 59
Requirements
hardware 15
RES() 126, 396, 397, 402, 457, 461, 496, 533, 555, 560, 577
RESET 527, 534, 571, 572, 575, 578
RESET STATS 342, 535, 578
Reset window positions 84
Resolution
grid lines 81
Resource request 266
logic 268
priorities 261
priority 261, 268
Resource statistics 269
RESOURCE() 167, 297, 536, 537, 577
Resource-related operation statements 426
free 473
get 476
graphic 482
jointly get 496
use 563
wait...until 568
Resources 48, 89, 126
accessing 126
closest 137
cost 176, 178
general statistics report 376
create 126
new resource 128
define 52
definition 126
downtimes 127, 131
clock 132
define 132
usage 133
dynamic 268
dynamic resources 129
edit 126
table 127
entity search rules 137
example 126
general statistics report 377
graphic 128
graphics 320
window 127, 128
group 233
home node 137
icon 127
least utilized 137
logic 128
longest idle 137
motion 138
move 76
multiple resource graphics 130
example 130
multiple, single-unit resources 131
multi-unit 131
vs. multiple single-unit 131
name 127
node logic
editor 140
example 140
notes 128
park search 128, 138
edit table 139
path network 137
people as 274
point
see glossary 594
preemption 134
examples 135
matrix 135
priorities 134
shift downtime 134
res() 126
resource points 128, 141
adding 141
deleting 142
moving 142
search
routines 138
rules 137
see glossary 593
selecting 280
shift & break nodes 137
specifications 128, 136
states by percentage
general statistics report 376
static resources 129
statistics 127
units 127
variability
  adding 48, 52
work search 128, 138
  edit table 139
Resource-specific system functions 425, 577
  last() 497
  next() 516
  ownedresource() 518
  resource() 536, 537
ResourceUnit() 537
Response 42
  variables 31
Response time 275
  minimize 274
RESQTY() 538, 577
RETURN 239, 539, 578
Return home 268
Return home if idle 137
Right-click
  editing 74
  menus 87
  simulation menu 360
Rotate
  object 321
  text 96
ROUND() 239, 400, 541
ROUTE 150, 373, 489, 542, 549, 578
Routing
  block 149
  color 88
  edit table 50, 53
  logic 50, 53, 56
  move logic 153
  path
    color 80, 82
    edit 154
    move 75
    show 77, 86, 87
    types 82
priority
  see glossary 594
process
  create 143
  edit 143
quantity 152
start new routing block 152
table
  * 152
  block number 152
type
  related 82
  selected 82
  unselected 82
Routing rules 405
  alternate 406
  backup 407
  continue 408
    dynamic priority changing 408
  dependent 410
  dialog box 405
  empty 411
  first available 412
  full 421
  join 413
  load 414
  longest unoccupied, (lu) 415
  probability 417
  random 418
  send 419
  turn 420
  user condition 422
Routing, user condition 276
Rule field, routing edit table 405
Rules
  dialog box 109
  location 91
Run
  length 41
    calendar date 338
    time only 338
    weekly time 338
  model 11, 56, 337
  non-terminating simulations 40
  simulation 345
  terminating simulations 39
Run-time
controls 345, 359
  animation panning 359
  clock display 359
  identifying location name 360
  simulation speed 359
end simulation 346
errors
  already routed 152
  no routing defined 152
file menu 345
help menu 358
information menu 353
arrays 86, 354
locations 86, 354
status light 354
variables 86, 354
interact menu 358
subroutines 358
interface 234
advantages 234
creating 235
defining 235, 343
example 236
model parameters 342, 343
numeric range 235
parameter name 235
prompt 235
record range 235
text 235
menus 345
models, creating 11
options menu 346
animation off/on 346
debug option 346, 347
trace output 346
user pause 346
zoom 346
pause/resume simulation 346
simulation menu 346
window menu 358

Save
and run 337
model 63
model as 63
Scale
grid 81
Scenarios 337, 343
defining 344
parameters 343
Scheduled maintenance 274
Scheduling a simulation project 30
Scope 28
Scroll
arrow, see glossary 594
bar, see glossary 594
box, see glossary 594
Search
definition 161
accessing 161
adding work to a shift or break block 162
advantage of shifts 161
editing work or break time 162
editor 161
menus 161
erasing work or break time 163
downtime
resource search rules
closest 137
least utilized 137
longest idle 137
routines 138
work 138
Search, find and replace 303
SEC 401, 447, 462
Seconds 401, 402, 462
SED files 257
Segments 119
SEND 282, 406, 419, 428, 544, 578
Sensitivity analysis 27
Separation distance, bridge 263
Serviceable nodes 261
SETRATE 546, 578
Settings 76, 77
layout 80
printer 68
Setup and installation 15
hardware requirements 15
network version 17
stand-alone pc 15
SFT files 257
Shell 178, 594
Shift
assignments 163
locations 164
overlapping downtimes 169
priorities 165
resources 164
units 164
selecting shift files 165
shift & break
logic 166
functions & statements 166
preemption 167
sequence of events 166
start times 165
usage 163
colors
customize 162
copy a shift 163
Park 138
principles 167
examples 168
locations 167
overlapping downtimes 169
preemption 168
resources 169
priorities 134
editor 161
menus 161
file 256
priorities
break 165
end shift 165
off-shift 165
start break 165
shift & break logic 297
break logic 297
functions & statements 297
off-shift logic 297
pre-break logic 297
pre-off-shift logic 297
sequence of events 297
Shift Library 331
Shifts & breaks 274
logic statements
priority 523
skip 547
system functions 425
dtleft() 463
forlocation() 470
forresource() 472
resource() 536, 537
Shift-specific system functions 577
forlocation() 577
forresource() 577
Show
conveyors and queues 97
grid 77, 85, 87, 312
hidden networks 87
networks 77, 85
routing paths 77, 86, 87
SimRunner 360
benefits 361
define
input factors 361
objective function 361
stage three simulation optimization 362
starting a new project 361
Simulation
animation off 58
focus 31
menu 337
description 62
during run time 346
model parameters 337
options 337
running a model 337
run-time
end simulation 346
pause/resume 346
save & run 337
scenarios 337
non-terminating 38, 39
running 40
options 57, 338
clock precision 339
common random numbers 340
customized reporting 342
disable
animation 339
cost 339
time series 339
display notes 339
maximum run length 339
output
path 338
reporting options 340
batch mean 340
interval length 341
number of replications 341
periodic 341
running a specific replication 341
standard 340
pause at start 339
run length
calendar date 338
time only 338
weekly time 338
pitfalls 46
planning
data gathering 32
steady-state 39, 40, 42
steps 25
analyzing the output 45
building the model 35
conducting experiments 37
defining the system 30
planning the study 26
reporting the results 45
terminating 38, 39, 41
running 39
Single-section conveyors 271
Sizing 76
SKIP 166, 297, 547, 578
Snap
  lines to border 155
  to grid 76, 77, 87
Snap to grid
  off 272
  on 272
SOUND 548, 578
Spacing
  load 272
Speed
  and distance 118
  bridge 261
  control bar 57
  conveyor 100, 270
  crane bridge 265
  factor 120
  hoist 261
  horizontal 275
  simulation
    run-time control 359
  vertical 275
SPLIT AS 97, 98, 112, 149, 150, 151, 178, 218, 373, 449, 453,
  483, 499, 549, 561, 578
Spreadsheet
  external file 578
SQRT() 551
Square
  draw 318
Square root 551
Stage one
  pre-analysis 361
Stand-alone PC
  setup and installation 15
Start new block 152
Stat::Fit 299
State
  initial 38
  terminating 38
State Chart 382
Statements 426
  and expression groups 577
  blocks 426
  control 426
  cost related 489, 490, 491
  entity-related operation 426
  general action 426
  nested 289
  new 357
  resource-related 426
Static resources 129
Statistics 91
  basic 91
  cost 591
  displaying on screen 281
    system throughput 281
    total system time for entities 281
  none 91
  observation-based 224
  resource 269
  time 595
  time series 91
  time-weighted 224
  view 59
Status
  light 94, 354
    place on icon 321
    see glossary 594
Steady-state 37, 40, 41
  simulation 39, 40, 42
Step
  back 322
  front 322
  trace 58
STOP 552, 578
Stream, distributions 427
Streams 258
  accessing 258
  definition 258
  edit table 258
  example 259
  multiple 44
  random number 43, 258
  usage 258
String
  see glossary 594
Strings
  character 393
  expressions 399, 402, 578
    char() 402
    character strings 402
    concatenation operators 402
    ent() 402
    format() 402
    loc() 402
    numeric expressions 402
    res() 402
    functions
      char() 446
      format() 471
Submodel
  merge 64
  tank 180
  import 180
uses 10

Submodels
  tank
    tank_dec 190
    tank_inc 190
    tank_risetrigger 191
Subroutines 89, 238, 399
  accessing 238
  and macros 578
  create 238
  definition 238
  edit 238
    table 238, 240
  example 240
  executing interactive subroutines during run time 358
  external 242
  format 239
  interactive 241
  logic 239, 241
  parameters 239, 240
  return statement 239
  subroutines vs. macros 242
  tank
    tank_cap 192
    tank_doooperation 193
    tank_doprep 195
    tank_empty 186
    tank_falltrigger 191
    tank_fill 185
    tank_freecap 192
    tank_godown 193
    tank_godownsched 194
    tank_rate 199
    tank_selectinput 198
    tank_selectoutput 196
    tank_setlevel 189
    tank_setstate 196
    tank_transfer 187
    tank_transferdownto 188
    tank_transferupto 187
    tank_updatestats 198
  type (none, real, integer or interactive) 238
  valid usage 239
Subtraction 398, 399, 403
Supply chains & logistics 7
Switches 76
Symbols and notation
  keyboard 3
  logic 3
  text 3
System
  definition 30, 31
menu, see glossary 594
System functions 399, 425
  break logic-specific 577
  downtime-specific 577
  entity-specific 577
  location-specific 577
  node logic-specific 577
  preempt logic specific 577
  resource-specific 577
  shift-specific 577
System throughput 281

T

Table
  editing 70
  functions 248
    accessing 248
    defining 248
    edit table 249
    editor 248
    examples 248, 249
  Table functions 399
  TAKE 453
  TANK_CAP 192
  TANK_DEC 190
  TANK_DOOPERATION 193
  TANK_DOPREP 195
  TANK_EMPTY 186
  TANK_FALLTRIGGER 191
  TANK_FILL 185
  TANK_FREECAP 192
  TANK_GODOWN 193
  TANK_GODOWNSCHED 194
  TANK_INC 190
  TANK_RATE 199
  TANK_RISETRIGGER 191
  TANK_SELECTINPUT 198
  TANK_SELECTOUTPUT 196
  TANK_SETLEVEL 189
  TANK_SETSTATE 196
  TANK_TRANSFER 187
  TANK_TRANSFERDOWNTO 188
  TANK_TRANSFERUPTO 187
  TANK_UPDATESTATS 198
  Tanks 94, 95, 180
    add labels and figures 181
    basic concepts 181
    border color 180
    capacity
maximum 91
change between a tank and a gauge 181
define 180
edit 180
fill color 180
flow time step 182
levels 181
rate of flow 182
submodel 180
import 180
Tanks, time units 182, 193, 195
Task move priority 261
Technical support 4
Terminating
  simulation 38, 39, 41
  running 39
  state 38
Termination logic 172
  execution time 172
Testing
  hypothesis 42
Text 3
  clear 72
  copy 72
  cut 72
  dialog box 96
  file
    view 57
  label 94
  paste 72
  see glossary 595
THEN 290, 486
THEN FREE 295, 514
THREADNUM() 553
Throughput 281
Tile 84
Time 118, 120
  between autosaves 326
  blocked 269
  default grid time 81
  expressions 399, 401
  colon notation 402
  load delivery 270
  move 269
  statistics 595
  studies 33
  time and condition dependent activities 31
  time-weighted statistics 224
  units 171
Time units, tank 182, 193, 195
TIMELEFT() 293, 554, 577
Timeplot 386
TIMESUSED() 555, 577
Title of model 171
Toolbar 85
Tools
  button bar 211
  menu
    description 62
    options
      confirm record deletion 325
      long build menu 325
      recalculating adjusted paths 325
    settings
      directories 325
      processing 153
TRACE 556, 578
Trace 346
  continuous 58, 352
  filtered 352
  off 351
  options 351
  output to file 353
  step 58, 351
  window 11
Training 8
Trajectory, hoist and bridge 267
Transfer lines 7
Transfering a license key 23
Translation status window 345
Travel to park 269
TRC files 257
Triangle
  draw 317
  Triangular distribution 427
  Trigger events, reclaim 267
TRUNC() 557
TURN 420
Two-dimensional array 228
Two-level design 43
Type 281
  conversion functions 425
  ent() 466
  real() 530
  trunc() 557
  numeric 397
Type of experimentation 28, 29

U

Unbatching 278
UNGROUP 97, 98, 178, 278, 283, 373, 449, 453, 483, 499,
Valid expressions & statements 577, 579
  fields evaluated during simulation 581
  fields evaluated only at translation 579
  groups by field 579
Validation, model 37
Variability
  resources
    adding 48, 52
VARIABLE() 565, 577
Variables 89, 223, 399
  accessing 223
  displaying information during run time 86, 354
  edit
    icon 225
    table 223
  global variable definition 223
icon 223
  editing 225
  placement 224
  removal 225
  initial value 223
  input 31
  layout 224
  local
    example 225
    variables 225
  response 31
  statistics 223
  type (real or integer) 223
Vehicles, industrial 274
Verification, model 36
Vertical bridge crane 275
Vertical speed 275
VIEW 566, 578
View 58, 77, 86, 88
  add 78
  define 77
  location 93
  managing 78
  menu 217
    accessing 76
    commands 83
    description 61
    edit table 83
      color 83
      edit table font 83
    layout settings 80
      background color 80, 81
      grid settings 80, 81
      routing path color 80, 82
    refresh layout 83
    reset window positions 84
    settings 77
    switches 76
    views 77, 86
      managing 78
      reference
        in model logic 79
      zoom 77, 79, 86
      to fit layout 77, 86
model
  reports 59
  statistics 59
  text 66
move
  down 79
  up 78
output 12
reference
  in model logic 79
remove 78
rename 79
routing 155
select 77
  view 78
  with shortcut key 78
set view 79
text 66
file 57
Views
  defining 77
  selecting 78

W
WAIT 134, 149, 166, 167, 175, 291, 293, 296, 297, 348, 375, 431, 476, 554, 567, 578
WAIT UNTIL 109, 140, 166, 182, 226, 232, 296, 297, 342, 374, 375
WAIT...UNTIL 431, 568, 578
WARMUP 342, 569, 578
Warm-up period 40
  determine 40
  initial 41
Weeks 401, 447, 462
Weibull distribution 427
What’s new
  features
    activex objects 586
    statements and functions 357
WHILE...DO 229, 234, 289, 431, 437, 492, 570, 578
Window menu 84
  description 62
    during run-time 358
WIP 281, 350, 544
WK 401, 447, 462
WMF
  importing a background graphic 213
Work search 128, 138
  and park search 268
    edit table 139
    exclusive 268
    non-exclusive 268
    see glossary 595
WRITE 255, 448, 571, 575, 578
Write data 254
WRITELINE 255, 448, 572, 575, 578
WWW.PROMODEL.COM 61

X
XSUB() 238, 573, 577
  external subroutine calls 573
XWRITE 255, 448, 471, 571, 575, 578

Z
Zero units 127
Zone
  active operation 268
  blocking 273
  claim examples 263
  claims 263
  extended movement 263
Zoom 57, 58, 77, 79, 86, 88
  animation 353
custom 79
to fit layout 77, 86, 88
Disclaimer

The information in this guide is provided by PROMODEL Corporation to document SimRunner. The content of this manual is subject to change without notice and does not represent a commitment on the part of PROMODEL Corporation. The software described in this guide is supplied under a license agreement and may be copied only under the terms of the license agreement. No part of this guide may be reproduced, transmitted, or distributed by any means, electronic or mechanical, for purposes other than the owner’s personal use without express written permission from PROMODEL Corporation.

Copyright Information

© 2002 PROMODEL Corporation
All rights reserved
Printed in the United States of America

SimRunner, emodel, ProModel, MedModel, and ServiceModel are registered trademarks of PROMODEL Corporation.

Text indicator graphics Copyright New Vision Technologies Inc.

Microsoft is a registered trademark and Windows is a trademark of Microsoft Corporation.

IBM is a registered trademark of International Business Machines Corporation.

Netware and Novell are a registered trademarks of Novell, Inc.

1/23/02
# Table of Contents

Table of Contents ............................................................. iii

**Introduction** ...................................................................... 1

- About the User Guide ......................................................... 1
- Symbols and Notation ......................................................... 2
- Product Support ................................................................. 2
- Modeling Services .............................................................. 3
- Reporting Suggestions ....................................................... 4

**Chapter 1: SimRunner Concepts** ........................................... 5

- What is SimRunner? .......................................................... 5
- Benefits ........................................................................... 5
- Where Do I Begin? ............................................................ 6
  - Concepts and Theories ................................................... 7
  - General Procedure ....................................................... 10
  - Pitfalls ........................................................................... 11

**Chapter 2: Getting Started** ................................................ 13

- The Interface ..................................................................... 13
- Set Up a Project ............................................................... 14
  - Select Model/Project .................................................... 14
  - Define Objectives ......................................................... 14
<table>
<thead>
<tr>
<th>Chapter 3: Building Projects</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>31</td>
</tr>
<tr>
<td>Set Up Project</td>
<td>32</td>
</tr>
<tr>
<td>Analyze Model</td>
<td>36</td>
</tr>
<tr>
<td>Optimize Model</td>
<td>38</td>
</tr>
</tbody>
</table>

| Appendix                                                      | 41   |

| Glossary                                                      | 43   |

| Bibliography                                                  | 47   |

| Index                                                         | 49   |
Introduction

0.1 About the User Guide
The SimRunner User Guide is a reference that will guide you through the process of building simulation optimization projects. This guide contains detailed information on the use of features and capabilities found within SimRunner and serves to complement the product training.

Chapter 1
SimRunner Concepts
As an introduction to simulation optimization, this chapter begins by reviewing some of the theory behind optimization. The remainder of the discussion revolves around the basic approach to building, running, and examining results from models.

Chapter 2
Getting Started
Introduces the product interface and allows you to become more familiar with the SimRunner environment. Contains an in-depth discussion and explanation of each step you must follow to build, run, and examine an optimization project.

Chapter 3
Building Projects
Steps you through a sample project.

Appendix
Contains a list of suggested readings.

Glossary
Contains definitions and descriptions for many of the terms and concepts common to simulation and modeling.

Bibliography
Referenced materials.
0.1.1 Symbols and Notation

To better help you navigate this text, please review the following symbols and conventions.

Keyboard

The names of keys are displayed in capital letters. For example, ESC refers to the Escape key and CTRL refers to the Control key.

Keys are frequently specified in combinations or in a sequence of keystrokes. For example, CTRL + L means to hold down the CTRL key while pressing L. When key commands are set off by commas (e.g., ALT + N, R), press and release each of these keys (or key combinations) in the order listed. The term “arrow keys” refers collectively to the ↑, ↓, ←, and → cursor keys.

Text

Specific text you are asked to type is shown in bold type. For example, if you are directed to type cd simrun, you would type the lowercase letters “cd” followed by a space and the letters “simrun.”

Placeholders for things such as file names and directories are shown in italics. For example, if you are directed to type filename.res, enter the name of the file you wish to use (e.g., model_1.res).

0.1.2 Product Support

Technical support is available to all licensed SimRunner users with current maintenance and support agreements. Support representatives are glad to answer specific questions you may have and offer direction in solving specific modeling challenges you encounter. See also Modeling Services on page 3.

Technical support

Technical support is available via: internet, e-mail, telephone, and fax. When you contact technical support, please be prepared to provide your user profile and a description of any problems you experience.

User Profile

- Your name and company
- The license # found on your security key
- Hardware make and configuration
- Network information (if applicable)
- Version number of Windows and SimRunner

Problem Description

- Brief description of the problem you are experiencing
- What you were doing when the problem occurred
- The exact wording of any messages that appeared on your screen
Internet
www.promodel.com/solutionscafe

Take a look at our Knowledgebase of Frequently Asked Questions (FAQs), Tips and Techniques, and other valuable software information.

E-mail support@promodel.com

When you contact technical support via e-mail, send your user profile and a description of the problem you encountered.

Telephone (888) PRO-MODEL

Speak to a technical support engineer and resolve the problem over the phone. Our support lines are open Monday through Friday from 6:00 AM to 6:00 PM MST.

After Hours Support (801) 362-8324

In our ongoing effort to serve you better, technical support is also available after hours. Please have ready your user profile and a description of the problem you encountered.

Fax (801) 226-6046

Send a fax of the listing created when you select Print Text from the File menu along with your user profile and a description of the problem you encountered.

0.1.3 Modeling Services

If you find yourself in need of extra help or specific expertise to complete your simulation project, let us help you. PROMODEL Modeling Services will meet all of your needs with fast, accurate results at competitive rates.

Whether simple or complex, partial or complete, PROMODEL Modeling Services can create any model you require. With our vast experience in producing simulation models for many diverse applications, we are in a unique position to evaluate your system and isolate specific improvements. We work closely with you during the development process to ensure that the model we create is complete and precise.

With each simulation, PROMODEL Corporation provides a complete, comprehensive analysis of your system. We document conclusions and results derived from the project and present you with statistics suitable for company presentations and briefings—you may even distribute a limited version of the model which allows repeated executions and minor revisions.

For more information on modeling services, please contact:

Phone (801) 223-4600
Fax (801) 226-6046
0.1.4 Reporting Suggestions

It is our goal to make SimRunner the ultimate output analysis, decision support, and optimization tool. To do this, we need your input. Please feel free to submit comments and ideas on how we may improve the SimRunner software and documentation.

Send us your comments

SimRunner Product Team
PROMODEL Corporation
1875 South State, Suite 3400
Orem, UT  84097

Phone  (801) 223-4600
Fax   (801) 226-6046
E-mail support@promodel.com
Chapter 1: SimRunner Concepts

1.1 What is SimRunner?

SimRunner is a decision support tool used to help optimize simulated processes. SimRunner takes your existing ProModel, MedModel, ServiceModel, or emodel simulation models, evaluates them for you, then performs tests to find better ways to achieve the results you desire.

Typically, most people use simulation tools to predict and improve system performance or to establish the relationships between various system elements. By modeling the actual facility or process, you can conduct what-if analyses to determine the best way to improve system performance—this is *optimization*. Although SimRunner cannot guarantee it will identify the optimal solution for all processes every time, it will find better solutions than you would likely get on your own.

With each optimization project, SimRunner runs sophisticated optimization algorithms on your model to help you optimize multiple factors simultaneously. Each project requires a validated model, a standard by which to measure system performance (an *objective function*), and a group of factors that SimRunner may change to improve system performance.

1.1.1 Benefits

Simulation allows you to find solutions to complex problems without incurring the tremendous costs associated with a trial and error approach. Optimization helps ensure that the solutions you implement are at or near their optimal values.

Unlike manual simulation experimentation which answers only specific what-if questions, SimRunner automatically seeks a *course of action* that will help optimize your entire system’s performance—essentially answering *how* to meet your objectives.

To help you present your findings, SimRunner allows you to output various types of reports:

- Data reports (for spreadsheets)
- Analysis reports (for text and word processing reports)
- Graphical reports (for charts and graphs)

You can print each of these reports or export them to other applications through common clipboard functions.
1.2 Where Do I Begin?

Start with a validated model

Once you complete and validate your simulation model, you are ready to begin an optimization project. If you are not working with a valid model, you don’t need to perform an optimization until the output from the simulation is valid.

Identify your simulation type

It is important to properly identify the simulation type—terminating or non-terminating. What does it mean to refer to a simulation as terminating or non-terminating? A terminating system stops when some key event occurs like the end of the day. When you come back the next day, you start fresh again. A non-terminating system is not necessarily a system that never stops production, rather it is a system that resumes from the point it left off. For both terminating and non-terminating simulations, you need to determine the appropriate run length and number of replications. For non-terminating simulations it is also necessary to determine the warm-up period.

Determine if model is a true candidate for optimization

Not every simulation model is built with the express purpose of optimizing some particular element. Many simulation models are built to demonstrate the relationships that exist between various elements of your system. If optimization is appropriate, define the objective function—the output statistics used to measure the performance of proposed solutions.

Use simulation to identify and examine potential solutions

Simulation has always been trial and error when it comes to optimization. We have some sort of optimization method that we apply to the model and we examine the model’s output statistics to see if we achieved the desired outcome. This is not a bad approach if you have one decision variable you are trying to optimize—but what if you are trying to optimize multiple decision variables at once? Interaction becomes very complex and requires more advanced optimization methods like SimRunner.

Define macros

When you build your model, you must define a macro for any variable you want to optimize. This provides SimRunner with a series of values it can change as it seeks to optimize your model. In SimRunner, these values are called factors. For information on how to add and modify macros, consult your ProModel, MedModel, ServiceModel, or enmodel User Guide.

Screen factors

Part of the simulation process is to evaluate the relationships that exist between model elements, or factors. Often, you will take the time to adjust some part of your model to find that the adjustment has no impact on system performance. Factor screening is the process of identifying which model elements (factors) do not affect the output of your model, and narrowing your search to include only those factors that affect the model’s output. Be discriminant in your selections.

Relax and wait

While some models contain relatively few factors that you can quickly optimize, others contain many. In a previous inventory reduction project, a high-end computer took approximately 24 hours to compute what it esteemed to be the optimal value for the model. Although it took a long time to produce this result, the net savings were tremendous.
Consider the results

While there is no promise that SimRunner will identify the optimal solution to your process, it is possible. SimRunner will, however, find better solutions than you would likely get with your own trial and error experimentation. The surest way to know the optimal solution to any model is to run an infinite number of replications of all possible inputs. Since this is not an option, take into consideration the number of experiments you are able to perform and act accordingly.

1.2.1 Concepts and Theories

SimRunner uses both genetic and evolution strategies algorithms with its primary algorithm being evolution strategies. The specific design of these algorithms for SimRunner is based on the work of Dr. Royce Bowden and other experts. Evolutionary algorithms have been extensively evaluated by academics and have proved reliable in optimizing simulated systems.

Evolutionary algorithms

An evolutionary algorithm is a numerical optimization technique based on simulated evolution. Solutions generated from the evolutionary algorithm must adapt to their environment in order to survive. Since each potential solution returns a specific result, you must establish an objective function to measure the performance of each solution. If the returned value falls within the acceptable range defined by the objective function, SimRunner will continue to examine the value as it searches for the optimal solution.

Example

To help you better understand how SimRunner’s optimization process works, consider the following analogy. If you and a group of explorers found yourselves on the slopes of a mountain, in the dark, with nothing but radios and altimeters, how would you find the summit?
The first step would be to establish the current altitude of everyone in your group by recording each person’s altimeter reading.

Next, you would direct your group members to wander out in any direction for various distances, then stop and review their new altimeter readings. At the second reading, you find that some of your group has moved higher and some have moved lower.

By comparing the results of each altimeter reading, you can determine the general direction in which to proceed. Since you want to climb to the summit, you proceed in the general direction that had the highest reading (in this case, 2).

Again, after everyone moves various distances, you stop to take another altimeter reading.

By taking the average of the group’s new altimeter readings, you can see that the overall reading increased. This confirms that you are moving in the right direction. Just to be sure, you repeat the process and take another reading.

As you will notice from the example, your group is beginning to converge upon a single point. The more you repeat the data collection process, the closer the group will get to one another, and the more certain you will be that you are at or near the summit. Just to be on the safe side, however, you even send a few members of your group out to remote parts of the terrain to be sure that there
is nothing higher than the point you already identified.

Once your average altimeter reading is equal to the best in your group, you have converged upon the summit and can be confident that you have achieved your goal.

Conceptually, this is how SimRunner works—only the terminology is different. Instead of altimeters, explorers, and tests, you will use objective functions, input factors, and replications. Each time the explorers move, SimRunner calls this a generation. The concepts are the same.

**Not an exhaustive search**

In spite of what some may think, you don’t want an algorithm that will do an exhaustive search. In a previous inventory reduction project, modelers estimated the number of possible solutions to be around $9.38 \times 10^{37}$—it was a big project. To perform an exhaustive search for the optimum value would take a lifetime. More than likely, you will never get the answer.

What you want is an algorithm that can efficiently explore the response surface (the output from the model) and focus on those areas returning good answers—without evaluating everything. To learn more about the algorithms used in SimRunner, consult the *Suggested Readings* on page 41.
1.2.2 General Procedure

The following is an overview of the process you will use to perform an optimization of your system.

**Step 1: Create, verify, and validate**

The most important preparation you can make for an optimization project is a validated model. It is not enough to simply create a model—it will profit you nothing if the model does not reflect the real operation. Once you validate the model, you are ready to begin.

**Step 2: Build a project**

With your model prepared for evaluation, create a new SimRunner project and identify the response statistic you wish to target. Using these response statistics, define an objective function by which to gauge system performance. SimRunner will use this objective function to measure system improvement. Next, select the input factors you will allow SimRunner to use as it determines how best to achieve system improvement. When you optimize the model, SimRunner tests each input factor to seek the combination of factors that will result in the greatest improvement of model performance.

**Step 3: Run experiments**

Once you select the input factors and define the objective function, you can use SimRunner to automatically conduct a series of experiments on your model. SimRunner runs your model for you and tests a variety of possible combinations of values. After it completes the tests, SimRunner lists the test results in order of the most to the least successful combination of factor values.

**Step 4: Evaluate suggestions**

The fourth step is to consider and evaluate SimRunner’s suggestions. This is crucial because SimRunner will often identify several candidate solutions to your problem and you may, for reasons not addressed in the model, prefer one solution over another. You may also wish to make additional model runs (replications) and look at confidence intervals to further evaluate SimRunner’s list of possible solutions.

**Step 5: Apply solution**

Once you identify the solution that best fits your needs, implement the solution.
1.2.3 Pitfalls

If you follow the general procedure stated previously, your chances of success are very good. Typically, projects fail because the:

- Model is not valid
- Analysis considers insignificant factors
- Analysis ignores significant factors
- Objective Function is inappropriately formulated
- Test results are not scrutinized
Chapter 2: Getting Started

2.1 The Interface

The SimRunner interface provides you with easy access to every step necessary to create an optimization project. The project building process is divided into three phases, each containing a series of steps necessary to complete the phase. As you move from phase to phase (displayed at the top of the dialog), a list of steps for the phase appears in the left pane.
2.2 Set Up a Project

This section provides detailed information about each step required to build an optimization project.

2.2.1 Select Model/Project

Select the model you will use for your project.

Create new project / Select model  Enter the name of the model you wish to optimize. You will enter a name for the project when you save it.

Open existing project / Select project  Select an existing project. If you open an existing project, it is not necessary to select the model you will use—the model is stored as part of the optimization project.

2.2.2 Define Objectives

The objective of your project is the final outcome you want to achieve. SimRunner measures your progress toward this goal using an objective function. An objective function is composed of response statistics, a min/max or target range, and a specific weight you wish to apply to each response statistic.

Response category

The response category is the type of statistic you wish to use to evaluate your model. Response categories include model elements such as locations, entities, resources, and variables.
Response statistics

Simply put, response statistics are those values you wish to improve. Once you define your targeted improvements, you are ready to define how you want them to perform—the objective for the response statistic.

Objective for response statistic

The objective for the response statistic refers to the way in which you want to effect change for that item. If you are trying to increase the overall output of a system, you would maximize the response statistic. Likewise, you could minimize the statistic or target a specific range within which you want the result. Finally, enter the reward or weight for each response statistic—larger numbers signify greater rewards in situations that require more than one objective.

Max  Check this option if you want to increase the final value of this statistic.
Min  Check this option if you want to decrease the final value of this statistic.

Please note

Maximized objective functions return positive values. Minimized objective functions return negative values.

Target Range  Check this option to enter a specific target range within which you want the final result.

Statistic’s weight  Weights serve as a means of load balancing for statistics that might bias the objective function. Since most simulation models produce a variety of large and small values, it is often necessary to weight these values to ensure that the objective function does not unintentionally favor any particular statistic. For example, suppose that a run of your model returns a throughput of .72 and an average WIP of 4.56. If you maximize throughput and minimize WIP by applying the same weight to both \( W_1 = W_2 \), you will bias the objective function in favor of WIP:

\[
\text{Maximize}(W_1 \times \text{Throughput}) = 0.72
\]
\[
\text{Minimize}(W_2 \times \text{WIP}) = 4.56
\]

In this case, since you want to ensure that both statistics carry equal weight in the objective function, you will apply a weight of 6.33 \( (W_1 = 6.33) \) to throughput and 1.0 \( (W_2 = 1.0) \) to
WIP to make them of equal weight in the objective function.

\[
\text{Maximize}([W_1] \cdot \text{Throughput}) = 4.56 \\
\text{Minimize}([W_2] \cdot \text{WIP}) = 4.56
\]

In situations where it is necessary to favor one statistic over another, balancing the statistics first will make it easier to control the amount of bias you apply. For example, if you apply a weight of 12.67 \((W_1=12.67)\) to throughput and 1.0 \((W_2=1.0)\) to WIP, the objective function will consider throughput to be twice as important as WIP (adapted from Harrell, Ghosh, and Bowden 2000).

**Please note**

*Typically, you will need to experiment with your model to identify the weight ratio necessary to balance statistics.*

**Response statistics selected for objective function**

After you define the objective for the response statistic, you may click the Add button to include the statistic as part of the objective function. SimRunner combines the statistics into a linear combination and displays the updated objective function for the project.

\[
Z = \text{Max}:10 \cdot \text{(Total Ovens Processed)} + \text{Max}:5 \cdot \text{(Total Cooktops Processed)} + \text{Min}:2 \cdot \text{(Total Resource Cost)}
\]

**Objective function**

The objective function is an expression used to quantitatively evaluate a simulation model’s performance. By measuring various performance characteristics and taking into consideration how you weigh them, SimRunner can measure how well your system operates. However, SimRunner knows only what you tell it via the objective function. For instance, if your objective function measures only one variable, Total_Throughput, SimRunner will attempt to optimize that variable. If you do not include an objective function term to tell it that you also want to minimize the total number of operators used, SimRunner will assume that you don’t care how many operators you use. Since the objective function can include multiple terms, be sure to include all of the response statistics about which you are concerned.

SimRunner’s capacity to include many different response statistics in an objective function gives it tremendous capability. For example, the objective function below signifies that you wish to maximize the total ovens and cooktops processed while minimizing the total resource cost. The numeric weighting factors indicate that maximizing Total Ovens Processed is the most important, followed by maximizing Total Cooktops Processed, then minimizing Total Resource Cost.
Perhaps the best way to define your objective function is in terms of cost or profit. When possible, this allows you to use a simple, single response statistic like maximize profit without concern over assigning meaningful weights to multiple response statistics.

**Example: Maximize up to a target**

The following example shows how to achieve a throughput target level. Suppose you want to target a production rate of 300 to 325 units per day. In the target range fields, assign a range of 300 to 325 and enter a weight of 1.

**Log time**

Because the LOG statement does not have a separate data structure (it occurs during the processing logic), SimRunner does not have direct access to log data. However, if you create a variable to represent the logged time, you can use the variable as part of the objective function.

### 2.2.3 Define Inputs

In every system, there are *controllable* and *uncontrollable* factors that determine the outcome of the process. Controllable factors include staffing, equipment, schedules, and facilities. Uncontrollable factors refer to such things as arrival rates.

Often, relationships exist between various controllable factors. How do you identify these relationships and use them to seek the best value for your objective function?—SimRunner. SimRunner allows you to target controllable model factors and determine which combination of values for those factors will elicit the behavior you desire.

With each test it performs, SimRunner examines the results to see if the results will produce the effect you require from the objective function. For information about how SimRunner performs these tests and evaluates data, see *Concepts and Theories* on page 7.

![SimRunner Interface](image)

**Macros listed in model**

All macros defined in your model are displayed. SimRunner will use these macros to improve the
value of your objective function. Typically, these are the controllable factors of your model.

Macro properties
Macro properties describe the basic attributes of each macro used in your project.

Data type Refers to the numeric type of the data (integer or real) SimRunner will use. Typically, you will use integers to represent the number of resources (e.g., people) and real numbers to represent time values or percentages (e.g., machine processing times or product mix).

Default value Refers to SimRunner's initial setting for the macro—the value SimRunner will use to analyze the model before conducting the optimization. See Analyze Model on page 22.

Lower and upper bound The limits (constraints) within which this value must fall during subsequent tests. If you defined these bounds in an RTI for the macro, you may override them here if you wish.

Macros selected as input factors
Displays a list of all macros you selected for use as input factors. Typically, you will want to use as few inputs as possible—only those you anticipate will affect the value of the objective function.

Define macros
Before you can use a model element as an input factor, you must define a macro for that element. Macros allow SimRunner to control the value of the factor and feed it back into the model.

Variables
If you want to use a variable from your model as an input factor, you must define a corresponding macro and set the variable equal to the macro at some point in your model. To do this, you can:

- Enter the name of the macro in the variable's "initial value" field.
- Set the variable equal to the macro in the model's processing logic.
- Set the variable equal to the macro in the model's initialization logic.

Resource & location capacities
In order to use a resource or location capacity as an input factor, you will need to define a macro that represents the capacity or number of resources and place this macro in the appropriate field for the resource or location. For instance, if you have a resource named Operator_1, you can create a macro named Number_Of_Operators to represent the “number of units” for the operator. When you run SimRunner, the macro Number_Of_Operators will appear on the list of input factors. Testing this factor will change the number of units of Operator_1 in the model.
SimRunner will not recognize any macro containing non-numeric characters (e.g., “N”, “’”), or “+”) as a valid input from the macro’s "text" field.

Distribution parameters
Since macros must be completely numeric in the "text" field for SimRunner’s use, macros that represent distributions will not appear in the list of available input factors. A macro can be used to represent a distribution parameter. For example, suppose you have a normal distribution, N(10,2), with an average of 10 and a standard deviation of 2. You can create a macro, Dist_1_Average, with a value of 10 and use this macro as the text value of the distribution: N(Dist_1_Average, 2). This will allow you to manipulate the distribution from SimRunner.

Please note
Using ProModel, MedModel, ServiceModel, or emodel, you can set up macros in your simulation model as run-time interfaces (RTI’s). SimRunner reads the RTI’s as the default values for the input factor’s lower and upper bounds. If you do not define RTI’s, SimRunner will use the factor’s current value as the lower and upper bounds.

2.2.4 Set Options

Optimization options

Optimization profile
SimRunner provides three optimization profiles: Aggressive, Moderate, and Cautious. The optimization profile is a reflection of the number of possible solutions SimRunner will examine. For example, the cautious profile tells SimRunner to consider the highest number of possible solutions—to cautiously and more thoroughly conduct its search for the optimum. As you move from aggressive to cautious, you will most often get better results because SimRunner examines more results—but not always. Depending on the difficulty of the problem you are trying to solve, you may get solutions that are equally good. If you are pressed for time or use relatively few input factors, a more aggressive approach—the aggressive profile—may be appropriate.
Convergence percentage  With every experiment, SimRunner tracks the objective function’s value for each solution. By recording the best and the average results produced, SimRunner is able to monitor the progress of the algorithm. Once the best and the average are at or near the same value, the results converge and the optimization stops. The convergence percentage controls how close the best and the average must be to each other before the optimization stops. A high percentage value will stop the search early, while a very small percentage value will run the optimization until the points converge.

Advanced Options

1. Options: the following options are available if selected on the Advanced Options menu. Select Options | Advanced... to enable Max and Min generation selection.

2. Max No. of generations The most iterations SimRunner will use to conduct the analysis. This impacts the maximum time allocated to the optimization search. Very high values allow SimRunner to run until it satisfies the convergence percentage.

3. Min No. of generations The fewest iterations SimRunner will use to conduct the analysis—this impacts the maximum time allocated to the optimization search. Typically, you will set the minimum number of generations to 1; however, if you specify a very large value, you can force SimRunner to continue to seek the optimal solution even after it satisfies the convergence percentage.

Simulation options

Disable animation Uncheck to activate the animation during run time. If you enable the animation, it will take longer to conduct the analysis but will not affect the model’s results.

Number of replications per experiment The number of times the model will run in order to conduct the experiment—to estimate the value of the objective function for a solution. (Typically, you will never conduct an optimization with only one replication.)

Warm-up time The amount of time the model must run before it reaches steady-state.

Run time The total run length of the model.

Confidence level If you specify more than one replication, SimRunner will compute and display a confidence interval based on the mean value of the objective function and its sample variance. The confidence level allows you to specify a 90%, 95%, or 99% confidence interval. Although you cannot determine the true mean value of the objective function for a given experiment (you
can only estimate it), the confidence interval provides a range that hopefully includes the true mean. The higher the value you select for the confidence level, the more confident you can be that the interval contains the true mean. However, note that a 99% confidence interval is generally wider than a 90% confidence interval given a fixed number of replications.

**Please note**

Typically you want SimRunner to run the algorithm until it fully converges. Do this by specifying a very low value for convergence percentage, such as 0.01, and, if running in advance mode, a very high value for maximum number of generations, such as 99999, and a value of 1 for minimum number of generations.
2.3 Analyze Model

The first step in conducting any analysis of your simulation model’s output is to make sure that your model produces output with the degree of accuracy you desire. If all of the aspects of your model are deterministic (with no random variance in any part of the model), you will get a precise output statistic with one replication. In most models, however, random variance is present in several places. The result of using random inputs in the model is that the output is also random. Because of this, you should think of a simulation experiment as a sampling technique. Since you don’t know the exact, true value or population statistic, the best you can do is collect a sample large enough to make a good estimate—you must run multiple replications.

In general, with each additional replication you run, you generate a more accurate estimate of the population statistic your are trying to measure in the objective function. For example, suppose you wish to maximize the utilization of a given resource by changing several factors in the model. For each experiment, you may need to run ten replications to get an accurate estimate of the utilization for a specific combination of settings. If your estimate isn’t accurate enough, you will not be able to tell if improvements to a system are the result of changes or simply an effect of random variance. SimRunner helps you select the appropriate number of replications for both terminating and non-terminating systems.

For non-terminating systems, SimRunner’s Objective Function Time Series graph shows the value of the objective function as it changed during the simulation based on several replications. At the very beginning of a simulation run, the simulation model is “empty.” There are no entities in the system and often all the statistics are set to zero. This is an artificial condition and, for non-terminating simulations, does not reflect reality. When you run a non-terminating simulation, you must run it long enough for the operation to stabilize—to reach steady state. The warm-up time is how long it takes the simulation to reach steady state. The end of the warm-up time is the point at which you want to begin sampling statistical data—data representative of how the system normally operates.

Please note

When you define a warm-up period, the model runs for a specific period of time at the beginning of each replication before results are recorded.

How do you know how long the warm-up period should be? SimRunner uses an approach based on Welch’s graphical method. SimRunner displays a time series graph of the objective function’s current value and moving average based on several replications of the simulation. As the objective function begins to stabilize, the moving average graph will appear to "flatten out" around a specific value or range. This behavior signals the end of the warm-up period.

It is quite possible that you may be unable to determine the warm-up period from just one look at the graph. If you are unable to make this determination, run the model again with a longer run length.
Define experiment

In the case of a non-terminating system, the warm-up period is the amount of time the model must run for the objective function to exhibit statistical regularity—to reach a steady-state. This occurs when the distribution of the objective function values is the same from one time period to the next. SimRunner helps you identify the length of the warm-up period.

Experimental parameters

Simulation run length  The total duration of the simulation. If you run a non-terminating simulation, the run length should be sufficient to allow the model to warm up and reach steady state. Start with a large initial value for the run length.

Output recording time interval (period)

SimRunner records output statistics during regular intervals of time. This sampling technique provides you with an observation of the output statistic for each time interval. The output recording time interval refers to the length of each time interval. The recording time interval should be large enough to ensure that simulated events occur, and that the model produces an output value for each response statistic listed as part of the objective function. For example, given a job arrives to a queue every 30 minutes, you do not want to select a recording time interval of less than 30 minutes if the average time jobs wait in the queue is part of the objective function. Be sure to set the recording time interval to observe at least one observation during each interval.

Number of test replications  The number of replications needed to conduct the analysis. The number of test replications should be five or more depending on how long you have to wait for results.

Percent error in objective function estimate

Given that you can only estimate the true value of the objective function, you have to decide how accurate your estimate needs to be. Entering a 10 indicates that you wish to estimate the required number of replications needed to obtain an estimate of the average value of the objective function to within 10% of its true value.

Confidence level  The confidence level (90%, 95%, or 99%) used to approximate the number of replications needed to estimate the value of the objective function to within the stated "percent error" of its true value. The higher the confidence level, the larger the number of replications needed will be.
Conduct analysis

Start analysis

Run  Begin analyzing the model.
Final Report  Produces an analysis report which describes the results of each experiment.
Analysis status  Displays the completion status of the analysis.

Warm-up detection for steady-state estimates

Moving average window  Allows you to adjust the number of periods used to compute the moving average plot. The plot is automatically redrawn.

Estimate required number of replications

Warm-up periods  Enter the number of time periods you wish to use as the warm-up period when estimating the required number of replications. Periods refer to the frequency with which you recorded data from the model. For example, if your output recording time interval is four hours, you may find that five periods will suffice (20 hours).
No. of replications  This field is automatically updated as the warm-up periods field is defined.
2.4 Optimize Model

2.4.1 Introduction

Often, the reason for building a simulation model of a system is to answer questions such as: “What are the optimal settings for ______ to minimize (or maximize) ______?” You can think of the simulation model as a black box that imitates the actual system. When you present inputs to the black box, the box produces outputs that estimate how the actual system will respond. In the question above, the first blank represents the input(s) to the simulation model that you control. (These inputs are often called decision variables or factors.) The second blank represents the performance measure(s) of interest, computed from the output response of the simulation model when you set the factors to specific values (see example below).

In the question, “What is the optimal number of material handling devices needed to minimize the time that workstations wait for material?”, the input factor is the number of material handling devices and the performance measure is the time that workstations wait (computed from the output response of the simulation model). The goal is to locate the optimal value for each factor that minimizes or maximizes the performance measure of interest.

Example

The following diagram shows the relationship between an optimization algorithm and a simulation model (adapted from Harrell, Ghosh, and Bowden 2000).

If you were to evaluate all combinations of the different values for the input factors \(X_1, X_2, X_3, \ldots\) and plot the output response generated by the simulation model, you would create what is called a response surface of the output for that model. Think of the response surface as a mountainous region with many peaks and valleys. In the case of a maximization problem, you wish to climb to the highest peak. In the case of a minimization problem, you wish to descend to the lowest valley.
2.4.2 Optimization Concepts

To optimize functions or the output from simulation models, you must apply some kind of method to evaluate different combinations of input factors until you arrive at what you consider the optimal solution. If you take several different input/output combinations (i.e., function evaluations), you should be able to establish which variables cause improvement in the output response and try a few more function evaluations. By ascending the “peak” (in the case of a maximizing problem), you will work your way to the top.

Once you climb to a peak (i.e., reach a local optimum), how do you determine whether your local optimum is the global optimum—the very best? How do you know that there is no better combination of inputs? The surest way would be to try every possible combination of input factors. This is not feasible for most problems. What you can do, however, is try to find and compare several local optimums. This will greatly increase your chance of finding the best, or global, solution.

In many situations, it is impossible to formulate a single equation that precisely describes a system’s behavior. For this reason, techniques such as simulation are used to model and study these systems. Although simulation itself does not optimize, it acts as a function to tell you (based on your model of the system) what results you will achieve from a given set of input factors. SimRunner conducts a variety of tests to seek ideal operation levels for your model.

When setting up your optimization, you can do several things to greatly improve SimRunner’s performance:

**Limit the number of input factors**
Don't include input factors that have relatively little impact on model results. Although SimRunner can handle multiple factors, each factor you add increases the amount of time necessary to optimize the model. So, the fewer the number of factors, the faster you will get results.

**Set good, tight bounds**
It takes a lot longer to find an answer between 1 and 1000 than between 1 and 10. The tighter the bounds you specify for your input factors, the faster you will get results.

**Formulate a good objective function**
Since SimRunner uses the objective function to evaluate a solution’s performance, it is absolutely necessary that you include the right output responses in the objective function. This allows SimRunner to test several combinations of factors to see which arrangement will improve the desired aspect of the system’s performance. Remember also that your answers are only as precise as the system's randomness allows. If your model gives results that are accurate only to ±5, SimRunner’s solutions will be equally accurate (±5).
2.4.3 SimRunner Optimization Techniques

SimRunner intelligently and reliably seeks the optimal solution to your problem based on the feedback from your simulation model by applying some of the most advanced search techniques available today. The SimRunner optimization method is based upon Evolutionary Algorithms (Goldberg 1989, Fogel 1992, and Schwefel 1981).

Evolutionary Algorithms are a class of direct search techniques based on concepts from the theory of evolution. The algorithms mimic the underlying evolutionary process in that entities adapt to their environment in order to survive. Evolutionary Algorithms manipulate a population of solutions to a problem in such a way that poor solutions fade away and good solutions continually evolve in their search for the optimum. Search techniques based on this concept have proven to be very robust and have solved a wide variety of difficult problems. They are extremely useful because they provide you with not only a single, optimized solution, but with many good alternatives.

Seek optimum

Run Begin optimizing the model.
Stop Halt the optimization.
Performance plot Plots the best objective function value found throughout the optimization process.
Final report The final report contains several of the best solutions found. SimRunner sorts these solutions to allow you to evaluate them further before you make your final decision. These results can be saved to a file using the Export Optimization Data option found in the File menu.

Convergence status

Phase 1 and Phase 2 SimRunner sometimes uses a genetic algorithm before using the evolution strategies algorithm based on the characteristics of the problem being solved. Phase 1 displays the convergence status of the genetic algorithm. Phase 2 displays the convergence status of the evolution strategies algorithm.

Generation The current generation. Each generation represents a collection of experiments performed on the model.
Experiment The current simulation experiment.
Response plot

**Independent variable 1 & 2** Select the input factors you wish to use to produce a partial response surface of the model’s output.

**Update chart** Updates the chart to reflect the data you selected.

**Edit chart** Accesses the controls you will need to change the appearance of the Surface Response Plot.
2.5 Menus

2.5.1 File menu

<table>
<thead>
<tr>
<th>File</th>
<th>Options</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
<td></td>
</tr>
<tr>
<td>Open Model...</td>
<td>Ctrl+M</td>
<td></td>
</tr>
<tr>
<td>Open Project...</td>
<td>Ctrl+O</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
<td></td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export Optimization Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 Tanker.mod</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**New**  Starts a new project.

**Open Model**  Opens an existing simulation model.

**Open Project**  Opens an existing optimization project.

**Save**  Saves the current optimization project to its original path and filename.

**Save As...**  Allows you to save the project under a different name or in a different location.

**Export Optimization Data**  Exports the data found in the optimization grid to a comma-delimited file of your choice.

**Recently opened files**  Displays a list of all recently opened files.

**Exit**  Quits SimRunner.

---

2.5.2 Options menu

- **Clear Optimization Data**  Clears Optimization Data from the data grid.
- **Clear Analysis Data**  Clears Analysis Data from the data grid.
- **Advanced...**  Provides an option to control Minimum and Maximum Generations. This effects the Setup Project | Set Options screen, providing additional optimization control to the user.

---

2.5.3 Help menu

- **Help Topics**  Provides access to the help system.
- **About SimRunner**  Provides information about SimRunner.
Chapter 2: Getting Started

Menus
Chapter 3: Building Projects

3.1 Getting Started

In this chapter, you will create a new project from a validated model that contains macros and examine how the model might perform more optimally.
3.2 Set Up Project

Step 1: Select model

1. Enter the name of the model you will use in the Create new project field or browse to select the model.

2. Click open to select a model.

3. Click Next to continue.

Step 2: Define objectives

1. Select the response category and statistic for each item you wish to monitor.

2. Click Add (the down arrow button). The statistic will appear in the selected response statistics window. You can remove portions of the function by selecting the up arrow button.
3. Enter the objective for the response statistic (Max, Min, Target range) and the weight to apply to the statistic. Select the Update button to apply the changes to the objective function.

4. Repeat this process to add any other response statistics. If you wish to remove a statistic, select the statistic to remove, then click the up arrow button. Once you have selected all the statistics you will use, click Next.

Step 3: Define inputs

1. Select a macro you will use in the project from the macros list.
2. Click the down arrow button to add the macro to the input factors list.
3. Select the numeric type, then enter the default value, the lower bound, and the
upper bound. Select Update to reflect the changes in the macro selected.

4. Repeat this process to add any other response statistics. If you need to change the properties for a macro that has already been added, select the macro to change, make the macro property change (Integer, Real, value and bounds), then click Update. If you wish to remove a statistic, select the statistic to remove, then click the up arrow button. Once you have selected all the statistics you want use, click Next.

**Step 4: Set options**

1. Select the optimization profile and enter the convergence percentage you wish to use.

2. Select the confidence level.
3. Enable or disable the animation as necessary and specify the number of replications per experiment you wish to run.

4. Enter the warm-up time and run time for the model.

5. Click Apply, then Next to continue.
3.3 Analyze Model

Step 1: Define experiment parameters

1. Enter the simulation run length and the output recording time interval (period).

2. Enter the number of test replications

3. Enter the percent of error in the objective function estimate and select a confidence level.

4. Click Apply, then Next to continue.
Step 2: Conduct analysis

1. Click **Run** to begin the analysis.

2. If you wish to adjust the number of periods used to compute the moving average (for steady state estimates), adjust the value for the **Moving Average Window**. The moving average plot will update to match the current settings.

3. Enter the warm-up time. SimRunner will suggest the number of replications you should run for the optimization project.

4. Click the **Final report** button to view the analysis report.
3.4 Optimize Model

Step 1: Seek optimum

1. Click **Run** to start the optimization.

2. Click **Performance Plot** to view the objective function performance throughout the optimization.

3. Click **Final Report** to display a written summary of the optimization.

Step 2: Response plot

1. Enter the independent variables (macro input factors) you wish to use in the response plot and click **Update chart**.
2. If you wish to modify the appearance of the graph, click **Edit Chart**. The following dialog will appear.

3. After you modify the appearance of the graph, click **OK**.
Chapter 3: Building Projects

Optimize Model
Appendix

Suggested Readings

PROMODEL recommends the following works to help you obtain a better knowledge of simulation and optimization.

Simulation


Optimization


Analyze Model

Analyze model runs tests to help you identify the initial bias (warm-up period) for non-terminating simulations and appropriate number of replications.

Confidence Level

Used for approximating the required number of replications and for computing confidence intervals. In the case of confidence intervals, it specifies the proportion of confidence intervals that contain the true mean.

Convergence Percentage

As SimRunner moves through the optimization process, it computes statistical data for the solutions it evaluates. From each generation, SimRunner records the best solution and the average of all solutions. When the population best and average are within the specified convergence percentage, SimRunner halts the optimization and the optimization is said to have "converged."

Data type

The numeric type (integer or real) of the input factor you will use. Typically, you will use integers to represent resources (e.g., people) and real numbers to represent time values or percentages (e.g., machine processing times or product mix).

Generation

A complete cycle of evaluating a population of "parent" solutions and selecting the best parents to produce a population of "offspring" solutions for the next generation.

Independent variable

See Input factors.
**Input factors**

Those factors for which SimRunner will seek optimal values. When you define input factors, you must provide the lower and upper bounds. An example of an input factor is the number of operations used.

**Lower bound**

The lowest numeric value of the input factor. The minimum value an input factor may have for optimization experimentation purposes.

**Macros**

A macro is a placeholder for an often-used expression used in an expression or logic field. You can type a macro once, then substitute the macro’s name anywhere in the model to use its value (as often as necessary).

**Objective function**

An expression used to quantitatively evaluate a simulation model’s performance. By measuring various performance characteristics and weighting them, an objective function is a single measure of how well a system performs.

SimRunner allows you to include many different performance characteristics in one objective function. For example, if you want an objective function to include a measure of total entities processed and resource utilization you could measure how “well” a certain simulation scenario ran by measuring \( Z \), where:

\[
Z = (\text{Total Processed}) + (\text{Resource Utilization})
\]

**Optimization**

Testing various what-if scenarios to determine the best way to conduct operations.

**Optimization Profile**

The optimization profile controls the size of the population of solutions SimRunner uses to seek the optimum. **Aggressive** is the smallest population, **Moderate** is a larger population size, and **Cautious** is the largest population.

**Output Factor**

See Objective function.

**Output Recording Time Interval**

The length of the individual time periods for which SimRunner computes statistics, as used within the Analyze Model step.

**Pre-analysis**

See Analyze Model.

**Project**

When you conduct an analysis in SimRunner, you create a project containing the model and the results from any tests you run.

**Run length**

The time length for which SimRunner will run your model for each experiment.

**Simulation**

Simulation is the act of creating a model to represent an actual location (e.g., plant floor, bank lobby, or emergency room) or abstract, logical process.

**Steady-state**

The point at which the output of the model exhibits statistical regularity—the distribution of the
output is the same from one time period to the next.

**Upper bound**

The highest numeric value of the input factor. In other words, “no more than this.”

**Warm-up Time**

The amount of time the model must run for the objective function to reach a steady state in the context of non-terminating simulations.

**Weighting**

This value signifies the importance of maximizing or minimizing the variable. For example, while it may be important to maximize the production level, it may be more important to maintain current personnel levels.
Bibliography

References
This manual referenced the following works. The list below will allow you to find these works easily as you seek to increase your knowledge of simulation and optimization.

Simulation


Optimization


Index

A

About SimRunner 29
Activity capacities 18
Animation
disable 20

B

Bound
lower 44
set 26
upper 45

C

Concepts and theories 7

D

Data
type 18, 43
Define
macros 18
Disable animation 20
Distribution parameters 19

E

eModel
product team 2
Exit 29
Export Optimization Data 27, 29

F

Factors
input 44
output 44
File
menu 29

G

General procedure 10
Getting to know SimRunner 13

H

Help
menu 29
Help topics 29

I

Independent variables 43
Input factors
limit 26
Interval width 44
Introduction
what is simrunner? 5

K

Keyboard 2
<table>
<thead>
<tr>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
<th>P</th>
<th>R</th>
<th>S</th>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Macros</td>
<td>New project</td>
<td>Objective function</td>
<td>Pitfalls</td>
<td>Resource capacities</td>
<td>Save</td>
<td>Target</td>
</tr>
<tr>
<td>input factors 26</td>
<td>define 18</td>
<td>29</td>
<td>16, 44</td>
<td>11</td>
<td>18</td>
<td>29</td>
<td>maximize up to 17</td>
</tr>
<tr>
<td>Location capacities 18</td>
<td>Maximize</td>
<td>Number of replications</td>
<td>formulate 26</td>
<td>Pre-analysis 44</td>
<td>2</td>
<td>project 29</td>
<td>Technical support 2</td>
</tr>
<tr>
<td>Log time 17</td>
<td>up to a target</td>
<td>test 23</td>
<td>Open project 29</td>
<td>Print 29</td>
<td>2</td>
<td>Technical support 2</td>
<td></td>
</tr>
<tr>
<td>Lower bound 44</td>
<td>example 17</td>
<td></td>
<td>Optimization 5, 44</td>
<td>Product support 2</td>
<td>2</td>
<td>Text 2</td>
<td>Theories and concepts 7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>L</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit</td>
<td>Macros</td>
</tr>
<tr>
<td>input factors 26</td>
<td>define 18</td>
</tr>
<tr>
<td>Location capacities 18</td>
<td>Maximize</td>
</tr>
<tr>
<td>Log time 17</td>
<td>up to a target</td>
</tr>
<tr>
<td>Lower bound 44</td>
<td>example 17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macros 44</td>
</tr>
<tr>
<td>define 18</td>
</tr>
<tr>
<td>Maximize</td>
</tr>
<tr>
<td>Menus</td>
</tr>
<tr>
<td>file menu 29</td>
</tr>
<tr>
<td>help menu 29</td>
</tr>
<tr>
<td>options menu 29</td>
</tr>
<tr>
<td>Modeling</td>
</tr>
<tr>
<td>services 3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project 29</td>
</tr>
<tr>
<td>Number of replications</td>
</tr>
<tr>
<td>test 23</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objective function 16, 44</td>
</tr>
<tr>
<td>formulate 26</td>
</tr>
<tr>
<td>Open project 29</td>
</tr>
<tr>
<td>Optimization 5, 44</td>
</tr>
<tr>
<td>concepts 26</td>
</tr>
<tr>
<td>techniques 27</td>
</tr>
<tr>
<td>Options</td>
</tr>
<tr>
<td>menu 29</td>
</tr>
<tr>
<td>Output</td>
</tr>
<tr>
<td>factor 44</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitfalls 11</td>
</tr>
<tr>
<td>Pre-analysis 44</td>
</tr>
<tr>
<td>Print 29</td>
</tr>
<tr>
<td>Product support 2</td>
</tr>
<tr>
<td>Project 44</td>
</tr>
<tr>
<td>new 29</td>
</tr>
<tr>
<td>open 29</td>
</tr>
<tr>
<td>save 29</td>
</tr>
<tr>
<td>ProModel</td>
</tr>
<tr>
<td>product team 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource capacities 18</td>
</tr>
<tr>
<td>RTI 19</td>
</tr>
<tr>
<td>Run length 44</td>
</tr>
<tr>
<td>Run-time interface 19</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
</tr>
<tr>
<td>as 29</td>
</tr>
<tr>
<td>project 29</td>
</tr>
<tr>
<td>ServiceModel</td>
</tr>
<tr>
<td>product team 2</td>
</tr>
<tr>
<td>Simulation 44</td>
</tr>
<tr>
<td>Statistical Advantage 43</td>
</tr>
<tr>
<td>Steady-state 44</td>
</tr>
<tr>
<td>Support, technical 2</td>
</tr>
<tr>
<td>Symbols and notation</td>
</tr>
<tr>
<td>keyboard 2</td>
</tr>
<tr>
<td>text 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
</tr>
<tr>
<td>maximize up to 17</td>
</tr>
<tr>
<td>Technical support 2</td>
</tr>
<tr>
<td>Text 2</td>
</tr>
<tr>
<td>Theories and concepts 7</td>
</tr>
<tr>
<td>Time</td>
</tr>
<tr>
<td>log 17</td>
</tr>
</tbody>
</table>
U
Upper bound 45

V
Variables 18
  independent 43

W
Weighting 45
Where do I begin? 6
  general procedure 10
  pitfalls 11
Stat::Fit®

©1995, 1996, 2001, 2006 Geer Mountain Software Corp. All rights reserved.
Printed in the United States of America.

Stat::Fit® and Statistically Fit® are registered trademarks of Geer Mountain Software Corp.

Windows is a trademark of Microsoft Corporation.
Software License and Limited Warranty Agreement

This document is a legal agreement between you, the end user, and Geer Mountain Software Corporation. BY OPENING THE SEALED DISK PACKAGE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, WHICH INCLUDE THE LICENSE AND LIMITED WARRANTY, PROMPTLY RETURN THE UNOPENED PACKAGE AND ALL OF THE ACCOMPANYING ITEMS (including documentation) FOR A FULL REFUND.

License

Geer Mountain Software grants to you, the end user, a non-exclusive license to use the enclosed computer program (the “Software”) on a single computer system, subject to the terms and conditions of this License and limited Warranty Agreement.

Copyright and permitted use

The SOFTWARE is owned by Geer Mountain Software and is protected by United States copyright law and international treaty provisions. Treat the SOFTWARE exactly as if it were a book, with one exception: You may make archival copies of the SOFTWARE to protect it from loss. The SOFTWARE may be moved from one computer to another, as long as there is no possibility of two persons using it at the same time. You may transfer the complete SOFTWARE and the accompanying written materials together on a permanent basis provided you do not retain any copies and the recipient agrees to the terms of this Agreement.

Other restrictions

You may not lease, rent or sublicense the SOFTWARE. You may not transfer the SOFTWARE or the accompanying written materials except as provided above. You may not reverse engineer, decompile, disassemble, or create derivative works from the SOFTWARE. If you later receive an update to this SOFTWARE or if this SOFTWARE is an update to a prior version, any transfer must include both the update and all accessible prior versions of the SOFTWARE.

Limited warranty and liability

Geer Mountain Software warrants only that (a) the SOFTWARE will perform substantially in accordance with the accompanying written materials and (b) the SOFTWARE is properly recorded on the disk media.

Your failure to return the enclosed registration card may result in Geer Mountain Software's inability to provide you with updates to the SOFTWARE and you assume the entire risk of performance and result in such event. This Limited Warranty extends for sixty (60) days from the date of purchase. The above Limited Warranty is in lieu of all other warranties, whether written, express, implied or otherwise. Geer Mountain Software specifically excludes all implied warranties including, but not limited to, implied warranties of merchantability and fitness for a particular purpose.

Geer Mountain Software shall not be liable with respect to the SOFTWARE or otherwise for special, incidental, consequential, punitive, or exemplary damages even if advised of the possibility of such damages. In no event shall liability for any reason and upon any cause of action whatsoever exceed the purchase price.

U.S. government restricted rights

If you are acquiring the SOFTWARE on behalf of any unit or agency of the United States Government, the following provisions apply:

The Government acknowledges Geer Mountain Software's representation that the SOFTWARE and its documentation were developed at private expense and no part of them is in the public domain. The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraphs (c)(1) and (l) of The Rights in Technical Data and Computer Software clause of DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is Geer Mountain Software Corporation, 104 Geer Mountain Road, South Kent, CT 06785.

This Agreement is governed by the laws of the State of Connecticut. In the event that you breach the provisions of this Agreement and Geer Mountain Software resorts to legal action to enforce its rights, you agree to reimburse Geer Mountain Software for the expense of doing so, including its reasonable attorneys fees.
# Table of Contents

Table of Contents

Introduction

About the User’s Guide ........................................................ IX
Terms and Conventions ......................................................... X
Technical Support ................................................................. X

Chapter 1: Overview

Basic Operation ................................................................. 2
Fitting a Distribution ......................................................... 3

Chapter 2: Data Entry and Manipulation

Creating a New Project ...................................................... 6
Opening Existing Projects .................................................. 7
Saving Files ....................................................................... 8
Data Table ....................................................................... 9
Input Options .................................................................. 11
  Operate ....................................................................... 12
  Transform .................................................................... 13
  Filter ......................................................................... 14
  Repopulate ................................................................... 14
  Generate ....................................................................... 15
Chapter 6: Tutorial ............................................................... 49

Tutorial ............................................................................... 50

Appendix: Distributions .......................................................... 55

Beta Distribution (min, max, p, q) ........................................ 56
Binomial Distribution (n, p) .................................................. 58
Chi Squared Distribution (min, nu) ................................... 60
Discrete Uniform Distribution (min, max) ...................... 62
Erlang Distribution (min, m, beta) ................................. 63
Exponential Distribution (min, beta) ............................. 65
Extreme Value type 1A Distribution (tau, beta) .......... 66
Extreme Value type 1B Distribution (tau, beta) .......... 67
Gamma Distribution (min, alpha, beta) ......................... 68
Geometric Distribution (p) ............................................... 70
Inverse Gaussian Distribution (min, alpha, beta) .......... 71
Inverse Weibull Distribution (min, alpha, beta) ............ 72
Johnson SB Distribution (min, lambda, gamma, delta) .... 73
Johnson SU Distribution (xi, lambda, gamma, delta) .... 75
Logistic Distribution (alpha, beta) ................................. 77
Log-Logistic Distribution (min, p, beta) ...................... 78
Lognormal Distribution (min, mu, sigma) .................... 80
Negative Binomial Distribution (p,k) ............................ 82
Normal Distribution (mu, sigma) ................................. 84
Pareto Distribution (min, alpha) .................................... 85
Pearson 5 Distribution (min, alpha, beta) .................... 86
Pearson 6 Distribution (min, beta, p, q) ...................... 87
Poisson Distribution (lambda) ......................................... 89
Power Function Distribution (min, max, alpha) ............ 90
Rayleigh Distribution (min, sigma) ............................. 91
Triangular Distribution (min, max, mode) ..................... 92
Uniform Distribution (min, max) ............................... 93
Weibull Distribution (min, alpha, beta) ...................... 94

Bibliography ........................................................................ 97

Index ...................................................................................... 99
Stat::Fit, a Statistically Fit application which fits analytical distributions to user data, is meant to be easy to use. Hopefully its operation is so intuitive that you never need to use this manual. However, just in case you want to look up an unfamiliar term, or a specific operation, or enjoy reading software manuals, we provide a carefully organized document with the information easily accessible.

Introduction

Stat::Fit, a Statistically Fit application which fits analytical distributions to user data, is meant to be easy to use. Hopefully its operation is so intuitive that you never need to use this manual. However, just in case you want to look up an unfamiliar term, or a specific operation, or enjoy reading software manuals, we provide a carefully organized document with the information easily accessible.

About the User’s Guide

Chapter 1: Overview
Summarizes a Quick Start for using Stat::Fit. An overview of the basic operations using the default settings is given.

Chapter 2: Data Entry and Manipulation
Provides the options for bringing data into Stat::Fit and for their manipulation.

Chapter 3: Statistical Analysis
Describes the distribution fitting process, the statistical calculations and the Goodness of Fit tests.

Chapter 4: Graphs
Goes into the numerous options available for the types of graphs and graph styles.

Chapter 5: Print and Output Files
Provides details on how to print graphs and reports.

Chapter 6: Tutorial
Is a tutorial with an example.

Appendix: Distributions
Provides descriptions and equations of various distributions.
Terms and Conventions

This manual uses Windows-specific terminology and assumes that you know how to use Windows. For help with Windows, see your Windows documentation. The terminology in this manual should be familiar to anyone with basic statistics knowledge.

Technical Support

Technical support for Stat::Fit is available through PROMODEL Corporation for all licensed users of ProModel, MedModel, and ServiceModel. PROMODEL technical support representatives will be glad to help you with questions regarding Stat::Fit.

Phone: 1-(888)-PRO-MODEL
Fax: (801) 226-6046
E-mail: pmteam@promodel.com
       mmteam@promodel.com
       smteam@promodel.com

Monday–Friday, 6 am to 6 pm MST
Chapter 1: Overview

This section describes the basic operation of Stat::Fit using the program’s default settings. For this example, we assume that the data is available in a text file.
Basic Operation

The data is loaded by clicking on the Open File icon, or selecting File on the menu bar and then Open from the Submenu, as shown below. All icon commands are available in the menu.

A standard Windows dialog box appears, and allows a choice of drives, directories and files. The data in an existing text file loads sequentially into a Data Table (see Chapter 2 for features of the Data Table). Data may also be entered manually. Stat::Fit allows up to 8000 numbers.

The number of data points is shown on the upper right; the number of intervals for binning the data on the upper left. By default, Stat::Fit automatically chooses the minimum number of intervals to avoid data smoothing. Also by default, the data precision is 6 decimal places. (See Chapter 2 for other interval and precision options.)
Fitting a Distribution

Continuous and discrete analytical distributions can be automatically fit to the input data by using the Auto::Fit command. This command follows nearly the same procedure described below for manual fitting, but chooses all distributions appropriate for the input data. The distributions are ranked according to their relative goodness of fit. An indication of their acceptance as good representations of the input data is also given. A table, as shown below provides the results of the Auto::Fit procedure.

<table>
<thead>
<tr>
<th>Distribution</th>
<th>rank</th>
<th>acceptance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lognormal(2, 2.53566, 2.50917)</td>
<td>96.8</td>
<td>do not reject</td>
</tr>
<tr>
<td>Weibull(2, 1.95795, 1.26987)</td>
<td>97.4</td>
<td>do not reject</td>
</tr>
<tr>
<td>Rayleigh(2, 2.30771)</td>
<td>97.4</td>
<td>do not reject</td>
</tr>
<tr>
<td>Gamma(2, 2.74957, 1.05008)</td>
<td>98.7</td>
<td>do not reject</td>
</tr>
<tr>
<td>Pearson 6(2, 2.65837, 2.93113, 2.9689, 3)</td>
<td>95.6</td>
<td>do not reject</td>
</tr>
<tr>
<td>Triangular(2, 3, 8.982367)</td>
<td>95.1</td>
<td>do not reject</td>
</tr>
<tr>
<td>Triangular(2, 4.88711, 9.469515)</td>
<td>91.2</td>
<td>do not reject</td>
</tr>
<tr>
<td>Beta(2, 1.77544, 2.18069)</td>
<td>76.7</td>
<td>do not reject</td>
</tr>
<tr>
<td>Lognormal(2, 0.867053, 0.700342)</td>
<td>74.8</td>
<td>do not reject</td>
</tr>
<tr>
<td>Inverse Gaussian(2, 4.49361, 2.88719)</td>
<td>35.4</td>
<td>do not reject</td>
</tr>
<tr>
<td>Uniform(2, 4)</td>
<td>34</td>
<td>do not reject</td>
</tr>
<tr>
<td>Pearson 5(2, 1.29615, 3.15778)</td>
<td>21.9</td>
<td>do not reject</td>
</tr>
<tr>
<td>Inverse Weibull(2, 1.22246, 0.615507)</td>
<td>17.5</td>
<td>do not reject</td>
</tr>
<tr>
<td>Power Function(2, 4.28316, 1.83186)</td>
<td>13.7</td>
<td>do not reject</td>
</tr>
<tr>
<td>Exponential(2, 2.80719)</td>
<td>4.86</td>
<td>do not reject</td>
</tr>
<tr>
<td>Chi Square(2, 3.49515)</td>
<td>5.76e-004</td>
<td>reject</td>
</tr>
<tr>
<td>Johnson SB(2, 3.47238, -0.175334, 0.828049)</td>
<td>0</td>
<td>reject</td>
</tr>
<tr>
<td>Pareto</td>
<td>no fit</td>
<td>reject</td>
</tr>
</tbody>
</table>

Manual fitting of analytical distributions to the input data requires a sequence of steps starting with a setup of the intended calculations.

The setup dialog is entered by clicking on the Setup icon or selecting Fit from the Menu bar and Setup from the Submenu.ations to the input data.

The first page of the setup dialog presents a list of analytical distributions. A distribution, say Erlang, is chosen by clicking on its name in the list on the left. The selected distribution then appears in the list on the right. The setup is selected for use by clicking OK.
The goodness of fit tests are calculated by clicking on the Fit icon. By default, only the Kolmogorov Smirnov test is performed; other tests and options may be selected on the Calculations page of the setup dialog, as shown below. (For details of the Chi Squared, Kolmogorov Smirnov and Anderson Darling tests, see Chapter 3.)

A graph comparing the fitted distribution to the input data is viewed by clicking on the Graph Fit icon. (Other results graphs as well as modifications to each graph are described in Chapter 4.)

The Stat::Fit project is saved by clicking on the Save icon which records not only the input data but also all calculations and graphs. Congratulations! You have mastered the Stat::Fit basics.
Chapter 2: Data Entry and Manipulation

This chapter describes in more detail the options available to bring data into Stat::Fit and then manipulate it.
Creating a New Project

A New Project is created by clicking on the New Project icon on the control bar or by selecting File from the menu bar and then New from the Submenu.

The New Project command generates a new Stat::Fit document, and shows an empty Data Table with the caption, document xx, where xx is a sequential number depending on the number of previously generated documents. The document may be named by invoking the Save As command and naming the project file. Thereafter, the document will be associated with this stored file. The new document does not close any other document. Stat::Fit allows multiple documents to be open at any time. The only limit is the confusion caused by the multitude of views that may be opened.

An input table appears, as shown below, which allows manual data entry.

Alternatively, data may be pasted from the Clipboard.
Opening Existing Projects

An existing project is opened by choosing File on the Menu bar and then Open from the Submenu, or by clicking on the Open icon on the control bar.

An Open Project Dialog box allows a choice of drives, directories and files.

Stat::Fit accepts 4 types of files:

- **SFP**  Stat::Fit project file
- **DAT**  Input data
- **.*** User specified designation for input data
- **BMP**  Graphics bitmap file

Select the appropriate file type and click on OK.

If the number text contains non-numeric characters, they cause the number just prior to the non-numeric text to be entered. For example, 15.45% would be entered as 15.45, but 16,452,375 would be entered as three numbers: 16, 452 and 375.

If the filename has a .SFP extension indicating a Stat::Fit project file, the project file is opened in a new document and associated with that document. If the filename has a .BMP extension indicating a saved bitmap (graph...), the bitmap is displayed. Otherwise, a text file is assumed and a new project is opened by reading the file for input data. The document created from a text file has an association with a project file named after the text file but with the .SFP extension. The project file has not been saved.
Chapter 2: Saving Files

The project file, the input data, or any graph are saved through one of the Save commands in the File submenu, or by clicking on the Save icon on the control bar.

When input data is entered into Stat::Fit whether through manual entry in a new document, opening a data file, pasting data in the Clipboard, or reopening a Stat::Fit project file, a Stat::Fit document is created which contains the data and all subsequent calculations and graphs. If the document is initiated from an existing file, it assumes the name of that file and the document can be saved automatically as a Stat::Fit project [.SFP extension] with the Save command.

The Save command saves the Stat::Fit document to its project file. The existing file is overwritten. If a project file does not exist (the document windows will have a document xx name), the Save As command will be called.

The Save command does NOT save the input data in a text file, but saves the full document, that is, input data, calculations, and view information, to a binary project file, “your project name”.SFP. This binary file can be reopened in Stat::Fit, but cannot be imported into other applications. If a text file of the input data is desired, the Save Input command should be used.

The Save As command is multipurpose. If the document is unnamed, it can be saved as either a Stat::Fit project or a text data file with the Save As command. If a document is named, it’s name can be changed by saving either the project or the input data to a file with a new name. (In any situation, the document assumes the name of the filename used.)

The Save Input command saves the input data in a separate text file, with each data point separated with a carriage return. This maintains the integrity of your data separate from the Stat::Fit project files and calculations. If an existing association with a text file exists, a prompt will ask for overwrite permission. Otherwise, a Save As dialog will prompt for a file name, save to that file, and associate that text file with the document. If no extension is specified, the file will be saved with the extension .DAT.
Data Table

All data entry in Stat::Fit occurs through the Data Table. After a project is opened, data may be entered manually, by pasting from the clipboard, or by generating data points from the random variate generator. An existing Stat::Fit project may be opened and data may be added manually. An example of the Data Table is shown below:

```
<table>
<thead>
<tr>
<th>Intervals</th>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>1000</td>
</tr>
</tbody>
</table>
```

All data are entered as single measurements, not cumulative data. The numbers on the left are aides for location and scroll with the data. The total number of data points and intervals for continuous data are shown at the top.

All data can be viewed by using the central scroll bar or the keyboard. The scroll bar handle can be dragged to get to a data area quickly, or the scroll bar can be clicked above or below the handle to step up or down a page of data. The arrows can be clicked to step up or down one data point.

The Page Up and Page Down keys can be used to step up or down a data page. The up and down arrow keys can be used to step up or down a data point. The Home key forces the Data Table to the top of the data, the End key, to the bottom.

Manual data entry requires that the Data Table be the currently active window which requires clicking on the window if it does not already have the colored title bar. Manual data entry begins when a number is typed. The current data in the Data Table is grayed and an input box is opened. The input box will remain open until the Enter key is hit unless the Esc key is used to abort the entry.

All numbers are floating point, and can be entered in straight decimal fashion, such as 0.972, or scientific notation, 9.72e-1 where ex stands for the power of ten to be multiplied by the preceding number. Integers are stored as floating point numbers.

If Insert is off, the default condition, the data point is entered at the current highlighted location (the dashed line box, not the colored box). A number may be highlighted with a click of the mouse at that location. Note that the number is also selected (the colored box) although this does not affect manual data entry. If Insert is on, the data point is entered before the data point in the highlighted box, except at the end of the data set. If a data point is entered in the highlighted box at the end of the data set, the data point is appended to the data set and the highlighted box is moved to the next empty location. In this way data may be entered continuously without relocating the data entry point. The empty position at the end of the data set can be easily reached by using the End key unless the Data Table is full, 8000 numbers.

A single number or group of numbers may be selected in the Data Table by clicking or dragging the mouse. The selected numbers are highlighted in a color, usually blue. If the shift key is used with a mouse click, a range of numbers is selected from the last selected number to the current position. If the ctrl key is used with a mouse click, the current position is added to the current
selections unless it was already selected, in which case it is deselected.

The Delete key deletes the currently selected area (the colored area) which can be a single number or group of numbers. *There is no undelete.* The Delete command in the Edit menu may also be used. The Cut command in the Edit menu deletes the selected numbers and places them in the Clipboard. The Copy command copies the currently selected numbers into the Clipboard. The Paste command pastes the numbers in the Clipboard before the number in the current highlighted (dashed box) location, not the selected location.

The Clear command clears all input data and calculations in the current document, after a confirming dialog. All views which depend on these data and calculations are closed. An empty Data Table is left open and the document is left open. The underlying Stat::Fit project file, if any, is left intact, but a Save command will clear it as well. *Use this command carefully.* This command is NOT the same as the New command because it maintains the document’s connection to the disk file associated with it, if any.
**Input Options**

Input Options allows several data handling options to be set: the number of intervals for the histogram and the chi-squared goodness of fit test, the precision with which the data will be shown and stored, and the distribution types which will be allowed.

The Input Options dialog is entered by clicking on the Input Options icon or by selecting Input from the menu bar and then Options from the Submenu.

An Input Options Dialog box is shown below:

The number of intervals specifies the number of bins into which the input data will be sorted. These bins are used only for continuous distributions; discrete distributions are collected at integer values. If the input data is forced to be treated as discrete, this choice will be grayed.

Note that the name *intervals* is used in Stat::Fit to represent the classes for continuous data in order to separate its use from the integer classes used for discrete data.

The number of intervals are used to display continuous data in a histogram and to compare the input data with the fitted data through a chi-squared test. Please note that the intervals will be equal length for display, but may be of either equal length or of equal probability for the chi-squared test. Also, the number of intervals for a continuous representation of discrete data will always default to the maximum number of discrete classes for the same data.

The five choices for deciding on the number of intervals are:

- **Auto** Automatic mode uses the minimum number of intervals possible without losing information.\(^1\) Then the intervals are increased if the skewness of the sample is large.

- **Sturges** An empirical rule for assessing the desirable number of intervals into which the distribution of observed data should be classified. If \(N\) is the number of data points and \(k\) the number of intervals, then:

\[
k = 1 + 3.3 \log_{10}N.
\]

- **Lower Bounds** Lower Bounds mode uses the minimum number of intervals possible without losing information. If \(N\) is the number of data points and \(k\) is the number of intervals, then:

\[
k = (2N)^{1/3}
\]

---

• **Scott**  Scott model is based on using the Normal density as a reference density for constructing histograms. If \( N \) is the number of data points, sigma is the standard deviation of the sample, and \( k \) is the number of intervals, then:

\[
k = (N)^{1/3} \left(\frac{\text{max} - \text{min}}{3.5\sigma}\right)
\]

• **Manual**  Allows arbitrary setting of the number of intervals, up to a limit of 1000. The precision of the data is the number of decimal places shown for the input data and all subsequent calculations. The default precision is 6 decimal places and is initially set on. The precision can be set between 0 and 15. Note that all discrete data is stored as a floating point number.

**Please note**

While all calculations are performed at maximum precision, the input data and calculations will be written to file with the precision chosen here. If the data has greater precision than the precision here, it will be rounded when stored.

**Distribution Type**  The type of analytical distribution can be either continuous or discrete. In general, all distributions will be treated as either type by default. However, the analysis may be forced to either continuous distributions or discrete distributions by checking the appropriate box in the Input Options dialog.

In particular, discrete distributions are forced to be distributions with integer values only. If the input data is discrete, but the data points are multiples of continuous values, divide the data by the smallest common denominator before attempting to analyze it. Input truncation to eliminate small round-off errors is also useful.

The maximum number of classes for a discrete distribution is limited to 5000. If the number of classes to support the input data is greater than this, the analysis will be limited to continuous distributions.

Most of the discrete distributions start at 0. If the data has negative values, an offset should be added to it before analysis.

**Operate**

Mathematical operations on the input data are chosen from the Operate dialog by selecting Input from the Menu bar and then Operate from the Submenu.

The Operate dialog allows the choice of a single standard mathematical operation on the input data. The operation will affect all input data regardless of whether a subset of input data is selected. Mathematical overflow, underflow or
other error will cause an error message and all the input data will be restored.

The operations of addition, subtraction, multiplication, division, floor and absolute value can be performed. The operation of rounding will round the input data points to their nearest integer. The data can also be sorted into ascending or descending order, or unsorted with randomly mix.

**Transform**

Data transformations of the input data are chosen from the Transform dialog by selecting Input from the Menu bar and then Transform from the submenu.

The transform functions available are: natural logarithm, log to base 10, exponential, cosine, sine, square root, reciprocal, raise to any power, difference and % change. Difference takes the difference between adjacent data points with the lower data point first. The total number of resulting data points is reduced by one. % change calculates the percent change of adjacent data points by dividing the difference, lower point first, by the upper data point and then multiplying by 100. The total number of data points is reduced by one.

The Transform dialog allows the choice of a single standard mathematics function to be used on the input data. The operation will affect all input data regardless of whether a subset of input data is selected. Mathematical overflow, underflow or other error will cause an error message and all the input data will be restored.
Filtering of the input data can be chosen from the Filter dialog by selecting Input from the Menu bar and then Filter from the submenu.

The Filter dialog allows the choice of a single filter to be applied to the input data, discarding data outside the constraints of the filter. All filters DISCARD unwanted data and change the statistics. The appropriate input boxes are opened with each choice of filter. With the exception of the positive filter which excludes zero, all filters are inclusive, that is, they always include numbers at the filter boundary.

The filters include a minimum cutoff, a maximum cutoff, both minimum and maximum cutoffs, keeping only positive numbers (a negative and zero cutoff), a non-negative cutoff, and a near mean cutoff. The near mean filters all data points less than the mean minus the standard deviation times the indicated multiplier or greater than the mean plus the standard deviation times the indicated multiplier.

Repopulate

The Repopulate command allows the user to expand rounded data about each integer. Each point is randomly positioned about the integer with its relative value weighted by the existing shape of the input data distribution. If lower or upper bounds are known, the points are restricted to regions above and below these bounds, respectively. The Repopulate command is restricted to integer data only, and limited in range from –1000 to +1000.

To use the repopulate function, select Input from the Menu bar and the Repopulate from the Submenu.
The following dialog will be displayed.

![Image]

The new data points will have a number of decimal places specified by the generated precision. The goodness of fit tests, the Maximum Likelihood Estimates and the Moment Estimates require at least three digits to give reasonable results. The sequence of numbers is repeatable if the same random number stream is used (e.g. stream 0). However, the generated numbers, and the resulting fit, can be varied by choosing a different random number stream, 0-99.

Please note

This repopulation of the decimal part of the data is not the same as the original data was or would have been, but only represents the information not destroyed by rounding. The parameter estimates are not as accurate as would be obtained with unrounded original data. In order to get an estimate of the variation of fitted parameters, try regenerating the data set with several random number streams.

Generate

Random variates can be generated from the Generate dialog by selecting Input from the Menu bar and then Generate from the submenu, or Clicking on the Generate icon.

![Image]

The Generate dialog provides the choice of distribution, parameters, and random number stream for the generation of random variates from each of the distributions covered by Stat::Fit. The generation is limited to 8000 points maximum, the limit of the input table used by Stat::Fit. The sequence of numbers is repeatable for each distribution because the same random number stream is used (stream 0). However, the sequence of numbers can be varied by choosing a different random number stream, 0-99.

The generator will not change existing data in the Data Table, but will append the generated data points up to the limit of 8000 points. In this manner the sum of two or more distributions may be tested. Sorting will not be preserved.

This generator can be used to provide a file of random numbers for another program as well as
to test the variation of the distribution estimates once the input data has been fit.

**Input Graph**

A graph of the input data can be viewed by selecting Input from the Menu bar and then Input Graph from the Submenu, or clicking on the Input Graph icon. A histogram of your data will be displayed. An example is shown below.

![Input Graph](image)

If the input data in the Data Table is continuous data, or is forced to be treated as continuous in the Input Options dialog, the input graph will be a histogram with the number of intervals being given by the choice of interval type in the Input Options. If the data is forced to be treated as discrete, the input graph will be a line graph with the number of classes being determined by the minimum and maximum values. Note that discrete data must be integer values. The data used to generate the Input Graph can be viewed by using the Binned Data command in the Statistics menu (see Chapter 3).

This graph, as with all graphs in Stat::Fit, may be modified, saved copied, or printed with options generally given in the Graph Style, Save As, and Copy commands in the Graphics menu. See Chapter 4 for information on Graph Styles.

**Input Data**

If the Data Table has been closed, then it can be redisplayed by selecting Input from the menu bar and Input Data from the submenu.
Chapter 3: Statistical Analysis

This section describes the descriptive statistics, the statistical calculations on the input data, the distribution fitting process, and the goodness of fit tests. This manual is not meant as a textbook on statistical analysis. For more information on the distributions, see “Appendix: Distributions” on page 55. For further understanding, see the books referenced in the “Bibliography” on page 97.
Chapter 3: Descriptive Statistics

Descriptive Statistics

The descriptive statistics for the input data can be viewed by selecting Statistics on the Menu bar and then Descriptive from the Submenu. The following window will appear:

<table>
<thead>
<tr>
<th>descriptive statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>data points</td>
</tr>
<tr>
<td>minimum</td>
</tr>
<tr>
<td>maximum</td>
</tr>
<tr>
<td>mean</td>
</tr>
<tr>
<td>median</td>
</tr>
<tr>
<td>mode</td>
</tr>
<tr>
<td>standard deviation</td>
</tr>
<tr>
<td>variance</td>
</tr>
<tr>
<td>coefficient of variation</td>
</tr>
<tr>
<td>skewness</td>
</tr>
<tr>
<td>kurtosis</td>
</tr>
</tbody>
</table>

The Descriptive Statistics command provides the basic statistical observations and calculations on the input data, and presents these in a simple view as shown above. Please note that as long as this window is open, the calculations will be updated when the input data is changed. In general, all open windows will be updated when the information upon which they depend changes. Therefore, it is a good idea, on slower machines, to close such calculation windows before changing the data.
Binned Data

The histogram/class data is available by selecting Statistics on the Menu bar and then Binned Data from the Submenu.

The number of intervals used for continuous data is determined by the interval option in the Input Options dialog. By default, this number is determined automatically from the total number of data points. A typical output is shown below:

For convenience, frequency and relative frequency are given. If the data is sensed to be discrete (all integer), then the classes for the discrete representation are also given, at least up to 1000 classes. The availability of interval or class data can also be affected by forcing the distribution type to be either continuous or discrete.

Because the table can be large, it is viewed best expanded to full screen by selecting the up arrow box in the upper right corner of the screen. A scroll bar allows you to view the rest of the table. This grouping of the input data is used to produce representative graphs. For continuous data, the ascending and descending cumulative distributions match the appropriate endpoints. The density matches the appropriate midpoints. For discrete distributions, the data is grouped according to individual classes, with increments of one on the x-axis.
Independence Tests

All of the fitting routines assume that your data are independent, identically distributed (IID), that is, each point is independent of all the other data points and all data points are drawn from identical distributions. \textit{Stat::Fit} provides three types of tests for independence.

The Independence Tests are chosen by selecting Statistics on the Menu bar and then Independence from the Submenu. The following submenu will be shown:

\begin{itemize}
\item \textbf{Scatter Plot:}\textit{ }
\end{itemize}

This is a plot of adjacent points in the sequence of input data against each other. Thus each plotted point represents a pair of data points \([X_{i+1}, X_i]\). This is repeated for all pairs of adjacent data points. If the input data are somewhat dependent on each other, then this plot will exhibit that dependence. Time series, where the current data point may depend on the nearest previous value(s), will show that pattern here as a structured curve rather than a seemingly independent scatter of points. An example is shown below.

\begin{itemize}
\item \textbf{Autocorrelation:}\textit{ }
\end{itemize}

The structure of dependent data can be visualized graphically by starting with randomly generated data, choosing this plot, and then putting the data in ascending order with the Input / Operate commands. The position of each point is now dependent on the previous points and this plot would be close to a straight line.

and discussion of autocorrelation is more complex (see Box 1). A graphical view of the autocorrelation can be displayed by plotting the scatter of related data points. The Scatter Plot, as previously described, is a plot of adjacent data points, that is, of separation or lag 1. Scatter plots for data points further removed from each other in the series, that is, for lag j, could also be plotted, but the autocorrelation is more instructive. The autocorrelation, ρ, is calculated from the equation:

\[ \sum_{i=a}^{n} \frac{(x_i - \bar{x})(x_{i+j} - \bar{x})}{\sigma^2(n-j)} \]

where j is the lag between data points, s is the standard deviation of the population, approximated by the standard deviation of the sample, and xbar is the sample mean. The calculation is carried out to 1/5 of the length of the data set where diminishing pairs start to make the calculation unreliable.

The autocorrelation varies between 1 and -1, between positive and negative correlation. If the autocorrelation is near either extreme, the data are autocorrelated. Note, however, that the autocorrelation can assume finite values due to the randomness of the data even though no significant autocorrelation exists.

The numbers in parentheses along the x-axis are the maximum positive and negative correlations. For large data sets, this plot can take a while to get to the screen. The overall screen redrawing can be improved by viewing this plot and closing it thereafter. The calculation is saved internally and need not be recalculated unless the input data changes.

**Runs Tests**

The Runs Test command calculates two different runs tests for randomness of the data and displays a view of the results. The result of each test is either DO NOT REJECT the hypothesis that the series is random or REJECT that hypothesis with the level of significance given. The level of significance is the probability that a rejected hypothesis is actually true, that is, that the test rejects the randomness of the series when the series is actually random.

A run in a series of observations is the occurrence of an uninterrupted sequence of numbers with the same attribute. For instance, a consecutive set of increasing or decreasing numbers is said to provide runs ‘up’ or ‘down’ respectively. In particular, a single isolated occurrence is regarded as a run of one.

The number of runs in a series of observations indicates the randomness of those observations. Too few runs indicate strong correlation, point to point. Too many runs indicate cyclic behavior.

The first runs test is a median test which measures the number of runs, that is, sequences of numbers, above and below the median (see Brunk 2). The run can be a single number above or below the median if the numbers adjacent to it are in the opposite direction. If there are too many or too few runs, the randomness of the series is rejected. This median runs test uses a

normal approximation for acceptance/rejection which requires that the number of data points above/below the median be greater than 10. An error message will be printed if this condition is not met.

The above/below median runs test will not work if there are too few data points or for certain discrete distributions.

The second runs test is a turning point test which measures the number of times the series changes direction (see Johnson\textsuperscript{1}). Again, if there are too many turning points or too few, the randomness of the series is rejected. This turning point runs test uses a normal approximation for acceptance/rejection which requires that the total number of data points be greater than 12. An error message will be printed if this condition is not met.

While there are other runs tests for randomness, some of the most sensitive require larger data sets, in excess of 4000 numbers (see Knuth\textsuperscript{2}).

Examples of the Runs Tests are shown below in the table. The length of the runs and their distribution is given.

\begin{verbatim}

<table>
<thead>
<tr>
<th>Distributions</th>
<th>Fit</th>
<th>Acceptance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gamma</td>
<td>0.1</td>
<td>GOOD</td>
</tr>
<tr>
<td>Normal</td>
<td>0.2</td>
<td>GOOD</td>
</tr>
<tr>
<td>Exponential</td>
<td>0.3</td>
<td>GOOD</td>
</tr>
<tr>
<td>Log-normal</td>
<td>0.4</td>
<td>GOOD</td>
</tr>
<tr>
<td>Weibull</td>
<td>0.5</td>
<td>GOOD</td>
</tr>
</tbody>
</table>

\end{verbatim}

\textbf{Distribution Fit}

Automatic fitting of continuous distributions can be performed by using the Auto::Fit command. This command follows the same procedure as discussed below for manual fitting, but chooses distributions appropriate for the input data. It also ranks the distributions according to their relative goodness of fit, and gives an indication of their acceptance as good representations of the input data. For more details, see the section on Auto::Fit at the end of this chapter.

The manual fitting of analytical distributions to the input data in the Data Table takes three steps. First, distributions appropriate to the input data must be chosen in the Fit Setup dialog along with the desired goodness of fit tests. Then, estimates of the parameters for each chosen distribution can be computed.

---


must be calculated by using either the moment equations or the maximum likelihood equation. Finally the goodness of fit tests are calculated for each fitted distribution in order to ascertain the relative goodness of fit. (See Breiman\textsuperscript{1}, Law & Kelton\textsuperscript{2}, Banks & Carson\textsuperscript{3}, Stuart & Ord\textsuperscript{4}).

Begin the distribution fitting process by selecting Fit on the Menu bar and then Setup from the Submenu, or by clicking on the Fit Setup icon.

The Distribution page of the Fit Setup dialog provides a distribution list for the choice of distributions for subsequent fitting. All distributions chosen here will be used sequentially for estimates and goodness of fit tests. Clicking on a distribution name in the distribution list on the left chooses that distribution and moves that distribution name to the distributions selected box on the right unless it is already there. Clicking on the distribution name in the \textit{distributions selected} box on the right removes the distribution. All distributions may be moved to the \textit{distributions selected} box by clicking the Select All button. The \textit{distributions selected} box may be cleared by clicking the Clear button.

If the choice of distributions is uncertain or the data minimal, use the guides in the following Help directories:

- Guided choice of distributions
- No data choice of distribution

These guides should give some ideas on appropriate models for the input data. Also, each distribution is described separately in the Appendix, along with examples.

After selecting the distribution(s), go to the next window of the dialog box to select the calculations to be performed.

Estimates can be obtained from either Moments or Maximum Likelihood Estimates (MLEs). The default setting for the calculation is MLE.

For continuous distributions with a \textbf{lower bound} or minimum such as the Exponential, the \textbf{lower bound} can be forced to assume a value at or below the minimum data value. This lower bound will be used for both the moments and maximum likelihood estimates. By default, it is left unknown which causes all estimating proce-

\begin{itemize}
\item\textsuperscript{1} “Statistics: With a View Toward Applications”, Leo Breiman, 1973, Houghton Mifflin
\item\textsuperscript{2} “Discrete-Event System Simulation”, Jerry Banks, John S. CarsonII, 1984, Prentice-Hall
\end{itemize}
dures to vary the lower bound with the other parameters. If new data is added below a preset lower bound, the bound will be modified to assume the closest integer value below all input data.

The **Accuracy of Fit** describes the level of precision in iterative estimations. The default is 0.0003, but can be changed if greater accuracy is desired. Note that greater accuracy can mean much greater calculation time. Some distributions have either moments estimates and/or maximum likelihood estimates which do not require iterative estimation; in these cases, the accuracy will not make any difference in the estimation.

The **Level of Significance** refers to the level of significance of the test. The Chi-Squared, Kolmogorov-Smirnov and Anderson-Darling tests all ask to reject the fit to a given level of significance. The default setting is 5%, however this can be changed to 1% or 10% or any value you desire. This number is the likelihood that if the distribution is rejected, that it was the right distribution anyway. Stated in a different manner, it is the probability that you will make a mistake and reject when you should not. Therefore, the smaller this number, the less likely you are to reject when you should accept.

The **Goodness of Fit** tests described later in the chapter, may be chosen. Kolmogorov-Smirnov is the default test.

The maximum likelihood estimates and the moment estimates can be viewed independent of the goodness of fit tests. The MLE command is chosen by selecting Fit from the Menu and then Maximum Likelihood from the Submenu.

The maximum likelihood estimates of the parameters for all analytical distributions chosen in the fit setup dialog are calculated using the log likelihood equation and its derivatives for each choice. The parameters thus estimated are displayed in a new view as shown below:

![Maximum Likelihood](image)

Some distributions do not have maximum likelihood estimates for given ranges of sample moments because initial estimates of the distribution’s parameters are unreliable. This is especially evident for many of the bounded continuous distributions when the sample skewness is negative. When such situations occur, an error message, rather than the parameters, will be displayed with the name of the analytical distribution.

Many of the MLEs require significant calculation, and therefore, significant time, even on a computer with a Math Coprocessor. Because of this, a Cancel dialog, shown below, will appear with each calculation.

![Maximum Likelihood Estimation](image)

Beside a Cancel button, it will display the values of the parameters in the current maximum likelihood calculation. If the Cancel button is clicked, the calculations will cease at the next iteration.
and an error message will be displayed in the Maximum Likelihood view next to the appropriate distribution.

The other choice for estimates is Moments. When the Moment Estimates command is chosen, the estimates of the parameters for all chosen analytical distributions chosen are calculated using the moment equations for each choice along with the sample moments from calculations on the input data in the Data Table. The parameters thus estimated are displayed as shown below:

Some distributions do not have moment estimates for given ranges of sample moments. This is especially evident for many of the bounded continuous distributions when the sample skewness is negative. When such situations occur, an error message rather than the parameters will be displayed with the name of the analytical distribution.

Note that all chosen estimates (MLEs or Moments) must be finished before the Result Graphs can be displayed or the Goodness of Fit tests can be done. Any time the choice of estimates is changed, all visible views of the Result Graphs and the Goodness of Fit tests will be redisplayed with the new calculated estimates.

The moment estimates have been included as an aid to the fitting process; except for the simplest distributions, they do NOT give good estimates of the parameters of a fitted distribution.

**Goodness of Fit Tests**

The tests for goodness of fit are merely comparisons of the input data to the fitted distributions in a statistically significant manner. Each test makes the hypothesis that the fit is good and calculates a test statistic for comparison to a standard. The Goodness of Fit tests include:

- Chi-squared test
- Kolmogorov Smirnov test
- Anderson Darling test

If the choice of test is uncertain, even after consulting the descriptions below, use the Kolmogorov Smirnov test which is applicable over the widest range of data and fitted parameters.

**Chi Squared Test**

The Chi Squared test is a test of the goodness of fit of the fitted density to the input data in the Data Table, with that data appropriately separated into intervals (continuous data) or classes (discrete data). The test starts with the observed data in classes (intervals). While the number of classes for discrete data is set by the range of the integers, the choice of the appropriate number of intervals for continuous data is not well determined. Stat::Fit has an automatic calculation which chooses the least number of intervals which does not oversmooth the data. An empirical rule of some popularity, Sturges’ rule, can also be used. If neither appears satisfactory, the number of intervals may be set manually. The intervals are set in the Input Options dialog of the Input menu.

The test then calculates the expected value for each interval from the fitted distribution, where the expected values of the end intervals include the sum or integral to infinity (+/-) or the nearest bound. In order to make the test valid, intervals
(classes) with less than 5 data points are joined to neighbors until remaining intervals have at least 5 data points. Then the Chi Squared statistic for this data is calculated according to the equation:

$$\chi^2 = \frac{\sum (n_i - np_i)^2}{np_i}$$

where $\chi^2$ is the chi squared statistic, $n$ is the total number of data points, $n_i$ is the number of data points in the $i$th continuous interval or $i$th discrete class, $k$ is the number of intervals or classes used, and $p_i$ is the expected probability of occurrence in the interval or class for the fitted distribution. The resulting test statistic is then compared to a standard value of Chi Squared with the appropriate number of degrees of freedom and level of significance, usually labeled alpha. In Stat::Fit, the number of degrees of freedom is always taken to be the net number of data bins (intervals, classes) used in the calculation minus 1; because this is the most conservative test, that is, the least likely to reject the fit in error. The actual number of degrees of freedom is somewhere between this number and a similar number reduced by the number of parameters fitted by the estimating procedure. While the Chi Squared test is an asymptotic test which is valid only as the number of data points gets large, it may still be used in the comparative sense (see Law & Kelton\(^1\), Brunk\(^2\), Stuart & Ord\(^3\)).

The goodness of fit view also reports a REJECT or DO NOT REJECT decision for each Chi Squared test based on the comparison between the calculated test statistic and the standard statistic for the given level of significance. The level of significance can be changed in the Calculation page of the Fit Setup dialog.

To visualize this process for continuous data, consider the two graphs below:

The first is the normal comparison graph of the histogram of the input data versus a continuous plot of the fitted density. Note that the frequency, not the relative frequency is used; this is the actual number of data points per interval. However, for the Chi Squared test, the comparison is made between the histogram and the value of the area under the continuous curve between each interval end point. This is represented in the second graph by comparing the observed data, the top of each histogram interval, with the expected data shown as square points. Notice that the interval near 6 has fewer than 5 as an expected value and would be combined with the adjacent interval for the calculation. The result is the sum

of the normalized square of the error for each interval.
In this case, the data were separated into intervals of equal length. This magnifies any error in the center interval which has more data points and a larger difference from the expected value. An alternative, and more accurate way, to separate the data is to choose intervals with equal probability so that the expected number of data points in each interval is the same. Now the resulting intervals are NOT equal length, in general, but the errors are of the same relative size for each interval. This equal probable technique gives a better test, especially with highly peaked data.
The Chi Squared test can be calculated with intervals of equal length or equal probability by selecting the appropriate check box in the Calculation page of the Fit Setup dialog. The equal probable choice is the default.

While the test statistic for the Chi Squared test can be useful, the p-value is more useful in determining the goodness of fit. The p-value is defined as the probability that another sample will be as unusual as the current sample given that the fit is appropriate. A small p-value indicates that the current sample is highly unlikely, and therefore, the fit should be rejected. Conversely, a high p-value indicates that the sample is likely and would be repeated, and therefore, the fit should not be rejected. Thus, the HIGHER the p-value, the more likely that the fit is appropriate.

When comparing two different fitted distributions, the distribution with the higher p-value is likely to be the better fit regardless of the level of significance.

Kolmogorov Smirnov Test

The Kolmogorov Smirnov test (KS) is a statistical test of the goodness of fit of the fitted cumulative distribution to the input data in the Data Table, point by point. The KS test calculates the largest absolute difference between the cumulative distributions for the input data and the fitted distribution according to the equations:

\[ D = \max(D^+, D^-) \]

\[ D^+ = \max \left( \frac{i}{n} - F(x) \right), \quad i=1,\ldots,n \]

\[ D^- = \max \left( F(x) - \frac{i-1}{n} \right), \quad i=1,\ldots,n \]

where \( D \) is the KS statistic, \( x \) is the value of the \( ith \) point out of \( n \) total data points, and \( F(x) \) is the fitted cumulative distribution. Note that the difference is determined separately for positive and negative discrepancies on a point by point basis.
The resulting test statistic is then compared to a standard value of the Kolmogorov Smirnov statistic with the appropriate number of data points and level of significance, usually labeled alpha. While the KS test is only valid if none of the parameters in the test have been estimated from the data, it can be used for fitted distributions because this is the most conservative test, that is, least likely to reject the fit in error. The KS test can be extended directly to some specific distributions, and these specific, more stringent, tests take the form of adjustment to the more general KS statistic. (See Law & Kelton\(^1\), Brunk\(^2\), Stuart & Ord\(^3\))

The goodness of fit view also reports a REJECT or DO NOT REJECT decision for each KS test based on the comparison between the calculated test statistic and the standard statistic for the given level of significance.

---

To visualize this process for continuous data, consider the two graphs below:

The first is the normal P-P plot, the cumulative probability of the input data versus a continuous plot of the fitted cumulative distribution. However, for the KS test, the comparison is made between the probability of the input data having a value at or below a given point and the probability of the cumulative distribution at that point. This is represented in the second graph by comparing the cumulative probability for the observed data, the straight line, with the expected probability from the fitted cumulative distribution as square points. The KS test measures the largest difference between these, being careful to account for the discrete nature of the measurement.

Note that the KS test can be applied to discrete data in slightly different manner, and the resulting test is even more conservative than the KS test for continuous data. Also, the test may be further strengthened for discrete data (see Gleser\(^1\)).

While the test statistic for the Kolmogorov-Smirnov test can be useful, the p-value is more useful in determining the goodness of fit. The p-value is defined as the probability that another sample will be as unusual as the current sample given that the fit is appropriate. A small p-value indicates that the current sample is highly unlikely, and therefore, the fit should be rejected. Conversely, a high p-value indicates that the sample is likely and would be repeated, and therefore, the fit should not be rejected. Thus, the HIGHER the p-value, the more likely that the fit is appropriate. When comparing two different fitted distributions, the distribution with the higher p-value is likely to be the better fit regardless of the level of significance.

**Anderson Darling Test**

The Anderson Darling test is a test of the goodness of fit of the fitted cumulative distribution to the input data in the Data Table, weighted heavily in the tails of the distributions. This test calculates the integral of the squared difference between the input data and the fitted distribution, with increased weighting for the tails of the distribution, by the equation:

\[
W_n^2 = \frac{\int_{-\infty}^{\infty} \left[ F(x) - F_n(x) \right]^2 w(x) \, dx}{\left( \int_{-\infty}^{\infty} w(x) \, dx \right)^2}
\]

where \(W_n^2\) is the AD statistic, \(n\) is the number of data points, \(F(x)\) is the fitted cumulative distribution, and \(F_n(x)\) is the cumulative distribution of

---

the input data. This can be reduced to the more useful computational equation:

\[ W_n^2 = n - \frac{1}{n} \sum_{i=1}^{n} (2i - 1) [\log \mu_i + \log(1 - \mu_{n+1-i})] \]

where \( \mu_i \) is the value of the fitted cumulative distribution, \( F(x_i) \), for the \( i \)th data point (see Law & Kelton\(^1\), Anderson & Darling\(^2,3\)).

The resulting test statistic is then compared to a standard value of the AD statistic with the appropriate number of data points and level of significance, usually labeled alpha. The limitations of the AD test are similar to the Kolmogorov-Smirnov test with the exception of the boundary conditions discussed below. The AD test is not a limiting distribution; it is appropriate for any sample size. While the AD test is only valid if none of the parameters in the test have been estimated from the data, it can be used for fitted distributions with the understanding that it is then a conservative test, that is, less likely to reject the fit in error. The validity of the AD test can be improved for some specific distributions. These more stringent tests take the form of a multiplicative adjustment to the general AD statistic.

The goodness of fit view also reports a REJECT or DO NOT REJECT decision for each AD test based on the comparison between the calculated test statistic and the standard statistic for the given level of significance. The AD test is very sensitive to the tails of the distribution. For this reason, the test must be used with discretion for many of the continuous distributions with lower bounds and finite values at that lower bound.

The test is inaccurate for discrete distributions as the standard statistic is not easily calculated.

While the test statistic for the Anderson Darling test can be useful, the p-value is more useful in determining the goodness of fit. The p-value is defined as the probability that another sample will be as unusual as the current sample given that the fit is appropriate. A small p-value indicates that the current sample is highly unlikely, and therefore, the fit should be rejected. Conversely, a high p-value indicates that the sample is likely and would be repeated, and therefore, the fit should not be rejected. Thus, the HIGHER the p-value, the more likely that the fit is appropriate. When comparing two different fitted distributions, the distribution with the higher p-value is likely to be the better fit regardless of the level of significance.

### General

Each of these tests has its own regions of greater sensitivity, but they all have one criterion in common. The fit and the tests are totally insensitive for fewer than 10 data points (Stat::Fit will not respond to less data), and will not achieve much accuracy until 100 data points. On the order of 200 data points seems to be optimum. For large data sets, greater than 4000 data points, the tests can become too sensitive, occasionally rejected a proposed distribution when it is actually a useful fit. This can be easily tested with the Generate command in the Input menu.

While the calculations are being performed, a window at the bottom of the screen shows its progress and allows for a Cancel option at any time.

---

The results are shown in a table. An example is given below:

<table>
<thead>
<tr>
<th>data points</th>
<th>500</th>
</tr>
</thead>
<tbody>
<tr>
<td>estimates</td>
<td>0.0003</td>
</tr>
<tr>
<td>accuracy of fit</td>
<td>0.05</td>
</tr>
</tbody>
</table>

### Please note

If an error occurred in the calculations, the error message is displayed instead.

For the Chi Squared Test, the details show:
- total classes [intervals]
- interval type [equal length, equal probable]
- net bins [reduced intervals]
- chi**2 [the calculated statistic]
- degrees of freedom [net bins-1 here]
- alpha [level of significance]
- chi**2(n, alpha) [the standard statistic]
- p-value
- result

For both the Kolmogorov Smirnov and Anderson Darling tests, the details show:
- data points
- stat [the calculated statistic]
- alpha [level of significance]
- stat (n, alpha) [the standard statistic]
- p-value
- result

In the summary section, the distributions you have selected for fitting are shown along with the results of the Goodness of Fit Test(s). The numbers in parentheses after the type of distribution are the parameters and they are shown explicitly in the detailed information, below the summary table.

### Please note

The above table shows results for the Chi-Squared Test. The number in parentheses is the degrees of freedom. When you want to compare Chi-Squared from different distributions, you can make a comparison only when they have the same degrees of freedom.

The detailed information, following the summary table, includes a section for each fitted distribution. This section includes:
- parameter values
- Chi Squared Test
- Kolmogorov Smirnov Test
- Anderson Darling Test
Automatic fitting of continuous distributions can be performed by clicking on the Auto::Fit icon or by selecting Fit from the Menu bar and then Auto::Fit from the Submenu.

This command follows the same procedure as previously discussed for manual fitting. Auto::Fit will automatically choose appropriate continuous distributions to fit to the input data, calculate Maximum Likelihood Estimates for those distributions, test the results for Goodness of Fit, and display the distributions in order of their relative rank. The relative rank is determined by an empirical method which uses effective goodness of fit calculations. While a good rank usually indicates that the fitted distribution is a good representation of the input data, an absolute indication of the goodness of fit is also given.

An example is shown below:

For continuous distributions, the Auto::Fit dialog limits the number of distributions by choosing only those distributions with a lower bound or by forcing a lower bound to a specific value as in Fit Setup. Also, the number of distributions will be limited if the skewness of the input data is negative. Many continuous distributions with lower bounds do not have good parameter estimates in this situation.

For discrete distributions, the Auto::Fit dialog limits the distributions by choosing only those distributions that can be fit to the data. The discrete distributions must have a lower bound. The acceptance of fit usually reflects the results of the goodness of fit tests at the level of significance chosen by the user. However, the acceptance may be modified if the fitted distribution would generate significantly more data points in the tails of the distribution than are indicated by the input data.
Replication and Confidence Level Calculator

The Replications command allows the user to calculate the number of independent data points, or replications, of an experiment that are necessary to provide a given range, or confidence interval, for the estimate of a parameter. The confidence interval is given for the confidence level specified, with a default of 0.95. The resulting number of replications is calculated using the t distribution\(^1\).

To use the Replications calculator, select Utilities from the Menu bar and then Replications.

The following dialog will be displayed.

Chapter 4: Graphs

This chapter describes the types of graphs and the Graphics Style options. Graphical analysis and output is an important part of Stat::Fit. The input data in the Data Table may be graphed as a histogram or line chart and analyzed by a scatter plot or autocorrelation graph. The resulting fit of a distribution may be compared to the input via a direct comparison, a difference plot, a Q-Q plot, and a P-P plot for each analytical distribution chosen. The analytical distributions can be displayed for any set of parameters.

The resulting graphs can be modified in a variety of ways using the Graphics Style dialog in the Graphics menu, which becomes active when a graph is the currently active window.
Result Graphs

A density graph of your input data and the fitted density can be viewed by choosing Fit from the Menu bar and then Result Graphs.

This graph displays a histogram of the input data overlaid with the fitted densities for specific distributions.

From the next menu that appears (see above), choose Comparison.

Quicker access to this graph is accomplished by clicking on the Graph icon on the Control bar.

The graph will appear with the default settings of the input data in a blue histogram and the fitted data in a red polygon, as shown below.

The distribution being fit is listed in the lower box on the right. If you have selected more than one distribution to be fit, a list of the distributions is given in the upper box on the right. Select additional distributions to be displayed, as comparisons, by clicking on the distribution name(s) in the upper box. The additional fit(s) will be added to the graph and the name of the distribution(s) added to the box on the lower right. There will be a Legend at the bottom of the graph, as shown below:

To remove distributions from the graph, click on the distribution name in the box on the lower right side and it will be removed from the graphic display.

Stat::Fit provides many options for graphs in the Graphics Style dialog, including changes in the graph character, the graph scales, the title texts, the graph fonts and the graph colors.

This dialog can be activated by selecting Graphics from the Menu bar and then Graphics Style from the Submenu.

The graph remains modified as long as the document is open, even if the graph itself is closed and reopened. It will also be saved with the project as modified. Note that any changes are singular to that particular graph; they do not apply to any other graph in that document or any other document.

If a special style is always desired, the default values may be changed by changing any graph to suit, and checking the Save Apply button at the bottom of the dialog.
Graphics Style

Graph

The Graphics Style dialog box has 5 tabs (or pages). When you select a tab, the dialog box changes to display the options and default settings for that tab. You determine the settings for any tab by selecting or clearing the check boxes on the tab. The new settings take effect when you close the dialog box. If you want your new settings to be permanent, select Save to Default and they will remain in effect until you wish to change them again.

The dialog box for the graph type options is shown below:

![Graph Style Dialog Box](image)

The **Graph Type** chooses between three types of distribution functions:

- **Density** indicates the probability density function, f(x), for continuous random variables and the probability mass function, p(j), for discrete random variables. Quite frequently, f(x) is substituted for p(j) with the understanding that x then takes on only integer values.

- **Ascending cumulative** indicates the cumulative distribution function, F(x), where x can be either a continuous random variable or a discrete random variable. F(x) is continuous or discrete accordingly. F(x) varies from 0 to 1.

- **Descending cumulative** indicates the survival function, (1-F(x)).

Graph Type is not available for Scatter Plot, Autocorrelation, Q-Q plot and P-P plot.

The **Normalization** area indicates whether the graph represents actual counts or a relative fraction of the total counts.

- **Frequency** represents actual counts for each interval (continuous random variable) or class (discrete random variable).

- **Relative Frequency** represents the relative fraction of the total counts for each interval (continuous random variable) or class (discrete random variable).

Normalization is only available for distribution graph types, such as Comparison and Difference.

The graph style can be modified for both the input data and the fitted distribution. Choices include points, line, bar, polygon, filled polygon and histogram. For Scatter Plots, the choices are modified and limited to: points, cross, dots.
Scale

The dialog box for Scale is shown below:

The Scale page allows the x and y axes to be scaled in various ways, as well as modifying the use of a graph frame, a grid, or tick marks. The default settings for Scale allow the data and fitted distribution to be displayed. These settings can be changed by deselecting the default and adding Min and Max values.

Moreover, the printed graph will maintain that aspect ratio as will the bitmap that can be saved to file or copied to the Clipboard.

The Frame option allows you to have a full, partial or no frame around your graph. A grid can be added to your graph in both x and y, or just a horizontal or vertical grid can be displayed. Tick marks can be selected to be inside, outside, or absent. Both ticks and the grid can overlay the data.

Text

The dialog box for Text is shown below:

The Text function allows you to add text to your graph. A Main Title, x-axis and y-axis titles, and legends can be included. Scale factors can be added. The layout of the y-axis title can be modified to be at the top, on the side or rotated along the side of the y-axis. Some graphs load default titles initially.

Fonts

The dialog box for Fonts is shown below:
The Fonts page of the dialog provides font selection for the text titles and scales in the currently active graph. The font type is restricted to TrueType®, printer Ready fonts that can be scaled on the display. The Font size is limited to a range that can be contained in the same window as the graph. Text colors can be changed in the Color page; no underlining or strikeouts are available.

Color

The dialog box for Color is shown below:

The Colors page of the dialog provides color options for all the fields of the currently active graph. For each object in the graph, a button to call the color dialog is located to the left and a color patch is located on the right. **Text** refers to all text including scales. **Input** refers to the first displayed graph, the input data in comparison graphs. **Result** refers to fitted data. **Bar Shade** refers to the left and bottom of histogram boxes and requires the check box be set on as well. **Background** refers to the background color; full white does not print.

Note that the colors are chosen to display well on the screen. If a laser printer with gray scales is used, the colors should be changed to brighter colors or grays in order to generate appropriate gray levels. Some of the colors will default to the nearest of the 16 basic Windows colors in order to display properly.
Other Graphs

Stat::Fit provides additional Result Graphs for visualizing the fit of your data to a distribution. Above we have described the Density Graph. The other choices on the Submenu are Distribution, Difference, Box Plot, Q-Q Plot and P-P Plot. All of these graph types allow the comparison of multiple distributions. If you have selected more than one distribution to be fit, a list of the distributions is given in the upper box on the right. Select additional distributions to be displayed, as comparisons, by clicking on the distribution name(s) in the upper box. The additional fit(s) will be added to the graph and the name of the distribution(s) added to the box on the lower right. There will be a Legend at the bottom of the graph. To remove distributions from the graph, click on the distribution name in the box on the lower right side and it will be removed from the graphic display.

Distribution Graph

The Distribution graph displays the cumulative distribution of the input data overlaid with the fitted cumulative distributions for specific distributions.

Difference Graph

The Difference Graph is a plot of the difference between the cumulative input data in the Data Table minus the fitted cumulative distribution. Note that conservative error bars shown in the graph are not a function of the number of intervals for continuous data. Although the graph may be modified to plot the difference between the input density and the fitted density, the error bars derived from the conservative Kolmogorov Smirnov calculations, are only applicable for the cumulative distribution.

Box Plot

Box Plots are another way to compare the data with the distributions. It is particularly good for looking at the extremes. The center line is the median. The box represents the quartiles (25% and 75%). The next set of lines are the octiles and the outer lines are the extremes of the data or distribution. A box plot gives a quick indication of potential skewness in a data set by relating the location of the box to the median. If one side of
the box is further away from the median than the other side, the distribution tends to be skewed in the direction furthest from the median.

Multiple distributions can be added to the graph for comparison.

Q-Q Plot

The Q-Q Plot, as shown below, is a plot of the input data (straight line) in the Data Table versus the value of x that the fitted distribution must have in order to give the same probability of occurrence. This plot tends to be sensitive to variations of the input data in the tails of the distribution (see Law & Kelton\(^1\)).

P-P Plot

The P-P Plot, as shown below, is a plot of the probability of the ith data point in the input data (straight line) from the Data Table versus the probability of that point from the fitted cumulative distribution. This plot tends to be sensitive to variations in the center of the fitted data (see Law & Kelton\(^2\)).

---

2. ibid., p. 339
Multiple distributions can be added to the graph for comparison.

A dialog box will allow you to select the type of distribution and its parameters. An example of the distribution graph viewer is shown below:

**Distribution Viewer**

The Distribution Viewer option allows you to display the functional form of any distribution with specified parameters totally independent of data. This is just a picture of what that analytical distribution would look like with the parameters you have selected. It can be used to visualize the functional form of distributions and can be useful in selecting a distribution for fitting. The Distribution Viewer allows active viewing of a distribution while the parameters or moments are changed.

To display the Distribution Viewer, select Utilities from the Menu bar and then Distribution Viewer from the Submenu.

Quicker access to the Distribution Viewer by clicking on the Distribution Viewer icon.

The Distribution Viewer uses the distribution and parameters provided in this dialog to create a graph of any analytical distribution supported by Stat::Fit. This graph is not connected to any input data or document. This graph of the distribution may then be modified using the sliders for each parameter, specifying the value, or specifying one of the moments of the distribution. The number of moments which may be modified is limited to the number of free parameters for that distribution.

As the value of each parameter or moment is changed, the graph is frozen at its previous representation. The graph is updated when the slider is released, or the edited value is entered with a Return, Tab, or mouse click in another area. The graph may also be updated with the Redraw Graph button when active.

The bounds of the distribution, if any, can be fixed; however this reduces the number of moments that can be modified. A grayed moment box can be viewed, but not modified.

Occasionally, the specified moments cannot be calculated with the given parameters, such as when the mean is beyond one of the bounds. In this situation, an error message is given and the moments are recalculated from the parameters.
Also, some distributions do not have finite moments for all values of the parameters and the appropriate moment boxes are shown empty. As with all graphs in Stat::Fit, the Distribution Viewer may be customized by using the Graphics Style dialog in the Graphics menu. The graphs may also be copied to the Clipboard or saved as a graphic file [.bmp] by using the Copy or Save As commands in the Graphics menu. Note that while the graph view currently open can still be modified, the copied or saved version is a fixed bitmap. The bitmap contains only the graph, and excludes parameter boxes and sliders.

The distribution in the Distribution Viewer may also be exported to another application by choosing the Export Fit command while the Distribution Viewer is the active window. In this way, no-data or minimal data descriptions can be translated from the form of the distribution in Stat::Fit to the form of the distribution in a particular application.

How to Copy and Save As

Any graph can be copied onto the Clipboard, so that you can transfer it to another program, by selecting Graphics from the Menu bar and then Copy from the Submenu. The Graphics Copy command places a copy of the current graph in the Clipboard as a bitmap.

The Graphics Save As command saves a bitmap (.bmp) file of the current graph. From there, it can be loaded into another application if that application supports the display of bitmaps. It can also be loaded into Stat::Fit, but will no longer be connected with a document. Note that the copy can no longer be modified with the Graphics Style dialog.
Chapter 5:
Print and Output Files

This chapter provides details on how to print graphs and reports tailored to meet your needs. Information on exporting files will also be given.
Chapter 5: Printing

The printing process is started by selecting File from the Menu bar. The following Submenu is displayed:

![Submenu Image]

**Print Style**

Select Print Style from the Submenu. All print output is a copy of selected windows of a Stat::Fit document or of a stand alone Distribution graph. The type of print output, whether a single active window, all active windows in the document, or a selected report, is chosen in the Print Style dialog. Unless changed by the user, the default style is to print the active window (colored title bar). Other options, such as fonts and labels, may be chosen in the Print Style dialog as well.

The Print Style dialog box has 2 tabs as shown below:

![Print Style Dialog]

**Print Type**

Print Type is the first tab in the Print Style dialog box. It allows you to select the items you want to have printed. Your choices include:

- **Active Window**: Print only the active window.
- **Active Document**: Print all of the open windows in a single document.

Other options available for printing are the inclusion of a Header or Footer. In either you can put the title of the document, a date and page numbers.
Fonts

The dialog box for Fonts is shown below:

The Font page of the File Print Style dialog provides font choice for the text pages to be printed. This choice does not change the font(s) chosen for the graphics pages. This allows you to select the font type and size for the written text in the report. The fonts for the graphs should have been previously selected in the Graph Style/Fonts dialog box.

Printer Set-up

Return to the Submenu under File shown at the beginning of this chapter, and select Printer Set-up. The standard windows dialog box for printer set-up will be displayed.

This standard Print Setup dialog will allow specification of the printer, paper size, and orientation of printed output. It will also allow access to the Options dialog of the chosen printer. This setup will subsequently be used by the Print command.

Print Preview

The Print Preview command opens a separate set of windows to display each expected page of the print output, using the options specified in the Print Style command. These windows can be closed by double clicking on the upper left Close button.

The Print Preview windows give a scaled version of the output to be generated by the Print command. Each graph will maintain the aspect ratio of the on screen window while maximizing the graph size to fit the printed page.
File Output

When input data is entered into Stat::Fit, whether through manual entry in a new document, opening a data file, pasting data from the Clipboard, or reopening a Stat::Fit project file, a Stat::Fit document is created which contains the data and all subsequent calculations and graphs. If the document is initiated from an existing file, it assumes the name of that file and the document can be saved automatically as a Stat::Fit project (.SFP extension) with the Save command. If the document is unnamed, it can be saved as either a Stat::Fit project or a text data file with the Save As command. In either situation, the on-screen document assumes the name of the file used.

A text file of the input data can be saved with the Save Input command which will prompt if the file already exists. Unless specifically changed, the file will be saved with the .DAT extension. All graphs can be saved independently as bitmap files (.BMP format), by using the Save As command in the Graphics menu when the graph is the active window.

Export Fit

The fitted distributions, ready for inclusion in a specific Application, may be saved in a text file by using the Export command in the File menu or the Export icon on the Control Bar. The Export command provides the fitted distribution in the form required by the Application in order to generate random variates from that distribution. The Export Fit dialog, as shown below, allows a choice of Applications in order to determine the format of the output and the choice of the analytical distribution. After both choices have been made the expected output is shown near the bottom of the dialog.

The Export command requires that the appropriate estimates have been calculated, either manually or automatically with the Auto::Fit command.

For some applications, the requested distribution may not be supported. If the generator for the unsupported distribution can be formed from a Uniform distribution, the analytical form of this generator is given instead. If the generator is not straightforward, no output will be provided.

The output can be directed to either the Windows clipboard or a text file.

Export of Empirical Distributions

The Export Empirical command allows the export of an empirical distribution for the input data to either the Windows clipboard or a text file. The output is formatted with a value and a probability, delimited by a space, on each line. An empirical distribution is advisable if the input data cannot be fit to the analytical distributions.
To export an empirical distribution, select File from the Menu bar, Export from the Submenu, and then Export Empirical.

The following dialog will be displayed:

If any of the data are non-integers, then the exported distribution may be only a continuous distribution with the minimum and maximum values determining the range of data included in the distribution. The number of data points included is shown. The number of intervals may be set as well, but should be small enough to avoid bins with zero data and large enough to avoid oversmoothing. The default interval value is the same as the auto value set by Stat::Fit and will avoid oversmoothing. The distribution may be either a cumulative or density distribution.

If the data is integer, then the exported distribution may be either a continuous or discrete distribution with the minimum and maximum values determining the range of data included in the distribution. The discrete integer range is limited to 1000. The number of data points included is indicated in the Points box. The distribution may be either a cumulative or density distribution.

The Precision of the numbers in the output is set by the Precision box whose default value is 3.
Chapter 6: Tutorial

This chapter provides an example to illustrate some of the functions of Stat::Fit. It will also give some insights for fitting your data and understanding the results of the tests and graphical outputs.
Tutorial

To begin, start a New File for data by clicking on the New File icon. An input data table will appear on the screen.

An easy way to provide some input data is to use the built-in number generator provided with Stat::Fit. Click on the Generate icon.

Select the logistic distribution, enter 1000 for the number of points and use the default settings. Click on OK. The data table will be filled with 1000 points of generated data.

A histogram of your new data can be displayed by clicking on the Input Graph icon. A graph very similar to the following will be shown:

The Descriptive Statistics of the input data can be viewed by selecting Statistics from the Menu bar and then Descriptive from the Submenu. The following table will be shown:

<table>
<thead>
<tr>
<th>descriptive statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>data points</td>
</tr>
<tr>
<td>minimum</td>
</tr>
<tr>
<td>maximum</td>
</tr>
<tr>
<td>mean</td>
</tr>
<tr>
<td>median</td>
</tr>
<tr>
<td>mode</td>
</tr>
<tr>
<td>standard deviation</td>
</tr>
<tr>
<td>variance</td>
</tr>
<tr>
<td>coefficient of variation</td>
</tr>
<tr>
<td>skewness</td>
</tr>
<tr>
<td>kurtosis</td>
</tr>
</tbody>
</table>

The independence of your data can be checked by selecting Statistics from the Menu bar and then
Independence from the Submenu. From the next submenu which appears, select Scatter Plot.

If the data is independent, it will scatter all over the graph.

The distribution fitting process is started by clicking on the Set-up icon. A dialog box for Fit Setup will appear. Looking at the graph of the input data, the shape resembles a Normal distribution. Therefore, let us try to fit the data to both a Logistic distribution and a Normal distribution.

Click on Logistic and then on Normal.

After selecting the distributions, go to the next window of the dialog box, for Calculations. In addition to the Chi-Squared Test, also select the Kolmogorov-Smirnov and Anderson-Darling Tests. Then click on OK.

The tests will be performed by clicking on the Test icon. The calculations for the Goodness of Fit tests will start. A summary of the results will be presented in a table as shown next:

The results of the tests indicate that neither distribution should be rejected. However you will notice that the p-values for the Logistic distribution are higher than for the Normal distribution, indicating a better fit.
Graphical results can be viewed by clicking on the Graph Fit icon. The following graph will be shown:

To compare this to the graph of the Normal distribution, click on Normal in the upper right box. It will be added to the graph as shown below:

Graphically both distributions appear to fit the data. Remember that the Goodness of Fit tests indicated that the Logistic distribution was a better fit. To get a better visualization of this, let us try some of the other Result Graphs.

Select Fit from the Menu bar and then Result Graphs from the Submenu. From the next submenu choose Q-Q Plot.

The Q-Q plot is sensitive to the tails of a distribution and you can see in the above graph that the Normal distribution does not provide a good fit for the tails of the data.

Another useful graph for displaying the fit is the Difference Graph. Select Fit from the Menu bar, Result Graphs from the Submenu and then Difference Graph.

The Difference Graphs illustrate the difference of the cumulative distribution you have fit compared to the data.

It is instructive to look at another distribution which might fit. Let us try the Weibull distribution. Repeat the previous procedures: click on the Setup icon and select the Weibull distribution for fitting. Hit OK and then click on the Test icon. The goodness of fit summary shows the results:

The results of these tests indicate that you should reject this distribution. Let us look at the Comparison Graph to see if it is obvious from its
visual appearance. Click on the Graph Fit icon and choose Weibull.

For a better visual display, try the Q-Q plot for the Weibull distribution.

Here we see the tails of the distribution do not fit well. Let us look at the P-P plot for the center of the distribution.

The combination of these plots provides a good visualization of how well the data is fit to a particular distribution.

Let us now print a Report with our results. Select File from the menu bar and then Print Style from the Submenu. In the first page of the dialog box, select Print Active document in order to print all of the test results and graphs.

Select Print Setup from the Submenu under File in order to specify your printer, paper and orientation. Select Print Preview to display your report before printing. If you are pleased with its contents, Select Print from the Submenu and hit OK.
Appendix:
Distributions
**Beta Distribution (min, max, p, q)**

\[ f(x) = \frac{1}{(max - min) B(p, q)} x^{p-1} (1-x)^{q-1} \]

\[ \text{min} \leq x \leq \text{max} \]

- **min** = minimum value of x
- **max** = maximum value of x
- **p** = lower shape parameter > 0
- **q** = upper shape parameter > 0

\[ B(p, q) \quad \text{Beta Function} \]

**Description**

The Beta distribution is a continuous distribution that has both upper and lower finite bounds. Because many real situations can be bounded in this way, the Beta distribution can be used empirically to estimate the actual distribution before much data is available. Even when data is available, the Beta distribution should fit most data in a reasonable fashion, although it may not be the best fit. The Uniform distribution is a special case of the Beta distribution with \( p, q = 1 \).

As can be seen in the examples above, the Beta distribution can approach zero or infinity at either of its bounds, with p controlling the lower bound and q controlling the upper bound. Values of p, q < 1 cause
the Beta distribution to approach infinity at that bound. Values of \( p, q > 1 \) cause the Beta distribution to be finite at that bound.

Beta distributions have many, many uses. As summarized in Johnson et al\(^1\), Beta distributions have been used to model distributions of hydrologic variables, logarithm of aerosol sizes, activity time in PERT analysis, isolation data in photovoltaic system analysis, porosity/void ratio of soil, phase derivatives in communication theory, size of progeny in *Escherchia Coli*, dissipation rate in breakage models, proportions in gas mixtures, steady-state reflectivity, clutter and power of radar signals, construction duration, particle size, tool wear, and others. Many of these uses occur because of the doubly bounded nature of the Beta distribution.

---

Binomial Distribution (n, p)

\[ x = 0, 1, ..., n \]

\( n = \) number of trials

\( p = \) probability of the event occurring

\[ \binom{n}{x} p^x (1-p)^{n-x} \]

**Description**

The Binomial distribution is a discrete distribution bounded by \([0,n]\). Typically, it is used where a single trial is repeated over and over, such as the tossing of a coin. The parameter, \( p \), is the probability of the event, either heads or tails, either occurring or not occurring. Each single trial is assumed to be independent of all others. For large \( n \), the Binomial distribution may be approximated by the Normal distribution, for example when \( np > 9 \) and \( p < 0.5 \) or when \( np(1-p) > 9 \).

As shown in the examples above, low values of \( p \) give high probabilities for low values of \( x \) and visa versa, so that the peak in the distribution may approach either bound. Note that the probabilities are actually weights at each integer, but are represented by broader bars for visibility.
The Binomial distribution has had extensive use in games, but is also useful in genetics, sampling of defective parts in a stable process, and other event sampling tests where the probability of the event is known to be constant or nearly so. See Johnson et al.¹

Chi Squared Distribution (min, nu)

\[ f(x) = \frac{1}{2^{\nu/2} \Gamma(\nu/2)} \exp\left(-\frac{(x - \text{min})}{2}\right)(x - \text{min})^{(\nu/2) - 1} \]

min = minimum x value
nu = shape parameter

Description

The Chi Squared is a bounded continuous distribution bounded on the lower side. Note that the Chi Squared distribution is a subset of the Gamma distribution with beta=2 and alpha=n\(\nu/2\). Like the Gamma distribution, it has three distinct regions. For n\(\nu/2\)=2, the Chi Squared distribution reduces to the Exponential distribution, starting at a finite value at minimum x and decreasing monotonically thereafter. For n\(\nu/2\)<2, the Chi Squared distribution tends to infinity at minimum x and decreases monotonically for increasing x. For n\(\nu/2\)>2, the Chi Squared distribution is 0 at minimum x, peaks at a value that depends on n, decreasing monotonically thereafter.

Because the Chi Squared distribution does not have a scaling parameter, its utilization is somewhat limited. Frequently, this distribution will try to represent data with a clustered distribution with n less than 2. However, it can be viewed as the distribution of the sum of squares of independent unit normal variables with n degrees of freedom and is used in many statistical tests. (see Johnson et al.3)

Examples of each of the regions of the Chi Squared distribution are shown above. Note that the peak of the distribution moves away from the minimum value for increasing n, but with a much broader distribution. More examples can be viewed by using the Distribution Viewer.
Discrete Uniform Distribution (min, max)

\[
\text{PDF} = \frac{1}{\text{max} - \text{min}}
\]

\(x = \text{min}, \text{min}+1, ..., \text{max}\)
\(\text{min} = \text{minimum } x\)
\(\text{max} = \text{maximum } x\)

Description

The Discrete Uniform distribution is a discrete distribution bounded on \([\text{min}, \text{max}]\) with constant probability at every value on or between the bounds. Sometimes called the discrete rectangular distribution, it arises when an event can have a finite and equally probable number of outcomes. (see Johnson et al.\(^1\))

Note that the probabilities are actually weights at each integer, but are represented by broader bars for visibility.

---

Erlang Distribution (min, m, beta)

\[
\text{min} = \text{minimum } x \\
m = \text{shape factor} = \text{positive integer} \\
\beta = \text{scale factor} > 0
\]

**Description**

The Erlang distribution is a continuous distribution bounded on the lower side. It is a special case of the *Gamma* distribution where the parameter, m, is restricted to a positive integer. As such, the Erlang distribution has no region where \(f(x)\) tends to infinity at the minimum value of \(x\) \([m<1]\), but does have a special case at \(m=1\), where it reduces to the *Exponential* distribution.

The Erlang distribution has been used extensively in reliability and in queuing theory, thus in discrete event simulation, because it can be viewed as the sum of \(m\) exponentially distributed random variables, each with mean \(\beta\). It can be further generalized (see Johnson\(^1\), Banks & Carson\(^2\)).

As can be seen in the previous examples, the Erlang distribution follows the Exponential distribution at \( m=1 \), has a positive skewness with a peak near 0 for \( m \) between 2 and 9, and tends to a symmetrical distribution offset from the minimum at larger \( m \).
Exponential Distribution (min, beta)

\[
\begin{align*}
\frac{1}{\beta} \exp\left(-\frac{x - \text{min}}{\beta}\right)
\end{align*}
\]

min = minimum x value
\(\beta\) = scale parameter = mean

Description

The Exponential distribution is a continuous distribution bounded on the lower side. Its shape is always the same, starting at a finite value at the minimum and continuously decreasing at larger x. As shown in the examples above, the Exponential distribution decreases rapidly for increasing x.

The Exponential distribution is frequently used to represent the time between random occurrences, such as the time between arrivals at a specific location in a queuing model or the time between failures in reliability models. It has also been used to represent the services times of a specific operation. Further, it serves as an explicit manner in which the time dependence on noise may be treated. As such, these models are making explicit use of the lack of history dependence of the exponential distribution; it has the same set of probabilities when shifted in time. Even when Exponential models are known to be inadequate to describe the situation, their mathematical tractability provides a good starting point. Later, a more complex distribution such as Erlang or Weibull may be investigated (see Law & Kelton\(^1\), Johnson et al.\(^2\))

Extreme Value type 1A Distribution (\(\tau, \beta\))

\(\tau = \) threshold/shift parameter
\(\beta = \) scale parameter

Description

The Extreme Value 1A distribution is an unbounded continuous distribution. It’s shape is always the same but may be shifted or scaled to need. It is also called the Gumbel distribution.

The Extreme Value 1A distribution describes the limiting distribution of the \textit{extreme} values of many types of samples. Actually, the Extreme Value distribution given above is usually referred to as Type 1, with Type 2 and Type 3 describing other limiting cases. If \(x\) is replaced by \(-x\), then the resulting distribution describes the limiting distribution for the \textit{least} values of many types of samples. These reflected pair of distributions are sometimes referred to as Type 1A and Type 1B.

The Extreme Value distribution has been used to represent parameters in growth models, astronomy, human lifetimes, radioactive emissions, strength of materials, flood analysis, seismic analysis, and rainfall analysis. It is also directly related to many learning models (see Johnson\(^1\)).

The Extreme Value 1A distribution starts below \(\tau\), is skewed in the positive direction peaking at \(\tau\), then decreasing monotonically thereafter. \(\beta\) determines the breadth of the distribution.

Extreme Value type 1B Distribution (tau, beta)

\[ f(x) = \frac{1}{\beta} \exp\left(\frac{x - \tau}{\beta}\right) \exp\left(\exp\left(-\frac{x - \tau}{\beta}\right)\right) \]

\( \tau = \) threshold/shift parameter
\( \beta = \) scale parameter

**Description**

The Extreme Value 1B distribution is an unbounded continuous distribution. It’s shape is always the same but may be shifted or scaled to need.

The Extreme Value 1B distribution describes the limiting distribution of the least values of many types of samples. Actually, the Extreme Value distribution given above is usually referred to as Type 1, with Type 2 and Type 3 describing other limiting cases. If \( x \) is replaced by \(-x\), then the resulting distribution describes the limiting distribution for the greatest values of many types of samples. These reflected pair of distributions are sometimes referred to as Type 1A and Type 1B. Note that the complimentary distribution can be used to represent samples with positive skewness.

The Extreme Value distribution has been used to represent parameters in growth models, astronomy, human lifetimes, radioactive emissions, strength of materials, flood analysis, seismic analysis, and rainfall analysis. It is also directly related to many learning models. (see Johnson et. al.4)

The Extreme Value 1B distribution starts below \( \tau \), is skewed in the negative direction peaking at \( \tau \), then decreasing monotonically thereafter. \( \beta \), determines the breadth of the distribution.

---

Gamma Distribution (min, alpha, beta)

\[ f(x) = \frac{1}{\beta^\alpha \Gamma(\alpha)} (x - \min)^{\alpha-1} \exp\left(-\frac{x - \min}{\beta}\right) \]

\( \min = \) minimum \( x \)
\( \alpha = \) shape parameter > 0
\( \beta = \) scale parameter > 0

**Description**

The Gamma distribution is a continuous distribution bounded at the lower side. It has three distinct regions. For \( \alpha = 1 \), the Gamma distribution reduces to the Exponential distribution, starting at a finite value at minimum \( x \) and decreasing monotonically thereafter. For \( \alpha < 1 \), the Gamma distribution tends to infinity at minimum \( x \) and decreases monotonically for increasing \( x \). For \( \alpha > 1 \), the Gamma distribution is 0 at minimum \( x \), peaks at a value that depends on both alpha and beta, decreasing monotonically thereafter. If alpha is restricted to positive integers, the Gamma distribution is reduced to the Erlang distribution.

Note that the Gamma distribution also reduces to the Chi-squared distribution for \( \min = 0, \beta = 2, \) and \( \alpha = n \mu / 2 \). It can then be viewed as the distribution of the sum of squares of independent unit normal variables, with \( n \mu \) degrees of freedom and is used in many statistical tests.
The Gamma distribution can also be used to approximate the Normal distribution, for large alpha, while maintaining its strictly positive values of x [actually (x-min)].

The Gamma distribution has been used to represent lifetimes, lead times, personal income data, a population about a stable equilibrium, interarrival times, and service times. In particular, it can represent lifetime with redundancy (see Johnson\(^1\), Shooman\(^2\)).

Examples of each of the regions of the Gamma distribution are shown above. Note the peak of the distribution moving away from the minimum value for increasing alpha, but with a much broader distribution.

---

Geometric Distribution (p)

\[ p = \text{probability of occurrence} \]

Description

The Geometric distribution is a discrete distribution bounded at 0 and unbounded on the high side. It is a special case of the Negative Binomial distribution. In particular, it is the direct discrete analog for the continuous Exponential distribution. The Geometric distribution has no history dependence, its probability at any value being independent of a shift along the axis.

The Geometric distribution has been used for inventory demand, marketing survey returns, a ticket control problem, and meteorological models (see Johnson\(^1\), Law & Kelton\(^2\))

Several examples with decreasing probability are shown above. Note that the probabilities are actually weights at each integer, but are represented by broader bars for visibility.

---

Inverse Gaussian Distribution (min, alpha, beta)

min = minimum x  
α = shape parameter > 0  
β = mixture of shape and scale > 0

Description

The Inverse Gaussian distribution is a continuous distribution with a bound on the lower side. It is uniquely zero at the minimum x, and always positively skewed. The Inverse Gaussian distribution is also known as the Wald distribution.

The Inverse Gaussian distribution was originally used to model Brownian motion and diffusion processes with boundary conditions. It has also been used to model the distribution of particle size in aggregates, reliability and lifetimes, and repair time (see Johnson\(^1\)).

Examples of Inverse Gaussian distributions are shown above. In particular, notice the drastically increased upper tail for increasing β.

Inverse Weibull Distribution (min, alpha, beta)

\[ f(x) = \alpha \beta \left( \frac{1}{\beta(x - \text{min})} \right) \exp\left( -\left( \frac{1}{\beta(x - \text{min})} \right)^\alpha \right) \]

\( \text{min} = \) minimum \( x \)
\( \alpha = \) shape parameter \( > 0 \)
\( \beta = \) mixture of shape and scale \( > 0 \)

Description

The Inverse Weibull distribution is a continuous distribution with a bound on the lower side. It is uniquely zero at the minimum \( x \), and always positively skewed. In general, the Inverse Weibull distribution fits bounded, but very peaked, data with a long positive tail.

The Inverse Weibull distribution has been used to describe several failure processes as a distribution of lifetime. (see Calabria & Pulcini 6)\(^1\) It can also be used to fit data with abnormal large outliers on the positive side of the peak.

Examples of Inverse Weibull distribution are shown above. In particular, notice the increased peakedness and movement from the minimum for increasing \( \alpha \).

---

Johnson SB Distribution (min, lamda, gamma, delta)

\[ f(x) = \frac{\delta}{\sqrt{2\pi \gamma(1 - y)\lambda}} \exp\left(\frac{(-1/2)\left(\gamma + \delta \ln\left(\frac{y}{1-y}\right)\right)^2}{\lambda}\right) \]

where: \( y = \frac{x - \text{min}}{\lambda} \); \( \text{min} \) = minimum value of \( x \)

\( \lambda \) = range of \( x \) above the minimum
\( \gamma \) = skewness parameter
\( \delta \) = shape parameter > 0

Description

The Johnson SB distribution is a continuous distribution has both upper and lower finite bounds, similar to the Beta distribution. The Johnson SB distribution, together with the Lognormal and the Johnson SU distributions, are transformations of the Normal distribution and can be used to describe most naturally occurring unimodal sets of data. However, the Johnson SB and SU distributions are mutually exclusive,
each describing data in specific ranges of skewness and kurtosis. This leaves some cases where the natural boundedness of the population cannot be matched.

The family of Johnson distributions have been used in quality control to describe non-normal processes, which can then be transformed to the Normal distribution for use with standard tests. As can be seen in the following examples, the Johnson SB distribution goes to zero at both of its bounds, with $\gamma$ controlling the skewness and $\delta$ controlling the shape. The distribution can be either unimodal or bimodal. (see Johnson et al.\textsuperscript{1} and N. L. Johnson\textsuperscript{2})

---

Johnson SU Distribution (xi, lamda, gamma, delta)

\[ f(x) = \frac{\delta}{\lambda \sqrt{2\pi} \sqrt{y^2 + 1}} \exp\left(-\frac{1}{2} \left[ \gamma + \delta \ln \left( y + \sqrt{y^2 + 1} \right) \right]^2 \right) \]

Where: \( y = \frac{x - \xi}{\lambda} \)

\( \lambda \) = scale parameter
\( \gamma \) = skewness parameter
\( \delta \) = shape parameter > 0
\( \xi \) = shift parameter

**Description**

The Johnson SU distribution is an unbounded continuous distribution. The Johnson SU distribution, together with the Lognormal and the Johnson SB distributions, can be used to describe most naturally
occurring unimodal sets of data. However, the Johnson SB and SU distributions are mutually exclusive, each describing data in specific ranges of skewness and kurtosis. This leaves some cases where the natural boundedness of the population cannot be matched.

The family of Johnson distributions have been used in quality control to describe non-normal processes, which can then be transformed to the Normal distribution for use with standard tests. The Johnson SU distribution can be used in place of the notoriously unstable Pearson IV distribution, with reasonably good fidelity over the most probable range of values. As can be see in the examples above, the Johnson SU distribution is one of the few unbounded distributions that can vary its shape, with $\gamma$ controlling the skewness and $\delta$ controlling the shape. The scale is controlled by $\gamma$, $\delta$, and $\lambda$. (see Johnson et al.\textsuperscript{1} and N. L. Johnson\textsuperscript{2})

---

Logistic Distribution (alpha, beta)

\[ f(x) = \frac{\exp\left(-\frac{x-\alpha}{\beta}\right)}{\beta \left[1 + \exp\left(-\frac{x-\alpha}{\beta}\right)\right]^2} \]

\( \alpha = \text{shift parameter} \)
\( \beta = \text{scale parameter} > 0 \)

**Description**

The Logistic distribution is an unbounded continuous distribution which is symmetrical about its mean (and shift parameter), \( \alpha \). As shown in the example above, the shape of the Logistic distribution is very much like the Normal distribution, except that the Logistic distribution has broader tails.

The Logistic function is most often used as a growth model; for populations, for weight gain, for business failure, etc. The Logistic distribution can be used to test for the suitability of such a model, with transformation to get back to the minimum and maximum values for the Logistic function. Occasionally, the Logistic function is used in place of the Normal function where exceptional cases play a larger role (see Johnson\(^1\)).

---

1. “Continuous Univariate Distributions, Volume 2”, Norman L. Johnson, Samuel Kotz, N. Balakrishnan, 1995, John Wiley & sons, p.113
Log-Logistic Distribution (min, p, beta)

$$f(x) = \frac{p \left( \frac{x - \text{min}}{\beta} \right)^{p-1}}{\beta \left[ 1 + \left( \frac{x - \text{min}}{\beta} \right)^{p} \right]^2}$$

min = minimum x  

p = shape parameter > 0  

β = scale parameter > 0

Description

The Log-Logistic distribution is a continuous distribution bounded on the lower side. Like the Gamma distribution, it has three distinct regions. For p=1, the Log-Logistic distribution resembles the Exponential distribution, starting at a finite value at minimum x and decreasing monotonically thereafter. For p<1, the Log-Logistic distribution tends to infinity at minimum x and decreases monotonically for increasing x. For p>1, the Log-Logistic distribution is 0 at minimum x, peaks at a value that depends on both p and β, decreasing monotonically thereafter.
By definition, the natural logarithm of a Log-Logistic random variable is a Logistic random variable, and can be related to the included Logistic distribution in much the same way that the Lognormal distribution can be related to the included Normal distribution. The parameters for the included Logistic distribution, Lalpha and Lbeta, are given in terms of the Log-Logistic parameters, LLp and LLβ, by

\[
\begin{align*}
\text{Lalpha} &= \ln (LL\beta) \\
\text{Lbeta} &= 1/LLp
\end{align*}
\]

The Log-Logistic distribution is used to model the output of complex processes such as business failure, product cycle time, etc. (see Johnson\(^1\)).

Note for p=1, the Log-Logistic distribution decreases more rapidly than the Exponential distribution but has a broader tail. For large p, the distribution becomes more symmetrical and moves away from the minimum.

---

The Lognormal distribution is a continuous distribution bounded on the lower side. It is always 0 at minimum $x$, rising to a peak that depends on both $\mu$ and $\sigma$, then decreasing monotonically for increasing $x$.

By definition, the natural logarithm of a Lognormal random variable is a Normal random variable. Its parameters are usually given in terms of this included Normal.

The Lognormal distribution can also be used to approximate the Normal distribution, for small $\sigma$, while maintaining its strictly positive values of $x$ [actually $(x - \text{min})$].

The Lognormal distribution is used in many different areas including the distribution of particle size in naturally occurring aggregates, dust concentration in industrial atmospheres, the distribution of minerals present in low concentrations, duration of sickness absence, physicians’ consultant time, lifetime distri-
butions in reliability, distribution of income, employee retention, and many applications modeling
weight, height, etc. (see Johnson\textsuperscript{1}).

The Lognormal distribution can provide very peaked distributions for increasing \( \sigma \), indeed, far more
peaked than can be easily represented in graphical form.

\begin{flushright}
\textsuperscript{1} “Continuous Univariate Distributions, Volume 1”, Norman L. Johnson, Samuel Kotz, N. Balakrishnan, 1994,
John Wiley & Sons, p. 207
\end{flushright}
**Negative Binomial Distribution (p,k)**

\[ x = \text{number of trials to get } k \text{ events...} \]

\[ p = \text{probability of event } = [0,1] \]

\[ k = \text{number of desired events } = \text{positive integer} \]

---

**Description**

The Negative Binomial distribution is a discrete distribution bounded on the low side at 0 and unbounded on the high side. The Negative Binomial distribution reduces to the Geometric Distribution for \( k=1 \). The Negative Binomial distribution gives the total number of trials, \( x \) to get \( k \) events (failures...), each with the constant probability, \( p \), of occurring.

The Negative Binomial distribution has many uses; some occur because it provides a good approximation for the sum or mixing of other discrete distributions. By itself, it is used to model accident statis-
stics, birth-and-death processes, market research and consumer expenditure, lending library data, biometrics data, and many others (see Johnson\textsuperscript{1}).

Several examples with increasing $k$ are shown above. With smaller probability, $p$, the number of classes is so large that the distribution is best plotted as a filled polygon. Note that the probabilities are actually weights at each integer, but are represented by broader bars for visibility.

\footnote{\textit{"Univariate Discrete Distributions"}, Norman L. Johnson, Samuel Kotz, Adrienne W. Kemp, 1992, John Wiley & Sons, p. 223}
Normal Distribution (mu, sigma)

\[ f(x) = \frac{1}{\sqrt{2\pi\sigma^2}} e^{-\frac{(x-\mu)^2}{2\sigma^2}} \]

\( \mu \) = shift parameter
\( \sigma \) = scale parameter = standard deviation

Description

The Normal distribution is a unbounded continuous distribution. It is sometimes called a Gaussian distribution or the bell curve. Because of its property of representing an increasing sum of small, independent errors, the Normal distribution finds many, many uses in statistics. It is wrongly used in many situations. Possibly, the most important test in the fitting of analytical distributions is the elimination of the Normal distribution as a possible candidate. (See Johnson\(^1\)).

The Normal distribution is used as an approximation for the Binomial distribution when the values of \( n \), \( p \) are in the appropriate range. The Normal distribution is frequently used to represent symmetrical data, but suffers from being unbounded in both directions. If the data is known to have a lower bound, it may be better represented by suitable parameterization of the Lognormal, Weibull or Gamma distributions. If the data is known to have both upper and lower bounds, the Beta distribution can be used, although much work has been done on truncated Normal distributions (not supported in Stat::Fit).

The Normal distribution, shown above, has the familiar bell shape. It is unchanged in shape with changes in \( \mu \) or \( \sigma \).

---

Pareto Distribution (min, alpha)

\[ f(x) = \frac{\alpha \min}{x^{\alpha + 1}} \]

\( \min = \text{minimum } x \)
\( \alpha = \text{scale parameter } > 0 \)

**Description**

The Pareto distribution is a continuous distribution bounded on the lower side. It has a finite value at the minimum \( x \) and decreases monotonically for increasing \( x \). A pareto random variable is the exponential of an Exponential random variable, and possesses many of the same characteristics. The Pareto distribution has, historically, been used to represent the income distribution of a society. It is also used to model many empirical phenomena with very long right tails, such as city population sizes, occurrence of natural resources, stock price fluctuations, size of firms, brightness of comets, and error clustering in communication circuits (see Johnson\(^1\)).

The shape of the Pareto curve changes slowly with \( \alpha \), but the tail of the distribution increases dramatically with decreasing \( \alpha \).

---

The Pearson 5 distribution is a continuous distribution with a bound on the lower side. The Pearson 5 distribution is sometimes called the Inverse Gamma distribution due to the reciprocal relationship between a Pearson 5 random variable and a Gamma random variable.

The Pearson 5 distribution is useful for modeling time delays where some minimum delay value is almost assured and the maximum time is unbounded and variably long, such as time to complete a difficult task, time to respond to an emergency, time to repair a tool, etc. Similar space situations also exist such as manufacturing space for a given process (see Law & Kelton ¹).

The Pearson 5 distribution starts slowly near its minimum and has a peak slightly removed from it, as shown above. With decreasing $\alpha$, the peak gets flatter (see vertical scale) and the tail gets much broader.

Pearson 6 Distribution (min, beta, p, q)

\[ f(x) = \frac{(x - \text{min})^{p \cdot q}}{\beta \left[ 1 + \left( \frac{x - \text{min}}{\beta} \right)^{p \cdot q} \right]} \cdot B(pq) \]

\( x > \text{min} \)
\( \text{min} \in (-\infty, \infty) \)
\( \beta > 0 \)
\( p > 0 \)
\( q > 0 \)

Description

The Pearson 6 distribution is a continuous distribution bounded on the low side. The Pearson 6 distribution is sometimes called the Beta distribution of the second kind due to the relationship of a Pearson 6 random variable to a Beta random variable. When \( \text{min}=0, \beta=1, p=nu_1/2, q=nu_2/2 \), the Pearson 6 distribution reduces to the F distribution of \( nu_1, nu_2 \) which is used for many statistical tests of goodness of fit (see Johnson\(^1\)).
Like the Gamma distribution, it has three distinct regions. For $p=1$, the Pearson 6 distribution resembles the Exponential distribution, starting at a finite value at minimum $x$ and decreasing monotonically thereafter. For $p<1$, the Pearson 6 distribution tends to infinity at minimum $x$ and decreases monotonically for increasing $x$. For $p>1$, the Pearson 6 distribution is 0 at minimum $x$, peaks at a value that depends on both $p$ and $q$, decreasing monotonically thereafter.

The Pearson 6 distribution appears to have found little direct use, except in its reduced form as the F distribution where it serves as the distribution of the ratio of independent estimators of variance and provides the final test for the analysis of variance.

The three regions of the Pearson 6 distribution are shown above. Also note that the distribution becomes sharply peaked just off the minimum for increasing $q$.

---

**Poisson Distribution (lambda)**

\[ P(k; \lambda) = \frac{e^{-\lambda} \lambda^k}{k!} \]

\( \lambda = \) rate of occurrence

---

**Description**

The Poisson distribution is a discrete distribution bounded at 0 on the low side and unbounded on the high side. The Poisson distribution is a limiting form of the Hypergeometric distribution.

The Poisson distribution finds frequent use because it represents the infrequent occurrence of events whose rate is constant. This includes many types of events in time or space such as arrivals of telephone calls, defects in semiconductor manufacturing, defects in all aspects of quality control, molecular distributions, stellar distributions, geographical distributions of plants, shot noise, etc.. It is an important starting point in queuing theory and reliability theory.\(^1\) Note that the time between arrivals (defects) is Exponentially distributed, which makes this distribution a particularly convenient starting point even when the process is more complex.

The Poisson distribution peaks near \( \lambda \) and falls off rapidly on either side. Note that the probabilities are actually weights at each integer, but are represented by broader bars for visibility.

---

Power Function Distribution (min, max, alpha)

\[
f(x) = \frac{\alpha (x - \text{min})^{\alpha - 1}}{(\text{max} - \text{min})^\alpha}
\]

min = minimum value of x
max = maximum value of x
\(\alpha\) = shape parameter > 0

Description

The Power Function distribution is a continuous distribution that has both upper and lower finite bounds, and is a special case of the Beta distribution with \(q=1\). (see Johnson et al.\(^1\)) The Uniform distribution is a special case of the Power Function distribution with \(p=1\).

As can be seen from the examples above, the Power Function distribution can approach zero or infinity at its lower bound, but always has a finite value at its upper bound. Alpha controls the value at the lower bound as well as the shape.

---

Rayleigh Distribution (min, sigma)

\[ f(x) = \frac{(x - \text{min})}{\sigma^2} \exp\left(\frac{(x - \text{min})^2}{2\sigma^2}\right) \]

\text{min} = \text{minimum } x \\
\sigma = \text{scale parameter } > 0

Description

The Rayleigh distribution is a continuous distribution bounded on the lower side. It is a special case of the Weibull distribution with alpha = 2 and beta/sqrt(2) = \sigma. Because of the fixed shape parameter, the Rayleigh distribution does not change shape although it can be scaled.

The Rayleigh distribution is frequently used to represent lifetimes because its hazard rate increases linearly with time, e.g. the lifetime of vacuum tubes. This distribution also finds application in noise problems in communications. (see Johnson et al. and Shooman)

Triangular Distribution (min, max, mode)

\[
f(x) = \begin{cases} 
 \frac{2(x - \text{min})}{(\text{max} - \text{min})(\text{mode} - \text{min})} & \text{min} < x \leq \text{mode} \\
\frac{2(\text{max} - x)}{(\text{max} - \text{min})(\text{max} - \text{mode})} & \text{mode} < x \leq \text{max}
\end{cases}
\]

min < x ≤ mode
mode < x ≤ max

min = minimum x
max = maximum x
mode = most likely x

Description

The Triangular distribution is a continuous distribution bounded on both sides. The Triangular distribution is often used when no or little data is available; it is rarely an accurate representation of a data set (see Law & Kelton\(^1\)). However, it is employed as the functional form of regions for fuzzy logic due to its ease of use.

The Triangular distribution can take on very skewed forms, as shown above, including negative skewness. For the exceptional cases where the mode is either the min or max, the Triangular distribution becomes a right triangle.

Uniform Distribution (min, max)

\[ \frac{1}{\text{max} - \text{min}} \]

min = minimum x
max = maximum x

Description

The Uniform distribution is a continuous distribution bounded on both sides. Its density does not depend on the value of x. It is a special case of the Beta distribution. It is frequently called the rectangular distribution (see Johnson\(^1\)). Most random number generators provide samples from the Uniform distribution on (0,1) and then convert these samples to random variates from other distributions.

The Uniform distribution is used to represent a random variable with constant likelihood of being in any small interval between min and max. Note that the probability of either the min or max value is 0; the end points do NOT occur. If the end points are necessary, try the sum of two opposing right Triangular distributions.

---

Weibull Distribution (min, α, β)

\[
f_X(x; \min, \alpha, \beta) = \begin{cases} 
0 & \text{if } x < \min \\
\exp\left(-\left(\frac{x - \min}{\beta}\right)^\alpha\right) & \text{if } x \geq \min 
\end{cases}
\]

\(\min = \) minimum x
\(\alpha = \) shape parameter > 0
\(\beta = \) scale parameter > 0

Description

The Weibull distribution is a continuous distribution bounded on the lower side. Because it provides one of the limiting distributions for extreme values, it is also referred to as the Frechet distribution and the Weibull-Gnedenko distribution. Unfortunately, the Weibull distribution has been given various functional forms in the many engineering references; the form above is the standard form given in Johnson\(^1\).

Like the Gamma distribution, it has three distinct regions. For \(\alpha=1\), the Weibull distribution is reduced to the Exponential distribution, starting at a finite value at minimum x and decreasing monotonically thereafter. For \(\alpha<1\), the Weibull distribution tends to infinity at minimum x and decreases monotonically.

cally for increasing x. For $\alpha>1$, the Weibull distribution is 0 at minimum x, peaks at a value that depends on both $\alpha$ and $\beta$, decreasing monotonically thereafter. Uniquely, the Weibull distribution has negative skewness for $\alpha>3.6$.

The Weibull distribution can also be used to approximate the Normal distribution for $\alpha=3.6$, while maintaining its strictly positive values of x [actually (x-min)], although the kurtosis is slightly smaller than 3, the Normal value.

The Weibull distribution derived its popularity from its use to model the strength of materials, and has since been used to model just about everything. In particular, the Weibull distribution is used to represent wearout lifetimes in reliability, wind speed, rainfall intensity, health related issues, germination, duration of industrial stoppages, migratory systems, and thunderstorm data (see Johnson and Shooman).

1. ibid.

Weibull Distribution (min, alpha, beta)
Bibliography


“Continuous Univariate Distributions, Volume 1”, Norman L. Johnson, Samuel Kotz, N. Balakrishnan, 1994, John Wiley & Sons


“Introductory Statistical Analysis”, Donald L. Harnett, James L. Murphy, 1975, Addison-Wesley


“Seminumerical Algorithms, Volume 2” Donald E. Knuth, 1981, Addison-Wesley


“Univariate Discrete Distributions” Normal L. Johnson, Samuel Kotz, Adrienne W. Kemp, 1992, John Wiley & Sons

# Index

## A

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>absolute value</td>
<td>13</td>
</tr>
<tr>
<td>AD statistic</td>
<td>28, 29</td>
</tr>
<tr>
<td>analytical distributions</td>
<td>22, 25, 84</td>
</tr>
<tr>
<td>Anderson Darling test</td>
<td>25, 28, 29, 30</td>
</tr>
<tr>
<td>ascending cumulative</td>
<td>35</td>
</tr>
<tr>
<td>Auto</td>
<td>22, 31, 46</td>
</tr>
<tr>
<td>autocorrelation</td>
<td>20, 21, 33, 35</td>
</tr>
</tbody>
</table>

## B

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beta distribution</td>
<td>56, 57, 84, 87, 93</td>
</tr>
<tr>
<td>binned data</td>
<td>16, 19</td>
</tr>
<tr>
<td>Binomial distribution</td>
<td>58, 59, 84</td>
</tr>
<tr>
<td>Box Plot</td>
<td>38</td>
</tr>
</tbody>
</table>

## C

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chi Squared Distribution</td>
<td>60</td>
</tr>
<tr>
<td>chi squared test</td>
<td>25, 26, 27, 51</td>
</tr>
<tr>
<td>classes</td>
<td>11, 12, 16, 19, 25, 26, 30</td>
</tr>
<tr>
<td>comparison graph</td>
<td>26, 34, 37</td>
</tr>
<tr>
<td>continuous data</td>
<td>9, 11, 16, 19, 25, 26, 28</td>
</tr>
<tr>
<td>continuous distributions</td>
<td>11, 12, 22, 24, 25, 29, 31</td>
</tr>
<tr>
<td>cumulative distribution</td>
<td>19, 27, 28, 29, 35, 39, 52</td>
</tr>
</tbody>
</table>

## D

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Table</td>
<td>9, 50</td>
</tr>
<tr>
<td>density</td>
<td>35</td>
</tr>
<tr>
<td>descending cumulative</td>
<td>35</td>
</tr>
<tr>
<td>descriptive statistics</td>
<td>18, 50</td>
</tr>
<tr>
<td>difference graph</td>
<td>38, 52</td>
</tr>
<tr>
<td>discrete data</td>
<td>11, 12, 16, 25, 28</td>
</tr>
<tr>
<td>discrete distribution</td>
<td>11, 12, 19, 22, 29, 58, 62, 70, 82, 89</td>
</tr>
<tr>
<td>Discrete Uniform distribution</td>
<td>62</td>
</tr>
<tr>
<td>distribution fit</td>
<td>23, 51</td>
</tr>
<tr>
<td>Distribution Graph</td>
<td>38</td>
</tr>
<tr>
<td>distribution viewer</td>
<td>40</td>
</tr>
</tbody>
</table>

## E

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Erlang distribution</td>
<td>63, 68</td>
</tr>
<tr>
<td>Exponential distribution</td>
<td>63, 64, 65, 68, 78, 79, 85, 88, 94</td>
</tr>
<tr>
<td>Export</td>
<td>46</td>
</tr>
<tr>
<td>Export of Empirical Distributions</td>
<td>46</td>
</tr>
<tr>
<td>Extreme Value distribution</td>
<td>66</td>
</tr>
<tr>
<td>Extreme Value type 1B Distribution</td>
<td>67</td>
</tr>
</tbody>
</table>

## F

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>file output</td>
<td>46</td>
</tr>
<tr>
<td>filter</td>
<td>14</td>
</tr>
</tbody>
</table>
fit setup 23, 26, 27, 51
fonts 36, 37, 45
frequency 35

G

Gamma distribution 63, 68, 69, 78, 84, 86, 88, 94
generate 15, 29, 50
Geometric distribution 70, 82
goodness of fit 11, 22, 23, 25, 26, 27, 28, 29, 31, 51, 87
graph colors 37
graph scale 36
graph text 36
graphics 16, 33, 34, 35, 41, 46
graphics style 33, 34, 35

H

histogram 11, 16, 19, 26, 33, 34, 35, 37

I

independence tests 20
input data 16
input graph 16, 50
input options 11, 16, 19, 25
intervals 9, 11, 12, 16, 19, 25, 26, 27, 30
Inverse gaussian distribution 71
Inverse Weibull Distribution 72

J

Johnson SB Distribution 73
Johnson SU Distribution 75

K

Kolmogorov Smirnov test 25, 27, 29
kurtosis 95

L

level of significance 21, 24, 26, 27, 28, 29, 30
Logistic distribution 51, 77
Log-Logistic distribution 78
Lognormal distribution 80, 81
lower bound 29, 56, 84
Lower Bounds 11

M

manual data entry 6, 9
maximum likelihood 23, 24
maximum likelihood estimates 23, 31
mean 20, 21, 65, 77, 80
mode 92
moments 23, 24, 25

N

Negative Binomial distribution 82
Normal distribution 51, 52, 58, 69, 77, 79, 80, 84, 95
normalization 35

O

operate 12, 20
Pareto distribution 85
Pearson 5 distribution 86
Pearson 6 distribution 87, 88
Poisson distribution 89
Power Function Distribution 90
P-P Plot 39, 53
precision 11, 12
print 44, 45
printer set-up 45
p-value 28

Q-Q Plot 39, 52

random number stream 15
random variates 15, 46, 93
rank 31
Rayleigh Distribution 91
reciprocal 86
relative frequency 19, 26
Repopulate 14
report 44, 45
result graphs 25, 34, 52
runs test 21, 22

scatter plot 20, 21, 35, 51
Scott 12
skewness 24, 25, 64, 92, 95
standard deviation 21, 80, 84
statistics 16, 18, 19, 20, 21, 23, 26, 27, 50
Sturges 11, 25
Click on a link to visit the ProModel web site:

Manufacturing
Portfolio Planning
Pharmaceuticals
Healthcare
Logistics
Financial Services
Government
Business Reengineering

www.promodel.com
<table>
<thead>
<tr>
<th>Área total</th>
<th>Costo Total CIF</th>
<th>Centro de Coste</th>
</tr>
</thead>
<tbody>
<tr>
<td>212 m²</td>
<td>$ 1.000.000,00</td>
<td>Cerrajería y Soldadura</td>
</tr>
<tr>
<td>212 m²</td>
<td>$ 1.000.000,00</td>
<td>Corte, enchape y tratamiento de maderas</td>
</tr>
<tr>
<td>212 m²</td>
<td>$ 1.000.000,00</td>
<td>Costura y tapicería</td>
</tr>
<tr>
<td>212 m²</td>
<td>$ 1.000.000,00</td>
<td>Ensamble General y Terminado</td>
</tr>
</tbody>
</table>

**Total**
<table>
<thead>
<tr>
<th>Área centro de coste</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>41,6 m²</td>
<td>$ 196,226,42</td>
</tr>
<tr>
<td>59,6 m²</td>
<td>$ 281,132,08</td>
</tr>
<tr>
<td>28,8 m²</td>
<td>$ 135,849,06</td>
</tr>
<tr>
<td>26,3 m²</td>
<td>$ 124,056,60</td>
</tr>
<tr>
<td>212,43 m²</td>
<td>$ 737,264,15</td>
</tr>
<tr>
<td>Concepto</td>
<td>Costo Total CIF</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Acueducto y alcantarillado</td>
<td>$ 13.600,00</td>
</tr>
<tr>
<td>Recoleccion de Basuras</td>
<td>$ 13.600,00</td>
</tr>
<tr>
<td>Telefonía movil y fija</td>
<td>$ 184.800,00</td>
</tr>
<tr>
<td>Energía eléctrica</td>
<td>$ 30.118,00</td>
</tr>
<tr>
<td>Servicios Públicos*</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>---</td>
</tr>
<tr>
<td><strong>Centro de Coste</strong></td>
<td><strong>Inductor</strong></td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Cerrajería y Soldadura*</td>
<td>54.3 Kw-h X 465$/Kw-h</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas**</td>
<td>5.38 Kw-h X 465$/Kw-h</td>
</tr>
<tr>
<td>Costura y tapicería***</td>
<td>2.61 Kw-h X 465$/Kw-h</td>
</tr>
<tr>
<td>Ensamble General y Terminado****</td>
<td>2.48 Kw-h X 465$/Kw-h</td>
</tr>
<tr>
<td>Servicios Públicos*</td>
<td>$ 3.400,00</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>$ 3.400,00</td>
</tr>
<tr>
<td></td>
<td>$ 3.400,00</td>
</tr>
<tr>
<td></td>
<td>$ 3.400,00</td>
</tr>
<tr>
<td></td>
<td>$ 3.400,00</td>
</tr>
<tr>
<td></td>
<td>$ 46.200,00</td>
</tr>
<tr>
<td></td>
<td>$ 46.200,00</td>
</tr>
<tr>
<td></td>
<td>$ 46.200,00</td>
</tr>
<tr>
<td></td>
<td>$ 46.200,00</td>
</tr>
<tr>
<td></td>
<td>$ 25.250,00</td>
</tr>
<tr>
<td></td>
<td>$ 2.501,70</td>
</tr>
<tr>
<td></td>
<td>$ 1.213,65</td>
</tr>
<tr>
<td></td>
<td>$ 1.153,20</td>
</tr>
<tr>
<td>Concepto</td>
<td>Costo Total CIF</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Combustible</td>
<td>$ 500.000,00</td>
</tr>
<tr>
<td>Lubricante</td>
<td>$ 100.000,00</td>
</tr>
<tr>
<td>Llantas</td>
<td>$ 62.500,00</td>
</tr>
<tr>
<td>Alineacion</td>
<td>$ 6.666,67</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 669.166,67</strong></td>
</tr>
<tr>
<td>Combustible</td>
<td>$ 35.000,00</td>
</tr>
<tr>
<td>Lubricante</td>
<td>$ 10.000,00</td>
</tr>
<tr>
<td>Rodamiento</td>
<td>$ 21.666,67</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 66.666,67</strong></td>
</tr>
<tr>
<td>Peajes</td>
<td>$ 140.000,00</td>
</tr>
<tr>
<td>Parqueadero</td>
<td>$ 30.000,00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 170.000,00</strong></td>
</tr>
<tr>
<td>Combustible</td>
<td>$ 200.000,00</td>
</tr>
<tr>
<td>Lubricante</td>
<td>$ 45.000,00</td>
</tr>
<tr>
<td>Llantas</td>
<td>$ 33.333,33</td>
</tr>
<tr>
<td>Alineacion</td>
<td>$ 5.000,00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 283.333,33</strong></td>
</tr>
<tr>
<td>Seguro-Riesgo</td>
<td>$ 70.000,00</td>
</tr>
<tr>
<td>SOAT</td>
<td>$ 21.666,67</td>
</tr>
<tr>
<td>Vehículo 2(Kia Picanto 1100CC)</td>
<td>$ 3.333,33</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>$ 18.333,33</td>
</tr>
<tr>
<td></td>
<td><strong>$ 113.333,33</strong></td>
</tr>
<tr>
<td></td>
<td>$ 60.000,00</td>
</tr>
<tr>
<td></td>
<td>$ 60.000,00</td>
</tr>
<tr>
<td></td>
<td><strong>$ 120.000,00</strong></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Inductor</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, encape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, encape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, encape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, encape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, encape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Materiales</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamblaje General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Ensamblaje General y Terminado</td>
<td>n° de personas por área (3)</td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Descripcion CIF</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>Discos de corte</td>
</tr>
<tr>
<td></td>
<td>Rueda esmeril</td>
</tr>
<tr>
<td></td>
<td>Cilindro CO2</td>
</tr>
<tr>
<td></td>
<td>Alambre soldadura</td>
</tr>
<tr>
<td></td>
<td>Discos pulidores</td>
</tr>
<tr>
<td></td>
<td>Guantes de carnsa</td>
</tr>
<tr>
<td></td>
<td>Punta antorcha soldador</td>
</tr>
<tr>
<td></td>
<td>PL 285 madera</td>
</tr>
<tr>
<td></td>
<td>Colbon 20Kg</td>
</tr>
<tr>
<td></td>
<td>Grapas 1*1/2</td>
</tr>
<tr>
<td></td>
<td>Grapas 1”</td>
</tr>
<tr>
<td></td>
<td>Grapas 3/4</td>
</tr>
<tr>
<td></td>
<td>Grapa Gema 95/10</td>
</tr>
<tr>
<td></td>
<td>Mantenimiento disco de corte</td>
</tr>
<tr>
<td></td>
<td>Grapa 80/10</td>
</tr>
<tr>
<td></td>
<td>Grapa 95/10</td>
</tr>
<tr>
<td></td>
<td>Plastico Enchuspar</td>
</tr>
<tr>
<td></td>
<td>Pega Imperial</td>
</tr>
<tr>
<td></td>
<td>Carton de 1*1/2</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfín madera</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfín espuma</td>
</tr>
<tr>
<td></td>
<td>Hilo cono Grande</td>
</tr>
<tr>
<td></td>
<td>Aceite Telus</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray negro</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray cromo</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray blanco</td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
</tr>
<tr>
<td></td>
<td>Vinilo negro</td>
</tr>
<tr>
<td></td>
<td>Laca blanca</td>
</tr>
<tr>
<td></td>
<td>Laca negra</td>
</tr>
</tbody>
</table>

Materia prima indirecta

Costura y tapiceria

Ensamble General y Terminado

Corte, enchape y tratamiento de maderas
<table>
<thead>
<tr>
<th>Total consumo mes</th>
<th>Inductor</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo*</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 170.000,00</td>
<td>Tiempo</td>
<td>50</td>
<td>$ 231,48</td>
</tr>
<tr>
<td>$ 12.500,00</td>
<td>Tiempo</td>
<td>20</td>
<td>$ 6,81</td>
</tr>
<tr>
<td>$ 254.800,00</td>
<td>Tiempo</td>
<td>202</td>
<td>$ 1.401,68</td>
</tr>
<tr>
<td>$ 81.153,60</td>
<td>Tiempo</td>
<td>202</td>
<td>$ 446,43</td>
</tr>
<tr>
<td>$ 9.000,00</td>
<td>Tiempo</td>
<td>13</td>
<td>$ 3,19</td>
</tr>
<tr>
<td>$ 6.000,00</td>
<td>Tiempo</td>
<td>202</td>
<td>$ 33,01</td>
</tr>
<tr>
<td>$ 7.500,00</td>
<td>Tiempo</td>
<td>202</td>
<td>$ 41,26</td>
</tr>
<tr>
<td>$ 1.256.864,00</td>
<td>Tiempo</td>
<td>430</td>
<td>$ 14.718,18</td>
</tr>
<tr>
<td>$ 35.000,00</td>
<td>Tiempo</td>
<td>510</td>
<td>$ 486,11</td>
</tr>
<tr>
<td>$ 27.500,00</td>
<td>Tiempo</td>
<td>128</td>
<td>$ 95,49</td>
</tr>
<tr>
<td>$ 38.000,00</td>
<td>Tiempo</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td>$ 38.000,00</td>
<td>Tiempo</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td>$ 3.750,00</td>
<td>Tiempo</td>
<td>128</td>
<td>$ 13,02</td>
</tr>
<tr>
<td>$ 6.000,00</td>
<td>Tiempo</td>
<td>235</td>
<td>$ 38,40</td>
</tr>
<tr>
<td>$ 84.000,00</td>
<td>Tiempo</td>
<td>83</td>
<td>$ 188,73</td>
</tr>
<tr>
<td>$ 6.500,00</td>
<td>Tiempo</td>
<td>83</td>
<td>$ 14,00</td>
</tr>
<tr>
<td>$ 50.000,00</td>
<td>Tiempo</td>
<td>23</td>
<td>$ 31,32</td>
</tr>
<tr>
<td>$ 612.401,12</td>
<td>Tiempo</td>
<td>95</td>
<td>$ 1.584,37</td>
</tr>
<tr>
<td>$ 230.000,00</td>
<td>Tiempo</td>
<td>40</td>
<td>$ 250,54</td>
</tr>
<tr>
<td>$ 58.050,00</td>
<td>Tiempo</td>
<td>53</td>
<td>$ 83,79</td>
</tr>
<tr>
<td>$ 43.200,00</td>
<td>Tiempo</td>
<td>39</td>
<td>$ 45,88</td>
</tr>
<tr>
<td>$ 9.000,00</td>
<td>Tiempo</td>
<td>125</td>
<td>$ 30,64</td>
</tr>
<tr>
<td>$ 9.250,00</td>
<td>Tiempo</td>
<td>125</td>
<td>$ 31,49</td>
</tr>
<tr>
<td>$ 20.000,00</td>
<td>Tiempo</td>
<td>20</td>
<td>$ 10,89</td>
</tr>
<tr>
<td>$ 19.500,00</td>
<td>Tiempo</td>
<td>13</td>
<td>$ 6,90</td>
</tr>
<tr>
<td>$ 8.000,00</td>
<td>Tiempo</td>
<td>7</td>
<td>$ 1,53</td>
</tr>
<tr>
<td>$ 9.000,00</td>
<td>Tiempo</td>
<td>82</td>
<td>$ 20,10</td>
</tr>
<tr>
<td>$ 144.000,00</td>
<td>Tiempo</td>
<td>82</td>
<td>$ 321,57</td>
</tr>
<tr>
<td>$ 65.000,00</td>
<td>Tiempo</td>
<td>82</td>
<td>$ 145,15</td>
</tr>
<tr>
<td>$ 64.000,00</td>
<td>Tiempo</td>
<td>82</td>
<td>$ 142,92</td>
</tr>
<tr>
<td>$ 240.000,00</td>
<td>Tiempo</td>
<td>82</td>
<td>$ 535,95</td>
</tr>
<tr>
<td>$ 80.000,00</td>
<td>Tiempo</td>
<td>82</td>
<td>$ 178,65</td>
</tr>
<tr>
<td>Concepto</td>
<td>Costo Total CIF</td>
<td>Centro de Coste</td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Bomberos</td>
<td>$ 8.666,67</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>IVA</td>
<td>$ 338.250,00</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Industria y Comercio</td>
<td>$ 57.416,67</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Renovación Cámara de Comercio</td>
<td>$ 39.333,33</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Arrendamiento</td>
<td>$ 264.764,00</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Acueducto</td>
<td>$ 3.400,00</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Recolección de basuras</td>
<td>$ 3.400,00</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Telefonía</td>
<td>$ 46.200,00</td>
<td>Cerrajería y Soldadura</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura y tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Servicio</td>
<td>Costo</td>
<td>Detalles</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Energía eléctrica</td>
<td>$ 24.860,00</td>
<td>Cerrajería y Soldadura, Corte, enchape y tratamiento de maderas, Costura y tapicería, Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Salarios administrativos</td>
<td>$ 3.400.000,00</td>
<td>Cerrajería y Soldadura, Corte, enchape y tratamiento de maderas, Costura y tapicería, Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Depreciación</td>
<td>$ 750.000,00</td>
<td>Cerrajería y Soldadura, Corte, enchape y tratamiento de maderas, Costura y tapicería, Ensamble General y Terminado</td>
<td></td>
</tr>
<tr>
<td>Inductor</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 2.166,67</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 2.166,67</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 2.166,67</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 8.456.250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 8.456.250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 8.456.250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 14.354,17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 14.354,17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 14.354,17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 9.833,33</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 9.833,33</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 9.833,33</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 66.191,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 66.191,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 66.191,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 11.550,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 11.550,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 11.550,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 6.215,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 6.215,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 6.215,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 6.215,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850.000,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850.000,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850.000,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 850.000,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 187.500,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 187.500,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N° de personas por área</td>
<td>$ 187.500,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Arrendamiento</td>
<td>Acueducto</td>
<td>Recolección de basuras</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>$ 187,03</td>
<td>$ 3,24</td>
<td>$ 3,24</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>$ 314,47</td>
<td>$ 7,87</td>
<td>$ 7,87</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>$ 40,54</td>
<td>$ 1,11</td>
<td>$ 1,11</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 542,04</strong></td>
<td><strong>$ 12,22</strong></td>
<td><strong>$ 12,22</strong></td>
</tr>
</tbody>
</table>

*El valor del costo hace referencia a 36720 min (204 horas hábiles*60min/hora*3 colaboradores)*

**Materia prima indirecta**

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripción CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajería y Soldadura</td>
<td>Discos de corte</td>
<td>50</td>
<td>$ 231,48</td>
</tr>
<tr>
<td></td>
<td>Rueda esmeril</td>
<td>20</td>
<td>$ 6,81</td>
</tr>
<tr>
<td></td>
<td>Cilindro CO2</td>
<td>202</td>
<td>$ 1,401,68</td>
</tr>
<tr>
<td></td>
<td>Alambre soldadura</td>
<td>202</td>
<td>$ 446,43</td>
</tr>
<tr>
<td></td>
<td>Discos pulidores</td>
<td>13</td>
<td>$ 3,19</td>
</tr>
<tr>
<td></td>
<td>Guantes de carnasa</td>
<td>202</td>
<td>$ 33,01</td>
</tr>
<tr>
<td></td>
<td>Punta antorcha soldador</td>
<td>202</td>
<td>$ 41,26</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>Grapa 80/10</td>
<td>83</td>
<td>$ 188,73</td>
</tr>
<tr>
<td></td>
<td>Grapa 95/10</td>
<td>83</td>
<td>$ 14,60</td>
</tr>
<tr>
<td></td>
<td>Plastico Enchuspar</td>
<td>23</td>
<td>$ 31,32</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfin madera</td>
<td>53</td>
<td>$ 1,584,37</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfin espuma</td>
<td>39</td>
<td>$ 250,54</td>
</tr>
<tr>
<td></td>
<td>Pega Imperial</td>
<td>95</td>
<td>$ 83,79</td>
</tr>
<tr>
<td></td>
<td>Carton de 1*1/2</td>
<td>40</td>
<td>$ 45,88</td>
</tr>
<tr>
<td></td>
<td>Hilo cono Grande</td>
<td>125</td>
<td>$ 30,64</td>
</tr>
<tr>
<td></td>
<td>Aceite Telus</td>
<td>125</td>
<td>$ 31,49</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------</td>
<td>----</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>Vinilo negro</td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>Laca blanca</td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>Laca negra</td>
<td>82</td>
<td>$</td>
</tr>
</tbody>
</table>

**TOTAL**
<table>
<thead>
<tr>
<th>Telefonia movil y fija</th>
<th>Energía electrica</th>
<th>Transporte</th>
<th>Gastos administrativos</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 44,04</td>
<td>$ 1.594,74</td>
<td>$ 338,97</td>
<td>$ 1.176,27</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 106,94</td>
<td>$ 202,91</td>
<td>$ 823,21</td>
<td>$ 2.856,65</td>
</tr>
<tr>
<td>$ 15,10</td>
<td>$ 40,36</td>
<td>$ 116,22</td>
<td>$ 403,29</td>
</tr>
<tr>
<td>$ 166,08</td>
<td>$ 1.838,01</td>
<td>$ 1.278,39</td>
<td>$ 4.436,21</td>
</tr>
</tbody>
</table>

Costo total prorrateado

<p>| $ 13,89 |
| $ 1,70  |
| $ 69,39 |
| $ 22,10 |
| $ -     |
| $ 1,63  |
| $ 2,04  |
| $ 17,16 |
| $ 1,33  |
| $ 4,08  |
| $ 298,94|
| $ 44,97 |
| $ 13,23 |
| $ -     |
| $ 3,68  |
| $ 3,78  |</p>
<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Arrendamiento</th>
<th>Acueducto</th>
<th>Recoleccion de basuras</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 995,29</td>
<td>$ 12,04</td>
<td>$ 12,04</td>
</tr>
<tr>
<td>Costura y tapiceria</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>$ 118,25</td>
<td>$ 3,24</td>
<td>$ 3,24</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 1.113,54</strong></td>
<td><strong>$ 15,28</strong></td>
<td><strong>$ 15,28</strong></td>
</tr>
</tbody>
</table>

### Materia prima indirecta

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripcion CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>PL 285 madera</td>
<td>430</td>
<td>$ 14.718,18</td>
</tr>
<tr>
<td></td>
<td>Colbon 20Kg</td>
<td>510</td>
<td>$ 486,11</td>
</tr>
<tr>
<td></td>
<td>Grapas 1*1/2</td>
<td>128</td>
<td>$ 95,49</td>
</tr>
<tr>
<td></td>
<td>Grapas 1¨</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td></td>
<td>Grapas 3/4</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td></td>
<td>Grapa Gema 95/10</td>
<td>128</td>
<td>$ 13,02</td>
</tr>
<tr>
<td></td>
<td>Mantenimiento disco de corte</td>
<td>235</td>
<td>$ 38,40</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$ 10,89</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$ 6,90</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$ 1,53</td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
<td>82</td>
<td>$ 20,10</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$ 321,57</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
<td>82</td>
<td>$ 145,15</td>
</tr>
<tr>
<td>Material</td>
<td>Cantidad</td>
<td>Precio</td>
<td>Total</td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Vinilo negro</td>
<td>82</td>
<td>$142,92</td>
<td></td>
</tr>
<tr>
<td>Laca blanca</td>
<td>82</td>
<td>$535,95</td>
<td></td>
</tr>
<tr>
<td>Laca negra</td>
<td>82</td>
<td>$178,65</td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td></td>
<td></td>
<td><strong>$51,52</strong></td>
</tr>
<tr>
<td>Telefonia movil y fija</td>
<td>Energía electrica</td>
<td>Transporte</td>
<td>Gastos Administrativos</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------</td>
<td>------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 163,56</td>
<td>$ 212,85</td>
<td>$ 1.259,02</td>
<td>$ 4.368,99</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 44,04</td>
<td>$ 57,65</td>
<td>$ 338,97</td>
<td>$ 1.176,27</td>
</tr>
<tr>
<td>$ 207,60</td>
<td>$ 270,50</td>
<td>$ 1.597,98</td>
<td>$ 5.545,26</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo total prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 1.540,27</td>
</tr>
<tr>
<td>$ 28,59</td>
</tr>
<tr>
<td>$ 5,62</td>
</tr>
<tr>
<td>$ 7,76</td>
</tr>
<tr>
<td>$ 7,76</td>
</tr>
<tr>
<td>$ 0,77</td>
</tr>
<tr>
<td>$ 3,27</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ 4,90</td>
</tr>
<tr>
<td>$ 78,43</td>
</tr>
<tr>
<td>$ 35,40</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>$ 34,86</td>
</tr>
<tr>
<td>$ 130,72</td>
</tr>
<tr>
<td>$ 43,57</td>
</tr>
<tr>
<td>$ 1,921,93</td>
</tr>
<tr>
<td>Centro de Coste</td>
</tr>
<tr>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
</tr>
<tr>
<td>Costura y tapiceria</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
</tr>
<tr>
<td><strong>Total</strong></td>
</tr>
</tbody>
</table>

**Materia prima indirecta**

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripcion CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorateo productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>Discos de corte</td>
<td>50</td>
<td>$ 231,48</td>
</tr>
<tr>
<td></td>
<td>Rueda esmeril</td>
<td>20</td>
<td>$ 6,81</td>
</tr>
<tr>
<td></td>
<td>Cilindro CO2</td>
<td>202</td>
<td>$ 1,401,68</td>
</tr>
<tr>
<td></td>
<td>Alambre soldadura</td>
<td>202</td>
<td>$ 446,43</td>
</tr>
<tr>
<td></td>
<td>Discos pulidores</td>
<td>13</td>
<td>$ 3,19</td>
</tr>
<tr>
<td></td>
<td>Guantes de carnasa</td>
<td>202</td>
<td>$ 33,01</td>
</tr>
<tr>
<td></td>
<td>Punta antorcha soldador</td>
<td>202</td>
<td>$ 41,26</td>
</tr>
<tr>
<td>Costura y tapiceria</td>
<td>Grapa 80/10</td>
<td>83</td>
<td>$ 188,73</td>
</tr>
<tr>
<td></td>
<td>Grapa 95/10</td>
<td>83</td>
<td>$ 14,60</td>
</tr>
<tr>
<td></td>
<td>Plastico Enchuspar</td>
<td>23</td>
<td>$ 31,32</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfin madera</td>
<td>53</td>
<td>$ 1,584,37</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfin espuma</td>
<td>39</td>
<td>$ 250,54</td>
</tr>
<tr>
<td></td>
<td>Pega Imperial</td>
<td>95</td>
<td>$ 83,79</td>
</tr>
<tr>
<td></td>
<td>Carton de 1*1/2</td>
<td>40</td>
<td>$ 45,88</td>
</tr>
<tr>
<td></td>
<td>Hilo cono Grande</td>
<td>125</td>
<td>$ 30,64</td>
</tr>
<tr>
<td></td>
<td>Aceite Telus</td>
<td>125</td>
<td>$ 31,49</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$ 10,89</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------</td>
<td>----</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$ 6,90</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$ 1,53</td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
<td>82</td>
<td>$ 20,10</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$ 321,57</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
<td>82</td>
<td>$ 145,15</td>
</tr>
<tr>
<td></td>
<td>Vinilo negro</td>
<td>82</td>
<td>$ 142,92</td>
</tr>
<tr>
<td></td>
<td>Laca blanca</td>
<td>82</td>
<td>$ 535,95</td>
</tr>
<tr>
<td></td>
<td>Laca negra</td>
<td>82</td>
<td>$ 178,65</td>
</tr>
<tr>
<td></td>
<td><strong>TOTAL</strong></td>
<td></td>
<td><strong>$ 871,75</strong></td>
</tr>
<tr>
<td>Telefonia movil y fija</td>
<td>Energía electrica</td>
<td>Transporte</td>
<td>Gastos administrativos</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------</td>
<td>------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>$ 119,53</td>
<td>$ 4.429,82</td>
<td>$ 920,05</td>
<td>$ 3.192,73</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 186,21</td>
<td>$ 229,59</td>
<td>$ 1.433,35</td>
<td>$ 4.973,93</td>
</tr>
<tr>
<td>$ 50,33</td>
<td>$ 115,30</td>
<td>$ 387,39</td>
<td>$ 1.344,31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo total prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
</tr>
<tr>
<td>$ 23,15</td>
</tr>
<tr>
<td>$ 1,70</td>
</tr>
<tr>
<td>$ 277,56</td>
</tr>
<tr>
<td>$ 88,40</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ 6,54</td>
</tr>
<tr>
<td>$ 8,17</td>
</tr>
<tr>
<td>$ 68,63</td>
</tr>
<tr>
<td>$ 5,31</td>
</tr>
<tr>
<td>$ 6,81</td>
</tr>
<tr>
<td>$ 298,94</td>
</tr>
<tr>
<td>$ 32,12</td>
</tr>
<tr>
<td>$ 17,64</td>
</tr>
<tr>
<td>$ 17,21</td>
</tr>
<tr>
<td>$ 6,13</td>
</tr>
<tr>
<td>$ 6,30</td>
</tr>
<tr>
<td>Centro de Coste</td>
</tr>
<tr>
<td>----------------------------------------</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Costura y tapiceria</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

### Materia prima indirecta

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripcion CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrteo productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PL 285 madera</td>
<td>430</td>
<td>$ 14,718,18</td>
</tr>
<tr>
<td></td>
<td>Colbon 20Kg</td>
<td>510</td>
<td>$ 486,11</td>
</tr>
<tr>
<td></td>
<td>Grapas 1*1/2</td>
<td>128</td>
<td>$ 95,49</td>
</tr>
<tr>
<td></td>
<td>Grapas 1¨</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td></td>
<td>Grapas 3/4</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td></td>
<td>Grapa Gema 95/10</td>
<td>128</td>
<td>$ 13,02</td>
</tr>
<tr>
<td></td>
<td>Mantenimiento disco de corte</td>
<td>235</td>
<td>$ 38,40</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray</td>
<td>20</td>
<td>$ 10,89</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray</td>
<td>13</td>
<td>$ 6,90</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray</td>
<td>7</td>
<td>$ 1,53</td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
<td>82</td>
<td>$ 20,10</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$ 321,57</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
<td>82</td>
<td>$ 145,15</td>
</tr>
<tr>
<td></td>
<td>Vinilo negro</td>
<td>82</td>
<td>$ 142,92</td>
</tr>
<tr>
<td></td>
<td>Laca blanca</td>
<td>82</td>
<td>$ 535,95</td>
</tr>
<tr>
<td></td>
<td>Laca negra</td>
<td>82</td>
<td>$ 178,65</td>
</tr>
</tbody>
</table>
TOTAL
<table>
<thead>
<tr>
<th>Telefonía móvil y fija</th>
<th>Energía eléctrica</th>
<th>Transporte</th>
<th>Gastos administrativos</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 342,22</td>
<td>$ 638,55</td>
<td>$ 2.634,25</td>
<td>$ 9.141,28</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 50,33</td>
<td>$ 86,48</td>
<td>$ 145,27</td>
<td>$ 504,11</td>
</tr>
<tr>
<td>$ 392,55</td>
<td>$ 725,03</td>
<td>$ 2.779,52</td>
<td>$ 9.645,39</td>
</tr>
</tbody>
</table>

**Costo total prorrateado**

<table>
<thead>
<tr>
<th></th>
<th>$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>2.567,12</td>
</tr>
<tr>
<td>$</td>
<td>85,78</td>
</tr>
<tr>
<td>$</td>
<td>16,85</td>
</tr>
<tr>
<td>$</td>
<td>23,28</td>
</tr>
<tr>
<td>$</td>
<td>23,28</td>
</tr>
<tr>
<td>$</td>
<td>2,30</td>
</tr>
<tr>
<td></td>
<td>9,80</td>
</tr>
<tr>
<td>$</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td>$</td>
<td>4,90</td>
</tr>
<tr>
<td></td>
<td>78,43</td>
</tr>
<tr>
<td>$</td>
<td>35,40</td>
</tr>
<tr>
<td>$</td>
<td>34,86</td>
</tr>
<tr>
<td></td>
<td>130,72</td>
</tr>
<tr>
<td></td>
<td>43,57</td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Arrendamiento</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>$ 304,60</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>Costura y tapicería</td>
<td>$ 255,27</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>$ 175,68</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 735,55</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripción CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo</th>
<th>Costo total prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cerrajería y Soldadura</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discos de corte</td>
<td>50</td>
<td>$ 231,48</td>
<td>$ 23,15</td>
<td></td>
</tr>
<tr>
<td>Rueda esmeril</td>
<td>20</td>
<td>$ 6,81</td>
<td>$ 1,70</td>
<td></td>
</tr>
<tr>
<td>Cilindro CO2</td>
<td>202</td>
<td>$ 1,401,68</td>
<td>$ 117,96</td>
<td></td>
</tr>
<tr>
<td>Alambre soldadura</td>
<td>202</td>
<td>$ 446,43</td>
<td>$ 37,57</td>
<td></td>
</tr>
<tr>
<td>Discos pulidores</td>
<td>13</td>
<td>$ 3,19</td>
<td>$ -</td>
<td></td>
</tr>
<tr>
<td>Guantes de carnaisa</td>
<td>202</td>
<td>$ 33,01</td>
<td>$ 2,78</td>
<td></td>
</tr>
<tr>
<td>Punta antorcha soldador</td>
<td>202</td>
<td>$ 41,26</td>
<td>$ 3,47</td>
<td></td>
</tr>
<tr>
<td><strong>Costura y tapicería</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grapa 80/10</td>
<td>83</td>
<td>$ 188,73</td>
<td>$ 11,44</td>
<td></td>
</tr>
<tr>
<td>Grapa 95/10</td>
<td>83</td>
<td>$ 14,60</td>
<td>$ 0,89</td>
<td></td>
</tr>
<tr>
<td>Plástico Enchuspar</td>
<td>23</td>
<td>$ 31,32</td>
<td>$ 6,81</td>
<td></td>
</tr>
<tr>
<td>Cinta sínfin madera</td>
<td>53</td>
<td>$ 1,584,37</td>
<td>$ 298,94</td>
<td></td>
</tr>
<tr>
<td>Cinta sínfin espuma</td>
<td>39</td>
<td>$ 250,54</td>
<td>$ 44,97</td>
<td></td>
</tr>
<tr>
<td>Pega Imperial</td>
<td>95</td>
<td>$ 83,79</td>
<td>$ 17,64</td>
<td></td>
</tr>
<tr>
<td>Cartón de 1*1/2</td>
<td>40</td>
<td>$ 45,88</td>
<td>$ -</td>
<td></td>
</tr>
<tr>
<td>Hilo cono Grande</td>
<td>125</td>
<td>$ 30,64</td>
<td>$ 3,68</td>
<td></td>
</tr>
<tr>
<td>Aceite Telus</td>
<td>125</td>
<td>$ 31,49</td>
<td>$ 3,78</td>
<td></td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$</td>
<td>10,89</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------</td>
<td>----</td>
<td>----</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$</td>
<td>6,90</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$</td>
<td>1,53</td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
<td>82</td>
<td>$</td>
<td>20,10</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$</td>
<td>321,57</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
<td>82</td>
<td>$</td>
<td>145,15</td>
</tr>
<tr>
<td></td>
<td>Vinilo negro</td>
<td>82</td>
<td>$</td>
<td>142,92</td>
</tr>
<tr>
<td></td>
<td>Laca blanca</td>
<td>82</td>
<td>$</td>
<td>535,95</td>
</tr>
<tr>
<td></td>
<td>Laca negra</td>
<td>82</td>
<td>$</td>
<td>178,65</td>
</tr>
<tr>
<td></td>
<td><strong>TOTAL</strong></td>
<td></td>
<td>$</td>
<td>578,58</td>
</tr>
<tr>
<td>Energía electrica</td>
<td>Transporte</td>
<td>Gastos administrativos</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
<td>------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 2.392,11</td>
<td>$ 552,03</td>
<td>$ 1.915,64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 114,79</td>
<td>$ 668,25</td>
<td>$ 2.318,93</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 230,60</td>
<td>$ 503,61</td>
<td>$ 1.747,60</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>$ 2.737,50</strong></td>
<td><strong>$ 1.723,89</strong></td>
<td><strong>$ 5.982,16</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Arrendamiento</td>
<td>Acueducto</td>
<td>Recoleccion de basuras</td>
<td>Telefonia movil y fija</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>$ 448,88</td>
<td>$ 7,78</td>
<td>$ 7,78</td>
<td>$ 105,69</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 459,37</td>
<td>$ 5,56</td>
<td>$ 5,56</td>
<td>$ 75,49</td>
</tr>
<tr>
<td>Costura y tapiceria</td>
<td>$ 614,13</td>
<td>$ 15,37</td>
<td>$ 15,37</td>
<td>$ 208,86</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>$ 185,81</td>
<td>$ 5,09</td>
<td>$ 5,09</td>
<td>$ 69,20</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 1.708,19</strong></td>
<td><strong>$ 33,80</strong></td>
<td><strong>$ 33,80</strong></td>
<td><strong>$ 459,23</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Materia prima indirecta</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Centro de Coste</strong></td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Costura y tapiceria</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Item</td>
</tr>
<tr>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Pintura en Spray negro</td>
</tr>
<tr>
<td>Pintura en Spray cromo</td>
</tr>
<tr>
<td>Pintura en Spray blanco</td>
</tr>
<tr>
<td>Gasolina</td>
</tr>
<tr>
<td>Disolvente (Thinner)</td>
</tr>
<tr>
<td>Vinilo blanco</td>
</tr>
<tr>
<td>Vinilo negro</td>
</tr>
<tr>
<td>Laca blanca</td>
</tr>
<tr>
<td>Laca negra</td>
</tr>
<tr>
<td>PL 285 madera</td>
</tr>
<tr>
<td>Colbon 20Kg</td>
</tr>
<tr>
<td>Grapas 1*1/2</td>
</tr>
<tr>
<td>Grapas 1&quot;</td>
</tr>
<tr>
<td>Grapas 3/4</td>
</tr>
<tr>
<td>Grapa Gema 95/10</td>
</tr>
<tr>
<td>Mantenimiento disco de corte</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
</tr>
<tr>
<td>Energía electrica</td>
</tr>
<tr>
<td>------------------</td>
</tr>
<tr>
<td>$ 4.607,02</td>
</tr>
<tr>
<td>$ 53,21</td>
</tr>
<tr>
<td>$ 114,79</td>
</tr>
<tr>
<td>$ 230,60</td>
</tr>
<tr>
<td>$ 5.005,63</td>
</tr>
<tr>
<td>Centro de Coste</td>
</tr>
<tr>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
</tr>
<tr>
<td>Costura y tapicería</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
</tr>
<tr>
<td><strong>Total</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripción CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo</th>
<th>Costo total prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajería y Soldadura</td>
<td>Discos de corte</td>
<td>50</td>
<td>$ 231,48</td>
<td>$ 23,15</td>
</tr>
<tr>
<td></td>
<td>Rueda esmeril</td>
<td>20</td>
<td>$ 6,81</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Cilindro CO2</td>
<td>202</td>
<td>$ 1.401,68</td>
<td>$ 138,78</td>
</tr>
<tr>
<td></td>
<td>Alambre soldadura</td>
<td>202</td>
<td>$ 446,43</td>
<td>$ 44,20</td>
</tr>
<tr>
<td></td>
<td>Discos pulidores</td>
<td>13</td>
<td>$ 3,19</td>
<td>$ 1,23</td>
</tr>
<tr>
<td></td>
<td>Guantes de carnasa</td>
<td>202</td>
<td>$ 33,01</td>
<td>$ 3,27</td>
</tr>
<tr>
<td></td>
<td>Punta antorcha soldador</td>
<td>202</td>
<td>$ 41,26</td>
<td>$ 4,08</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$ 10,89</td>
<td>$ 1,63</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$ 6,90</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$ 1,53</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
<td>82</td>
<td>$ 20,10</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$ 321,57</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
<td>82</td>
<td>$ 145,15</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Vinilo negro</td>
<td>82</td>
<td>$ 142,92</td>
<td>-</td>
</tr>
<tr>
<td>Laca blanca</td>
<td>82</td>
<td>$</td>
<td>535,95</td>
<td>$</td>
</tr>
<tr>
<td>-------------</td>
<td>-----</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Laca negra</td>
<td>82</td>
<td>$</td>
<td>178,65</td>
<td>$</td>
</tr>
<tr>
<td>TOTAL</td>
<td></td>
<td>$</td>
<td>216,34</td>
<td>$</td>
</tr>
<tr>
<td>Energía eléctrica</td>
<td>Transporte</td>
<td>Gastos administrativos</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
<td>------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 2.657,89</td>
<td>$ 513,29</td>
<td>$ 1.781,21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 17,30</td>
<td>$ 87,16</td>
<td>$ 302,47</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 2.675,19</td>
<td>$ 600,45</td>
<td>$ 2.083,67</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Arrendamiento</td>
<td>Acueducto</td>
<td>Recolección de basuras</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>------------------------</td>
<td></td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td></td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 2.717,92</td>
<td>$ 32,87</td>
<td>$ 32,87</td>
<td></td>
</tr>
<tr>
<td>Costura y tapiceria</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td></td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>$ 77,70</td>
<td>$ 2,13</td>
<td>$ 2,13</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$ 2.795,62</strong></td>
<td><strong>$ 35,00</strong></td>
<td><strong>$ 35,00</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Materia prima indirecta**

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripcion CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Corte, enchape y tratamiento de maderas</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PL 285 madera</td>
<td>430</td>
<td>$</td>
<td>14.718,18</td>
</tr>
<tr>
<td>Colbon 20Kg</td>
<td>510</td>
<td>$</td>
<td>486,11</td>
</tr>
<tr>
<td>Grapas 1*1/2</td>
<td>128</td>
<td>$</td>
<td>95,49</td>
</tr>
<tr>
<td>Grapas 1&quot;</td>
<td>128</td>
<td>$</td>
<td>131,94</td>
</tr>
<tr>
<td>Grapas 3/4</td>
<td>128</td>
<td>$</td>
<td>131,94</td>
</tr>
<tr>
<td>Grapa Gema 95/10</td>
<td>128</td>
<td>$</td>
<td>13,02</td>
</tr>
<tr>
<td>Mantenimiento disco de corte</td>
<td>235</td>
<td>$</td>
<td>38,40</td>
</tr>
<tr>
<td><strong>Ensamble General y Terminado</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$</td>
<td>10,89</td>
</tr>
<tr>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$</td>
<td>6,90</td>
</tr>
<tr>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$</td>
<td>1,53</td>
</tr>
<tr>
<td>Gasolina</td>
<td>82</td>
<td>$</td>
<td>20,10</td>
</tr>
<tr>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$</td>
<td>321,57</td>
</tr>
<tr>
<td>Vinilo blanco</td>
<td>82</td>
<td>$</td>
<td>145,15</td>
</tr>
<tr>
<td>Material</td>
<td>Cantidad</td>
<td>Precio</td>
<td>Total</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Vinilo negro</td>
<td>82</td>
<td>$</td>
<td>142,92</td>
</tr>
<tr>
<td>Laca blanca</td>
<td>82</td>
<td>$</td>
<td>535,95</td>
</tr>
<tr>
<td>Laca negra</td>
<td>82</td>
<td>$</td>
<td>178,65</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td></td>
<td></td>
<td>397,57</td>
</tr>
</tbody>
</table>
### Telefonia movil y fija

<table>
<thead>
<tr>
<th></th>
<th>Energía electrica</th>
<th>Transporte</th>
<th>Gastos administrativos</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 446,65</td>
<td>$ 638,55</td>
<td>$ 3438,09</td>
<td>$ 11930,71</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 28,94</td>
<td>$ 86,48</td>
<td>$ 222,75</td>
<td>$ 772,98</td>
</tr>
<tr>
<td>$ 475,59</td>
<td>$ 725,03</td>
<td>$ 3660,84</td>
<td>$ 12703,69</td>
</tr>
</tbody>
</table>

### Costo total prorrateado

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 4107,40</td>
</tr>
<tr>
<td>$ 114,38</td>
</tr>
<tr>
<td>$ 22,47</td>
</tr>
<tr>
<td>$ 31,05</td>
</tr>
<tr>
<td>$ 31,05</td>
</tr>
<tr>
<td>$ 31,05</td>
</tr>
<tr>
<td>$ 30,06</td>
</tr>
<tr>
<td>$ 9,80</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ 0,61</td>
</tr>
<tr>
<td>$ 9,80</td>
</tr>
<tr>
<td>$ 4,43</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>Centro de Coste</td>
</tr>
<tr>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
</tr>
<tr>
<td>Costura y tapicería</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
</tr>
<tr>
<td><strong>Total</strong></td>
</tr>
</tbody>
</table>

### Materia prima indirecta

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripción CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PL 285 madera</td>
<td>430</td>
<td>$ 14.718,18</td>
<td></td>
</tr>
<tr>
<td>Colbon 20Kg</td>
<td>510</td>
<td>$ 486,11</td>
<td></td>
</tr>
<tr>
<td>Grapas 1*1/2</td>
<td>128</td>
<td>$ 95,49</td>
<td></td>
</tr>
<tr>
<td>Grapas 1&quot;</td>
<td>128</td>
<td>$ 131,94</td>
<td></td>
</tr>
<tr>
<td>Grapas 3/4</td>
<td>128</td>
<td>$ 131,94</td>
<td></td>
</tr>
<tr>
<td>Grapa Gema 95/10</td>
<td>128</td>
<td>$ 13,02</td>
<td></td>
</tr>
<tr>
<td>Mantenimiento disco de corte</td>
<td>235</td>
<td>$ 38,40</td>
<td></td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$ 10,89</td>
<td></td>
</tr>
<tr>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$ 6,90</td>
<td></td>
</tr>
<tr>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$ 1,53</td>
<td></td>
</tr>
<tr>
<td>Gasolina</td>
<td>82</td>
<td>$ 20,10</td>
<td></td>
</tr>
<tr>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$ 321,57</td>
<td></td>
</tr>
<tr>
<td>Vinilo blanco</td>
<td>82</td>
<td>$ 145,15</td>
<td></td>
</tr>
<tr>
<td>Vinilo negro</td>
<td>82</td>
<td>$ 142,92</td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td>Cantidad</td>
<td>Precio</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>Laca blanca</td>
<td>82</td>
<td>$ 535,95</td>
<td></td>
</tr>
<tr>
<td>Laca negra</td>
<td>82</td>
<td>$ 178,65</td>
<td></td>
</tr>
<tr>
<td>Discos de corte</td>
<td>50</td>
<td>$ 231,48</td>
<td></td>
</tr>
<tr>
<td>Rueda esmeril</td>
<td>20</td>
<td>$ 6,81</td>
<td></td>
</tr>
<tr>
<td>Cilindro CO2</td>
<td>202</td>
<td>$ 1,401,68</td>
<td></td>
</tr>
<tr>
<td>Alambre soldadura</td>
<td>202</td>
<td>$ 446,43</td>
<td></td>
</tr>
<tr>
<td>Discos pulidores</td>
<td>13</td>
<td>$ 3,19</td>
<td></td>
</tr>
<tr>
<td>Guantes de carnasa</td>
<td>202</td>
<td>$ 33,01</td>
<td></td>
</tr>
<tr>
<td>Punta antorcha soldador</td>
<td>202</td>
<td>$ 41,26</td>
<td></td>
</tr>
</tbody>
</table>

TOTAL

Ensamble General y Terminado

Cerrajería y Soldadura
<table>
<thead>
<tr>
<th></th>
<th>Telefonia movil y fija</th>
<th>Energía electrica</th>
<th>Transporte</th>
<th>Gastos administrativos</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$ 89,33</td>
<td>$ 4.695,61</td>
<td>$ 687,62</td>
<td>$ 2.386,14</td>
</tr>
<tr>
<td></td>
<td>$ 390,03</td>
<td>$ 478,91</td>
<td>$ 3.002,27</td>
<td>$ 10.418,37</td>
</tr>
<tr>
<td></td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td></td>
<td>$ 33,97</td>
<td>$ 86,48</td>
<td>$ 261,49</td>
<td>$ 907,41</td>
</tr>
<tr>
<td></td>
<td>$ 513,33</td>
<td>$ 5.261,00</td>
<td>$ 3.951,38</td>
<td>$ 13.711,92</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo total prorranteado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 4.449,68</td>
</tr>
<tr>
<td>$ 85,78</td>
</tr>
<tr>
<td>$ 16,85</td>
</tr>
<tr>
<td>$ 23,28</td>
</tr>
<tr>
<td>$ 23,28</td>
</tr>
<tr>
<td>$ 2,30</td>
</tr>
<tr>
<td>$ 7,35</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ -</td>
</tr>
<tr>
<td>$ 0,61</td>
</tr>
<tr>
<td>$ 9,80</td>
</tr>
<tr>
<td>$ 4,43</td>
</tr>
<tr>
<td>$ 4,36</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Centro de Coste</td>
</tr>
<tr>
<td>---------------------------------</td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de</td>
</tr>
<tr>
<td>maderas</td>
</tr>
<tr>
<td>Costura y tapiceria</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

**Materia prima indirecta**

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripcion CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorratoe productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corte, enchape y tratamiento de</td>
<td>PL 285 madera</td>
<td>430</td>
<td>$ 14.718,18</td>
</tr>
<tr>
<td>maderas</td>
<td>Colbon 20Kg</td>
<td>510</td>
<td>$ 486,11</td>
</tr>
<tr>
<td></td>
<td>Grapas 1*1/2</td>
<td>128</td>
<td>$ 95,49</td>
</tr>
<tr>
<td></td>
<td>Grapas 1”</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td></td>
<td>Grapas 3/4</td>
<td>128</td>
<td>$ 131,94</td>
</tr>
<tr>
<td></td>
<td>Grapa Gema 95/10</td>
<td>128</td>
<td>$ 13,02</td>
</tr>
<tr>
<td></td>
<td>Mantenimiento disco de corte</td>
<td>235</td>
<td>$ 38,40</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$ 10,89</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray cromo</td>
<td>13</td>
<td>$ 6,90</td>
</tr>
<tr>
<td></td>
<td>Pintura en Spray blanco</td>
<td>7</td>
<td>$ 1,53</td>
</tr>
<tr>
<td></td>
<td>Gasolina</td>
<td>82</td>
<td>$ 20,10</td>
</tr>
<tr>
<td></td>
<td>Disolvente (Thinner)</td>
<td>82</td>
<td>$ 321,57</td>
</tr>
<tr>
<td></td>
<td>Vinilo blanco</td>
<td>82</td>
<td>$ 145,15</td>
</tr>
<tr>
<td>Material</td>
<td>Cantidad</td>
<td>Precio</td>
<td>Total</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Vinilo negro</td>
<td>82</td>
<td>$</td>
<td>142,92</td>
</tr>
<tr>
<td>Laca blanca</td>
<td>82</td>
<td>$</td>
<td>535,95</td>
</tr>
<tr>
<td>Laca negra</td>
<td>82</td>
<td>$</td>
<td>178,65</td>
</tr>
</tbody>
</table>

**TOTAL**
<table>
<thead>
<tr>
<th>Telefonia movil y fija</th>
<th>Energía electrica</th>
<th>Transporte</th>
<th>Gastos administrativos</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 434,07</td>
<td>$ 478,91</td>
<td>$ 3.341,24</td>
<td>$ 11.594,64</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 62,91</td>
<td>$ 172,95</td>
<td>$ 484,24</td>
<td>$ 1.680,38</td>
</tr>
<tr>
<td>$ 496,98</td>
<td>$ 651,86</td>
<td>$ 3.825,48</td>
<td>$ 13.275,02</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo total prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 2.053,70</td>
</tr>
<tr>
<td>$ 171,57</td>
</tr>
<tr>
<td>$ 33,70</td>
</tr>
<tr>
<td>$ 46,57</td>
</tr>
<tr>
<td>$ 46,57</td>
</tr>
<tr>
<td>$ 4,60</td>
</tr>
<tr>
<td>$ 7,35</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>$ 1,23</td>
</tr>
<tr>
<td>$ 19,61</td>
</tr>
<tr>
<td>$ 8,85</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>Centro de Coste</td>
</tr>
<tr>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
</tr>
<tr>
<td>Costura y tapicería</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
</tr>
<tr>
<td><strong>Total</strong></td>
</tr>
</tbody>
</table>

**Materia prima indirecta**

<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Descripcion CIF</th>
<th>Minutos por actividad</th>
<th>Valor prorrateo productos objetivo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>Discos de corte</td>
<td>50</td>
<td>$ 231,48</td>
</tr>
<tr>
<td></td>
<td>Rueda esmeril</td>
<td>20</td>
<td>$ 6,81</td>
</tr>
<tr>
<td></td>
<td>Cilindro CO2</td>
<td>202</td>
<td>$ 1,401,68</td>
</tr>
<tr>
<td></td>
<td>Alambre soldadura</td>
<td>202</td>
<td>$ 446,43</td>
</tr>
<tr>
<td></td>
<td>Discos pulidores</td>
<td>13</td>
<td>$ 3,19</td>
</tr>
<tr>
<td></td>
<td>Guantes de carnasa</td>
<td>202</td>
<td>$ 33,01</td>
</tr>
<tr>
<td></td>
<td>Punta antorcha soldador</td>
<td>202</td>
<td>$ 41,26</td>
</tr>
<tr>
<td>Costura y tapiceria</td>
<td>Grapa 80/10</td>
<td>83</td>
<td>$ 188,73</td>
</tr>
<tr>
<td></td>
<td>Grapa 95/10</td>
<td>83</td>
<td>$ 14,60</td>
</tr>
<tr>
<td></td>
<td>Plastico Enchuspar</td>
<td>23</td>
<td>$ 31,32</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfín madera</td>
<td>53</td>
<td>$ 1,584,37</td>
</tr>
<tr>
<td></td>
<td>Cinta sinfín espuma</td>
<td>39</td>
<td>$ 250,54</td>
</tr>
<tr>
<td></td>
<td>Pega Imperial</td>
<td>95</td>
<td>$ 83,79</td>
</tr>
<tr>
<td></td>
<td>Carton de 1*1/2</td>
<td>40</td>
<td>$ 45,88</td>
</tr>
<tr>
<td></td>
<td>Hilo cono Grande</td>
<td>125</td>
<td>$ 30,64</td>
</tr>
<tr>
<td></td>
<td>Aceite Telus</td>
<td>125</td>
<td>$ 31,49</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>Pintura en Spray negro</td>
<td>20</td>
<td>$</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------</td>
<td>----</td>
<td>---</td>
</tr>
<tr>
<td>Pintura en Spray cromo</td>
<td></td>
<td>13</td>
<td>$</td>
</tr>
<tr>
<td>Pintura en Spray blanco</td>
<td></td>
<td>7</td>
<td>$</td>
</tr>
<tr>
<td>Gasolina</td>
<td></td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td>Disolvente (Thinner)</td>
<td></td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td>Vinilo blanco</td>
<td></td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td>Vinilo negro</td>
<td></td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td>Laca blanca</td>
<td></td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td>Laca negra</td>
<td></td>
<td>82</td>
<td>$</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Telefonia movil y fija</td>
<td>Energía electrica</td>
<td>Transporte</td>
<td>Gastos administrativos</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------</td>
<td>------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>$ 100,65</td>
<td>$ 4.872,81</td>
<td>$ 774,78</td>
<td>$ 2.688,61</td>
</tr>
<tr>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
<td>$ 0,00</td>
</tr>
<tr>
<td>$ 154,75</td>
<td>$ 317,60</td>
<td>$ 1.191,22</td>
<td>$ 4.133,74</td>
</tr>
<tr>
<td>$ 31,45</td>
<td>$ 86,48</td>
<td>$ 242,12</td>
<td>$ 840,19</td>
</tr>
<tr>
<td>$ 286,86</td>
<td>$ 5.276,88</td>
<td>$ 2.208,12</td>
<td>$ 7.662,54</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo total prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
<tr>
<td>$</td>
</tr>
</tbody>
</table>
### TUBERIA/ACERO

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Espaldar</td>
<td>cm</td>
<td>166</td>
<td>Tubería redonda C.20 * 3/4&quot;</td>
<td>6903</td>
</tr>
<tr>
<td>Base</td>
<td>cm</td>
<td>156</td>
<td>Tubería redonda C.20 * 3/4&quot;</td>
<td>6903</td>
</tr>
<tr>
<td>Piecero</td>
<td>cm</td>
<td>117</td>
<td>Tubería redonda C.20 * 3/4&quot;</td>
<td>6903</td>
</tr>
<tr>
<td>Travesaño</td>
<td>cm</td>
<td>31</td>
<td>Tubería redonda C.20 * 1/2&quot;</td>
<td>4812</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 600cm
*el IVA para este material es del 16%

### MADERA/AGLOMERADO

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1295</td>
<td>Aglomerado de 15mm</td>
<td>46551</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>700</td>
<td>Aglomerado de 15mm</td>
<td>46551</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm²
*el IVA para este material es del 16%

### ESPUMA

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1295</td>
<td>Densidad 70 de 5 cm</td>
<td>53448</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1295</td>
<td>Densidad 26 de 1 cm</td>
<td>7759</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>700</td>
<td>Densidad 20 de 5 cm</td>
<td>23448</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 20000cm³
*el IVA para este material es del 16%

### PLASTICO

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1443</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1320</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>950</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>925</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>367,5</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>315</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 14000cm³
*el IVA para este material es del 16%

### MATERIALES Y/O PROCESOS VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tapones</td>
<td>unidad</td>
<td>4</td>
<td>Tapon de 3/4 plastico</td>
<td>60</td>
</tr>
<tr>
<td>Tornillos</td>
<td>unidad</td>
<td>4</td>
<td>Dry Walls 8*5/8</td>
<td>15</td>
</tr>
<tr>
<td>Tornillos</td>
<td>unidad</td>
<td>2</td>
<td>Hexagono 1/4* 1 1/4</td>
<td>40</td>
</tr>
<tr>
<td>Tuercas</td>
<td>unidad</td>
<td>2</td>
<td>Tuerca de uña de 1/4</td>
<td>55</td>
</tr>
<tr>
<td>Cromado Est. Metalica</td>
<td>unidad</td>
<td>1</td>
<td>Cromado Estructura metalica</td>
<td>12069</td>
</tr>
</tbody>
</table>

*el IVA para este material es del 16%
<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>8007,48</td>
<td>$ 2.215,40</td>
</tr>
<tr>
<td>8007,48</td>
<td>$ 2.081,94</td>
</tr>
<tr>
<td>8007,48</td>
<td>$ 1.561,46</td>
</tr>
<tr>
<td>5581,92</td>
<td>$ 288,40</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 6.147,21</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>53999,16</td>
<td>$ 1.873,16</td>
</tr>
<tr>
<td>53999,16</td>
<td>$ 1.012,52</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 2.885,68</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>61999,68</td>
<td>$ 4.014,48</td>
</tr>
<tr>
<td>9000,44</td>
<td>$ 582,78</td>
</tr>
<tr>
<td>27199,68</td>
<td>$ 951,99</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 5.549,25</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>13920</td>
<td>$ 1.434,75</td>
</tr>
<tr>
<td>13920</td>
<td>$ 1.312,46</td>
</tr>
<tr>
<td>13920</td>
<td>$ 944,57</td>
</tr>
<tr>
<td>13920</td>
<td>$ 919,71</td>
</tr>
<tr>
<td>13920</td>
<td>$ 365,40</td>
</tr>
<tr>
<td>13920</td>
<td>$ 313,20</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 5.290,10</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>69,6</td>
<td>$ 278,40</td>
</tr>
<tr>
<td>17,4</td>
<td>$ 69,60</td>
</tr>
<tr>
<td>46,4</td>
<td>$ 92,80</td>
</tr>
<tr>
<td>63,8</td>
<td>$ 127,60</td>
</tr>
<tr>
<td>14000,0</td>
<td>$ 14.000,04</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 14.568,44</strong></td>
</tr>
</tbody>
</table>

| Costo Total      | **$ 34.440,67**   |
## MADERA/ENCHAPE

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>1</td>
<td>1400</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>240</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>600</td>
<td>Aglomerado de 15mm</td>
<td>$46.551,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>3200</td>
<td>Aglomerado de 15mm</td>
<td>$46.551,00</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>304</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>4</td>
<td>480</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1200</td>
<td>MDF 4 mm</td>
<td>$29.438,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>231</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm²

*el IVA para este material es del 16%

## FORMICA

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>600</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>3200</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>4</td>
<td>480</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 29768 cm²

*el IVA para este material es del 16%

## MATERIALES VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agarradera</td>
<td>UNI</td>
<td>1</td>
<td>Agarradera metalica</td>
<td>$862,00</td>
</tr>
<tr>
<td>Chapa</td>
<td>UNI</td>
<td>1</td>
<td>Chapa metalica</td>
<td>$1.724,00</td>
</tr>
<tr>
<td>Tapones</td>
<td>UNI</td>
<td>4</td>
<td>Tapon rectangular</td>
<td>$50,00</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.710,05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 586,30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 53.999,16</td>
<td>$ 867,87</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 53.999,16</td>
<td>$ 4.628,66</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 742,65</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 2.345,21</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 34.148,08</td>
<td>$ 1.097,66</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 282,16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 12.260,56</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 34.665,44</td>
<td>$ 1.397,42</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 3.726,46</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 2.235,88</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 7.359,77</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 999,92</td>
<td>$ 999,92</td>
</tr>
<tr>
<td>$ 1.999,84</td>
<td>$ 1.999,84</td>
</tr>
<tr>
<td>$ 58,00</td>
<td>$ 232,00</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 3.231,76</strong></td>
</tr>
</tbody>
</table>

**COSTO TOTAL**  $ 22.852,08
## MADERA/ENCHAPE

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>2800</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>4</td>
<td>1312,5</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>240</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>4</td>
<td>464</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>595</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1480</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>336</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>3260</td>
<td>MDF de 4mm</td>
<td>29438</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>2000</td>
<td>MDF de 4mm</td>
<td>29438</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm²  
*el IVA para este material es del 16%

## FORMICA

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>3029,5</td>
<td>Formica</td>
<td>29884</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>703</td>
<td>Formica</td>
<td>29884</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1577</td>
<td>Formica</td>
<td>29884</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>2317,5</td>
<td>Formica</td>
<td>29884</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 29768 cm²  
*el IVA para este material es del 16%

## MATERIALES VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agarradera</td>
<td>UNI</td>
<td>3</td>
<td>Agarradera metalica</td>
<td>862</td>
</tr>
<tr>
<td>Chapa</td>
<td>UNI</td>
<td>2</td>
<td>Chapa metalica</td>
<td>1724</td>
</tr>
<tr>
<td>Rodachinas</td>
<td>Display x4Uni</td>
<td>1</td>
<td>Rodachin Deslizante</td>
<td>6333</td>
</tr>
<tr>
<td>Bisagra</td>
<td>Pares</td>
<td>1</td>
<td>Bisagra de parche</td>
<td>1552</td>
</tr>
<tr>
<td>Tornillo</td>
<td>UNI</td>
<td>16</td>
<td>Dry Walls 8*5/8</td>
<td>15</td>
</tr>
<tr>
<td>Gancho</td>
<td>UNI</td>
<td>1</td>
<td>Gancho porta-secador</td>
<td>6500</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 6.840,18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 6.412,67</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 586,30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 2.267,03</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 1.453,54</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 1.807,76</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 820,82</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34148,08</td>
<td>$ 2.981,97</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34148,08</td>
<td>$ 1.697,71</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42000,12</td>
<td>$ 2.250,09</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 27.118,08</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>34665,44</td>
<td>$ 7.055,83</td>
</tr>
<tr>
<td>34665,44</td>
<td>$ 1.637,32</td>
</tr>
<tr>
<td>34665,44</td>
<td>$ 1.836,45</td>
</tr>
<tr>
<td>34665,44</td>
<td>$ 2.698,78</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 13.228,37</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>999,92</td>
<td>$ 2.999,76</td>
</tr>
<tr>
<td>1999,84</td>
<td>$ 3.999,68</td>
</tr>
<tr>
<td>7346,28</td>
<td>$ 7.346,28</td>
</tr>
<tr>
<td>1800</td>
<td>$ 1.800,00</td>
</tr>
<tr>
<td>17,4</td>
<td>$ 278,40</td>
</tr>
<tr>
<td>7540</td>
<td>$ 7.540,00</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 23.964,12</strong></td>
</tr>
</tbody>
</table>

**COSTO TOTAL**  $ 64.310,56
### TUBERIA/ACERO

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm</td>
<td>4</td>
<td>35</td>
<td>Tuberia redonda C.18 * 3/4&quot;</td>
</tr>
<tr>
<td>cm</td>
<td>4</td>
<td>28</td>
<td>Tuberia redonda C.18 * 3/4&quot;</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>56</td>
<td>Tuberia redonda C.18 * 3/4&quot;</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>68</td>
<td>Tuberia redonda C.18 * 3/4&quot;</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>24</td>
<td>Tuberia redonda C.18 * 1/2&quot;</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>49</td>
<td>Tuberia redonda C.16 * 3/4&quot;</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>10</td>
<td>Platina de 3/16 * 1&quot;</td>
</tr>
<tr>
<td>cm</td>
<td>4</td>
<td>10,5</td>
<td>Platina de 1/4 * 1&quot;</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 600cm
*el IVA para este material es del 16%

### MADERA/AGLOMERADO

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>2272,5</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1805</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>240,5</td>
</tr>
<tr>
<td>Cabecero</td>
<td>cm²</td>
<td>1</td>
<td>308</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 3500 cm², para el Triplex curvo de 12 mm
*el precio unitario viene dado para una medida de 37332 cm², para el aglomerado de 19 mm

### ESPUMA

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>2272,5</td>
<td>casata de 8cm</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>2272,5</td>
<td>Densidad 26 de 1 cm</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1805</td>
<td>Densidad 26 de 8 cm</td>
</tr>
<tr>
<td>Cabecero</td>
<td>cm²</td>
<td>308</td>
<td>Densidad 26 de 8 cm</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>240,5</td>
<td>Densidad 20 de 5 cm</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 20000cm²
*el IVA para este material es del 16%

### PLASTICO

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>2392</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>2520</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>2</td>
<td>1836,75</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1898</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>352</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 14000cm²
*el IVA para este material es del 16%

### MATERIALES VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tapones</td>
<td>unidad</td>
<td>4</td>
<td>Tapon Canoa</td>
</tr>
<tr>
<td>Material</td>
<td>Unidad</td>
<td>Cantidad</td>
<td>Tamaño</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------</td>
<td>----------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Tornillos</td>
<td>unidad</td>
<td>8</td>
<td>Hex DE 1/4 * 1 1/2&quot;</td>
</tr>
<tr>
<td>Tornillos</td>
<td>unidad</td>
<td>24</td>
<td>HEX DE 1/4 * 1&quot;</td>
</tr>
<tr>
<td>Tuercas</td>
<td>unidad</td>
<td>34</td>
<td>Tuerca de uña de 1/4</td>
</tr>
<tr>
<td>Cromado Est. Metalica</td>
<td>unidad</td>
<td>1</td>
<td>Cromado Estructura metalica</td>
</tr>
</tbody>
</table>
### Descripción

<table>
<thead>
<tr>
<th>Descripción</th>
<th>Costo Unitario*</th>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aglomerado de 19mm</td>
<td>$73,035,00</td>
<td>$84,720,60</td>
<td>$5,157,17</td>
</tr>
<tr>
<td>Triplex de 12mm Curvo</td>
<td>$5,172,00</td>
<td>$5,999,52</td>
<td>$3,094,04</td>
</tr>
<tr>
<td>Triplex de 12mm Curvo</td>
<td>$5,172,00</td>
<td>$5,999,52</td>
<td>$824,51</td>
</tr>
<tr>
<td>Triplex de 12mm Curvo</td>
<td>$5,172,00</td>
<td>$5,999,52</td>
<td>$527,96</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$9,603,67</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Descripción

<table>
<thead>
<tr>
<th>Descripción</th>
<th>Costo Unitario*</th>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telas plasticas</td>
<td>$12,000,00</td>
<td>$13,920,00</td>
<td>$2,378,33</td>
</tr>
<tr>
<td>Telas plasticas</td>
<td>$12,000,00</td>
<td>$13,920,00</td>
<td>$2,505,60</td>
</tr>
<tr>
<td>Telas plasticas</td>
<td>$12,000,00</td>
<td>$13,920,00</td>
<td>$3,652,51</td>
</tr>
<tr>
<td>Telas plasticas</td>
<td>$12,000,00</td>
<td>$13,920,00</td>
<td>$1,887,15</td>
</tr>
<tr>
<td>Telas plasticas</td>
<td>$12,000,00</td>
<td>$13,920,00</td>
<td>$699,98</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$11,123,57</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Descripción

<table>
<thead>
<tr>
<th>Costo Unitario*</th>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$173,00</td>
<td>$200,00</td>
<td>$800,00</td>
</tr>
<tr>
<td>$</td>
<td>45,00</td>
<td>$</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$</td>
<td>38,00</td>
<td>$</td>
</tr>
<tr>
<td>$</td>
<td>55,00</td>
<td>$</td>
</tr>
<tr>
<td>$</td>
<td>25,862,00</td>
<td>$</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$</strong></td>
<td>34,444,72</td>
</tr>
</tbody>
</table>

**COSTO TOTAL**  
$ 88,407,78
### MADERA/ENCHAPE

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>59,2</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>6</td>
<td>1523,2</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>9460,5</td>
<td>MDF de 4mm</td>
<td>29438</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>765</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1845</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>4</td>
<td>449,5</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>456</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>1209</td>
<td>MDF de 4mm</td>
<td>29438</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm², para el aglomerado de 12mm
*el precio unitario viene dado para una medida de 52460 cm², para el MDF 4 mm

### FORMICA

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>600</td>
<td>Formica</td>
<td>$ 29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>3200</td>
<td>Formica</td>
<td>$ 29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>4</td>
<td>480</td>
<td>Formica</td>
<td>$ 29.884,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 29768 cm²
*el IVA para este material es del 16%

### MATERIALES VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base metalica</td>
<td>Unidad</td>
<td>1</td>
<td>Base en hierro</td>
<td>$ 14.000,00</td>
</tr>
<tr>
<td>Angulos de alum.</td>
<td>Unidad</td>
<td>2</td>
<td>Ángulos en aluminio</td>
<td>$ 4.000,00</td>
</tr>
<tr>
<td>Agarraderas</td>
<td>Unidad</td>
<td>3</td>
<td>Agarraderas metalicas</td>
<td>$ 1.000,00</td>
</tr>
<tr>
<td>Chapas</td>
<td>Unidad</td>
<td>2</td>
<td>Chapas cromadas</td>
<td>$ 2.500,00</td>
</tr>
<tr>
<td>Bisagras</td>
<td>PARES</td>
<td>1</td>
<td>Bisagras de parche</td>
<td>$ 1.700,00</td>
</tr>
<tr>
<td>Lamparas</td>
<td>Unidad</td>
<td>1</td>
<td>Lampara Ojo de Buey</td>
<td>$ 6.500,00</td>
</tr>
<tr>
<td>Vidrios</td>
<td>Unidad</td>
<td>6</td>
<td>Vidrios en 4mm</td>
<td>$ 4.000,00</td>
</tr>
<tr>
<td>Cable Duplex</td>
<td>Mts</td>
<td>1</td>
<td>Cable duplex n° 12</td>
<td>$ 2.500,00</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 144,62</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 11.163,18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34148,08</td>
<td>$ 6.158,18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 1.868,84</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 2.253,60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 2.196,19</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45599,6</td>
<td>$ 1.113,97</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34148,08</td>
<td>$ 1.573,96</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 26.472,53</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 34.665,44</td>
<td>$ 1.397,42</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 3.726,46</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 2.235,88</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 7.359,77</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 16.240,00</td>
<td>$ 16.240,00</td>
</tr>
<tr>
<td>$ 4.640,00</td>
<td>$ 9.280,00</td>
</tr>
<tr>
<td>$ 1.160,00</td>
<td>$ 3.480,00</td>
</tr>
<tr>
<td>$ 2.900,00</td>
<td>$ 5.800,00</td>
</tr>
<tr>
<td>$ 1.972,00</td>
<td>$ 1.972,00</td>
</tr>
<tr>
<td>$ 7.540,00</td>
<td>$ 7.540,00</td>
</tr>
<tr>
<td>$ 4.640,00</td>
<td>$ 27.840,00</td>
</tr>
<tr>
<td>$ 2.900,00</td>
<td>$ 2.900,00</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 75.052,00</strong></td>
</tr>
</tbody>
</table>

**COSTO TOTAL**  $ 108.884,30
### MADERA/ENCHAPE

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>2040</td>
<td>Aglomerado de 12mm</td>
<td>$ 39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1020</td>
<td>Aglomerado de 12mm</td>
<td>$ 39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>2</td>
<td>150</td>
<td>Aglomerado de 12mm</td>
<td>$ 39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>6</td>
<td>453</td>
<td>Aglomerado de 12mm</td>
<td>$ 39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>3</td>
<td>545,75</td>
<td>Aglomerado de 12mm</td>
<td>$ 39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>3</td>
<td>295,1</td>
<td>Aglomerado de 12mm</td>
<td>$ 39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>4022,25</td>
<td>Aglomerado de 9mm</td>
<td>$ 36.207,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm²*

### FORMICA

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>600</td>
<td>Formica</td>
<td>$ 29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>3200</td>
<td>Formica</td>
<td>$ 29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>4</td>
<td>480</td>
<td>Formica</td>
<td>$ 29.884,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 29768 cm²*

*el IVA para este material es del 16%*  

### MATERIALES VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base metalica</td>
<td>Unidad</td>
<td>1</td>
<td>Base en hierro</td>
<td>$ 12.000,00</td>
</tr>
<tr>
<td>chapas</td>
<td>Unidad</td>
<td>2</td>
<td>Chapas cromadas</td>
<td>$ 2.500,00</td>
</tr>
<tr>
<td>Agarraderas</td>
<td>Unidad</td>
<td>3</td>
<td>Agarraderas metalicas</td>
<td>$ 1.000,00</td>
</tr>
<tr>
<td>niveladores</td>
<td>Unidad</td>
<td>6</td>
<td>Niveladores plasticos</td>
<td>$ 250,00</td>
</tr>
<tr>
<td>tornillos</td>
<td>Unidad</td>
<td>16</td>
<td>Dry Walls 8*5/8</td>
<td>$ 15,00</td>
</tr>
<tr>
<td>rieles</td>
<td>pares</td>
<td>3</td>
<td>rieles de 30</td>
<td>$ 2.200,00</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 4.983,56</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.245,89</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 366,44</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 3.319,93</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.999,84</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.081,36</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 42.000,12</td>
<td>$ 4.525,21</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 17.522,23</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 34.665,44</td>
<td>$ 1.397,42</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 3.726,46</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 2.235,88</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 7.359,77</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 13.920,00</td>
<td>$ 13.920,00</td>
</tr>
<tr>
<td>$ 2.900,00</td>
<td>$ 5.800,00</td>
</tr>
<tr>
<td>$ 1.160,00</td>
<td>$ 3.480,00</td>
</tr>
<tr>
<td>$ 290,00</td>
<td>$ 1.740,00</td>
</tr>
<tr>
<td>$ 17,40</td>
<td>$ 278,40</td>
</tr>
<tr>
<td>$ 2.552,00</td>
<td>$ 7.656,00</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 32.874,40</strong></td>
</tr>
</tbody>
</table>

**COSTO TOTAL** $ 57.756,40
### MADERA/ENCHAPE

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>2272</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1120</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1043,2</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>525</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>2590</td>
<td>MDF 4 mm</td>
<td>$29.438,00</td>
</tr>
<tr>
<td>cm²</td>
<td>3</td>
<td>517,5</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>6</td>
<td>345</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>3</td>
<td>262,2</td>
<td>Aglomerado de 12mm</td>
<td>$39.310,00</td>
</tr>
<tr>
<td>cm²</td>
<td>3</td>
<td>855</td>
<td>MDF 4 mm</td>
<td>$29.438,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm², para el aglomerado de 12mm

*el precio unitario viene dado para una medida de 52460 cm², para el MDF 4 mm

### FORMICA

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm²</td>
<td>2</td>
<td>736</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>1043,2</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>2590</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>742,5</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>3</td>
<td>517,5</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
<tr>
<td>cm²</td>
<td>1</td>
<td>525</td>
<td>Formica</td>
<td>$29.884,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 29768 cm²

*el IVA para este material es del 16%

### MATERIALES VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base metalica</td>
<td>Unidad</td>
<td>1</td>
<td>Base en hierro</td>
<td>$12.000,00</td>
</tr>
<tr>
<td>chapas</td>
<td>Unidad</td>
<td>2</td>
<td>Chapas cromadas</td>
<td>$2.500,00</td>
</tr>
<tr>
<td>Agarraderas</td>
<td>Unidad</td>
<td>3</td>
<td>Agarraderas metalicas</td>
<td>$1.000,00</td>
</tr>
<tr>
<td>rodachinas</td>
<td>Display x 4</td>
<td>1</td>
<td>Rodachin Deslizante</td>
<td>$6.800,00</td>
</tr>
<tr>
<td>tornillos</td>
<td>UNI</td>
<td>16</td>
<td>Dry wall 8*5/8</td>
<td>$15.00</td>
</tr>
<tr>
<td>ganchos</td>
<td>UNI</td>
<td>1</td>
<td>Gancho cromado</td>
<td>$5.000,00</td>
</tr>
<tr>
<td>Rieles</td>
<td>pares</td>
<td>3</td>
<td>rieles de 30</td>
<td>$2.200,00</td>
</tr>
</tbody>
</table>
### Tabla 1

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 45.599,60</td>
<td>$ 5.550,32</td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.368,04</td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.274,23</td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 641,27</td>
</tr>
<tr>
<td>$ 34.148,08</td>
<td>$ 1.685,92</td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.896,32</td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 2.528,43</td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 960,80</td>
</tr>
<tr>
<td>$ 34.148,08</td>
<td>$ 1.669,65</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 17.574,97</strong></td>
</tr>
</tbody>
</table>

### Tabla 2

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 34.665,44</td>
<td>$ 1.714,17</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 1.214,83</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 3.016,11</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 864,66</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 1.807,92</td>
</tr>
<tr>
<td>$ 34.665,44</td>
<td>$ 611,37</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 9.229,06</strong></td>
</tr>
</tbody>
</table>

### Tabla 3

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 13.920,00</td>
<td>$ 13.920,00</td>
</tr>
<tr>
<td>$ 2.900,00</td>
<td>$ 5.800,00</td>
</tr>
<tr>
<td>$ 1.160,00</td>
<td>$ 3.480,00</td>
</tr>
<tr>
<td>$ 7.888,00</td>
<td>$ 7.888,00</td>
</tr>
<tr>
<td>$ 17,40</td>
<td>$ 278,40</td>
</tr>
<tr>
<td>$ 5.800,00</td>
<td>$ 5.800,00</td>
</tr>
<tr>
<td>$ 2.552,00</td>
<td>$ 7.656,00</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 44.822,40</strong></td>
</tr>
</tbody>
</table>

**COSTO TOTAL** $ 71.626,43
### TUBERIA/ACERO

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm</td>
<td>2</td>
<td>71</td>
<td>Tubería redonda C.18 * 1&quot;</td>
<td>$11.354,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>74</td>
<td>Tubería redonda C.20 * 1&quot;</td>
<td>$9.317,00</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>45</td>
<td>Tubería redonda C.20 * 1&quot;</td>
<td>$9.317,00</td>
</tr>
<tr>
<td>cm</td>
<td>3</td>
<td>24</td>
<td>Tubería redonda C.18 * 3/8&quot;</td>
<td>$3978*</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>99</td>
<td>Tubería redonda C.20 * 5/8&quot;</td>
<td>$6.000,00</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>120</td>
<td>Tubería redonda C.20 * 5/8&quot;</td>
<td>$6.000,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 300cm, para la referencia 3/8 C.18

*el precio unitario viene dado para una medida de 600cm, para las demas referencias

*el IVA para este material es del 16%

### MATERIALES Y/O VARIOS

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bastidor</td>
<td>UNI</td>
<td>1</td>
<td>Asiento en aluminio</td>
<td>$8.621,00</td>
</tr>
<tr>
<td>tornillos</td>
<td>UNI</td>
<td>4</td>
<td>Dry wall 8*5/8</td>
<td>$15,00</td>
</tr>
<tr>
<td>tapones</td>
<td>UNI</td>
<td>4</td>
<td>Tapon plastico de 1&quot; Int</td>
<td>$52,00</td>
</tr>
<tr>
<td>Cromado</td>
<td>UNI</td>
<td>1</td>
<td>Cromado estructura metalica</td>
<td>$12.069,00</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 13.170,64</td>
<td>$ 3.117,05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 10.807,72</td>
<td>$ 2.665,90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 10.807,72</td>
<td>$ 810,58</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 4.614,48</td>
<td>$ 1.107,48</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 6.960,00</td>
<td>$ 1.148,40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 6.960,00</td>
<td>$ 1.392,00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 10.241,41</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 10.000,36</td>
<td>$ 10.000,36</td>
</tr>
<tr>
<td>$ 17,40</td>
<td>$ 69,60</td>
</tr>
<tr>
<td>$ 60,32</td>
<td>$ 241,28</td>
</tr>
<tr>
<td>$ 14.000,04</td>
<td>$ 14.000,04</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 24.311,28</strong></td>
</tr>
</tbody>
</table>

**COSTO TOTAL**  $ 34.552,69
**TUBERIA/ACERO**

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm</td>
<td>1</td>
<td>446</td>
<td>Tubería redonda C.18 * 1”</td>
<td>$ 11.354,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>37</td>
<td>Tubería redonda C.20 * 1”</td>
<td>$ 9.317,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>27</td>
<td>Tubería redonda C.20 * 1”</td>
<td>$ 9.317,00</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>37</td>
<td>Tubería redonda C.20 * 1/2”</td>
<td>$ 3.978,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>37</td>
<td>Platinas de 3/16 * 1</td>
<td>$ 12.295,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>24</td>
<td>Platinas de 3/16 * 1</td>
<td>$ 12.295,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>14</td>
<td>Platinas de 1/8 * 1</td>
<td>$ 7.904,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>7</td>
<td>Platinas de 1/8 * 1</td>
<td>$ 7.904,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>7</td>
<td>Platinas de 1/8 * 1</td>
<td>$ 7.904,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 600cm, para las demas referencias
*el IVA para este material es del 16%

**MADERAS**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1720</td>
<td>Aglomerado de 15mm</td>
<td>$ 46.551,00</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>180</td>
<td>Aglomerado de 15mm</td>
<td>$ 46.551,00</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1419</td>
<td>Aglomerado de 12mm</td>
<td>$ 39.310,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm²
*el IVA para este material es del 16%

**PLASTICO**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>1554</td>
<td>Telas plasticas</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>1620</td>
<td>Telas plasticas</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>2</td>
<td>1428</td>
<td>Telas plasticas</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1258</td>
<td>Telas plasticas</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>256</td>
<td>Telas plasticas</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>510</td>
<td>Telas plasticas</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 14000cm²
*el IVA para este material es del 16%

**ESPUMA**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1720</td>
<td>Espuma casata de 5 cm</td>
<td>$ 53.448,00</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1720</td>
<td>Densidad 26 de 1 cm</td>
<td>$ 7.759,00</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1419</td>
<td>Densidad 26 de 5 cm</td>
<td>$ 38.793,00</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>180</td>
<td>Densidad 20 de 5 cm</td>
<td>$ 23.448,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 20000cm²
*el IVA para este material es del 16%

**MATERIALES VARIOS**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tapones</td>
<td>unidad</td>
<td>4</td>
<td>1&quot; Int.</td>
<td>$ 60,00</td>
</tr>
<tr>
<td>Tuercas</td>
<td>unidad</td>
<td>4</td>
<td>Tuerca de uña de 3/16</td>
<td>$ 50,00</td>
</tr>
<tr>
<td>Material</td>
<td>Unidad</td>
<td>Cantidad</td>
<td>Descripción</td>
<td>Precio</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------</td>
<td>----------</td>
<td>--------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>tornillos</td>
<td>unidad</td>
<td>4</td>
<td>tornillos 3/4*3/16</td>
<td>$30,00</td>
</tr>
<tr>
<td>Cabeza de fibra</td>
<td>UNI</td>
<td>1</td>
<td>Cabeza en fibra de vidrio</td>
<td>$56.034</td>
</tr>
<tr>
<td>Pintura</td>
<td>UNI</td>
<td>1</td>
<td>Pintura electroestatica</td>
<td>$8.621</td>
</tr>
<tr>
<td>manguera desague</td>
<td>UNI</td>
<td>1</td>
<td>Manguera plastica</td>
<td>$4.310</td>
</tr>
<tr>
<td>griferia</td>
<td>UNI</td>
<td>1</td>
<td>Juego completo griferia</td>
<td>$18.276</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 13.170,64</td>
<td>$ 9.790,18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 10.807,72</td>
<td>$ 1.332,95</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 10.807,72</td>
<td>$ 972,69</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 4.614,48</td>
<td>$ 284,56</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 14.262,20</td>
<td>$ 1.759,00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 14.262,20</td>
<td>$ 1.140,98</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 9.168,64</td>
<td>$ 427,87</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 9.168,64</td>
<td>$ 213,93</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 9.168,64</td>
<td>$ 305,62</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTAL</td>
<td>$ 16.227,79</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 53.999,16</td>
<td>$ 2.487,91</td>
</tr>
<tr>
<td>$ 53.999,16</td>
<td>$ 260,36</td>
</tr>
<tr>
<td>$ 45.599,60</td>
<td>$ 1.733,25</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$ 4.481,52</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unitario*</th>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 12.000,00</td>
<td>$ 13.920,00</td>
<td>$ 1.545,12</td>
</tr>
<tr>
<td>$ 12.000,00</td>
<td>$ 13.920,00</td>
<td>$ 1.610,74</td>
</tr>
<tr>
<td>$ 12.000,00</td>
<td>$ 13.920,00</td>
<td>$ 2.839,68</td>
</tr>
<tr>
<td>$ 12.000,00</td>
<td>$ 13.920,00</td>
<td>$ 1.250,81</td>
</tr>
<tr>
<td>$ 12.000,00</td>
<td>$ 13.920,00</td>
<td>$ 509,07</td>
</tr>
<tr>
<td>$ 12.000,00</td>
<td>$ 13.920,00</td>
<td>$ 1.014,17</td>
</tr>
<tr>
<td>TOTAL</td>
<td></td>
<td>$ 8.769,60</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 61.999,68</td>
<td>$ 5.331,97</td>
</tr>
<tr>
<td>$ 9.000,44</td>
<td>$ 774,04</td>
</tr>
<tr>
<td>$ 44.999,88</td>
<td>$ 3.192,74</td>
</tr>
<tr>
<td>$ 27.199,68</td>
<td>$ 244,80</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$ 9.543,55</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 69,60</td>
<td>$ 278,40</td>
</tr>
<tr>
<td>$ 58,00</td>
<td>$ 232,00</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>$34,80</td>
<td>$139,20</td>
</tr>
<tr>
<td>$64,999,44</td>
<td>$64,999,44</td>
</tr>
<tr>
<td>$10,000,36</td>
<td>$10,000,36</td>
</tr>
<tr>
<td>$4,999,60</td>
<td>$4,999,60</td>
</tr>
<tr>
<td>$21,200,16</td>
<td>$21,200,16</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$ 101,849,16</strong></td>
</tr>
</tbody>
</table>

**COSTO TOTAL** $140,871,62
**TUBERIA/ACERO**

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm</td>
<td>5</td>
<td>27</td>
<td>Tubería redonda C.16 * 1 1/4&quot;</td>
<td>$ 19.735,00</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>29,5</td>
<td>Tubería redonda C.20 * 1&quot;</td>
<td>$ 9.317,00</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>184</td>
<td>Tubería redonda C.18 * 3/4&quot;</td>
<td>$ 8.387,00</td>
</tr>
<tr>
<td>cm</td>
<td>4</td>
<td>28</td>
<td>Tubería redonda C.18 * 3/4&quot;</td>
<td>$ 8.387,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>49</td>
<td>Tubería redonda C.16 * 3/4&quot;</td>
<td>$ 11.673,00</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>13</td>
<td>Platina de 3/16 * 1&quot;</td>
<td>$ 12.295,00</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>16</td>
<td>Platinas de 1/8 *1</td>
<td>$ 7.904,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>40</td>
<td>Platinas de 3/16 *1</td>
<td>$ 12.295,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>14</td>
<td>Angulo de 3/16*1&quot;</td>
<td>$ 20.232,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>16</td>
<td>Angulo de 3/16*1&quot;</td>
<td>$ 20.232,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>16</td>
<td>Platina de 3/16 * 1&quot;</td>
<td>$ 12.295,00</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>16</td>
<td>Tubería redonda C.18 * 3/4&quot;</td>
<td>$ 8.387,00</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 300cm, para la referencia 3/8 C.18
*el precio unitario viene dado para una medida de 600cm, para las demas referencias
*el IVA para este material es del 16%

**MADERA/AGLOMERADO**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>2205</td>
<td>Triplex de 19 mm</td>
<td>73035</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>236,5</td>
<td>Triplex curvo de 12 mm</td>
<td>5172</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1672</td>
<td>Aglomerado de 15mm</td>
<td>46551</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm²
*el precio unitario viene dado para una medida de 3500 cm², para el Triplex curvo de 12 mm
*el IVA para este material es del 16%

**PLASTICO**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>2597</td>
<td>Telas plasticas</td>
<td>67241</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>2352</td>
<td>Telas plasticas</td>
<td>40313</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1672</td>
<td>Telas plasticas</td>
<td>40313</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>432</td>
<td>Telas plasticas</td>
<td>23448</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 14000cm²
*el IVA para este material es del 16%

**ESPUMA**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>2397</td>
<td>Densidad 26 de 8 cm</td>
<td>67241</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1672</td>
<td>Densidad 20 de 8 cm</td>
<td>38103</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>236,5</td>
<td>Densidad 20 de 5 cm</td>
<td>23448</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 20000cm²

**MATERIALES VARIOS**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tapones</td>
<td>unidad</td>
<td>4</td>
<td>1&quot; Int.</td>
<td>$ 60,00</td>
</tr>
<tr>
<td>Descripción</td>
<td>Unidad</td>
<td>Cantidad</td>
<td>Descripción</td>
<td>Precio</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------</td>
<td>----------</td>
<td>--------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Tornillos</td>
<td>unidad</td>
<td>4</td>
<td>Tornillos 3/4*3/16</td>
<td>$30,00</td>
</tr>
<tr>
<td>Tuercas</td>
<td>unidad</td>
<td>34</td>
<td>Tuerca de uña de 1/4</td>
<td>$55,00</td>
</tr>
<tr>
<td>Cromado Est. Metalica</td>
<td>unidad</td>
<td>1</td>
<td>Cromado Estructura metalica</td>
<td>$25,862,00</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$22.892,60</td>
<td>$5.150,84</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$10.807,72</td>
<td>$531,38</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$9.728,92</td>
<td>$2.983,54</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$4.614,48</td>
<td>$1.722,74</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$13.540,68</td>
<td>$2.211,64</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$14.262,20</td>
<td>$309,01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$9.168,64</td>
<td>$244,50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$14.262,20</td>
<td>$1.901,63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$23.469,12</td>
<td>$1.095,23</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$23.469,12</td>
<td>$1.251,69</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$14.262,20</td>
<td>$760,65</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$4.614,48</td>
<td>$492,21</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$18.655,05</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>84720,6</td>
<td>$5.003,99</td>
</tr>
<tr>
<td>5999,52</td>
<td>$405,40</td>
</tr>
<tr>
<td>53999,16</td>
<td>$2.418,48</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$7.827,86</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unitario*</th>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>12000</td>
<td>$13.920,00</td>
<td>$2.582,16</td>
</tr>
<tr>
<td>12000</td>
<td>$13.920,00</td>
<td>$2.338,56</td>
</tr>
<tr>
<td>12000</td>
<td>$13.920,00</td>
<td>$1.662,45</td>
</tr>
<tr>
<td>12000</td>
<td>$13.920,00</td>
<td>$859,06</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td></td>
<td><strong>$7.442,23</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>77999,56</td>
<td>$9.348,25</td>
</tr>
<tr>
<td>44199,48</td>
<td>$3.695,08</td>
</tr>
<tr>
<td>27199,68</td>
<td>$321,64</td>
</tr>
<tr>
<td><strong>TOTAL</strong></td>
<td><strong>$13.364,96</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$69,60</td>
<td>$278,40</td>
</tr>
<tr>
<td>$</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>---</td>
</tr>
<tr>
<td>$34,80</td>
<td></td>
</tr>
<tr>
<td>$63,80</td>
<td></td>
</tr>
<tr>
<td>$30.000,00</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Costo total**  $ 79.876,90
**TUBERIA/ACERO**

<table>
<thead>
<tr>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
<th>Costo Unit. + IVA</th>
</tr>
</thead>
<tbody>
<tr>
<td>cm</td>
<td>2</td>
<td>127</td>
<td>Tubería redonda C.20 * 1&quot;</td>
<td>9317</td>
<td>10807,72</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>95</td>
<td>Tubería redonda C.18 * 1&quot;</td>
<td>11354</td>
<td>13170,64</td>
</tr>
<tr>
<td>cm</td>
<td>3</td>
<td>42</td>
<td>Tubería redonda C.18 * 1&quot;</td>
<td>11354</td>
<td>13170,64</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>132</td>
<td>Tubería redonda C.18 * 1&quot;</td>
<td>11354</td>
<td>13170,64</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>15</td>
<td>Tubería redonda C.20 * 1&quot;</td>
<td>9317</td>
<td>10807,72</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>37</td>
<td>Tubería redonda C.20 * 1&quot;</td>
<td>9317</td>
<td>10807,72</td>
</tr>
<tr>
<td>cm</td>
<td>2</td>
<td>52,5</td>
<td>Tubería redonda C.18 * 3/8&quot;</td>
<td>3978*</td>
<td>4614,48</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>128</td>
<td>Tubería redonda C.18 * 3/8&quot;</td>
<td>3978*</td>
<td>4614,48</td>
</tr>
<tr>
<td>cm</td>
<td>4</td>
<td>15</td>
<td>Tubería redonda C.18 * 3/8&quot;</td>
<td>3978*</td>
<td>4614,48</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>80</td>
<td>Tubería redonda C.18 * 3/8&quot;</td>
<td>3978*</td>
<td>4614,48</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>32</td>
<td>Tubería redonda C.18 * 1&quot;</td>
<td>11354</td>
<td>13170,64</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>28</td>
<td>Tubería redonda C.18 * 5/8&quot;</td>
<td>7612</td>
<td>8829,92</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>112</td>
<td>Tubería redonda C.18 * 3/4&quot;</td>
<td>8387</td>
<td>9728,92</td>
</tr>
<tr>
<td>cm</td>
<td>1</td>
<td>32</td>
<td>Tubería redonda C.18 * 3/4&quot;</td>
<td>8387</td>
<td>9728,92</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 600cm, para las demás referencias

**MADERAS**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>1840</td>
<td>Aglomerado de 15mm</td>
<td>46551</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1840</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>231</td>
<td>Aglomerado de 15mm</td>
<td>46551</td>
</tr>
<tr>
<td>Piecero</td>
<td>cm²</td>
<td>1</td>
<td>576</td>
<td>Aglomerado de 15mm</td>
<td>46551</td>
</tr>
<tr>
<td>Asiento (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>1330</td>
<td>Aglomerado de 15mm</td>
<td>46551</td>
</tr>
<tr>
<td>Espalda (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>731,25</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
<tr>
<td>Almohadilla</td>
<td>cm²</td>
<td>1</td>
<td>297</td>
<td>Aglomerado de 12mm</td>
<td>39310</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 37332 cm²

*el IVA para este material es del 16%
<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>2016</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>1584</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>2100</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1932</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1400</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>306</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>480</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Asiento (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>1480</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Asiento (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>1350</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>884</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>748</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Espalda (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>636</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Almohadilla</td>
<td>cm²</td>
<td>1</td>
<td>576</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
<tr>
<td>Piecero</td>
<td>cm²</td>
<td>1</td>
<td>1050</td>
<td>Telas plasticas</td>
<td>12000</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 14000cm²
*el IVA para este material es del 16%

**ESPUMA**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Cantidad</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>1840</td>
<td>Espuma casata de 5 cm</td>
<td>53448</td>
</tr>
<tr>
<td>Asiento</td>
<td>cm²</td>
<td>1</td>
<td>1840</td>
<td>Densidad 26 de 1 cm</td>
<td>7759</td>
</tr>
<tr>
<td>Espalda</td>
<td>cm²</td>
<td>1</td>
<td>1840</td>
<td>Densidad 26 de 5 cm</td>
<td>38793</td>
</tr>
<tr>
<td>Brazos</td>
<td>cm²</td>
<td>2</td>
<td>231</td>
<td>Densidad 26 de 5 cm</td>
<td>23448</td>
</tr>
<tr>
<td>Asiento (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>1330</td>
<td>Espuma casata de 5 cm</td>
<td>53448</td>
</tr>
<tr>
<td>Asiento (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>1330</td>
<td>Densidad 26 de 1 cm</td>
<td>7759</td>
</tr>
<tr>
<td>Espalda (Butaco)</td>
<td>cm²</td>
<td>1</td>
<td>731,25</td>
<td>Densidad 26 de 3 cm</td>
<td>22414</td>
</tr>
<tr>
<td>Almohadilla</td>
<td>cm²</td>
<td>1</td>
<td>297</td>
<td>Densidad 26 de 3 cm</td>
<td>22414</td>
</tr>
<tr>
<td>Piecero</td>
<td>cm²</td>
<td>1</td>
<td>1050</td>
<td>Densidad 26 de 5 cm</td>
<td>23448</td>
</tr>
</tbody>
</table>

*el precio unitario viene dado para una medida de 20000cm²
*el IVA para este material es del 16%

**MATERIALES VARIOS**

<table>
<thead>
<tr>
<th>Subparte</th>
<th>Unidad de Medida</th>
<th>Medida</th>
<th>Descripción</th>
<th>Costo Unitario*</th>
<th>Costo Unit. + IVA</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>unidad</td>
<td></td>
<td>1&quot; Int.</td>
<td></td>
<td>$</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>---</td>
<td>---------</td>
<td>---</td>
<td>------</td>
</tr>
<tr>
<td>Tapones</td>
<td></td>
<td>10</td>
<td></td>
<td></td>
<td>60,00</td>
</tr>
<tr>
<td>tuercas</td>
<td></td>
<td>4</td>
<td>Tuerca de uña de 3/16</td>
<td></td>
<td>50,00</td>
</tr>
<tr>
<td>tornillos</td>
<td></td>
<td>4</td>
<td>tornillos 3/4*3/16</td>
<td></td>
<td>30,00</td>
</tr>
<tr>
<td>Cromado Est.Metalica</td>
<td></td>
<td>1</td>
<td>Cromado Estructura metalica</td>
<td></td>
<td>22,413,00</td>
</tr>
</tbody>
</table>

**TOTAL**

**COSTO TOTAL**
<table>
<thead>
<tr>
<th>Costo prorrateado</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>4.575,27</td>
</tr>
<tr>
<td>$</td>
<td>4.170,70</td>
</tr>
<tr>
<td>$</td>
<td>2.765,83</td>
</tr>
<tr>
<td>$</td>
<td>2.897,54</td>
</tr>
<tr>
<td>$</td>
<td>540,39</td>
</tr>
<tr>
<td>$</td>
<td>666,48</td>
</tr>
<tr>
<td>$</td>
<td>1.615,07</td>
</tr>
<tr>
<td>$</td>
<td>1.968,84</td>
</tr>
<tr>
<td>$</td>
<td>922,90</td>
</tr>
<tr>
<td>$</td>
<td>1.230,53</td>
</tr>
<tr>
<td>$</td>
<td>702,43</td>
</tr>
<tr>
<td>$</td>
<td>412,06</td>
</tr>
<tr>
<td>$</td>
<td>1.816,07</td>
</tr>
<tr>
<td>$</td>
<td>518,88</td>
</tr>
<tr>
<td>$</td>
<td>24.802,98</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>53.999,16</td>
</tr>
<tr>
<td>$</td>
<td>53.999,16</td>
</tr>
<tr>
<td>$</td>
<td>45.599,60</td>
</tr>
<tr>
<td>$</td>
<td>45.599,60</td>
</tr>
<tr>
<td>$</td>
<td>53.999,16</td>
</tr>
<tr>
<td>$</td>
<td>53.999,16</td>
</tr>
<tr>
<td>$</td>
<td>45.599,60</td>
</tr>
<tr>
<td>$</td>
<td>45.599,60</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$ 9.227,38</td>
</tr>
<tr>
<td>Costo Unit. + IVA</td>
<td>Costo prorrateado</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 2.004,48</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 1.574,95</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 2.088,00</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 1.920,96</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 1.392,00</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 608,50</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 954,51</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 1.471,54</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 1.342,29</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 878,95</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 743,73</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 632,37</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 572,71</td>
</tr>
<tr>
<td>$ 13.920,00</td>
<td>$ 1.044,00</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$ 10.543,41</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Costo Unit. + IVA</th>
<th>Costo prorrateado</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ 61.999,68</td>
<td>$ 5.703,97</td>
</tr>
<tr>
<td>$ 9.000,44</td>
<td>$ 828,04</td>
</tr>
<tr>
<td>$ 44.999,88</td>
<td>$ 4.139,99</td>
</tr>
<tr>
<td>$ 27.199,68</td>
<td>$ 628,31</td>
</tr>
<tr>
<td>$ 61.999,68</td>
<td>$ 4.122,98</td>
</tr>
<tr>
<td>$ 9.000,44</td>
<td>$ 598,53</td>
</tr>
<tr>
<td>$ 26.000,24</td>
<td>$ 950,63</td>
</tr>
<tr>
<td>$ 26.000,24</td>
<td>$ 386,10</td>
</tr>
<tr>
<td>$ 27.199,68</td>
<td>$ 1.427,98</td>
</tr>
<tr>
<td>TOTAL</td>
<td>$ 18.786,54</td>
</tr>
</tbody>
</table>

Costo prorrateado
<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Valor H/H*</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>$ 4.740,90</td>
<td>Cerrajeria</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soldadura</td>
</tr>
<tr>
<td>Tapicería y Costura</td>
<td>$ 4.250,00</td>
<td>Tapicería</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
</tr>
</tbody>
</table>
### Actividad | Tiempo empleado (min) |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cortar</td>
<td>3</td>
</tr>
<tr>
<td>Figurado (Doblar)</td>
<td>7</td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>5</td>
</tr>
<tr>
<td>Union Partes (Soldar)</td>
<td>10</td>
</tr>
<tr>
<td>Pulido</td>
<td>5</td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>5</td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>35</strong></td>
</tr>
<tr>
<td>Corte madera</td>
<td>10</td>
</tr>
<tr>
<td>Figurado</td>
<td>6</td>
</tr>
<tr>
<td>Pulimento</td>
<td>2</td>
</tr>
<tr>
<td>Corte espuma</td>
<td>7</td>
</tr>
<tr>
<td>Pegado y secado</td>
<td>15</td>
</tr>
<tr>
<td>Contras</td>
<td>15</td>
</tr>
<tr>
<td>Tapizado</td>
<td>15</td>
</tr>
<tr>
<td>Costura</td>
<td>15</td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>85</strong></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>2</td>
</tr>
<tr>
<td>Proceso de ensamblle</td>
<td>7</td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>3</td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>12</strong></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td><strong>132</strong></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Valor H/H*</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 4.482,62</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$ 4.173,00</td>
</tr>
</tbody>
</table>
### Mesa manicure Oval

<table>
<thead>
<tr>
<th>Actividad</th>
<th>Tiempo empleado (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corte de madera</td>
<td>20</td>
</tr>
<tr>
<td>Armado de pieza</td>
<td>30</td>
</tr>
<tr>
<td>Cepillado y pulido</td>
<td>5</td>
</tr>
<tr>
<td>Corte de fórmica</td>
<td>15</td>
</tr>
<tr>
<td>Aplicación y secado de pegamento</td>
<td>45</td>
</tr>
<tr>
<td>Terminado y pulido</td>
<td>15</td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>130</strong></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>5</td>
</tr>
<tr>
<td>Proceso de ensamble</td>
<td>10</td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>20</td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>35</strong></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td><strong>165</strong></td>
</tr>
</tbody>
</table>
$ 9,712.35

$ 2,434.25

$ 12,146.60
<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Valor H/H*</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajería y Soldadura</td>
<td>$ 4.740,90</td>
<td>Cerrajería</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soldadura</td>
</tr>
<tr>
<td>Tapicería y Costura</td>
<td>$ 4.250,00</td>
<td>Tapicería</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura</td>
</tr>
<tr>
<td>Ensamble General y Terminado</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
</tr>
</tbody>
</table>
### Tabla de Actividades y Tiempo Empleado

<table>
<thead>
<tr>
<th>Actividad</th>
<th>Tiempo empleado (min)</th>
<th>SubTotal (Min)</th>
<th>SubTotal (Min) Costo ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cortar</td>
<td>5</td>
<td>95</td>
<td>$ 7.506,43</td>
</tr>
<tr>
<td>Figurado (Doblar)</td>
<td>23</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Union Partes (Soldar)</td>
<td>40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulido</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td>95</td>
<td></td>
<td><strong>$ 7.506,43</strong></td>
</tr>
<tr>
<td>Corte madera</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Figurado</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulimento</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corte espuma</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pegado y secado</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contras</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tapizado</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Costura</td>
<td>25</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td>148</td>
<td></td>
<td><strong>$ 10.483,33</strong></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proceso de ensamble</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td>40</td>
<td></td>
<td><strong>$ 2.782,00</strong></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td>283</td>
<td></td>
<td><strong>$ 20.771,76</strong></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Valor H/H*</td>
<td>Area</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------</td>
<td>---------------------------</td>
<td></td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 4.482,62</td>
<td>Corte madera</td>
<td></td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
<td></td>
</tr>
<tr>
<td>Actividad</td>
<td>Tiempo empleado (min)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corte de madera</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Armado de pieza</td>
<td>90</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cepillado y pulido</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corte de fórmica</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aplicación y secado de pegamento</td>
<td>75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminado y pulido</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>272</strong></td>
<td><strong>$ 20.321,22</strong></td>
<td></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proceso de ensamblle</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>40</strong></td>
<td><strong>$ 2.782,00</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td><strong>312</strong></td>
<td><strong>$ 23.103,22</strong></td>
<td></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Valor H/H*</td>
<td>Area</td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>$ 4.740,90</td>
<td>Cerrajería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soldadura</td>
<td></td>
</tr>
<tr>
<td>Tapicería y Costura</td>
<td>$ 4.250,00</td>
<td>Tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura</td>
<td></td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
<td></td>
</tr>
<tr>
<td>Actividad</td>
<td>Tiempo empleado (min)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>Cortar</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Figurado (Doblar)</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Union Partes (Soldar)</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulido</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>57</strong></td>
<td><strong>$ 4.503,86</strong></td>
<td></td>
</tr>
<tr>
<td>Corte madera</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Figurado</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulimento</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corte espuma</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pegado y secado</td>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contras</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tapizado</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Costura</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>69</strong></td>
<td><strong>$ 4.887,50</strong></td>
<td></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proceso de ensamblle</td>
<td>40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>52</strong></td>
<td><strong>$ 3.616,60</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td><strong>178</strong></td>
<td><strong>$ 13.007,96</strong></td>
<td></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Valor H/H*</td>
<td>Area</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------</td>
<td>-----------------------</td>
<td></td>
</tr>
<tr>
<td>Cerrajería y Soldadura</td>
<td>$          4.740,90</td>
<td>Cerrajería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soldadura</td>
<td></td>
</tr>
<tr>
<td>Tapicería y Costura</td>
<td>$          4.250,00</td>
<td>Tapicería</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura</td>
<td></td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$          4.482,62</td>
<td>Corte madera</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enchape de madera</td>
<td></td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$          4.173,00</td>
<td>Ensamble</td>
<td></td>
</tr>
</tbody>
</table>
### Conjunto manicure y pedicure

<table>
<thead>
<tr>
<th>Actividad</th>
<th>Tiempo empleado (min)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cortar</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>figurado</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Union Partes (Soldar)</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>Pulido</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>84</strong></td>
<td><strong>$6.637,26</strong></td>
</tr>
<tr>
<td>Corte madera</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Figurado</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Pulimento</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Corte espuma</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Pegado y secado</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contras</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Tapizado</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Costura</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>166</strong></td>
<td><strong>$11.758,33</strong></td>
</tr>
<tr>
<td>Corte de madera</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Armado de pieza</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Cepillado y pulido</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Corte de fórmica</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Aplicación y secado de pegamento</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Terminado y pulido</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>60</strong></td>
<td><strong>$4.482,62</strong></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Proceso de ensamble</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>55</strong></td>
<td><strong>$3.825,25</strong></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td><strong>365</strong></td>
<td><strong>$26.703,47</strong></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Valor H/H*</td>
<td>Area</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>$ 4.740,90</td>
<td>Cerrajeria</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soldadura</td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
</tr>
<tr>
<td>Actividad</td>
<td>Tiempo empleado (min)</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------</td>
<td></td>
</tr>
<tr>
<td>Cortar</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Figurado (Doblar)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Union Partes (Soldar)</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Pulido</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

| SubTotal (Min)                  | 53                    | $ 4.187,80  |
|---------------------------------|-----------------------|
| Revision de subpartes           | 3                     |
| Proceso de ensamble             | 3                     |
| Terminado y Limpieza            | 3                     |

| SubTotal (Min)                  | 9                     | $ 625,95    |

<p>| Total tiempo empleado           | 62                    | $ 4.813,75  |</p>
<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Valor H/H*</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 4.482,62</td>
<td>Corte madera Enchape de madera</td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
</tr>
<tr>
<td>Actividad</td>
<td>Tiempo empleado (min)</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------</td>
<td></td>
</tr>
<tr>
<td>Corte de madera</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Armado de pieza</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>Cepillado y pulido</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Corte de fórmica</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Aplicación y secado de pegamento</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>Terminado y pulido</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>355</strong></td>
<td><strong>$ 26.522,18</strong></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Proceso de ensamblle</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>23</strong></td>
<td><strong>$ 1.599,65</strong></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td><strong>378</strong></td>
<td><strong>$ 28.121,83</strong></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Valor H/H*</td>
<td>Area</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$4.482,62</td>
<td>Corte madera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enchape de</td>
</tr>
<tr>
<td></td>
<td></td>
<td>madera</td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>$4.740,90</td>
<td>Cerrajeria</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soldadura</td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$4.173,00</td>
<td>Ensamble</td>
</tr>
<tr>
<td>Actividad</td>
<td>Tiempo empleado (min)</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------</td>
<td></td>
</tr>
<tr>
<td>Corte de madera</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>Armado de pieza</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Cepillado y pulido</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Corte de fórmica</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Aplicación y secado de pegamento</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>Terminado y pulido</td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>
| **SubTotal (Min)**                | **310**               | $ 23.160,22
| Cortar                            | 10                    |
| Figurado (Doblar)                 | 5                     |
| Calibración (Mediciones)          | 10                    |
| Union Partes (Soldar)             | 40                    |
| Pulido                            | 3                     |
| Calibración (Mediciones)          | 3                     |
| **SubTotal (Min)**                | **71**                | $ 5.610,07
| Revision de subpartes             | 5                     |
| Proceso de ensamble               | 15                    |
| Terminado y Limpieza              | 7                     |
| **SubTotal (Min)**                | **27**                | $ 1.877,85

<p>| Total tiempo empleado             | 408                   | $ 30.648,13 |</p>
<table>
<thead>
<tr>
<th>Centro de Coste</th>
<th>Valor H/H*</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corte, enchape y tratamiento de maderas</td>
<td>$ 4.482,62</td>
<td>Corte madera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enchape de madera</td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
</tr>
<tr>
<td>Actividad</td>
<td>Tiempo empleado (min)</td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------</td>
<td></td>
</tr>
<tr>
<td>Corte de madera</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>Armado de pieza</td>
<td>180</td>
<td></td>
</tr>
<tr>
<td>Cepillado y pulido</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Corte de fórmica</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Aplicación y secado de pegamento</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Terminado y pulido</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>345</strong></td>
<td><strong>$ 25.775,08</strong></td>
</tr>
<tr>
<td>Revision de subpartes</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Proceso de ensamble</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td><strong>SubTotal (Min)</strong></td>
<td><strong>50</strong></td>
<td><strong>$ 3.477,50</strong></td>
</tr>
<tr>
<td><strong>Total tiempo empleado</strong></td>
<td><strong>395</strong></td>
<td><strong>$ 29.252,58</strong></td>
</tr>
<tr>
<td>Centro de Coste</td>
<td>Valor H/H*</td>
<td>Area</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Cerrajeria y Soldadura</td>
<td>$ 4.740,90</td>
<td>Cerrajeria</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Soldadura</td>
</tr>
<tr>
<td>Tapiceria y Costura</td>
<td>$ 4.250,00</td>
<td>Tapiceria</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura</td>
</tr>
<tr>
<td>Ensamble General y</td>
<td>$ 4.173,00</td>
<td>Ensamble</td>
</tr>
</tbody>
</table>
### Tabla de Actividades y Tiempos Empleado

<table>
<thead>
<tr>
<th>Actividad</th>
<th>Tiempo empleado (min)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cortar</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Figurado (Doblar)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Union Partes (Soldar)</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Pulido</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Calibración (Mediciones)</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

| SubTotal (Min)       | 80                    | $ 6.321,20 |

<table>
<thead>
<tr>
<th>Actividad</th>
<th>Tiempo empleado (min)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Corte madera</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Figurado</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Pulimento</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Corte espuma</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>Pegado y secado</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contras</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Tapizado</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Costura</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

| SubTotal (Min)       | 123                   | $ 8.712,50 |

<table>
<thead>
<tr>
<th>Actividad</th>
<th>Tiempo empleado (min)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision de subpartes</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Proceso de ensamble</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Terminado y Limpieza</td>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

| SubTotal (Min)       | 25                    | $ 1.738,75 |

<p>| Total tiempo empleado| 228                   | $ 16.772,45 |</p>
<table>
<thead>
<tr>
<th>AREA DE PRODUCCION</th>
<th>VLR HORA OBRA MANO</th>
<th>AUX. TRANS VR HORA</th>
<th>SALUD 8,5%</th>
<th>PENSION 12%</th>
<th>ARP 1,05%</th>
<th>ICBF 3%</th>
<th>SENA 2%</th>
<th>COMF 4%</th>
<th>CESANTIAS 8,33%</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAPICERIA</td>
<td>2.500</td>
<td>293,75</td>
<td>212,50</td>
<td>300,00</td>
<td>26,15</td>
<td>75,00</td>
<td>50,00</td>
<td>100,00</td>
<td>232,72</td>
</tr>
<tr>
<td>COSTURA</td>
<td>2.625</td>
<td>293,75</td>
<td>223,13</td>
<td>315,00</td>
<td>27,46</td>
<td>78,75</td>
<td>52,50</td>
<td>105,00</td>
<td>243,13</td>
</tr>
<tr>
<td>CERRAJERIA</td>
<td>2.938</td>
<td>293,75</td>
<td>249,73</td>
<td>352,56</td>
<td>30,73</td>
<td>88,14</td>
<td>58,76</td>
<td>117,52</td>
<td>269,20</td>
</tr>
<tr>
<td>SOLDADURA</td>
<td>2.831</td>
<td>293,75</td>
<td>240,64</td>
<td>339,72</td>
<td>29,61</td>
<td>84,93</td>
<td>56,62</td>
<td>113,24</td>
<td>260,29</td>
</tr>
<tr>
<td>CARPINTERIA</td>
<td>2.715</td>
<td>293,75</td>
<td>230,78</td>
<td>325,80</td>
<td>28,40</td>
<td>81,45</td>
<td>54,30</td>
<td>108,60</td>
<td>250,63</td>
</tr>
<tr>
<td>ARMADURIA</td>
<td>2.500</td>
<td>293,75</td>
<td>212,50</td>
<td>300,00</td>
<td>26,15</td>
<td>75,00</td>
<td>50,00</td>
<td>100,00</td>
<td>232,72</td>
</tr>
<tr>
<td>LIMPIEZA</td>
<td>2.206</td>
<td>293,75</td>
<td>187,51</td>
<td>264,72</td>
<td>23,07</td>
<td>66,18</td>
<td>44,12</td>
<td>88,24</td>
<td>208,23</td>
</tr>
<tr>
<td>CONTROL CALIDAD</td>
<td>2.831</td>
<td>293,75</td>
<td>240,64</td>
<td>339,72</td>
<td>29,61</td>
<td>84,93</td>
<td>56,62</td>
<td>113,24</td>
<td>260,29</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AREA DE PRODUCCION</th>
<th>MENSUAL</th>
<th>DIARIO</th>
<th>VR HORA</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAPICERIA</td>
<td>600.000</td>
<td>20.000</td>
<td>2.500</td>
</tr>
<tr>
<td>PROMEDIO</td>
<td>600.000</td>
<td>20.000</td>
<td>2.500</td>
</tr>
<tr>
<td>GUSTAVO HIJO</td>
<td>450.000</td>
<td>0</td>
<td>2.500</td>
</tr>
<tr>
<td>JHON EDUARD FLOREZ</td>
<td>750.000</td>
<td>0</td>
<td>2.500</td>
</tr>
<tr>
<td>ANDERSON</td>
<td>600.000</td>
<td>0</td>
<td>2.500</td>
</tr>
<tr>
<td>COSTURA</td>
<td>0</td>
<td>0</td>
<td>2.625</td>
</tr>
<tr>
<td>MARLENY HINCAPIE</td>
<td>630.000</td>
<td>21.000</td>
<td>2.625</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AREA DE PRODUCCION</th>
<th>MENSUAL</th>
<th>DIARIO</th>
<th>VR HORA</th>
</tr>
</thead>
<tbody>
<tr>
<td>CERRAJERIA</td>
<td></td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>JAVIER TORO</td>
<td>705.000</td>
<td>23.500</td>
<td>2.938</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Departamento</td>
<td>Total Horas</td>
<td>Total Salario</td>
<td>Horas Extras</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>SOLDADURA</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>IVAN HINCAPIE</td>
<td>679.500</td>
<td>679.500</td>
<td>22.650</td>
</tr>
<tr>
<td>CARPINTERIA</td>
<td>651.500</td>
<td>651.500</td>
<td>21.717</td>
</tr>
<tr>
<td>FRANCISCO TORO</td>
<td>705.000</td>
<td>705.000</td>
<td>0</td>
</tr>
<tr>
<td>CARLOS CHALARCA</td>
<td>634.500</td>
<td>634.500</td>
<td>0</td>
</tr>
<tr>
<td>LUIS ROMERO</td>
<td>615.000</td>
<td>615.000</td>
<td>0</td>
</tr>
<tr>
<td>ARMADURIA</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LAZARO GONZALEZ</td>
<td>600.000</td>
<td>600.000</td>
<td>20.000</td>
</tr>
<tr>
<td>LIMPIEZA</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LUIS FERNANDO HINCAPIE</td>
<td>529.500</td>
<td>529.500</td>
<td>17.650</td>
</tr>
<tr>
<td>CONTROL DE CALIDAD</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>WALTER GONZALEZ</td>
<td>679.500</td>
<td>679.500</td>
<td>22.650</td>
</tr>
<tr>
<td>INTER CESAN 12%</td>
<td>PRIMA 8.33%</td>
<td>VACACIONES 4,17%</td>
<td>VR TOTAL MANO OBRA</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>27,93</td>
<td>232,72</td>
<td>104,25</td>
<td>4.155,02</td>
</tr>
<tr>
<td>29,18</td>
<td>243,13</td>
<td>109,46</td>
<td>4.345,48</td>
</tr>
<tr>
<td>32,30</td>
<td>269,20</td>
<td>122,51</td>
<td>4.822,42</td>
</tr>
<tr>
<td>31,24</td>
<td>260,29</td>
<td>118,05</td>
<td>4.659,38</td>
</tr>
<tr>
<td>30,08</td>
<td>250,63</td>
<td>113,22</td>
<td>4.482,62</td>
</tr>
<tr>
<td>27,93</td>
<td>232,72</td>
<td>104,25</td>
<td>4.155,02</td>
</tr>
<tr>
<td>24,99</td>
<td>208,23</td>
<td>91,99</td>
<td>3.707,03</td>
</tr>
<tr>
<td>31,24</td>
<td>260,29</td>
<td>118,05</td>
<td>4.659,38</td>
</tr>
</tbody>
</table>

0
ESTUDIO DE COSTOS DE PRODUCCIÓN MEDIANTE EL MÉTODO TRADICIONAL Y EL MÉTODO ABC EN LA EMPRESA MUEBLES YOLY SIMULADO EN EL SOFTWARE PROMODEL

Ejecutado por: Juan Camilo Rodríguez V.
Julián Alberto Garcés H.

Director: Eduardo Arturo Cruz.
Resumen

En el presente trabajo de grado se establecen los costos de producción mediante las metodologías tradicional y ABC. Brindando soluciones de alta calidad a la problemática que encierra determinar los rubros concernientes a Materia Prima, Costo de Mano de Obra y Costos Indirectos de Fabricación en la Empresa Muebles Yoly.
Fase 1: Recolección, descripción y toma de información preliminar.

Fase 2: Estructura de costos por el método tradicional y método ABC.

Fase 3: Determinación de tiempos de fabricación, materias primas directas y costos Indirectos de los productos de estudio.

Fase 4: Simulación en Promodel, Interpretación de resultados obtenidos y posterior socialización.
Fase 1: Recolección, descripción y toma de información preliminar.

Identificar los productos que para la empresa representan mayor volumen de ventas y alto margen de rentabilidad.

Describir el actual sistema de costeo de la fábrica y las dificultades que este sistema presenta.
Identificar los productos que para la empresa representan mayor volumen de ventas y alto margen de rentabilidad.

Catálogos.

Entrevistas.

Visitas a las Áreas de Producción.

Criterios de Representatividad.
Describir el actual sistema de costeo de la fábrica y las dificultades que este sistema presenta.

Descripción previa del concepto de Costos a los Propietarios

Charlas, diálogos e interacción acerca del S.A.C

Ventajas y oportunidades de mejoras identificadas

Concertación
Fase 2: Estructura de costos por el método tradicional y método ABC.

**Identificar** los centros de costos y/o procesos que se llevan a cabo para la fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.

**Establecer las actividades y tareas relevantes que hacen parte de los procesos productivos, de los productos con mayor volumen de ventas y alto margen de rentabilidad.**

**Identificar los inductores (cost drivers) asociados a las tareas que se llevan a cabo en la fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.**

**Establecer la estructura del flujo de costos de los procesos identificados al interior de la empresa.**
Identificar los centros de costos y/o procesos que se llevan a cabo para la fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.

- **C&S**
  - Centro de Cerrajería y Soldadura.

- **EC&TM**
  - Centro de Enchape, Corte y Tratamiento de Maderas Aglomeradas.

- **T&C**
  - Centro de Tapicería y Costura.

- **E&T**
  - Centro de Ensamble y Terminado.

- **A&V**
  - Centro Administrativo y de ventas
Establecer las actividades y tareas relevantes que hacen parte de los procesos productivos, de los productos con mayor volumen de ventas y alto margen de rentabilidad.

<table>
<thead>
<tr>
<th>Centro de Costos</th>
<th>Área</th>
<th>Actividades</th>
<th>Detalle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cerrajería y Soldadura</td>
<td>Cerrajería</td>
<td>Cortar</td>
<td>Corte de Tubería en Acero</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Figurado</td>
<td>Dobladado Mecánico de Partes Metálicas</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calibración (Mediciones)</td>
<td>Revisión de Calidad de Acabados</td>
</tr>
<tr>
<td></td>
<td>Soldadura</td>
<td>Pulido</td>
<td>Perfeccionamiento de la pieza Soldada</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calibración (Mediciones)</td>
<td>Revisión de Calidad de Acabados</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unión de Partes (Soldar)</td>
<td>Soldadura y/o Unión de Partes Metálicas</td>
</tr>
<tr>
<td>Tapicería y Costura</td>
<td>Tapicería</td>
<td>Pulido</td>
<td>Perfeccionamiento de la Pieza de Madera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte de Madera</td>
<td>Corte de Maderas Aglomeradas</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Figurado</td>
<td>Diseño Final de la Pieza de Madera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pegado y Secado</td>
<td>Aplicación de Pegamentos a Espuma y Madera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contras</td>
<td>Diseño y Corte de Moldes Traseros de la Pieza</td>
</tr>
<tr>
<td></td>
<td>Costura</td>
<td>Tapizado</td>
<td>Unión de la Madera, Espuma y Plástico</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costura</td>
<td>Corte de Plásticos y Costura de estos</td>
</tr>
<tr>
<td>Corte, Enchape y Tratamiento de Maderas</td>
<td>Corte de Madera</td>
<td>Corte de Madera</td>
<td>Corte de Maderas Aglomeradas</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Armado de Pieza</td>
<td>Unión de Partes de Madera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cepillado y Pulido</td>
<td>Perfeccionamiento de la Madera</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corte de Fórmica</td>
<td>Corte de Láminas de Fórmica</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Aplicación y Secado de Pegamento</td>
<td>Aplicación de Pegamentos a Madera y Fórmica</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Terminado y Pulido</td>
<td>Revisión de Calidad de Acabados</td>
</tr>
<tr>
<td>Ensamble</td>
<td>Ensamble</td>
<td>Revisión de subpartes</td>
<td>Inspección de Subpartes de los demás Centros</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Proceso de ensamble</td>
<td>Unión de Subpartes de los demás Centros</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Terminado y Limpieza</td>
<td>Revisión de Calidad de Acabados</td>
</tr>
<tr>
<td>Administrativo</td>
<td>Gestión Administrativa y de Ventas</td>
<td>Facturación</td>
<td>Proceso de Emisión de Facturas</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Compras</td>
<td>Gestión de Aprovisionamiento de MP</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tesorería</td>
<td>Gestión de Pagos a Proveedores y Cobros Clientes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contabilidad</td>
<td>Documentación Legal a nivel Contable</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ventas</td>
<td>Administración y Gestión de Ventas</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Servicios Generales</td>
<td>Cartas, Recomendaciones, informes varios.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gerencia Administrativa</td>
<td>Direcciónamiento Estratégico de todas las Áreas</td>
</tr>
</tbody>
</table>
Identificar los inductores (*cost drivers*) asociados a las tareas que se llevan a cabo en la fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.
Establecer la estructura del flujo de costos de los procesos identificados al interior de la empresa.
Fase 3: Determinación de tiempos de fabricación, materias primas directas y costos Indirectos de los productos de estudio.

Identificar los costos de las materias primas que se utilizan en la fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.

Determinar los tiempos de fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.

Establecer los costos indirectos de fabricación en que se incurren en la producción de los productos con mayor volumen de ventas y alto margen de rentabilidad.
Identificar los costos de las materias primas que se utilizan en la fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.

Porcentaje de Costos de Materia Prima Directa Por Centro de Costo.

- Tubería en Acero: 11%
- Madera Aglomerada: 19%
- Ensamble: 52%
- Costura: 18%
- Enchape: 19%

Materiales:
- Fórmica
- Espuma y/o FibroEspuma
- Telas Plásticas
Determinar los tiempos de fabricación de los productos con mayor volumen de ventas y alto margen de rentabilidad.

<table>
<thead>
<tr>
<th>Producto</th>
<th>Cerrajería y Soldadura (Min)</th>
<th>Enchape (Min)</th>
<th>Costura y Tapicería (Min)</th>
<th>Ensamble (Min)</th>
<th>Total tiempo por producto (Min)</th>
<th>Costo de Mano de Obra Directa por producto ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Butaco M</td>
<td>3 7 5 10 5 5</td>
<td>10 6 2 7 15 15</td>
<td>15 15 15 15 2 7 3</td>
<td>132</td>
<td>$ 9.620,96</td>
<td></td>
</tr>
<tr>
<td>Mesa manicure Oval</td>
<td>20 30 5 15 45 15</td>
<td>5 10 20</td>
<td></td>
<td>165</td>
<td>$ 12.146,60</td>
<td></td>
</tr>
<tr>
<td>Peinador Yoly</td>
<td>60 90 17 15 75 15</td>
<td>5 15 20</td>
<td></td>
<td>312</td>
<td>$ 23.103,22</td>
<td></td>
</tr>
<tr>
<td>Silla peluquería yoly</td>
<td>5 23 17 40 5 5</td>
<td>10 10 3 5 20 15</td>
<td>60 25 15 20 5</td>
<td>283</td>
<td>$ 20.771,76</td>
<td></td>
</tr>
<tr>
<td>Peinador Roma</td>
<td>45 180 15 25 60 20</td>
<td>5 30 15</td>
<td></td>
<td>395</td>
<td>$ 29.252,58</td>
<td></td>
</tr>
<tr>
<td>Mesa manicure RACC</td>
<td>45 90 10 15 130 20</td>
<td>5 15 7</td>
<td></td>
<td>337</td>
<td>$ 25.038,07</td>
<td></td>
</tr>
<tr>
<td>Auxiliar de manicure</td>
<td>60 120 15 15 120 25</td>
<td>3 15 5</td>
<td></td>
<td>378</td>
<td>$ 28.121,83</td>
<td></td>
</tr>
<tr>
<td>Silla yoly en acero</td>
<td>5 10 10 20 5 3</td>
<td>3 3 3</td>
<td></td>
<td>62</td>
<td>$ 4.813,75</td>
<td></td>
</tr>
<tr>
<td>Lavacabezas yoly</td>
<td>5 15 10 17 5 5</td>
<td>10 5 2 7 20 0</td>
<td>10 15 5 40 7</td>
<td>178</td>
<td>$ 13.007,96</td>
<td></td>
</tr>
<tr>
<td>Silla peluquería karen</td>
<td>10 10 10 40 5 5</td>
<td>10 13 3 7 20 10</td>
<td>10 50 10 3 15 7</td>
<td>228</td>
<td>$ 16.772,45</td>
<td></td>
</tr>
<tr>
<td>Conjunto manicure y pedicure</td>
<td>12 15 12 35 5 5</td>
<td>13 10 5 13 20 15</td>
<td>30 60 10 30 15</td>
<td>365</td>
<td>$ 26.703,47</td>
<td></td>
</tr>
<tr>
<td><strong>Total Minutos por Actividad</strong></td>
<td>40 80 64 162 30 28 235 510 67 90 450 120</td>
<td>53 44 15 39 95 55 165 125</td>
<td>61 200 107 2835</td>
<td>$ 209.352,63</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Total Minutos por Centro de Costo</th>
<th>404</th>
<th>1472</th>
<th>591</th>
<th>368</th>
<th>100%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Porcentaje de partipacion de tiempo por Centro de Costo</td>
<td>14%</td>
<td>52%</td>
<td>21%</td>
<td>13%</td>
<td>100%</td>
</tr>
<tr>
<td>Costo de Mano de Obra Directa Por Centro de Costo</td>
<td>$ 31.922,06</td>
<td>$ 109.973,67</td>
<td>$ 41.862,50</td>
<td>$ 25.594,40</td>
<td>$ 209.352,63</td>
</tr>
<tr>
<td>Porcentaje de Participacion de los costos por área</td>
<td>15%</td>
<td>53%</td>
<td>20%</td>
<td>12%</td>
<td>100%</td>
</tr>
</tbody>
</table>
Establecer los costos indirectos de fabricación en que se incurren en la producción de los productos con mayor volumen de ventas y alto margen de rentabilidad.

### CIF's Método ABC Vs CIF's Método Tradicional

<table>
<thead>
<tr>
<th>Producto</th>
<th>Cerrajería</th>
<th>Enchape</th>
<th>Costura</th>
<th>Ensamble</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Butaco M</td>
<td>$2.314,00</td>
<td>-</td>
<td></td>
<td></td>
<td>$4.568,00</td>
</tr>
<tr>
<td>Mesa manicure Oval</td>
<td>$  -</td>
<td>$4.688,00</td>
<td></td>
<td></td>
<td>$5.581,00</td>
</tr>
<tr>
<td>Peinador Yoly</td>
<td>$  -</td>
<td>$8.976,00</td>
<td></td>
<td></td>
<td>$9.728,00</td>
</tr>
<tr>
<td>Silla peluquería yoly</td>
<td>$ 6.459,00</td>
<td>-</td>
<td>$3.158,00</td>
<td>$698,00</td>
<td>$10.315,00</td>
</tr>
<tr>
<td>Peinador Roma</td>
<td>$  -</td>
<td>$9.791,00</td>
<td></td>
<td></td>
<td>$10.771,00</td>
</tr>
<tr>
<td>Mesa manicure RACC</td>
<td>$  -</td>
<td>$11.324,00</td>
<td></td>
<td></td>
<td>$11.843,00</td>
</tr>
<tr>
<td>Auxiliar de manicure</td>
<td>$  -</td>
<td>$11.994,00</td>
<td></td>
<td></td>
<td>$12.456,00</td>
</tr>
<tr>
<td>Silla yoly en acero</td>
<td>$ 3.772,00</td>
<td>-</td>
<td></td>
<td>$149,00</td>
<td>$3.921,00</td>
</tr>
<tr>
<td>Lavacabezas yoly</td>
<td>$ 3.553,00</td>
<td>-</td>
<td>$1.783,00</td>
<td>$989,00</td>
<td>$6.325,00</td>
</tr>
<tr>
<td>Silla peluquería karen</td>
<td>$ 6.651,00</td>
<td>-</td>
<td>$2.809,00</td>
<td>$450,00</td>
<td>$9.910,00</td>
</tr>
<tr>
<td>Conjunto manicure y pedicure</td>
<td>$ 6.424,00</td>
<td>$1.901,00</td>
<td>$3.426,00</td>
<td>$1.085,00</td>
<td>$12.836,00</td>
</tr>
<tr>
<td><strong>Total por centro de costo</strong></td>
<td>$29.173,00</td>
<td>$48.674,00</td>
<td>$13.214,00</td>
<td>$7.193,00</td>
<td>$98.254,00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Porcentaje de Costos Indirectos de Fabricación por Centro de Costo</th>
<th>30%</th>
<th>50%</th>
<th>13%</th>
<th>7%</th>
<th>100%</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Producto</th>
<th>Cerrajería</th>
<th>Enchape</th>
<th>Costura</th>
<th>Ensamble</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Butaco M</td>
<td>$3.490,18</td>
<td>-</td>
<td></td>
<td></td>
<td>$619,32</td>
</tr>
<tr>
<td>Mesa manicure Oval</td>
<td>$  -</td>
<td>$9.056,23</td>
<td></td>
<td></td>
<td>$2.069,53</td>
</tr>
<tr>
<td>Peinador Yoly</td>
<td>$  -</td>
<td>$18.117,24</td>
<td></td>
<td></td>
<td>$1.256,62</td>
</tr>
<tr>
<td>Silla peluquería yoly</td>
<td>$ 9.651,79</td>
<td>-</td>
<td></td>
<td>$8.131,10</td>
<td>$20.425,52</td>
</tr>
<tr>
<td>Peinador Roma</td>
<td>$  -</td>
<td>$21.738,96</td>
<td></td>
<td></td>
<td>$2.660,63</td>
</tr>
<tr>
<td>Mesa manicure RACC</td>
<td>$  -</td>
<td>$21.742,32</td>
<td></td>
<td></td>
<td>$1.426,54</td>
</tr>
<tr>
<td>Auxiliar de manicure</td>
<td>$  -</td>
<td>$23.924,00</td>
<td></td>
<td></td>
<td>$1.234,09</td>
</tr>
<tr>
<td>Silla yoly en acero</td>
<td>$ 5.553,52</td>
<td>-</td>
<td></td>
<td></td>
<td>$451,96</td>
</tr>
<tr>
<td>Lavacabezas yoly</td>
<td>$ 5.468,88</td>
<td>-</td>
<td></td>
<td>$4.101,75</td>
<td>$2.736,35</td>
</tr>
<tr>
<td>Silla peluquería karen</td>
<td>$ 9.339,03</td>
<td>-</td>
<td></td>
<td>$6.942,46</td>
<td>$1.290,85</td>
</tr>
<tr>
<td>Conjunto manicure y pedicure</td>
<td>$ 9.247,95</td>
<td>$3.917,89</td>
<td>$2.933,43</td>
<td>$2.933,43</td>
<td>$19.270,64</td>
</tr>
<tr>
<td><strong>Total por centro de costo</strong></td>
<td>$42.751,35</td>
<td>$98.143,64</td>
<td>$33.083,81</td>
<td>$18.721,84</td>
<td>$192.700,64</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Porcentaje de Costos Indirectos de Fabricación por Centro de Costo</th>
<th>22%</th>
<th>51%</th>
<th>17%</th>
<th>10%</th>
<th>100%</th>
</tr>
</thead>
</table>

### CIF's Método ABC

**CIF's Método ABC Vs CIF's Método Tradicional**

- **CIF's Método ABC**
- **CIF's Método Tradicional**

![Diagrama de barras comparando CIF's Método ABC y CIF's Método Tradicional](image-url)
Fase 4: Simulación, Interpretación de resultados obtenidos y posterior socialización

Determinar el punto de equilibrio en la empresa Muebles Yoly mediante la implementación del sistema de costos tradicionales y sistema de costos ABC.

Simular el método tradicional y método ABC de costeo en software Promodel teniendo en cuenta las variables que componen cada sistema de costeo.

Interpretar los resultados obtenidos en la simulación de ambos sistemas.

Socializar el análisis de los resultados obtenidos en la simulación, recomendando algunas mejoras que se hayan observado en el transcurso de este trabajo con los propietarios de la empresa.
Simulación del método tradicional y método ABC de costeo en software Promodel teniendo en cuenta las variables que componen cada sistema de costeo

Simulación Método Tradicional (4 corridas).

Simulación Método ABC (4 corridas).

Software PROMODEL.

- **Locaciones**: 4.
- **Entidades**: Una por cada Locación.
- **Procesamiento**: Tiempos de Fab. Por tareas.
- **Recursos**: 3 por locación.
- **Llegadas**: De acuerdo a capacidad Centro de Costo
Interpretar los resultados obtenidos en la simulación de ambos sistemas

Simulaciones Por Ambas Metodologías.
Socializar el análisis de los resultados obtenidos en la simulación, recomendando algunas mejoras que se hayan observado en el transcurso de este trabajo con los propietarios de la empresa.
MUCHAS GRACIAS